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Welcome to Bryce 3D

Welcome to Bryce 3D™, the leading 3D
program for desktop artists and
animators, Web designers, and
multimedia producers. Bryce 3D is ideal
for creating 3D graphics for magazines,
ads, or virtually any illustration that
would benefit from the powerful 3D
impact of realistic perspective and
shading.

Bryce 3D’s easy animation features let
you create great animations for video and
multimedia. Bryce 3D’s key-event and
timeline-based animation, lets you create
incredibly realistic, fully animated 3D
worlds. Where rivers rush through
gorges, the sun sets over the ocean, or
mist evaporate to reveal flocks of birds
soaring between mountain peaks.

Bryce 3D can also be an invaluable tool
for interactive multimedia.

Your Bryce 3D package includes:

*  The Bryce 3D CD-ROM
*  The Bryce 3D User Guide
*  The Bryce 3D Quick Reference Card

*  Your Bryce 3D serial number

* A Software Registration Card

If you are missing any of these items,
please contact your Bryce 3D dealer or
distributor, or contact MetaCreations
Customer Service at (408) 430-4063.

"
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What'’s New in Bryce 3D

The new Bryce 3D has new tools, features
and improvements from Bryce 2. For
those upgrading, the following overview
will provide a head start on locating,
learning, and taking advantage of these
additions.

*  Animation

*  Volume Textures

+ Texture Editing

* Enhanced Environmental Controls
* Visible Light Effects

* Infinite Slabs

Animation

Bryce moves. Almost any property of a
scene or object can be animated. Using
Bryce’s easy-to-use animation system you
can quickly add motion to your scene.
The Animation controls, available in the

Working window and the editors, let you
quickly setup a key frame animations for
everything from the position of an object,
to the look of the sky.

The new Advanced Motion Lab lets you
refine your animation. The features of the
lab, the Time Mapping Curves and the
Sequencer, let you adjust the position of
frames or remap the time in your
animation.

To learn more about the animation
controls, refer to “Creating Animations”
on page 354. To learn more about the
Advanced Motion Lab refer to “Advanced
Motion Lab” on page 363.

Volume Materials

Bryce now lets you create two type of
materials: Surface materials, and Volume
materials. Surface materials work like the
materials in Bryce 2. Volume materials let
you define the properties of an object’s
entire volume—inside and out. The new
Materials Lab lets you control properties
for the material’s volume color,
transparency and more.

To learn more about Volume materials,

refer to “Volume Material Channels” on
page 210.
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Texture Editing

The new Deep Texture Editor now gives
you unprecedented control over almost
every aspect of a texture in Bryce. You can
create new textures to use as Material
components, or edit existing textures.
The Deep Texture Editor gives you the
power to bring any surface to life.

To learn more about the Deep Texture
Editor, refer to “Textures” on page 239.

Enhanced Environment Controls

The Environment Attributes dialog let
you control every aspect of your Bryce
environment. The three tabs let you
control the look of clouds, the motion of
clouds, the position and look of the sun
or moon and the lets you add
environmental effects.

This new dialog lets you add incredibly
realistic environment effects like
rainbows, sun rings or star fields.

To learn more about the Environment
Attributes dialog, refer to
“Environmental Attributes dialog” on
page 131.

x  Bryce 3D

Visible Light Effects

Bryce now lets you create volumetric light
effects. A volume light projects that has
actual depth, and can be affected by other
light sources in the scene.

To learn more about Visible Light
sources, refer to “Visible Lights” on
page 328.

Infinite Slabs

This new type of infinite plane lets you
planes with depth. An infinite slab can let
you create realistic bodies of water with
depth. When you drop an object into this
type of water, it can change color as it
sinks deeper into the slab.

To learn more about infinite slabs, refer
to “Infinite Slabs” on page 109.
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About Your User Gmde

This manual provides all the information
you need to get the most out of Bryce 3D.
It will help you learn the application and
serve as a reference as you attempt more
sophisticated procedures and effects.

This user guide assumes you are already
familiar with basic Macintosh and
Windows concepts—menus, dialogs, and
mouse operations, such as clicking and
dragging. If you need more information
on these subjects, or on the Macintosh
Finder or the Windows Desktop, refer to
the Macintosh User’s Manual or the
Microsoft Windows User’s Guide,
respectively.

The best way to learn Bryce 3D is to read
“Bryce 3D Basics” on page 21and then
complete the “Tutorial” on page 53. The
tutorial leads you through the process of
creating illustrations and animations in
Bryce 3D and also explains some of the
important concepts you'll need to know
to model and animate in 3D.

After you complete the tutorial, open a
new file and start building your own
scene.

You may also want to review
“Troubleshooting” on page 429 which
provides answers to many commonly
asked questions.

Computer graphics and
three-dimensional modeling use special
terms that are usually explained where
they are introduced. In addition,
“Glossary” on page 421 provides concise
definitions of a number of terms.



Conventions

The Bryce 3D User Guide is for both
Macintosh and Windows. By convention,
Macintosh commands precede Windows
commands in the text. For example,
Command/Ctrl+l, is equivalent to the
Macintosh Command-1 and the
Windows Ctrl+1. For simplicity, the term
folder refers to directories as well as
folders. Screenshots usually alternate
between the Macintosh and Windows
versions. The Bryce 3D interface for both
platforms is identical, unless otherwise
specified.

There are also several conventions used to
identify paths to certain tools and
controls. The convention to a menu
follows the rule of the menu name>
menu item. The convention to a palette
follows the rule of the palette name:
subpalette name or palette item. The
convention to a palette menu follows the
rule of palette name: palette menu>
menu item.

Modifier Keys

When a modifier key differs between the
Macintosh and Windows platform, the

Macintosh modifier is listed first followed
by a slash and the Windows modifier key.

Option/Alt means Macintosh users press
the Option key and Windows users
press Alt.

LS T T T L 1 .L.J
Customer Support
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Technical Support is free* to registered
users of Bryce 3D. There are three easy
options to contact technical support for
guestions about installation,
configuration or functionality. These
options are: Web, e-mail and phone
support. For questions about creative
technique, please see the Creative
Support section below.

You will find the answers to most of your
questions within the pages of this User
Guide. If you need further assistance, you
may contact MetaCreations’s Technical
Support in any of the following ways:

Web Support

Many of the answers to your questions
are available 24 hours a day on our
website:

http://www.metacreations.com/support

In addition to frequently asked questions,
our web site provides troubleshooting
techniques, late breaking product news,
and other resources to get the most out of
Bryce 3D.

E-mail Support

To answer your technical support
question most effectively and quickly,
please use the e-mail form provided to
you on our website:

http://www.metacreations.com/support.

If you do not have World Wide Web
access, please send e-mail to:

bryce@metacreations.com

Phone Support

Phone support hours are
Monday-Friday, 8:00 AM-5:00 PM
Pacific Standard Time, excluding
holidays.

Call (408) 430-4063. When calling, please

have your serial number handy and be at
the computer that you need assistance.
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Fax Support
(805)566-6359

Please include your name and serial
number on all correspondence.

Creative Support

If you have questions regarding creative
technique, please refer to our message
boards on our website:

http://www.metacreations.com

This area is available to you to meet and
talk with other users of Bryce to share
knowledge, technique, and inspiration.

* MetaCreations does not currently
charge for technical support for

Bryce 3D. The only expense to the user is
the telephone toll charges.

-~ = _-‘-l--._‘_____‘_ R o
MetaCreations reserves the right to
change its support policies at any time.
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Who is MetaCreations?

MetaCreations is a major force in 2D and
3D graphic software, developing and
marketing next generation products that
unite traditional art and design
techniques with digital technology.
MetaCreations products are engineered
to deliver realtime interaction, intuitive
functionality and creativity to design
professionals, graphics hobbyists and
consumers who work on desktop
computers.

MetaCreations’ focus is maintained by
three product values:

+  Faithfully replicate Natural-Media®
and real world looks in the digital
medium.

+ Facilitate and extend the range of
creativity by allowing artists to do
things they couldn’t do before.

+  Capture human expression and
allow the artist’s perspective and
intent to show through.

™
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For More Information
For more information about
MetaCreations’ products, see our World
Wide Web site on the Internet:

http://www.metacreations.com
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What is Bryce 3D?

Bryce 3D is a stand-alone application that
allows you to create and animate virtual
environments.

With Bryce you can create any type of
environment you can dream up, from the
ivory beaches of Tahiti to the silvery rings
of Saturn. Bryce’s user interface contains
all the tools you'll need to create your
environments.

Bryce 3D includes controls for managing
infinite skies. The sky controls let you set
everything from time of day to the color
and frequency of clouds. The sky controls
also let you set light direction, sun/
moonlight, atmospheric depth haze (with

Bryce 3D Overview 13




intensity and color), height fog (with
height, intensity and color), and multiple
sky color components.

Bryce also includes controls for creating a
wide variety of objects to populate your
environment. The Terrain editor lets you
create an infinite number of custom
terrains that you can use to create
landscapes.

The realism of a Bryce environment is
largely dependent on the Materials
applied to the objects in the scene.
Materials are complex combinations of
textures and values. The Materials Lab
lets you combine textures and channel
values to create textures that can simulate
any material found in the real world and
a few that aren’t!

When your environment is set up just the
way you want it, you can add a fourth
dimension—time. Bryce 3D’s animation
tools let you set up landscapes that move
and materials that change over time.

14  Chapter @ Bryce 3D
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Application Overview

The Bryce Window

Bryce’s default environment consists of
the Working window, the Control palette
and the Tool palettes. By default, the
Bryce environment replaces your screen
whenever you launch the application.
However, your operating system’s
standard menus and windows are still
available from within Bryce.

When you launch the application, the Bryce
window replaces your desktop.

The Working Window

The Working window displays all the
objects in your Bryce scene. It's the work
area where you'll arrange the objects and
lights to create your environment.

The view of your scene shown in the
Working Window is taken from a camera.
You can move this camera to get different
views of your scene.

The Working window displays all the objects
that make up your scene.

The Working window also has several
display modes that let you view your
objects as wireframes, rendered objects or
a combination of both. Refer to “Display
Modes” on page 23 for more on these
display modes.



Nano-Preview

The Nano-Preview displays a rendered
preview of your scene. As you update
your scene, the Nano-Preview can update
to show your changes. The Nano-Preview
is a preview tool that lets you see how
your adjustments to object position or
other properties affect the final look of
the scene.

The Nano-Preview window shows a small
rendered version of your scene. As you change
the scene, the display updates to show your
changes.

This preview window has several display
options that let you control how your
scene appears in the Nano-Preview. These
three modes can be very helpful when
you're working on a complex scene.

You can also use the Nano-Preview’s
preset viewing positions to see your scene
from different angles. These options can
help you quickly see the effects of your
changes in 3D space.

The Memory Dots along the side of the
Nano-Preview let you store your favorite
camera positions.

Refer to “Using the Nano-Preview” on
page 30 for more on working with the
Nano-Preview.

View Control

The View Control lets you adjust the view
of your scene. When you use this control,
the view of your scene changes, but the
camera doesn’'t move.

The View Control lets you control how you see
your scene.

Using this control you can see your scene
from the top, bottom, left, right, front or
back. You can also set your scene to
continuously rotate so you can see it from
any angle. Refer to “View Control” on
page 15 for more on using the View
Control.

Camera Controls

The Camera Controls change the
position of the camera. The Camera
Crosses let you move the camera
specifically along the X, Y and Z axis. The
Camera Trackball lets you move the
camera in any direction and along any
axis. Refer to “Camera Controls” on

page 15 for more on moving the camera.

Use the Camera controls to adjust the position of
the camera.
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Render Controls

The Render Controls let you render your
scene. When you render your scene you
can see all the materials and lighting
effects you added.

The Render controls let you render your scene as
a 2D image.

The center button starts the rendering
process while the other buttons control
rendering options. Refer to “Rendering a
Scene” on page 406 for more on
rendering.

Text Display Area

The area just below the Render Controls
is reserved for momentary display of text
information. This area identifies the
names of interface elements as you pass
your cursor over them as well as
displaying information about total
number of polygons in a scene, current
control settings and free memory
information.
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The Text Display Area displays the name of
items in the user interface as you pass your

cursor over them. This area also displays
information about tool settings.

The Tool Palettes

Bryce uses a series of palettes to manage
tools and controls—the Create palette,
Edit palette, Sky & Fog palette, Advanced
Display palette, Selection palette and
Animation controls. These palettes let
you create objects, edit objects, create
skies and fog, control the display of your
scene, select objects and animate objects.

Beside the title of each of the three
palettes along the top of the interface is a
small triangle which opens the different
Preset Libraries available in Bryce.

The Create Palette

The Create palette contains tools for
creating infinite planes, terrains, stones,
primitive shapes, derivative primitives,
2D picture objects and lights.

E_ iy . ke
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The Create palette contains tools for creating all
the types of objects you can use in a Bryce scene.

The Triangle icon for this palette opens
the Preset Objects Library. Refer to “The
Create Palette” on page 106 for more on
the Create palette.

The Edit Palette

The Edit palette contains tools for editing
object materials, resizing, rotating,
repositioning, aligning and randomizing
objects. The Edit Terrain Object tool
accesses the Terrain Editor which lets you
design and adjust terrain objects.

15“*&“

The Edit palette contains tools for transforming
objects and accessing the Editors.

The Triangle icon for this palette opens
the Preset Materials Library. Refer to
“Transforming Objects” on page 285 for
more on the Edit palette.



The Sky & Fog Palette

The controls available on this palette let
you add shadows, fog and haze, and set
the altitude, frequency, and amplitude of
clouds. The palette also lets you control
the color of clouds in your sky and the
position of the sun and moon.

.

The Sky & Fog palette contains tools for creating
the environment of your Bryce scene.

The memory dots along the side of the
palette let you store your favorite sky and
fog settings.

The Triangle icon for this palette opens
the Preset Sky & Fog Library. Refer to
“The Sky & Fog Palette” on page 131 for
more on the Sky & Fog palette.

Advanced Display Palette

The Advanced Display is not visible in the
main interface. It only appears when you
pass the mouse over the right side of the
Working window. After you're finished
working with the palette it gradually
fades away so as to not clutter the screen.

The Advanced Display palette contains
tools for controlling the display of the
interface and enabling/disabling the

Nano-Editor and Plop Render features.
You can also control the resolution of the
Wireframes preview, zoom in and out,
enable/disable wireframe shadows, and
set underground and depth cues. Refer to
“Viewing Your Scene” on page 31 for
more on using the Advanced Display
palette tools.

fa

The Advanced Display palette contains tools for
changing the Working Window display.

The Animation Controls

The Animation controls lets you set up
key frames and edit the time line of your
animation.

o e e S )
The Animation controls displays the time line of
your animation.

It also contains controls for previewing
your animation, adding and deleting key
frames and accessing the Advanced
Motion Lab. Refer to “Setting Up an
Animation” on page 355 for more on
using the Animation controls.

Selection Palette

The Selection palette contains tools for
selecting specific types of objects in your
scene. The palette is not visualize in the
default Working window. To view it, you
must swap the Animation controls for the
Selection palette using the Swap button.

Using the palette tools, you can select
objects by type, by group or family. Refer
to “Selecting Objects” on page 36 for
more on selecting objects.

e NONDOWNSAOW . 1 /50

The Selection palette contains tools that let you
set objects by type or family.

The VCR controls available in this palette
let you cycle though the selections and
enables Solo mode. Refer to “The VCR
Controls” on page 38 for more on using
the VCR controls.

i

Use the VCR Controls to cycle through all the
object s in your scene and activate Solo mode.
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The Editors

Bryce has several editors that let you do
everything from creating terrains to
editing the speed of animation. Each
editor is like a separate room in Bryce.
When active, the editor takes over the
interface, completely replacing the
Working Window.

The Terrain Editor

The Terrain Editor is where you'll create
all the terrain objects in your scene. The
editor contains tools for painting and
refining terrain objects.

The Terrain Editor lets you create any type of
landscape using the preset tools and paint brush.

The Terrain Editor also has a real-time
preview so you can see the effects of your
changes instantly.
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Three tabs in the Terrain Editor let you
switch between the various terrain
creation tools:

+ Elevation provides access to the
terrain generation and editing tools.

+ Filtering lets you adjust the filter
curve for a terrain. By adjusting this
curve you can make subtle changes to
the topography of your terrain.

+ Picture lets you use 2D pictures to
create terrains.

Refer to “The Terrain Editor” on
page 164 for more on the Terrain Editor.

The Materials Lab

The Materials Lab is where you'll create
the materials to apply to your objects. By
combining up to four texture
components on the materials grid, you
can create incredibly complex surfaces
that can bring your scene to life.

There are two types of materials you can
create: Surface materials, which define
the surface properties of an object, and
Volume materials, which define the
properties of an object’s volume as well as
its surface. Refer to “The Materials Lab”
on page 229 for more on the

Materials Lab.

The Materials Lab lets you create different types
of materials by combining texture components
on the materials grid.

When you're creating a Volume material,
the settings available in the Materials Lab
change. The settings that appear let you
set up the volumetric properties of the
material. Refer to “Understanding
Volume Material Channels” on page 197
for more on Volume materials.



When you're creating volume materials the
settings in the Materials Lab change. Some of
the surface material settings are replaced by
volume effects settings.

The Advanced Motion Lab

The Advanced Motion Lab lets you
fine-tune your animations. After you've
created your key frames, using the
Animation controls, you can use the tools
available in this lab to control the speed at
which objects move along a motion path,
adjust the position of key frames, and
preview your changes.

The Advanced Motion Lab lets you refine the
action in your animations. Use the Velocity
Curve editor to create different velocity effects
and the Hierarchy area to control when object
transformations occur.

There are three areas within the
Advanced Motion Lab that let you edit
specific aspects of your animations: the
Time Mapping Curve editor, the
Hierarchy List and the Sequencer.

The Time Mapping Curve editor lets you
create a time mapping filter which alters

how the time in your animation is
mapped to actual time.

By adjusting the shape of a time mapping

curve you can create different velocity

effects. Refer to “Time Mapping Curves”
on page 367 for more on velocity curves.

The Hierarchy List area lets you see how
objects are linked and grouped within
your scene. Although you can’t change
the hierarchy of your scene in this area, it
can be a valuable visualization tool.

The Sequencer lets you see where key
events were recorded for all of an object’s
properties. Using this area you can
control exactly when object
transformations occur. Refer to 1
“Properties in the Sequencer” on b
page 353 for more on the Sequencer.
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The Bryce Preset Libraries

Bryce has several libraries of presets that
can make creating scenes easier. There are
three main preset Libraries available in
Bryce 3D: the Preset Obijects Library, the
Materials Presets Library, and the Sky &
Fog Preset Library. You can use the
objects library to add pre-made objects to
your scene. Refer to “Using the Presets
Object Library” on page 125 for more on
the Preset Objects Library.
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The Preset Object Library contains a variety of
3D objects you can use in your scene.

20  Chapter @ Bryce 3D

The Materials library lets you add a wide
variety of materials to your objects. Refer
to “Using the Preset Materials Library”
on page 234 for more on the Preset
Materials Library.

The Sky & Fog Preset library contains
pre-made skies that you can add to your
scene to quickly create an environment.
Refer to “Using the Preset Skies Library”
on page 160 for more on the Preset

Sky & Fog Library.

The Menu Bar

The Bryce 3D menu bar contains three
menus: the File menu, the Edit menu,
and the Objects menu. These menus
provide access to several Bryce functions
and editors.

The display of the menu bar depends on
the state of the application. When the
application interface snaps to the edges of
your screen, the menu bar is hidden until
you pass the pointer over the menu

bar area.



Bryce 3D Basics
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Overview

This section describes how to perform
most of the basic functions in Bryce and
how to set up the application.
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Setting Application
Preferences

By setting application Preferences, you
can customize Bryce to suit the way you
work. You do not have to restart Bryce to
make these changes take effect.

Application Preferences are set in the
Preferences dialog.
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The Preferences dialog lets you set the opening
state of the application and customize it.

To set the application’s launch state:

1. Choose Edit menu> Preferences.
The Preferences dialog appears.
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2. Enable either Launch to Previous
State or Launch to Default State.

Launch to Previous State launches
Bryce using the settings from your
last session.

Launch to Default State launches
Bryce using the default settings.

To save PICT or bitmaps used in a
scene with a file:

1. Choose Edit menu> Preferences.
The Preferences dialog appears.

2. Enable PICT with Scene Open/Save.

With this option enabled, Bryce will
automatically open or save a PICT or
BMP file (PICT/BMP files are
automatically appended with the
extension) along with your scene file
every time you open or save. In most
cases, this option should always be
selected.

To control new object placement:

1. Choose Edit menu> Preferences.
The Preferences dialog appears.

2. Enable either Create Objects Within
View or Create Objects at World
Center.

Create Objects Within View places
newly created objects within the
camera view, rather than at world
center.

Create Objects at World Center
places newly created objects at world
center, regardless of whether they will
be visible in your current camera
view.

o
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Setting Up the Bryce
Window

When you first launch Bryce 3D, the
interface snaps to the edges of your
screen. The menu bar is hidden until you
pass your cursor over it, and other
applications are hidden behind Bryce.
This setup lets you work with a
uncluttered desktop.

To maximize the Bryce window:

1. Pass the cursor over the right side of
the Working window. The Advanced
Display palette appears.



2. Click the Interface Max/Min tool.

Use the Interface Max/Min tool to switch
between a Bryce window and a standard
window.

3. Click the tool again to switch to a
standard window.

Setting Up the Working Window

Before you start working in Bryce, you
may want to set up how objects are
displayed in the Working window. These
display modes can help you when you're
arranging objects and can also speed up
your redraw time.

Display Modes

The Display Mode tool, at the
bottom-right corner of your Working
window, toggles through the three
possible display modes.

To switch between display modes:
1. Click on the Display Mode tool in the
corner of the Working window.

IH'
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This button is only visible when you
pass your pointer over it.

2. Click the button until you're in the
desired mode.

There are three modes available:

»  Wireframe Display shows all
objects as wireframes.

In Wireframe Display all objects are shown as
wireframes.

+  Bitmap Display shows a
rendered scene. The display
automatically switches to this
mode whenever you click the
Render button.

0

In Bitmap Display all objects are displayed as
rendered objects.
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«  Wireframe/Bitmap Display lets
you edit wireframes while
simultaneously viewing your
rendered image behind them.

In Wireframe/Bitmap display, all objects are
displayed as wireframes, but with the rendered
image in the background.

This mode is most useful when you
have a partially-rendered image and
are unhappy with the results. If you
switch to this mode, you can move
your wireframe objects, relative to
the rendered image behind it. In this
way, you can accurately judge the
results of your change.

To toggle between modes:
o Press the Esc key.
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The Esc key will toggle between the
last Wireframe mode you selected
(Wireframe, or Wireframe/Bitmap)
and Bitmap mode.

Flat Shaded Preview Mode

This preview mode is only available if
your system contains hardware that
supports OpenGL.

In Flat Shaded Preview display, all objects are
displayed as flat shaded solids.

When this mode is active your objects
appear as flat shaded solids instead of
wireframes, and you can see the effects of
light sources on object surfaces. However,
you can’t see materials.

To display objects in Flat Shaded
Preview:

o Hold down the mouse button over
the Display Mode button and choose
OpenGL from the menu.

Wireframe attributes

When you're in Wireframe mode, there
are several options you can set to make
the display more helpful. Disabling some
of these options may speed up drawing
time.

To set Wireframe attributes:

1. Make sure you're in Wireframe mode.
Click the Display Mode tool until the
display switches to Wireframe.

2. Drag the Depth Cue control up or
down. Dragging up increases the
intensity of the depth cueing effect
and dragging down decreases it.

=



When depth cueing is active, the
wireframe appears lighter the farther
it is from the camera.

When depth cueing is active, objects appear
lighter the farther they are from the camera.

1"_'__ ._\_E_-__ _._..I-I'*
If you hold down the Control key/
Ctrl+Alt keys and click on the Depth
Cue icon, Bryce will turn both
antialiased wireframes and depth
cueing on or off simultaneously.

e

3. Click the Wireframe Shadows button
to turn shadows on or off.

Shadows are designed to help you
determine object placement in your
scene. For this reason shadows

appear even when there is no ground
plane or when the object is below the
ground plane.

You can use wireframe shadows to help you
determine the placement of objects in the scene.

e

This feature may slow down your
system when working with a complex
scene on slower machines.

e

4. Click the Underground On/Off
button to hide or show underground
lines.

When underground lines are hidden,
any portion of a terrain or object that
is positioned below ground level will
not be visible in your wireframe
scene. This is useful for easy

visualization and composition.
However, you might overlook an
object that is hidden underground.

When underground is enabled, objects that are
positioned below the ground plane are not
visible in the scene.

5. Click the Resolution tool and then
choose Static, Selected or Motion.
Then choose a resolution for the
wireframe mode.

2

Static is the resolution of the
wireframe when the object is not
moving.

Selected is the resolution of the
wireframe when the object is selected.

Motion is the resolution of the
wireframe when the object is being
moved.
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Window Backgrounds

il The background texture of the working
T window can add a great deal to the overall
look of the interface. It makes it easier to
see wireframes and selected objects.

To select a background texture:

o Click the Background Paper button
and choose a background from the
menu.

[
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Adding a background texture may slow
down some machines. If you need
g more speed for any reason, select No
Texture, and you will get a simple,
clean background with no texture.
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To select a background color:

§
; ._5" 1. Click the Background Paper button
3 and choose Select Color from the
3 i menu.
el

Use the color picker to select a color.
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Using the Bryce Interface
The Bryce 3D interface can be completely
customized. If you want to, you can tear
apart the interface and reposition any
palette, or you can choose to hide the
entire interface and leave only the
working window visible.

To move a palette:

o Hold down the Spacebar and drag the
desired palette to a new location.

When you break the interface apart, you can see
all the palettes at the same time. You can move
these palettes anywhere in the Bryce window.

To reset a palette to its original
position:

o Hold down the Option/Alt key and
the Spacebar, then click on a palette,
or choose Edit menu> Reset
Palettes to reset all palettes to their
default positions.

To hide the Bryce interface:

1. Press Command-Tab/Ctrl+Tab. All
the palettes disappear and your image
appears at the center of your work
space.

2. Press Command-Tab/Ctrl+Tab again
to display all the palettes.

To display individual palettes:
1. Press Command-Tab/Ctrl+Tab to
hide the interface.

2. Press the key combination for the
palette you want to display:

*  Command-1/Ctrl+1=Create
palette

+ Command-2/Ctrl+2=Edit palette



«  Command-3/Ctrl+3=Sky&Fog
palette

+  Command-4/Ctrl+4=Control
palette

+  Command-5/Ctrl+5=Selection
palette

+  Command-6/Ctrl+6=Display
palette

Displaying Text Information

The Text Display area at the bottom of
the Control palette displays a great deal of
valuable information about the interface
and statistics for your scene.

During rendering, the Text Display area
displays projected and elapsed time
estimates. This estimate does not include
the time for antialiasing. The total time,
including antialiasing, will be calculated
and displayed in the Render Report.

When you're working in the Timeline or
Animation controls, the Text Display area
displays the current time.

To display information about the
interface:

o Pass the pointer over any interface
element.

The name of the element is displayed.
In some cases, the element’s current
settings are also displayed.

To display statistics about the objects in
your scene:

1. Switch to Wireframe display using
the Display Mode tool.

2. Pass the pointer over the working
window.

» If no objects are selected, the
Text Display area displays a count
of all of the objects in your scene,
as well as a total polygon count.

+ If an object is selected, the Text
Display area displays object and
polygon counts for the selected
object.

To display information about rendered

images:

1. Switch to bitmap display mode using
the Display Mode tool.

If you have not rendered your image,
the working window is blank.

2. Pass the pointer over the working
window.

The Text Display area shows
information about free memory and
file dimensions.

Displaying/Hiding Palettes

To keep the interface uncluttered, many
of Bryce’s palettes and toolbars are
hidden when you first launch the
application. Some palettes are hidden
behind other palettes.

To display different palettes:

o Click on a text button above the
Working window, or press the key
combination for the desired palette:

+  Command-1/Ctrl+1=Create
palette

+  Command-2/Ctrl+2=Edit palette
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+ Command-3/Ctrl+3=Sky&Fog
palette

+  Command-4/Ctrl+4=Control
palette

To display hidden palettes:

o Pass the cursor over the edges of the
Working window, or

o Press the key combination for the
hidden palette you want to display:

+  Command-5/Ctrl+5=Selection
palette

+ Command-6/Ctrl+6=Display
palette

Displaying Submenus and Pop-up
Dialogs

Wherever you see an inverted or sideways
triangle icon in the interface, it indicates
that there is a menu or other item
available, which contains options
pertinent to the item closest to it. For
example, in the Edit palette, there are
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triangle icons next to each tool in the
palette. These triangles access the
additional options for the tools.

Create)

The triangle icon next to a tool or text button
indicates that there are more options available
for the element.

To display a submenu:

o Click the triangle icon.

-

‘R~ Trackball
Center to Selection
Tripod
Free Camera
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Click the triangle icon next to a tool to access
additional options.
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Working with Documents

Before you can create a Bryce
environment you need a document. A
document can be either a blank scene or
an existing file that you're going to edit.

Creating an Empty Scene

When you create a blank scene, Bryce
opens the Document Setup dialog which
lets you specify the aspect ratio and
dimensions of the new scene.

To create a new document:

1. Choose File menu> New. The
Document Setup dialog appears.
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Use the Document Setup dialog to set he
resolution and aspect ratio for your image.

2. Enter values in the Document
Resolution fields.

This is the absolute size of your
working space expressed in pixels.
You can enter any values you like
here, though it’s recommended that



you not exceed your available screen
space if you can avoid it. You can
work small and render large if you
need to. The values in the Aspect
Ratio fields will update automatically
as needed.

Enter values in the Document Aspect
Ratio fields.

These fields represent the Document
Resolution as a ratio. Depending on
the type of work you are doing, it
may be more convenient to enter
values here rather than in the
resolution fields above. For instance,
many video formats, as well as the
standard 13” screen, are 3:4 aspect
ratios.

The values in the Document
Resolution fields will update
automatically if you change the
aspect ratio.

Enable the Constrain Proportions
button if you want to preserve the
current aspect ratio as you adjust the
resolution.

Select a Render Resolution from the
list.

This resolution sets the absolute size

of your rendered image, expressed in
pixels as a multiple of your document
size.

You may be working at Bryce’s
default size as you build your scene,
but you may then wish to render that
scene four times larger for print, or
four times smaller for a Web page.
Rather than resetting your document
resolution every time you render, and
thus impacting your wireframe
workspace, you can simply set a
separate size for rendering. Think of
Document Resolution as input, and
Render Resolution as output.

The default resolution is 480 x 360, and
the default aspect ratio is 4:3.

To set up a new document using
presets:

1. Choose File menu> New. The
Document Setup dialog appears.

2. Click one of the preset aspect ratios
displayed along the right side of the
dialog.

These presets are aspect ratios for
many useful document types. The
pixel values that are placed in the

Document Resolution fields are

either absolute (as in Legal or Letter)

or based on your available screen
resolution (as in Maximum
Recommended or Square).
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If you hold down the Control ke)_//

Ctrl+Alt keys when you're accessing
this dialog, the last Render Resolution

option will be called Maximum, and will

automatically set up the largest
possible vertical render size based on
your current Aspect Ratio.
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Opening an Existing File

Bryce 3D can open any file created in
Bryce 2 (Mac or PC).

To open an existing file:

1. Choose File menu> Open.

2. Use the dialog controls to locate and

open your file.
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Merging scenes

You can merge two Bryce scenes using the
Merge command. When you use this
command the scene you open is merged
with the currently open scene. Objects
from the scene you're opening are placed
in your current scene, at the same
absolute coordinates that they previously
occupied.

To merge two scenes:

Choose File menu> Merge. A dialog
appears prompting you to save the
current scene.

1. Click Save. The Open dialog appears.

2. Use the dialog controls to locate the
file you want to merge and click
Open.

The file you selected is merged with
the current scene.

— _-‘—l-.._‘______ =
Holding down the Option/Alt key while
performing this function will merge
only the sky from the incoming scene.
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Working in a Scene

Displaying Your Scene

The display of your scene is controlled by
the display mode you selected when you
set up the Working window. You can also
control how individual objects are
displayed and how your scene is displayed
in the Nano-Preview.

Changing Object Display

You can change how your objects are
displayed using the Object menu
commands. Changing the object preview
can greatly reduce redraw time in a
complex scene. The Object’s preview does
not affect how the object renders.

To display objects as boxes:

1. Choose Object menu> Show Object
as Box.

This command displays any selected
object, objects, or group as box(es).

This is useful when you just want to
work with the object’s position, but

don’t need more details.

Keyboard Shortcut: Command-B/
Ctrl+B.

To display objects as wireframes:

o Choose Object menu> Show Object
as Lattice.

Use this command to change objects
shown as boxes back to wireframes.

Keyboard Shortcut: Command-L/
Ctrl+L.

Using the Nano-Preview

The Nano-Preview is where your object is
displayed before you render it. The
preview can display your scene from a
number of different angles without
affecting the position of the camera.

LALLLLL

The Nano-Preview displays a rendered preview
of your scene.



To display your scene from different
angles in the Nano-Preview:

o Click the triangle icon below the
Nano-Preview and choose a preset
display angle.
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Click the triangle icon to access the preset
display angles for the Nano-Preview.

The view of your scene does not
change in the Working window.

To set Nano-Preview options:

o Click the triangle icon below the
Nano-Preview and choose a display
option;

+  Sky Only previews only your sky
settings.

+  Full Scene previews your actual
scene. This is the default setting
for the Nano-Preview.

+  Wireframe Only previews your
wireframes only, as opposed to a
rendered preview.

+ Auto Update will automatically
update the preview render with
every single change you make
during your session. In most
cases, this is a godsend, giving
you almost immediate feedback
after any action. On slower
machines, or when working with
highly complex scenes, you may
wish to deselect this option.

With this option deselected,
you'll need to click in the

Nano-Preview window or press
Control-R/Ctrl+Alt+R to update
the render.

Viewing Your Scene

When you're creating an environment in
Bryce, your scene can quickly become
rather large. You may not be able to see
the entire landscape in the Working
window. Bryce has several tools that can
help you see every inch of your new
world.

Orthogonality and Views

When you view a scene from the side,
front, top or bottom using the Camera,
you'll see certain amounts of perspective
distortions. These distortions can make
precise visual alignments difficult.

For instance, if you had a dozen cubes in
different locations, and then went to Top
View to place them on top of one
another, you would find it very difficult.
Cubes further from the camera would be
slightly smaller than cubes close to the
camera. This results in a confusing array
of lines. The more complex the scene, the
more confusing and difficult this kind of
alignment becomes.
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If you viewed objects from above through a
real-world camera, the perspective distortions
would make aligning or placement difficult.

To solve this problem, Bryce 3D uses a
perspective-free, drafting board kind of
view in which like-sized objects far away
appear exactly the same as those up close.

Bryce uses an “orthogonal projection” of your
objects to eliminate perspective distortion.
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This perspective-free view is called an
orthogonal projection. In Bryce 3D, all
views other than your Main View (that is,
Top, Bottom, Right, Left, Front and Back)
are orthogonal projections. They are not
generated by the camera, and so do not
contain the perspective distortion that
would necessarily come with a camera
view.

As a result, Camera controls do not work
in these views. You can navigate within
the orthogonal views using the Zoom and
Pan tools.

- D R
If you press the Render button while in
an orthogonal view, Bryce will quickly
set up the camera position you need,
and render your image. There may be
slight differences between what you
see in the wireframe projection and
what you see in the rendered image,
as a result of the added perspective
distortion in the rendered image.

* il _-h-‘—\—____ -

Zooming In and Out

In Bryce there is a difference between
moving the camera and using the zoom
tools.

When you move the Camera, you're
moving in 3D space. When you use the
pan and zoom controls, you're
transforming a 2D projection of your 3D
scene—your camera position does not
change.

When you use the Zoom tool, you are
essentially making the 2D projection
larger or smaller. Your camera position in
3D space does not change.

To zoom in:

o Click on the Zoom In tool.

E

Bryce scales the 2D projection of
your scene larger, creating the
illusion of zooming into your 3D
scene; your camera position remains
unchanged.

Keyboard Shortcut: Command-plus/
Ctrl+plus.

To zoom out:
o Click the Zoom Out tool.

2



Bryce scales the 2D projection of
your scene smaller, creating the
illusion of zooming out of your 3D
scene. Your camera position remains
unchanged.

Keyboard Shortcut:
Command-minus/Ctrl+minus.

To zoom into an area:

o Hold down Command-Spacebar/
Ctrl+Spacebar and drag a marquee
around an area of your scene.

Your cursor changes to a Zoom tool,
and Bryce centers and scales up the
area in the marquee to fit your
window.

To zoom out of an area:

o Hold down
Command-Option-Spacebar/
Ctrl+Alt+Spacebar and drag around
an area.

Bryce scales down your entire scene
to fit within the area your marquee
selected.

To zoom numerically:

1. Double-click the Trackball in the
Control palette. The Camera & 2D
Projection dialog appears.

2. Enter a value in the Scale field.
The default value is 100%.

To reset the zoom value:

o Pressthe Option/Alt key and click the
Zoom tool.

The view of your scene resets to
100%.

Panning

Panning works exactly like zooming.
When you use the Panning tool, you are
moving a 2D projection of your scene
right and left, up and down in front of the
camera. Your camera position in 3D
space does not change.

To pan your scene using the Pan tool:

o Drag over the Pan tool in the
direction you want your scene to
move.

To pan your scene using the Spacebar:

o Hold down the Spacebar and drag in
the direction you want your scene to
move.

To pan numerically:

1. Double-click the Trackball in the
Control palette. The Camera & 2D
Projection dialog appears.

2. Enter avalue in the Horizontal field.
The default value is 240.

3. Enter avalue in the Vertical field.
The default value is 180.

To reset the pan value:

o Pressthe Option/Alt key and click the
Pan tool.

The view of your scene resets to 240
horizontal and 180 vertical.
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Using Fly-around View

You may have noticed a tiny circular icon
above and to the right of the Views icon;
clicking here will change from your

current View to a special motion view, or

Fly-around View.
abi

In Fly-around view your scene rotates so you can
see it from a number of angles.

This view enables you to get a sense of
context in your Bryce world. If you're
working close to the ground, or stuck in
the midst of a clump of trees, or you've
lost a cube you know you created a half
an hour ago, you can use the Fly-around
view to see your entire scene all at once.

In Fly-around view, Bryce positions the
Camera on an imaginary monorail track
above and away from your scene such
that you can see the whole thing from all
sides as the camera moves around it.

To switch to Fly-around view:

o Click the Fly-around view icon next
to the View control. The View control
icon changes to the Fly-around
control icon.

To switch back to Camera view:

o Click on the Fly-around view icon
again.

To rotate the view of your scene in
Fly-around view:

o Move your mouse in the direction
you want to rotate. The scene rotates
in the direction you drag.

To zoom in and out in Fly-around view:

o Hold down the Command/Ctrl key.

To pause the Fly-around:

o Press the Spacebar.

To end the Fly-around and save
Fly-around position:

o Press Return/Enter. The view
switches back to camera view and the
last Fly-around position becomes the
new Camera View.

Keyboard Shortcut: Command-Y/
Ctrl+Y.

Using the View Control

Bryce lets you view your scene from
several preset positions; Main, Top,
Front, and Side, Bottom, Right, Left and
Back. All theses views with the exception
of the Main View are special Orthogonal
projections which allow perspective-free
views well-suited for alignment
operations.



The View control is an interactive way of
cycling through the various preset views.
The current position of the View control
indicates the view you're seeing in the
Working window.

S|

The View Control lets you select from different
views of your scene.

To switch views using the View control:

o Click or drag the Views control until
you reach the view you are looking
for.

Every time you click the control

Bryce displays a different preset view.

To switch views using the View control
menu:

o Click the triangle icon next to the
View control and select a view
option;

Camera View: select this option
to view your scene as the Camera
sees it, based on the Camera’s
current location and orientation.

From Top: select this option to
view a perspective-free
orthogonal projection of your
scene as seen from above (based
on absolute world coordinates).

From Right: select this option to
view a perspective-free
orthogonal projection of your
scene as seen from the right
(based on absolute world
coordinates).

From Front: select this option to
view a perspective-free
orthogonal projection of your
scene as seen from the front
(based on absolute world
coordinates).

From Left: select this option to
view a perspective-free
orthogonal projection of your
scene as seen from the left (based
on absolute world coordinates).

+  From Back: select this option to
view a perspective-free
orthogonal projection of your
scene as seen from behind (based
on absolute world coordinates).

*  From Bottom: select this option
to view a perspective-free
orthogonal projection of your
scene as seen from below (based
on absolute world coordinates).

+ Director’s View: select this option
to view you seen from the
perspective of a director sitting
outside the scene.

To switch views using the keyboard:
o Select a preset view shortcut:

+ Camera View=1

+ Top View=2

* Right View=3

* Front View=4

* Director’s View=5
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To reset the view of your scene:

o Click the triangle icon next to the
View control and choose Reset Views,
or

o Press the Option/Alt key and click on
the Views icon.

This option resets your Camera View
to Bryce’s default setting.

Selecting Objects

Before you can perform any type of
editing or transforming operation on an
object, you need to select it. Besides
selecting objects using the cursor, Bryce’s
Selection tools let you select objects by
type or family. You can also cycle through
all the objects in your scene.

To select an object:

o Click on any object. A selected
object’s wireframe will appear red,
or

o Draga marquee around the object.
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To select a number of objects:
o Shift-drag a marquee around a
number of objects.

To step through all the objects in your
scene:

o Press the Tab key until the object you
want selected appears in red.

To select all objects:

o Choose Edit menu> Select All, or
o Press Command-A/Ctrl+A.

To select an object within a group:

o Hold down Control and click the
desired object.

To deselect all:
o Choose Edit menu> Deselect All, or

o Click anywhere outside the selected
area.

To add objects to a selection:

o Hold down the Shift key while
selecting the object.

To remove objects from a selection:

o Shift-click the selected object.

To select obscured objects:

o Hold down the Shift key and select
through the obscuring object. All
objects underneath the cursor and
behind the frontmost object will be
selected.

The Selection Palette

The Selection palette is hidden behind
the Animation controls in Bryce’s default
state. The palette is divided into two
sections: select by type tools and the VCR
controls.

e NONDONNAOR L /20
The Selection palette has tools for selecting
objects in variety of different ways.



o Click the Swap button in lower right
corner of the Working window. The
Selection palette appears.

=
Click the Swap button to switch between the
Animation and Selection palettes.

Selecting By Object Type

The Select by Type icons let you select all
the objects in your scene that are of a
particular type. For instance, clicking on
a sphere here will select all spheres and
sphere-derivative objects in your scene.

The following tools are available:

ﬁl Selects all Infinite slabs.

Selects all Water, Cloud, and
Ground planes.

Selects all Terrain objects.

Selects all Stone and Mesh
objects.

Selects all Symmetrical Lattice
objects.

NeFE
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Selects all Torus objects.

Selects all Spheres, Ellipsoids, and
Squashed Spheres objects.

Selects all Cylinder, Tuboid,
Squashed Cylinder, and
Stretched Cylinder objects.

Selects all Cube, Brickoid, and
Stretched Cube objects.

Selects all Pyramid objects.

Selects all Cone, Stretched Cone,
and Squashed Cone objects.

Selects all 2D Disk objects.

Selects all 2D Face and 2D PICT
objects.

Selects all Radial Light objects.

Selects all Spotlight objects.

Selects all Square Spotlight
objects.

Selects all Parallel Light objects.

u]

Hold down the cursor over the tool
for the type of object you want to
select and choose the name of the
object from the menu that appears.

You must first name objects, if you
want them to appear in this menu.
Refer to “Naming Objects” on
page 107 for more on haming
objects.

To select objects by family:

]

To select Polymesh objects:

]

Click the Families tool and choose

the name of family you want to select

from the menu.

You must first name a family if you

want it to appear in this menu. Refer

to “Families” on page 309 for more
information.

Click the triangle icon next to the
selections palette and choose Select
Polymesh.
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All of the above selection controls will
respect the previously-described
Shift-click techniques for multiple
selections and deselections.

To select all objects except a specific
type:

1. Click the tool for the object you want
to exclude from the selection. All the
objects of that type are selected.

2. Click the triangle icon in the
Selection palette and choose Select
Inverse from the menu.

To select all the objects in your scene:

o Click the triangle icon in the
Selection palette and choose Select
All from the menu.

The VCR Controls

The VCR controls let you step through
the various selection tools and activate
Solo Mode.

e __
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To display the VCR Controls:
1. Click the Swap button in the lower

right corner of the Working window.
The Selection palette appears.

2. Passyour cursor over the right side of
the Selection palette. The VCR
Controls appear.

To step forward and backward through
the object types in your scene:

1. Click on the larger forward arrow to
step forward through object types
within the current scene. The first
object of its type is selected.

L

2. Click on the larger backward arrow to
step back through object types.

—
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If you watch the Select By Type icons,
the object type you are stepping to
will highlight momentarily.

To step forward and backwards
through the object in a selected object

type:

1. Click on the smaller forward arrow to
step forward through each object of
the type in a selection.

11

a

For example, you can use the large
arrows to step to the first sphere
created in your scene, and then the
smaller arrows to step through all
other spheres in your scene.

2. Click the smaller backwards arrow to
step backwards through each object
of the type in a selection.

- ——— -

One advantage to making selections
with this technique is that you can
select objects within a Group. Simply
clicking on a Grouped object will not
necessarily select the entire group;
using the VCR controls to select within
a Group allows you to reposition



objects, or assign textures to objects
within a Group without having to first
Ungroup them.

- e —

To step sequentially through every
object in your scene:

1. Click the triangle icon in the
Selection palette and choose
Alternate VCR Mode.

2. Click the larger backwards or
forwards arrow.

To step sequentially through families:

1. Click the triangle icon in the selection

palette and choose Alternate VCR
Mode.

2. Click the smaller backwards or
forwards arrow.

To temporarily remove all unselected
objects from the scene:

1. Select an object.

I o

2. Click the Solo Mode button in the
center of the VCR controls. The
button color changes to red.

In Solo Mode, you can only edit the
selected objects; all the other objects
remain in place but uneditable.

If you’re working on a very complex
scene, Solo Mode speeds up your
work significantly as Bryce does not
have to calculate and draw
extraneous wireframe objects.

Editing Your Scene’s Contents

Bryce supports several of the basic editing

features you find in most applications.
You can cut, copy and paste objects
between the clipboard and your scene.

Cutting and Pasting Objects

To cut and paste an object:
1. Select an object.

2. Choose Edit menu> Cut, or
Press Command-X/Ctrl+X.

The selected item is removed from
your scene and placed on the
clipboard.

Choose Edit menu> Paste, or press
Command-V/Ctrl+V.

To copy and paste an object:

1.
2.

Select an object.

Choose Edit menu> Copy, or press
Command-C/Ctrl+C.

A copy of the selected item is placed
on the clipboard.

Choose Edit menu> Paste, or press
Command-V/Ctrl+V.

Copying and Pasting Materials

Using the Copy/Paste Material
commands, you can edit an object’s
material without affecting the object.

To copy and paste an object’s material:
1.
2.

Select an object.

Choose Edit menu> Copy Material,

or press Command-Option-C/
Ctrl+Alt+C.
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The selected item’s material is copied
to the clipboard.

3. Choose Edit menu> Paste Material,
or, press Command-Option-P/
Ctrl+Alt+P.

Copying and Pasting Matrices

Using the Copy/Paste Matrix commands,
you can copy information about an
object’s location, size and orientation
values to the clipboard and then paste
them onto other objects.

To copy and paste an object’s matrix:
1. Select an object.

2. Choose Edit menu> Copy Matrix, or
press Option-C/Alt+C.

The selected object’s matrix is copied
to the clipboard.

3. Select a different object.

4. Choose Edit menu> Paste Matrix,
or press Option-P/Alt+P.

To delete a selected object:

1. Select an object.
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2. Choose Edit menu> Clear, or press
the Delete/Backspace key.

Duplicating and Replicating Objects
When you duplicate an object, Bryce
creates an exact copy of the object and
places it in exactly the same position as
the original. When you replicate an
object, Bryce creates a new object and
applies the last set of transformations
toit.

To duplicate an object:
1. Select an object.

2. Choose Edit menu> Duplicate, or
press Command-D/Ctrl+D.

To replicate an object:
1. Select an object.

2. Choose Edit menu> Replicate, or
press Command-Option-D/
Ctrl+Alt+D.

A new object appears at a size,
location and orientation based on the
last set of transformations. For
example, if you select an object, drag

it to a new location and then select
Replicate, a new object is created at
the same distance from the original.

To replicate objects numerically:
1. Select an object.

2. Choose Edit menu>
Multi-Replicate, or press
Command-Option-Shift-D/
Ctrl+Alt+Shift+D.

The Multi-Replicate dialog appears.
3. Enter avalue in the Quantity field.

This value sets the number of
duplicates you want to create.

4, Enter X,Y and Z values in the Offset
fields.

Offset values are expressed in a range
from 0 to 99999 Bryce units of
measure (refer to “Bryce Units” on
page 282 for more on Bryce units).
The default value is zero.

5. Enter X,Y and Z values in the Rotate
fields.

Rotate values are expressed as
degrees, with a range of 0 to 999. The
default value is zero.



6. Enter X,Y and Z values in the Scale
fields.

Size values are expressed as a
percentage of current size, with a
range of 0 to 9999%. The default
value is 100%.

-
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The Quantity value entered in this
dialog sets the number of duplicates
created when you use the Replicate

command.

- _-——-|_.h_____ -

Undoing Operations

The Undo and Revert to Saved
commands let you erase the effects of
changes you made to your scene.

To undo the last operation:

o Choose Edit menu> Undo, or press
Command-Z/Ctrl+Z.

To redo the last operation:

o Choose Edit menu> Redo.

To revert to the last saved version of
your scene:

o Choose File menu> Revert to Saved.

All unsaved changes are discarded.

The Marker Pen

The Marker Pen turns your screen into a
white board. When you're using the
Marker Pen, you can draw anywhere in
the Bryce environment without affecting
your scene. One key click erases all the
marker pen lines.

To draw with the marker tool:

1. Click the Marker Pen tool, or press
the M key.

2. Drag it anywhere on your screen.

To erase marker pen lines:

o Click the Marker Pen tool again, or
press the M key again.

"
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Saving and Closing

The Save command lets you save your
work in a convenient location for later
use. Since your scene files can quickly
become large and complex, you should
save your work often.

Saving Files

To save a file:

1. Chose File menu> Save. The Save
dialog appears.

2. Use the dialog controls to choose a

location for your work and click Save.

To save a file under a different name:

1. Chose File menu> Save As. The Save
dialog appears.

2. Enter a new name and/or location in
the fields provided and click Save.

3. Acopy of your work is saved, leaving
the original intact.

Bryce 3D Basics 41




If the PICT /BMP With Scene Open/
Save preference is selected, Bryce
saves both the scene data and the
rendered image when it saves the file.

Closing

When you close the application, a dialog
appears asking you to save your work.

¢V
To close Bryce:

o Choose File menu> Quit, or press
Command-Q/Ctrl+Q.
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Animation in
Bryce 3D
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Animation Overview

Animation is the process of adding a
fourth dimension to your scene—time.
To create an animation, you arrange a
scene then record your movements or
transformations of objects over time.
Bryce creates a motion path from your
recorded movements and then generates
an animation.

You can animate almost anything in your
scene:

+ the motion of objects, lights, and the
camera

» object size and shape
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+ object materials
+ terrain objects

*  sky properties

The Animation Process

Animation is a cooperative process
between you and Bryce. You set up the
arrangement of objects and scene
settings, and then you adjust those
settings over time. Bryce steps in and fills
in the gaps between adjustments. When
you play the animation, motion is
created.

The steps to creating an animation are as
follows:

+ Create objects using the Create tools
or the Terrain Editor.

+ Build a scene by arranging and
transforming objects, lights and
the camera.

*  Adjust the position, orientation or
scale of objects. Each time you make
an adjustment, you create a key event
which indicates a point where an
object property was changed.

+  Adjust the shape or placement of the
motion path.
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+  Adjust the speed at which the object
moves along the motion path using
the Advanced Motion Lab.

* Render the animation as a movie file.
You can render the animation as a
QuickTime/AVI movie file or as a set
of frames.

S
Animation Tools
Bryce 3D’s animation tools are designed

to help you quickly and easily animate the
properties of your scene.

Animation Controls

The animation controls let you record an
animation and preview it in the Working
Window. You can also use the controls to
change the current time or move to
different points in time.

Palette
Timeline controls
e ?I - 95'
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Time Dots  Animation Preview Key frame

controls controls

Use the animation controls to record and
preview your animation.

The Animation controls appears in three
areas in Bryce:

*  The Working Window
*  The Materials Lab
*  The Terrain Editor.

The tools have basically the same
function in each area. The only difference
is that controls in the editors let you
create key events for the properties
associated with the editor. This means
that in the Terrain Editor you can only
add key events for terrain objects, and in
the Materials Lab you can only add key
events for material properties.

The Timeline

The Timeline is a graphical
representation of time. The darker gray
area within the Timeline represents the
current length of your animation.

Timeline
|
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Working Area Current Time Indicator

The Timeline indicates the length of your
animation and the current time.




The colored section of the timeline
represents the length of the Working
Area. The Working Area can be used as a
visual guide to help you isolate portions
of your timeline. When you render the
animation you can choose to render the
entire timeline or just the Working Area.
This is also the only area that is previewed
when you use the animation preview
controls.

The Current Time indicator lets you
move to different points in time. This is
the main tool you'll use to create
animations. Every time you want to add a
key event, you move the Current Time
indicator to a different point on the
timeline.

Animation Preview Controls

The Animation Preview controls let you
move between the key frames in your
animation.

To Start Play To End

Previous Key frame Next Key frame

Use the Animation Preview Controls to move
between key frames in your animation.

The larger buttons move to the beginning
and the end of the animation. The
smaller buttons move to the next and
previous key frames.

Time Dots

The Time Dots let you save positions on
the timeline. You can use the dots to
quickly jump between areas of the
timeline you're working on.

Use the Time dots to quickly move between
saved positions along the timeline.

Key Frame Controls

The Key Frame controls let you add and
delete key frames from your animation.

Key frame Indicator
-
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Add Key frame Delete Key frame

Use the Key Frame controls to add and delete
key frames from the timeline.

The Key frame indicator is only active
when the current time is at a key frame.

The Add Frame button lets you add a key
frame. In Auto-Record mode, Bryce
automatically adds key frames for you,
but when you disable the mode, you'll
have to use this button to add key frames
at points in the timeline.

The Delete Key button deletes the
selected key event or a specific type of key
event. In the Working Window, deleting a
key event deletes all the frames at the
current time. In the editors the Delete
Key button only deletes key events for the
properties associated with the editor.

Animation Options

The triangle icon to the right of the
animation controls, displays Auto-Key
option menu. This menu lets you turn
the animation system on or off.

+ Auto Key
R Ticker Marks

Use the triangle icon to access the animation
options menu which lets you enable or disable
the animation system.

When the animation system is enabled,
every change you make to the scene is
recorded as a key event. Changes can
include things like moving an object,
changing a material, or changing the
shape of a terrain.
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When the animation system is disabled,
your changes are not recorded. To record
a key event you have to use the Add Key
Frame button. The animation system is
enabled by default.

Swap Button

The Swap button lets you switch between
the Animation controls and the Selection
palette.

Use the Swap button to switch between palettes.

Advanced Motion Lab Button

The Advanced Motion Lab button opens
the Advanced Motion Lab.

&

Use the Advanced Motion Lab button to display
the Advanced Motion Lab.
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The Advanced Motion Lab

The Advanced Motion Lab contains tools
that let you control the detailed
properties of your animation. You can use
the lab to view object hierarchies, remap
key events and adjust the position of key
frames on the timeline.

Time Mapping Curve Editor Preview Area

Hierarchy Area

Sequencer

The Advanced Motion Lab lets you control the
speed of objects along a motion path and the
placement of key frames on the timeline.

Hierarchy List Area

The Hierarchy List Area displays the
scene’s hierarchical structure, including
links, and groups. You can view all the
hierarchies expanded or just the parent

objects in the scene. You can also expand
an object’s listing to show all of its
properties.

The Sequencer

The Sequencer lets you see the key frames
recorded for each property within an
object. Each property has its own
timeline track. Key frames are displayed
as white marks on the timeline. The
current time is indicated by the Current
Time bar.

Hierarchy List Object Timeline

- Key frame

Current Time Bar

The Sequencer lets you control the placement of
key events on the timeline.



The Sequencer lets you see where in time
a change in an object’s property occurred
and edit the position of that event.
Different types of objects have different
properties.

Origin

Each Object listed in the Hierarchy List area can
be expanded to show the timelines of any
transformations applied to it.

A scene contains more than just objects.
You can expand the Hierarchy List to also
display the properties for your scene’s sky
and the camera.

The display buttons along the left side of
the hierarchy area let you hide or display
an object in the animation preview. This
can help you isolate objects in a complex
scene.

Use the display buttons to hide or show objects
in the animation preview.

Time Mapping Curve Editor

The Time Mapping Curve editor lets you
control the length of time between key
events. Each property listing in the
Hierarchy List has its own time mapping
curve.

The curve acts like a time filter which
remaps the time in your animation.
Depending on the shape of the curve, the
events in your animation may take longer
to complete, or may all occur very
rapidly.

A time mapping curve can speed up
events while slowing down others. You
can even reverse the action in your
animation. Refer to “Time Mapping
Curves” on page 367 for more on
working with Time Mapping Curves.

The Time Mapping Curve editor lets you remap
the time in your animation.

Preview Area

The Preview Area contains tools that let
you preview your animation.

Animation Preview

Preview VCR Controls

The Animation Preview area lets you see any
changes you make to the velocity of objects.

The Preview Area has three parts:

« The Animation Preview area displays
a wireframe preview of your scene.
Any changes you make in the Time
Mapping Curve editor or the
Sequencer are updated to this area.

+ The Preview VCR controls let you
play the animation like a movie. You
can stop, play, move forward one key
frame, or back one.
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+  The Preview Display Controls let you
zoom in/out of the preview, switch
between Camera View and Director
View, pan the preview and reset the
preview.

il
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Bryce 3D has several special features that
let you add extra effects to your
animations:

+ Time Mapping Curves

* Animating Transformations
* Animating Materials

* Animating Terrains

+ Animating Skies

Time Mapping Curves

Time Mapping Curves are graphical
representations of the time mapping
filter. The filter remaps the time in your
animation, so that the events that occur
at specific times in your animation occur
differently in actual time.
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By adjusting the shape of the curve, you
can control how fast events occur. When
you create a sharp jump in the curve, you
speed up the events in your animation.
When you flatten the curve, you slow
down key events.

Each property of your scene can have a
different curve, so you can have key
events occurring at different speeds.
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Refer to “Time Mapping Curves’-’ on
page 48 for more on Time Mapping
Curves.
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Animating Transformations

When you're in Auto-Record mode, every
transformation you apply to an object is
recorded as a key frame.

In the Hierarchy area you can see where
the key frames for these transformations
appear in the timeline. By moving these
key frames you can control the order in
which transformations are applied. For
example, you can take an object that
grows larger and then moves left, and
turn it into an object that moves left and
then grows. Several animation
techniques, like squash and stretch, can
be simulated using transformations.
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Refer to “Animating Transformations”
on page 48 for more on animating
transformations.
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Animating Materials

The Materials Lab has its own set of

animation tools that let you animate
material properties. You can animate
almost any property or texture.

When you're animating between textures,
Bryce interpolates between patterns and
colors over time. You can have a rocky
terrain turn into a desert during the
course of your animation.

* il e . ]
Refer to “Animating Materials” on
page 385 for more on animating
materials.
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Animating Terrains

The Terrain Editor has a set of animation
tools that let you animate a terrain over
time. You can animate the shape of the
terrain, or the filtering effects like Erosion
or Mounds.



Using these tools, you can create a terrain
that changes shape as time passes.

_,r‘_- = _-'--I-..__.___-_ 2o o
Refer to “Animating Terrains” on
page 393 for more on animating
terrains.
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Animating Skies

The Sky & Fog palette and the
Environmental Attributes dialog have a
number of controls that let you set the
properties of your environment. By
changing these properties over the course
of an animation, you can animate your
environment. For examples, you can
make clouds move, or gradually change
the time of day.

_,r"- = _-'---_.__l___-_ R o
Refer to “Animating Skies” on
page 389 for more on animating skies.
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Managing Your Project

Storyboarding

If you are attempting anything other than
a brief animation, it’s a good idea to
create a storyboard first. A storyboard is a
series of drawn images showing the key
actions in an animation. The storyboard
helps you quickly work out the
animations viewpoint, framing and
composition. Because you're just
sketching, it’s easy to make changes and
other arrangements. Your work on the
storyboard will give you an idea of the
types of objects you'll need to model and
how to arrange the scene.

You can make sample storyboards by
drawing a series of horizontal screen
outlines on a sheet of paper, usinga4to 3
aspect ratio (ratio of width to height).
Draw the screens as large as necessary,
and leave a block of space for the

narration or description. You can also
purchase cartooning storyboards at art
supply stores.

You can use a storyboard to help layout the
action in your animation.
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Simplifying Your Scenes

In general, the 3D scenes you create for
animation need not be as complex as a
typical illustration scene. The viewer’s eye
tends to be drawn toward motion and
foreground elements. Static objects and
background elements are scanned only
casually.

By reducing unnecessary detail, you can
reduce rendering times dramatically and
keep the size of your scene files
manageable. When preparing a scene for
animation, keep the following guidelines
in mind:

+ Refine your animation. Keep the
objects as simple as possible. Detail is
usually lost in an animation.

+  Use fewer objects, and limit the
number of reflective and transparent
objects.

¢+ Use the minimum number of lights
required to achieve an effect.
Additional light adds significantly to
the rendering time.

+ Limit the number of objects with
complex materials.
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+ If acomplex model remains in the
background for the duration of the
animation, try substituting a simpler
version.

+ If your camera view remains
unchanged for an entire scene,
consider rendering a still image with
just the scene’s background elements.
Then use this image as a backdrop
and animate only the foreground
elements. This technique requires
some planning to make sure that
shadows and transparent objects
don't give the “trick” away.

Rendering Without Compression

If you are not pressed for hard disk space,
it usually makes sense to render your
animation without compression. This
ensures that you'll have a high quality
copy of the animation to work with.

Working from your uncompressed
original, you can save copies,
experimenting with various compression
settings until you are satisfied with both
the image quality and playback rate.

An animation compressed multiple times
degrades significantly, so you should
always render without compression if you
intend to do any postprocessing in
another application.

Motion and Timing
Principles

As an animator, the most important skill
you can master is the ability to portray
motion convincingly, whether it is
intended to be realistic or exaggerated
and cartoonish. No matter how good a
3D modeler you are, the timing of the
events in your animation are of
paramount importance.

Many of the principles of timing and
motion developed by cell animators
apply to 3D animation with Bryce 3D as
well. Many of these principles apply
especially to character animation, but
most are useful for any subject matter.
For more information, you can refer to
one of the many excellent books on
cartoon animation.



Squash and Stretch

Squash and stretch are animator’s terms
for the exaggerated redistribution of an
object’s mass as it moves or shifts
positions. Squash and stretch portray the
qualities of elasticity and weight in a
character or an object.

Think of a bouncing rubber ball. As it
falls it stretches; as soon as it hits the
ground it is squashed. If the ball failed to
change shape, the audience would
interpret it as a solid, rigid mass.

You can accomplish squash and stretch in
Bryce 3D by transforming the object at
different points in time.

This ball’s bouncing motion is exaggerated by
deforming its shape so that it stretches as its

descending and squashes when it hit the surface.

Lag and Overlap

When an object moves from one point to
another, not everything has to move at
once. For true-to-life movement, action
that is secondary to the main activity can
lag and overlap. For example, when you
animate swirling curves, the cubes at the
top would swirl faster than those at the
bottom. In Bryce 3D, an object’s
hierarchy can be used to create these
effects.

Arc vs. Straight Line Movement

Character motion appears more realistic
if it follows an arc or curved path instead
of a straight line. Most objects affected by
gravity also follow curved, rather than
straight trajectories.

Bryce 3D’s motion paths can be used to
create any type of trajectory.

Secondary Motion

Secondary motion adds realism and
credibility to a scene. A character turning
his head to stare at something in disbelief
shouldn’t just turn his head; his jaw
should drop and his eyes should blink as
well. The viewer focuses on the main
action, but registers the secondary
motion as supporting it. Bryce 3D’s
Advanced Motion Lab gives you enough

control to manage even the finest details
of your animation, so you can add this
kind of secondary detail.

Exaggeration

Exaggerating an action emphasizes it,
making it more prominent. For example,
if intrigue is called for, have a character
sneak instead of walk.

If you want your animation to resemble
footage from a hand-held camera, give
your camera an exaggerated bobbing
motion. Virtually any type of action can
be exaggerated to get an idea across.

Timing

Timing is as important in animation as it

is in any dramatic form. Consider the b
difference between an abrupt stop and a B
gradual slowdown. Each conveys a el
completely different impression. In

general, a motion that continues at the el
same pace lacks interest and seems s
unreal. h

If you are trying to animate realistic
character action, act out the sequence
yourself, timing how long each pose is
held and how long each action takes with
a stopwatch.
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Timing is one of the most difficult aspects
of animation to master. The key events
you define at different points on the time
line need to be synchronized with those
that came before and those that follow.
Fortunately, you can use the interactive
nature of computer animation to
fine-tune your timing. Test your
animation frequently by previewing it in
the Working window or by dragging the
Current Time indicator back and forth
between key events. Adjust the event’s
position in the Advanced Motion Lab
until you're satisfied with the timing.
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Creating Objects
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Overview

Objects are the building blocks of your
Bryce world. They can be used as props,
to populate a scene, or add detail to
landscapes.

An object is the most basic item in Bryce.
Objects can be anything from terrains to
pebbles. In Bryce, there are several ways
of creating objects. Some objects use
unique editors, others can be created by a
simple one-step click.

There are two main tools for creating
objects. The Create palette, which
contains tools for creating objects with a
single click, and the Preset Objects
Library, which contains pre-made objects
you can add to your scene.
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Objects in the Scene

Every object in the scene has a bounding
box. The box acts like a visual guide that
tells you how much space it occupies in
3D space. It also provides access to a

series of tools that let you edit an object’s
attributes and placement.

An object’s bounding box lets you see how much
space it occupies in 3D space.

The buttons around the edges let you set
an object’s attributes.

The black points on the edges of the box
are called control handles. These handles
can be used to edit the object’s size and
orientation. As you pass your cursor over
the handles, it changes to display the type
of control you're selecting.
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When the cursor turns into letter, it
means that you’re over a constrain
handle. The handle will only move along
the axis indicated by the letter. For
example, if the cursor changesto ay, it
means that the handle will only move
along the Y axis.

If your cursor changes to a letter, it means that
you're over a constrained control handle.

Dragging this type of handle usually
distorts the shape of the object.

If the handle changes to a black square
with a right-angle, it means that the
handle can move in any direction, but the
object will be scaled proportionally.

If your cursor changes to a black box with a
right-angle, it means that you can use the
handle to proportionally scale the object.

The handle in the center of the object
represents its origin point. This point is
used as the center of rotation and scaling
for the object. Refer to “Transforming
Objects” on page 285 for more on
rotating and scaling objects.

The handle in the center of the object represents
its origin point. This point defines the object’s
center of rotation.

Control handles are used to edit the
object interactively. Refer to “Object
Origin Points” on page 286 for more on
using control handles.



To display an object’s bounding box:
1. Create an object.
2. Select the object.

Object Preview

When you create an object, it appears as a
wireframe in the Working window. The
wireframe represents the structure of the
object’s shape.

Objects appear as wireframes in the scene. The
wireframe gives you an idea of the object’s shape
and structure.

The wireframe preview lets you see how
an object looks as it’s being rotated or
animated without having to calculate and
render any complex surface properties.
The wireframe casts a shadow on the
ground plane below it. The shadow can

be used as a visual guide to help you
determine the object’s position in
3D space.

As you move the object it’s shadow follows it
along the ground plane. When you have a
number of objects, the shadows can help you see
its exact position in the scene.

If you move the object below the ground
plane, the portion of the object that’s
below ground is not drawn. This can help
you avoid placing an object outside the
view of the scene. Wireframe shadows do
not interact with light. These appear
regardless of the light sources in

the scene.

If you move an object below ground, the portion
of the wireframe that'’s below the ground plane is
not displayed in the scene.

- —————
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Both shadows and underground
wireframes are preview options that
can be turned on and off. Refer to
“Wireframe attributes” on page 24 for
more on these features.

il — -
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Object Preview Modes N | S S Shaded Preview

Besides wireframes, there are three other To display an object as a box: )
ways you view an object; Bounding Box, ] F i e ———
‘r.-’ Shaded Preview, and Rendered Preview. 1. Selectan object. This mode is only available if you have
;: 2. Click Object menu> Show Obiject as an OpenGL accelerator card in your
J Bounding Box Box. system.
If you haveal dyou find th or -
ITyou have a large scene and you find that Click the A icon that appears next to
it's taking too long to redraw the entire . . - . . .
; the object’s bounding box to display In this mode, objects appear as solids.
scene, you can change the display of the . . . ; i
; ; ; ; the Object Attributes dialog. The colors assigned to the object are also
objects so that only their bounding box is isible. Obi ‘ frected b
displayed. In the dialog, click the Show as Box 1o . oeect surtaces are eiectec by
9 light sources. Materials textures are not
button. visible in this mode.

To display an object as a wireframe:

i

f | 1. Select an object.

3 : 2. Click Object menu> Show Object as
ri . = Lattice.
! i1 or

| Click the A icon that appears next to
g : the object’s bounding box to display

4 The Show Object as Box preview mode displays the Object Attributes dialog.

the object using only its bounding box. In the dialog, disable the Show as Box
In the shaded preview mode you'll be able to see
b . button. et .
i You can move the box just as you would all the objects in your scene as solids.
an normal object. The box can also cast a
shadow.
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Rendered Preview

If you want to see what the object’s
surface looks like or how it is affected by
light gels, you'll have to render it.

The Nano-Preview shows you a small
preview of what the object looks like
rendered.

The Nano-Preview of the object shows you a
small preview of what the object will look like
when its rendered.

J._'__ __---_l___-__ _.‘u’.
Refer to “Using the Nano-Preview” on

page 30 for more on the
Nano-Preview.

o __-""---_.__________.,r

If you want to see the object at full size
you'll have to render it. Once it is
rendered, you can see the bitmap preview
of the object, using the Bitmap Preview
mode.

_.-r""_ __—--._-__-__ _.‘u_*
Refer to “The Rendering Procedure” on
page 400 for more on rendering and
“Display Modes” on page 23 for more
on Bitmap Preview mode.

o —_-""---..__________.,r

0

To see a full-sized preview of the object you'll
need to render the scene.

e ®

Primitives vs. Procedural
Objects

Bryce’s Create palette lets you create two
different types of basic object: Primitives
and Procedurals.

Primitives are basic geometric shapes
such as the sphere, cube, pyramid, torus,
cone, cylinder, plane and disk. These

shapes can be thought of as primary
geometric building blocks, from which
more complex objects are constructed.

This train is made up of primitive and primitive
derivative objects.

Primitives also have derivative groups
(such as the ellipsoid and squashed
sphere, which are derived from the
Sphere), which allow you to create
different shapes without having to
perform the transformations yourself.

Procedural objects are object that require
special constructions or “procedures” to
create. Procedures can include operations
such as preassignment of materials,
randomization of internal parameters or
assignment of light properties.
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This scene shows examples of procedural objects.

Object Placement

When you create a new object it can be
placed in your scene either at absolute
world center or at an arbitrary location
based on your current view. Object
placement is determined by your
preference setting. Refer to “To control
new object placement:” on page 22 for
more information.
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The Create Palette

The main tool for creating objects is the
Create palette. This palette provides
access to tools which let you create all the
object types available in Bryce.

Create Planes Create Primitives

Create Picture Objects
Create Lights

The Create palette provides access to tools you'll
need to create all the different types of object
available in Bryce.

The tools on the palette represent the
type of object they create. When you click
a tool, the object appears in the center of
the scene.

The name of each tool appears in the Text
Display area as you move your cursor
over it.

TWV"

Create
Stretched Pyramid

As you move the cursor over the tool in the
Create palette, its name appears in the Text
Display area.

To display the Create palette:
o Click the Create button at the top of
the Bryce window.

To use a Create tool:
1. Display the Create palette.

2. Click on the tool for the object type
you want to create.

The object appears in the working
window.

The Triangle icon next to the Create
button at the top of the Bryce window lets
you access the Preset Objects Library.



To open the Preset Objects Library:
o Click the Triangle icon next to the

Create button at the top of the Bryce
window.

h‘i

The Triangle icon next to the Create button
opens the Preset Objects Library.

The Object Attributes Dialog

The Object Attributes dialog lets you set a
number of properties that determine how
the object appears in the Working
Window.

The dialog is where you'll set up the
object’s name, size, orientation,
placement and display quality. It's most
often used to numerically transform the
object. When you're animating an object,
the dialog is used to control how the
object interacts with its motion path.
Refer to “Animating” on page 351 for
more on animating.
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The Object Attributes dialog contains controls
for setting the object’s name, scale, position, and
orientation.

The dialog is divided into three tabs:
General, Linking and Animation.

The General tab contains controls for
setting the object’s name and display
attributes and position. Refer to “Editing
Object Attributes” on page 312 for more
on using the dialog to edit objects.

The Linking tab contains controls for
setting up parent-child links and
tracking. Refer to “Linking Objects” on
page 305 for more on linking and
“Tracking Objects” on page 378 for more
on tracking.

The Animation tab lets you set the
properties of the object when it is
connected to a Motion Path. Refer to
“Motion Paths” on page 372 for more on
motion paths.

To display the Object Attributes dialog:
1. Select an object.
2. Click Object menu> Attributes.

or

Click the A icon that appears next to
an object’s bounding box.

Naming Objects

When you create an object, the first thing
you should do is assign a name to it. An
object’s name identifies it in the Working
Window.

You can select objects, by name, using the
Selection palette. The name can also help
you distinguish a specific object when
your scene contains more than one object
of the same type. Refer to “Selecting
Objects” on page 36 for more
information.

An object’s name is also used when you're

creating parent-child links and setting up
object tracking.
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To name an object:
1. Select an object.

2. Click the A icon that appears next to
its bounding box.

3. Enter a name in the Object Name
field.

a®

Creating Infinite Planes

An infinite plane object extends in all
directions out to infinity. When you
create a plane in Bryce it appears as a
finite plane to make it easier to position,
but when your scene is rendered the
plane extends infinitely in all directions.

Though procedurally these three infinite
planes are different, they are all
considered to be Infinite Planes for the
purpose of selecting with the Selection
tools.
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When you add a plane object it appears as a
finite object in the Working window.....

- s 4 o

to infinity

Water

Water planes are created just a bit higher
than ground level. That way, if you have
already created ground and terrains, you
can easily place a water plane into your
scene, and immediately see the terrains
peeking out from the water.

...but when you render the scene it extends out

To create a Water plane:

o Click the Water plane tool.

—
[
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Use the Water plane to add bodies of water to
your environment.

Once the plane appears in your scene
you can edit it like any other object.
Refer to “Editing Object Attributes”
on page 312 for more on editing
objects.

Water planes are created with a water
texture randomly chosen from the
Waters & Liquids Preset Materials
Library. You can change this material by
selecting a different preset or creating an
new material.
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To change the water plane’s Preset
Material:

1. Click the second Triangle icon at the
top of the Bryce environment. The
Preset Materials Library appears.

2. Choose a library and material then
click the OK icon.



Refer to “Using the Preset Materials
Library” on page 234 for more on the
Preset Materials Library.

Ground

Ground planes are created at ground
level. By default, all new scenes open with
an infinite ground plane.

To create a Ground plane:

o Click the Ground plane tool.

Use the Ground plane to add ground to your
environment.

Once the plane appears in your scene
you can edit it like any other object.

The Ground plane is created with a gray
color, as are all Bryce primitives. Once
you begin assigning textures to objects,
Ground objects (as well as all other
primitive objects) will inherit the texture
assigned to the previous object.

Cloud

Cloud planes are placed much higher in
your scene since they’re generally the
highest objects in your environment.

To create a Cloud plane:

o Click the Cloud plane tool.

Lar=,

Use the Cloud plane to add clouds to your
environment.

Once the plane appears in your scene
you can edit it like any other object.

Cloud planes are automatically assigned a
randomly chosen texture from the
Clouds & Fogs Preset Materials Library.
You can change this material by selecting
a different preset or creating a new
material.

To change the Cloud plane’s preset
material:

1. Click the second Triangle icon at the
top of the Bryce environment. The
Preset Materials Library appears.

2. Choose a library and material then
click the OK icon.

Infinite Slabs

An infinite slab is a plane object that has
depth. An infinite plane is a plane object
that has no depth. The plane has no effect
on objects above it or below it; an infinite
slab can affect objects within it.

For example, anything you place within
the slab’s depth will be affected by the
slab’s volume color.

Slabs are usually used to create water.

When you create a water slab, you create

water with realistic volume. This means

that if you sink an object into the water it

will be affected by the colors or textures .,
you assign to the slab’s volume.

In an infinite slab, the plane in the scene has
depth that affects the objects within it.
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The realistic look of a water slab depends
almost entirely on the material you assign
to it. The Volume color plays an essential
role in creating realistic water effects.
Refer to “Volume Color” on page 210 for
more on Volume Color and materials.

To create an Infinite Slab:

1. Click the plane tool and choose the
Water Slab icon from the popup.

Surface
|
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The popup that appears when you click the
Water plane tool lets you choose between an
infinite plane and an infinite slab.

2. Select the slab.

3. Click the A icon that appears next to
its bounding box. The Object
Attributes dialog appears.

4. Enter a depth value in the Size Y field
and click the OK icon.
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Creating Stones

The Stone object tool creates random,
organic Stone shapes that can be assigned
materials and positioned throughout
your scene.

To create a Stone Object:

o Click the Stone object tool.

>

o
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Use the Stone object tool to create randomly
generated stones.

Stones objects are polyhedron based, and
can be smoothed or unsmoothed using
the Polyhedron dialog. Refer to “Editing
Imported Polyhedrons and Stones” on
page 322 for more information.

Stones are assigned random textures
automatically from the Rocks & Stones
Preset Materials Library.

To change a stone’s preset material:

1. Click the second Triangle icon at the
top of the Bryce environment. The
Preset Materials Library appears.

2. Choose a library and material then
click the OK icon.

Since Stones are essentially clumps of
polyhedrons, they are highly dependent
on the textures assigned to them for their
realism. For example, if you assign a flat
texture with no bumpiness to a Stone, the
results won't be very Stone-like. Try to
assign rocky textures to stones. Refer to
“Using the Material Preview Area” on
page 234 for more on assigning textures.
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Creating Symmetrical
Lattices

A Symmetrical Lattice is a terrain object
that has a mirror image of itself fused at
its base. When you modify one half of the
lattice, the corresponding changes are
applied to the mirrored half.

The Symmetrical Lattice can be a great
timesaving tool. Instead of creating
symmietrical shapes by duplicating and
aligning two halves, you just need to edit
one half of a lattice and your object is
created for you. Symmetrical Lattices are
edited as Terrains, using the Terrain
Editor. Refer to “Clipping Terrains” on
page 190 for more information.

Many advanced types of objects can be
created using the lattice object. Any
object that’s symmetical can be created by
painting it’s shape in the Terrain Editor.

i
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The hair dryer in this example was created using
a symmetrical lattice object.

To create a Symmetrical Lattice:

o Click the Symmetrical Lattice tool.

Use the Symmetrical Lattice tool to create
symmetrical objects.
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Primitives are the primary geometric

building blocks in Bryce. You can create
spheres, toruses, cylinders, cubes,
pyramids, cones, discs, and 2D squares.

To create a geometric primitive:

o Click one of the primitive tools:

S L1

Creates spheres

Creates toruses

Creates cylinders

Creates cubes

Creates pyramids

Creates cones

Creating Objects
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Creates discs

Creates 2D faces

«
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By default all primitives are assigned
a flat gray color.

Derivative Primitives

Derivative primitives are primitive
objects whose shape is “derived” from
basic geometric primitives.

Derivative primitives were created so that
you could skip some of the editing
procedures on most of the basic
primitives. For example, instead of
elongating a cube to make it into a pillar,
you can just use the Stretched Cube or
Brickiod derivatives.
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To create a derivative primitive:

o Click one of the derivative primitives
tools available:

Sphere derivatives: Ellipsoid,
Squashed Sphere

Cylinder derivatives: Tuboid,
Stretched Cylinder, Squashed
Cylinder

Cube derivatives: Stretched
Cube, Brickoid

Pyramid derivatives:
Stretched Pyramid, Squashed
Pyramid

Cone derivatives: Stretched
Cone, Squashed Cone
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Creating a Pict Object

A Pict Object is a 2D picture that is
applied to a 2D finite plane. The object is
basically a picture on a frame. The Frame
is a 2D plane, meaning that it has no
depth. If you view it from the side, it
disappears.

Using a Pict Object is a quick way of
creating very complex-looking objects.
The only problem is that you can only
view them from one angle, so the front of
the Pict Object must always be facing the
camera.

The Alpha channel of the object can be
used to create transparencies in the Pict
Object.

This truck object was created using a 2D Pict
Object....



however, if you move the camera, the 2D nature
of the object is very obvious.

_l,.-"- - _H-‘____ o ‘-’
A good way of ensuring that your 2D
Pict Object always looks right is to have
it track the camera. Refer to “Tracking
Objects” on page 378 for more on
tracking.
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Alpha Channels and Pict Objects

The picture you use must have an Alpha
channel. Refer to “Alpha Channels” on
page 115 for more on Alpha channels.

The alpha channel of your Pict images
will allow you to specify visible and
invisible portions of your picture texture.

For example, you can clip out a picture’s The Pictures dialog appears:
background so that only the main object
in the picture is visible.

The Pictures dialog lets you select 2D images to
use as Pict Objects.

2. Click an image square to load an
This is what the car image looks like with and image.
without an alpha channel applied.

3. If the image you want is not in the
The shadow cast by the image will be in library:

the shape of the picture’s alpha channel . .
which gives a more realistic look. _CI'Ck th? Load button. The load
image dialog appears.

T — +  Use the dialog controls to locate
To create a Pict object: the picture you want to use and /i
1. Click the Pict Object tool. click Open. L
e o
or e

In another application, copy the
picture you want to use to the
clipboard.

A

Creating Objects 113



. EF

+  Access the Picture dialog and
click the Paste button.

The picture is loaded into the first

image box and its alpha channels are

loaded into the second box.

When you load a new picture into the Picture
dialog, the main image is loaded into the first
box its alpha channel is loaded into the second
box, and the combination is loaded into the
third.

You can invert the alpha channel by
clicking the Invert button.

»

4. Click the OK icon to exit the dialog.

Bryce creates a 2D plane and maps
the image onto it as a texture. The
Pict Object is created with the same
aspect ratio as the original picture.
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When you exit the picture dialog, the image is
mapped onto a 2D plane and placed in your
scene.

R e el

Working with Pictures

Pictures can be used in several ways in
Bryce. They can be used as 2D Pict
Objects or as components in materials or
gels.

When you use a picture as an object, it is
applied to a 2D plane and appears as an
object in the Working window. Refer to
“Creating a Pict Object” on page 112 for
more on creating 2D Pict Objects.

This is what a picture looks like when it is used
as an object.

When you use a picture as a material
component, the image is applied to a
material channel, where its values are
used to drive the value of the channel.
Refer to “Materials” on page 193 for more
on working with Materials.

This is what a picture looks like when it is used
as part of a material.



When you use a picture as a gel, the
image is placed in front of the light and
appears as a projection. Refer to
“Applying Gels” on page 349 for more
on gels.

Th8i is what a picture looks like when it is used
as a gel.

Alpha Channels

Every image contains a number of
channels that store data about the
makeup of the picture. For instance
channels can contain masks, colors, or
bump information.

The alpha channel of an image is its first
channel. The channel is a like a grayscale

map that accompanies an image, which is

used primarily as a “mask.” Areas in the
alpha channel that are white will be
ignored by the program as it computes

the picture (appearing transparent), and
areas that are black will be recognized
and computed (appearing opaque).

The most common use for alpha
channels is to mask the contours of a 2D
object, separating it from any unwanted
background information. For instance,
you may import a picture of a dog. If you
have created an alpha channel “mask”
describing the area of the dog as black
and the “non-dog” area as white, then
unwanted cats and mailmen in the
original Pict’s background will not be
seen in your rendered image.

In Bryce, Alpha channels are also used
when your picture is a component in a
material. In this case the alpha channel
can be used to determine everything from
the bumps in a material to how a surface
property is applied on an object. Refer to
“2D Textures” on page 215 for more on
using pictures in a material.

"#_,_— _"-I--.-_-_-__-__. ___,...ll‘"
If you want to use the picture in the
library for multiple purposes, you'll
need to make sure that all the pictures
have an alpha channel.

"'_,.;-— _-'_-'---._-_‘__-__._.‘ur

Without Mask

%

With Mask
This example illustrates how the Alpha channel
mask is used to eliminate the unwanted areas of
an image.
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The Picture Library

The Picture Library stores all the images
available in Bryce. The library can be
used to catalogue pictures and to import
pictures. You can store any number of
pictures in the library. The only limit is
your system’s memory.

There are two ways of accessing the
Picture Library. The method you use
depends on how you're going to use the
image.

To access the Picture Library from the
Create palette:

o Click the Pict Object tool. The library
automatically opens.

To access the Picture Library from the
Materials Lab:

1. Select an object.

2. Click the M icon that appears next to
the object’s bounding box. The
Materials Lab appears.

3. Click on one of the columns in the
grid to activate a component window.
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4. Inthe window, click the P button in
the bottom-left corner. A default
picture appears in the window.

5. Click the Pink button at the top of
the window. The Picture Library
appears.

To access the Picture Library from the
Light Editor:

1. Selectalight source.

2. Click the E icon that appears next to
the object’s bounding box. The Light
Editor appears.

3. Click the 2D Texture button at the
bottom of the editor. The library
appears.

Previewing Pictures

The three most prominent items at the
top of the library are the Pict, Alpha, and
Combined preview windows. The first
window displays the current picture, the
second window displays the alpha
channel associated with the picture and
the third displays the resulting picture
after the alpha channel is combined with
the picture.

RGB Image Alpha Combined

Channel Image

The three windows at the top of the editor
display the picture, its alpha channel and the
result of combining the two.

Picture Thumbnails

Below the three preview windows are the
picture thumbnails that display a small
preview of each picture in the library. The
grey thumbnails represent empty slots in
the library. When you load images, they
are added to the first available grey slot.

¥l | Ol RS *
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The thumbnails below the preview windows
represent all the pictures available in the library.

If there are a large number of pictures in
the library, you can use the scroll bar to
scroll through all the thumbnails.



To display an image in the library:

o Click on the picture’s thumbnail. The
picture, and its associated alpha
channel, appears in the three preview
windows at the top of the dialog.

Loading Pictures Into the Library

You can load pictures into the library to
create your own custom library. Pictures
can be loaded into any of the three
preview windows.

When you load a picture into the first
window, you're loading only the picture’s
RGB (Red, Green and Blue) color
information.

The picture loaded into the first preview
window replaces the currently selected
picture in the library, so you're replacing
a picture in the library with the picture
you're loading. If you want to add a new
picture to the library, you need to load it
into the Combined Image window.

When you load a picture into the second
window, you're only loading the picture’s
alpha channel.

The alpha channel determines which
portions of the picture are visible and
which are not. The areas of the picture
that are transparent appear as a
checkboard pattern.

When you load an image into the Alpha
Channel window, the black and white alpha
channel appears in the window.

Every picture should have an alpha
channel assigned to it. If the picture does
not have an alpha channel, the resulting
image appears completely opaque.

If there is no Alpha Channel, the image appears
completely opaque.

- —————
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If your picture doesn’t have an alpha
channel, you can copy the image from
the RGB Image window into the Alpha
Channel window. This way your picture
won't appear completely opaque.

_ ————
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The Alpha channel you load does not
have to necessarily match the image. You
can create some interesting clipping
effects by combining different alpha
channels and images.

In this example, the image was combined with a
different alpha channel to create a new clipping
effect.

When you load a picture into the last
preview window, the Combined Image
window, the entire picture is loaded into
the first empty thumbnail slot.
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To replace the RGB information in a
picture:

1. Click the thumbnail of the picture
you want to replace.

2. Click the Load button on top of the
RGB Image window. The Load dialog
appears.

The Load button displays the Load dialog which
lets you select a picture to load into the RGB
Image window.

3. Use the dialog controls to locate the
desired image and click Load.

The picture appears in the first
preview window.

To replace the Alpha channel
information in a picture:

1. Click the thumbnail of the picture
you want to replace.

2. Click the Load button on top of the
Alpha Channel window. The Load
dialog appears.
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3. Use the dialog controls to locate the
desired image and click Load.

The picture’s alpha channel appears
in the first preview window.

To load a new picture into the Library:

1. Click an empty picture slot in the
bottom of the library.

2. Click the Load button on top of the
Combined Image window. The Load
dialog appears.

3. Use the dialog controls to locate the
desired image and click Load.

The picture’s thumbnail appears in
the empty slot.

Copying and Pasting Pictures

Copying and pasting in the Picture
Library works differently for each of the
three image windows.

When you copy and paste into the first
window, you're only pasting RGB color
information, so if you copy an image
from the Combined window, only the
color information is pasted into the RGB
window.

As with loading, any changes you make in
the RGB Image window changes the
selected image.

When you copy and paste into the second
window, you're only working with the
Alpha Channel information, so any
image you paste into this window will
appear as an alpha channel image (i.e.
black and white). Any changes you make
in this window affect only the selected
image.

When you copy an image from the
Combined window the entire image is
placed on the clipboard. Depending on
where you paste it, only a portion of the
image may be used.

When you paste a picture into the
Combined window, it appears as a color
image with transparent and solid areas.
All pictures are treated as color. So if you
paste a picture copied from the Alpha
Channel window in this window, you'll
get an RGB representation of the alpha
channel image. As well, any image pasted
into this window creates a new picture
entry in the library. [zot verify]



To copy and paste RGB information in a
picture:

1. Click the Copy button below the RGB
Image window.

The Copy button places the contents of the RGB
Image window on the clipboard.

2. Click the Paste button below the
window where you want the RGB
image to appear.

+ If you paste the image into the
Alpha Channel window, it is
desaturated and used as an alpha
channel.

+ Ifyou paste it into the Combined
Image window, the RGB image
becomes a new entry in the
library.

To copy and paste Alpha Channel
information in a picture:

1. Click the Copy button below the
Alpha Channel window.

The Copy button places the contents of the

Alpha Channel window on the clipboard.

2. Click the Paste button below the
window where you want the Alpha
Channel information to appear.

+ If you paste the image into the
RGB Image window, an RGB
representation of the alpha
channel is placed in the window.

+ If you paste it into the Combined
Image window, an RGB
representation of the alpha
channel is placed in an empty slot
in the library [zot verify].

To create a new picture using RGB
color information only:

1. Click the Copy button below the RGB
Image window.

2. Click the Paste button below the
Combined window. The RGB
information is placed in an empty
slot in the library.

To create a new picture using Alpha
channel information only:

1. Click the Copy button below the
Alpha Channel window.

2. Click the Paste button below the
Combined window. The alpha
channel information is placed in an
empty slot in the library.
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Deleting Pictures

When you delete a picture, you remove
all the image information (including
color and alpha channel) from the
library.

To delete a picture from the library:

1. Click the thumbnail for the picture
you want to delete.

2. Click the Delete button above the
Combined window.

Inverting the Alpha Channel

When you invert an alpha channel all the
black areas become white and the white
areas become black. This means that all
the areas that were transparent now
become solid and vice versa.

To invert an alpha channel:

o Click the Invert button above the
Alpha channel window.

The Invert button swaps all the black and white
values in the alpha channel.
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Picture Lists

A Picture List is a file that contains a
group of pictures. A Picture list can be
used to store all the pictures used in a
given scene, or to store a series of pictures
you use most often.

- —————
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You should also use a picture Iis-t to
store any pictures you've used as part
of material.
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There are several Pict texture List files
provided as samples for your first
excursions. ZOT where?

To open a picture list:

1. Click the Open List button at the
bottom of the Picture Library. The
Open dialog appears.

2. Use the dialog controls to locate the
desired list and click Open. The
pictures in the list appear in the
library.

To save a picture list:

1. Click the Save List button at the
bottom of the Picture Library. The
Save dialog appears.

2. Enter a name for the list and click
save.

Name the list the same as the scene.
This way, you can easily find the list
that belongs to a specific scene.

Sl
Importing Objects
Bryce can open DXF, 3DMF and files
created in previous versions of Bryce.

To import an object:

1. Choose File menu> Import. The
Open dialog appears.

2. Bryce searches for available DXF or
3DMF files in any location and
display them within the dialog.

3. Select the file you want and click OK.



4. You can disable automatic format
checking, which can be very time
consuming in certain cases, by
clicking the checkbox.

Some Notes on Imported Files

There are almost as many types of DXF
files as there are applications that write
them. While DXF is the closest thing to a
“standard,” DXF files can be slow and
cumbersome. Bryce does a good job of
handling most any file it sees, but due to
the idiosyncrasies in the various types of
the format, some files may take longer
than others to load and results may be
inconsistent depending on the way the
original file was generated.

Bryce preserves logical groups and basic
colors assigned to imported objects. The
colors are not visible on the wireframes,
as that would conflict with Bryce’s
“Family” wireframe colors; but the colors
are evident when you render your file.
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The Bryce DXF and 3DMF Plug-ins
reside in the Plug-ins folder alongside
the Bryce application and Support Files
folder.
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Creating Boolean Objects
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A Boolean object is an object created by
combining two or more objects to form a
single object. Boolean objects are created
by performing Boolean operations on a
number of objects. You can perform three
types of Boolean operations in Bryce:
union, subtraction and intersection.

Bryce uses Object properties to perform
Boolean operations. Objects can be
Neutral, Positive, Negative or
Intersecting. When you combine these
objects in a group, the result is a Boolean
object.

Boolean operations do not have any effect
on Neutral objects. When you group a
neutral object with a Boolean object, no
Boolean operation is performed.

-1 @

Negative+Positive

Negative +Neutral

If you were to group a neutral object with a
Boolean object, both objects would remain
visible with no Boolean operation occurring.
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Neutral is the default object proZ)edy.
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Boolean Operations

Boolean Union is performed by grouping
two positive objects. The area that is
common to both object is removed,
creating a continuous object. For
example, when you group two positive
spheres, you get a kind of peanut shaped
object which is the union of the two
objects.
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Boolean union is performed by grouping two Boolean subtraction is performed by grouping a Boolean Intersection is performed by grouping a
positive objects positive object with a negative object. Positive object with an Intersecting object.
Boolean Subtraction is performed by Boolean Intersection is performed by Negative or Intersecting objects must
grouping a negative object with a positive combining an Intersecting object with a share space with at least one Positive
object. The area that is common to both Positive object. The area that is common object in the group to exhibit a Boolean
objects is subtracted from the positive to both objects becomes the only visible operation. If there is no common space,
object resulting in a positive object with portion of the group. Negative objects are invisible when
negative space. For example, when you rendered.

| ; group a positive sphere with a negative

 WRah one, the resulting object looks like a A group that contains an Intersecting

L‘\ sphere with a crater. object that does not intersect with any

other object in the group becomes
entirely invisible; this is because the
Intersecting object is intersecting with
nothing.
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You can build very complex objects by
compounding Booleans. Suppose you
wanted to create a flute. You would first
create the hollow tube by combining a
positive cylinder with a negative cylinder,
then create several negative spheres and
group those with the tube, creating a
simple flute.

To subtract one object from another:
1. Select an object.

2. Click the A button next to the object’s
bounding box, or press
Command-Option-E/Ctrl+Alt+E, or
choose Object menu> Edit

Attributes.
This sprinkler was created using compound The Object Attributes dialog appears.
Boolean operations.
Since Bryce performs Boolean ® Neufral
operations using object attributes, you ) Posilive
can adjust the shape of a Boolean object J Negative
by repositioning the objects in the group. 3 Intersect

You can edit objects within groups using
the Solo mode in the Selection palette.
Refer to “Selecting Objects” on page 36

Use the Object Attributes dialog to set an object’s
Boolean attribute.

for more. 3. Enable the Negative checkbox.
This simple flute was created by grouping a . . .
hollow tlﬁ)be with several negat%(/g Sph';reg- The final Boolean object appears only in 4. Move the negative object so that it
_ the rendered image or in the intersects another object.
By compounding more Boolean Nano-Preview. You won't be able to see 5. Make sure that the second object’s
operations on top of this simple flute you  the Boolean object in the Wireframe Boolean attribute is set to Positive.
could create even more complex objects. preview.

6. Select both objects and click the
G button next to the selection’s
bounding box.

When your scene is rendered, the
area where the two objects intersect is
removed from the positive object.
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To create an object that is the
intersection of two objects:

1
2.

124

Select an object.

Click the A button next to the object’s
bounding box, or press
Command-Option-E/Ctrl+Alt+E, or
choose Object menu> Edit
Attributes.

The Object Attributes dialog appears.

Enable the Intersecting checkbox.

Move the intersecting object so that it
intersects another object.

Make sure that the second object’s
Boolean attribute is set to Positive.

Select both objects and click the
G button next to the selection’s
bounding box.

When your scene is rendered, the
area where the two objects intersect
becomes the only visible portion of
the group.
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Creating Geometric Paths

A geometric path is an object that acts as
a motion path for other objects.
Geometric Paths do not render as objects.

You can think of these paths as railroad
tracks. Objects can move along the track
but the they can’t move off of it.

R

Objects attached to a geometric path can move
to any point along the path, but they can’t move
off it. So, their trajectory is controlled by the
shape of the path.

e e ——— — -
You can control how an object is
constrained to the path using the
options in the Object Attributes dialog.
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Geometric paths can be edited just like
you would any other object. You rotate,
position or scale the path using the tools
in the Edit palette. You can also edit a
path by dragging its control points. This

way can change the geometry of the paths
and so the trajectory of any object
attached to it.

Geometric paths are especially useful
when you creating motion animations, as
they can help you create predictable and
repeatable motion.

The other great thing about geometric
paths is that you can have more than one
object attached to it. This can be very
useful if you want a number of objects to
move along the same trajectory.

; -
You can attach multiple objects to the same

path. The motion of each object on the path is
constrained by the shape of the path.

Objects that are attached to the same
path can be animated at different rates.
So, if you can think of the objects as
different trains on the same track, some
trains are at the beginning of the track,
others are in the middle and some are at
the end. All the object attached to the
path will have the same trajectory.



All the objects attached to a path have the same
trajectory, but they can move at different rates.

For example, this snake is made up cylinders all
attached to the same path, but they’re moving a
different rates so it looks like the snake’s body is
slithering.

You can also align objects differently to
the same path. So object may appear to
tilt differently as they follow the same
trajectory.

Since geometric paths are objects, they
can also be attached to other paths. Some
very complex types of motion can be
created using this technique.

i
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For example, you can simulate the motion of the
solar system by attaching an object on a circular
path to circular geometric path.

The object on the circular path would act like a
moon orbiting around a planet which is also
orbiting around the Sun.

To create a geometric path:
o Choose Object menu> Create Path.

A default-shaped path object appears
in your scene.

To convert a motion path into a
geometric path object:

1. Select an object with a motion path.
2. Choose Object menu> Create Path.

A path object with the same shape as
the path you selected is created.

To link an object to a path:
1. Select the object you want to attach to
the path.

2. Move the cursor over the Link icon
that appears next to its bounding
box.

y

3. Drag the linking control handle from
the object to path object.
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Usmg the Presets Object
Library

IR TS

The Presets Object Library contains all
the Preset objects available in Bryce.
Objects in the library are either

3D models or geometric paths. Refer to
“Creating Geometric Paths” on page 124
for more on geometric paths.

You can place objects from the library

anywhere in your scene and edit them
just as you would any object.
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Library to your scene:

1. Click the Triangle icon next to the
Create button at the top of the Bryce
environment. The Object Preset
Library appears.

GETEE]  Bookean Lesson #1

Use the Preset Object Library to add 3D models
to your scene.

2. Click on a category name (Boolean
Objects, Mountains, Stones and
Trees, or Imported Objects) to switch
categories.

3. Click on the preset thumbnails to
view preset names and descriptions

Bryce 3D

4. Click the OK icon to add the selected
object your scene.

o~ _-l--._‘______ o i
The Create palette does not need to be
active for you to access the Object
Presets Library.
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You can also select presets in one
motion by dragging directly to the
desired preset and releasing the
mouse. You can also drag over the
category names to change categories,
into the category’s presets and then

release mouse.
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Adding and Deleting Preset
Objects

You can add a number of different types
of object you to the preset library:
Terrains, Boolean objects, compound
groups, geometric paths and DXF
objects. The preset will retain all Boolean,
grouping and textural properties of

the object.

1. Select the object you want to add to
the library.

2. Click the Triangle icon next to the
Create button at the top of the Bryce
window. The selected object appears
in the preview area of the Object
Preset Library dialog.

Bk Otjects [N
The object preview area displays the object you
selected.

3. Click a category name. The library
switches to the category you selected.

The new preset will be added to the
category you select.



4. Click the Triangle icon in the bottom
right corner of the object preview and
choose a view option from the menu.
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Use the Triangle icon at the bottom of the

preview area to display a list of preview options.

Normal is the default view of your
selected object.

Up Close displays a close-up of your
object.

Render With Neutral Sky displays
your object with a flat sky, instead of
the sky applied to your scene.

5. Set up the preview of the object:

+ Drag the preview area to rotate
the view of the object.

+ Hold down the Spacebar and
drag up, down, right, or left to
pan the object preview.

+ Hold down Command/Ctrl and
drag in the preview area to zoom
in and out of the preview.

6. Click the Add button at the bottom of
the dialog. The Add Obiject dialog
appears.

7. Enter a name for the new preset in
the Preset Name field.

8. Enter a description of the preset in
the Description field and click the
OKicon.

This name and description will
appear beneath the object preview
whenever the preset is selected.

‘F. _-—,_.._'__ — .- >
You can edit the name and description
of any preset at any time simply by
pressing the Tab key, or clicking on the
name or description.
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9. Click the OK icon. Your preset is
added to the first available space
within the current category.

To delete an object preset:

1. Click the Triangle icon next to the
Create button at the top of the Bryce
environment. The Preset Object
Library appears.

2. Click on the preset you want to
delete, or hold down Shift and select
a continuous series of presets, or hold
down Command/Ctrl and select a
discontinuous set of presets.

3. Click the Delete button at the bottom
of the dialog.

Importing and Exporting Preset
Objects

Importing and exporting presets is a
handy way to exchange custom presets
with other users.

To import a Preset object file:

1. Click the Triangle icon next to the
Create button at the top of the Bryce
window. The Preset Objects Library
appears.

2. Select the category into which you
want to import the file.

3. Click the Import button at the
bottom of the dialog. The file open
dialog appears.

4. Locate the file which you would like
to import and click Import.
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The contents of the file are placed
into the first available space in the
current category.

To export a Preset object file:

1.
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Click the Triangle icon next to the
Create button at the top of the Bryce
window. The Preset Objects Library
appears.

Select the category from which you
want to export presets.

Select the preset or presets you wish
to export.

Click the Export button at the
bottom of the dialog. The save file
dialog appears.

Enter a name and location for the file
and click Save. The file is saved as a
DXF object.
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Creating Skies
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Environments and Bryce 3D

A Bryce sky defines the virtual
environment of your scene. Unlike many
other 3D applications, Bryce’s virtual
environment is not merely a backdrop, it
is an infinite 3D representation of natural
environmental phenomena.

All the elements in your sky interact with
each other just like the they would in the
real world. Colors in your environment
interact with everything in your scene
just as they would in nature. For example,
red sunlight is invisible until it strikes an
object, then the object exhibits red
highlights. If it's a blue object, it takes on
a purple cast and so on.
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The colors in the sky change depending
on the position of the sun, and how much
moisture (Haze, Fog) is present in the
atmosphere. All this, plus natural
reflection, refraction, and more make
Bryce’s Sky & Fog palette responsible for
a great deal of the natural, or
supernatural, look and feel of Bryce
images.

The objects in your scene may look incredibly
realistic on their own...
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...bout when you add a sky, the scene becomes a
window looking out into a real world.

You can add even more realism to a sky
by enabling one of the many
environmental effects available for skies.
Using these effects you can create night
skies full of stars, or have a bright
rainbow streaking across the roof of your
world. One of the most spectacular
effects is the Volumetric World effect.
When this effect is enabled all the light in
your scene appears as visible rays. This is
similar to the effects of light shining
through clouds on a hazy day.

The other-worldly look of this spaceship landing
was created using Volumetric World.

Like any other scene setting, skies can be
animated. Any property of a sky can be
changed at different points along the
animation timeline. When the animation
plays, the sky property will appear to
change over time. Using this technique,
you can create a scene that changes from
day to night, or from clear to cloudy.
Refer to “Animating Skies” on page 389
for more on animating skies.
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The Sky & Fog Palette

The Sky & Fog palette is where you'll set
up the attributes of your environment.
The palette uses visual controls in the
form of thumbnails to help you see how
changing the value of an attribute affects
your sky.

Sky Mode
Shadow Intensity

Haze Intensity
Cloud Altitude
Cloud Coverage

Fog Height

Fog Color Cloud Color
Ambient Color Sky Dome Color
Sky Mode Options  Haze Color

The Sky & Fog palette’s thumbnails let you set
values for sky attributes.

The name of the control you're adjusting
appears in the Text Display area of the
Control palette. You can also use this area
to help guide you if you prefer numeric
precision.

L WL
Fog

Fog Color
The Text Area displays the name of a Sky & Fog
control as you pass the cursor over it. When
you're adjusting the setting of a controls, this
area displays its current value.

Each control has at least one color swatch
along the bottom of the thumbnail.
Theses swatches are used to set the color
for a given sky attribute, like cloud color
or fog color.

Next to the thumbnails are a series of
controls that let you set the frequency and
amplitude of clouds, the position of the
sun or moon and store sky properties.
There are no visual guides for these
controls but you can see their effects in
the Preview area.

Cloud Frequency
and Amplitude

Day/Night Toggle

Random Skies

Memory Dots

Sun Color Sky & Fog

Sun/Moon Position"')ptio"s

The set of controls at the end of the palette does
not have visual guides, but you can see their
effects in the Preview area.

Environmental Attributes dialog

The Sky & Fog options button provides
access to the Environmental Attributes
dialog. This dialog contains controls for
fine-tuning environmental effects like
clouds, rainbows, and sun and moon
rings.

The dialog contains three tabs:

* Sun & Moon contains controls for
positioning the sun and moon as well
as adding effects like rings and
horizon illusions.
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* Cloud Cover contains controls for
editing cloud textures and setting up
cloud animations.

+  Atmosphere contains controls for
rainbows, visible lights and color
blending.

Working with the Sky & Fog
palette

The Sky & Fog palette has several settings
that you can use to control how the
palette affects your scene and how the sun
tracks your camera view. You can also use
the palette’s memory dots to store
settings as you experiment with different
environmental attributes.

Using the Control Thumbnails

The thumbnails are visual guides, and
they are also used to set the attributes of
Sky & Fog effects.

To change the intensity of an effect:

o Drag to the left or right inside the
thumbnail to change the intensity of
the effect.
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To pick a color for an effect:

o Click the color bar below the
thumbnail. A color picker appears
and your pointer changes to an
eyedropper.

meanierh L
e

Click on the bar below the thumbnail to access
the color picker.

While the eyedropper is active, you
can select colors from anywhere in
your scene, or even different parts of
the interface.
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For more control after picking with the
color picker, try Option-click/Alt+click
to get Bryce’s second color editor,
switch to HLS mode and adjust
saturation or lightness (less saturated
colors can make for more realistic fog
and haze effects), or you can enter
numeric values if you need to precisely
match specific colors.
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Setting Palette Options

The Sky & Fog palette options let you link
the palette controls directly to your scene
and link your sun to the camera.

To link Sky & Fog attributes directly to

your scene:

o Click the triangle icon below the
memory dots at the right edge of the
palette and choose Choose Auto
Update from the menu.

When this option is enabled, every
change you make to the Sky & Fog
palette settings will start a render of
your scene with the new sky settings.

Note: Unless you have marqueed a
small region to be updated, every
change you make will begin a
completely new render.

To reset Sky & Fog palette settings to

their defaults:

o Click the triangle icon below the
memory dots at the right edge of the
palette and choose Reset Sky from the
menu



Saving Sky & Fog settings

The memory dots in the Sky & Fog
palette let you store your favorite

Sky & Fog settings. Using these dots you
can safely explore many Sky & Fog
configurations without losing your
favorite settings along the way. Memory
Dots appear along the right side of the
palette.

Use the Memory dots to store your favorite
Sky & Fog settings.

To save Sky & Fog settings:
o Inthe Sky & Fog palette, click on an
empty dot (empty dots are gray).

All the current Sky & Fog palette
settings are stored into the
selected dot.

To switch to a saved Sky & Fog setting:
o Click on a full dot (full dots are
turquoise.) The current settings are

replaced with the settings stored in
the dot.

An active dot will be turquoise with a
white point inside it.

To reset Sky & Fog settings to default:

o Inthe Sky & Fog palette, click the
uppermost memory dot. This dot
always appears full.

To delete a saved Sky & Fog setting:
o Option-click/Alt+click on a full
Memory Dot.

The uppermost dot cannot be
cleared.
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Memory Dots are not saved with the
file, so be sure to save your favorite
skies as presets before ending a Bryce
session.

P e

Randomizing Skies

Randomizing skies is a very powerful way

of exploring possibilities you may never .
find any other way. When you randomize ]
the sky all the settings in the palettes are ;
replaced by randomly generated values.

P

Click the Randomize Sky button to randomly
generate sky settings.

To randomize your sky:
o Click on the Randomize Sky Button.

Remember, you can always return to

the default settings by click on the

top Memory Dot. =
_ T
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Working with Sky Modes

The Sky modes act as the base of your sky.
The Sky modes control lets you set the
base colors and light tones for your
environment. There are four modes

available: Soft Sky, Dark Sky, Custom Sky
and Atmosphere Off.
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As you switch between the modes, the
thumbnail also changes to give you a
preview of what the mode looks like.

fadi Sy
Darier §iy
Cusiom Sky
Abmaephaere OfF

The four Sky modes control the base colors and
tones used to create your sky.

To select a sky mode:

o Click the Sky mode thumbnail to
cycle through the four modes, or

o Drag left or right inside the
thumbnail to cycle through the
modes, or

o Click the triangle icon next to the
thumbnail and choose a mode from
the menu.
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Sky Modes

Soft Sky is the default state of the sky. It
features softer shades of blue and lighter
tones.

Darker Sky is a darker version of Soft
Sky. It uses darker shades of color and
tones. This mode is good for creating

more brooding skies.

Custom Sky lets you choose your own
colors for the sky; this way you can create
some truly alien environments. When
this mode is selected, the standard
behavior of colors in the sky with respect
to sun position is disabled.

Horizon
Color

Solar
Halo Color

Sky Color

In Custom Sky mode you can pick your own
colors for the sky.

Atmosphere Off disables the standard
sky color behaviors, relative to sun
position, and uses a single color for the
sky. This mode is useful when you need
to render objects against a simple colored
(or black or white) background. The Sun
color still affects objects in this mode. If
you have red sunlight, for instance,
objects in your scene will reflect red light.

To set custom sky colors:

1. Click the triangle icon next to the Sky
Mode thumbnail and choose Custom
Sky from the menu. The thumbnail
changes to the Custom Sky control.



2. Click the Sky Color swatch and

choose a color from the color picker.

The Sky Color is the main sky color
in this mode, regardless of sun
position.

Click the Solar Halo Color swatch
and choose a color from the color
picker.

This is the color of the halo around
the sun.

Click the Horizon Color swatch and
choose a color from the color picker.

This color will in certain cases affect
your scene below ground level if you
have a haze setting of greater than
zero. It will also impact the color of
Stratus clouds near the horizon.

In most cases, this will be the least

obviously used color in your scene;
unless you are making outer space

scenes, in which case this could be

very useful for you.

To render objects against a plain
background:

1. Click the triangle icon next to the Sky
Mode thumbnail and choose
Atmosphere Off from the menu. The
thumbnail changes to the
Atmosphere Off control.

2. Click the Atmosphere swatch and
choose a color from the color picker.

3. Drag left inside the Haze control and
set the value to 0. This setting
eliminates the suggestion of a

horizon.
TR A SR
Setting Sky Attributes

Once you've selected a Sky mode you
have the basis for your virtual
environment. All the other atmosphere
effects you add later will interact with the
base mode. There are two other attributes
that affect how all the other effects will
appear: Shadows and Ambient color.

Shadows in Your Scene k

All the objects in your scene cast i
shadows. Using the Shadow control you

can set the intensity and color of all the y
shadows in your scene.

Shadow

Color
Use the Shadows control to set the color and
intensity of shadows in your scene.

Shadows=10

Shadows=90

As you change the value of the Shadow control,
the brightness of shadows changes.

The shadow control is not the only
control for shadows. The position of
shadows is dependent on the position of
the sun. Since the sky interacts directly
with objects in the scene, the color of the
sun also effects the color of shadows.

The object’s material properties also
effect the color of shadows.
Semi-transparent or transparent objects
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with a transparency color will change the

color of the object’s shadow. As well,
volume materials can dramatically
change the shape and color of shadows.

Use the Shadows control to set the color and
intensity of shadows in your scene.

- il _-‘_'-‘——_.___ R
By default, the Clouds in Bryce do not
cast shadows. If you want the cloud
layer to cast shadows on the ground
below, enable the Cloud Shadows
option. Refer to “Cloud Coverage” on
page 145 for more on this option.
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To set shadow intensity:

1. Display the Sky & Fog palette by
clicking the Sky & Fog button at the
top of the Bryce window.

2. Drag left or right inside the Shadow
control thumbnail. Dragging left
decreases the intensity and dragging
right increases it.

The cursor changes to a two headed arrow as
you drag over the control.

To set shadow intensity numerically:

1. If it’s not already visible, display the

Sky & Fog palette by clicking the text

item on the menu bar.

2. Click the triangle in the corner of the
palette and choose Edit Sky & Fog.
The Environmental Attributes dialog
appears.
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Use the Environmental Attributes dialog to set
sky attributes numerically.

3. Enter a value into the Shadow
field.This field governs the intensity
of shadows rendered in your image.
The range is 0 to 100%, and the
default value is 100%.



Ambient Color

The Ambient Color is the color of all the
light that surrounds the objects in your
scene. Light from the sun interacts with
ambient color to produce the color for
both highlights and shadows.

Ambient Color is used as the source color
for material Ambience. The Ambient
Color tints the surfaces of all objects in
your scene that have some level of
ambience. Any other color you apply to
the object’s surface is mixed with the
Ambient color to create the final surface
color. For example, if the Ambient Color
is red, any color you assign to an object’s
surface ambience is mixed with red.

Refer to “Ambience” on page 201 for
more on material ambience.

To set Ambient Color:

o Click the color swatch below the
shadow control thumbnail and
choose a color from the color picker.

For realistic effects, at noon, or in the
afternoon, ambient color should be a
little blue to get nice blue-ish
shadows. At dawn, you can set
Ambient Color to red or pink, and at
night you can set it to gray-blue.

b ‘._
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Adding Fog and Haze

Fog and Haze are two atmospheric effects
that can add realistic depth to your scene.
Fog can make objects appear to disappear
the farther they get from the camera.
Haze can add the illusion of a distant
horizon. The Fog and Haze controls in
the Sky & Fog palette let you control the
color and intensity of these effects.

Fog

Haze Intensity

Haze Color

Fog Color

Use the Fog and Haze controls to set the
intensity and color of Fog and Haze effects.

Fog

Fog can add an element of sensuality,
mystery, and even realism to your scenes.
It acts like a thin layer of cloud close to
the ground. Using Fog you can create the
illusion of depth without having to add
distant objects.

Fog can create a sense of depth in your scene In
this scene, the fog was used to add depth to the
road as it moves away from the camera. Notice
how the feeling of depth was created without the
addition of background objects.

You can set intensity, height and color

attributes for the fog.
e

W

Fog=10 Fog=90

For example, you can see how the fog changes in
these skies as the Fog value changes.

The fog acts as a global layer covering the

entire scene. Its color and intensity are
the same through the scene.
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To set the amount of Fog:

1. Display the Sky & Fog palette by
clicking the Sky & Fog text button.

2. Drag horizontally inside the Fog
thumbnail to increase or decrease the
amount of fog in your rendered
scene. Drag to the left to decrease the
amount of fog and to the right to
increase it.

To set Fog height:

1. Display the Sky & Fog palette by
clicking the Sky & Fog text button.

2. Drag vertically inside the Fog control
to increase or decrease the height of
your fog. Drag up to increase the
height and down to decrease it.

The height and amount values are
displayed in the Text area of the Control
palette as you drag.
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To set Fog color:

1. Display the Sky & Fog palette by
clicking the Sky & Fog text button.

2. Click the color swatch beneath the
Fog thumbnail and choose a color
from the color picker.

To set Fog attributes numerically:

1. If it’s not already visible, display the
Sky & Fog palette by clicking the text
item on the menu bar.

2. Click the triangle in the corner of the
palette and choose Edit Sky and Fog.
The Environmental Attributes dialog
appears.

3. Click the Atmosphere tab.

4. Enter avalue in the Fog field. This
field sets the amount of fog rendered
in your image. The range is 0 to
100%, and the default value is 0%.

5. Enter avalue in the Height field. This
field sets the height of fog rendered
into your scene, assuming there is a
value greater than zero in the Fog
field. The range is 0 to 100%, and the
default value is 0%.

Blending the Fog Color

Since the fog remains constant
throughout the scene, you may get some
odd looking results when you're creating
a sunset or sunrise. In these cases the sun
is very close to the ground plane where
the fog exists, so the fog should react to
the sunlight. The Blend with Sun feature
lets you create exactly this effect. As the
sun approaches the Fog, the color and
intensity of the fog changes to interact
with the color of the sun.

In this example, the Fog is linked to the sun so

you can see the changes in the fog color and
intensity as the sun gets closer to the horizon.

To link Fog color to the Sun controls:

1. If it’s not already visible, display the
Sky & Fog palette by clicking the text
item on the menu bar.



Click the triangle in the corner of the
palette and choose Edit Sky and Fog.
The Environmental Attributes dialog
appears.

Click the Atmosphere tab.

4. With the object selected, click the M

icon that appears next to its
bounding box. The Materials Lab
appears.

Click the Volume button at the top of

the lab.

6. Set up the values for channels in the
material. Refer to “Building
Materials” on page 232 for more on
creating materials.

4, Click the Blend with Sun button.

Make sure the Blend Fog button is
enabled.

6. Enter avalue in the Color field to set
how much of the fog color is blended
with the sun.

* Choose a cloud-like texture from
texture components. Stratus,
Cumulus or one of the
CloudBump textures work well.

In this example, fog only appears around the
base of the castle. This effect was created by
applying a volume material to a flattened sphere

to set the intensity of the fog color object.
when it's blended. «  Pay special attention to the Base

7. Enter avalue in the Luminance field

f- _-'---_._____-_ R o
This technique can also be used to
create visible smoke, or gas.
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Density channel as this sets the

To get the best effect, set both these
transparency of your fog.

fields to 100.
* You need to set a high value for

the Edge Softness channel to blur

the edges of the sphere object.
There may be times when you want to T 4R TR SRS 43 R 7. Click the OK icon to exit the lab
create localized pockets of fog. For this ' '
type of effect you you'll need to use an
object with a volume material applied to
it; this way the object looks like fog. The . .
area covered by the fog is then controlled 2= Click the Sphere tool. A sphere object
by the size of the object. A flattened appears in the scene.

sphere usually makes a good fog volume. 3. Squash and stretch the sphere, until it
is the desired shape. Refer to
“Transforming Objects” on page 285
for more on transforming objects.

Localized Fog

To create localized fog: 8. In the Working window, move the

object to the area where you want the
fog to appear.

1. Display the Create palette.
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Haze

Haze is the natural effect you see when a
plane (like the ocean) stretches out
towards the horizon. At this distant point
a different color appears over the horizon
and light becomes fuzzy.

Haze creates the illusion of a distant horizons. In
this scene, the haze is used to create the
distinction between the water plane and the sky.

The Haze control lets you set the intensity
and color of the Haze effect in your Bryce
scene.

With haze set to zero, your horizon will
have an unnaturally hard edge. Also note
that the Cloud Altitude control will affect
the height of this band of haze. The
higher the altitude of the atmosphere, the
wider the band of haze at the horizon.
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Haze=0 Haze=90

You can see how the haze changes in these skies
as the Haze value changes.
Haze is applied to the entire scene

equally. The haze always appears at the
horizon.

To set Haze intensity:

1. Display the Sky & Fog palette by
clicking the Sky & Fog button at the
top of the Bryce window.

2. Drag horizontally inside the Haze
thumbnail to increase or decrease the
degree of haze in your scene. Drag to
the left to decrease the amount of
haze and to right to increase it.

To set Haze intensity numerically:

1. If it’s not already visible, display the
Sky & Fog palette by clicking the
button at the top of the Bryce
window.

2. Click the triangle in the corner of the
palette and choose Edit Sky and Fog.
The Environmental Attributes dialog
appears.

Click the Atmosphere tab.

4. Enter avalue in the Haze field. This
field governs the amount of haze
rendered into your scene. The range
is 0 to 100%, and the default value is
4%.

w

To set Haze color:

1. Display the Sky & Fog palette by
clicking the Sky & Fog button at the
top of the Bryce window.

2. Click the color swatch beneath the
Haze thumbnail and choose a color
from the color picker.

Fog and Haze colors should be the same,
or almost the same. For realism, the haze
should be a little brighter and bluer than
the fog. At nighttime, you have less
illumination, so an effective nocturnal
haze color could be dark blue-gray.



Blending the Haze color with the Sun

Since the Haze always appears at the
horizon it should change color as the sun
sets or rises. The Blend with Sun feature
lets you simulate this effect. When the
two elements are linked, the haze color
and brightness change depending on the
position of the sun. This creates very
realistic looking sunsets.

In this example, the haze is linked to the sun.
You can see how the color of the horizon changes
as it gets closer to the sun.

When you're using this feature to creates
sunsets, you should choose the haze color
carefully so as to create a natural-looking
color scheme.

To link Haze to the Sun controls:

1. If it'’s not already visible, display the
Sky & Fog palette by clicking the text
item on the menu bar.

2. Click the triangle in the corner of the
palette and choose Edit Sky and Fog.
The Environmental Attributes dialog
appears.

Click the Atmosphere tab.
4. Click the Blend with Sun button.

Make sure the Blend Haze button is
enabled.

6. Enter avalue in the Color field to set
how much of the haze color is
blended with the sun.

7. Enter avalue in the Luminance field
to set the intensity of the haze color
when it’s blended.

8. To get the best effect, set both these
fields to 100.

Clouds in Bryce

There two kinds of clouds in Bryce:
clouds in the environment and cloud
planes.

Clouds you add to your sky interact with
the light in your scene. They can block
out the light of the sun and change the
color of the light that hits the objects in
the scene. These clouds are infinitely
distant so you cannot fly through the
clouds in the sky. If you want to have this
effect, use a cloud plane. Sky clouds can
also cast shadows on the ground below.

The clouds in this scene were created using
Cumulus clouds from the Sky and Fog palette.
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You can change the look of the clouds by
editing the texture used to create it. By
changing the texture you can alter the
shape and position of the clouds within
the sky.

Cloud planes are infinite planes that act
as objects in your scene. They cast
shadows and can interact with other
objects.

The clouds in this scene were created using an
infinite cloud plane. Using this type of cloud,
you can fly an airplane through the layer.

Both types of clouds can be animated.
The clouds in the sky can be animated by
changing their color, position or
frequency, and cloud planes can be
animated just like other objects. They can
also be animated using the Cloud Motion
controls. These controls let you set
parameters for automatically animating
clouds.
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Refer to “Animating Couds” on
page 391 for more on animating
clouds.
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Adding Clouds

The Sky & Fog palette provides several
controls that set the attributes of clouds
in your sky. The Cloud Coverage, Cloud
Altitude and Cloud Frequency and
Amplitude controls let you set the general
appearance of your clouds. The Cloud
Color sets the color of the clouds.

Cloud Frequency and Amplitude

Sky Dome Color Cumulus Color
Cloud Height

Use the cloud controls to set the attributes of the
clouds in your scene.

Cloud Cover

You can add clouds to your scene in five
easy steps:

+  Select the type of cloud

*  Adjust the cloud texture
+ Set the cloud coverage and color
+ Setcloud altitude

+  Set the frequency and amplitude of
clouds

Cloud Types

There are two types of clouds you can add
to your Bryce environment: Cumulus and
Stratus. Cumulus clouds are generally
found at lower altitudes and appear
thicker and fluffier.

-

The sky in this scene uses Cumulus clouds.



The Stratus appear at higher altitudes and
appear thinner and more wispy.

.
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The sky in this scene uses Stratus clouds.

To add Cumulus clouds to a sky:

1. If it’s not already visible, display the
Sky & Fog palette by clicking the
Sky & Fog button at the top of the
Bryce window.

2. Click the triangle in the corner of the
palette and choose Cumulus Clouds.

Cumulus clouds are thicker, darker
clouds at a lower altitude. These
clouds will take on tinges of Sunlight
color, Ambient color, or Cumulus
color.

To add Stratus clouds to a sky:
1. If it'’s not already visible, display the
Sky & Fog palette by clicking the

Sky & Fog button at the top of the
Bryce window.

2. Click the triangle in the corner of the
palette and choose Stratus Clouds.

Stratus clouds are bright white, thin,
clean clouds that appear at high
altitudes. These clouds are very
responsive to Sunlight color and Sky
Dome color, and less responsive to
Cumulus color or Ambient color.

-~ _-_'-'-l—-u______ -
You can also choose both cloud types,
or neither. Selecting neither cloud type

creates a clear sky.
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Editing Cloud Textures

Clouds in Bryce are created using a
procedural texture with a cloud pattern.
The color, position size, and pattern
within the texture determines the final
look of cloud in your sky. You can edit
this texture using either the

Environmental Attributes palette, or for
more complex editing, you can use the
Texture Editor.

The texture used for a clouds can come
from either the Bryce texture library or
you can create your own.

To edit cloud texture in the
Environmental Attributes dialog:

1. If it'’s not already visible, display the
Sky & Fog palette by clicking the
Sky & Fog button at the top of the
Bryce window.

2. Click the triangle in the corner of the
palette and choose Edit Sky & Fog.
The Environmental Attributes palette
appears.

3. Click the Cloud Cover tab.
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The Cloud Cover tab provides controls that let
you edit the textures that are used to create the
clouds in your scene. As you change a texture,
the texture preview updates.

4.

Click the Arrow icon next to the type
of clouds you want to edit.

-

The two edit arrows let you quickly choose
which texture you want to edit.

5.

144

Click the + or - Turbulence buttons
to increase or decrease the amount of
noise in the texture.

* Increasing the Turbulence
creates a more dense pattern
within the texture.

Click the + or - Complexity buttons
to increase or decrease the amount of
detail in the texture.
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* Increasing the Complexity
increases the complexity of the
patterns within the texture.

Click the Randomize button if you
want to choose a randomly generated
texture for your clouds.

Click the OK icon to apply your
changes.

To edit cloud textures in the Deep
Texture Editor:

1.

e

If it'’s not already visible, display the
Sky & Fog palette by clicking the
Sky & Fog button at the top of the
Bryce window.

Click the triangle in the corner of the
palette and choose Edit Sky & Fog.
The Environmental Attributes palette
appears.

Click the Cloud Cover tab.

Click the Arrow icon next to the type
of clouds you want to edit.

Click the Editor button. The Deep
Texture Editor appears.

The cloud texture and its
components appear in the
component windows.
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If you're not familiar with using the
Deep Texture Editor you may get some
very unpredictable results which may
result in clouds that don’t look much
like clouds. Before you start editing the
clouds texture you may want to refer to
“Textures” on page 239 for more
instruction on how to use the editor.

When you open a cloud texture in the texture
editor, you can see its components in the various
windows. You can use the editor’s tools to
completely redesign the texture or to alter the
existing texture.

6. If you want to add additional
turbulence to the cloud texture,
adjust the texture’s Noise:



* Click the Noise button at the
bottom of the editor. The Noise
control appears.

The Noise control lets you adjust the frequency
of the noise in any of the texture’s components.

+ Move the component indicator at
the top of the control to the
component you want to edit.

+  Adjust the Noise slider to
increase/decrease the frequency
of the noise in the texture.

7. If you want to change the colors of a
component, click one of the color
indicators in the component window
and choose a new color.

8. If you want to add more complexity
to the texture, adjust its Phase:

+ Click the Phase button at the
bottom of the editor. The Phase
control appears.

The Phase control lets you adjust the amplitude
of the phase in any of the texture’s components.

+ Move the component indicator at
the top of the control to the
component you want to edit.

+  Adjust the Phase slider to
increase/decrease the amplitude
of the phase.

9. If you want to change the pattern in
the texture, apply a filter;

+ Click the Filter button at the
bottom of the editor. The
Filtering control appears.

Clip aX+b
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The Filtering control displays a graphical
representation of the filter applied to your
texture. By changing the equation of the filter to
the value of the variables, you can change the
patterns within the cloud texture.

+ Move the component indicator at
the top of the control to the
component you want to edit.

+ Change the filter equation and
variable values to adjust the filter
applied to your texture.

* il _-__‘-L___-_ e
Filtering is a rather complex operation.
Try experimenting with different

equations and see what happens.
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10. Click the OK icon to exit the editor.

Cloud Coverage

Cloud Coverage controls the quantity of
clouds you can see in the sky. A high
coverage means that there is a very dense
cloud layer, and a low setting means that
there are very few clouds in the sky.

Cloud coverage also indirectly controls
the brightness of the environment. The
more cloud coverage you have in a sky,
the darker the environment, since less
sunlight can pass through the clouds.

Adjusting cloud coverage changes the
quantity of clouds but not the
frequency. You can think of it as
adjusting the volume on a radio
without changing the station.
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Cloud Coverage

Cloud Color

The Cloud Coverage control in the Sky & Fog
palette lets you interactively set the quantity of
clouds in the sky.

Cloud Coverage=10 Cloud Coverage=90
For example, you can see how the clouds change

in these skies as the cloud coverage value
changes.

To set cloud coverage:

1. Ifit's not already visible, display the
Sky & Fog palette by clicking the
Sky & Fog button at the top of the
Bryce window.

2. Drag left or right inside the Cloud
Coverage control thumbnail. Drag
left to decrease coverage and right to
increase it.

Bryce 3D

To set cloud coverage numerically:

1. If it’s not already visible, display the
Sky & Fog palette by clicking the
Sky & Fog button at the top of the
Bryce window.

2. Click the triangle in the corner of the
palette and choose Edit Sky & Fog.
The Environmental Attributes dialog
appears.

Click the Cloud Cover tab.

Enter a value in the Density field at
the bottom of the dialog.

 ow

Density  Height

Scale Amp.
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The De}\sity field controls the amount of clouds
in your scene. The range is 0 to 100%, and the
default value is 20%.

To set cloud color:

1. Display the Sky & Fog palette by
clicking the Sky & Fog button.

2. Click the color swatch beneath the
Cloud Coverage thumbnail and
choose a color from the color picker.

Cloud Altitude

The altitude of your clouds has a great
effect on the personality of your sky.
Higher altitudes will result in smaller,
more distant cloud formations, as well as
a thicker band of haze at the horizon.
Lower altitudes result in larger, more
languorous cloud formations and a
thinner band of haze at the horizon.

Cloud Altitude

The Cloud Altitude control in the Sky & Fog
palette lets you interactively set the height of the
cloud layer in the sky.

Cloud Altitude=10 Cloud Altitude=90

For example, you can see how the clouds change
in these skies as the cloud altitude value changes.

There are two things to remember when
working with this control. First, the
Cloud Altitude will affect the size of your
Haze band, if you have a haze setting
greater than zero. The higher the altitude,



the wider the haze region will be on the
horizon. You can use this interaction to
your benefit.

Second, remember to lower your altitude
setting if you are creating a nighttime
scene. Since high altitudes increase the
size of the horizon Haze region, the sky
will be too unnaturally bright for realistic
night scenes.

To set cloud altitude:

1. If it’s not already visible, display the
Sky & Fog palette by clicking the text
item on the menu bar.

2. Drag horizontally inside the Cloud
Altitude control thumbnail. Drag left
to decrease altitude and right to
increase it.

To set cloud altitude numerically:

1. Display the Sky & Fog palette by
clicking the Sky & Fog text button.

2. Click the triangle in the corner of the
palette and choose Edit Sky & Fog.
The Environmental Attributes dialog
appears.

3. Click the Cloud Cover tab.

4. Enter avalue in the Height field at the
bottom of the palette.

Density  Height

2o | e
Scale Amn.
The Height field controls the height of the clouds
in your scene. The range is 0 to 999, and the
default value is 3.

Sky Dome Color

The Sky Dome color lets you create a
color wash over your scenes, even if there
is no sunlight present. This color
simulates the natural effect that occurs
when you have color in the sky even
though the sun has set. Sky dome color is
a great way of creating late afternoon or
evening scenes.

Sky Dome Color

The Sky Dome Color control in the Sky & Fog
palette lets you choose a color from either the
color picker or the color dialog.

- e
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For late afternoon and early evening
realism, try using a touch of orange or

yellow. This will create a cast of color

over your entire scene, regardless of
the position or color of the sun or
moon.

- B
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To set Sky Dome color:

1. If it's not already visible, display the
Sky & Fog palette by clicking the text
item on the menu bar.

2. Click the color bar beneath the Cloud
Altitude control thumbnail and
choose a color from the color picker.

Frequency and Amplitude

The Frequency and Amplitude control
lets you set the types of cloud formation
you'll see in your sky. By combining these
two controls you can change your clouds
from light and fluffy to dark and
brooding.

Use Frequency and Amplitude to control the
types of cloud formations in your scene.

Creating Skies 147

3




Frequency

Amplitude

This graph shows the effects of different
Frequency and Amplitude settings on a sky.
Frequency values range from 2 at the top to 150
at the bottom. The Amplitude values range from
50 at the left to 500 on the right.

2.

In the Cloud Frequency and
Amplitude control, drag horizontally
to control the frequency of your
cloud formations.

Drag left, and the “spikes” will get
closer together, resulting in smaller
formations. Drag right for larger,
more luxurious formations.

e

The Text Display area shows you the
numerical value of the amplitude as
you drag

e

3. Drag vertically to control the

amplitude of your cloud formations.

Drag away from the horizontal
center, and the spikes increase in
height, resulting in formations with
harder edges. Drag toward the
horizontal center for softer-edged
formations.

everything that was previously clear
sky will be clouds, while everything that
was cloud will be clear sky.

N .

To set Frequency and Amplitude
numerically:

1.

If it’s not already visible, display the
Sky & Fog palette by clicking the text
item on the menu bar.

Click the triangle in the corner of the
palette and choose Edit Sky & Fog
from the menu. The Environmental
Attributes dialog appears.

Click the Cloud Cover tab.
Enter a value in the Scale field.

ZLII él

Scale  Amp.

The Scale field controls the frequency (scale) of

cloud formations in your scene. The range is
-200 to +200, and the default value is 25.

e,

To set Cloud Frequency and Amplitude:

1. Display the Sky & Fog palette by
clicking the Sky & Fog button at the
top of the Bryce window.
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Note: It is possible to invert the spikes.
This means that you can exchange
positive and negative spaces in your
sky. If you invert the amplitude,



5. Enter a value in the Amplitude field.

u -
Zoale Amp.
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The Amplitude field controls the amplitude

(edge softness) of clouds in your scene. The range
is -500 to +500, and the default value is 100.

Linking Clouds to the Camera View

If you move the camera view during an
animation, the clouds in your
environment will appear to zoom by,
creating a kind of time-lapsed effect. If
you want the clouds to appear fixed as
you move the camera, link the cloud in
the sky to the camera view. This way,
wherever the camera moves the clouds
will follow, so that they seem to remain
stationary.

To link clouds to view:

1. If it’s not already visible, display the
Sky & Fog palette by clicking the text
item on the menu bar.

2. Click the triangle in the corner of the
palette and choose Edit Sky & Fog
from the menu. The Environmental
Attributes dialog appears.

3. Click the Cloud Cover tab.

4. Click the Link Clouds to View
button.

Refer to “Animating Skies” on
page 389 for more on animating
skies.

Using a Fixed Cloud Plane

As you move higher up in a Bryce
environment, the cloud pattern shifts, so
that it appears as if you're getting closer to
the clouds. If you want to counter this
effect, you can use the Fix Cloud Plane
option to freeze the cloud pattern so that
it doesn’t change as you move higher up
in the environment.

To use a fixed cloud pattern in your sky:

1. If it'’s not already visible, display the
Sky & Fog palette by clicking the text
item on the menu bar.

2. Click the triangle in the corner of the
palette and choose Edit Sky & Fog
from the menu. The Environmental
Attributes dialog appears.

3. Click the Cloud Cover tab.
4. Click the Fixed Cloud Plane button.

"
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Working with the Sun

The sun is the source of all natural light
in your scene. Its attributes have a
profound effect on the look of your scene.

The color of the sun affects all the colors
of all the object in the scene; Sunlight
color tints all the other visible colors.

The position of the sun controls the time
of day in your scene. If the sun is above
the horizon, it is day; if it is below, it is
night, and if it is at the horizon, it is
sunrise or sunset.

The sun can be animated just like all the
other elements of your Bryce scene. You
can create time-elapsed effects by
changing the position of the sun over the
course of an animation. Refer to
“Animating Sun or Moon Position” on
page 392 for more on animating the Sun.
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Positioning the Sun

The sun position control sets the
direction your natural light is coming
from whether it is sunlight or moonlight.
The position can be set using the Sun
control in the Sky & Fog palette. The
control works like a trackball, with the

sun at one end and the moon at the other.

The control works like a trackball. As you drag
over the control both elements move in the
direction you drag.

You can think of the control as a compass:
if the highlight on the Sun Control sphere
is positioned at 12 o'clock, the light
comes from the north, and so on.
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As you change the position of the sun, the “time
of day” changes. When the sun position is closer
to the edges of the control, the sun appears closer
to the horizon, making the scene darker.

When the sun is in the center of the control, the
sun shines from directly above the sun, like it
would at high noon.

The colors in your sky will change
depending on the position of the Sun
Control, or the “time of day...” just like in
the real world.

The angle of the shadows changes as the
sun changes. If your object is shiny, and
there are no other light sources, the
position of the sun controls where the
highlight appears.

In this example, you can see the effects of the

sun’s position on several reflective and shiny
objects.

Day and Night

Your sky always contains two heavenly
bodies: the sun and the moon. There is
always one body visible in your sky. At
night it is the moon and in the day its the
sun.

The two bodies are connected and always
remain at opposite ends of the sky. As you
move the sun you're also moving the
moon. This means that when the sun dips
below the horizon in front of you, the
moon is rising behind you.



The link between the sun and the moon can be
seen by positioning the sun at the horizon in
front of the camera...

.if you turn the camera 180° you'll see the moon
just rising over the horizon as well.

To switch between night and day:
1. Display the Sky & Fog palette.

2. Click the Day/Night toggle button in
the top-left corner of the sun position
controls.

Sunrise/Sunset

You can create a sunset or sunrise by
positioning the sun or moon so that it is
visible on your horizon.

=

Sunsets or sunrises can be created by moving the
sun closer to the horizon.

The colors in the sky automatically
change to create the illusion of the
sunrise or sunset colors. You can also use
the Sky Dome color to give your sunset/
sunrise added color.

For a more realistic sunset you may want
to link the fog and haze to the sun so that
they react to the sun color as it
approaches the horizon. Refer to

“Blending the Fog Color” on page 138
and “Blending the Haze color with the
Sun” on page 141 for more on this
feature.

You may also want to enable the Horizon
illusion for the sun. This feature makes
the sun appear larger as it approaches the
horizon. Refer to “Sun/Moon Horizon
Illusion” on page 157 for more on this
effect.

To position the sun manually:

1. Display the Sky & Fog palette by
clicking the Sky & Fog button at he
top of the Bryce window.

2. Drag the larger highlight area in the
Sun Position controls to the position
where you want the light to originate.

- - _-l—--_‘_____ R o
You can position the sun, or the moon,
on the horizon as you like by nudging
the Sun Control until the light is visible
in your scene.

o e L
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To position the sun numerically:

1. Display the Sky & Fog palette by
clicking the Sky & Fog button at he
top of the Bryce window.

2. Click the triangle in the corner of the
palette and choose Edit Sky & Fog.
The Environmental Attributes palette
appears

Click the Sun & Moon tab.

4. Inthe Numerical Sun Values fields,
type a value into the X field. The X
field controls the east-to-west
position of the sun. The range is -99
to +99, and the default value is 60.

5. Enter avalue into the Y field. The Y
field controls the height of the sun
relative to your scene. The range is
-99 to +99, and the default value is
20.

6. Enter avaluein to the Z field. The Z
field controls the north to south
position of the sun. The range is -99
to +99, and the default value is zero.

~ R
= g

Positive values are above the horizon,
negative values below.
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Linking the Sun to the Camera

Normally, you'd have to reposition the
sun every time you changed the camera
to maintain a certain effect or sunlight
angle. However, if you apply the Link Sun
to Camera, you're sun will track the
camera. The position of the sun relative
to the camera remains the same no
matter where the camera is positioned.
This way you can set up the sun position
once and then not worry about losing the
effect as you move the camera.

4

When the sun is linked to the camera, the sun
moves relative to the Camera. Wherever the
camera moves the sun follows. As it moves, the
sun maintains a constant distance from the
camera.

This feature can also be very useful when
you're animating your scene. Refer to
“Animating” on page 351 for more.

To link the sun to the camera:

1. Display the Sky & Fog palette by
clicking the Sky & Fog text button.

2. Click the triangle in the corner of the
palette and choose Edit Sky & Fog.
The Environmental Attributes palette
appears.

Click the Sun & Moon tab.
4. Click the Link Sun to View button.

When this option is enabled, your
sun will always remain in the same
position relative to the camera.
Wherever you move the camera the
sun will follow. This is an easy way of
seeing how a sunset will look against
different skylines.

Sun Color

Light in nature is not usually visible until
it strikes an object. When you're using
normal light, a purple sunlight color will
not paint your entire sky purple, but
objects in your scene will reflect purple.
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When you're using Visible World,
choosing purple will paint your entire
scene purple.
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The grayscale bar at the bottom of the
color palette lets you set the intensity of
the sun. Black turns the sun off and white
sets the sun to its brightest intensity.

You can also use the color palette to set the

intensity of the sun. Black represents the lowest
intensity and white the highest.

To set the Sun Color:

1. Display the Sky & Fog palette by
clicking the Sky & Fog text button.

2. Click the Sun Color swatch and
choose a color from the color picker.

Disabling the Sun

You can also remove the sun from the sky
altogether, by disabling it. When the sun
is disabled, the only light visible in your
scene comes from individual light
sources.

To disable the Sun:

1. Display the Sky & Fog palette by
clicking the Sky & Fog text button.

2. Click the triangle in the corner of the
palette and choose Edit Sky & Fog.
The Environmental Attributes palette
appears

Click the Sun & Moon tab.
4, Click the Disable Sun/Moon button.

il
Working with the Moon
The moon is the most prominent object
in the night sky. In a night scene it
provides all the natural light in the
environment. Like the sun, the moon’s

attributes can greatly affect the final look
of your scene.

Its position in the sky effects all the angles
and intensities of all the shadows in the
scene.

The brightness is affected by the
illumination reflected of the earth. The
brighter the earthshine, the brighter the
moon appears.

Unlike the sun, the moon has phases
which simulate the effects of the earth’s
shadow passing over the face of the moon
during a month.

The moon’s position and phases can be
animated using the Animation controls
and the timeline. Refer to “Animating
Sun or Moon Position” on page 392 for
more on animating the moon.

Positioning the Moon

The moon is positioned at the same time
as the Sun. The two are always at opposite
ends of the sky, so wherever the sun is

positioned, the moon is directly opposite.

In the Sun/Moon control on the Sky &
Fog palette, the moon’s position is
represented by the smaller highlight
portion of the Sun Position trackball.
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The position of the moon is represented by the
smaller highlight portion of the position control
trackball. You can position the moon by either
moving the smaller highlight or by dragging the
sun. The moon is always opposite the sun.

To position the moon manually:

1. Display the Sky & Fog palette by
clicking the Sky & Fog button at he
top of the Bryce window.

2. Drag the blue highlight area in the
Sun/Moon Position controls to the
position where you want the light to
originate.

- ——
-
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You can position the sun, or the moon,
on the horizon as you like by nudging
the Sun/Moon control until the light is
visible in your scene.
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To position the moon numerically:

1. Display the Sky & Fog palette by
clicking the Sky & Fog button at he
top of the Bryce window.

2. Click the triangle in the corner of the
palette and choose Edit Sky & Fog.
The Environmental Attributes palette
appears

Click the Sun & Moon tab.

4. Inthe Numerical Sun Values fields,
type a value into the X field. The X
field controls the east-to-west
position of the sun/moon. The range
is -99 to +99, and the default value is
60.

*  The moon will be positioned exactly
opposite these values, so you can
invert them to position the moon
numerically, or place the Sun behind
the camera so that the moon appears
in front of it.

5. Enteravalue into theY field. The Y
field controls the height of the sun/
moon relative to your scene. The
range is -99 to +99, and the default
value is 20.

6. Enter avalue in to the Z field. The Z
field controls the north to south
position of the sun/moon. The range
is -99 to +99, and the default value
is zero.

- ——
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Positive values are above the horizon,
negative values below.
-~ R



Moon Phases

The moon phases control simulates
different aspects of the moon as it orbits
the earth.

The change in the phases of the moon can
indicate the passage of time.

The moon phase is a visual cue at to the
time of the month. In an animation, you
can use the moon phase to simulate the

passage of a time. Refer to “Animating

Sky & Fog settings” on page 390 for more.

The phase is controlled using the Moon
Phase controls in the Environmental
Attributes palette.

To set the moon’s phase:

1. Display the Sky & Fog palette by
clicking the Sky & Fog button at he
top of the Bryce window.

2. Click the triangle in the corner of the
palette and choose Edit Sky & Fog
from the menu. The Environmental
Attributes dialog appears.

Click the Sun & Moon tab.

4. Drag over the Moon Phase control.
The phase changes as you drag.
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The Moon Phase control lets you set the phases
of the moon.

5. Click the OK icon to exit the dialog.

Moon Brightness and Sharpness

The moon is directly affected by the light
reflected from the earth. The brighter the
reflection, the brighter the moon’s
shadow. In Bryce this effect is controlled
by the Earthshine setting which makes
the moon brighter or darker.

A realistic moon does not have sharp
edges and may appear blurry on hazy
nights. The Softness control lets you set
the moon'’s edge softness to give a more
realistic feel.

To set the brightness of the moon’s
shadow:

1. Display the Sky & Fog palette by
clicking the Sky & Fog button at he
top of the Bryce window.

2. Click the triangle in the corner of the
palette and choose Edit Sky & Fog
from the menu. The Environmental
Attributes dialog appears.

Click the Sun & Moon tab.

4. Drag over the Earthshine control.
Drag left to increase the brightness
and right to decrease it.

a lII Earthahine

The Earthshine control lets you adjust the
brightness of the moon.

* Enter a value in the Earthshine
field to set Earthshine
numerically.

5. Click the OK icon to exit the dialog.
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To set the moon’s edge softness:

1. Display the Sky & Fog palette by
clicking the Sky & Fog button at he
top of the Bryce window.

2. Click the triangle in the corner of the
palette and choose Edit Sky & Fog
from the menu. The Environmental
Attributes dialog appears.

Click the Sun & Moon tab.

4. Drag over the Softness control. Drag
left to soften edges, or right to
sharpen them.

&1 Soffness

The Softness control lets you set the edge softness
of the moon.

+ Enteravalue in the S field to set
Softness numerically.

5. Click the OK icon to exit the palette.

i T
Adding Environmental

Effects

The elements in a sky aren’t constant; it is
always changing, reflecting weather
patterns or the time of day. If it rains
there’s a rainbow. If its night, there’s stars.

IR IR
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If it’s sunset, the sun looks bigger. If you
look right at the sun on a hazy day you'll
see rings around it. Sometimes, if its hazy
enough you can even see the sunlight
streaking out of the clouds. All these
illusions are called environmental effects
and Bryce’s Environmental Attributes
palette lets contains all the controls you'll
need to the add them to your scene.

Sun/Moon Rings

If you look directly at the sun on a hazy
day you'll be able so see rings
surrounding it. These rings are created by
the reflection off of ice particles in the air.
In Bryce, you can use the Sun/Moon
Rings to create this effect.

In this example, rings have been added to the
sun to make the scene look like a sweltering
desert.

This effect creates concentric circles
around the image of the sun or moon.
Using the Environmental Attributes
palette, you can set the radius of the rings
and add a secondary ring to increase the
effect. The color of the rings is controlled
by the color of the sun/moon.

1. Display the Sky & Fog palette by
clicking the Sky & Fog button at he
top of the Bryce window.

2. Click the triangle in the corner of the
palette and choose Edit Sky & Fog
from the menu. The Environmental
Attributes dialog appears.

Click the Sun & Moon tab.
4. Click the Rings button.

5. Inthe Rings area, enter a value in the
Intensity field to set the brightness of
the ring.

intensity

The Intensity field next to the rings preview sets
the brightness of the rings.



6. Enter avalue in the Radius field to set
the radius of the ring.

S0 Radius

The Radius field next to the Rings preview sets
the radius of the ring.

To add a secondary Sun/Moon ring:

1. Display the Sky & Fog palette by
clicking the Sky & Fog button at he
top of the Bryce window.

2. Click the triangle in the corner of the
palette and choose Edit Sky & Fog
from the menu. The Environmental
Attributes palette appears.

Click the Sun & Moon tab.

4. Click the Secondary Ring button in
the Rings area.

Sun/Moon Horizon lllusion

If you've ever watched a sunset, you
probably noticed that the sun appeared to
get larger as it approached the horizon.
The same is true for the moon. At certain
times of the month it appears huge. This
illusion can be simulated using the
Horizon illusion.

The spooky look of this night scene was created
by applying a Horizon Illusion to the moon.

When the illusion is active, the sun or
moon will appear to grow larger as it
approaches the horizon.

To add a secondary Sun/Moon ring:

1. Display the Sky & Fog palette by
clicking the Sky & Fog button at he
top of the Bryce window.

2. Click the triangle in the corner of the
palette and choose Edit Sky & Fog
from the menu. The Environmental
Attributes palette appears.

Click the Sun & Moon tab.

4. Click the Horizon Illusion button at
the top of the dialog.

5. Inthe Horizon Illusion area, enter a
value in the Intensity field to set the
brightness of the sun/moon illusion.

4an | intensity

The Intensity field next to the Rings preview sets
the width of the illusion.

Rainbows

In the real world rainbows appear after
rainstorms as arcs of light displaying all
the color in the spectrum. In Bryce a
rainbow is an atmospheric effect that can
be added to any sky.

A rainbow is only visible if the sun is
visible, meaning you can’t have a rainbow
at night. As well, you can add a secondary
rainbow to create the illusion of
reflection.

Rainbows are linked to the sun so that as
the color or intensity of the sun changes,
so does the rainbow.

Rainbows are infinitely distant. You can’t

approach them by moving the camera, so
the pot of gold is always just out of reach.
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To add a rainbow to your sky:

1. Display the Sky & Fog palette by
clicking the Sky & Fog button at he
top of the Bryce window.

2. Click the triangle in the corner of the
palette and choose Edit Sky & Fog
from the menu. The Environmental
Attributes dialog appears.

3. Click the Atmosphere tab.
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The Atmosphere tab of the Environmental
Attributes dialog contains all the controls you'll
need to create rainbows.

4, Click the Rainbows button to activate
the rainbow controls.

5. Enter a value in Radius field in the
Rainbow area. This value sets the
width of the rainbow.

158 Chapter @ Bryce 3D

Enter a value in the Opacity field.
This controls the rainbow’s
transparency.

To add a secondary rainbow to
your sky:

1.

Display the Sky & Fog palette by
clicking the Sky & Fog button at he
top of the Bryce window.

Click the triangle in the corner of the
palette and choose Edit Sky & Fog
from the menu. The Environmental
Attributes palette appears.

Click the Atmosphere tab.

Click the Secondary Rainbow button.

Enter a value in Intensity field in the
Rainbow area. This value sets the
width of the secondary rainbow.

Star Fields

Stars in Bryce are randomly generated
star maps. They are infinitely distant so
they do not get closer as you move the
camera. Star Fields are affected by the
moon’s brightness and color.

In this example you can see how the moon
affects the color and intensity of the stars
around it.

You can also add comets to your Star
Fields. Comets appear at random
positions. You'll usually only get one or
two comets per starfield.

To add a Star Field:
1. Display the Sky & Fog palette by

clicking the Sky & Fog button at the
top of the Bryce window.



2. Click the triangle in the corner of the
palette and choose Edit Sky & Fog
from the menu. The Environmental
Attributes palette appears.

Click the Sun & Moon tab.

4, Click the Starfield button at the
bottom of the palette.

To add comets to a Star Field:

1. Display the Sky & Fog palette by
clicking the Sky & Fog button at he
top of the Bryce window.

2. Click the triangle in the corner of the
palette and choose Edit Sky & Fog
from the menu. The Environmental
Attributes palette appears.

3. Click the Sun & Moon tab.

4, Click the Comets button at the
bottom of the palette.

Volumetric World

The Volumetric World effect simulates
the effects of particles in the air being
illuminated by light sources. In Bryce this
effect turns all the light sources in your
scene into visible light sources. Sunlight

also becomes visible, so that any color
you applied to the sun appears
everywhere in the scene.

Normal Environment

Volumetric World

In this example you can see how the Volumetric
World effect transforms a scene.

Visible sunlight is volumetric, meaning
that it is affected by all the objects
within it.

f- _-‘-I--_.___-_-_ R o
Although Volumetric World is a very
beautiful effect, its also a time
consuming one. It will add a
considerably to your scene’s rendering

time.
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To add visible sunlight to your scene:

1. Display the Sky & Fog palette by
clicking the Sky & Fog button at he
top of the Bryce window.

2. Click the triangle in the corner of the
palette and choose Edit Sky & Fog
from the menu. The Environmental
Attributes palette appears.

Click the Atmosphere tab.

4. Click either the Rough or Fine button
in the Visible Light area. This option
controls the quality of the light.
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Using the Preset Skies
Library

The Preset Skies Library contains all the
preset skies available in Bryce. You can
place them in your scene and edit them
just as you would another object.

To add a sky from the Preset Skies

library to your scene:

1. Click the triangle icon next to the
Sky & Fog text button at the top of
the Bryce window. The Preset Skies
Library appears.

Use the Preset Skies Library to add pre-made
skies to your scene.
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Click on the preset thumbnails to
view preset names and descriptions.

Click the OK icon to add the selected
sky to your scene.

- _-l—-._.._____ o

The Sky & Fog palette does notzeed to
be active for you to access the Preset
Skies Library.
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You can select presets in one motion
by dragging directly to the desired
preset, and releasing the mouse
button. You can also drag over the
category names to change categories,
into the category's presets, and then
release mouse button.

Adding and Deleting Preset Skies

You can add the sky from any open scene
to the Preset Skies Library. This is a good
way of saving your favorite skies.

To add a sky to the preset library:

1. Click the triangle icon next to the
Sky & Fog text button at the top of
the Bryce environment. The sky from
your scene appears in the preview
area of The Preset Skies Library
dialog.

The preview area displays the sky from your
scene.

2. Click the Add button at the bottom of
the dialog. The Add Obiject dialog
appears.

3. Enter a name for the new preset in
the Preset Name field.

4. Enter a description of the preset in
the Description field and click the
OKicon.



This name and description will
appear beneath the object preview
whenever the preset is accessed.

_;-' _-\_n.\_.._ S— — >
You can edit the name and description
of any preset at any time simply by
pressing the Tab key, or clicking on the
name or description.
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5. Click the OK icon. Your preset will be
added to the first available space
within the current category.

To delete an object preset:

1. Click the triangle icon next to the
Sky & Fog text button at the top of
the Bryce environment. The Preset
Skies Library appears.

2. Click on the preset you want to
delete, or hold down Shift and select
a continuous series of presets, or hold
down Command/Ctrl and select a
discontinuous set of presets.

3. Click the Delete button at the bottom
of the Preset Skies Library dialog.

Importing and Exporting Preset
Skies

Importing and exporting presets is a
handy way to exchange custom presets
with other users.

To import a preset sky file:

1. Click the triangle icon next to the
Sky & Fog text button at the top of
the Bryce environment. The Preset
Skies Library appears.

2. Click the Import button at the
bottom of the Preset Skies Library

dialog. The file open dialog appears.

3. Locate the file which you would like
to import and click Import.

The contents of the file are placed
into the first available space in the
current category.

To export a preset sky file:

1. Click the triangle icon next to the
Sky & Fog text button at the top of
the Bryce environment. The Preset
Skies Library appears.

2. Select the preset or presets you wish
to export.

3. Click the Export button at the
bottom of the Preset Skies Library
dialog. The save file dialog appears.

4. Enter a name and location for the file
and click Save.
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Terrains

What is a Terrain?

Terrain objects define the landscape of
your scene. They represent the land forms
of any scene: mountains, deserts, islands
or even floating cities. In Bryce, a terrain
object is a height map, which determines
the shape of your landscape. You can
make subtle adjustments to the map that
can result in new mountain ranges or
river beds.

Bryce creates a terrain’s shape by
converting brightness values in grayscale
images into a height map. White areas in
the image result in the highest altitudes
and black areas result in the lowest. The
Terrain Editor lets you generate the
grayscale images that are used to create
terrain objects.
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Creating terrains in the Terrain Editor isa
two-step process. First, generate the
source of your terrain image by using the
preset effects, painting an image using the
paintbrush or importing a picture. Then,
filter the image. The editor’s Filtering
tools let you fine-tune the grayscale
values in your terrain.

You can also animate the creation of a
terrain. Using the Animation controls
available at the bottom of the editor, you
can change the shape of your terrain
object over time. You can animate the
formation of mountains and valleys, or
the gradual destruction of the landscape.

.
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The Terrain Editor

The Terrain Editor can be used to
generate the grayscale image that is
converted into a terrain object. It can also
be used to edit an existing terrain.

You cannot access the Terrain Editor
unless you have a terrain object in your
scene. When the editor opens, it
temporarily replaces the screen and
displays the current terrain as a three
dimensional preview. The height map
that was used to create the terrain is
displayed in the Terrain Canvas.
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Editing Tool panels Terrain Canvas

3D Terrain Preview

When you access the Terrain Editor, it
temporarily takes over your screen.

To add a terrain object to your scene:

1. Click the Create text button at the top
of the Bryce environment. The Create
palette appears.

2. Click the terrain object tool. A
randomly generated terrain appears
in your scene.

B

Once you have a terrain object you can
customize it in the editor.

To open the Terrain Editor:

1. Select the terrain object.

2. Click the E icon that appears next to
the terrain object,

or choose Object menu>Edit
Object,

or click the Edit text button and then
click the Edit Terrain tool,

or press Command-E/Ctrl+E.

Features of the Terrain Editor

The Terrain Editor is divided into four
sections:

* The Editing tools, which let you
generate and edit the terrain’s height
map

* The Terrain Canvas, which displays
the grayscale image used as a height
map



*  The 3D Terrain Preview, which
displays a three-dimensional preview
of the terrain you're working on

* The Animation controls, which let
you set up key frames for animating
the terrain

Editing Tools

Terrain tools are divided into three tabs
that contain tools for generating terrain
elevations, filtering terrains, and
importing pictures to use as terrains:

+ Elevation contains tools for
generating terrains, and applying
effects.

* Filtering contains tools for
fine-tuning the gray levels in your
terrain Canvas.

+ Pictures contains tools for importing
a picture to use as a Terrain Canvas.

The Terrain Editor tools are divided into three
tabs.

To access a tab:

o Click the tab label. The tab tools
move to the front. By default, the
Elevation tools are in front.

Terrain Canvas

The Terrain Canvas displays the grayscale
image that is used to create the terrain
object. You can think of the Terrain
Canvas as a top view of the terrain object
you're creating.

The Terrain Canvas is where you paint
the height map for your terrain. The
image in the center of this area is the
canvas. Around the canvas are the
painting tools and zoom area controls.

Paintbrush Controls

Color
Gradient
Strip

Clipping
Bracket

Zoom Area Controls
Brush Mode Selector

The Terrain Canvas displays the grayscale image
that is used to create your terrain.

The main tools in this area are the
grayscale paintbrush and the height
picker. The paintbrush lets you paint
images using different shades of gray. The
Height Picker lets you pick up gray levels
from other parts of your image to set the
gray level of the paintbrush.

The left side of the frame includes all the
paintbrush controls (Size, Hardness,
Flow, and Level) as well as the Grid
selector, which controls the resolution of
the grayscale data.

The right side contains a gradient strip

and bracket for clipping operations and
controls for color mapping.
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The bottom part of the frame includes a
Brush Mode selector and Zoom Area
controls.

3D Terrain Preview

The 3D Terrain Preview in the lower left
corner of your screen displays the
resulting terrain object based on the
image in the Terrain Canvas. As you edit
the terrain image, the preview updates to
show the result of your changes.

The 3D Terrain Preview shows the terrain object
that will be produced from the image in the
Terrain Canvas.

The preview of your terrain can be
rotated so you can see your terrain object
from different angles.

166 Chapter @ Bryce 3D

To rotate the terrain preview:

o Drag the preview object in the
direction you want to rotate the
terrain.

Animation Controls

The Animation controls at the bottom of
the editor let you create key frames for
your terrain. Any change you make to the
geometry of the terrain can be stored in a
key frame and animated.

Current Time Indicator
Preview Controls

I_I_I

Key Frame Controls

The Animation controls let you create key
frames for the terrain so you can animate the
terrain editing process.

The Timeline that runs along the bottom
of the editor displays the length of the
animation. The Current Time Indicator
within the timeline lets you set the
current time of the animation.

The buttons in the Animation controls let
you preview the animation. The buttons
beside the preview controls let you add
and delete key frames from the Timeline.

Working in the Terrain Editor

Using Terrain Editor Tools

Most of the tools in the Terrain Editor are
displayed as control dots. These dots let
you apply an effect or operation to the
terrain gradually or at 100%.

To apply a tool to the Terrain Canvas:

1. Move the cursor over the tool you
want to use.

2. Do one of the following:

+ Apply an effect or operation
entirely by clicking the control
dot just once.

+  Apply an effect gradually by
dragging over the control dot.

«  Apply an effect by clicking a tool
more than once. The effect is
applied in 100% increments.



Starting a New Terrain

By default when you open the Terrain
Editor, the terrain you selected in the
Working window appears in the Terrain
Canvas. If you want to begin with a new,
flat Terrain Canvas, use the New button.

To create a new Terrain Canvas:

1. Make sure the Elevation tab is
displayed. If it’s not, click the
Elevation title.

2. Click the New button.
or press Command-N/Ctrl+N.

A flat black image appears in the
Terrain Canvas.

To gradually flatten your terrain:

o Drag to the right over the New
button.

The existing Terrain Canvas
gradually fades to black.

— - >

- B
Many of the effects in the Elevation tab
require grayscale values. If you apply

these effects to a black map they may

have no effect. Try to use this only
when you're setting up for brushing
operations.

- B,

To reset your terrain:

o Hold down Control and click the
New button.

The Terrain Canvas is reset to the
terrain that appeared when you first
opened the editor.

Inverting Terrains

Since the Terrain Editor uses brightness
to determine altitude, you can change
mountains into canyons by inverting the
black and white values in your image.

To invert your terrain image:

1. Make sure the Elevation tab is
displayed. If it’s not click the
Elevation title.

2. Click the Invert button, or press
Command-1/Ctrl+l.

All the black areas of your image
become white and white areas
become black.

To gradually invert your terrain image:

o Drag to the right over the Invert
button.

The black areas in the existing
Terrain Canvas progressively turn
white.

Undoing Operations

You can reverse any effect you apply to
your image using the Undo button. You
can toggle between Undo and Redo by
clicking the Undo button repeatedly.

To undo operations in the Terrain
Editor:

1. Make sure the Elevation tab is
displayed. If it'’s not click the
Elevation title.

2. Click the Undo button, or press
Command-Z/Ctrl+Z

The last operation you applied is
undone.
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Eroding Terrains

Erosion simulates the effects of water
erosion on your terrain objects. The
calculations in this effect simulate
droplets of water falling on your terrain,
and then calculate where the droplets
would trickle based on the shades of gray
progressing towards black. This effect
works best on maps that have large
sloping areas.

The Erode button simulates the effects of
erosion over a short period of time, like
decades. To simulate the effects of
centuries of erosion, use the Eroded tool.

This is what a terrain looks like before you apply
the Erode effect. Notice that this image map has
sloping areas that will make the erode effect
more visible.
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This is the same terrain after the Erode effect is
applied. You can see how the surface now
contains tracks created by running water.

To erode terrains:

1. Make sure the Elevation tab is
displayed. If it’s not, click the
Elevation title.

2. Click the Erode button. You can also
gradually apply erosion by holding
down the mouse button while the
pointer is over the Erode button.

Setting 3D Terrain Preview Options
The 3D Terrain area has several options

that control how the preview updates and
displays.

To set 3D Terrain Preview options:

o Click the triangle icon in the bottom
left corner of the Terrain Canvas
frame and choose an option from the
menu:

Auto Rotate sets the 3D Preview to
rotate perpetually. All changes
update the 3D preview as it turns.

RIP To Screen displays a full-screen
preview of your terrain. Clicking
anywhere will return you to the main
Terrain Editor. Use Command-W/
Ctrl+W to toggle in and out of this
mode.

Realtime Linking connects all terrain
editing to the 3D Terrain Preview.
Every analog change you make is
applied simultaneously to the Terrain
Canvas and the 3D preview. You can
turn this feature off and on with the
Control/Ctrl key.



Using the Zoom Area

When the Zoom Area is active, only a
small portion of your terrain is displayed
in the 3D Terrain Preview. The 3D
Terrain Preview displays the zoomed-in
portion of your Terrain Canvas. You can
use this feature to see small variations in
the surface of your terrain. The Zoom
Area can be moved to any point on your
Terrain Canvas.

Use the Zoom Area to see a close up of an area in
your Terrain Canvas in 3D.

You can always paint while the Zoom
Area is active; in fact this is a nice way to
paint in the Terrain Canvas while
previewing a small section in 3D to
observe details.

To turn the Zoom Area on:

o Click the On text button below the
Zoom Area title at the bottom of the
Terrain Canvas frame.

A marquee appears on your Terrain
Canvas.

To turn the Zoom Area off:

o Click the Off text button below the
Zoom Area title at the bottom of the
Terrain Canvas frame.

To move the Zoom area:

1. Move your pointer over an edge of
the Zoom Area marquee. The pointer
changes to a hand tool.

2. Drag the marquee to an area in the
Terrain Canvas.

To resize the Zoom area:

1. Move the pointer over a corner of the
Zoom Area marquee.

2. Drag away from the center of the
marquee to enlarge the Zoom Area,
or towards the center to shrink the
area.

To scale the zoom area to fill the
Terrain Canvas:

o Click the Crop text button below the
Zoom Area title at the bottom of the
Terrain Canvas frame.

The contents of your Zoom Area are
scaled to fill the entire Terrain
Canvas area. The Zoom Area
contents replace the existing contents
of the Terrain Canvas.

This feature can be useful for creating
new terrains from larger high-resolution
terrains.

To fit the contents of the Terrain
Canvas into the Zoom Area:

o Click the Fit text button below the
Zoom Area title at the bottom of the
Terrain Canvas frame.

The entire contents of your Terrain
Canvas are scaled down to fit into the
Zoom Area marquee. The rest of the
Terrain Canvas will be filled with black.
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Setting Terrain Resolution

The terrain’s resolution determines the
amount of detail in your terrain. The
higher the resolution, the more detail
appears in your terrain’s surface.
However, higher resolution values also
increase the rendering time for your
scene and require more memory.

The default resolution is 128. The highest
resolutions should be reserved for
terrains that are very close to your camera
and for any other case where detail is
important. For items that are far away, or
where detail is not so important, lower
resolutions are more appropriate.

Brush sizes may appear to vary
depending on your resolution, but in fact
they remain proportional to the size of
the Terrain Canvas. The Terrain Canvas is
always displayed at 256x256. So, if you
change the resolution to 1024x1024, the
Terrain Canvas will still appear in that
256x256 window and, in order to remain
proportional, brushes will appear smaller.

To set the Terrain resolution:

o Click the Grid icon on the left side of
the Terrain Canvas frame and choose
a resolution from the menu.
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The resolutions available are:

16 verycoarse

+ 32 coarse

+ 64 simple

« 128 normal

o 256 fine

+ 512 ultrafine

« 1024 massive resolution
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Creating Terrains
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You can create terrains in several ways.
You can let the editor do all the work of
generating a terrain based on a series of
algorithms, you can use the editor’s
painting tools to create a custom image,
or you can import an image into the
editor.

When you generate a terrain, you use the
Terrain Editor’s Elevation tools, which
include erosion effects as well as dozens
of other effects optimized for the purpose
of heightening realism in Bryce terrains.

When you paint a terrain you use the
editor’s grayscale paintbrush to paint a
topographical image. The image is then
converted to a terrain object.

You can also create a terrain by importing
a picture into the editor. The picture is
converted to grayscale which is then used
to generate altitude values.

Creating Landscapes

When you're planning the shape of your
terrain you should keep in mind the kind
of landscape you want to create. You
don’t have to create all the land in your
scene as a single terrain. More complex
landscapes can be created by combining
several terrain objects.

Before creating terrain objects, plan out
the entire map of your landscape. Then
you'll be able to see where different
terrain objects might be combined to
create a single land mass.

e

Before you start creating terrains you should
map out all the land masses in your
environment...



...then you'll be able to see where you will need
to combine more than one terrain to create a
specific type of landscape.

If you have more terrains in your scene,
you'll have a bigger scale for the
environment. This gives you more
resolution and better atmosphere effects.

Pay attention to where the camera is
positioned in the scene. Terrains that are
closer to the camera need to be more
detailed than those off in the distance.

Animation and Terrain Editing

You can record the process of creating a
terrain into an animation using the
Animation controls. Refer to
“Animating” on page 351 for more on
animating. Some of the Elevation tools
can produce some unpredictable results
when they’re animated, so you may want
to experiment with animating elevations
before you create your final terrain.

Elevation Tools

The Elevation tools are preset effects that
apply different calculations to your
Terrain Canvas. The tools are divided
into three categories on the tab: Source
Generator, Basic Tools and Special
Effects.

Source Generators create basic terrain
surfaces. The Basic Tools edit the overall
shape of your terrain, and Special Effects
add realism to your terrain’s surface.

You can create a terrain by combining
effects. For example, you can start off
creating a basic terrain using the Fractal
tool, then create realistic ridges by
applying the Erode tool. From there you
can fine-tune your terrain by applying
Spikes, creating Mounds or adding Cross
Ridges. Finally, you can define the basic
shape of your terrain by blurring the
edges.

Using Elevation Tools

Along the bottom left corner of the
Elevation tab are an orange and green
curve of dots. The green curve contains
tools for changing a terrain’s geometry,
like adding mounds or spikes. The orange
curve contains tools that apply filtering
effects to an existing terrain, like
posterizing or equalizing.

These two curves represent different sets of
elevation tools. Click the curves to toggle
between the two sets.

To switch between sets of elevation
tools:

1. Click the curves in the bottom left
corner of the panel. The button
works like a toggle.

2. Click again to return to the first set.

Including both sets of buttons, there are a
total of 30 elevation tools.

To use an elevation tool:

1. Make sure the Elevation tab is
displayed. If it’s not, click the
Elevation title.

2. Click an effect tool. 100% of the
effect is applied to the Terrain
Canvas.

3. Click the tool again to increase the
intensity of the effect.
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Most elevation effects can also be applied
gradually.

To apply an elevation effect gradually:

1. Move the pointer over an Elevation
tool. The pointer changes to a
two-headed arrow.

2. Drag to the left to increase the effect
or drag to the right to decrease it.

Source Generators

The Source Generator tools can be used
in two ways: to generate a terrain from
scratch, or to alter the geometry of an
existing terrain.

Fractal

This tool creates terrains based on fractal
patterns. It can be applied to an existing
image and it can be applied gradually.
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This tool produces terrains based on fractal
patterns. The terrains it creates have lots of
spikes and valleys. This tool produces good basic
terrains.

Eroded

This tool applies natural erosion to your
terrain. It can also be applied to a blank
image to create an eroded terrain, or to
an existing image. You can also gradually
apply erosion to an image. Eroded
produces extremely realistic terrains.

Notice that when animating this type of
terrain, material is actually added to the
terrain, not removed from it as you might
expect.

This tool produces terrains based on eroded
land. The terrains produced by this tool have
deep grooves and canyons.

The Eroded tool is a more intense version
of the Erode tool.

Picture

This tool creates terrains from imported
images. When you click this tool, the
Open dialog appears. You can use this
dialog to locate and load a picture to use
as a Terrain Canvas. Refer to “Working
with Pictures” on page 114 for more.



Raise/Lower Sharpening

This tool adjusts the brightness of your This tool sharpens the gray values in your
Terrain Canvas. Drag to the right to lower Terrain Canvas. Drag left to increase
your height map or drag to the left to sharpening and right to decrease it. b

raise it. Single clicks gradually lower
the map.

This tool produces terrains based on a picture.
This tool is how you import image maps created
in other graphics applications.

This tool adjusts the brightness of your Terrain
Canvas, which raises or lowers the height of the

Using this tool you can import an image entire terrain.

map created in another application like

Painter or Photoshop. This tool sharpens the Terrain Canvas gray
values. You can use smoothing to create spikes or
ridges.

Basic Tools

The Basic Tools are used to alter an
existing Terrain Canvas only. They have
no effect on a blank canvas.
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Smoothing

This tool blurs the Terrain Canvas. Drag
right to decrease the blurring effect or left
to increase it.

Smoothing is especially effective prior to
using the Erode button, since the Erode
algorithm works best when there are
shades of gray in an image. If your canvas
has too many sharp black to white
transitions, the Erode may not be as
effective.

This tool blurs your Terrain Canvas creating
smoother black to white transitions.
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Gaussian Edges

This tool does not blur your map. It
creates a “Gaussian curve” from dark to
light, starting from the edges of your
Terrain Canvas. This creates edges that
gradually transition from dark to light, or
start at the lowest possible altitude, and
gradually progress into higher altitudes.

Gaussian Edges eliminates the seams
between ground and terrain objects,
when the ground plane and the terrain
have the same surface material. You
should apply this tool to any terrain that
is going to be sitting on a ground plane in
your scene.

This tool creates gradually ascending edges on
your terrain which can create a smooth
transition from the ground plane of your scene
to the terrain.

Square Edges

This tool creates an abrupt drop at the
edges of your terrain. Use this tool when
you have a terrain whose edges are not
level, and you do not wish to use the
Gaussian Edges tool for soft transitions.

This tool creates an abrupt drop at the edges of
your terrain. Use Square Edges to level the edges
of a terrain.

You can add a slope to the square edges of
your terrain by applying this tool
gradually. Drag left to increase the slope
and right to decrease it.



Round Edges

This tool creates an abrupt circular drop
at the edges of your terrain.

You can add a slope to the round edges of
your terrain by applying this tool
gradually. Drag left to increase the slope
and right to decrease it.

This tool creates an abrupt circular drop at the
edges of your terrain. Use Round Edges to create
a circular base for your terrains.

Basic Noise

This tool adds roughness to your terrain’s
surface by adding noise to the Terrain
Canvas. Drag left to increase the noise
and right to decrease it.

This tool adds roughness to your terrain’s
surface. Use Basic Noise to create rocky
mountains.

Slope Noise

This tool adds roughness to any sloping
surfaces in your terrain. Slope Noise adds
noise to all the sloping areas of your
terrain. Drag left to increase the noise and
right to decrease it.

Slope Noise has no effect on flat surfaces.
More noise is added to steep slopes.

This tool adds roughness to the sloping surfaces
of your terrain.
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Height Noise

This tool adds small amounts of noise at
lower altitudes and more noise at higher
altitudes. Drag left to increase the noise
and right to decrease it.

This tool adds a little roughness to your terrain’s
surface at lower altitudes and more at higher
altitudes.
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Image Filtering Effects

These tools, located on the orange curve,
apply filters to your terrain that act like
image filters. They can change the look of
the terrain without altering its basic
shape.

Spikes

This tool adds spiky structures to your
map. When you apply the right material
to these structures they can look
remarkably like trees if they’re viewed
from a distance.

This tool adds spikes to your terrain’s surface.
Use Spikes when you want to add trees to your
terrain.

Mounds

This tool adds midsized splotches to your
canvas. You can use this tool to create the
appearance of stones or boulders under
transparent water planes.

This tool adds splotches to your Terrain Canvas
that look like boulders on flat surfaces or towers
on sloped surfaces.



Dampen

This tool works like a contrast control. It
will push gray values towards either black
or white depending on where the gray
value falls in the black/white range. Less
than 50% goes to black, greater than 50%
goes to white.

This tool controls the contrast of your Terrain
Canvas. Use Dampen to create abrupt drops
and valleys.

Equalize

This tool acts like the Equalize function
you may have seen in 2D image editing
applications. It redistributes gray values
in your Terrain Canvas such that a full
range from black to white is present in
your canvas.

This tool equalizes black and white values in
your Terrain Canvas. Use Equalize to eliminate
sharp ridges or deep valleys.

Posterize

This tool stratifies the gray levels in your
Terrain Canvas, resulting in stair-stepped
terrain structures. This is a good tool for
creating desert plateaus.

Use Posterize to create stair-stepped desert
plateaus or paddy fields on the side of a
mountain.
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Mosaic

This tool is not a button on the Elevation
tab. To use this tool, hold down Opt/Alt
as you drag over the Posterize button.

Mosaic creates highly pixelated square
structures based on the gray content of
your canvas.

This tool is excellent for instant
cityscapes. Try adding one of the sci-fi
city materials from the Preset Materials
Library to a Mosaic terrain.

This tool pixelizes your Terrain Canvas. Use
Mosaic to create cityscapes.
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Sawtooth

This tool modifies your Terrain Canvas

based on a sawtooth waveform structure.

The results look like schizoid desert
canyons and icebergs.

This tool creates schizoid desert canyons or
icebergs.

Subcontours

This tool works like a contrast control
with the threshold set almost at white.
Most values are pushed to black while
only the very lightest are pushed to white.

This tool produces spiky peaks with sloping
contours.

Subcontours produces spiky peaks with
very low, gently sloping contours.

Geometry Effects

This green set of Elevation tools add to
the geometry of your terrain, which can
alter its basic shape. You can also use
most of these tools to create terrains from
scratch.



Blob Maker

This tool creates a smooth, circular
structure within your existing Terrain
Canvas. Drag left or right to change the
size of the structure. Drag up and down
to set the vertical location of the
structure.

This tool creates circular structures within your
Terrain Canvas.

Relief Noise

This tool acts like an emboss effect. It will
emboss the grayscale data in your canvas
and convert it to height information.

This tool embosses the grayscale data in your
Terrain Canvas.

Raise Edges

This tool acts like an inverted version of
the Square Edges tool. It creates abrupt
increases in altitude at the edges of your
terrain.

This tool creates abrupt increases in altitude at
the edges of your terrain.
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Subplateaus

This tool smears your grayscale data in
one direction while averaging the gray
values. The result is natural structures
not unlike those created by the Mounds
effect, except that these structures are
more directly related to your original
gray data.

Because it creates boulder-like
structures, this tool is good for making
tidepools.

This tool creates boulder-like structures within
your Terrain Canvas.
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Cross Ridges

This tool creates sharp ridges in a cross
patter. It creates very interesting
canal-like structures.

This tool creates canal-like structures within
your Terrain Canvas.

Cross Ridges 2

This tool is the inverse of the Cross
Ridges tool. Instead of creating canals, it
creates peaks.

This tool creates peak-like structures within
your Terrain Canvas.



Bubble Ridges

Similar to the Blob Maker, the spherical
structure this tool creates is of a
consistent size. Dragging this button
allows you to place the structure
anywhere you like in your canvas.

This tool creates a spherical structure within
your terrain that can be placed at any point in
your canvas.
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Painting Terrains

Although you can create some very
spectacular terrains using just the
elevation tools, there are times when you
want to create a precise Terrain Canvas.
The Terrain Editor’s paintbrush lets you
paint any type of terrain you wish. Using
the Paintbrush, you can re-create
real-world topographical maps or design
landscapes with specific contours.

Setting Up the Paintbrush

Before painting with the Paintbrush, you
should set up some of its parameters.
Using the brush settings you can control
the size, hardness, strength and color of
your brush.

Brush Size

Brush Hardness

Brush Flow

Gray Level Control

Brush Behavior Options

Use the Paintbrush settings to control the
attributes of your brush.

To set brush attributes:

1.

2.

In the Terrain Canvas frame, drag
over the Size control.

Drag away from the center to
increase the size of the brush and
towards the center to decrease it.

Drag over the Hard control.

Drag towards the center of the
control to make brush edges harder
or away from the center to make
brush edges softer.

3. Drag the pointer over the Flow
control.

Drag to the right to increase the flow
or to the left to decrease it.

Brush Flow determines the strength
of the paintbrush. The higher the
flow setting, the more color is
applied.

4. Drag over the Level control.

Drag down to apply a darker gray, or
up to apply a lighter gray.

Since you’re painting altitudes,
lighter grays result in higher points
and ridges while darker grays create
lower points and valleys.

The default level is 100% gray.
However, it effectively paints at 50%
because of the other default settings.

While you're painting, you may want to
re-create a specific altitude in different
parts of the terrain. If you've changed the
brush settings, re-creating a specific
altitude can be quite difficult. However,
using the Height Picker tool you can
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quite easily re-create altitudes by picking
up gray levels from different parts of your
image and applying them to the brush.

To pick up gray levels from the terrain
image:

1. While holding down the Control/
Ctrl, move the cursor over the
Terrain Canvas and click the desired
altitude color. The color is applied to
the brush.

2. Drag the brush over a different area
of the canvas. The altitude color you
picked up is applied to the new area.

Brush Behaviors

The paintbrush in the Terrain Editor
paints elevations by default, but this is
not the only way of painting using the
brush. You can also set the brush to paint
effects. This lets you apply elevation
effects locally, or to increase/decrease
existing gray levels in your Terrain
Canvas.

To paint elevations:

1. Make sure the Elevation tab is visible.
If it’s not, click the Elevation title.
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2. Click the triangle icon next to the
Brush Behaviors heading and choose
Paint Elevation from the menu.

The brush paints in shades of gray
that are then used to generate
altitudes. This is the default brush
behavior.

To apply an effect locally:

1. Make sure the Elevation tab is visible.

If it’s not, click the Elevation title.

2. Click the triangle icon next to the
Brush Behavior heading and choose
Paint Effect from the menu.

3. Hold down the Spacebar and click
the Elevation effect you want to
paint.

4. Drag the paintbrush over an area of
your canvas.

To remove an effect locally:

1. Click the triangle icon next to the
Brush Behavior heading and choose
Unpaint Effect from the menu.

2. Drag the paintbrush over an area of
your canvas where you applied an
effect locally.

The Unpaint Effect brush only affects
areas where you applied an effect
with the paintbrush.

An effective way of using this brush is
to paint an effect in broad, easy
strokes, and then selectively unpaint
areas of effect away.

To erode areas of your terrain:

1. Click the triangle icon next to the
Brush Behaviors heading and choose
Erode from the menu.

2. Drag the paintbrush over the area
you want to erode.

The paintbrush applies the erosion
effect to the area painted over.

To lighten gray levels:

1. Click the triangle icon next to the
Brush Behavior heading and choose
Maximum from the menu.

2. Drag the paintbrush over an area you
want to lighten.

In this mode, gray levels in your
canvas that are below the current
gray level are lightened to match the
current level. Values above the
current Level setting are untouched.



To darken gray levels:

1. Click the triangle icon next to the
Brush Behavior heading and choose
Minimum from the menu.

2. Drag the paintbrush over an area you
want to darken.

In this mode, gray levels in your
canvas that are above the current gray
level are darkened to match the
current level. Values below the
current Level setting are untouched.

Modifying Brush Behavior

The Option/Alt key can modify the
behavior of the paintbrush on-the-fly.

* In Elevation mode, Option/Alt
inverts the gray level. For example, if
you're painting white, holding down
Option/Alt will paint black.

* In Paint Effect mode, the Option/Alt
key will toggle to Unpaint Effect
mode.
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Filtering Terrains

Filtering is the process of adjusting the
grayscale curve of your Terrain Canvas.
By adjusting the grayscale curve, you
create a custom elevation effect.

How Filtering Works

The Filter area is essentially a graph that
represents gray level input from black to
white horizontally, and gray level output
from black to white vertically.

Lightest
Gray
Value
Output

Darkest
Gray
Value
Output

Darkest Gray Values Lightest Gray
Input Values Input

The Filtering graph expresses all the input and
output gray values in your Terrain Canvas.

The default diagonal filter creates a graph
where all values input as black are also
output as black, and all values input as
white are also output as white. That is
why your Terrain Canvas appears
unchanged—none of its gray level values
have been altered.

By dragging in this Filter area, you can
remap the gray values in your Terrain
Canvas.

To see how filtering works:

1. Place your cursor (which changesto a
Pencil within the Filtering area) in
the top left corner of the Filter Area.

2. Drag diagonally to the bottom right
corner.

As you can see in the Preview area, your
Terrain Canvas is inverted.

The original graph stated that all values
input as black were output as black and
all the values input as white were output
as white.
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In the original Filtering graph all values input as
black are output as black and all values input as
white are output as white.

The new graph you created now states
that all values input as black are output as
white and all the values input as white are
now output as black. In other words all
the dark values are light and all the light
values are dark.
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darkest
Is are

In the new Filtering graph all values input at 0
are output at 255 and all values input at 255 are
output at 0.

This is a drastic example. In most cases
you would adjust more specifically, like
lightening the midtone grays or
darkening specific gray values.
Remember that this graph represents
your Terrain Canvas, so you're changing
the shape of your terrain object as you
adjust gray values.

The Filtering Tab

The Filtering tab is divided into three
areas: the Filtering graph, the graph
preview and the filtering presets.

Filtering Presets

Filteiing
PFEFRF AP TTN M

Filtering Graph Preview Area
Use the Filtering tab to edit the Filtering graph

and apply filtering presets.

The Filtering graph displays your Terrain
Canvas’s gray levels as value inputs and
outputs. You can edit this graph to adjust
the gray level values in your canvas.

Next to the graph is the Preview area.
This area shows you what your Terrain
Canvas would look like if applied to the



current Filtering graph.This area
automatically updates as you make
changes to the graph.

Along the top of the tab are the nine
Filtering presets you can apply to the
graph. Each preset represents a different
predefined graph. They are designed to
create specific changes in gray levels, like
smooth gradients and abrupt transitions.

Working in the Filtering tab

Altering the Filtering Graph

The best way to start adjusting the
Filtering graph is to determine the type of
effect you want to create. For example, if
your canvas is too dark, raise the value of
the darker gray value inputs by drawing a
ridge in the left side of the graph.

Before

Drawing a ridge on the left side of the graph....

After

....raises the value of the darkest grays in your
Terrain Canvas.

To alter the Filtering graph:

1. Make sure the Filtering tab is visible.

If it’s not, click the Filtering title.

2. Dragyour pointer over the area of the
Filtering graph you want to adjust.

When you drag over a black area, the
pencil draws in gray; dragging over a
gray area draws in black.

Tracing over any lines you've drawn
erases them.

To undo all changes to the Filtering
graph:

1. Make sure the Filtering tab is visible.
If it’s not, click the Filtering title.

2. Click the Reset text button below the
Filtering graph.

The graph returns to the default
Filtering graph.

To soften harsh transitions in the
graph:

1. Make sure the Filtering tab is visible.
If it's not, click the Filtering title.

2. Click the Soften text button below the
Filtering graph.

3. Click the Soften button again to
soften the transitions more.
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Applying Presets

Filtering presets are provided to help you
get started adjusting the Filtering graph.
These preset are designed to provide
different effects. The best way of using
these presets is to apply them to your
graph and see what happens.

To apply presets:

1. Make sure the Filtering tab is visible.
If it’s not, click the Filtering title.

2. Click one of the preset buttons along
the top of the tab. The current graph
is replaced with the preset graph.

Applying Filtering Changes to Your
Terrain Canvas

Although any changes you make to the
graph are applied to the Preview area,
they do not automatically affect your
Terrain Canvas. You have to Apply the
changes before they affect the canvas.

You can temporarily apply your changes
to the 3D Preview in real-time by holding
down Control/Ctrl as you drag over the
Filtering graph.
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To apply the Filtering graph to the 3D
Preview:
o Hold down the mouse button over

the filter graph preview. The 3D
preview updates.

When you release the mouse the 3D
Preview switches back to the
unfiltered terrain.

To apply filtering changes to the
Terrain Canvas:

o Click the Apply text button beneath
the Preview area.

Blending the Filtering Graph With the
Terrain Canvas

The Filtering Tab offers several ways of
applying your Filtering graph to the
Terrain Canvas. You can apply the graph
directly or you can blend the graph with
the canvas.

When you use a blending option you're
essentially drawing a grayscale gradient
and then blending it with your original
canvas.

FFEFRpPFEmM

This terrain was altered by directly applying a
filtering effect.

This terrain was altered by blending a filtering
effect with the original canvas.



To blend the Filtering graph with the

Terrain Canvas:

1. Adjust the Filtering graph to achieve

the desired effect.

Click the triangle icon below the
Filtering graph and choose an option
from the menu:

Horizontal horizontally blends your
Filtering graph, expressed as a
grayscale gradient, with your Terrain
Canvas.

Vertical vertically blends your
Filtering graph, expressed as a
grayscale gradient, with your Terrain
Canvas.

Horizontal Add horizontally blends
your Filtering graph, expressed as a
grayscale gradient, with your Terrain
Canvas.

This option uses a slightly different
algorithm than the previous
Horizontal option: it's not a
traditional Additive, but an average
of the existing terrain grayscale values
with the maximum of the Terrain
and Filter values.

Vertical Add vertically blends your
Filtering graph, expressed as a
grayscale gradient, with your Terrain
Canvas.

This option uses a slightly different
algorithm than the previous Vertical
option: it’s not a traditional Additive,
but an average of the existing terrain
grayscale values with the maximum
of the Terrain and Filter values.

3. Click Apply.

g
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Crééfing Terrains; .Using
Pictures

The Terrain Editor converts grayscale
values in the Terrain Canvas into altitudes
to create terrain objects. You can take
advantage of this process to create unique
terrains based on the grayscale values in a
picture.

The Terrain Editor’s Picture tab lets you
import a picture into the Terrain Canvas.
You can then apply elevation effects or
filter it just as you would any other
Terrain Canvas.

The Pictures Tab

The Picture Tab is made of three picture
squares and a blend control. The first two
picture squares let you load a picture to
use a terrain and the third square shows
you the result of combining the two
pictures. The blend control lets you
specify how the pictures are combined.

Use the Picture tab to load and blend pictures to
create unique terrains.

Working in the Pictures Tab

Loading Pictures

You can load any two pictures from
anywhere on your system. You can also
copy and paste images from the
Clipboard.
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To load pictures:

0

Click the Load text button above the
picture box into which you want to
load the picture.
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Hold down Option/Alt key to load the
picture’s color data directly into the 3D
Terrain preview. This allows you to see
the interaction between the picture and
the grayscale to height interpretation of
its luminance values. The color data is
only for viewing purposes and will not
render with the terrain.
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To copy and paste a picture into the
Picture tab:

1.

188

In another application, copy the
picture you want to use to the
Clipboard.

In the Picture tab, click the Paste text
button below the picture box where
you want the picture to appear.
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When you use Command-V/Ctrl+V to
paste from the Clipboard, the picture
always appears in the first square.
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Blending Pictures

Once you have a picture in each of the
first two squares, you blend them to
create a third image that is used to create
the new Terrain Canvas.

To blend pictures:

1. Load pictures into the first two
squares.

If you load only one picture a white
square is used as the second blend
image.

2. Click the triangle icon under the
third picture box and choose a Blend
mode from the menu:

Blend compares each corresponding
pixel from the first two squares, and
displays an average of the two in the
corresponding location of the third
square.

Minimum compares each
corresponding pixel from the first
two squares, and displays the darker
of the two in the corresponding
location of the third square.

Subtract compares each
corresponding pixel from the first
two squares, subtracts the brightness
value of one from the brightness
value of the other, and displays the
result in the corresponding location
of the third square.

Add compares each corresponding
pixel from the first two squares, adds
the brightness value of one to the
brightness value of the other, and
displays the result in the
corresponding location of the third
square.

Drag the pointer over the Blend
control.

Drag to the left to use more of the
first image in the blend. Drag to the
right to use more of the second
image.



Applying Changes to the Terrain
Canvas

Although the results of blending pictures
appears in the third picture box, it is not
automatically applied to your Terrain
Canvas.

To apply a picture to the Terrain
Canvas:

o Click the Apply text button beneath
the third picture square.
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Color in the Terrain Editor is used as a
visual aid to help you see the relationship
between color values and altitude. This
color only exists in the Terrain Editor and
is not applied to the terrain object.

You can apply a color gradient to your Terrain
Canvas to help you visualize the relationship
between color values and altitude.

When you apply color in the editor, it
maps a gradient to the altitudes in your
Terrain Canvas. For example, if you apply
a gradient from blue to yellow, blue
might represent the lowest altitude while
yellow may represent the highest. Which
colors are mapped to which altitudes is
left completely up to you.

Gradients can be extremely useful when
you're filtering terrains, as they make the
differences between gray levels more
visible.

b
oy

You can apply a color gradient to your Terrain
Canvas it also appears in the Filtering tab. This
makes it easier to see the differences in gray
levels.

i
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Mapping Color to Your Terrain Canvas

The Terrain Editor’s color picker contains
all the gradient you can apply to your
terrain. The gradient you select is applied
to both the Terrain Canvas and the 3D
Terrain Preview.

Gradient Bar

Color Picker

Color/Grayscale
Toggle

Use the Color Picker button to choose a color
gradient and the gradient bar to set color
mapping.

To map colors to your Terrain Canvas:

1. Click the Color Picker button in the
bottom right corner of the Terrain
Canvas Frame and drag over a
gradient in the palette.
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The gradient you selected appears in
the Gradient bar and is mapped to
the Terrain Canvas and the 3D
Terrain Preview.

2. Dragthe gradient up or down to map
the colors to altitudes.

The colors at the bottom of the
gradient represent the lowest altitude
and the those at the top represent the
highest.

The Gradient Bar has two modifiers:
+  Opt/Alt resets the Gradient Bar.

+ Command-F/Ctrl+F flips the
colors in the gradient.

To return to grayscale:

o Click the Color/Grayscale toggle to
switch back to the default gray
gradient.

Although gradients are meant to be used
only in the Terrain Editor, you can apply
the gradient to the Terrain’s Diffuse
channel. The gradient then becomes the
terrain’s Diffuse color. This allows you to
render the gradient with the terrain.

To apply a gradient to a terrain’s
Diffuse channel:

1. Apply a gradient to the terrain.

2. Click the triangle icon below the
Color/Grayscale toggle button and
choose Load Gradient into Diffuse
channel.

The gradient becomes the terrain’s
Diffuse color.

To remove a gradient from a terrain’s
Diffuse channel:

1. Open the terrain in the Terrain
Editor.

2. Click the Color/Grayscale toggle.

T — S,
Clipping Terrains

Using the Terrain Editor’s clipping
controls, you determine which values in
your terrain are rendered as the final
terrain object. The Clipping controls next
to the Gradient bar represent the render
range for the terrain. Anything outside
the range included in the brackets will
not be rendered.



You can use these controls to eliminate
any unwanted information from the
terrain without altering its basic shape.
For example, you can keep the main
terrain while eliminating the black square
on which it sits.

Using the Clipping Bracket you can eliminate
unwanted areas from the terrain’s edges. This
feature can be useful when you're creating
islands.

The clipping feature is particularly useful
when editing a Symmetrical Lattice. The
maximum lower range of the Clipping
Bracket determines where the two halves
of the Symmetrical Lattices are joined.

To set the clipping range:
1. Drag the top of the Clipping Bracket
to set the maximum upper range.

Any areas in the Terrain Canvas
whose gray levels fall outside the
bracket’s maximum upper range will
appear colored to indicate they will
be omitted from rendering.

2. Drag the bottom of the Clipping
Bracket to set the maximum lower
range.

Any areas in the Terrain Canvas
whose gray levels fall outside the
bracket’s maximum lower range will
also appear colored to indicate they
will be omitted from rendering.

The out-of-range colors for upper and
lower limits are different, to better enable
you to distinguish upper and lower
clipped areas at a glance. Upper
out-of-range color is usually blue, and
lower out-of-range is usually red, though
the colors change for many of the color
maps.

To reset the Clipping Bracket:
o Hold down Option/Alt and click the
bracket.

To move the entire Clipping Bracket at
once:

o Click the center of the Clipping
Bracket and drag up or down.

Terrain objects are actually hollow, so if
you clip the upper range off your terrain,
you'll be able to see through the top of the
terrain to whatever is underneath. To
eliminate this effect you can add caps to
your terrains. Caps seal up any holes in
the terrain’s top, bottom or sides.

To add caps to your terrain:

o Click the triangle icon below the
Color/Grayscale toggle button and
choose one of the following from the
menu: Top Cap, Bottom Cap or Side
Caps.
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Saving Terrains

Since the terrains you create in the
Terrain Editor are objects in the scene,
you can save any terrain in the Preset
Obijects Library just as you would any
object. Refer to “Adding and Deleting
Preset Objects” on page 126 for
instruction on saving objects to the preset
library.

Tips for Speeding Up the Terrain
Editor on Slower Machines

To speed up performance on slower
machines, disable both the Realtime
Linking and AutoRotate options.

To speed up the Elevation effects, use the
single-click method rather than the click-
drag “dial in” method, as the latter can be
quite slow on these machines.

When you create a terrain in your Bryce
scene, a natural impulse is to immediately
dress it up with a cool material and
render it right away to see what it looks
like. For serious composition, consider
keeping your terrains free of textural
attributes until the final stages, as
procedural textures take longer to render
than smooth shaded surfaces. This will
keep you working rapidly on your
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composition. Then, before your final
output, you can take some time to design
surfaces for your terrain.



Materials

Materials are what bring your Bryce
environment to life. A material defines
the surface properties of an object in your
scene. It has the power to turn a bunch of
polygons into an island or the peaks of
the Himalayas. You can also alter the basic
function of an object. A simple cylinder
can become a pillar, a tree trunk or a
metal pipe, just by adjusting the
properties of the material applied to it.

In Bryce, a material isn't just a picture
that’s wrapped around an object; it’s a
truly 3D surface. The material properties
you assign to an object are applied to the
whole object—inside and out.

Bryce’s new volume materials let you
apply a material to the interior of the
object as well as to its surface. The
Volume Material controls let you set how
the entire object’s volume reacts to its
environment.
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Material Structure
A material is made up of fourteen
channels. Each of these channels defines a
different property of an object’s surface.
When you combine all the channels
together you get a material.

—Material Channels

aterial

A material has fourteen channels that define its
surface properties. The combination of the
values of all the channels produces a material.

New materials are created by adjusting
the values for each channel.

There are two types of materials you can
create in Bryce: surface materials, which
define the properties of an object’s
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surface, and volume materials, which
define the properties of an object’s
volume.

Understanding Surface Material
Channels

The fourteen channels of a surface
material each represent a different surface
property. These properties simulate
different physical properties of a surface,
and the combination defines how the
object’s surface interacts with light in the
Bryce environment.

To understand how the channels work
you need to understand a little about how
you perceive light and color.

The color and size of an object is
determined by how the light that hits the
object is reflected back to your eye.
Objects appear green because they reflect
green light. Objects are reflective because
they reflect light. An object appears shiny
because it reflects light back at you.

An object appears transparent because
light passes through its surface, hits the
objects behind it and is reflected back
through the surface. Bryce’s material
channels simulate all these behaviors.
When you set a channel value, you're
setting how your object’s surface interacts
with light that hits it, whether that light is

from a direct source like the sun, or an
indirect source like light reflected off
other surfaces.

Light Source

Material channels simulate physical properties
of an object. When you set channel values, you're
defining how the object’s surface, or volume,
interacts with light.

When you're creating volume materials,
your settings not only control how light
interacts with the surface of the object,
but also how it interacts with the object’s
volume.

The effects of the channels are additive,
meaning that each value you set directly
affects all the other values. So, if you set
the Diffuse Color to yellow and the
Ambient Color to Blue, the object will
have a greenish tint.



Channels are interdependent. For
example, you won't see the effects of the
Transparent Color if the object is not
transparent.

should always add up to 100, and
Diffusion and Ambience values should
also always add up to 100.

Each surface material is made up of
fourteen channels, divided into three
groups:;

When you're using these channels it’s
important to understand the physical

property they’re simulating. Only in this
way can you make meaningful
adjustments to the component values.

For example, if you set both Transparency
and Reflection to 100, you'll get an
unusually bright object that doesn’t look
very realistic. The reason for this is that
the object is emitting more light than it is
receiving, something it couldn’t do in
reality.

Since material channels simulate
real-world surface properties, you should
try to keep channel values within a
realistic range.

For example, here Transparency and Reflection
are both set to 100. With these settings you're
saying that 100% of the light that hits the object,
passes through its surface, and 100% of the light
that hits the object is also reflected off its surface.

The result is an object that emits more light than
it receives because it’s reflecting the light that
hits it as well as the light from behind it.

Color channels

Diffuse Color
Ambient Color
Specular Color
Transparent Color
Specular Halo

Volume Color

Value channels

+ Diffusion

+  Ambience

+  Specularity
In reality, an object can only reflect a portion of . .
the light that’s passing through it. So, Metallicity
Transparency and Reflection values should «  Bump Height

always add up to 100.

A good rule of thumb to keep in mind
while you're setting these channels is that
the Transparency and Reflection channels

Materials
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Optics channels
* Transparency
* Reflection

+ Refraction

Color Channels

The Color group contains all the
channels that control the color reflected
off an object’s surface. The channels in
the Color group are Diffuse Color,
Ambient Color, Specular Color,
Transparent Color and Volume Color.

Diffuse Color, Ambient Color, and
Specular Color define the colors the
surface reflects when direct light hits it.
For example, Diffuse Color defines the
color that is reflected in all directions
when direct light hits it and Specular
Color is the color that appears in the
object’s highlight.

These color channels are directly related
to the Diffusion, Ambience, and
Specularity channels. Diffusion,
Ambience, and Specularity control how
light reflects off the object, while Diffuse
Color, Ambient Color and Specular Color
control the color of that light.
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So, for example, if you selected yellow as
the Diffuse Color, the object appears
yellow. The intensity of the yellow color is
controlled by the Diffusion channel.
Refer to “Diffuse Color” on page 200,
“Ambient Color” on page 202, and
“Specular Color” on page 204 for more
information.

Transparent Color sets the color of any
light that passes through the surface of
the object and Specular Halo controls the
size of the highlight that appears when an
object has a shiny surface. Refer to
“Transparent Color” on page 207 and
“Specular Halo” on page 204.

The remaining color channel, Volume
Color, controls the color of the interior of
the object. Refer to “Volume Color” on
page 210 for more information.

Value Channels

The second group of channels, the Value
group, controls how much light affects an
object. The channels in the Value group
are Diffusion, Ambience, Specularity,
Metallicity and Bump Height.

Diffusion, Ambience, and Specularity
define how the surface interacts with
direct light. They let you control how
much direct light affects the surface of an
object. In a physical environment, these

channels control how shiny, dark or
bright the object appears. Refer to
“Diffusion” on page 200, “Ambience” on
page 201 and “Specularity” on page 203
for more information.

Metallicity is related to Reflection. It
determines how much reflected light is
filtered through the Diffuse Color. Refer
to “Volume Material Channels” on

page 210 for more information.

Bump Height controls the height of any
bumps or dents on the object’s surface.
Refer to “Bump Height” on page 206 for
more information.

Optics Channels

The Optics group of channels controls
the intensity of optical effects produced
by the object’s surface. The channels in
the Optics group are Transparency,
Reflection and Refraction.

Transparency and Reflection channels
control how indirect light interacts with
the object’s surface. In a physical
environment, these channels control how
transparent or reflective the object
appears. Refer to “Transparency” on

page 206 and “Reflection” on page 209
for more information.



Refraction is directly related to
Transparency. The Refraction channel
sets how much the light that passes
though the object is bent. Refer to
“Refraction” on page 208 for more
information.

Understanding Volume Material
Channels

Surface materials define the properties of
the surface of an object. The interior of
the object is empty. If you were to fly
through the object you would see one
layer of material, emptiness and then
another layer of material. A volume
material is applied to the entire object,
both inside and out. If you were to fly
through a volume material you would be
surrounded by a material.

3

Blue spots become blue spheres

when the texture is applied as a
Volume Material.

When you create a volume material, the
channels define not just the surface of an object,
but its volume as well.

When you're setting channel values for a
volume material, you're setting up how
light will interact with the object’s
volume. Channels control whether the
interior of an object is bright, dark, shiny,
or transparent.

In most cases the interior of an object will
be filled with a texture. If so, the channels
control the surface properties of the
elements within the texture.

For example, if you apply blue spots as a
volume material, you get a volume filled
with blue spheres. The channels then
control whether those spheres are bright,
dark, shiny, or dull.

When the interior of an object is filled with a
texture, the material channels control the
surface properties of the elements within the
texture.

In this example, the Specularity channel is used
to make the blue spheres within an object shiny.
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Volume materials are made up of thirteen
channels, divided into three groups:

Color channels

+ Diffuse Color

+  Ambient Color

»  Specular Color

+ Transparent Color
»  Specular Halo

*  Volume Color

Value channels
+ Diffusion
+  Ambience

+  Specularity

Volume channels
+ Base Density
+ Edge Softness
*  Fuzzy Factor
*  Quality/Speed
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The channels in the Color and Value
groups work exactly as they do for surface
materials, except that the channel settings
are applied to the object’s volume instead
of its surface.

Volume Channels
The Volume channels control special

volume properties of the object’s interior.

Base Density controls the density of the
object. This channel defines how much
material there is in the interior of an
object. As a result, Base Density controls
how much light passes into the object. A
solid object doesn’t allow any light to pass
through it, while less dense objects allow
more light in. Refer to “Base Density” on
page 210 for more.

Edge Softness, Fuzzy Factor and Quality/
Speed control the appearance of texture
elements within the material. Edge
Softness and Fuzzy Factor control the
quality of the edges and sharpness of the
texture while Quality controls the render
quality of the material. Refer to “Edge
Softness” on page 211, “Fuzzy Factor” on
page 211 and “Quality/Speed” on

page 211 for more.

Understanding Material
Components

Each Bryce material channel can contain
up to three components that determine
the channel’s setting. A component can
be a color, a texture or a numerical value.
A texture can be either a 2D texture
(picture) or a 3D texture.

2D/3DTexture
Value —— Component
Color —
{_l
Channels

Each Bryce material channel contains
components that determine its setting.

You can have up to three texture components in
a channel, and some channels let you use four
textures and a value as components.

Colors can only be used in the Diffuse,
Ambient, Specular Transparent, Specular
Halo and Volume channels. Values are



used in the Diffusion, Ambience,
Specularity, Metallicity, Bump Height,
Transparency, Reflection, Refraction,
Base Density, Edge Softness, Fuzzy
Factor, and Quality/Speed channels.

When you're using a texture as a
component, the information in the
texture’s channels is used as the value of
the material channel. For example, if
you're using a texture to set Diffuse Color,
the texture’s color channel is used. If
you're using a texture to set the Diffusion
value, the texture’s alpha channel
determines the Diffusion intensity.

Components are combined using one of
three modes: Mode A, Mode AB and
Mode ABC. In Mode A, only one
component is used to set the channel’s
value. In Mode AB, two components are
combined to set the channel’s value,
based on altitudes. The values from
texture A are applied at low altitude and
values from texture B are applied at
higher altitude.

In Mode ABC, the values of two textures,
A and B, are blended based on the alpha
channel of texture C.

When you're using textures as a
component you can choose from a
number of preset textures, or you can
open the Texture Editor and create your

own textures. Refer to “Combining
Components” on page 223 for more
information.

In some channels, you can use both a
texture and a value. In this case, the value
determines how much of the texture’s
value is used to drive the channel. For
example if you apply a Blue Checkers
texture to the Bump Height channel, the
texture sets the shape of the bumps and
the value sets how prominent those
bump appear.

In this example the shape of the bumps on the
object is set by the texture component in the
Bump Height channel, but the height of those
bumps is set by a value.

A Word About Alpha Channels

One of the outputs a texture component
can produce is an alpha channel. The
alpha channel is a grayscale
representation of the texture pattern or
grain. When you use a texture as a
component in a material channel, these
grayscale values are used to map surface
properties. White areas in the alpha
channel represent 100% of the effect and
black represents 0%.

Images, or 2D textures, also contain an
alpha channel. In images, the alpha
channel acts as a mask for the image. The
image’s alpha channel is used in the same
way as a texture’s alpha channel.
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Surface Material Channels

This section provides details on each of
the surface material channels.

Diffusion

Diffusion determines how much direct
light is reflected diffusely, or scattered, in
all directions.

Direct Light
-
- Viewer
I
/s
¢
I
/
Surf =
urface I
reflects light \ 4
diffusely !

The small arrows projecting off the surface of the

object illustrate how Diffusion works.

When light hits an object with diffusion
set to 100%, all the light that hits it is
reflected back scattered in all directions.
This gives the object a flatly lit

Bryce 3D

appearance. If the object’s diffusion is set
to 0%, no light is reflected off its surface,
so the object appears black.

Diffusion set to
0% 100%

Diffusion set to

Diffusion controls how much light is diffusely
reflected off the object’s surface.

Setting Diffusion Using a Texture

When you assign a texture to the
Diffusion channel, the texture’s alpha
channel determines which areas of the
surface have high diffusion and which
have low diffusion. Bright areas in the
alpha channel have a high diffusion value
and darker areas have low diffusion
values.

Higher Diffusion
values

Lower Diffusion
values

E: Alpha Channel

When you use a texture to set the Diffusion
channel, the grayscale values in the texture’s
alpha channel determine the diffusion of the
objects.

Diffuse Color

Diffuse Color acts like a filter through
which all diffuse light passes. When light
hits the object, the amount of light that’s
reflected diffusely is determined by the



Diffusion channel setting, and the color
of that light is set by the Diffuse Color
channel.

Direct Light

Diffuse Color T
~ “Viewer

Surface ?
reflects light
diffusely

This graphic shows how diffuse light passes
through the Diffuse Color.

When Diffusion is set to a value greater
than zero, the Diffuse Color appears
wherever the object is hit by direct light.

Diffuse Color
applied to areas
hit by direct light

Diffuse Color is the color of diffusely reflected
light.

Be careful when using pure constant
colors as the Diffuse Color because you
may not get the results you're expecting.
If you use a pure color, only that color is
reflected off the object. So if you're using
100% green, only green light is reflected
off the surface. This doesn’t cause a
problem when the object is hit by white
light because there is green in white.
However, if you use 100% red light on the
object, it will appear black, since there is
no green in 100% red, so no light is
reflected off the object.

Try to avoid using pure colors for the
Diffuse Color, so that your object always
reflects some color.

Ambience

Ambience simulates the effects of light
hitting the object from all directions. The
Ambience value controls the amount of
light that is reflected off the surface
uniformly.

Qﬁ X

Light from
all directions

? Lsaitlz(attered
A X zgi\

The large arrows represent ambient light hitting
the object’s surface. The smaller arrows
represent the light reflected off the object’s
surface.

When Ambience is set to a value higher
than zero, the object will reflect light
from all over its surface, not only from
the area hit by light. This makes the
object look brighter.

The higher the Ambience value, the
brighter an object appears. At 100%, the
object appears unnaturally bright,
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regardless of the light source. If you want
to create a realistic effect, the sum of the
Ambience and Diffusion values should

add up to 100.

—adl

Ambience set to

Ambience set to
0% 100%

Ambience controls the general brightness of an
object.

An object’s ambience is directly related to
the general ambience of the environment.
So, the ambient value you set for the
object is directly affected by the Ambient
Color you set in the Sky & Fog palette.

The Ambient Color in the Sky & Fog
palette controls how much ambient light
is available in the environment. The
Ambience channel controls how much of
the available ambient light is reflected off
the object’s surface.

So, if you set the Ambient Color in the
Sky & Fog palette to black, or 0%
ambience, then the Ambience channel
value has no effect. If you set the Ambient
Color to white, or 100% ambience, the
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Ambience channel value will control how
much of the available light is reflected off
the object’s surface.

Setting Ambience Using a Texture

When you assign a texture to the
Ambience channel, the grayscale values
from the texture’s alpha channel
determine which areas of the surface have
high ambience and which have low
ambience. Bright areas in the alpha
channel have high ambience values and
darker areas have low ambience values.

Higher Ambience
values

Lower Ambience
values

|
H_| Alpha Channel

When you use a texture to set the Ambience
channel’s value, the values are determined by
the grayscale values in the texture’s alpha
channel.

Generally, it’s best to set Ambience using
a value. However, you can get some
interesting effects using textures instead.
For example, if you use a splotchy texture,

you'll get areas of your surface that
appear to glow regardless of external
light, mixed in with normal surface areas.

Ambient Color

Ambient Color is the color that is
reflected off the surface of an object
regardless of where the light source hits it.
The Ambient Color is directly linked to
the Ambience channel setting. If the
Ambience is set to zero, the Ambient
Color is invisible.

1
SN Ambient Color 7

>
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Ambient Color is the color that reflects off the
entire surface of the object and is directly related
to Ambience.



The Ambient Color tints the entire
surface of the image.

Ambient Color
tints the entire
surface

Ambient Color is the color that appears no
matter where light strikes the object.

The Ambient Color channel is also
related to the ambient color you set in the
Sky & Fog palette. The ambient color of
the environment is added to the ambient
color of the object, so if your
environment is blue and your object’s
ambient color is yellow, your object
appears green.

Setting Ambient Color Using a Texture

When you assign a texture to the Ambient
Color channel, the color channel in the
texture is used as the Ambient Color. In
other words the texture’s color is applied
to any area of the object that’s in shadow.

Specularity

Specularity controls how much light is
reflected back from the surface of the
object at the viewer.

Viewer sees
highlight

Incoming Light
Reflected Light

Surface is
reflective

Specularity is the highlight reflected back at the
viewer.

Since the direct reflection creates a
highlight on the object, you can think of
Specularity as the channel that
determines the intensity of the highlight
that appears on the object, or the
“shininess” of the object.

The higher you set the Specularity, the
shinier the object appears. When the
Specularity is set to zero, the object
appears dull.

Specularity set to Specularity set to

0% 100%

Specularity controls the intensity of the highlight
of an object.

Setting Specularity Using a Texture

When you assign a texture to the
Specularity channel, the grayscale values
in a texture’s alpha channel are applied to
the object’s highlight. Bright areas of the
alpha channel increase the intensity of the
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highlight, and darker areas decrease the
intensity. The alpha channel may also
create patterns in the highlight.

High Specularity
values

Lower Specularity
values

. Alpha Channel

When you use a texture to set the Specularity
channel’s value, the highlight’s intensity is
determined by the texture’s alpha channel
values.
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Specular Color

Normally, the color of an object’s
highlight would reflect the color of the
light source. However, using Specular
Color you can set a specific color for your
highlight.

Specular Color
applied to
object’s highlight

Specular Color is the color of the object’s
highlight.

Specular Color is directly linked to the
Specularity channel. If the Specularity is

set to zero, the Specular Color is invisible.

By adding Specular Color you can make
it appear as though a colored light is
shining on the object.

Setting Specular Color Using a Texture

When you assign a texture to the Specular
Color channel, the texture’s color channel
is used as the Specular Color. In other
words the texture’s color is applied to the
object’s highlight.

Specular Halo

The Specular Halo channel lets you
control the size of the Specular highlight.

The size is controlled by the luminance
value of the component you select.
Brighter colors create larger highlights
and darker colors create smaller
highlights.

Specular Halo set
using bright colors

Specular Halo controls the size of the highlight
on your object.

Specular Halo set
using dark colors

Colors are expressed as RGB (Red, Green
and Blue) values. Specular Halo channels
use the values from each of these
channels to set the size of the highlight. If
the values are all in balance (that is, all the
same), the highlight appears uniform.
However, if one value is higher that the
rest (for example, R=200, G=100,



B=100), you'll get a highlight with a
slightly colored ring (for example, a red
ring).

Specular Halo
with balanced
color

Specular Halo with
varied RGB values

When you use a balanced color as the Specular
Halo, you get a uniform highlight. If you use a
color with varied RGB values, slight rings
appear on the highlight.

Depending on the component you use in
this channel, you may be able to set each
color value differently to create different
highlight effects. The easiest way to use
this channel is with a color.

When using a color, try picking more
desaturated colors. These colors produce
more predictable results because the
difference between RGB values is less.

r il _-‘-'-‘——_.___ R
Check out the Specularity Lesson
series in the Fast & Simple category in
the Preset Materials Library to see
Specular Halo in action.
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Setting Specular Halo Using a Texture

When you assign a texture to the Specular
Halo channel, the RGB value of the
texture’s color channel is used for the
Specular Halo.

Metallicity

The Metallicity channel value acts as a
filter for reflected light. This value
controls how much of the reflected light
is filtered through the Diffuse Color.

At 50%, half the reflected light is tinted
with the Diffuse Color; at 100%, all the
light that’s reflected is tinted.

Metallicity is linked to Reflection. If
Reflection is set to zero, the Metallicity
channel has no effect.

Metallicity set to
50%

Metallicity controls how much of the reflected
light is tinted with the Diffuse Color.

Metallicity makes objects look metallic
because it tints the color of reflections. If
you want to create specific types of metals
you need to adjust the Diffuse Color. For
example, to create gold use a yellow
Diffuse color.

Setting Metallicity Using a Texture

When you apply a texture to the
Metallicity channel, the texture’s alpha
channel is used to determine the intensity
of the Diffuse Color. Lighter areas of the
alpha channel increase the intensity of the
color, and darker areas decrease the
intensity.
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Bump Height

The Bump Height controls the height of
bumps in an object’s surface. The bumps
on an object’s surface are determined by
the texture’s Bump channel. The Bump
Height channel is linked to the Bump
channel in the texture. If you use a texture
without a Bump channel, this channel
has no effect. You can enter negative
values in this channel, which turns
bumps into dents.

Bump Height set to
-100%

Bump Height set to
+100%

Bump Height controls the height of bumps on
the surface of your object.
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Transparency

The Transparency channel controls how
much light can pass through the object’s
surface.

Direct Light

b
The amount of light that can pass through an
object’s surface is set with the Transparency
channel.

The higher the Transparency value, the
more of the surrounding environment is
visible through the object’s surface. If

there is no other light being reflected, an
object set at 100% Transparency appears

invisible.

Transparency set to

Transparency set
to 0% 100%

Transparency controls how much of the
surrounding environment is visible through the
object’s surface.

To create a realistic transparent object,
you need to pay attention to details. You'll
need to combine the effects of the other
channels to simulate a realistic object. For
example, transparent bubbles all have
highlights, so you'll need to add
Specularity. Balloons have a flatter
surface so you'll need to add more
Diffusion to the surface. Glass has a
refraction effect associated to it, so you'll
need to add Refraction to the surface.



Setting Transparency Using a Texture

When you apply a texture to the
Transparency channel, the texture’s alpha
channel is used to determine which areas
of the object are transparent. Lighter
areas of the alpha channel are not
transparent while darker areas are.

You can create some interesting effects
using textures. For instance, a
checkerboard texture will result in an
object that's alternately transparent and
solid. The final look of the Transparency
channel is determined by the Shading
mode. When the material is applied using
normal shading, Transparency creates an
optical effect.

When the material is applied using Blend
Transparency mode, Transparency creates
a punch-out effect. The areas of the
surface that are 100% transparent are
completely ignored during shading so
that they appear as gaps or holes it the
surface. Any areas that are less than a
100% result in a normal transparency
effect.

Refer to “Shading Modes” on page 225
for more on Shading modes.

Cage texture
applied to
Transparency
channel

You can create some interesting effects using
textures in the Transparency channel, like this
checkerboard object. This example was created
using regular shading.

This is what the same material looks like when
you use Blend Transparency.

Transparent Color

The Transparent Color channel
determines the color of the transparent
areas of your object. Light is filtered
through this color as it passes through the
object’s surface. As a result, anything you
can see through your object is tinted with
the Transparent Color you select.
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Transparent Color tints any light that passes
through the object.

Keep in mind that the Transparent Color
interacts with the other colors in the
material. If the Diffuse Color is white,
then the Transparent Color takes
precedence. If the Diffuse color is yellow,
and the Transparent color is red, the
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object appears orange. However, when
you're using Refraction, the Transparent
Color blends with the Diffuse Color.

Transparent
Color applied to
the object

The Transparent color tints everything you see
through the surface of your object.

Transparent Color is linked to the
Transparency channel. If the
Transparency is set to zero, the
Transparent Color is invisible.

Setting Transparent Color Using a
Texture

When you assign a texture to the
Transparent Color channel, the texture’s
color channel is applied to the
transparent areas of your object.
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Refraction

The Refraction channel determines
whether light bends when it passes
through the surface of an object.

_Ar
Light is A
filtered o
through P o
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|I I, |if Refraction
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) / / / than 100
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Light may bend as it passes through an object,
depending on the Refraction value.

Higher Refraction settings produce slight
reflections as some of the light is bent
directly back at its source. Higher
Refraction settings also change the color

of the object’s surface as the colors
reflected from the environment affect the
object’s color.

Refraction set to Refraction set to
0 116

Refraction controls how much light bends as it
passes through a transparent surface.

The Refraction value is what makes
transparent surfaces look like glass.

As you increase the Refraction value, the
edges of the object will become reflective.
This simulates the effect of light being
refracted so sharply that it does not
penetrate the object’s surface.

Refraction set to
140 300

Refraction set to

In these examples you can see how the edges
become more reflective as you increase the
Refraction value.



The higher you increase the Refraction
value, the more the Diffuse Color is
blended with the Transparent Color. The
higher the value, the more Diffuse Color
is visible in the object’s surface. Any light
that’s visible through the surface of the
object is then tinted through both the
Diffuse Color and the Transparent Color.

-~ i

B
Refraction values are expressed as

100 x Refraction Index value. The
Refraction Index contains refraction
values for specific types of surfaces.
For example, the Refraction Index of
water is 1.3; this value is expressed as
130 in the Materials Lab.
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Refraction is linked to Transparency. If
Transparency is set to zero, this channel
has no effect.

Setting Refraction Using a Texture

You cannot use a texture to set the value
of the Refraction channel. You can only
use a value to set this channel.

Reflection

The Reflection channel controls how
much light, direct or indirect, is reflected
off the object’s surface. Unlike Diffusion,
which scatters light, Reflection directs
light back at its source, giving the object a
mirrorlike appearance.

Incoming Light
e

EC ol
! Surface is " Reflected Light

Reflective |

154
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Viewer sees object on
the surface of object

Reflection determines how much light is
reflected off the surface of the object.

The higher the Reflection setting, the
more reflective the surface. At 50%, half
the light that hits the object’s surface is
reflected, at 100% all light is reflected.

-
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Reflection set to

Reflection set to
50% 50%

Reflection controls how much light is reflected
off the surface of an object.

As you increase the Reflection value, the
color of the object changes, since you can
see more of the environment in the
object’s surface.

Setting Reflection Using a Texture

When you apply a texture to the
Reflection channel, the texture’s alpha
channel is used to determine which areas
of the object are reflective. Lighter areas
of the alpha channel are reflective, while
darker areas are not.
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Volume Material Channels

Volume materials use most of the same
channels as surface materials. These
channels all work the same as they do for
surface materials. The only difference is
that the channels control the properties
of the object’s volume, not its surface.

In addition to the channels already
discussed, Volume materials have several
specialized channels.

Volume Color

The Volume Color channel controls the
color applied to the interior of an object.
Everything inside the object will appear
tinted with this color as all light is filtered
through the Volume Color.
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The interior of an object can have color, which
you set with Volume Color.

The Volume Color interacts with the
Transparent Color. If your surface is
transparent, light is tinted by the
Transparent Color and the Volume Color.

Volume Color
applied to the
interior of the
object

The Volume color tints everything inside the
object.

Volume color is an excellent way of
creating underwater light effects.

Base Density

Base Density controls how dense the
object is. In areas where the object is very
dense, no light passes through the object.
Where the object is less dense, more light
passes through its volume. Base Density
works like Transparency in 3D space.
Areas that are less dense appear to be
more transparent.

High values create very solid objects like
rocks, while lower settings create less
dense objects like clouds.

Base Density set
to 100 to 0

Base Density set

Base Density controls the density of the area
within an object. Objects with a low density will
appear more transparent.

You should use this channel cautiously.
The more transparent objects are, the
more time they take to render.



Setting Base Density Using a Texture

When you use a texture to set this
channel, the alpha channel is used to
determine which areas of the object are
solid and which are empty.

Edge Softness

Edge Softness controls the softness of the
edges of the silhouette of objects with a
volume material. For example, a sphere
with a low Edge Softness value will have a
“hard” silhouette, meaning that you'll be
able to clearly see the edges of the sphere.
A high Edge Softness value will almost
totally obscure the edges of the sphere.

Edge Softness
setto 0

Edge Softness
set to 100

Edge Softness controls the softness of an object’s
silhouette.

This channel is useful for obscuring the
general shape of an object. Use this effect
if you want to blur the overall shape of
the object to which you're applying the
material.

Fuzzy Factor

Fuzzy Factor controls the dullness or
sharpness of a material. Values greater
than 100 adjust the dullness of the
material, and values less than 100 adjust
the sharpness of a material. At 100 there
is no dullness or sharpness applied

Fuzzy Factor set
to 0 to 200

Fuzzy Factor set

Fuzzy Factor controls dullness/sharpness of the
texture within your object.

As you increase the dullness of your
object, it becomes less dense, so you may
have to increase the Base Density to
compensate. Likewise, as you increase the
sharpness of the object it becomes more
dense.

You can use this channel to smooth
sharp-looking clouds, or sharpen dull
stone textures.

Quality/Speed

Quiality/Speed controls the render quality

of the texture. This channel represents the

inverse relationship between render

quality and rendering speed. As you

increase the render quality of the

material, you decrease the speed at which

its rendered. As you increase the speed at

which a material is rendered, you r
decrease its quality.

Quality/Speed
setto setto O

Quality/Speed
set to set to 100

The Quality/Speed value controls the quality of
the texture’s render in relation to how fast it
renders.

The material loses detail as the quality
decreases. Detail is introduced as it
increases.

For still images you probably want to
increase the quality of the material and
sacrifice speed, since the scene only has to
be rendered once. For animations, you
probably want to sacrifice quality since
the scene will have to be rendered once
for each frame in the movie.
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Material Components
This section describes the various
components you can use to set a material

channel value. It also describes how to set
the parameters for each component.

Color Components

A color component is an RGB color that
is directly applied to a channel. Colors
can only be used in the Color channels:
Diffuse, Ambient, Specular, Specular
Halo, and Volume.

When you're using a color in these
channels you cannot combine it with a
texture. If you choose a texture
component for any of the Color channels,
the color oval appears blank. The Volume
channel can only be set with a color.
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To use a color as a component:

1. Inthe Materials Lab, click the color
oval in one of the channel rows on
the Material Grid and choose a color
from the palette.

The Color oval in the channel column displays
the color palette.

+ Tochoose a color using the Color
Picker, hold down Option/Alt
when you click the color oval.

The selected color appears in the
color oval. If you click on one of the
columns, the color oval appears
blank.

Value Components

Value components are numerical values
you use to set the intensity of a channel.
Values can only be used in the Value,
Optics or Volume channels.

A value is indicated by either the
numerical field in the left side of the
channel in the Material Grid, or the slider
that extends out from the channel. The

sliders let you quickly set the value of a
channel and the numeric field shows the
current setting.

TRANSPARENCY

REFLECTION

The value slider in a channel lets you set a
numerical value for the intensity of the channel
and displays the channel’s current setting.

Values can be used with textures. In this
case the value sets how much of the
texture is applied to the channel. For
example, if you use an orange-colored
texture to set the Diffuse Color channel,
the value would indicate how much of the
texture color is used as the Diffuse Color.

A value of 100 means that all the texture
information is used in the channel; a
value of 0 means that none of the texture
is used.

Not all channels use values. The Color
channels only use colors or textures. The
Refraction channel can only be set with a
value.



To use a value as a component:

o Inthe Materials Lab, drag the slider
next to the channel whose value you
want to set. As you drag, the
numerical value appears in the
number field.

Some channels let you set negative
values.

Texture Components

When you use a texture as a component,
Bryce extracts values from the texture to
use as a value for the material channel.
There are two types of texture
components you can use: pictures and 3D
textures. Pictures are images you import
from either the Picture Library or from
another application. 3D textures are
procedural textures generated by Bryce
and stored in a texture library.

You can assign up to four textures as
components for a material. These
textures can be any combination of
pictures and 3D textures. Each texture
component is assigned a letter: A, B, C, or
D.

The texture you assign to a component is
used throughout the material, so the
texture you assign as component A in the

Diffusion channel is the same component
A used in the Ambience channel and so
on.

When you're setting channel values, you
can mix and match components. For
example, you can assign component A to
Diffusion and component D to
Ambience. You can also combine textures
within the same channel using the blend
modes AB and ABC. In this case the
texture you assigned to A is blended with
the textures assigned to Band C to set a
material channel value. Refer to
“Combining Components” on page 223
for more on blend modes.

The Texture Component Window

The Texture Component window
displays the attributes of a selected
texture component. You can have up to

four windows visible in the Materials Lab.

Display Deep

Texture Editor
Display Texture Texture Name
Transformation
Palette

Texture Library
list

Use Picture | Mapping Modes

Use 3D Texture Current Mapping Mode

The Component window displays the selected
component and its current attributes.

The six buttons on the Texture
Component window let you set the type
of component, the texture mapping
mode, access the texture transformation
controls and the Deep Texture Editor.

To use a Texture as a component:

o Click acolumn in the material grid. A
Texture Component window appears.

The component window corresponds
to the columns in the grid, so if you
click column A in the grid, texture
component A becomes active.
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3D Textures

3D textures have three different types of
outputs: Color, Alpha channel and Bump.
These outputs are used differently by the
material channels.

Color channels use the texture’s color to
set the value of the channel. For example,
if you use a texture in the Diffuse
channel, the colors in the texture appear
wherever the object reflects light
diffusely.

Diffuse color set
using a texture

Diffuse color set
using a color

When you use a texture to set the value of a
Color channel, the color information is used to
set the material channel value. In this example,
the Diffuse color was set using a texture.

Value, Optics and Volume channels use
the alpha channel information from a
texture to set the value of the material
channel. For example, when you use a
texture to set Specularity, the texture’s
alpha channel information determines
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which areas of the object are shiny. As a
result, you'll see the pattern of the texture
on the object.

Specularity set
using a value
When you use a texture to set the value of an
Intensity channel, the alpha channel
information is used to set the material channel
value. In this example, Specularity was set using
a texture.

Specularity set
using a texture

The Bump information in a 3D texture is
used only by the Bump Height channel.
The Bump channel in the texture
determines the pattern of bumps or dents

in the object. In fact, you won't be able to
see the effects of the Bump Height value
unless you assign a texture to the channel.

ump Height set B
using a value using a texture

Bump channel information from a texture is
used to determine the pattern of bumps or dents
in an object. You must assign a texture to the
Bump Height channel to see the bumps or dents.

To use a 3D texture as a component:

1. Inthe Materials Lab, click a channel
column.

A randomly selected texture appears
in the Component window.

When you select 3D texture as a component, the
Component window displays a randomly
selected texture in the preview area and shows
the texture’s current attributes.



2. If you want to change this texture,
click the triangle button next to the
texture name at the top of the
window and choose a preset texture
from the menu.

The triangle button next to the 3D texture’s

name in the component window provides access
to all the preset 3D textures available in Bryce.

The texture you selected appears in
the Component window.

2D Textures

2D textures are pictures you've created in
another application or one you've
selected from the Pictures Library. The
data in the channels of these pictures are
used as values in the material channels.

To use a 2D texture as a component:

1. Inthe Materials Lab, click a channel
column. A texture appears in the
texture component window.

2. Inthe Component window, click the
P button at the bottom of the
Component window.

The P button changes the component to a 2D
picture.

A default picture appears in the
Component window.

When you select 2D texture as a component, the
Component window displays a default picture
in the preview area and shows the picture’s
current attributes.

3. To change the picture, click the pink
button at the top of the component
window.

.. [

The pink button displays the Pictures Library.

The Pictures Library appears.

The Pictures dialog lets you select a 2D images to
use as a Pict object.

4. Click an image square to load an
image.

5. If the image you want is not in the
library:

+ Click the Load text button. The
Load Image dialog appears.

+ Use the dialog controls to locate
the picture you want to use and
click Open.

or

+ Inanother application, copy the
picture you want to use to the
Clipboard.

+ Access the Picture dialog and
click the Paste text button.
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The picture is loaded into the first
image box and its alpha channels are
loaded into the second box.

When you load a new picture into the Picture
dialog, the main image is loaded into the first
box and its alpha channel is loaded into the
second box.

You can invert the alpha channel by
clicking the invert button.

R -
6. Click the OK icon to exit the dialog.

The picture appears in the
Component window.
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Texture Mapping Modes

Once you've decided on a texture to use
as a component, you need to decide how
the texture is mapped onto your object.
The appearance of the texture can change
dramatically depending on how it’s
applied to the object.

Each texture you apply can have a
different mapping mode. When you're
mixing textures (Mode AB or Mode
ABC), you can choose which portions of
your textures you want to combine.

To select a mapping mode for a texture:

1. Inthe Materials Composer, click a
channel.

Select a mode for the channel.

3. Click the title of the Component
window and choose either 2D
Texture or 3D Texture.

4. Click the current Mapping Mode title
and choose a mapping mode from
the menu.

Object Space

In this mode, textures are scaled
proportionally to the size of your object.
If you change the size of your object, the
texture scale changes with it. The texture
also rotates along with the object. This
means that the texture does not appear to
move as you reposition or rotate the
object.

In Object Space mode, textures are applied to
the object so the texture will not move as you
move the object.



World Space

In this mode, the texture is infinitely large
3D space, and only a small portion is
applied to your object. This means that
the texture appears to change as you
move your object, since it is moving
through the texture in 3D space.

In World Space mode, the texture is applied to
the entire world, so the texture appears to move
as you move the object.

Parametric

In this mode, the texture is applied onto
the object as if it were a decal. For
example, if you use this mapping mode
on a cube, one iteration of the texture is
placed on each face.

Parametric mode applies the texture as a 2D
decal.

The texture is mapped onto the object so
it rotates and scales as the object is scaled
or rotated.

This mode works best with 2D Pict
textures.

Parametric Scaled

This mode works like the World Space
moade, only in 2D. Textures mapped using
this mode are not scaled with the object.

S=

Parametric Scaled mode applies the texture as a
decal, but does not scale the texture as you scale
the object.

Use this mode when you want to map a

2D picture onto constructed objects like
buildings.
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World Top Spherical Cylindrical

In this mode a 2D projection of the In this mode, a 2D projection of your In this mode, your texture is mapped
texture is applied to the object from texture is mapped onto a virtual sphere onto the front of your object, wrapping
directly above it. If you move your object that surrounds your object. It is then around the right and left sides all the way
or rotate it, the texture does not move projected from the sphere onto your to the back. Edge pixels going to the

with the object; it remains constant while object. center appear on the top and bottom of
the object moves through it. your object.

g

| N

\

Spherical mode applies the texture to a virtual

World Top mode applies the texture to the top of sphere and then projects it onto your object. Cylindrical mode wraps a texture around the
the world. The texture appears as a projection object starting from the front.
on top of the object and streaks down its sides.
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Reflection Map

In this mode, a 2D projection of your
texture is applied to a virtual sphere that
surrounds your scene. The texture is then
reflected off of the sphere and onto your
object.

Parametric
Scaled

Reflection
Map

Reflection Map mode applies a reverse image of
your texture to your object.

This mode works best on objects with
irregular surfaces. It also works well with
terrains.

Random

This mode randomly applies a
2D projection of the texture all over the
surface of your object.

Random mode applies the texture all over the
object in a random pattern.

Object Top

This mode applies a 2D projection of the
texture to the top of your object. The
texture rotates and scales along with the
object.

Object Top mode applies the texture to the top of
the object.
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Object Front

This mode applies a 2D projection of the
texture to the front of your object. The
texture rotates and scales along with the
object.

Object Front mode applies the texture to the
front of the object.
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Mapping Mode Modifiers

You can modify the mapping modes in
two different ways.

Symmetrical Tiling

When you tile a texture onto an object in
symmetrical tiling mode, each repeated
instance of your texture is tiled
horizontally and vertically as needed to
seamlessly produce a symmetrical pattern
over the surface of the object.

in Symmetrical Tiling mode, textures are
seamlessly tiled across the object.

Scale Pict Size

This mode modifier only affects picture
textures. When selected, the image is
scaled to cover the entire surface of the
object instead of being tiled.

Transforming Textures

Since a 3D texture exists in
three-dimensional space, it can be
transformed along the X, Y, or Z
axis—just like a 3D object. Using the
texture transformation tools, you can
scale, position or rotate your texture.

The final look of the transformation
depends on the mapping mode you use to
apply the texture to the object. In some
modes, texture transformations may not
be very noticeable, while in others, like
Parametric, transforms can have a large
impact on the look of the material.

You may find it necessary to experiment
with different settings to get the results
you want. If you find that the texture isn’t
reacting the way you want it to, try
changing the mapping mode. Refer to
“Texture Mapping Modes” on page 216
for more on mapping modes.

The transformation tools give you very
fine control over the final appearance of
the texture.

Scale

Using the Scale tool, you can control the
frequency of the texture. Increasing the
scale of a texture decreases the frequency



of the pattern, since it doesn’t have to be
repeated as many times to cover the
surface of the object.

Scale X=0% Scale X=50% Scale X=100%

Since a 3D texture exists in 3D space, you can
change its size in all three axes. Adjusting the
scale in X changes the size of the texture along
the X axis.

VY

Scale Y=0% Scale Y=50% Scale Y=100%

Adjusting the scale in Y changes the size of the
texture along the Y axis.

A e

Scale Z=0% Scale Z=50% Scale Z=100%

Adjusting the scale in Z changes the size of the
texture along the Z axis.

Rotation

Using the Rotation controls you can
control the angle of the texture on the
object’s surface. You can create very
different texture effects depending on its

orientation. Rotation Rotation Rotation
Z=0° Z=90° Z=180°
Adjusting the orientation in Z changes the angle
of the texture along the Z axis. r
You can transform a texture numerically
by adjusting the X, Y and Z coordinates !
or interactively using the transformation I
Rotation Rotation Rotation tools.
X=0° X=90° X=180° ;
Since a 3D texture exists in 3D space you can .
Position

change its orientation in all three axes.
Adjusting the rotation in X changes the angle of
the texture along the X axis.

Ve

Rotation Rotation Rotation
Y=0° Y=90° Y=180°

Adjusting the orientation in Y changes the angle
of the texture along the Y axis.

Using the Position controls, you can
control where the texture appears on the
object’s surface. When you're using a
picture as a component, placement can
be vital to the look of the material. For
example, if you're placing a decal on an
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object, use the Position controls to e e U g . As you adjust the value, the material
preview updates to show the results

of your changes.

precisely place the image in the center of

the object or on the correct face To transform a texture numerically:

1. Inthe Texture Component window,
“. click the click the first button on the
left at the top of the window.

The Transformation palette appears.

Position Position Position

X=0 BU X=50 BU X=100 BU
Since a 3D texture exists in 3D space you can
change its position in all three axes. Adjusting
the position in X changes the placement of the
texture along the X axis.

>

The material preview area updates as you
transform the texture to show your changes.

4. Click the OK icon to apply your
changes.

To transform a texture interactively:

Use the texture transformation palette to adjust :

Position Position Position the scale, position and orientation of the texture 1 In. the Text_u re Component window,
Y=0 BU Y=50 BU Y=100 BU component. click the click the first _button on the
Adjusting the position in Y changes the left at the top of the window.
placement of the texture along the Y axis.

2. Move your cursor over the
transformation you want to apply.

3. Drag the cursor over the value you 2. Move the cursor over the tool you
g want to adjust. want to use until the mode you want
| ] ) is active.
v | Drag left to increase the value or right
to decrease it. 3. Asyou pass the cursor over the tool,
the tool changes to display the

Positi it Positi . .
720 BU. P 79100 8U different modes available.

Adjusting the position in Z changes the
placement of the texture along the Z axis.

The Transformation tools appear.
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4. Drag the mouse in the direction you
want to move, scale, or rotate the
texture.

5. Click the OK icon to apply your
changes.

Editing Textures

You can edit the makeup of an existing
texture or create a completely new texture
using the Deep Texture Editor. This
editor uses some rather complex
texture-generation concepts to create
textures for Bryce. You can either choose
to learn all these concepts to create your
textures precisely, or use the editor as a
type of lab where you combine random
settings and see the results.

Refer to “Textures” on page 239 for more
information about learning
texture-generation concepts.

Combining Components

You can combine material components
using one of three blending modes:

* Mode A
* Mode AB
* Mode ABC

Mode A

In Mode A, only one component is used
to set the value of a channel. The
component can be a value, a picture or
3D texture.

Mode AB

In Mode AB, two textures are blended
together based on altitudes. At the lowest
altitudes the values from texture A are
used, at higher altitudes texture B is used
to set the value of the channel.

Altitude is based on the distance between
the ground level and the highest object in
your scene.

When you use this mode, an object’s
surface material is a blend between two
texture components. Texture B appears at
the bottom of the object and Texture A
appears at the top. In between is a blend
between texture B and texture A. Bryce
creates the blend by interpolating
between the two textures.

For example, if you use Mode AB in the
Diffuse Color channel, the color in
texture A appears at the bottom of an
object’s surface, and the color from

texture B appears at the top. A color
gradient between color A and color B
appears in the middle of the object

In this example, Mode AB was used to set the
Diffuse Color channel. Values from texture A set
the Diffuse Color channel at lower altitudes
while values from texture B set the channel at
higher altitudes.

Mode AB can be used to create snow
covered peaks on terrains or murky
depths in infinite water slabs.

To use mode AB to blend textures:

1. Inthe Materials Lab, Control/Ctrl-
click the B column of a channel.
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Component indicators appear in
both the A and B columns of the
channel.

DIFFUSE N

Component indicators in both the A and B
columns of a channel indicates that you're using
mode AB to blend texture components.

Mode ABC

In Mode ABC, two textures, texture A
and texture B, are blended based on the
alpha channel of texture C. In this mode
the alpha channel from texture C acts like
a map that tells Bryce where to apply the
values from texture A and texture B. All
the white areas of the alpha channel use
values from texture A; black areas in the
alpha channel use values from texture B.
Gray areas in the alpha channel use a
combination of both textures.
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Alpha Channel Texture Used

Texture A

Combination
of Aand B

. Texture B
In the example that follows three textures

were combined using Mode ABC in the
Diffuse Color channel.

Texture A

Texture B

Texture C

Using Mode ABC to combine the three textures,
the spot texture (A) appears in the white areas of
the checker texture’s alpha channel (C) and the
lines texture (B) appears in the black areas of the
alpha channel.

To use Mode ABC to blend textures:
1. Inthe Materials Lab, Control/Ctrl-
click the C column of a channel.

Component indicators appear in the
A, B and C columns of the channel.

Component indicators in the A, Band C
columns of a channel indicate that you're using
Mode ABC to blend texture components.
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Shading Modes

Shading refers to the process of applying
material channel values to an object.
When an object is shaded, the different
values in the material are applied to the
object. The shading modes available in
Bryce determine how material channels
are applied to create different effects.

Using a material, you can define whether a
surface is shiny, smooth, or opaque.

Using a shading mode, you determine how those
properties are applied to the object.

The shading mode cannot only determine how
the material is applied to the surface of the
object, but how it’s applied to its volume as well.

To choose a shading mode:

o Click the triangle icon next to the
material type buttons at the top of
the Materials Lab.

EhiliEis Bai
P Pend - Sivisas

Click the triangle icon at the top of the Materials
Lab to display a listing of the available shading
modes.

Surface Material Shading Modes

This section explains the surface material
shading modes.

Normal

Normal mode applies the values of the
material without modifying them in any
way. Objects are shaded according to the
values you set in the material channels.
This mode has no special effects; it
simulates a real-world appearance using
the material channel values.

This is the default mode and is
appropriate for most objects.

Blend Transparency

In Blend Transparency mode, visibility is
controlled by Transparency. When this
mode is active, areas of the object that are
100% transparent are ignored.
Transparent areas are not shaded and do
not cast shadows. These areas appear as
gaps or holes in the object’s surface.
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This mode lets you create punch-outs
when using a texture.

Using Normal Shading

This cage was created by using blend
transparency to “punch-out” areas of the object’s
surface.

Anything less than 100% Transparency
results in normal transparent areas.
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Fuzzy

Fuzzy mode changes the effective
Transparency based on the thickness of
the object. As a result, objects appear
fuzzy on the edges and solid at the center.

When you apply a material using Fuzzy shading
mode, the edges of the object appear blurred,
while the center remains solid.

Since Bryce uses depth information to
synthesize this blurry effect, it is not
available for 2D objects such as Squares
or Disks.

Use the Transparency setting to adjust the
degree of fuzziness.

Light

Light is a very specialized shading mode
best used to create visible lighting effects.
Obijects shaded with this mode appear
transparent and self-illuminating.

The Light shading mode is designed to create
simple light effects. If you apply it to a cone
object, it looks like a cone of light.

Only the Diffuse, Ambient and
Transparent Color channels are used to
determine the color of the light. All other
channels are ignored.

This mode is useful for creating point
lights without the rendering overhead
that comes with true volume light objects
(that is, light-sensitive volume materials).



Volume Material Shading Modes

This sections explains the volume
material shading modes.

Flat Shading

Flat shading mode is designed for clouds,
gases and other self-luminous gaseous
materials. Flat shading mode does not
shade an object, meaning that light
sources have no effect on the color or
brightness of the object.

The Flat shading mode applies your material as
a volume material, but does not apply any
shading.

When this mode is active, Diffusion,
Ambience, Specularity, Ambient Color,
Specular Color and Transparency Color
have no effect.

The color of the material is determined
entirely by the Diffuse Color channel.

Full Shading

Full shading mode is designed for hard
edged, sharp objects like rocks. When Full
shading mode is active, the visible
portions of the material are shaded and
can be affected by light sources.

The Full shading mode applies your material as
a volumetric material, and applies shading to
the visible portions of the material.

Since light sources can affect portions of
your material, shadows will appear
within the object. This can greatly
increase rendering time. If you don’t need
to see shadows in the object, make sure
the Receive Shadows filter is disabled.

Usually you should disable this filter
unless you're creating very specialized
effects.

Light Sensitive

Light Sensitive mode is designed for
creating visible light effects such as light
beams. Light Sensitive mode does not
shade objects, but the particles in your
material are sensitive to light.

In this mode, Density doesn’t control
density as much as it sets the light
sensitivity of material particles. Higher
values create brighter particles and lower
values create darker particles.

.l _q_-""---..__________,r

To get the best results for light objects,
use the Additive blend mode.

- _H_-""---..__________._..r

The color of the particles is determined
entirely by the Diffuse Color channel.

The result is like shining a light through a
volume. If you were shining a light
through a cloud material, you would be
able to see the clouds within the light
cone.
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When this mode is active, Diffusion,
Ambience, Specularity, Ambient Color,
Specular Color and Transparency Color
have no effect.

Use Light Sensitive shading mode to create
visible light effects like light beams.

Shading Mode Modifiers

Shading mode modifiers are not shading
modes, but they modify an existing
shading mode. When you select a
modifier it remains enabled until you
disable it. You can also apply more than
one modifier at the same time.

Additive

When this modifier is active, material
channels are applied to the environment
behind the object instead of to the
object’s surface.
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If you put an object on a bright
background, it appears almost white. For
best results, set your Ambient Color
control to zero and render against a dark,
plain background. Objects with this
shading mode modifier selected will not
cast shadows.

When you modify a shading mode using
Additive, objects appear as ghost images.

This mode is very useful for creating
planets and quarter moons, light beams,
and ghost images.

Distance Blur

This modifier is designed to minimize the
problem created by highly bumpy
textures fading into infinity (i.e., the
horizon). Often, moiré-like patterns
appear in these cases as the pixels try to
resolve the infinitely receding high

frequencies of bumpy water or grooved
sand, and so on. The Distance Blur
modifier fades the bumpiness well before
it hits the horizon.

Receive Shadows

This modifier prevents an object’s surface
from accepting shadows cast by objects
around it. The object itself will cast a
shadow, but it won’t accept them from
other objects.

When the Receive Shadow filter is disabled, no
shadows will appear on the object’s surface.

Cast Shadows

This modifier prevents an object from
casting shadows. The object’s surface still
reacts normally with light but it does not
cast any shadows.



Volume Blend-Altitude

This modifier gradually blends in the
Volume color based on altitude. Areas at
lower altitudes are tinted with the 100%
Volume Color; as you move higher up,
less of the Volume Color is added.

Using the Volume Blend-Altitude you can
simulate the effects of sinking deeper into a
volume of water. The lower you sink, the darker
it becomes.

This modifier can be used to create a
sense of depth in an infinite water slab. If
you blend between a light Diffuse Color
and a darker Volume Color, you can
create the illusion of depth as you sink
deeper into the water.

Volume Blend-Distance

This modifier blends the Diffuse and
Volume Colors of your material based on
the distance from the camera. Areas that
are closer to the camera will be tinted less
with the Volume color. As you move
further away, more of the Volume Color
is visible.

Using the Volume Blend-Distance you can
simulate the effects of looking through murky
water. Distant objects appear darker that closer
ones.

This modifier is excellent for creating
underwater depth effects. If you blend a
darker Diffuse Color with a lighter
Volume Color in an infinite slab, you can
simulate the effects of murky water on
distant objects.
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The Materials Lab

The Materials Lab is where you create and
edit your materials in Bryce. This unique
editor lets you combine a wide variety of
components and channels to create an
infinite number of different surfaces and
volumes.

To display the Materials Lab:

1. Create an object.

2. Select the object in the Working
window. A number of object

attribute icons appear to the right of
the object.

0
l@(i‘lh
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Use the quick access buttons next to a selected
object to access editors and get information
about the object.
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3. Click the M icon. Alternatively, you
can choose Object menu> Edit
Material or display the Edit palette
and click the Edit Material tool.

The contents of the composer depend on
the material currently applied to the
object. If there is no material, the default
material’s settings appear.

A Quick Tour of the Materials
Lab

The Materials Lab is set up like a visual
chart that lets you see all the different
channels that make up your material. At a
glance, you can see all the settings for
each material channel and the texture
components used to drive channel values.

In the top left corner is the mode toggle
button. This button lets you switch
between surface material and volume
material. The buttons also indicate what
type of material you're creating. Surface is
enabled by default. When you toggle to
Volume, the channels in the lab change to
display the volume channels.

L)
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Use the toggle button to switch between material
types.
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Material Preview Window

On the left side of the Materials Lab is the
Material Preview. This little window
shows you what your material will look
like when its applied to an object. The
preview updates as you adjust the
channels.

Copy o« Paste

The Material Preview shows you what your
material will look like when it’s applied to an
object. You can drag the preview to get a
different view of the object.

The Materials Grid

The center of the Materials Lab is call the
Material Grid. This is where you combine
values, colors and textures to set channel

values. The Materials Grid is divided into
three sections each containing logical
groups of channels.

The Material Grid gives you a one-glance view
of all the channels that make up your material.

The Color channels group contains all
the material channels that define the
colors that appear on the object surface
when it’s struck by light.

The Color group in the Material Grid contains
all the channels that define the color of an
object’s surface or volume.



Each channel in the Color group has a
color oval next to its title. This oval lets
you quickly set a color for the channel.

Use the Color oval to quickly set a color for the
channel using the Color Picker.

The Value group contains all the channels
that define how the object’s surface or
volume reacts to light. In other words,
they control whether the object is shiny,
metallic, bright or dark.

The Value group contains all the channels that
define how an object’s surface or volume reacts
to light.

The Optics group contains all the
channels that define any optical effects
associated with the object.

When you're creating volume materials,
the Optics group is replaced by the
Volume group. This group contains all
the channels that define the appearance
of an object’s volume.

All of the channels in these three groups
have sliders on the left side of its row. The
sliders lets you quickly set the value of the
channel. Values can be used in
conjunction with textures or on their
own. In the case of the Refraction
channel, you must use a value.

DIFFUSION

AMBIENCE

Use the value sliders to set a value for the
channel.

Each channel is divided into four
columns: A, B, C, and D. These columns
represent texture components you can
use to set the value of the channel. At the
top of each column is a Frequency slider.
This slider lets you quickly set the
frequency of a texture component.
Setting the frequency is the same as
scaling the texture.

When a texture component indicator
appears in a column, it means that a
component is being used to drive the
value of the channel. The column in
which the indicator appears indicates

which texture component is being used.
For example, if a texture component
indicator appears in column A of the
Ambience channel, component A is being
used to drive the Ambience value.

DIFFUSION

Component indicators let you know which
channels are being driven by a texture and
which texture component (A, B, C or D) is being
used.

Texture Component Windows

Along the right side of the lab are the
Texture Component windows. These four
windows are also labeled A, B, C, and D.
When a texture component is active,
these windows display a preview of the
texture and provide access to texture
editing tools.
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Component A

Component B

Component C

Component D

The four Texture Component windows
correspond to the four columns in each channel
in the Materials Grid

Along the bottom of the Materials Lab are
the Animation controls. These controls
let you animate between textures or
animate the properties of a single texture
over time.

Use the Animation controls to animate a
material over time.
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Working in the Materials

Lab

This section describes how to use the

Materials Lab to create a and store

materials.

Building Materials

A material is a combination of values,
colors and textures applied through
fourteen different channels. You build
materials by selecting components
(colors, values or textures) and
combining them on the Materials Grid.

To create a new surface material:
1. Select an object.
2. Display the Materials Lab.

3. Set the material channels to define
the properties of your material.

- e

—
Remember, channels can be set using
values, colors or texture components.
You may want to experiment with
different setting to see the results of
your changes.
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4. If you're using texture components,
you can:

+ Edit the scale, position or
rotation of the texture using the
texture transformation controls.

+ Edit the makeup of the texture
using the Deep Texture Editor.

+ Set a mapping mode for the
texture.

5. Choose a shading mode for the
material by clicking the triangle icon
at the top of the Materials Lab and
choosing a mode from the menu.

6. Click the OK icon. The new material
is applied to the selected object.

To create a new volume material:

1. Select an object.
2. Display the Material Lab.



Click the toggle button to switch to
Volume.

Set the material channels to define
the properties of your material.
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Remember, channel values are applied
to the object’s volume not its surface,
so adjust the material’s channels
accordingly.

o R
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If you're using texture components,
you can:

+ Edit the scale, position or
rotation of the texture using the

texture transformation controls.

+ Edit the makeup of the texture
using the Deep Texture Editor.

+ Set a mapping mode for the
texture.

=l . — ]
You should always use a texture
component in the Base Density

channel.
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6. Choose a shading mode for the
material by clicking the triangle icon
at the top of the Materials Lab and
choosing a mode from the menu.

The shading modes for volume
materials are different from those for
surface materials.

7. Click the OK icon. The new material
is applied to the selected object.

To activate a component in the
Materials Grid:

o Click an empty channel column. A
component window appears.

To use a component in a channel:

o Inamaterial channel, click the
column that corresponds to the
component you want to use.

To switch between components:

o Drag the component indicator to a
different column.

To combine a component with a value:

1. Inamaterial channel, click an empty
column.

2. Drag over the value control for the
channel.

Copying and Pasting Materials

The Materials Lab has its own dedicated
clipboard that lets you store materials.
You can have an object in your clipboard,
then enter the Materials Lab and copy a
material without disturbing the contents
of your clipboard.

To copy a material to the Materials
clipboard:

o Click the Copy button below the
Material Preview window.

To paste a material to the Materials
clipboard:

o Click the Paste button below the
Material Preview window.
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Using the Material Preview Area

There are several different ways you can
see the effects of your material on an
object.

To switch preview modes:

o Click the triangle at the bottom of the
material preview and choose an
option from the menu:

Normal displays your object as it looks in
your scene. This is the default view of
your selected object.

Up Close displays a zoomed in view of
your object.

Render With Neutral Sky displays your
object against a plain sky. When disabled,
your preview contains the current sky
settings. This option makes it easier to see
the material without being distracted by
patterns in the sky.

Render With Neutral Ground displays
your object with a plain ground. When
disabled, the ground in your preview has
the same texture as the object.

Current Selection displays the selected
object exactly as it appears in the your
scene.
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Box displays the material applied to a
cube.

Sphere displays the material applied to a
sphere.

Cone displays the material applied to a
cone.

Cylinder displays the material applied to
a cylinder.

Terrain displays the material applied to a
randomly generated terrain object.

Ground displays the material applied to
an infinite plane.

Torus displays the material applied to a
torus object. Torus objects are good for
displaying material properties like
altitude changes, slope and height
changes, and metallicity.

To change the view angle of the
preview area:

o Drag the Preview area in the
direction you want to view it from.

The preview switches to wireframe as
you move it. The angle of the preview
does not affect the angle of the object
in your scene.

S
Material Presets
Material presets are predefined materials.
Presets contain channels values that
simulate a wide variety of commonly

used surfaces. Presets are stored in the
Material Presets Library.

Presets are a great way of understanding
how materials are made. You can open
one of the presets and see what channel
and components were used to create the
final material.

The Material Presets Library can also be
used as a cookbook. Some of the shaders
are organized as lessons that can lead you
through the process of creating
interesting effects. For example, try
opening the Specularity lessons in the
Simple & Fast category.

Using the Preset Materials
Library

The Preset Materials Library contains all
the material presets available in Bryce.
You can place them on your objects
directly and edit them just as you would
any other material.



To add a material from the Preset
Materials Library to an object:

1. Select an object.

2. In the Working window, click the
triangle icon next to the Edit text
button at the top of the Bryce
environment. The Preset Materials
Library appears.

Flerwiber Crold Swies- 17

Use the Preset Materials Library to add
pre-made materials to your object.

or

In the Materials Composer, click the
triangle icon next to the Material
Preview window

3. Click one of the Category names
along the left side of the dialog.

4. Click the thumbnail of the preset you
want to add.

5. Click the OK icon to add the selected
material to your object.

-~ B

B
You can also select presets in one
motion by dragging directly to the
desired material preset and releasing
the mouse button. You can also drag
over the category names to change
categories into the category’s presets,
and then release mouse button.
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Adding and Deleting Preset Materials

You can add the material from any object
to the Preset Materials Library. This is a
good way of saving your favorite
materials.

To add a material to the library:

1. Select the object whose material you
want to add to the library.

2. Click the triangle icon next to the
Edit text button at the top of the
Bryce environment. Your selected
object will appear in the preview area
of the Preset Material Library dialog.

The preview area displays the object you
selected.

3. Click a category name. The library
switches to the category you selected.

The new preset will be added to the
category you select.

4. Click the triangle icon at the bottom

right corner of the preview and
choose a view option from the menu.

Normal is the default view of your
selected object.

Up Close displays a close-up of your
object.

Render With Neutral Sky displays
your object with a flat sky instead of
the sky applied to your scene.
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Render With Neutral Ground
displays your object on a flat ground
plane instead of the ground used in
your scene.

Current Selection displays your
object exactly as it appears in your
scene.

Box displays your material applied to
a cube.

Sphere displays your material
applied to a sphere.

Cone displays your material applied
to a cone.

Cylinder displays your material
applied to a cylinder.

Terrain displays your material
applied to a terrain. You might want
to disable Render With Neutral
Ground as terrain materials look
better when placed on a ground plane
with the same material.

Ground displays your material
applied to an infinite plane.

Torus displays your material applied
to a torus object.

Drag the preview area to rotate the
view of your object.
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Hold down the Spacebar and drag
up, down, right, or left to pan the
your object preview.

Hold down Command/Ctrl and drag
in the preview area to zoom in and
out of the preview.

Click the Add button at the bottom of
the dialog. The Add Material dialog
appears.

Enter a name for the new preset in
the Preset Name field.

Enter a description of the preset in
the Description field and click the
OKicon.

The name and description will
appear next to the material preview
whenever the preset is accessed.

e - -~

You can edit the name and description
of any preset at any time simply by
pressing the Tab key or by clicking the
name or description.

e ——

. Click the OK icon. Your preset will be

added to the first available space
within the current category.

To delete a material preset:

1. Click the triangle icon next to the
Edit text button at the top of the
Bryce environment. The Preset
Materials Library appears.

2. Click the preset you want to delete.
or

Hold down Shift and select a
continuous series of presets.

or

Hold down Command/Ctrl and
select a discontinuous set of presets.

3. Click the Delete button at the bottom
of the Preset Materials Library dialog.

Importing and Exporting Preset
Materials
Importing and exporting presets is a

handy way to exchange custom presets
with other users.



To import a preset material file:

1. Click the triangle icon next to the
Edit text button at the top of the
Bryce environment. The Preset
Materials Library appears.

or

In the Materials Lab, click the triangle
icon next to the Material Preview
window.

2. Click the Import button at the
bottom of the Preset Materials
Library dialog. The File Open dialog
appears.

3. Locate the file you want to import
and click Import.

The contents of the file are placed
into the first available space in the
current category.

To export a preset material file:

1. Click the triangle icon next to the
Edit text button at the top of the
Bryce environment. The Preset
Materials Library appears.

2. Select the preset or presets you want
to export.

3. Click the Export button at the
bottom of the Preset Materials
Library dialog. The Save File dialog
appears.

4. Enter a name and location for the file
and click Save.

Animating Materials

Animating materials can add an exciting
new dimension to your materials—time.
Using the Animation controls, you can
interpolate between textures over time or
change the properties of a single texture
over the course of an animation.

The animation tools are a great way of
adding life to your scene. Instead of
creating an animation with simple
motion, you can create subtle effects like
changing a cube from water to ice or
changing the seasons on a mountain.

Refer to “Animating Materials” on
page 385 for complete instructions on
animating materials.

Speeding Up Materials

While there is almost an infinite number
of materials with the added complexity of
creating materials using multiple

components and adding volumes, you
need not use all the features of the lab all
at once.

The more complex your material, the
longer it takes to render so you should
use complexity only where its necessary.

Rendering Transparency, Reflection and
Refraction always require longer
rendering time, but when you add the
complexity of creating transparent,
reflective or refractive volumes, your
rendering time can increase
exponentially. If you find that your scene
is taking too long to render, you may
want to try setting the Transparency,
Reflection and Refraction values to zero.

Additionally, use Full Shading Volume
textures sparingly. This type of material
creates specific types of effects, so you
should limit these materials to specific
areas of your scene. If you spread Full
Shading Volume textures everywhere
throughout your scene, be prepared for a
long wait while the scene renders.
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Textures and Materials

The thing that makes Bryce so unique is
its materials. A material can truly bring
any object to life, and textures are the
power behind the material. A material
can make your object shiny, dull, or
transparent, but the textures within that
material are what make it look like wood,
rock. water or clouds.

Textures define the color, pattern or
bumps within a material. A material can
contain up to four textures. These
textures can be used to drive the channels
that make up the material. So, by altering
the make-up or pattern of a texture you
can dramatically alter the appearance of a
material.
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Texture Structure

A Bryce texture can be made up of three
components. These components
contribute the raw patterns or textures
within a texture. Each component can
then contribute one of three types of
output to the final texture. These outputs
are then combined to create the final
texture.

Component 1

CIAG

COMBINED

Component 2 Component 3

Result

FINAL TEXTURE

This diagram shows the structure of a texture.

Within each component is a combination
of colors and noise that create a pattern.
Noise is what creates the pattern within
the texture. The shape of the noise inside
a component is determined by the phase
of the noise and the filter applied to it.
The filter can create coherent patterns,
random spots or anything in between.
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Refer to “Noise” on page 250, “Phase” on
page 257 and “Filtering” on page 261 for
more on Noise, Phase and Filtering.
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This diagram shows the structure of a texture
including the structure of a component.

A component can contribute one of three
types of output to the final texture: Color
output, which determine the colorsin a
texture, Alpha output, which determines
the bright and dark areas in a texture, and
Bump output, which determines the size
and pattern of bumps in the texture.

The component can contribute any
combination of outputs. So you can have
a final texture that contains Color output,
Alpha output, and Bump output, or it
can have all Color output or all Bump, or
any combination of the three.

The outputs in a texture are used by the
material, so the type of output you have
in a texture depends entirely on how you
want to use the texture in the material.
For example, if you're using the texture as
a bump map for the Bump Height
channel in a material, you’d probably
want all the components to contribute
only Bump output.

A texture can contain up to three
components. It can be made up of all
three components or just one, depending
on the type of texture you want to create.
The more components you use, the more
complex your texture.

Components are combined using Blend
Modes. These modes can create a wide
range of effects.

Component 1 Component 2

\ﬁLEND MODE

COMBINED

The way components are combined to create the
final texture is determined by the Blend Mode
you select.



Components are combined differently
depending on how many you use. If you
use one or two they are combined
according to the blend method you select.
If you use three, the first two components
are combined, and the resulting texture is
then combined with the third component
to create the final texture.

Component 1

GG

COMBINED

|

RESULT

|

FINAL TEXTURE

Component 2 Component 3

When you use three components, the first two
components (C1 and C2) combine to create a
hybrid texture which is then combined with the
third component (C3) to create the final texture.
So they’re combined using the formula
(C1+C2)+C3=FINAL.

The texture components are combined
together to form the final Combination
texture. The final texture can have its own
color scheme, noise, phase or filter. Any
changes you make to the combination

texture changes the final texture. These
types of operations are called Global
changes. Refer to “Global Changes” on
page 270 for more on global changes.

Changes
to this
texture
are global

When the components are combined they
produce the combination texture. This texture
can have its own color scheme, noise, phase or
filter. These operations are called Global
changes.

The end result of the Global changes is
the final texture which can then be used
in the Materials lab to create a material.

Components vs. Texture Components

Before you get any deeper into the
discussion of texture structure you
should understand a little terminology.

A texture is a part of a material. It can be

used to drive any of the material’s
channels. When you use a texture in a
materials it’s called a texture component.

The texture itself also has components. It
can be made up of up to three
components that determine the look an
color of the texture. The components that
make up a texture are called components.

RAEEHED |
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The difference between components and texture
components may be a bit confusing. Just
remember that when you're talking about a
texture, you're dealing with components. When
you're working with materials, you're using
texture components.
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Understanding Component
Structure

A texture can have up to three
components. When combined, the
components create the final texture. A
component consists of noise and color.

A component can have up to three colors.
The combined texture can also have a
different set of three colors which is
added to the colors from the
components. In total your texture can
contain up to twelve colors.

The noise in a component is made of base
Noise which is modified by the Phase,
which controls the complexity of the
noise, and the Filter, which determines
the shape or pattern of the noise.
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A component consists of noise and color. The
Noise is modified by the Phase and the Filter.
Each component can then produce Color, Alpha
or Bump output.
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Components and Output

A component’s output type determines
what type of information it’s going to
contribute to the final texture. The
Output type also determines the
component’s structure. A component
that does not have a Color output won't
contain any color information. The same
is true for the two other types of output.
If there’s no Alpha or Bump output
there’s no Alpha or Bump information in
the component.

Component Output
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The main purpose of creating a
component is to use it as part of a
material which will then be applied to an
object. How and what a texture
contributes to a material is determined by
the type of output it produces.

A texture can produce three different
types of output: Color, Alpha and Bump.

When you apply a texture to a material,
you can see the output types in the
Texture Component Window in the
Materials Lab.

Color output Alpha output Bump output

The three boxes in the Texture Component
Window in the Materials Lab represent the three
output types available for a texture.

If a texture does not produce a particular output
the box appears gray.

Refer to “Texture Components” on
page 213 for more on using textures in
materials.



In the Deep Texture Editor, the output
type for a component is indicated by the
three output buttons along the left side of
the Component Window.

Color output

Alpha output

The three buttons along the right side of the
Component window indicate the output type for
a component. If a button appears depressed, it
means that the component produces the selected
output type.

Assigning Output Types

A texture can produce all three output
types or only one. The number of output
types for the final texture depends on the
output you assign to the components. A
component can produce one or all three
types of outputs.

You can assign more than one
component to the same output type. If
you do have more than one component

with the same output type, the output
information will be blended to produce a
final output.

For example, if you have two components
that produce Color output, when you
combine them the colors from both
components are blended together and the
result is applied to the final texture.

In order to produce an output type, a
final texture must contain at least one
component that produces the type of
output you want. For example, if you
want your final texture to contain color
output, at least one of its components
must produce color output.

Each output type contributes something
different to the final material.

Color Output

Color output is used by the color
channels of a material. The color values
you assign to a textures's components are
combined to form a final texture. The
combined values are then used to drive
the Diffuse, Ambient, Specularity,
Specular Halo, or Transparency color
channels. Refer to “Understanding
Surface Material Channels” on page 194
for more on these channels.

The colors in a texture usually appear in
the form of a pattern or grain. When you
assign the texture to a material, this
pattern appears in the final material.

Original Texture

Material containing texture

The texture in this example was applied to the
Diffuse color and Ambient Color channels of the
object’s material. You can see how the color
pattern in the texture appears in the material.

To assign Color output to a texture:
1. Display the Deep Texture Editor.

2. Inthe desired component window,
click the C button on the right side of
the component window.
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Alpha Output

Alpha output is used by the various
Intensity and Optic channels of the
material. When a texture’s Alpha output
is assigned to a material, it’s used to either
to determine an effect’s intensity or as a
guide map for combining multiple
textures.

When there is only one texture
component in a material channel, the
texture’s Alpha output is usually used to
determine the intensity of a channel
effect. For example, if you assign a texture
to the Diffuse channel, the texture’s Alpha
output is used to determine which areas
are the most diffuse and which are the
least diffuse.

Original Texture

Material containing texture

The texture in this example was applied to the
Diffuse channel of the object’s material. You can
see how the alpha pattern in the texture controls
the diffuse intensity on the object’s surface.
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1. Display the Deep Texture Editor.

2. In the desired component window,
click the A button on the right side of
the component window.

Bump Output

The Bump output is used only by the
Bump Height material channel to
determine the pattern and height of the
bumps in a material.

Original Texture

Material containing texture

The texture in this example was applied to the
Bump Height channel of the object’s material.
You can see how the bump output in the texture
controls the pattern of bumps on the object’s
surface.

To assign Bump output to a texture:
1. Display the Deep Texture Editor.

2. In the desired component window,
click the B button on the right side of
the component window.
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Component Elements

A texture is made up of components.
Each of those components can contain
several elements that determine the color,
pattern, grain or bumps in the
component.

The Component window

You can have up to three components in
your texture. As you activate
components, a component window
becomes active. Each window displays a
preview of the component elements.



Reset Component Open Filtering palette

Open Noise palette
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Component

Open P
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Randomize
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The Component window displays the selected
component and its current attributes.

The three buttons on the Component
window let you access the Noise palette,
the Filtering palette and the Phase palette.
The buttons along the right side of the
window indicate the type of output
produced by the component.

To activate a component:
1. Display the Deep Texture Editor.

2. Click the component selector in the
top-left corner of the editor.

The component selector lets you pick how many
components you want to use to build your
texture.

The selector lets you choose from 1,
2, or 3 components.

Color

The colors in a component determine its
color scheme. Each component can have
up to three colors. Colors can be chosen

using the color picker or the Color dialog.

The color in a component is affected by
the noise, phase and filter. You can create
some very interesting patterns of color by
modifying the noise. The color pattern
created by the changes in the noise is
applied directly to the final texture. So
even if Color is the only output type for
the component you'll still see a pattern in
your final texture.

When the Color Output is selected for a
component, only the color information is
combined with the other components.
Also, when you apply the texture to a
material, the colors in the component
contribute to the colors used in the Color
channels of the material.

There are two color models you can use
to create colors in the components: RGB
and HLS. RGB combines red, green and
blue to create color. HLS combines Hue,
Lightness and Saturation values to create
color. The method you choose depends
on the final output of your Bryce 3D
scene. RGB usually works best for most
types of output.

‘__. _-—,_._.__ — .- >
If the Color output is not active for a
component, changing the colors or
Color Blending Modes has no effect.

‘__. _-—‘_q_.__ >
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To activate Color output for a
component:

1. Display the Deep Texture Editor.

2. Inthe desired component window,

click the C button.

—

The three buttons along the right side of the
component window display the component’s
output type.

An output type is active when the
button appears light gray.
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To choose colors for a component:
1. Display the Deep Texture Editor.

2. In the desired component window,
make sure the C button is selected.

3. Click one of the color indicators
along the left side of the component
window and choose a color from the
palette.

The three color indicators along the left side of
the window display the colors used in the
component.

To mix colors for a component:
1. Display the Deep Texture Editor.

2. In the desired component window,
make sure the C button is selected.

3.

Option/Alt-click the one of the color
indicators along the left side of the
component window. The Color
dialog appears.

The Color dialog lets you mix a color to use in
the component by entering values or adjusting
the color sliders.

4,

Choose a color model by clicking one
of the buttons along the bottom of
the dialog.

Enter color values or adjust the
sliders to mix a new color.

Click the OK icon.



Color Blending Modes

There are several blending modes you can
use to create a color scheme.

To choose a Color Blending mode:
1. Display the Deep Texture Editor.

2. In the desired component window,
make sure the C button is active.

3. Click the triangle icon in the lower
left corner of the window and choose
a mode from the menu.
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The pop-up lists all the Color Blending Modes
available in the Deep Texture Editor.

None
No blending is applied.

Red or Hue

When the RGB model is used, this mode
outputs only red color values. When the
HLS model is used, only Hue values are

output.

_.-"-. - _-E_-_-_\_ 2o _-,
This mode and the Green or Light, and
Blue or Saturation mode are available
so that you can separate color values
among the components. For example,
you could set each component to
output one of the different color values.

o e —

Green or Light

When the RGB model is used, this mode
outputs only green color values. When
the HLS model is used, only Lightness
values are output.

Blue or Saturation

When the RGB model is used, this mode
outputs only blue color values. When the
HLS model is used, only Saturation
values are output.

Spline Interpol

This mode creates a blend between all the |
colors in the component. k

This is what a color blend looks like using Spline
Interpol.

Linear Interpol 2

This mode creates a linear blend between
the first two colors selected for the
component.

This is what a color blend looks like using Linear
Interpol 2.
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i Linear Interpol 3 Earth Map values are applied next and colors with
the highest values (i.e. bright colors) are

all the colors in the component. according to the contours of the applied closest to the center.

component’s bump map. The three colors
you selected for the component are
applied to the middle range of the bump
map. Blue is applied to the lowest bump
values and white is applied to the highest
values to simulate polar caps. Earth Map
is excellent for creating planets.

r‘j This mode creates a linear blend between In this mode extra colors are generated

This is what a color blend looks like using

This is what a color blend looks like using Linear Banded.
Interpol 3.

. Perturbed
Randomized

In this mode colors are applied in

In this mode the three colors are blended irregular patterns.

and then applied randomly throughout
the component.

This is what a color blend looks like using Earth
Map.

Banded

In this mode colors are applied in bands.
The bands are determines by color values.
Colors with the lowest value (i.e. dark L oo

. This is what a color blend looks like usin
colors) are applied to the bands furthest Perltulrbve\:ld. 1@ using

This is what a color blend looks like using from the center, colors with middle range
Randomized.
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Interferences

In this mode the red, green and blue
values of the first color in the component
are used to create a repeating pattern
around the contours of the component’s
noise.

This is what a color blend looks like using
Interferences.

Interpol + Interferences

This mode is a combination of Linear
Interpolation and Interferences.

This is what a color blend looks like using
Interpol + Interferences.

Altitude

In this mode a white layer is added above
the colors at high altitudes. Any portion
of the object below ground is
automatically colored blue. Altitudes are
based on the object’s height.

This is what a color blend looks like using
Altitude.

Spline with Snow

This mode performs a spline
interpolation of the colors in the
component, but adds a white layer above
the colors at high altitudes. Altitudes are
based on the object’s height.

This is what a color blend looks like using Spline
with Snow.

Slope

In this mode the three colors are applied
to the object depending on its slope.

This is what a color blend looks like using Slope.

Orient

In this mode the three colors are applied
to the object according to its east-west
orientation.

This is what a color blend looks like using
Orient.
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Noise

Noise is the basis of all the textures. It is
the background turbulence that creates
the basis for texture patterns.

In audio terms you can think of noise as
the background static that you hear on
old recordings. Sound is layered on top of
this noise to create music. Like in audio,
you layer other functions on top of the
noise in your texture to create the final
pattern or look of your texture.

There are two ways of creating noise: the
Noise palette or the Noise Editor.

The Noise palette can increase or decrease
the amount of noise in any of the texture
components. However, using the palette,
you can only edit the existing noise.

Component Indicator

Open Noise
Editor

Noise slider

The Noise palette lets you increase or decrease
the amount of noise in a component.
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To display the Noise palette:
1. Display the Deep Texture Editor.

2. Click the Noise button at the bottom
of the editor. The Noise palette
appears.

#7 Phase

f[: Noise @ Filter

The three buttons at the bottom of the Deep
Texture Editor let you display the Noise, Phase
and Filter palettes.

or

+ Click the Noise button in the
top-left corner of on any of the
component windows.

The three buttons along the outside of a
component window let you display the Noise,
Phase and Filter palettes.

The Noise Editor is much more powerful
than the Noise palette. It contains
controls for creating noise from scratch.

Octaves Noise Mode

Noise Type Noise Preview

No. of Dimensions

Frequency Controls

Direction Controls

The Noise Editor lets you create noise and adjust
its properties.

To display the Noise Editor:
1. Display the Deep Texture Editor.

2. Click the Noise button at the bottom
of the editor. The Noise palette
appears.



3. Click the top-left corner of the
palette. The corner turns green as you
ppass your cursor over it.

The top-left corner of the Noise palette lets you
display the Noise Editor.

Creating Noise

The Noise editor is the tool you'll use to
create noise with a component or
combined texture. The noise creation
process involves several steps:

*  Choose the number of dimensions in
the noise.

» Choose a Noise Type. This will give
the basis for creating a noise pattern
or grain.

* Adjust the frequency of the noise.
* Adjust the orientation of the noise.

+  Apply a modifier to your noise, by
choosing a Noise Mode.
The following sections describe the

various parts of the editor and how to use
them in the noise creation process.

Noise Dimensions

Texture in Bryce can exist in 3D so your
noise can have up to three dimensions.
Noise dimensions determine which axes
you can use to adjust the orientation and
frequency of the noise.

-r'__. = _-_hh_l___\_ e i
Its easier to see the number of
dimensions for your noise if you use a
cube in the Noise Preview.

o _-_'-'-l.q____ _—
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1D Noise 2D Noise 3D Noise

These three examples show the difference
between 1D, 2D and 3D noise.

To choose the number of dimensions
for your noise:

1. Display the Deep Texture Editor.
2. Display the Noise Editor.

3. Click one of the dimension buttons at
the bottom of the editor.

The three buttons at the bottom of the editor let
you choose between 1D, 2D and 3D noise.

Noise Type

There are 27 different types of noise
available in the Noise Editor. Random
noise is the default (RND).

Each noise type provides you with a
different basic pattern to start your
texture. Some are more linear or
geometrical while others are more
random.

More complex noise types require more
rendering time. The time it takes to
render the preview is a good indication of
how long the final texture will take to
render.
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You should use the more complex noise
types cautiously.
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These are examples of the some of the types of
noise available.

The best way of choosing a noise type is
to apply a few to your component and see
how they look. Remember that this noise
is only the basis of the texture. You can
still edit this noise using the other
controls in the editor, so don’t discard a
noise type because its not perfect. The
other controls can help you fine-tune the
noise.
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To choose a noise type:
1. Display the Deep Texture Editor.
2. Display the Noise Editor.

3. Click the type field at the top of the
editor and choose a noise type from
the menu.

Type | RND Continuous

The Type area at the top of the editor displays
the name of the currently selected noise type.

Noise Frequency

Noise Frequency determines how often
the pattern within a texture repeats.
Frequency is like scaling the noise. Higher
frequencies decrease the scale of the noise
S0 you can see the pattern more often.
Lower frequencies increase the scale of
the noise so the pattern repeats less often.

You can change noise frequency using the
Frequency fields. The fields let you enter
numerical values to adjust the noise
frequency along the X, Y or Z axis. You
can also adjust the values using the scroll
arrows.

The number of dimensions in the noise
determines how many axes you can use to
adjust the frequency. For 1D noise you
can only use the X axis. With 2D noise
you can use both the X and Y axes. For
3D noise you can use all the axes.

If you try to adjust the Z axis frequency
for a 2D noise, your changes will have no
effect.

The Frequency fields let you enter values to
precisely control the noise frequency along the X,
Y or Z axes.



Adjusting the frequency can radically
change the look of your noise. If you
adjust the frequency in separate axes, you
can achieve even more interesting effects.

- =

Frequency Frequency Frequency
=10 =50 =100

Noise frequency settings control the repetition of
patterns in a component.

Frequency X=10 Y=80 Z= 10

In this example, the noise frequency was
changed in only the Y axis.

To change the frequency of noise:
1. Display the Deep Texture Editor.
2. Display the Noise Editor.

3. Drag over the X field in the
Frequency area to set the noise
frequency in the X axis.

Drag left to decrease the value or
right to increase it.

4. Dragoverthe field in the Frequency
area to set the noise frequency in the
Y axis.

5. Drag over the Z field in the
Frequency area to set the noise
frequency in the Z axis.

— _-‘-l—--_‘__l___‘_ i

You can also drag over the scroll
arrows to speed up the increments.

— _-‘-l—--_-__‘___‘_ i

Noise Orientation

Noise Orientation controls the direction
of the noise. Noise has a grain or a fixed
up and down, when you adjust the
orientation you change how the noise is
laid out within the texture.

When you apply a texture, the direction
of the noise within the texture remains
constant regardless of the orientation of
the object.

Since noise can exist in three dimensions,
you adjust the direction of the noise in
the X, Y, or Z axis.

The number of dimensions in the noise
determines how many axes you can use to
adjust the orientation. For 1D noise you
can only use the X axis. With 2D noise
you can use both the X and Y axes. For
3D noise you can use all the axes.

You can edit the noise orientation using
the Direction numerical fields.The fields
let you enter precise angles for noise
orientation. You can also use the scroll
arrows to set the angle in increments.

The Direction fields let you enter rotation angles
to precisely control the noise direction along the
X, Y or Z axes.
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Changing noise orientation can
dramatically change the look of your
noise. You'll see just how different your
noise can look when you rotate it along a
single axis.

Rotation in XYZ

Rotation in Rotation in
X XY

Noise orientation controls the direction of the
noise.

To change the orientation of noise:
1. Display the Deep Texture Editor.
2. Display the Noise Editor.

3. Drag over the XY field in the
Direction area to set the noise angle
in the X and Y axes.

Drag left to decrease the value or
right to increase it.

4. Drag over the YZ field in the
Direction area to set the noise angle
inthe Y and Z axes.
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You can also drag over the scrow
arrows to speed up the increments.
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Noise Octaves

Noise octaves are like musical octaves. In
a musical scale, if you play F and then F
an octave down, you're playing the same
note, only it sounds lower. If you play
both notes at the same time, the sound is
more complex than if you played only
one note. The same is true of noise. When
you add an octave to noise it becomes
more complex but the type of noise
remains the same.

< =

2 Octaves

1 Octave 3 Octaves

These examples use RND Continuous noise and
RND Linear noise to show the effects of
increasing octaves.

- _-_'-'"-l--—___ =l
Increasing the octaves adds
processing time to the component.

o e o

To change the number of octaves:
1. Display the Deep Texture Editor.
2. Display the Noise Editor.

3. Drag over the octaves field at the top
of the editor.

|

The octaves field at the top of the editor displays
the number of octaves currently applied to the
noise.

Noise Modes

Noise modes modify the octaves of a
noise. As you add complexity by
increasing the octaves, the Noise Modes
let you modify the additional noise so
that it produces different effects.

Many of the Noise modes use dark and
light values to modify the existing noise.
Also, you may not see the effects of the
modes if the Octave is set to 0.

To choose a Noise Mode:
1. Display the Deep Texture Editor.
2. Display the Noise Editor.



3. Click the Mode field at the top of the
editor and choose a mode from the
menu.

There are thirteen noise modes available:

Standard

This mode adds a new octave to the noise
at half the frequency and twice the
amplitude. This is the default mode.

In this example, Standard mode was applied to
RND Continuous noise.

Irregular

This mode adds a new octave to the noise
at half the frequency and twice the
amplitude. However, in this mode higher
frequency noise is modified more that the
rest. The end result is that more detail is
added to the noise.

In this example, Irregular mode was applied to
RND Continuous noise.

More Irregular

This mode works exactly like Irregular
except that this mode is more intense.

In this example, More Irregular mode was
applied to RND Continuous noise.

Maximum

This mode uses the only the highest
values, or lightest areas, to produce the
modified noise.

In this example, Maximum mode was applied to
RND Continuous noise.

Mulitfractal

In this mode lighter areas create higher
contrast noise.

In this example, Mulitfractal mode was applied
to RND Continuous noise.

With Rotation

In this mode each additional octave is
rotated. With Rotation mode it’s easier to
see linear noise types.

In this example, With Rotation mode was
applied to RND Linear noise.
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Minimum

This mode uses only the lowest values, or
darkest areas, to produce the modified
noise.

L
—

In this example, Minimum mode was applied to
RND Continuous noise.

Multiply

In this mode all the values in the noise are
multiplied together. The results is a
darker noise.

In this example, Multiply mode was applied to
RND Continuous noise.
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Difference

In this mode all the values in the noise are
evaluated. All the values that are equal
create black areas. When the values are
different, the lower value becomes darker.
The more octaves you have in the noise,
the darker the modified noise. Difference
works even at 0 octaves.

In this example, Difference mode was applied to
RND Continuous noise.

Minimum 90

This mode repeats the noise at a 90° angle
from its original orientation and
combines the original and copy using
only the highest values. This mode is
good for creating woven patterns.

In this example, Minimum 90 mode was applied
to RND Continuous noise.

Maximum 90

This mode repeats the noise at a 90° angle
from its original orientation and
combines the original and copy using
only the lowest values.

In this example, Maximum mode was applied to
RND Continuous noise.

Auto-phased

This mode automatically introduces
phase shifts into the noise.

E
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In this example, Auto-phased mode was applied
to RND Continuous noise.




Displaced Max

This mode creates a copy of the noise and
displaces noise by a small amount and
then lightens any areas where the two
overlap. This mode is good for creating
stone textures.

In this example, Displaced Max mode was
applied to RND Continuous noise.

Phase

Phase introduces turbulence into your
noise. The phase displaces the grain or
patterns within the your noise. When you
design the phase, you're creating a
displacement map along which the noise
will be modified.

You can control how the phase interacts
with your noise using the Phase palette.
You can design your phase using the
Phase Editor.

The Phase palette controls the amplitude.
The phase amplitude controls the
intensity of the displacement. As the
amplitude is increased, there is more
interference with the original noise.

Open Phase Editor
Component Indicator

|
Amplitude Slider

The Phase palette lets you increase or decrease
the amplitude of the phase in a component.

You won't have to increase the amplitude
very much before you start seeing the
phase pattern you designed interfere with
the existing noise. In fact, it’s probably a
good idea to keep the phase amplitude
low so that the phase pattern doesn’t
overwhelm the noise.

Original Noise

Phase=50 Phase=250

This graph shows how the phase interacts with
the noise at different amplitude settings.
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To display the Phase palette:

1. Display the Deep Texture Editor.

2. Click the Phase button at the bottom
of the editor. The Phase palette
appears.

& Noise £ Filter

-

The three buttons at the bottom of the Deep
Texture Editor let you display the Noise, Phase
and Filter palettes.

or

+  Click the Phase button in the
bottom-right corner of any of the
component windows.

The three buttons along the outside of a
component window let you display the Noise,
Phase and Filter palettes.

The Phase Editor looks a lot like the
Noise Editor. It has the same type of tools
and they work exactly like they do in the
Noise Editor. The difference is that you're
using noise patterns, orientations,
frequencies and modes to design how the
basic Noise will be displaced.
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Using the Phase Editor you can perform
several functions:

* Create 1D, 2D, or 3D phase

»  Change the type of noise

»  Change the frequency of the phase

+ Change the orientation of the phase
+  Change the noise octaves

+ Change the noise modulations.

—Octaves

Noise Mode

Noise T
olse Type Phase Preview

Frequency

Number of Dimensions Controls

Direction Controls

The Phase Editor lets you create noise to use as
phase.

While the Phase Editor lets you create the
noise pattern or grain within the phase,
the Phase palette controls how that phase
is applied to the component or the
combined texture.

To display the Phase Editor:
1. Display the Deep Texture Editor.
2. Click the Phase button at the bottom

of the editor. The Phase palette
appears.

3. Click the top left corner of the
palette. The corner turns green as you
pass your cursor over it.

The top left corner of the Phase palette lets you
display the Phase Editor.

Creating Phase

Phase is designed using the Phase Editor.
The phase creation process involves
several steps:



*  Choose the number of dimensions in
the phase.

+ Choose a noise type. This gives the
basis for creating a phase pattern or
grain.

+ Adjust the frequency of the noise.
» Adjust the orientation of the noise.

*  Apply a modifier to the noise by
choosing a Noise Mode.

You'll notice that many of the steps for
creating the phase are the same as those
for creating noise. That’s because you are
creating noise. The difference is that
instead of applying the noise to the
texture, the noise you create for the phase
is used to displace the existing noise.

The following sections describe the
various parts of the editor and how to use
them in the noise creation process.

Phase Dimensions

Just like noise, you can set the dimensions
of the phase. The number of dimensions
determines which noise axes will be
displaced when you apply the phase. For
example, if you apply a one-dimensional
phase to a three- dimensional noise, only
the X axis of the noise will be displaced.

- e

—
Its easier to see the number of
dimensions for your phase if you use a
cube in the Phase Preview.
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Combined Texture

3D Noise 1D Phase

In this example, a 1D phase was applied to a 3D
noise.

To choose the number of dimensions
for your phase:

1. Display the Deep Texture Editor.
2. Display the Phase Editor.

3. Click one of the dimension buttons at
the bottom of the editor.

The three buttons at the bottom of the editor let
you choose between 1D, 2D and 3D phase.

Phase Noise Type

There are 27 types of noise available in
the Phase Editor. Random Noise is the
default (RND).

Each noise type provides you with a
different basic pattern for the phase. The
noise types available in the Phase Editor
are the same as those in the Noise Editor,
S0 you can refer to “Noise Type” on

page 251 for more on noise types.

Phase Frequency

Phase frequency determines how often
the pattern within the noise repeats.
Frequency is like scaling the noise. Higher
frequencies decrease the scale of the noise
S0 you can see the pattern more often.
Lower frequencies increase the scale of
the noise so the pattern repeats less often.

You can change phase noise frequency

using the Frequency numerical fields.
The fields let you enter numerical values
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to adjust the noise frequency along the X,
Y or Z axis. You can also adjust the values
using the scroll arrows.

The number of dimensions in the phase
determines how many axes you can use to
adjust the noise frequency. For 1D phase
you can only use the X axis. With 2D
phase you can use both the X and Y axes.
For 3D phase you can use all the axes.

Adjusting the frequency of the Phase
noise disproportionately can have some
very interesting effects on your noise.

Frequency X=10 Y=80 Z= 10

In this example, the phase noise frequency was
changed in only the Y axis and then applied to
3D noise.
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To change the frequency of phase
noise:

1. Display the Deep Texture Editor.
2. Display the Phase Editor.

3. Drag over the X field in the
Frequency area to set the phase noise
frequency in the X axis.

The Frequency fields let you enter values to
precisely control the noise frequency along the X,
Y or Z axes.

Drag left to decrease the value or
right to increase it.

4. Dragoverthe field in the Frequency
area to set the Phase noise frequency
in the Y axis.

5. Drag over the Z field in the
Frequency area to set the Phase noise
frequency in the Z axis.

_..-"- = _-‘---.-_l___-_ E o
You can also drag over the scroll
arrows to speed up the increments.
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Phase Noise Orientation

Phase noise orientation controls the
direction of the noise within the phase.

The number of dimensions in the phase
determines how many axes you can use to
adjust the orientation.

You can edit the noise orientation using
the Direction numerical fields.The fields
let you enter precise angles for noise
orientation. You can also use the scroll
arrows to set the angle in increments.

The Direction fields let you enter rotation angles
to precisely control the noise direction along the
X, Y or Z axes.



Like frequency, changing the orientation
of the phase noise in only one or two axes
can create some very interesting results.

In this example, the phase noise orientation was
changed in only the Y axis and then applied to
3D noise.

To change the orientation of phase
noise:

1. Display the Deep Texture Editor.
2. Display the Phase Editor.

3. Drag over the XY field in the
Direction area to set the noise angle
in the X and Y axes.

Drag left to decrease the value or
right to increase it.

4. Drag over the YZ field in the
Direction area to set the noise angle
in the Y and Z axes.

- S o

B
You can also drag over the scroll
arrows to speed up the increments.
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Phase Noise Octaves

Phase noise octaves work exactly like the
noise octaves. They introduce an extra
level of complexity to the noise. Refer to
“Noise Octaves” on page 254 for more on
octaves.

Phase Noise Modes

Phase noise modes work exactly like the
noise modes. They modify the octaves of
a noise. Refer to “Noise Modes” on

page 254 for more on octaves.

Filtering

The filter you apply to the noise in a
component can change the entire look of
the noise. The filter refines the noise so
that it has more or less detail, increases its
contrast, applies it only at high altitude or
changes its spatial orientation. Whatever
the change, the filter has a profound
effect on the final look of your texture.

Filters are expressed as equations with
variables. When the equation is applied
to the noise, it changes some aspect of the

noise. You can control how the equation
affects the noise by changing the values of
the variables.

The filter only affects the noise. The
phase cannot be altered using a filter. The
phase is blended with the noise.

Filters are edited using the Filtering
palette. The palette displays the current
filter and provides tools for editing the
filter graph.

Component Indicator

Filtering Equation Filtering graph

“ Filter

Mone

Rest button Filter Variables

The Filtering palette displays the current filter
and provides tools for editing it.
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To display the Filtering palette:
1. Display the Deep Texture Editor.

2. Click the Filtering button at the
bottom of the editor.

#" Noise ﬂ[ﬁ Filter

The three buttons at the bottom of the Deep
Texture Editor let you display the Noise, Phase
and Filter palettes.

# PHase

or

+  Click the Filtering button in the
top right corner of any of the
component windows.

The three buttons along the outside of a
component window let you display the Noise,
Phase and Filter palettes.

Editing the Filter

Filters are equations which have
variables. Each equation can have up to
three variables labeled a, b and c. The
values for each variable are displayed at
the bottom of the palette. Generally, a
controls the intensity of the filter effect
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while b controls the overall height. In
some filters a and b may stand for other
things.

There are two ways you can adjust a filter:
by changing the variable values or by
changing the shape of the graph (which
automatically changes the variable
values). The method you use depends on
how much you know about a particular
filter. If you're not sure what the filter
does, change the graph—it’s a much
more intuitive way of working.

To edit the Filtering graph:
1. Display the Filtering palette.

2. Drag over the Filtering graph area.
The shape of the graph changes as
you drag.

The graph area of the Filtering palette lets you
interactively adjust the filtering effect.

Notice that the variables also changes
as you move the graph.

+ Dragging horizontally changes
the value of a.

+ Dragging vertically changes the
value of b.

To change variable values:
1. Display the Filtering palette.

2. Drag over the variable field you want
to change. Drag left to reduce the
value or right to increase it.

The shape of the graph changes as you
adjust the values.

Choosing a Filter

Each filter available in the Filtering
palette offers something unique. The best
way of choosing which filter you want to
use is to apply it to a component and see
what happens.

To choose a filter:
1. Display the Deep Texture Editor.
2. Display the Filtering palette.

3. Click the Filtering Equation area and
choose a filter from the menu.



There are fourteen filters available. The
following sections describe the filters and
gives you some idea of how to edit them.

None

This option deactivates the filter. No
filtering is applied to the component.

Quantize

This filter works like a Posterize effect.
When its applied, gray values jump from
one value to the next, creating a blocky
stair-step type of effect.

In this filter a and b control the contrast
and height, while ¢ controls the number
of levels between white and black.

RND Contmuous
Noise Noise + Quantize

RND Continuous

In this example, Quantize was applied to RND
Continuous noise.

Saw Wave

When the graph for this filter has only a
small curve, it acts like a contrast filter. As
it approaches the height limits (set by b),
it bounces back on itself. This creates
high-contrast breaks in the noise.

For color output use this filter to get areas
of high-contrast alternating color.

When you set the value of a to a high
number you'll get areas with a larger
amount of noise.

In thls example, Saw Wave was applied to RND
Continuous noise.

Sine Wave—Sin (aX) + b

This filter creates noise that appears as
large number of lines that are oriented in
the same direction. Use this filter to
generate wood grains.

The a variable controls the number of
lines. Higher values create a better effect.

In this example, Sine Wave was applied to RND
Continuous noise.

Absolute—Abs(aX + b)

This filter works like a Difference effect.
When it’s applied, you'll get more light
areas in your noise and a higher level of
detail in a bump map.

To get additional bump information
using this filter, setato 2 and b to -1.

In this example, Absolute was applied to RND
Continuous noise.
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XPower—(X PWR a) +b

This filter smooths out the darkest areas
of your noise. However it has less effect
on lighter areas and no effect on white.

In this example, XPower was applied to RND
Continuous noise.

Gaussian—(a(X + b))

This filter smooths out darker areas of
your noise and makes lighter areas
noisier. White areas become the noisiest.

In this example, Gaussian was applied to RND
Continuous noise.
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ClipaX+b

Clip is probably the filter you'll use most.
It’s a contrast filter.

The a variable controls the contrast and b
controls the overall brightness.

For a low contrast effect make the wave in
the graph smaller. Decrease the value of a
to reduce the size of the wave and
increase b to move the wave up. Using
this wave, all the values will be expressed
as mid-gray.

For a high contrast effect, adjust the wave
so that it hits both the top and bottom
edges of the preview. Increase the value of
a and make b negative to move the curve
down.

To invert the colors in your noise, make a
negative and increase b.

In this example, different levels of Clip were
applied to RND Continuous noise.

Altitude Minus Slope—Xb + a
(Altitude-Slope)

This filter applies noise only at certain
combinations of slope and altitude.
When a is positive and b is negative, noise
is applied at high altitudes and on flat
surfaces.



When a is negative and b is positive, noise
is applied at low altitudes and on steep
slopes.

_'._.-' _-‘-l—--_-__‘___‘_ =g o
The Altitude Minus Slope filter works
on the slope and altitude of an object
in World Space.
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In this example, Altitude Minus Slope was
applied to RND Continuous noise and then to
objects in a scene.

Slope—X(a * Slope + b)

This filter applies noise based on an
object’s slope. Slope can range anywhere
from flat and horizontal to steep and
vertical. This is an excellent filter to use if
you want to isolate a texture to vertical
cliffs or flat surfaces.

In this filter a determines the steepness of
the noise (-4 is flat, 4 is vertical). The b
variable controls the starting point of the
transition.

+ To place noise on vertical surfaces
make a=4 and b=2.

* To place noise on flat surfaces make
a=-4 and b=1.5.

_..-'"- _-‘-l—--_.___-_‘_ R o
The Slope filter works on the slope of
an object in World Space.
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In this example, Slope was applied to RND
Continuous noise and then to objects in a scene.

Altitude—X(a* Altitude + b)

This filter modulates the scale of the noise
according to an object’s altitude.

In this filter a determines how fast the
noise is scaled by altitude. A lower value
creates a gradual transition, while higher
values create sharper transitions.

To apply noise at higher altitudes make
sure a is positive. At high altitudes b
controls the transition. The higher the
transition, the lower the number. So, at
high altitudes b should be a negative
number.

To apply noise at lower altitude, reverse

the variables so that a is negative and b is
positive.
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The Altitude filter works on the altitude
of an object in World Space.

In this example, Altitude was applied to RND
Continuous noise and then to objects in a scene.
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Orientation—X(a * Orientation + b)

This filter applies noise based on an
object’s east-west orientation.

In this example, Orientation was applied to
RND Continuous noise and then to objects in a
scene.

Smooth Clip

This filter works exactly like the Clip
filter. It’s also a contrast filter, except that
this filter smooths out the transitions
between darks and grays.

The a variable controls the contrast and b
controls the overall brightness.

In this example, Smooth Clip was applied to
RND Continuous noise.

Snow Puddles

This filter turns noise into snow patches.
Snow is applied according to an object’s
slope and altitude.

The a variable controls how much the
noise interferes with the smoothness of
the snow. When a=0 the noise doesn’t
interfere at all so the snow is perfectly
smooth. When the a value is higher, the
snow starts looking like the noise.

The b variable shifts the altitude or snow
level. It sets where the snow begins.



The c variable controls how steep an
object has to be before the snow appears
on its surface. The higher the number, the
flatter an object has to be before snow
appears on its surface.

In this example, Snow Puddles was applied to
RND Continuous noise and then to objects in a
scene.

O %

r
IR e

Combining Components

The Deep Texture Editor gives you
unparalleled control over the look and
feel of each one of the components that
make up a texture, but the control doesn’t
stop there. The Deep Texture Editor also
lets you control how those components
are combined to create the final texture.

Blend Modes

Components are combined using Blend
modes. These modes are filters applied to
the components to determine how the
properties in each component are
combined with the other components’
properties to form the final texture.

The number of blend modes you can use
varies depending on how many
components you're using to build the
texture.

If you're using only one component, the
properties in the component are applied
directly to the final texture. When you're
using two components, they’re blended
using a single blend mode, and the result
is then applied as the final texture.

When you're using three components, the
first two components are blended
together using a blend mode, then the
result of that blend is combined with the

third component using a second blend
mode. The result of all the blending is
then applied as the final texture.

Component 1 Component 2

CI)E
w/BLEND

RESULT

Component 3

BLEND

FINAL TEXTURE

This diagram explains when the blend modes
are applied as you combine components to form
a texture.

Depending on the Blend mode, the
different types of output can affect each
other during the combination process. So
its possible that the Bump output of one
component may affect the Color output
of another.
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To apply a blend mode:
1. Display the Deep Texture Editor.

2. Click the Arrow between components
and choose a mode from the menu.

The arrows between components in the Deep
Texture Editor provide access to the Blend
Modes menu.

*  Click the arrow on the left to

choose a Blend Mode to combine
components 1 and 2.

+  Click the arrow on the right to
choose a Blend Mode to combine
the results of Component 1 and 2
with 3.

There are nineteen blend modes you can
use to combine your components:

Parallel

This mode does not blend components.
Use it when each component has a
different output type. If two components
share an output type, only the first output
will be applied to the final texture.
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For example, if Component 1 has
output= Color and Bump, and
component 2 has output=Color and
Alpha, only the color from Component 1
will be applied to the texture.

Combine

Combine is a blend mode for colors only.
When you use this blend mode, the first
color in Component 2 is used as an alpha
channel. Wherever that color appears in
Component 2, it is replaced with the
colors from Component 1.

For example, lets say Component 2 has
Yellow, Green and Blue and Component
1 has Orange, Purple and Black as its
color scheme.

When you combine them using the
Combine blend mode, Yellow disappears
from Component 2. Everywhere that
Yellow appeared, you'll see Orange,
Purple and Black.

Average

Average is normal blend mode where all
the component values are mixed with
equal weight. So if one component is
white and the other is black, the result is

gray.

This is a good all-purpose blend mode to
use for creating textures.

Multiply

When you use this blend mode to
combine components, you'll get a darker
result. In this mode, when a black
component is combined with a gray
component, the result is black. When a
gray component is combined with a
white component, the result is gray.
When two shades of gray are combined,
the result is proportionally darker.

In the case of Bump output, this mode
will flatten most areas since black is flat
and darker values create flatter bumps.

Maximum

When two components are combined
using Maximum, the two components
are compared and the one that’s lighter
becomes the result.

Blend Maximum

Blend Maximum works the same as
Maximum, except that it creates blurring
at points of sharp transition.



When Blend Maximum is applied to
Bump output, the resulting bump map
will have many high points and few deep
pits.

This mode works best on Bump output.

This mode is the opposite of Maximum.
When two components are combined,
they’re evaluated and the darker areas of

both are combined to produce the result.

Blend Minimum

Blend Minimum works the same as
Minimum except that it creates blurring
at points of sharp transition.

When Blend Maximum is applied to
Bump output, the resulting bump map
will have mostly low areas with very few
high points.

Add

Add combines colors so that they appear
dramatically lighter. However, it doesn’t
have the same effect on Bump output.

Subtract

When you combine grayscale
components using Subtract, they tend to
turn out black or very dark. When you
use it with colored components, the
result is brilliant colors that tend to
compliment the original colors.

Blend v1 and v2

These two blend modes let you use one of
the components as an alpha channel for
blending.

When you choose Blend v1, the noise in
the first component is used as an alpha
channel to blend the two components.

When you choose Blend v2, the noise in
the second component is used as an alpha
channel to blend the components.

Blend Slope

Using Blend Slope, components are
combined according to an object’s slope.
The first component is applied to areas
that are flat and the other is applied to
areas that are steep.

Fast Slope

Fast Slope works exactly like Blend Slope
except that the transition from one
component to the other is more abrupt.

Blend Altitude

This mode blends components according
to an object’s altitude. The first
component appears at low altitudes and
the second appears at high altitudes.

Blend Orientation

In this mode, one component is applied
in all directions, while the other is applied
in only one direction. You can use this
mode to simulate things like moss that
only grow on one side of a tree.

Blend Random

This mode introduces an extra layer of
noise and uses it as an alpha channel for
combining the two components.
Component 1 appears in some areas of
the new noise, and Component 2 appears
in other.

Since this mode adds another layer of
noise, you're also adding more processing
time.

Procedural Blend

Procedural Blend combines two
components so that the color and values
of Component 1 are applied to
Component 2 based on the gray values in

Textures 269



'
'i. n

Component 2. In essence, the Alpha
output from Component 2 is used as a
guide for blending.

Where Component 2 is light, Component
1 is not applied. Where Component 2 is
dark, Component 1 is made darker.
Where Component 2 is gray, Component
1 is applied without change.

This mode usually results in more
saturated colors.

Difference

Difference finds the difference between
the noise in the two components and
displays the result.

This mode only works on output of like
types. So if Component 1 has Alpha and
Color output while Component 2 has
only Alpha, the two Alpha outputs are
combined and the Color output is left
unchanged.

Global Changes

The component window in the center of
the editor, called the Combination
component, represents the final
combined texture. Any changes you make
to this final component are considered
global changes since they affect the entire
texture.
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The Combination component can have
its own color scheme, filter, noise pattern
or phase. These attributes are applied to
all the component elements. For
example, the Combination noise values
affect the noise within each component.

Global changes give you a way of
applying a last layer of complexity to your
texture.

Global Colors

The colors in the Combination
component interact with the combined
colors in the three components. They act
as a final color filter for the texture. After
the colors in each component are
combined, they are blended with the
combination component colors to
produce the colors in the final texture.

You can also apply a final Color Blending
method to the combination component.
The Blending method you apply to the
combination component is applied on
top of the other modes used in the
components.

For example, if you choose Altitude in the
Combination component, the texture
color is applied using the blend modes in
the components and then also applied by
altitude.

This example shows a texture containing a
texture with different Color Blending modes in
it.



To add colors directly to a texture:

1. Click the top color circle in the
combination component window
and choose a color from the palette.

The color circles in the Combination component
window let you apply colors directly to the final
texture.

2. Repeat for each of the other two color
circles.

Global Noise

When you change the noise in the
Combination component, (i.e., globally)
it applies to all the components equally.
So if you increase the noise in the final
component, the noise in each of the
components increases. Likewise, when
you decrease the noise globally, the noise
in each individual component decreases.

Global noise can be different than
component phase, so you can introduce a
completely different type of noise into the
texture.
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Use this option cautiously. The more
noise you introduce into your texture,
the longer it takes to render and draw.
If you introduce too much complex
noise patterns into a texture, you may
find your render time increased
significantly.
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You can adjust global noise in the same
way you would for a single component,
using the Noise palette or the Noise
editor.

To adjust noise globally:

1. Click the top left button in the
combination component window.

The Noise palette appears.

The three buttons along the outside of the

Combination component window let you access

the editing palettes.

2. Drag the slider to adjust the noise
value.

or

Click the top left corner of the Noise
palette to display the Noise Editor.

+  Use the editor’s controls to design
the global noise pattern or grain.

Global Phase

As you adjust the Global Phase value, new
phase is introduced into each of the
components.

Global phase can be different than
component phase, so you can introduce a
completely different type of phase into
the texture.
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You can adjust global phase in the same
way you would for a single component
using the Phase palette or the Phase
Editor.

To adjust phase globally:
1. Click the bottom right button in the
combination component window.

The Phase palette appears.

The bottom right button on the outside of the
Combination component window accesses the
Phase palette.

2. Drag the slider to adjust the phase
amplitude.

or

Click the top left corner of the Phase
palette to display the Phase Editor.

¢+ Use the editor’s controls to design
the global phase.
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Global Filtering

The Filter affects the final look of the
noise within a component. The Global
Filter affects the look of the combined

noise. The Global Filter is applied to the

noise in the Combination component.

The global filter only affects the noise,

not the phase in the component. Any of

the filters you used in the components
can be used as the global filter.
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Use this option cautiously. The more
complex the noise in your texture, the
longer it takes to render and produce.
If you introduce too much complexity,
you may find your render time
increased significantly.
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To filter noise globally:

1. Click the top right button in the
combination component window.

e = - -~
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The Filtering palette appears.

The top right button on the outside of the
Combination component window accesses the
Filtering palette.

2. Choose afilter and adjust its variables
to create the desired effect.
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The Dééb Texture éditbr

The Deep Texture Editor can be a source
of incredible power or incredible
frustration. It all depends on how you
jump into it.

The editor can be used in two ways. If
you're comfortable with equations and
algorithms, it gives you the freedom to
create any textural pattern or surface you
can imagine. If you're not so
mathematically inclined, playing around
with these deep functions can get you lost
rather quickly.

For those who don’t want to learn to
calculate and postulate, the Deep Texture
Editor can be used as a large palette. Take
a little of this and little of that, blend



them all together and see if you like the
result. If it'’s a magnificent work of art,
keep it; if not, discard it.

The only real penalty you may encounter
when using the Deep Texture Editor
unawares, is that you may inadvertently
create a very complex texture that could
add considerably to your rendering time.
This is an easy pitfall to avoid however.
The last section of this chapter gives you
some tips on reducing the complexity of
your textures. Refer to “Tips for Speeding
Up Textures” on page 277 for more.

Before you start creating textures, you
may want to familiarize yourself with this
incredible tool.
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Tip: When you're just exploring the
editor, set all the component outputs

to Alpha. This lets you see the effects
of your changes more clearly.
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To display the Deep Texture Editor:
1. Display the Materials Lab.

2. Click the A, B or C column of the
material channel to which you want
to assign a texture.

A component window becomes
active.

3. Click the pink button at the top of the
Component window.

The Deep Texture Editor appears.

A Quick Tour: The Deep Texture
Editor

The layout of the Deep Texture Editor is a
visual representation of the texture
creation process. The three components
along the top combine to form the final
texture, shown in the middle. The layout
makes the editor very easy to use.

Along the top of the editor you'll see the
preview options. These three icons let
you choose how you want to display the
component.

The three icons at the top of the editor let you
choose a preview mode.

Below the preview control on the left,
you'll see the component selector. This
tool lets you choose the number of
components you want to use to build
your texture.

The component selector lets you choose how
many components you want to use to build a
texture.

The rest of the editor displays the
component window. The three windows
along the top represent the three
components you can use in a texture and
the center window represents the
combined texture.

The three windows along the top of the editor
represent the components, and the window in
the center displays the final combined texture.
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The arrows between windows represents
the blend modes.

Elend Slope

The arrows between components in the Deep
Texture Editor provide access to the Blend
Modes menu.

The three buttons along the bottom of
the editor let you display the three editing
palettes. The palettes let you control the
noise, phase and filtering applied to the
texture.

& Noise L

The three buttons along the bottom of the editor
let you display the editing palettes.

#" Phase

Filter

You can access the Noise and Phase
Editors from within the Noise and Phase
palettes.

274 Chapter @ Bryce 3D

S
, o .. IR R S R 1 u
Working in the Deep Texture
Editor
This section describes how to use the

Deep Texture Editor to create and store
textures.
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Building Textures

A texture is a combination of
components. You build textures by
designing or editing components (i.e.,
colors, noise, phase or filters) and
combining them using Blend modes.

To build a texture:
1. Display the Deep Texture Editor.
2. Click the Component Selector to

choose the number of components
you want to use to build the texture.

The component windows become
active.

3. Inthe first component window, click
one of the Output buttons to choose
an output type.

4. If your component contains color,
click one of the color circles and

choose a color to apply to the texture.

7.

You can choose up to three colors for
each component.

Click the triangle icon below the
color circles and choose a Color
Blending mode for your colors.

Click the Noise button at the bottom
of the editor. The Noise palette
appears.

Adjust the noise in the component

by:

+ Dragging the Noise slider on the
Noise palette to increase or
decrease the amount of noise in
the component.

¢+ Click the top left corner of the
palette to display the Noise
editor, then use the editor
controls to design or edit the
noise in the component.

Click the bottom right button on the
Component window. The Phase
palette appears.

Adjust the phase in the component

by:

+ Dragging the Phase slider on the
Phase palette to increase or
decrease the amplitude of the
phase in the component.



+  Click the top left corner of the
palette to display the Phase
editor, then use the editor
controls to design or edit the
phase in the component.

10. Click the Filtering button at the
bottom of the editor. The Filtering
palette appears.

11. Choose a filter to apply the
component noise and adjust that
filter’s variables.

12. Repeat steps 3-11 for each
component in the texture.

As you edit the noise, phase, or filter
of the remaining components, make
sure you move the component
indicator at the top of each palette to
be sure you’re editing the right
component’s attributes.
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The component indicator at the top of each

palette lets you know which component you're

editing.

13. Click the arrow between Component
1 and Component 2 and choose a
Blend mode from the menu.

14,

15.

16.

17.

18.

If you have more than two
components, click the arrow between
Components 2 and 3 and choose a
second blend mode.

The result of blending all the
components appears in the
Combination window.

Click the color circles in the
Combination component window,
and choose colors for the final
texture.

* You can also choose a Blending
mode.

If you want to change the noise of
combined component, display the
Noise palette.

If it’s already displayed, make sure
the component indicator is on the
fourth component.

If you want to change the phase of
combined component, display the
Phase palette.

If it’s already displayed, make sure
the component indicator is on the
fourth component.

If you want to change the filter of
combined component, display the
Filtering palette.

If it's already displayed, make sure
the component indicator is on the
fourth component.

19. Click the OK icon at the bottom of
the editor. The texture appears in one
of the component windows in the
Materials Lab.

Using Drag and Drop in the
Editor

The Deep Texture Editor lets you drag
and drop component elements between
component windows. This a quick way of
copying elements between components.

For example, if you were setting up a red,
green and blue separation of the colors in
your texture, you could drag the same
elements to all three component windows
and change the Color Blending mode.

To drag and drop between windows:

o Drag from the window you want to
copy to the window where you want
the elements to appear. Release the
mouse button to drop the
component elements.

Textures 275



The elements you drop into a
window replace the existing
elements.

Changing Component Preview

Each component window has a preview
of the component’s elements. You can
choose to display the elements mapped
onto a flat surface, a cube or a sphere.

Displaying the component on a cube
makes it easier to see 3D noise and phase
changes.

To choose a preview mode:

o Click the flat surface, cube or sphere
in the top-right corner of the editor.

The three icons at the top of the editor let you
choose a preview mode for the component
windows.

Randomizing Textures

A quick way of designing a texture
without going into designing noise or
filters is to create random components.
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The randomize buttons in the
component windows let you randomize
the elements in the component window.
The type of output you choose for the
component determines what part of the
component is randomized.

This is an excellent way of exploring the
editor. Just randomize the components
elements and combine them to see what
happens.

To randomize component elements:

o Click the knob in the bottom right
corner of the component window.

The knob in the bottom right corner of the
component window randomizes the elements in
the component.

Undoing Changes

The Reset control lets you undo all the
changes you've applied to a component
and returns to the component displayed
when you first entered the editor.

To reset a component:

o Click the knob in the bottom right
corner of the component window.

The knob in the top-left corner of the component
window resets the component to the way it
looked when you first opened the editor.



Saving Textures

You can save your texture as part of
texture list so you can access it quickly
from the Materials Lab.

To save a texture:

1. Inthe Combination component
window, click the knob in the top
right corner of the component
window.

The knob in the top right corner of the
Combination component window lets you save
your texture.

The Save Texture dialog appears.

2. Enter a name for the new texture and
click the OK icon.

The new texture appears at the
bottom of the texture list. The list can
be accessed from the Materials Lab.

-
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Tips for Speeding Up
Textures
Textures can be the most powerful effects
you create in Bryce. They can also be the
most costly. The more complex the
texture, the longer it takes to calculate
and the longer it takes to apply to an
object, which finally increases the
rendering time.

When you're creating the texture, you
always have to keep in mind that it’s part
of a material, which is part of an object.
All these parts can contribute to the
rendering time:

*  The material that contains the texture
may have several complex attributes
of its own, like Transparency and
Reflection.

*  The size of the object may also
contribute to the rendering time.

Consider the effect of applying a complex
texture to a complex material onto an
infinite plane. The time to calculate this
object would be staggering.

A good rule of thumb when working with
complex objects and textures is to make
the texture element as simple as possible.
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These tips are meant only as a
precaution to prevent you from
inadvertently creating a huge texture.
That doesn’t mean that you shouldn’t
use the more complex features as well,
after all they were created for a reason.
You should just use them cautiously.
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Noise

« Use asimpler noise type. Some noise
types (like Vortex) require more time
to process than others.

+ Restrict the amount of noise you add
to each component. in fact, not all
the components need to have noise.

« Watch the frequency of the noise.
Higher frequency noise requires
more time to calculate then lower
frequency noise.

»  Watch the number of octaves in the
noise. Each octave adds another level
of complexity.

Phase

«  When you're designing the phase, you
may want to use simpler noise.
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Cut down on the number of phase
types you combine. If each
component has a different type of
phase, combining them can increase
calculation times.

Watch the amplitude of the noise.
Higher amplitude phase takes much
longer to calculate.

Apply Global Phase cautiously. This
is the quickest way of increasing the
complexity of your texture because
global phase introduces more
complexity into each component
simultaneously.

Filtering

Filtering introduces complexity or

detail into the noise of a component.

Make sure that you aren’t using a
filter unnecessarily. Not all noise
needs filters.

Be careful when you apply a Global
Filter as this adds even more
complexity to the noise.
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Creating Skies
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Environments and Bryce 3D

A Bryce sky defines the virtual
environment of your scene. Unlike many
other 3D applications, Bryce’s virtual
environment is not merely a backdrop, it
is an infinite 3D representation of natural
environmental phenomena.

All the elements in your sky interact with
each other just like the they would in the
real world. Colors in your environment
interact with everything in your scene
just as they would in nature. For example,
red sunlight is invisible until it strikes an
object, then the object exhibits red
highlights. If it's a blue object, it takes on
a purple cast and so on.
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The colors in the sky change depending
on the position of the sun, and how much
moisture (Haze, Fog) is present in the
atmosphere. All this, plus natural
reflection, refraction, and more make
Bryce’s Sky & Fog palette responsible for
a great deal of the natural, or
supernatural, look and feel of Bryce
images.

The objects in your scene may look incredibly
realistic on their own...

130 Chapter @ Bryce 3D

...bout when you add a sky, the scene becomes a
window looking out into a real world.

You can add even more realism to a sky
by enabling one of the many
environmental effects available for skies.
Using these effects you can create night
skies full of stars, or have a bright
rainbow streaking across the roof of your
world. One of the most spectacular
effects is the Volumetric World effect.
When this effect is enabled all the light in
your scene appears as visible rays. This is
similar to the effects of light shining
through clouds on a hazy day.

The other-worldly look of this spaceship landing
was created using Volumetric World.

Like any other scene setting, skies can be
animated. Any property of a sky can be
changed at different points along the
animation timeline. When the animation
plays, the sky property will appear to
change over time. Using this technique,
you can create a scene that changes from
day to night, or from clear to cloudy.
Refer to “Animating Skies” on page 389
for more on animating skies.
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The Sky & Fog Palette

The Sky & Fog palette is where you'll set
up the attributes of your environment.
The palette uses visual controls in the
form of thumbnails to help you see how
changing the value of an attribute affects
your sky.

Sky Mode
Shadow Intensity

Haze Intensity
Cloud Altitude
Cloud Coverage

Fog Height

Fog Color Cloud Color
Ambient Color Sky Dome Color
Sky Mode Options  Haze Color

The Sky & Fog palette’s thumbnails let you set
values for sky attributes.

The name of the control you're adjusting
appears in the Text Display area of the
Control palette. You can also use this area
to help guide you if you prefer numeric
precision.

L WL
Fog

Fog Color
The Text Area displays the name of a Sky & Fog
control as you pass the cursor over it. When
you're adjusting the setting of a controls, this
area displays its current value.

Each control has at least one color swatch
along the bottom of the thumbnail.
Theses swatches are used to set the color
for a given sky attribute, like cloud color
or fog color.

Next to the thumbnails are a series of
controls that let you set the frequency and
amplitude of clouds, the position of the
sun or moon and store sky properties.
There are no visual guides for these
controls but you can see their effects in
the Preview area.

Cloud Frequency
and Amplitude

Day/Night Toggle

Random Skies

Memory Dots

Sun Color Sky & Fog

Sun/Moon Position"')ptio"s

The set of controls at the end of the palette does
not have visual guides, but you can see their
effects in the Preview area.

Environmental Attributes dialog

The Sky & Fog options button provides
access to the Environmental Attributes
dialog. This dialog contains controls for
fine-tuning environmental effects like
clouds, rainbows, and sun and moon
rings.

The dialog contains three tabs:

* Sun & Moon contains controls for
positioning the sun and moon as well
as adding effects like rings and
horizon illusions.
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* Cloud Cover contains controls for
editing cloud textures and setting up
cloud animations.

+  Atmosphere contains controls for
rainbows, visible lights and color
blending.

Working with the Sky & Fog
palette

The Sky & Fog palette has several settings
that you can use to control how the
palette affects your scene and how the sun
tracks your camera view. You can also use
the palette’s memory dots to store
settings as you experiment with different
environmental attributes.

Using the Control Thumbnails

The thumbnails are visual guides, and
they are also used to set the attributes of
Sky & Fog effects.

To change the intensity of an effect:

o Drag to the left or right inside the
thumbnail to change the intensity of
the effect.
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To pick a color for an effect:

o Click the color bar below the
thumbnail. A color picker appears
and your pointer changes to an
eyedropper.
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Click on the bar below the thumbnail to access
the color picker.

While the eyedropper is active, you
can select colors from anywhere in
your scene, or even different parts of
the interface.
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For more control after picking with the
color picker, try Option-click/Alt+click
to get Bryce’s second color editor,
switch to HLS mode and adjust
saturation or lightness (less saturated
colors can make for more realistic fog
and haze effects), or you can enter
numeric values if you need to precisely
match specific colors.
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Setting Palette Options

The Sky & Fog palette options let you link
the palette controls directly to your scene
and link your sun to the camera.

To link Sky & Fog attributes directly to

your scene:

o Click the triangle icon below the
memory dots at the right edge of the
palette and choose Choose Auto
Update from the menu.

When this option is enabled, every
change you make to the Sky & Fog
palette settings will start a render of
your scene with the new sky settings.

Note: Unless you have marqueed a
small region to be updated, every
change you make will begin a
completely new render.

To reset Sky & Fog palette settings to

their defaults:

o Click the triangle icon below the
memory dots at the right edge of the
palette and choose Reset Sky from the
menu



Saving Sky & Fog settings

The memory dots in the Sky & Fog
palette let you store your favorite

Sky & Fog settings. Using these dots you
can safely explore many Sky & Fog
configurations without losing your
favorite settings along the way. Memory
Dots appear along the right side of the
palette.

Use the Memory dots to store your favorite
Sky & Fog settings.

To save Sky & Fog settings:
o Inthe Sky & Fog palette, click on an
empty dot (empty dots are gray).

All the current Sky & Fog palette
settings are stored into the
selected dot.

To switch to a saved Sky & Fog setting:
o Click on a full dot (full dots are
turquoise.) The current settings are

replaced with the settings stored in
the dot.

An active dot will be turquoise with a
white point inside it.

To reset Sky & Fog settings to default:

o Inthe Sky & Fog palette, click the
uppermost memory dot. This dot
always appears full.

To delete a saved Sky & Fog setting:
o Option-click/Alt+click on a full
Memory Dot.

The uppermost dot cannot be
cleared.
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Memory Dots are not saved with the
file, so be sure to save your favorite
skies as presets before ending a Bryce
session.

P e

Randomizing Skies

Randomizing skies is a very powerful way

of exploring possibilities you may never .
find any other way. When you randomize ]
the sky all the settings in the palettes are ;
replaced by randomly generated values.

P

Click the Randomize Sky button to randomly
generate sky settings.

To randomize your sky:
o Click on the Randomize Sky Button.

Remember, you can always return to

the default settings by click on the

top Memory Dot. =
_ T
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Working with Sky Modes

The Sky modes act as the base of your sky.
The Sky modes control lets you set the
base colors and light tones for your
environment. There are four modes

available: Soft Sky, Dark Sky, Custom Sky
and Atmosphere Off.
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As you switch between the modes, the
thumbnail also changes to give you a
preview of what the mode looks like.
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The four Sky modes control the base colors and
tones used to create your sky.

To select a sky mode:

o Click the Sky mode thumbnail to
cycle through the four modes, or

o Drag left or right inside the
thumbnail to cycle through the
modes, or

o Click the triangle icon next to the
thumbnail and choose a mode from
the menu.
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Sky Modes

Soft Sky is the default state of the sky. It
features softer shades of blue and lighter
tones.

Darker Sky is a darker version of Soft
Sky. It uses darker shades of color and
tones. This mode is good for creating

more brooding skies.

Custom Sky lets you choose your own
colors for the sky; this way you can create
some truly alien environments. When
this mode is selected, the standard
behavior of colors in the sky with respect
to sun position is disabled.

Horizon
Color

Solar
Halo Color

Sky Color

In Custom Sky mode you can pick your own
colors for the sky.

Atmosphere Off disables the standard
sky color behaviors, relative to sun
position, and uses a single color for the
sky. This mode is useful when you need
to render objects against a simple colored
(or black or white) background. The Sun
color still affects objects in this mode. If
you have red sunlight, for instance,
objects in your scene will reflect red light.

To set custom sky colors:

1. Click the triangle icon next to the Sky
Mode thumbnail and choose Custom
Sky from the menu. The thumbnail
changes to the Custom Sky control.



2. Click the Sky Color swatch and

choose a color from the color picker.

The Sky Color is the main sky color
in this mode, regardless of sun
position.

Click the Solar Halo Color swatch
and choose a color from the color
picker.

This is the color of the halo around
the sun.

Click the Horizon Color swatch and
choose a color from the color picker.

This color will in certain cases affect
your scene below ground level if you
have a haze setting of greater than
zero. It will also impact the color of
Stratus clouds near the horizon.

In most cases, this will be the least

obviously used color in your scene;
unless you are making outer space

scenes, in which case this could be

very useful for you.

To render objects against a plain
background:

1. Click the triangle icon next to the Sky
Mode thumbnail and choose
Atmosphere Off from the menu. The
thumbnail changes to the
Atmosphere Off control.

2. Click the Atmosphere swatch and
choose a color from the color picker.

3. Drag left inside the Haze control and
set the value to 0. This setting
eliminates the suggestion of a

horizon.
TR A SR
Setting Sky Attributes

Once you've selected a Sky mode you
have the basis for your virtual
environment. All the other atmosphere
effects you add later will interact with the
base mode. There are two other attributes
that affect how all the other effects will
appear: Shadows and Ambient color.

Shadows in Your Scene k

All the objects in your scene cast i
shadows. Using the Shadow control you

can set the intensity and color of all the y
shadows in your scene.

Shadow

Color
Use the Shadows control to set the color and
intensity of shadows in your scene.

Shadows=10

Shadows=90

As you change the value of the Shadow control,
the brightness of shadows changes.

The shadow control is not the only
control for shadows. The position of
shadows is dependent on the position of
the sun. Since the sky interacts directly
with objects in the scene, the color of the
sun also effects the color of shadows.

The object’s material properties also
effect the color of shadows.
Semi-transparent or transparent objects
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with a transparency color will change the

color of the object’s shadow. As well,
volume materials can dramatically
change the shape and color of shadows.

Use the Shadows control to set the color and
intensity of shadows in your scene.

- il _-‘_'-‘——_.___ R
By default, the Clouds in Bryce do not
cast shadows. If you want the cloud
layer to cast shadows on the ground
below, enable the Cloud Shadows
option. Refer to “Cloud Coverage” on
page 145 for more on this option.
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To set shadow intensity:

1. Display the Sky & Fog palette by
clicking the Sky & Fog button at the
top of the Bryce window.

2. Drag left or right inside the Shadow
control thumbnail. Dragging left
decreases the intensity and dragging
right increases it.

The cursor changes to a two headed arrow as
you drag over the control.

To set shadow intensity numerically:

1. If it’s not already visible, display the

Sky & Fog palette by clicking the text

item on the menu bar.

2. Click the triangle in the corner of the
palette and choose Edit Sky & Fog.
The Environmental Attributes dialog
appears.
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Use the Environmental Attributes dialog to set
sky attributes numerically.

3. Enter a value into the Shadow
field.This field governs the intensity
of shadows rendered in your image.
The range is 0 to 100%, and the
default value is 100%.



Ambient Color

The Ambient Color is the color of all the
light that surrounds the objects in your
scene. Light from the sun interacts with
ambient color to produce the color for
both highlights and shadows.

Ambient Color is used as the source color
for material Ambience. The Ambient
Color tints the surfaces of all objects in
your scene that have some level of
ambience. Any other color you apply to
the object’s surface is mixed with the
Ambient color to create the final surface
color. For example, if the Ambient Color
is red, any color you assign to an object’s
surface ambience is mixed with red.

Refer to “Ambience” on page 201 for
more on material ambience.

To set Ambient Color:

o Click the color swatch below the
shadow control thumbnail and
choose a color from the color picker.

For realistic effects, at noon, or in the
afternoon, ambient color should be a
little blue to get nice blue-ish
shadows. At dawn, you can set
Ambient Color to red or pink, and at
night you can set it to gray-blue.

b ‘._
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Adding Fog and Haze

Fog and Haze are two atmospheric effects
that can add realistic depth to your scene.
Fog can make objects appear to disappear
the farther they get from the camera.
Haze can add the illusion of a distant
horizon. The Fog and Haze controls in
the Sky & Fog palette let you control the
color and intensity of these effects.

Fog

Haze Intensity

Haze Color

Fog Color

Use the Fog and Haze controls to set the
intensity and color of Fog and Haze effects.

Fog

Fog can add an element of sensuality,
mystery, and even realism to your scenes.
It acts like a thin layer of cloud close to
the ground. Using Fog you can create the
illusion of depth without having to add
distant objects.

Fog can create a sense of depth in your scene In
this scene, the fog was used to add depth to the
road as it moves away from the camera. Notice
how the feeling of depth was created without the
addition of background objects.

You can set intensity, height and color

attributes for the fog.
e

W

Fog=10 Fog=90

For example, you can see how the fog changes in
these skies as the Fog value changes.

The fog acts as a global layer covering the

entire scene. Its color and intensity are
the same through the scene.
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To set the amount of Fog:

1. Display the Sky & Fog palette by
clicking the Sky & Fog text button.

2. Drag horizontally inside the Fog
thumbnail to increase or decrease the
amount of fog in your rendered
scene. Drag to the left to decrease the
amount of fog and to the right to
increase it.

To set Fog height:

1. Display the Sky & Fog palette by
clicking the Sky & Fog text button.

2. Drag vertically inside the Fog control
to increase or decrease the height of
your fog. Drag up to increase the
height and down to decrease it.

The height and amount values are
displayed in the Text area of the Control
palette as you drag.
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To set Fog color:

1. Display the Sky & Fog palette by
clicking the Sky & Fog text button.

2. Click the color swatch beneath the
Fog thumbnail and choose a color
from the color picker.

To set Fog attributes numerically:

1. If it’s not already visible, display the
Sky & Fog palette by clicking the text
item on the menu bar.

2. Click the triangle in the corner of the
palette and choose Edit Sky and Fog.
The Environmental Attributes dialog
appears.

3. Click the Atmosphere tab.

4. Enter avalue in the Fog field. This
field sets the amount of fog rendered
in your image. The range is 0 to
100%, and the default value is 0%.

5. Enter avalue in the Height field. This
field sets the height of fog rendered
into your scene, assuming there is a
value greater than zero in the Fog
field. The range is 0 to 100%, and the
default value is 0%.

Blending the Fog Color

Since the fog remains constant
throughout the scene, you may get some
odd looking results when you're creating
a sunset or sunrise. In these cases the sun
is very close to the ground plane where
the fog exists, so the fog should react to
the sunlight. The Blend with Sun feature
lets you create exactly this effect. As the
sun approaches the Fog, the color and
intensity of the fog changes to interact
with the color of the sun.

In this example, the Fog is linked to the sun so

you can see the changes in the fog color and
intensity as the sun gets closer to the horizon.

To link Fog color to the Sun controls:

1. If it’s not already visible, display the
Sky & Fog palette by clicking the text
item on the menu bar.



Click the triangle in the corner of the
palette and choose Edit Sky and Fog.
The Environmental Attributes dialog
appears.

Click the Atmosphere tab.

4. With the object selected, click the M

icon that appears next to its
bounding box. The Materials Lab
appears.

Click the Volume button at the top of

the lab.

6. Set up the values for channels in the
material. Refer to “Building
Materials” on page 232 for more on
creating materials.

4, Click the Blend with Sun button.

Make sure the Blend Fog button is
enabled.

6. Enter avalue in the Color field to set
how much of the fog color is blended
with the sun.

* Choose a cloud-like texture from
texture components. Stratus,
Cumulus or one of the
CloudBump textures work well.

In this example, fog only appears around the
base of the castle. This effect was created by
applying a volume material to a flattened sphere

to set the intensity of the fog color object.
when it's blended. «  Pay special attention to the Base

7. Enter avalue in the Luminance field

f- _-'---_._____-_ R o
This technique can also be used to
create visible smoke, or gas.
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Density channel as this sets the

To get the best effect, set both these
transparency of your fog.

fields to 100.
* You need to set a high value for

the Edge Softness channel to blur

the edges of the sphere object.
There may be times when you want to T 4R TR SRS 43 R 7. Click the OK icon to exit the lab
create localized pockets of fog. For this ' '
type of effect you you'll need to use an
object with a volume material applied to
it; this way the object looks like fog. The . .
area covered by the fog is then controlled 2= Click the Sphere tool. A sphere object
by the size of the object. A flattened appears in the scene.

sphere usually makes a good fog volume. 3. Squash and stretch the sphere, until it
is the desired shape. Refer to
“Transforming Objects” on page 285
for more on transforming objects.

Localized Fog

To create localized fog: 8. In the Working window, move the

object to the area where you want the
fog to appear.

1. Display the Create palette.
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Haze

Haze is the natural effect you see when a
plane (like the ocean) stretches out
towards the horizon. At this distant point
a different color appears over the horizon
and light becomes fuzzy.

Haze creates the illusion of a distant horizons. In
this scene, the haze is used to create the
distinction between the water plane and the sky.

The Haze control lets you set the intensity
and color of the Haze effect in your Bryce
scene.

With haze set to zero, your horizon will
have an unnaturally hard edge. Also note
that the Cloud Altitude control will affect
the height of this band of haze. The
higher the altitude of the atmosphere, the
wider the band of haze at the horizon.
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Haze=0 Haze=90

You can see how the haze changes in these skies
as the Haze value changes.
Haze is applied to the entire scene

equally. The haze always appears at the
horizon.

To set Haze intensity:

1. Display the Sky & Fog palette by
clicking the Sky & Fog button at the
top of the Bryce window.

2. Drag horizontally inside the Haze
thumbnail to increase or decrease the
degree of haze in your scene. Drag to
the left to decrease the amount of
haze and to right to increase it.

To set Haze intensity numerically:

1. If it’s not already visible, display the
Sky & Fog palette by clicking the
button at the top of the Bryce
window.

2. Click the triangle in the corner of the
palette and choose Edit Sky and Fog.
The Environmental Attributes dialog
appears.

Click the Atmosphere tab.

4. Enter avalue in the Haze field. This
field governs the amount of haze
rendered into your scene. The range
is 0 to 100%, and the default value is
4%.

w

To set Haze color:

1. Display the Sky & Fog palette by
clicking the Sky & Fog button at the
top of the Bryce window.

2. Click the color swatch beneath the
Haze thumbnail and choose a color
from the color picker.

Fog and Haze colors should be the same,
or almost the same. For realism, the haze
should be a little brighter and bluer than
the fog. At nighttime, you have less
illumination, so an effective nocturnal
haze color could be dark blue-gray.



Blending the Haze color with the Sun

Since the Haze always appears at the
horizon it should change color as the sun
sets or rises. The Blend with Sun feature
lets you simulate this effect. When the
two elements are linked, the haze color
and brightness change depending on the
position of the sun. This creates very
realistic looking sunsets.

In this example, the haze is linked to the sun.
You can see how the color of the horizon changes
as it gets closer to the sun.

When you're using this feature to creates
sunsets, you should choose the haze color
carefully so as to create a natural-looking
color scheme.

To link Haze to the Sun controls:

1. If it'’s not already visible, display the
Sky & Fog palette by clicking the text
item on the menu bar.

2. Click the triangle in the corner of the
palette and choose Edit Sky and Fog.
The Environmental Attributes dialog
appears.

Click the Atmosphere tab.
4. Click the Blend with Sun button.

Make sure the Blend Haze button is
enabled.

6. Enter avalue in the Color field to set
how much of the haze color is
blended with the sun.

7. Enter avalue in the Luminance field
to set the intensity of the haze color
when it’s blended.

8. To get the best effect, set both these
fields to 100.

Clouds in Bryce

There two kinds of clouds in Bryce:
clouds in the environment and cloud
planes.

Clouds you add to your sky interact with
the light in your scene. They can block
out the light of the sun and change the
color of the light that hits the objects in
the scene. These clouds are infinitely
distant so you cannot fly through the
clouds in the sky. If you want to have this
effect, use a cloud plane. Sky clouds can
also cast shadows on the ground below.

The clouds in this scene were created using
Cumulus clouds from the Sky and Fog palette.
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You can change the look of the clouds by
editing the texture used to create it. By
changing the texture you can alter the
shape and position of the clouds within
the sky.

Cloud planes are infinite planes that act
as objects in your scene. They cast
shadows and can interact with other
objects.

The clouds in this scene were created using an
infinite cloud plane. Using this type of cloud,
you can fly an airplane through the layer.

Both types of clouds can be animated.
The clouds in the sky can be animated by
changing their color, position or
frequency, and cloud planes can be
animated just like other objects. They can
also be animated using the Cloud Motion
controls. These controls let you set
parameters for automatically animating
clouds.
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Refer to “Animating Couds” on
page 391 for more on animating
clouds.
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Adding Clouds

The Sky & Fog palette provides several
controls that set the attributes of clouds
in your sky. The Cloud Coverage, Cloud
Altitude and Cloud Frequency and
Amplitude controls let you set the general
appearance of your clouds. The Cloud
Color sets the color of the clouds.

Cloud Frequency and Amplitude

Sky Dome Color Cumulus Color
Cloud Height

Use the cloud controls to set the attributes of the
clouds in your scene.

Cloud Cover

You can add clouds to your scene in five
easy steps:

+  Select the type of cloud

*  Adjust the cloud texture
+ Set the cloud coverage and color
+ Setcloud altitude

+  Set the frequency and amplitude of
clouds

Cloud Types

There are two types of clouds you can add
to your Bryce environment: Cumulus and
Stratus. Cumulus clouds are generally
found at lower altitudes and appear
thicker and fluffier.

-

The sky in this scene uses Cumulus clouds.



The Stratus appear at higher altitudes and
appear thinner and more wispy.

.
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The sky in this scene uses Stratus clouds.

To add Cumulus clouds to a sky:

1. If it’s not already visible, display the
Sky & Fog palette by clicking the
Sky & Fog button at the top of the
Bryce window.

2. Click the triangle in the corner of the
palette and choose Cumulus Clouds.

Cumulus clouds are thicker, darker
clouds at a lower altitude. These
clouds will take on tinges of Sunlight
color, Ambient color, or Cumulus
color.

To add Stratus clouds to a sky:
1. If it'’s not already visible, display the
Sky & Fog palette by clicking the

Sky & Fog button at the top of the
Bryce window.

2. Click the triangle in the corner of the
palette and choose Stratus Clouds.

Stratus clouds are bright white, thin,
clean clouds that appear at high
altitudes. These clouds are very
responsive to Sunlight color and Sky
Dome color, and less responsive to
Cumulus color or Ambient color.

-~ _-_'-'-l—-u______ -
You can also choose both cloud types,
or neither. Selecting neither cloud type

creates a clear sky.
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Editing Cloud Textures

Clouds in Bryce are created using a
procedural texture with a cloud pattern.
The color, position size, and pattern
within the texture determines the final
look of cloud in your sky. You can edit
this texture using either the

Environmental Attributes palette, or for
more complex editing, you can use the
Texture Editor.

The texture used for a clouds can come
from either the Bryce texture library or
you can create your own.

To edit cloud texture in the
Environmental Attributes dialog:

1. If it'’s not already visible, display the
Sky & Fog palette by clicking the
Sky & Fog button at the top of the
Bryce window.

2. Click the triangle in the corner of the
palette and choose Edit Sky & Fog.
The Environmental Attributes palette
appears.

3. Click the Cloud Cover tab.
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The Cloud Cover tab provides controls that let
you edit the textures that are used to create the
clouds in your scene. As you change a texture,
the texture preview updates.

4.

Click the Arrow icon next to the type
of clouds you want to edit.

-

The two edit arrows let you quickly choose
which texture you want to edit.

5.

144

Click the + or - Turbulence buttons
to increase or decrease the amount of
noise in the texture.

* Increasing the Turbulence
creates a more dense pattern
within the texture.

Click the + or - Complexity buttons
to increase or decrease the amount of
detail in the texture.
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* Increasing the Complexity
increases the complexity of the
patterns within the texture.

Click the Randomize button if you
want to choose a randomly generated
texture for your clouds.

Click the OK icon to apply your
changes.

To edit cloud textures in the Deep
Texture Editor:

1.

e

If it'’s not already visible, display the
Sky & Fog palette by clicking the
Sky & Fog button at the top of the
Bryce window.

Click the triangle in the corner of the
palette and choose Edit Sky & Fog.
The Environmental Attributes palette
appears.

Click the Cloud Cover tab.

Click the Arrow icon next to the type
of clouds you want to edit.

Click the Editor button. The Deep
Texture Editor appears.

The cloud texture and its
components appear in the
component windows.
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If you're not familiar with using the
Deep Texture Editor you may get some
very unpredictable results which may
result in clouds that don’t look much
like clouds. Before you start editing the
clouds texture you may want to refer to
“Textures” on page 239 for more
instruction on how to use the editor.

When you open a cloud texture in the texture
editor, you can see its components in the various
windows. You can use the editor’s tools to
completely redesign the texture or to alter the
existing texture.

6. If you want to add additional
turbulence to the cloud texture,
adjust the texture’s Noise:



* Click the Noise button at the
bottom of the editor. The Noise
control appears.

The Noise control lets you adjust the frequency
of the noise in any of the texture’s components.

+ Move the component indicator at
the top of the control to the
component you want to edit.

+  Adjust the Noise slider to
increase/decrease the frequency
of the noise in the texture.

7. If you want to change the colors of a
component, click one of the color
indicators in the component window
and choose a new color.

8. If you want to add more complexity
to the texture, adjust its Phase:

+ Click the Phase button at the
bottom of the editor. The Phase
control appears.

The Phase control lets you adjust the amplitude
of the phase in any of the texture’s components.

+ Move the component indicator at
the top of the control to the
component you want to edit.

+  Adjust the Phase slider to
increase/decrease the amplitude
of the phase.

9. If you want to change the pattern in
the texture, apply a filter;

+ Click the Filter button at the
bottom of the editor. The
Filtering control appears.

Clip aX+b
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The Filtering control displays a graphical
representation of the filter applied to your
texture. By changing the equation of the filter to
the value of the variables, you can change the
patterns within the cloud texture.

+ Move the component indicator at
the top of the control to the
component you want to edit.

+ Change the filter equation and
variable values to adjust the filter
applied to your texture.

* il _-__‘-L___-_ e
Filtering is a rather complex operation.
Try experimenting with different

equations and see what happens.
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10. Click the OK icon to exit the editor.

Cloud Coverage

Cloud Coverage controls the quantity of
clouds you can see in the sky. A high
coverage means that there is a very dense
cloud layer, and a low setting means that
there are very few clouds in the sky.

Cloud coverage also indirectly controls
the brightness of the environment. The
more cloud coverage you have in a sky,
the darker the environment, since less
sunlight can pass through the clouds.

Adjusting cloud coverage changes the
quantity of clouds but not the
frequency. You can think of it as
adjusting the volume on a radio
without changing the station.
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Cloud Coverage

Cloud Color

The Cloud Coverage control in the Sky & Fog
palette lets you interactively set the quantity of
clouds in the sky.

Cloud Coverage=10 Cloud Coverage=90
For example, you can see how the clouds change

in these skies as the cloud coverage value
changes.

To set cloud coverage:

1. Ifit's not already visible, display the
Sky & Fog palette by clicking the
Sky & Fog button at the top of the
Bryce window.

2. Drag left or right inside the Cloud
Coverage control thumbnail. Drag
left to decrease coverage and right to
increase it.

Bryce 3D

To set cloud coverage numerically:

1. If it’s not already visible, display the
Sky & Fog palette by clicking the
Sky & Fog button at the top of the
Bryce window.

2. Click the triangle in the corner of the
palette and choose Edit Sky & Fog.
The Environmental Attributes dialog
appears.

Click the Cloud Cover tab.

Enter a value in the Density field at
the bottom of the dialog.

 ow

Density  Height

Scale Amp.
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The De}\sity field controls the amount of clouds
in your scene. The range is 0 to 100%, and the
default value is 20%.

To set cloud color:

1. Display the Sky & Fog palette by
clicking the Sky & Fog button.

2. Click the color swatch beneath the
Cloud Coverage thumbnail and
choose a color from the color picker.

Cloud Altitude

The altitude of your clouds has a great
effect on the personality of your sky.
Higher altitudes will result in smaller,
more distant cloud formations, as well as
a thicker band of haze at the horizon.
Lower altitudes result in larger, more
languorous cloud formations and a
thinner band of haze at the horizon.

Cloud Altitude

The Cloud Altitude control in the Sky & Fog
palette lets you interactively set the height of the
cloud layer in the sky.

Cloud Altitude=10 Cloud Altitude=90

For example, you can see how the clouds change
in these skies as the cloud altitude value changes.

There are two things to remember when
working with this control. First, the
Cloud Altitude will affect the size of your
Haze band, if you have a haze setting
greater than zero. The higher the altitude,



the wider the haze region will be on the
horizon. You can use this interaction to
your benefit.

Second, remember to lower your altitude
setting if you are creating a nighttime
scene. Since high altitudes increase the
size of the horizon Haze region, the sky
will be too unnaturally bright for realistic
night scenes.

To set cloud altitude:

1. If it’s not already visible, display the
Sky & Fog palette by clicking the text
item on the menu bar.

2. Drag horizontally inside the Cloud
Altitude control thumbnail. Drag left
to decrease altitude and right to
increase it.

To set cloud altitude numerically:

1. Display the Sky & Fog palette by
clicking the Sky & Fog text button.

2. Click the triangle in the corner of the
palette and choose Edit Sky & Fog.
The Environmental Attributes dialog
appears.

3. Click the Cloud Cover tab.

4. Enter avalue in the Height field at the
bottom of the palette.

Density  Height

2o | e
Scale Amn.
The Height field controls the height of the clouds
in your scene. The range is 0 to 999, and the
default value is 3.

Sky Dome Color

The Sky Dome color lets you create a
color wash over your scenes, even if there
is no sunlight present. This color
simulates the natural effect that occurs
when you have color in the sky even
though the sun has set. Sky dome color is
a great way of creating late afternoon or
evening scenes.

Sky Dome Color

The Sky Dome Color control in the Sky & Fog
palette lets you choose a color from either the
color picker or the color dialog.

- e
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For late afternoon and early evening
realism, try using a touch of orange or

yellow. This will create a cast of color

over your entire scene, regardless of
the position or color of the sun or
moon.

- B
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To set Sky Dome color:

1. If it's not already visible, display the
Sky & Fog palette by clicking the text
item on the menu bar.

2. Click the color bar beneath the Cloud
Altitude control thumbnail and
choose a color from the color picker.

Frequency and Amplitude

The Frequency and Amplitude control
lets you set the types of cloud formation
you'll see in your sky. By combining these
two controls you can change your clouds
from light and fluffy to dark and
brooding.

Use Frequency and Amplitude to control the
types of cloud formations in your scene.
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Frequency

Amplitude

This graph shows the effects of different
Frequency and Amplitude settings on a sky.
Frequency values range from 2 at the top to 150
at the bottom. The Amplitude values range from
50 at the left to 500 on the right.

2.

In the Cloud Frequency and
Amplitude control, drag horizontally
to control the frequency of your
cloud formations.

Drag left, and the “spikes” will get
closer together, resulting in smaller
formations. Drag right for larger,
more luxurious formations.

e

The Text Display area shows you the
numerical value of the amplitude as
you drag

e

3. Drag vertically to control the

amplitude of your cloud formations.

Drag away from the horizontal
center, and the spikes increase in
height, resulting in formations with
harder edges. Drag toward the
horizontal center for softer-edged
formations.

everything that was previously clear
sky will be clouds, while everything that
was cloud will be clear sky.

N .

To set Frequency and Amplitude
numerically:

1.

If it’s not already visible, display the
Sky & Fog palette by clicking the text
item on the menu bar.

Click the triangle in the corner of the
palette and choose Edit Sky & Fog
from the menu. The Environmental
Attributes dialog appears.

Click the Cloud Cover tab.
Enter a value in the Scale field.

ZLII él

Scale  Amp.

The Scale field controls the frequency (scale) of

cloud formations in your scene. The range is
-200 to +200, and the default value is 25.

e,

To set Cloud Frequency and Amplitude:

1. Display the Sky & Fog palette by
clicking the Sky & Fog button at the
top of the Bryce window.
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Note: It is possible to invert the spikes.
This means that you can exchange
positive and negative spaces in your
sky. If you invert the amplitude,



5. Enter a value in the Amplitude field.

u -
Zoale Amp.
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The Amplitude field controls the amplitude

(edge softness) of clouds in your scene. The range
is -500 to +500, and the default value is 100.

Linking Clouds to the Camera View

If you move the camera view during an
animation, the clouds in your
environment will appear to zoom by,
creating a kind of time-lapsed effect. If
you want the clouds to appear fixed as
you move the camera, link the cloud in
the sky to the camera view. This way,
wherever the camera moves the clouds
will follow, so that they seem to remain
stationary.

To link clouds to view:

1. If it’s not already visible, display the
Sky & Fog palette by clicking the text
item on the menu bar.

2. Click the triangle in the corner of the
palette and choose Edit Sky & Fog
from the menu. The Environmental
Attributes dialog appears.

3. Click the Cloud Cover tab.

4. Click the Link Clouds to View
button.

Refer to “Animating Skies” on
page 389 for more on animating
skies.

Using a Fixed Cloud Plane

As you move higher up in a Bryce
environment, the cloud pattern shifts, so
that it appears as if you're getting closer to
the clouds. If you want to counter this
effect, you can use the Fix Cloud Plane
option to freeze the cloud pattern so that
it doesn’t change as you move higher up
in the environment.

To use a fixed cloud pattern in your sky:

1. If it'’s not already visible, display the
Sky & Fog palette by clicking the text
item on the menu bar.

2. Click the triangle in the corner of the
palette and choose Edit Sky & Fog
from the menu. The Environmental
Attributes dialog appears.

3. Click the Cloud Cover tab.
4. Click the Fixed Cloud Plane button.

"
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Working with the Sun

The sun is the source of all natural light
in your scene. Its attributes have a
profound effect on the look of your scene.

The color of the sun affects all the colors
of all the object in the scene; Sunlight
color tints all the other visible colors.

The position of the sun controls the time
of day in your scene. If the sun is above
the horizon, it is day; if it is below, it is
night, and if it is at the horizon, it is
sunrise or sunset.

The sun can be animated just like all the
other elements of your Bryce scene. You
can create time-elapsed effects by
changing the position of the sun over the
course of an animation. Refer to
“Animating Sun or Moon Position” on
page 392 for more on animating the Sun.
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Positioning the Sun

The sun position control sets the
direction your natural light is coming
from whether it is sunlight or moonlight.
The position can be set using the Sun
control in the Sky & Fog palette. The
control works like a trackball, with the

sun at one end and the moon at the other.

The control works like a trackball. As you drag
over the control both elements move in the
direction you drag.

You can think of the control as a compass:
if the highlight on the Sun Control sphere
is positioned at 12 o'clock, the light
comes from the north, and so on.
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As you change the position of the sun, the “time
of day” changes. When the sun position is closer
to the edges of the control, the sun appears closer
to the horizon, making the scene darker.

When the sun is in the center of the control, the
sun shines from directly above the sun, like it
would at high noon.

The colors in your sky will change
depending on the position of the Sun
Control, or the “time of day...” just like in
the real world.

The angle of the shadows changes as the
sun changes. If your object is shiny, and
there are no other light sources, the
position of the sun controls where the
highlight appears.

In this example, you can see the effects of the

sun’s position on several reflective and shiny
objects.

Day and Night

Your sky always contains two heavenly
bodies: the sun and the moon. There is
always one body visible in your sky. At
night it is the moon and in the day its the
sun.

The two bodies are connected and always
remain at opposite ends of the sky. As you
move the sun you're also moving the
moon. This means that when the sun dips
below the horizon in front of you, the
moon is rising behind you.



The link between the sun and the moon can be
seen by positioning the sun at the horizon in
front of the camera...

.if you turn the camera 180° you'll see the moon
just rising over the horizon as well.

To switch between night and day:
1. Display the Sky & Fog palette.

2. Click the Day/Night toggle button in
the top-left corner of the sun position
controls.

Sunrise/Sunset

You can create a sunset or sunrise by
positioning the sun or moon so that it is
visible on your horizon.

=

Sunsets or sunrises can be created by moving the
sun closer to the horizon.

The colors in the sky automatically
change to create the illusion of the
sunrise or sunset colors. You can also use
the Sky Dome color to give your sunset/
sunrise added color.

For a more realistic sunset you may want
to link the fog and haze to the sun so that
they react to the sun color as it
approaches the horizon. Refer to

“Blending the Fog Color” on page 138
and “Blending the Haze color with the
Sun” on page 141 for more on this
feature.

You may also want to enable the Horizon
illusion for the sun. This feature makes
the sun appear larger as it approaches the
horizon. Refer to “Sun/Moon Horizon
Illusion” on page 157 for more on this
effect.

To position the sun manually:

1. Display the Sky & Fog palette by
clicking the Sky & Fog button at he
top of the Bryce window.

2. Drag the larger highlight area in the
Sun Position controls to the position
where you want the light to originate.

- - _-l—--_‘_____ R o
You can position the sun, or the moon,
on the horizon as you like by nudging
the Sun Control until the light is visible
in your scene.

o e L
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To position the sun numerically:

1. Display the Sky & Fog palette by
clicking the Sky & Fog button at he
top of the Bryce window.

2. Click the triangle in the corner of the
palette and choose Edit Sky & Fog.
The Environmental Attributes palette
appears

Click the Sun & Moon tab.

4. Inthe Numerical Sun Values fields,
type a value into the X field. The X
field controls the east-to-west
position of the sun. The range is -99
to +99, and the default value is 60.

5. Enter avalue into the Y field. The Y
field controls the height of the sun
relative to your scene. The range is
-99 to +99, and the default value is
20.

6. Enter avaluein to the Z field. The Z
field controls the north to south
position of the sun. The range is -99
to +99, and the default value is zero.

~ R
= g

Positive values are above the horizon,
negative values below.
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Linking the Sun to the Camera

Normally, you'd have to reposition the
sun every time you changed the camera
to maintain a certain effect or sunlight
angle. However, if you apply the Link Sun
to Camera, you're sun will track the
camera. The position of the sun relative
to the camera remains the same no
matter where the camera is positioned.
This way you can set up the sun position
once and then not worry about losing the
effect as you move the camera.

4

When the sun is linked to the camera, the sun
moves relative to the Camera. Wherever the
camera moves the sun follows. As it moves, the
sun maintains a constant distance from the
camera.

This feature can also be very useful when
you're animating your scene. Refer to
“Animating” on page 351 for more.

To link the sun to the camera:

1. Display the Sky & Fog palette by
clicking the Sky & Fog text button.

2. Click the triangle in the corner of the
palette and choose Edit Sky & Fog.
The Environmental Attributes palette
appears.

Click the Sun & Moon tab.
4. Click the Link Sun to View button.

When this option is enabled, your
sun will always remain in the same
position relative to the camera.
Wherever you move the camera the
sun will follow. This is an easy way of
seeing how a sunset will look against
different skylines.

Sun Color

Light in nature is not usually visible until
it strikes an object. When you're using
normal light, a purple sunlight color will
not paint your entire sky purple, but
objects in your scene will reflect purple.
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When you're using Visible World,
choosing purple will paint your entire
scene purple.
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The grayscale bar at the bottom of the
color palette lets you set the intensity of
the sun. Black turns the sun off and white
sets the sun to its brightest intensity.

You can also use the color palette to set the

intensity of the sun. Black represents the lowest
intensity and white the highest.

To set the Sun Color:

1. Display the Sky & Fog palette by
clicking the Sky & Fog text button.

2. Click the Sun Color swatch and
choose a color from the color picker.

Disabling the Sun

You can also remove the sun from the sky
altogether, by disabling it. When the sun
is disabled, the only light visible in your
scene comes from individual light
sources.

To disable the Sun:

1. Display the Sky & Fog palette by
clicking the Sky & Fog text button.

2. Click the triangle in the corner of the
palette and choose Edit Sky & Fog.
The Environmental Attributes palette
appears

Click the Sun & Moon tab.
4, Click the Disable Sun/Moon button.

il
Working with the Moon
The moon is the most prominent object
in the night sky. In a night scene it
provides all the natural light in the
environment. Like the sun, the moon’s

attributes can greatly affect the final look
of your scene.

Its position in the sky effects all the angles
and intensities of all the shadows in the
scene.

The brightness is affected by the
illumination reflected of the earth. The
brighter the earthshine, the brighter the
moon appears.

Unlike the sun, the moon has phases
which simulate the effects of the earth’s
shadow passing over the face of the moon
during a month.

The moon’s position and phases can be
animated using the Animation controls
and the timeline. Refer to “Animating
Sun or Moon Position” on page 392 for
more on animating the moon.

Positioning the Moon

The moon is positioned at the same time
as the Sun. The two are always at opposite
ends of the sky, so wherever the sun is

positioned, the moon is directly opposite.

In the Sun/Moon control on the Sky &
Fog palette, the moon’s position is
represented by the smaller highlight
portion of the Sun Position trackball.
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The position of the moon is represented by the
smaller highlight portion of the position control
trackball. You can position the moon by either
moving the smaller highlight or by dragging the
sun. The moon is always opposite the sun.

To position the moon manually:

1. Display the Sky & Fog palette by
clicking the Sky & Fog button at he
top of the Bryce window.

2. Drag the blue highlight area in the
Sun/Moon Position controls to the
position where you want the light to
originate.

- ——
-
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You can position the sun, or the moon,
on the horizon as you like by nudging
the Sun/Moon control until the light is
visible in your scene.
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To position the moon numerically:

1. Display the Sky & Fog palette by
clicking the Sky & Fog button at he
top of the Bryce window.

2. Click the triangle in the corner of the
palette and choose Edit Sky & Fog.
The Environmental Attributes palette
appears

Click the Sun & Moon tab.

4. Inthe Numerical Sun Values fields,
type a value into the X field. The X
field controls the east-to-west
position of the sun/moon. The range
is -99 to +99, and the default value is
60.

*  The moon will be positioned exactly
opposite these values, so you can
invert them to position the moon
numerically, or place the Sun behind
the camera so that the moon appears
in front of it.

5. Enteravalue into theY field. The Y
field controls the height of the sun/
moon relative to your scene. The
range is -99 to +99, and the default
value is 20.

6. Enter avalue in to the Z field. The Z
field controls the north to south
position of the sun/moon. The range
is -99 to +99, and the default value
is zero.

- ——
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Positive values are above the horizon,
negative values below.
-~ R



Moon Phases

The moon phases control simulates
different aspects of the moon as it orbits
the earth.

The change in the phases of the moon can
indicate the passage of time.

The moon phase is a visual cue at to the
time of the month. In an animation, you
can use the moon phase to simulate the

passage of a time. Refer to “Animating

Sky & Fog settings” on page 390 for more.

The phase is controlled using the Moon
Phase controls in the Environmental
Attributes palette.

To set the moon’s phase:

1. Display the Sky & Fog palette by
clicking the Sky & Fog button at he
top of the Bryce window.

2. Click the triangle in the corner of the
palette and choose Edit Sky & Fog
from the menu. The Environmental
Attributes dialog appears.

Click the Sun & Moon tab.

4. Drag over the Moon Phase control.
The phase changes as you drag.
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The Moon Phase control lets you set the phases
of the moon.

5. Click the OK icon to exit the dialog.

Moon Brightness and Sharpness

The moon is directly affected by the light
reflected from the earth. The brighter the
reflection, the brighter the moon’s
shadow. In Bryce this effect is controlled
by the Earthshine setting which makes
the moon brighter or darker.

A realistic moon does not have sharp
edges and may appear blurry on hazy
nights. The Softness control lets you set
the moon'’s edge softness to give a more
realistic feel.

To set the brightness of the moon’s
shadow:

1. Display the Sky & Fog palette by
clicking the Sky & Fog button at he
top of the Bryce window.

2. Click the triangle in the corner of the
palette and choose Edit Sky & Fog
from the menu. The Environmental
Attributes dialog appears.

Click the Sun & Moon tab.

4. Drag over the Earthshine control.
Drag left to increase the brightness
and right to decrease it.

a lII Earthahine

The Earthshine control lets you adjust the
brightness of the moon.

* Enter a value in the Earthshine
field to set Earthshine
numerically.

5. Click the OK icon to exit the dialog.

Creating Skies 155




To set the moon’s edge softness:

1. Display the Sky & Fog palette by
clicking the Sky & Fog button at he
top of the Bryce window.

2. Click the triangle in the corner of the
palette and choose Edit Sky & Fog
from the menu. The Environmental
Attributes dialog appears.

Click the Sun & Moon tab.

4. Drag over the Softness control. Drag
left to soften edges, or right to
sharpen them.

&1 Soffness

The Softness control lets you set the edge softness
of the moon.

+ Enteravalue in the S field to set
Softness numerically.

5. Click the OK icon to exit the palette.

i T
Adding Environmental

Effects

The elements in a sky aren’t constant; it is
always changing, reflecting weather
patterns or the time of day. If it rains
there’s a rainbow. If its night, there’s stars.

IR IR
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If it’s sunset, the sun looks bigger. If you
look right at the sun on a hazy day you'll
see rings around it. Sometimes, if its hazy
enough you can even see the sunlight
streaking out of the clouds. All these
illusions are called environmental effects
and Bryce’s Environmental Attributes
palette lets contains all the controls you'll
need to the add them to your scene.

Sun/Moon Rings

If you look directly at the sun on a hazy
day you'll be able so see rings
surrounding it. These rings are created by
the reflection off of ice particles in the air.
In Bryce, you can use the Sun/Moon
Rings to create this effect.

In this example, rings have been added to the
sun to make the scene look like a sweltering
desert.

This effect creates concentric circles
around the image of the sun or moon.
Using the Environmental Attributes
palette, you can set the radius of the rings
and add a secondary ring to increase the
effect. The color of the rings is controlled
by the color of the sun/moon.

1. Display the Sky & Fog palette by
clicking the Sky & Fog button at he
top of the Bryce window.

2. Click the triangle in the corner of the
palette and choose Edit Sky & Fog
from the menu. The Environmental
Attributes dialog appears.

Click the Sun & Moon tab.
4. Click the Rings button.

5. Inthe Rings area, enter a value in the
Intensity field to set the brightness of
the ring.

intensity

The Intensity field next to the rings preview sets
the brightness of the rings.



6. Enter avalue in the Radius field to set
the radius of the ring.

S0 Radius

The Radius field next to the Rings preview sets
the radius of the ring.

To add a secondary Sun/Moon ring:

1. Display the Sky & Fog palette by
clicking the Sky & Fog button at he
top of the Bryce window.

2. Click the triangle in the corner of the
palette and choose Edit Sky & Fog
from the menu. The Environmental
Attributes palette appears.

Click the Sun & Moon tab.

4. Click the Secondary Ring button in
the Rings area.

Sun/Moon Horizon lllusion

If you've ever watched a sunset, you
probably noticed that the sun appeared to
get larger as it approached the horizon.
The same is true for the moon. At certain
times of the month it appears huge. This
illusion can be simulated using the
Horizon illusion.

The spooky look of this night scene was created
by applying a Horizon Illusion to the moon.

When the illusion is active, the sun or
moon will appear to grow larger as it
approaches the horizon.

To add a secondary Sun/Moon ring:

1. Display the Sky & Fog palette by
clicking the Sky & Fog button at he
top of the Bryce window.

2. Click the triangle in the corner of the
palette and choose Edit Sky & Fog
from the menu. The Environmental
Attributes palette appears.

Click the Sun & Moon tab.

4. Click the Horizon Illusion button at
the top of the dialog.

5. Inthe Horizon Illusion area, enter a
value in the Intensity field to set the
brightness of the sun/moon illusion.

4an | intensity

The Intensity field next to the Rings preview sets
the width of the illusion.

Rainbows

In the real world rainbows appear after
rainstorms as arcs of light displaying all
the color in the spectrum. In Bryce a
rainbow is an atmospheric effect that can
be added to any sky.

A rainbow is only visible if the sun is
visible, meaning you can’t have a rainbow
at night. As well, you can add a secondary
rainbow to create the illusion of
reflection.

Rainbows are linked to the sun so that as
the color or intensity of the sun changes,
so does the rainbow.

Rainbows are infinitely distant. You can’t

approach them by moving the camera, so
the pot of gold is always just out of reach.
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To add a rainbow to your sky:

1. Display the Sky & Fog palette by
clicking the Sky & Fog button at he
top of the Bryce window.

2. Click the triangle in the corner of the
palette and choose Edit Sky & Fog
from the menu. The Environmental
Attributes dialog appears.

3. Click the Atmosphere tab.
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The Atmosphere tab of the Environmental
Attributes dialog contains all the controls you'll
need to create rainbows.

4, Click the Rainbows button to activate
the rainbow controls.

5. Enter a value in Radius field in the
Rainbow area. This value sets the
width of the rainbow.
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Enter a value in the Opacity field.
This controls the rainbow’s
transparency.

To add a secondary rainbow to
your sky:

1.

Display the Sky & Fog palette by
clicking the Sky & Fog button at he
top of the Bryce window.

Click the triangle in the corner of the
palette and choose Edit Sky & Fog
from the menu. The Environmental
Attributes palette appears.

Click the Atmosphere tab.

Click the Secondary Rainbow button.

Enter a value in Intensity field in the
Rainbow area. This value sets the
width of the secondary rainbow.

Star Fields

Stars in Bryce are randomly generated
star maps. They are infinitely distant so
they do not get closer as you move the
camera. Star Fields are affected by the
moon’s brightness and color.

In this example you can see how the moon
affects the color and intensity of the stars
around it.

You can also add comets to your Star
Fields. Comets appear at random
positions. You'll usually only get one or
two comets per starfield.

To add a Star Field:
1. Display the Sky & Fog palette by

clicking the Sky & Fog button at the
top of the Bryce window.



2. Click the triangle in the corner of the
palette and choose Edit Sky & Fog
from the menu. The Environmental
Attributes palette appears.

Click the Sun & Moon tab.

4, Click the Starfield button at the
bottom of the palette.

To add comets to a Star Field:

1. Display the Sky & Fog palette by
clicking the Sky & Fog button at he
top of the Bryce window.

2. Click the triangle in the corner of the
palette and choose Edit Sky & Fog
from the menu. The Environmental
Attributes palette appears.

3. Click the Sun & Moon tab.

4, Click the Comets button at the
bottom of the palette.

Volumetric World

The Volumetric World effect simulates
the effects of particles in the air being
illuminated by light sources. In Bryce this
effect turns all the light sources in your
scene into visible light sources. Sunlight

also becomes visible, so that any color
you applied to the sun appears
everywhere in the scene.

Normal Environment

Volumetric World

In this example you can see how the Volumetric
World effect transforms a scene.

Visible sunlight is volumetric, meaning
that it is affected by all the objects
within it.

f- _-‘-I--_.___-_-_ R o
Although Volumetric World is a very
beautiful effect, its also a time
consuming one. It will add a
considerably to your scene’s rendering

time.
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To add visible sunlight to your scene:

1. Display the Sky & Fog palette by
clicking the Sky & Fog button at he
top of the Bryce window.

2. Click the triangle in the corner of the
palette and choose Edit Sky & Fog
from the menu. The Environmental
Attributes palette appears.

Click the Atmosphere tab.

4. Click either the Rough or Fine button
in the Visible Light area. This option
controls the quality of the light.
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Using the Preset Skies
Library

The Preset Skies Library contains all the
preset skies available in Bryce. You can
place them in your scene and edit them
just as you would another object.

To add a sky from the Preset Skies

library to your scene:

1. Click the triangle icon next to the
Sky & Fog text button at the top of
the Bryce window. The Preset Skies
Library appears.

Use the Preset Skies Library to add pre-made
skies to your scene.
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Click on the preset thumbnails to
view preset names and descriptions.

Click the OK icon to add the selected
sky to your scene.

- _-l—-._.._____ o

The Sky & Fog palette does notzeed to
be active for you to access the Preset
Skies Library.
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You can select presets in one motion
by dragging directly to the desired
preset, and releasing the mouse
button. You can also drag over the
category names to change categories,
into the category's presets, and then
release mouse button.

Adding and Deleting Preset Skies

You can add the sky from any open scene
to the Preset Skies Library. This is a good
way of saving your favorite skies.

To add a sky to the preset library:

1. Click the triangle icon next to the
Sky & Fog text button at the top of
the Bryce environment. The sky from
your scene appears in the preview
area of The Preset Skies Library
dialog.

The preview area displays the sky from your
scene.

2. Click the Add button at the bottom of
the dialog. The Add Obiject dialog
appears.

3. Enter a name for the new preset in
the Preset Name field.

4. Enter a description of the preset in
the Description field and click the
OKicon.



This name and description will
appear beneath the object preview
whenever the preset is accessed.

_;-' _-\_n.\_.._ S— — >
You can edit the name and description
of any preset at any time simply by
pressing the Tab key, or clicking on the
name or description.

=l . — ]

5. Click the OK icon. Your preset will be
added to the first available space
within the current category.

To delete an object preset:

1. Click the triangle icon next to the
Sky & Fog text button at the top of
the Bryce environment. The Preset
Skies Library appears.

2. Click on the preset you want to
delete, or hold down Shift and select
a continuous series of presets, or hold
down Command/Ctrl and select a
discontinuous set of presets.

3. Click the Delete button at the bottom
of the Preset Skies Library dialog.

Importing and Exporting Preset
Skies

Importing and exporting presets is a
handy way to exchange custom presets
with other users.

To import a preset sky file:

1. Click the triangle icon next to the
Sky & Fog text button at the top of
the Bryce environment. The Preset
Skies Library appears.

2. Click the Import button at the
bottom of the Preset Skies Library

dialog. The file open dialog appears.

3. Locate the file which you would like
to import and click Import.

The contents of the file are placed
into the first available space in the
current category.

To export a preset sky file:

1. Click the triangle icon next to the
Sky & Fog text button at the top of
the Bryce environment. The Preset
Skies Library appears.

2. Select the preset or presets you wish
to export.

3. Click the Export button at the
bottom of the Preset Skies Library
dialog. The save file dialog appears.

4. Enter a name and location for the file
and click Save.
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Terrains

What is a Terrain?

Terrain objects define the landscape of
your scene. They represent the land forms
of any scene: mountains, deserts, islands
or even floating cities. In Bryce, a terrain
object is a height map, which determines
the shape of your landscape. You can
make subtle adjustments to the map that
can result in new mountain ranges or
river beds.

Bryce creates a terrain’s shape by
converting brightness values in grayscale
images into a height map. White areas in
the image result in the highest altitudes
and black areas result in the lowest. The
Terrain Editor lets you generate the
grayscale images that are used to create
terrain objects.
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Creating terrains in the Terrain Editor isa
two-step process. First, generate the
source of your terrain image by using the
preset effects, painting an image using the
paintbrush or importing a picture. Then,
filter the image. The editor’s Filtering
tools let you fine-tune the grayscale
values in your terrain.

You can also animate the creation of a
terrain. Using the Animation controls
available at the bottom of the editor, you
can change the shape of your terrain
object over time. You can animate the
formation of mountains and valleys, or
the gradual destruction of the landscape.

.
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The Terrain Editor

The Terrain Editor can be used to
generate the grayscale image that is
converted into a terrain object. It can also
be used to edit an existing terrain.

You cannot access the Terrain Editor
unless you have a terrain object in your
scene. When the editor opens, it
temporarily replaces the screen and
displays the current terrain as a three
dimensional preview. The height map
that was used to create the terrain is
displayed in the Terrain Canvas.
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Editing Tool panels Terrain Canvas

3D Terrain Preview

When you access the Terrain Editor, it
temporarily takes over your screen.

To add a terrain object to your scene:

1. Click the Create text button at the top
of the Bryce environment. The Create
palette appears.

2. Click the terrain object tool. A
randomly generated terrain appears
in your scene.

B

Once you have a terrain object you can
customize it in the editor.

To open the Terrain Editor:

1. Select the terrain object.

2. Click the E icon that appears next to
the terrain object,

or choose Object menu>Edit
Object,

or click the Edit text button and then
click the Edit Terrain tool,

or press Command-E/Ctrl+E.

Features of the Terrain Editor

The Terrain Editor is divided into four
sections:

* The Editing tools, which let you
generate and edit the terrain’s height
map

* The Terrain Canvas, which displays
the grayscale image used as a height
map



*  The 3D Terrain Preview, which
displays a three-dimensional preview
of the terrain you're working on

* The Animation controls, which let
you set up key frames for animating
the terrain

Editing Tools

Terrain tools are divided into three tabs
that contain tools for generating terrain
elevations, filtering terrains, and
importing pictures to use as terrains:

+ Elevation contains tools for
generating terrains, and applying
effects.

* Filtering contains tools for
fine-tuning the gray levels in your
terrain Canvas.

+ Pictures contains tools for importing
a picture to use as a Terrain Canvas.

The Terrain Editor tools are divided into three
tabs.

To access a tab:

o Click the tab label. The tab tools
move to the front. By default, the
Elevation tools are in front.

Terrain Canvas

The Terrain Canvas displays the grayscale
image that is used to create the terrain
object. You can think of the Terrain
Canvas as a top view of the terrain object
you're creating.

The Terrain Canvas is where you paint
the height map for your terrain. The
image in the center of this area is the
canvas. Around the canvas are the
painting tools and zoom area controls.

Paintbrush Controls

Color
Gradient
Strip

Clipping
Bracket

Zoom Area Controls
Brush Mode Selector

The Terrain Canvas displays the grayscale image
that is used to create your terrain.

The main tools in this area are the
grayscale paintbrush and the height
picker. The paintbrush lets you paint
images using different shades of gray. The
Height Picker lets you pick up gray levels
from other parts of your image to set the
gray level of the paintbrush.

The left side of the frame includes all the
paintbrush controls (Size, Hardness,
Flow, and Level) as well as the Grid
selector, which controls the resolution of
the grayscale data.

The right side contains a gradient strip

and bracket for clipping operations and
controls for color mapping.
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The bottom part of the frame includes a
Brush Mode selector and Zoom Area
controls.

3D Terrain Preview

The 3D Terrain Preview in the lower left
corner of your screen displays the
resulting terrain object based on the
image in the Terrain Canvas. As you edit
the terrain image, the preview updates to
show the result of your changes.

The 3D Terrain Preview shows the terrain object
that will be produced from the image in the
Terrain Canvas.

The preview of your terrain can be
rotated so you can see your terrain object
from different angles.
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To rotate the terrain preview:

o Drag the preview object in the
direction you want to rotate the
terrain.

Animation Controls

The Animation controls at the bottom of
the editor let you create key frames for
your terrain. Any change you make to the
geometry of the terrain can be stored in a
key frame and animated.

Current Time Indicator
Preview Controls

I_I_I

Key Frame Controls

The Animation controls let you create key
frames for the terrain so you can animate the
terrain editing process.

The Timeline that runs along the bottom
of the editor displays the length of the
animation. The Current Time Indicator
within the timeline lets you set the
current time of the animation.

The buttons in the Animation controls let
you preview the animation. The buttons
beside the preview controls let you add
and delete key frames from the Timeline.

Working in the Terrain Editor

Using Terrain Editor Tools

Most of the tools in the Terrain Editor are
displayed as control dots. These dots let
you apply an effect or operation to the
terrain gradually or at 100%.

To apply a tool to the Terrain Canvas:

1. Move the cursor over the tool you
want to use.

2. Do one of the following:

+ Apply an effect or operation
entirely by clicking the control
dot just once.

+  Apply an effect gradually by
dragging over the control dot.

«  Apply an effect by clicking a tool
more than once. The effect is
applied in 100% increments.



Starting a New Terrain

By default when you open the Terrain
Editor, the terrain you selected in the
Working window appears in the Terrain
Canvas. If you want to begin with a new,
flat Terrain Canvas, use the New button.

To create a new Terrain Canvas:

1. Make sure the Elevation tab is
displayed. If it’s not, click the
Elevation title.

2. Click the New button.
or press Command-N/Ctrl+N.

A flat black image appears in the
Terrain Canvas.

To gradually flatten your terrain:

o Drag to the right over the New
button.

The existing Terrain Canvas
gradually fades to black.

— - >

- B
Many of the effects in the Elevation tab
require grayscale values. If you apply

these effects to a black map they may

have no effect. Try to use this only
when you're setting up for brushing
operations.

- B,

To reset your terrain:

o Hold down Control and click the
New button.

The Terrain Canvas is reset to the
terrain that appeared when you first
opened the editor.

Inverting Terrains

Since the Terrain Editor uses brightness
to determine altitude, you can change
mountains into canyons by inverting the
black and white values in your image.

To invert your terrain image:

1. Make sure the Elevation tab is
displayed. If it’s not click the
Elevation title.

2. Click the Invert button, or press
Command-1/Ctrl+l.

All the black areas of your image
become white and white areas
become black.

To gradually invert your terrain image:

o Drag to the right over the Invert
button.

The black areas in the existing
Terrain Canvas progressively turn
white.

Undoing Operations

You can reverse any effect you apply to
your image using the Undo button. You
can toggle between Undo and Redo by
clicking the Undo button repeatedly.

To undo operations in the Terrain
Editor:

1. Make sure the Elevation tab is
displayed. If it'’s not click the
Elevation title.

2. Click the Undo button, or press
Command-Z/Ctrl+Z

The last operation you applied is
undone.
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Eroding Terrains

Erosion simulates the effects of water
erosion on your terrain objects. The
calculations in this effect simulate
droplets of water falling on your terrain,
and then calculate where the droplets
would trickle based on the shades of gray
progressing towards black. This effect
works best on maps that have large
sloping areas.

The Erode button simulates the effects of
erosion over a short period of time, like
decades. To simulate the effects of
centuries of erosion, use the Eroded tool.

This is what a terrain looks like before you apply
the Erode effect. Notice that this image map has
sloping areas that will make the erode effect
more visible.
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This is the same terrain after the Erode effect is
applied. You can see how the surface now
contains tracks created by running water.

To erode terrains:

1. Make sure the Elevation tab is
displayed. If it’s not, click the
Elevation title.

2. Click the Erode button. You can also
gradually apply erosion by holding
down the mouse button while the
pointer is over the Erode button.

Setting 3D Terrain Preview Options
The 3D Terrain area has several options

that control how the preview updates and
displays.

To set 3D Terrain Preview options:

o Click the triangle icon in the bottom
left corner of the Terrain Canvas
frame and choose an option from the
menu:

Auto Rotate sets the 3D Preview to
rotate perpetually. All changes
update the 3D preview as it turns.

RIP To Screen displays a full-screen
preview of your terrain. Clicking
anywhere will return you to the main
Terrain Editor. Use Command-W/
Ctrl+W to toggle in and out of this
mode.

Realtime Linking connects all terrain
editing to the 3D Terrain Preview.
Every analog change you make is
applied simultaneously to the Terrain
Canvas and the 3D preview. You can
turn this feature off and on with the
Control/Ctrl key.



Using the Zoom Area

When the Zoom Area is active, only a
small portion of your terrain is displayed
in the 3D Terrain Preview. The 3D
Terrain Preview displays the zoomed-in
portion of your Terrain Canvas. You can
use this feature to see small variations in
the surface of your terrain. The Zoom
Area can be moved to any point on your
Terrain Canvas.

Use the Zoom Area to see a close up of an area in
your Terrain Canvas in 3D.

You can always paint while the Zoom
Area is active; in fact this is a nice way to
paint in the Terrain Canvas while
previewing a small section in 3D to
observe details.

To turn the Zoom Area on:

o Click the On text button below the
Zoom Area title at the bottom of the
Terrain Canvas frame.

A marquee appears on your Terrain
Canvas.

To turn the Zoom Area off:

o Click the Off text button below the
Zoom Area title at the bottom of the
Terrain Canvas frame.

To move the Zoom area:

1. Move your pointer over an edge of
the Zoom Area marquee. The pointer
changes to a hand tool.

2. Drag the marquee to an area in the
Terrain Canvas.

To resize the Zoom area:

1. Move the pointer over a corner of the
Zoom Area marquee.

2. Drag away from the center of the
marquee to enlarge the Zoom Area,
or towards the center to shrink the
area.

To scale the zoom area to fill the
Terrain Canvas:

o Click the Crop text button below the
Zoom Area title at the bottom of the
Terrain Canvas frame.

The contents of your Zoom Area are
scaled to fill the entire Terrain
Canvas area. The Zoom Area
contents replace the existing contents
of the Terrain Canvas.

This feature can be useful for creating
new terrains from larger high-resolution
terrains.

To fit the contents of the Terrain
Canvas into the Zoom Area:

o Click the Fit text button below the
Zoom Area title at the bottom of the
Terrain Canvas frame.

The entire contents of your Terrain
Canvas are scaled down to fit into the
Zoom Area marquee. The rest of the
Terrain Canvas will be filled with black.

Terrains 169



Setting Terrain Resolution

The terrain’s resolution determines the
amount of detail in your terrain. The
higher the resolution, the more detail
appears in your terrain’s surface.
However, higher resolution values also
increase the rendering time for your
scene and require more memory.

The default resolution is 128. The highest
resolutions should be reserved for
terrains that are very close to your camera
and for any other case where detail is
important. For items that are far away, or
where detail is not so important, lower
resolutions are more appropriate.

Brush sizes may appear to vary
depending on your resolution, but in fact
they remain proportional to the size of
the Terrain Canvas. The Terrain Canvas is
always displayed at 256x256. So, if you
change the resolution to 1024x1024, the
Terrain Canvas will still appear in that
256x256 window and, in order to remain
proportional, brushes will appear smaller.

To set the Terrain resolution:

o Click the Grid icon on the left side of
the Terrain Canvas frame and choose
a resolution from the menu.

170 Chapter @  Bryce 3D

The resolutions available are:

16 verycoarse

+ 32 coarse

+ 64 simple

« 128 normal

o 256 fine

+ 512 ultrafine

« 1024 massive resolution
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Creating Terrains
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You can create terrains in several ways.
You can let the editor do all the work of
generating a terrain based on a series of
algorithms, you can use the editor’s
painting tools to create a custom image,
or you can import an image into the
editor.

When you generate a terrain, you use the
Terrain Editor’s Elevation tools, which
include erosion effects as well as dozens
of other effects optimized for the purpose
of heightening realism in Bryce terrains.

When you paint a terrain you use the
editor’s grayscale paintbrush to paint a
topographical image. The image is then
converted to a terrain object.

You can also create a terrain by importing
a picture into the editor. The picture is
converted to grayscale which is then used
to generate altitude values.

Creating Landscapes

When you're planning the shape of your
terrain you should keep in mind the kind
of landscape you want to create. You
don’t have to create all the land in your
scene as a single terrain. More complex
landscapes can be created by combining
several terrain objects.

Before creating terrain objects, plan out
the entire map of your landscape. Then
you'll be able to see where different
terrain objects might be combined to
create a single land mass.

e

Before you start creating terrains you should
map out all the land masses in your
environment...



...then you'll be able to see where you will need
to combine more than one terrain to create a
specific type of landscape.

If you have more terrains in your scene,
you'll have a bigger scale for the
environment. This gives you more
resolution and better atmosphere effects.

Pay attention to where the camera is
positioned in the scene. Terrains that are
closer to the camera need to be more
detailed than those off in the distance.

Animation and Terrain Editing

You can record the process of creating a
terrain into an animation using the
Animation controls. Refer to
“Animating” on page 351 for more on
animating. Some of the Elevation tools
can produce some unpredictable results
when they’re animated, so you may want
to experiment with animating elevations
before you create your final terrain.

Elevation Tools

The Elevation tools are preset effects that
apply different calculations to your
Terrain Canvas. The tools are divided
into three categories on the tab: Source
Generator, Basic Tools and Special
Effects.

Source Generators create basic terrain
surfaces. The Basic Tools edit the overall
shape of your terrain, and Special Effects
add realism to your terrain’s surface.

You can create a terrain by combining
effects. For example, you can start off
creating a basic terrain using the Fractal
tool, then create realistic ridges by
applying the Erode tool. From there you
can fine-tune your terrain by applying
Spikes, creating Mounds or adding Cross
Ridges. Finally, you can define the basic
shape of your terrain by blurring the
edges.

Using Elevation Tools

Along the bottom left corner of the
Elevation tab are an orange and green
curve of dots. The green curve contains
tools for changing a terrain’s geometry,
like adding mounds or spikes. The orange
curve contains tools that apply filtering
effects to an existing terrain, like
posterizing or equalizing.

These two curves represent different sets of
elevation tools. Click the curves to toggle
between the two sets.

To switch between sets of elevation
tools:

1. Click the curves in the bottom left
corner of the panel. The button
works like a toggle.

2. Click again to return to the first set.

Including both sets of buttons, there are a
total of 30 elevation tools.

To use an elevation tool:

1. Make sure the Elevation tab is
displayed. If it’s not, click the
Elevation title.

2. Click an effect tool. 100% of the
effect is applied to the Terrain
Canvas.

3. Click the tool again to increase the
intensity of the effect.
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Most elevation effects can also be applied
gradually.

To apply an elevation effect gradually:

1. Move the pointer over an Elevation
tool. The pointer changes to a
two-headed arrow.

2. Drag to the left to increase the effect
or drag to the right to decrease it.

Source Generators

The Source Generator tools can be used
in two ways: to generate a terrain from
scratch, or to alter the geometry of an
existing terrain.

Fractal

This tool creates terrains based on fractal
patterns. It can be applied to an existing
image and it can be applied gradually.
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This tool produces terrains based on fractal
patterns. The terrains it creates have lots of
spikes and valleys. This tool produces good basic
terrains.

Eroded

This tool applies natural erosion to your
terrain. It can also be applied to a blank
image to create an eroded terrain, or to
an existing image. You can also gradually
apply erosion to an image. Eroded
produces extremely realistic terrains.

Notice that when animating this type of
terrain, material is actually added to the
terrain, not removed from it as you might
expect.

This tool produces terrains based on eroded
land. The terrains produced by this tool have
deep grooves and canyons.

The Eroded tool is a more intense version
of the Erode tool.

Picture

This tool creates terrains from imported
images. When you click this tool, the
Open dialog appears. You can use this
dialog to locate and load a picture to use
as a Terrain Canvas. Refer to “Working
with Pictures” on page 114 for more.



Raise/Lower Sharpening

This tool adjusts the brightness of your This tool sharpens the gray values in your
Terrain Canvas. Drag to the right to lower Terrain Canvas. Drag left to increase
your height map or drag to the left to sharpening and right to decrease it. b

raise it. Single clicks gradually lower
the map.

This tool produces terrains based on a picture.
This tool is how you import image maps created
in other graphics applications.

This tool adjusts the brightness of your Terrain
Canvas, which raises or lowers the height of the

Using this tool you can import an image entire terrain.

map created in another application like

Painter or Photoshop. This tool sharpens the Terrain Canvas gray
values. You can use smoothing to create spikes or
ridges.

Basic Tools

The Basic Tools are used to alter an
existing Terrain Canvas only. They have
no effect on a blank canvas.
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Smoothing

This tool blurs the Terrain Canvas. Drag
right to decrease the blurring effect or left
to increase it.

Smoothing is especially effective prior to
using the Erode button, since the Erode
algorithm works best when there are
shades of gray in an image. If your canvas
has too many sharp black to white
transitions, the Erode may not be as
effective.

This tool blurs your Terrain Canvas creating
smoother black to white transitions.
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Gaussian Edges

This tool does not blur your map. It
creates a “Gaussian curve” from dark to
light, starting from the edges of your
Terrain Canvas. This creates edges that
gradually transition from dark to light, or
start at the lowest possible altitude, and
gradually progress into higher altitudes.

Gaussian Edges eliminates the seams
between ground and terrain objects,
when the ground plane and the terrain
have the same surface material. You
should apply this tool to any terrain that
is going to be sitting on a ground plane in
your scene.

This tool creates gradually ascending edges on
your terrain which can create a smooth
transition from the ground plane of your scene
to the terrain.

Square Edges

This tool creates an abrupt drop at the
edges of your terrain. Use this tool when
you have a terrain whose edges are not
level, and you do not wish to use the
Gaussian Edges tool for soft transitions.

This tool creates an abrupt drop at the edges of
your terrain. Use Square Edges to level the edges
of a terrain.

You can add a slope to the square edges of
your terrain by applying this tool
gradually. Drag left to increase the slope
and right to decrease it.



Round Edges

This tool creates an abrupt circular drop
at the edges of your terrain.

You can add a slope to the round edges of
your terrain by applying this tool
gradually. Drag left to increase the slope
and right to decrease it.

This tool creates an abrupt circular drop at the
edges of your terrain. Use Round Edges to create
a circular base for your terrains.

Basic Noise

This tool adds roughness to your terrain’s
surface by adding noise to the Terrain
Canvas. Drag left to increase the noise
and right to decrease it.

This tool adds roughness to your terrain’s
surface. Use Basic Noise to create rocky
mountains.

Slope Noise

This tool adds roughness to any sloping
surfaces in your terrain. Slope Noise adds
noise to all the sloping areas of your
terrain. Drag left to increase the noise and
right to decrease it.

Slope Noise has no effect on flat surfaces.
More noise is added to steep slopes.

This tool adds roughness to the sloping surfaces
of your terrain.
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Height Noise

This tool adds small amounts of noise at
lower altitudes and more noise at higher
altitudes. Drag left to increase the noise
and right to decrease it.

This tool adds a little roughness to your terrain’s
surface at lower altitudes and more at higher
altitudes.
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Image Filtering Effects

These tools, located on the orange curve,
apply filters to your terrain that act like
image filters. They can change the look of
the terrain without altering its basic
shape.

Spikes

This tool adds spiky structures to your
map. When you apply the right material
to these structures they can look
remarkably like trees if they’re viewed
from a distance.

This tool adds spikes to your terrain’s surface.
Use Spikes when you want to add trees to your
terrain.

Mounds

This tool adds midsized splotches to your
canvas. You can use this tool to create the
appearance of stones or boulders under
transparent water planes.

This tool adds splotches to your Terrain Canvas
that look like boulders on flat surfaces or towers
on sloped surfaces.



Dampen

This tool works like a contrast control. It
will push gray values towards either black
or white depending on where the gray
value falls in the black/white range. Less
than 50% goes to black, greater than 50%
goes to white.

This tool controls the contrast of your Terrain
Canvas. Use Dampen to create abrupt drops
and valleys.

Equalize

This tool acts like the Equalize function
you may have seen in 2D image editing
applications. It redistributes gray values
in your Terrain Canvas such that a full
range from black to white is present in
your canvas.

This tool equalizes black and white values in
your Terrain Canvas. Use Equalize to eliminate
sharp ridges or deep valleys.

Posterize

This tool stratifies the gray levels in your
Terrain Canvas, resulting in stair-stepped
terrain structures. This is a good tool for
creating desert plateaus.

Use Posterize to create stair-stepped desert
plateaus or paddy fields on the side of a
mountain.
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Mosaic

This tool is not a button on the Elevation
tab. To use this tool, hold down Opt/Alt
as you drag over the Posterize button.

Mosaic creates highly pixelated square
structures based on the gray content of
your canvas.

This tool is excellent for instant
cityscapes. Try adding one of the sci-fi
city materials from the Preset Materials
Library to a Mosaic terrain.

This tool pixelizes your Terrain Canvas. Use
Mosaic to create cityscapes.
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Sawtooth

This tool modifies your Terrain Canvas

based on a sawtooth waveform structure.

The results look like schizoid desert
canyons and icebergs.

This tool creates schizoid desert canyons or
icebergs.

Subcontours

This tool works like a contrast control
with the threshold set almost at white.
Most values are pushed to black while
only the very lightest are pushed to white.

This tool produces spiky peaks with sloping
contours.

Subcontours produces spiky peaks with
very low, gently sloping contours.

Geometry Effects

This green set of Elevation tools add to
the geometry of your terrain, which can
alter its basic shape. You can also use
most of these tools to create terrains from
scratch.



Blob Maker

This tool creates a smooth, circular
structure within your existing Terrain
Canvas. Drag left or right to change the
size of the structure. Drag up and down
to set the vertical location of the
structure.

This tool creates circular structures within your
Terrain Canvas.

Relief Noise

This tool acts like an emboss effect. It will
emboss the grayscale data in your canvas
and convert it to height information.

This tool embosses the grayscale data in your
Terrain Canvas.

Raise Edges

This tool acts like an inverted version of
the Square Edges tool. It creates abrupt
increases in altitude at the edges of your
terrain.

This tool creates abrupt increases in altitude at
the edges of your terrain.
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Subplateaus

This tool smears your grayscale data in
one direction while averaging the gray
values. The result is natural structures
not unlike those created by the Mounds
effect, except that these structures are
more directly related to your original
gray data.

Because it creates boulder-like
structures, this tool is good for making
tidepools.

This tool creates boulder-like structures within
your Terrain Canvas.
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Cross Ridges

This tool creates sharp ridges in a cross
patter. It creates very interesting
canal-like structures.

This tool creates canal-like structures within
your Terrain Canvas.

Cross Ridges 2

This tool is the inverse of the Cross
Ridges tool. Instead of creating canals, it
creates peaks.

This tool creates peak-like structures within
your Terrain Canvas.



Bubble Ridges

Similar to the Blob Maker, the spherical
structure this tool creates is of a
consistent size. Dragging this button
allows you to place the structure
anywhere you like in your canvas.

This tool creates a spherical structure within
your terrain that can be placed at any point in
your canvas.
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Painting Terrains

Although you can create some very
spectacular terrains using just the
elevation tools, there are times when you
want to create a precise Terrain Canvas.
The Terrain Editor’s paintbrush lets you
paint any type of terrain you wish. Using
the Paintbrush, you can re-create
real-world topographical maps or design
landscapes with specific contours.

Setting Up the Paintbrush

Before painting with the Paintbrush, you
should set up some of its parameters.
Using the brush settings you can control
the size, hardness, strength and color of
your brush.

Brush Size

Brush Hardness

Brush Flow

Gray Level Control

Brush Behavior Options

Use the Paintbrush settings to control the
attributes of your brush.

To set brush attributes:

1.

2.

In the Terrain Canvas frame, drag
over the Size control.

Drag away from the center to
increase the size of the brush and
towards the center to decrease it.

Drag over the Hard control.

Drag towards the center of the
control to make brush edges harder
or away from the center to make
brush edges softer.

3. Drag the pointer over the Flow
control.

Drag to the right to increase the flow
or to the left to decrease it.

Brush Flow determines the strength
of the paintbrush. The higher the
flow setting, the more color is
applied.

4. Drag over the Level control.

Drag down to apply a darker gray, or
up to apply a lighter gray.

Since you’re painting altitudes,
lighter grays result in higher points
and ridges while darker grays create
lower points and valleys.

The default level is 100% gray.
However, it effectively paints at 50%
because of the other default settings.

While you're painting, you may want to
re-create a specific altitude in different
parts of the terrain. If you've changed the
brush settings, re-creating a specific
altitude can be quite difficult. However,
using the Height Picker tool you can
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quite easily re-create altitudes by picking
up gray levels from different parts of your
image and applying them to the brush.

To pick up gray levels from the terrain
image:

1. While holding down the Control/
Ctrl, move the cursor over the
Terrain Canvas and click the desired
altitude color. The color is applied to
the brush.

2. Drag the brush over a different area
of the canvas. The altitude color you
picked up is applied to the new area.

Brush Behaviors

The paintbrush in the Terrain Editor
paints elevations by default, but this is
not the only way of painting using the
brush. You can also set the brush to paint
effects. This lets you apply elevation
effects locally, or to increase/decrease
existing gray levels in your Terrain
Canvas.

To paint elevations:

1. Make sure the Elevation tab is visible.
If it’s not, click the Elevation title.
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2. Click the triangle icon next to the
Brush Behaviors heading and choose
Paint Elevation from the menu.

The brush paints in shades of gray
that are then used to generate
altitudes. This is the default brush
behavior.

To apply an effect locally:

1. Make sure the Elevation tab is visible.

If it’s not, click the Elevation title.

2. Click the triangle icon next to the
Brush Behavior heading and choose
Paint Effect from the menu.

3. Hold down the Spacebar and click
the Elevation effect you want to
paint.

4. Drag the paintbrush over an area of
your canvas.

To remove an effect locally:

1. Click the triangle icon next to the
Brush Behavior heading and choose
Unpaint Effect from the menu.

2. Drag the paintbrush over an area of
your canvas where you applied an
effect locally.

The Unpaint Effect brush only affects
areas where you applied an effect
with the paintbrush.

An effective way of using this brush is
to paint an effect in broad, easy
strokes, and then selectively unpaint
areas of effect away.

To erode areas of your terrain:

1. Click the triangle icon next to the
Brush Behaviors heading and choose
Erode from the menu.

2. Drag the paintbrush over the area
you want to erode.

The paintbrush applies the erosion
effect to the area painted over.

To lighten gray levels:

1. Click the triangle icon next to the
Brush Behavior heading and choose
Maximum from the menu.

2. Drag the paintbrush over an area you
want to lighten.

In this mode, gray levels in your
canvas that are below the current
gray level are lightened to match the
current level. Values above the
current Level setting are untouched.



To darken gray levels:

1. Click the triangle icon next to the
Brush Behavior heading and choose
Minimum from the menu.

2. Drag the paintbrush over an area you
want to darken.

In this mode, gray levels in your
canvas that are above the current gray
level are darkened to match the
current level. Values below the
current Level setting are untouched.

Modifying Brush Behavior

The Option/Alt key can modify the
behavior of the paintbrush on-the-fly.

* In Elevation mode, Option/Alt
inverts the gray level. For example, if
you're painting white, holding down
Option/Alt will paint black.

* In Paint Effect mode, the Option/Alt
key will toggle to Unpaint Effect
mode.
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Filtering Terrains

Filtering is the process of adjusting the
grayscale curve of your Terrain Canvas.
By adjusting the grayscale curve, you
create a custom elevation effect.

How Filtering Works

The Filter area is essentially a graph that
represents gray level input from black to
white horizontally, and gray level output
from black to white vertically.

Lightest
Gray
Value
Output

Darkest
Gray
Value
Output

Darkest Gray Values Lightest Gray
Input Values Input

The Filtering graph expresses all the input and
output gray values in your Terrain Canvas.

The default diagonal filter creates a graph
where all values input as black are also
output as black, and all values input as
white are also output as white. That is
why your Terrain Canvas appears
unchanged—none of its gray level values
have been altered.

By dragging in this Filter area, you can
remap the gray values in your Terrain
Canvas.

To see how filtering works:

1. Place your cursor (which changesto a
Pencil within the Filtering area) in
the top left corner of the Filter Area.

2. Drag diagonally to the bottom right
corner.

As you can see in the Preview area, your
Terrain Canvas is inverted.

The original graph stated that all values
input as black were output as black and
all the values input as white were output
as white.
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In the original Filtering graph all values input as
black are output as black and all values input as
white are output as white.

The new graph you created now states
that all values input as black are output as
white and all the values input as white are
now output as black. In other words all
the dark values are light and all the light
values are dark.
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darkest
Is are

In the new Filtering graph all values input at 0
are output at 255 and all values input at 255 are
output at 0.

This is a drastic example. In most cases
you would adjust more specifically, like
lightening the midtone grays or
darkening specific gray values.
Remember that this graph represents
your Terrain Canvas, so you're changing
the shape of your terrain object as you
adjust gray values.

The Filtering Tab

The Filtering tab is divided into three
areas: the Filtering graph, the graph
preview and the filtering presets.

Filtering Presets

Filteiing
PFEFRF AP TTN M

Filtering Graph Preview Area
Use the Filtering tab to edit the Filtering graph

and apply filtering presets.

The Filtering graph displays your Terrain
Canvas’s gray levels as value inputs and
outputs. You can edit this graph to adjust
the gray level values in your canvas.

Next to the graph is the Preview area.
This area shows you what your Terrain
Canvas would look like if applied to the



current Filtering graph.This area
automatically updates as you make
changes to the graph.

Along the top of the tab are the nine
Filtering presets you can apply to the
graph. Each preset represents a different
predefined graph. They are designed to
create specific changes in gray levels, like
smooth gradients and abrupt transitions.

Working in the Filtering tab

Altering the Filtering Graph

The best way to start adjusting the
Filtering graph is to determine the type of
effect you want to create. For example, if
your canvas is too dark, raise the value of
the darker gray value inputs by drawing a
ridge in the left side of the graph.

Before

Drawing a ridge on the left side of the graph....

After

....raises the value of the darkest grays in your
Terrain Canvas.

To alter the Filtering graph:

1. Make sure the Filtering tab is visible.

If it’s not, click the Filtering title.

2. Dragyour pointer over the area of the
Filtering graph you want to adjust.

When you drag over a black area, the
pencil draws in gray; dragging over a
gray area draws in black.

Tracing over any lines you've drawn
erases them.

To undo all changes to the Filtering
graph:

1. Make sure the Filtering tab is visible.
If it’s not, click the Filtering title.

2. Click the Reset text button below the
Filtering graph.

The graph returns to the default
Filtering graph.

To soften harsh transitions in the
graph:

1. Make sure the Filtering tab is visible.
If it's not, click the Filtering title.

2. Click the Soften text button below the
Filtering graph.

3. Click the Soften button again to
soften the transitions more.
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Applying Presets

Filtering presets are provided to help you
get started adjusting the Filtering graph.
These preset are designed to provide
different effects. The best way of using
these presets is to apply them to your
graph and see what happens.

To apply presets:

1. Make sure the Filtering tab is visible.
If it’s not, click the Filtering title.

2. Click one of the preset buttons along
the top of the tab. The current graph
is replaced with the preset graph.

Applying Filtering Changes to Your
Terrain Canvas

Although any changes you make to the
graph are applied to the Preview area,
they do not automatically affect your
Terrain Canvas. You have to Apply the
changes before they affect the canvas.

You can temporarily apply your changes
to the 3D Preview in real-time by holding
down Control/Ctrl as you drag over the
Filtering graph.
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To apply the Filtering graph to the 3D
Preview:
o Hold down the mouse button over

the filter graph preview. The 3D
preview updates.

When you release the mouse the 3D
Preview switches back to the
unfiltered terrain.

To apply filtering changes to the
Terrain Canvas:

o Click the Apply text button beneath
the Preview area.

Blending the Filtering Graph With the
Terrain Canvas

The Filtering Tab offers several ways of
applying your Filtering graph to the
Terrain Canvas. You can apply the graph
directly or you can blend the graph with
the canvas.

When you use a blending option you're
essentially drawing a grayscale gradient
and then blending it with your original
canvas.

FFEFRpPFEmM

This terrain was altered by directly applying a
filtering effect.

This terrain was altered by blending a filtering
effect with the original canvas.



To blend the Filtering graph with the

Terrain Canvas:

1. Adjust the Filtering graph to achieve

the desired effect.

Click the triangle icon below the
Filtering graph and choose an option
from the menu:

Horizontal horizontally blends your
Filtering graph, expressed as a
grayscale gradient, with your Terrain
Canvas.

Vertical vertically blends your
Filtering graph, expressed as a
grayscale gradient, with your Terrain
Canvas.

Horizontal Add horizontally blends
your Filtering graph, expressed as a
grayscale gradient, with your Terrain
Canvas.

This option uses a slightly different
algorithm than the previous
Horizontal option: it's not a
traditional Additive, but an average
of the existing terrain grayscale values
with the maximum of the Terrain
and Filter values.

Vertical Add vertically blends your
Filtering graph, expressed as a
grayscale gradient, with your Terrain
Canvas.

This option uses a slightly different
algorithm than the previous Vertical
option: it’s not a traditional Additive,
but an average of the existing terrain
grayscale values with the maximum
of the Terrain and Filter values.

3. Click Apply.

g
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Crééfing Terrains; .Using
Pictures

The Terrain Editor converts grayscale
values in the Terrain Canvas into altitudes
to create terrain objects. You can take
advantage of this process to create unique
terrains based on the grayscale values in a
picture.

The Terrain Editor’s Picture tab lets you
import a picture into the Terrain Canvas.
You can then apply elevation effects or
filter it just as you would any other
Terrain Canvas.

The Pictures Tab

The Picture Tab is made of three picture
squares and a blend control. The first two
picture squares let you load a picture to
use a terrain and the third square shows
you the result of combining the two
pictures. The blend control lets you
specify how the pictures are combined.

Use the Picture tab to load and blend pictures to
create unique terrains.

Working in the Pictures Tab

Loading Pictures

You can load any two pictures from
anywhere on your system. You can also
copy and paste images from the
Clipboard.
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To load pictures:

0

Click the Load text button above the
picture box into which you want to
load the picture.
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Hold down Option/Alt key to load the
picture’s color data directly into the 3D
Terrain preview. This allows you to see
the interaction between the picture and
the grayscale to height interpretation of
its luminance values. The color data is
only for viewing purposes and will not
render with the terrain.
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To copy and paste a picture into the
Picture tab:

1.

188

In another application, copy the
picture you want to use to the
Clipboard.

In the Picture tab, click the Paste text
button below the picture box where
you want the picture to appear.
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When you use Command-V/Ctrl+V to
paste from the Clipboard, the picture
always appears in the first square.
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Blending Pictures

Once you have a picture in each of the
first two squares, you blend them to
create a third image that is used to create
the new Terrain Canvas.

To blend pictures:

1. Load pictures into the first two
squares.

If you load only one picture a white
square is used as the second blend
image.

2. Click the triangle icon under the
third picture box and choose a Blend
mode from the menu:

Blend compares each corresponding
pixel from the first two squares, and
displays an average of the two in the
corresponding location of the third
square.

Minimum compares each
corresponding pixel from the first
two squares, and displays the darker
of the two in the corresponding
location of the third square.

Subtract compares each
corresponding pixel from the first
two squares, subtracts the brightness
value of one from the brightness
value of the other, and displays the
result in the corresponding location
of the third square.

Add compares each corresponding
pixel from the first two squares, adds
the brightness value of one to the
brightness value of the other, and
displays the result in the
corresponding location of the third
square.

Drag the pointer over the Blend
control.

Drag to the left to use more of the
first image in the blend. Drag to the
right to use more of the second
image.



Applying Changes to the Terrain
Canvas

Although the results of blending pictures
appears in the third picture box, it is not
automatically applied to your Terrain
Canvas.

To apply a picture to the Terrain
Canvas:

o Click the Apply text button beneath
the third picture square.

.P’u
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r to Terrains

Color in the Terrain Editor is used as a
visual aid to help you see the relationship
between color values and altitude. This
color only exists in the Terrain Editor and
is not applied to the terrain object.

You can apply a color gradient to your Terrain
Canvas to help you visualize the relationship
between color values and altitude.

When you apply color in the editor, it
maps a gradient to the altitudes in your
Terrain Canvas. For example, if you apply
a gradient from blue to yellow, blue
might represent the lowest altitude while
yellow may represent the highest. Which
colors are mapped to which altitudes is
left completely up to you.

Gradients can be extremely useful when
you're filtering terrains, as they make the
differences between gray levels more
visible.

b
oy

You can apply a color gradient to your Terrain
Canvas it also appears in the Filtering tab. This
makes it easier to see the differences in gray
levels.

i
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Mapping Color to Your Terrain Canvas

The Terrain Editor’s color picker contains
all the gradient you can apply to your
terrain. The gradient you select is applied
to both the Terrain Canvas and the 3D
Terrain Preview.

Gradient Bar

Color Picker

Color/Grayscale
Toggle

Use the Color Picker button to choose a color
gradient and the gradient bar to set color
mapping.

To map colors to your Terrain Canvas:

1. Click the Color Picker button in the
bottom right corner of the Terrain
Canvas Frame and drag over a
gradient in the palette.
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The gradient you selected appears in
the Gradient bar and is mapped to
the Terrain Canvas and the 3D
Terrain Preview.

2. Dragthe gradient up or down to map
the colors to altitudes.

The colors at the bottom of the
gradient represent the lowest altitude
and the those at the top represent the
highest.

The Gradient Bar has two modifiers:
+  Opt/Alt resets the Gradient Bar.

+ Command-F/Ctrl+F flips the
colors in the gradient.

To return to grayscale:

o Click the Color/Grayscale toggle to
switch back to the default gray
gradient.

Although gradients are meant to be used
only in the Terrain Editor, you can apply
the gradient to the Terrain’s Diffuse
channel. The gradient then becomes the
terrain’s Diffuse color. This allows you to
render the gradient with the terrain.

To apply a gradient to a terrain’s
Diffuse channel:

1. Apply a gradient to the terrain.

2. Click the triangle icon below the
Color/Grayscale toggle button and
choose Load Gradient into Diffuse
channel.

The gradient becomes the terrain’s
Diffuse color.

To remove a gradient from a terrain’s
Diffuse channel:

1. Open the terrain in the Terrain
Editor.

2. Click the Color/Grayscale toggle.

T — S,
Clipping Terrains

Using the Terrain Editor’s clipping
controls, you determine which values in
your terrain are rendered as the final
terrain object. The Clipping controls next
to the Gradient bar represent the render
range for the terrain. Anything outside
the range included in the brackets will
not be rendered.



You can use these controls to eliminate
any unwanted information from the
terrain without altering its basic shape.
For example, you can keep the main
terrain while eliminating the black square
on which it sits.

Using the Clipping Bracket you can eliminate
unwanted areas from the terrain’s edges. This
feature can be useful when you're creating
islands.

The clipping feature is particularly useful
when editing a Symmetrical Lattice. The
maximum lower range of the Clipping
Bracket determines where the two halves
of the Symmetrical Lattices are joined.

To set the clipping range:
1. Drag the top of the Clipping Bracket
to set the maximum upper range.

Any areas in the Terrain Canvas
whose gray levels fall outside the
bracket’s maximum upper range will
appear colored to indicate they will
be omitted from rendering.

2. Drag the bottom of the Clipping
Bracket to set the maximum lower
range.

Any areas in the Terrain Canvas
whose gray levels fall outside the
bracket’s maximum lower range will
also appear colored to indicate they
will be omitted from rendering.

The out-of-range colors for upper and
lower limits are different, to better enable
you to distinguish upper and lower
clipped areas at a glance. Upper
out-of-range color is usually blue, and
lower out-of-range is usually red, though
the colors change for many of the color
maps.

To reset the Clipping Bracket:
o Hold down Option/Alt and click the
bracket.

To move the entire Clipping Bracket at
once:

o Click the center of the Clipping
Bracket and drag up or down.

Terrain objects are actually hollow, so if
you clip the upper range off your terrain,
you'll be able to see through the top of the
terrain to whatever is underneath. To
eliminate this effect you can add caps to
your terrains. Caps seal up any holes in
the terrain’s top, bottom or sides.

To add caps to your terrain:

o Click the triangle icon below the
Color/Grayscale toggle button and
choose one of the following from the
menu: Top Cap, Bottom Cap or Side
Caps.
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Saving Terrains

Since the terrains you create in the
Terrain Editor are objects in the scene,
you can save any terrain in the Preset
Obijects Library just as you would any
object. Refer to “Adding and Deleting
Preset Objects” on page 126 for
instruction on saving objects to the preset
library.

Tips for Speeding Up the Terrain
Editor on Slower Machines

To speed up performance on slower
machines, disable both the Realtime
Linking and AutoRotate options.

To speed up the Elevation effects, use the
single-click method rather than the click-
drag “dial in” method, as the latter can be
quite slow on these machines.

When you create a terrain in your Bryce
scene, a natural impulse is to immediately
dress it up with a cool material and
render it right away to see what it looks
like. For serious composition, consider
keeping your terrains free of textural
attributes until the final stages, as
procedural textures take longer to render
than smooth shaded surfaces. This will
keep you working rapidly on your
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composition. Then, before your final
output, you can take some time to design
surfaces for your terrain.



Materials

Materials are what bring your Bryce
environment to life. A material defines
the surface properties of an object in your
scene. It has the power to turn a bunch of
polygons into an island or the peaks of
the Himalayas. You can also alter the basic
function of an object. A simple cylinder
can become a pillar, a tree trunk or a
metal pipe, just by adjusting the
properties of the material applied to it.

In Bryce, a material isn't just a picture
that’s wrapped around an object; it’s a
truly 3D surface. The material properties
you assign to an object are applied to the
whole object—inside and out.

Bryce’s new volume materials let you
apply a material to the interior of the
object as well as to its surface. The
Volume Material controls let you set how
the entire object’s volume reacts to its
environment.
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Material Structure
A material is made up of fourteen
channels. Each of these channels defines a
different property of an object’s surface.
When you combine all the channels
together you get a material.

—Material Channels

aterial

A material has fourteen channels that define its
surface properties. The combination of the
values of all the channels produces a material.

New materials are created by adjusting
the values for each channel.

There are two types of materials you can
create in Bryce: surface materials, which
define the properties of an object’s
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surface, and volume materials, which
define the properties of an object’s
volume.

Understanding Surface Material
Channels

The fourteen channels of a surface
material each represent a different surface
property. These properties simulate
different physical properties of a surface,
and the combination defines how the
object’s surface interacts with light in the
Bryce environment.

To understand how the channels work
you need to understand a little about how
you perceive light and color.

The color and size of an object is
determined by how the light that hits the
object is reflected back to your eye.
Objects appear green because they reflect
green light. Objects are reflective because
they reflect light. An object appears shiny
because it reflects light back at you.

An object appears transparent because
light passes through its surface, hits the
objects behind it and is reflected back
through the surface. Bryce’s material
channels simulate all these behaviors.
When you set a channel value, you're
setting how your object’s surface interacts
with light that hits it, whether that light is

from a direct source like the sun, or an
indirect source like light reflected off
other surfaces.

Light Source

Material channels simulate physical properties
of an object. When you set channel values, you're
defining how the object’s surface, or volume,
interacts with light.

When you're creating volume materials,
your settings not only control how light
interacts with the surface of the object,
but also how it interacts with the object’s
volume.

The effects of the channels are additive,
meaning that each value you set directly
affects all the other values. So, if you set
the Diffuse Color to yellow and the
Ambient Color to Blue, the object will
have a greenish tint.



Channels are interdependent. For
example, you won't see the effects of the
Transparent Color if the object is not
transparent.

should always add up to 100, and
Diffusion and Ambience values should
also always add up to 100.

Each surface material is made up of
fourteen channels, divided into three
groups:;

When you're using these channels it’s
important to understand the physical

property they’re simulating. Only in this
way can you make meaningful
adjustments to the component values.

For example, if you set both Transparency
and Reflection to 100, you'll get an
unusually bright object that doesn’t look
very realistic. The reason for this is that
the object is emitting more light than it is
receiving, something it couldn’t do in
reality.

Since material channels simulate
real-world surface properties, you should
try to keep channel values within a
realistic range.

For example, here Transparency and Reflection
are both set to 100. With these settings you're
saying that 100% of the light that hits the object,
passes through its surface, and 100% of the light
that hits the object is also reflected off its surface.

The result is an object that emits more light than
it receives because it’s reflecting the light that
hits it as well as the light from behind it.

Color channels

Diffuse Color
Ambient Color
Specular Color
Transparent Color
Specular Halo

Volume Color

Value channels

+ Diffusion

+  Ambience

+  Specularity
In reality, an object can only reflect a portion of . .
the light that’s passing through it. So, Metallicity
Transparency and Reflection values should «  Bump Height

always add up to 100.

A good rule of thumb to keep in mind
while you're setting these channels is that
the Transparency and Reflection channels

Materials
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Optics channels
* Transparency
* Reflection

+ Refraction

Color Channels

The Color group contains all the
channels that control the color reflected
off an object’s surface. The channels in
the Color group are Diffuse Color,
Ambient Color, Specular Color,
Transparent Color and Volume Color.

Diffuse Color, Ambient Color, and
Specular Color define the colors the
surface reflects when direct light hits it.
For example, Diffuse Color defines the
color that is reflected in all directions
when direct light hits it and Specular
Color is the color that appears in the
object’s highlight.

These color channels are directly related
to the Diffusion, Ambience, and
Specularity channels. Diffusion,
Ambience, and Specularity control how
light reflects off the object, while Diffuse
Color, Ambient Color and Specular Color
control the color of that light.
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So, for example, if you selected yellow as
the Diffuse Color, the object appears
yellow. The intensity of the yellow color is
controlled by the Diffusion channel.
Refer to “Diffuse Color” on page 200,
“Ambient Color” on page 202, and
“Specular Color” on page 204 for more
information.

Transparent Color sets the color of any
light that passes through the surface of
the object and Specular Halo controls the
size of the highlight that appears when an
object has a shiny surface. Refer to
“Transparent Color” on page 207 and
“Specular Halo” on page 204.

The remaining color channel, Volume
Color, controls the color of the interior of
the object. Refer to “Volume Color” on
page 210 for more information.

Value Channels

The second group of channels, the Value
group, controls how much light affects an
object. The channels in the Value group
are Diffusion, Ambience, Specularity,
Metallicity and Bump Height.

Diffusion, Ambience, and Specularity
define how the surface interacts with
direct light. They let you control how
much direct light affects the surface of an
object. In a physical environment, these

channels control how shiny, dark or
bright the object appears. Refer to
“Diffusion” on page 200, “Ambience” on
page 201 and “Specularity” on page 203
for more information.

Metallicity is related to Reflection. It
determines how much reflected light is
filtered through the Diffuse Color. Refer
to “Volume Material Channels” on

page 210 for more information.

Bump Height controls the height of any
bumps or dents on the object’s surface.
Refer to “Bump Height” on page 206 for
more information.

Optics Channels

The Optics group of channels controls
the intensity of optical effects produced
by the object’s surface. The channels in
the Optics group are Transparency,
Reflection and Refraction.

Transparency and Reflection channels
control how indirect light interacts with
the object’s surface. In a physical
environment, these channels control how
transparent or reflective the object
appears. Refer to “Transparency” on

page 206 and “Reflection” on page 209
for more information.



Refraction is directly related to
Transparency. The Refraction channel
sets how much the light that passes
though the object is bent. Refer to
“Refraction” on page 208 for more
information.

Understanding Volume Material
Channels

Surface materials define the properties of
the surface of an object. The interior of
the object is empty. If you were to fly
through the object you would see one
layer of material, emptiness and then
another layer of material. A volume
material is applied to the entire object,
both inside and out. If you were to fly
through a volume material you would be
surrounded by a material.

3

Blue spots become blue spheres

when the texture is applied as a
Volume Material.

When you create a volume material, the
channels define not just the surface of an object,
but its volume as well.

When you're setting channel values for a
volume material, you're setting up how
light will interact with the object’s
volume. Channels control whether the
interior of an object is bright, dark, shiny,
or transparent.

In most cases the interior of an object will
be filled with a texture. If so, the channels
control the surface properties of the
elements within the texture.

For example, if you apply blue spots as a
volume material, you get a volume filled
with blue spheres. The channels then
control whether those spheres are bright,
dark, shiny, or dull.

When the interior of an object is filled with a
texture, the material channels control the
surface properties of the elements within the
texture.

In this example, the Specularity channel is used
to make the blue spheres within an object shiny.
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Volume materials are made up of thirteen
channels, divided into three groups:

Color channels

+ Diffuse Color

+  Ambient Color

»  Specular Color

+ Transparent Color
»  Specular Halo

*  Volume Color

Value channels
+ Diffusion
+  Ambience

+  Specularity

Volume channels
+ Base Density
+ Edge Softness
*  Fuzzy Factor
*  Quality/Speed
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The channels in the Color and Value
groups work exactly as they do for surface
materials, except that the channel settings
are applied to the object’s volume instead
of its surface.

Volume Channels
The Volume channels control special

volume properties of the object’s interior.

Base Density controls the density of the
object. This channel defines how much
material there is in the interior of an
object. As a result, Base Density controls
how much light passes into the object. A
solid object doesn’t allow any light to pass
through it, while less dense objects allow
more light in. Refer to “Base Density” on
page 210 for more.

Edge Softness, Fuzzy Factor and Quality/
Speed control the appearance of texture
elements within the material. Edge
Softness and Fuzzy Factor control the
quality of the edges and sharpness of the
texture while Quality controls the render
quality of the material. Refer to “Edge
Softness” on page 211, “Fuzzy Factor” on
page 211 and “Quality/Speed” on

page 211 for more.

Understanding Material
Components

Each Bryce material channel can contain
up to three components that determine
the channel’s setting. A component can
be a color, a texture or a numerical value.
A texture can be either a 2D texture
(picture) or a 3D texture.

2D/3DTexture
Value —— Component
Color —
{_l
Channels

Each Bryce material channel contains
components that determine its setting.

You can have up to three texture components in
a channel, and some channels let you use four
textures and a value as components.

Colors can only be used in the Diffuse,
Ambient, Specular Transparent, Specular
Halo and Volume channels. Values are



used in the Diffusion, Ambience,
Specularity, Metallicity, Bump Height,
Transparency, Reflection, Refraction,
Base Density, Edge Softness, Fuzzy
Factor, and Quality/Speed channels.

When you're using a texture as a
component, the information in the
texture’s channels is used as the value of
the material channel. For example, if
you're using a texture to set Diffuse Color,
the texture’s color channel is used. If
you're using a texture to set the Diffusion
value, the texture’s alpha channel
determines the Diffusion intensity.

Components are combined using one of
three modes: Mode A, Mode AB and
Mode ABC. In Mode A, only one
component is used to set the channel’s
value. In Mode AB, two components are
combined to set the channel’s value,
based on altitudes. The values from
texture A are applied at low altitude and
values from texture B are applied at
higher altitude.

In Mode ABC, the values of two textures,
A and B, are blended based on the alpha
channel of texture C.

When you're using textures as a
component you can choose from a
number of preset textures, or you can
open the Texture Editor and create your

own textures. Refer to “Combining
Components” on page 223 for more
information.

In some channels, you can use both a
texture and a value. In this case, the value
determines how much of the texture’s
value is used to drive the channel. For
example if you apply a Blue Checkers
texture to the Bump Height channel, the
texture sets the shape of the bumps and
the value sets how prominent those
bump appear.

In this example the shape of the bumps on the
object is set by the texture component in the
Bump Height channel, but the height of those
bumps is set by a value.

A Word About Alpha Channels

One of the outputs a texture component
can produce is an alpha channel. The
alpha channel is a grayscale
representation of the texture pattern or
grain. When you use a texture as a
component in a material channel, these
grayscale values are used to map surface
properties. White areas in the alpha
channel represent 100% of the effect and
black represents 0%.

Images, or 2D textures, also contain an
alpha channel. In images, the alpha
channel acts as a mask for the image. The
image’s alpha channel is used in the same
way as a texture’s alpha channel.
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Surface Material Channels

This section provides details on each of
the surface material channels.

Diffusion

Diffusion determines how much direct
light is reflected diffusely, or scattered, in
all directions.

Direct Light
-
- Viewer
I
/s
¢
I
/
Surf =
urface I
reflects light \ 4
diffusely !

The small arrows projecting off the surface of the

object illustrate how Diffusion works.

When light hits an object with diffusion
set to 100%, all the light that hits it is
reflected back scattered in all directions.
This gives the object a flatly lit

Bryce 3D

appearance. If the object’s diffusion is set
to 0%, no light is reflected off its surface,
so the object appears black.

Diffusion set to
0% 100%

Diffusion set to

Diffusion controls how much light is diffusely
reflected off the object’s surface.

Setting Diffusion Using a Texture

When you assign a texture to the
Diffusion channel, the texture’s alpha
channel determines which areas of the
surface have high diffusion and which
have low diffusion. Bright areas in the
alpha channel have a high diffusion value
and darker areas have low diffusion
values.

Higher Diffusion
values

Lower Diffusion
values

E: Alpha Channel

When you use a texture to set the Diffusion
channel, the grayscale values in the texture’s
alpha channel determine the diffusion of the
objects.

Diffuse Color

Diffuse Color acts like a filter through
which all diffuse light passes. When light
hits the object, the amount of light that’s
reflected diffusely is determined by the



Diffusion channel setting, and the color
of that light is set by the Diffuse Color
channel.

Direct Light

Diffuse Color T
~ “Viewer

Surface ?
reflects light
diffusely

This graphic shows how diffuse light passes
through the Diffuse Color.

When Diffusion is set to a value greater
than zero, the Diffuse Color appears
wherever the object is hit by direct light.

Diffuse Color
applied to areas
hit by direct light

Diffuse Color is the color of diffusely reflected
light.

Be careful when using pure constant
colors as the Diffuse Color because you
may not get the results you're expecting.
If you use a pure color, only that color is
reflected off the object. So if you're using
100% green, only green light is reflected
off the surface. This doesn’t cause a
problem when the object is hit by white
light because there is green in white.
However, if you use 100% red light on the
object, it will appear black, since there is
no green in 100% red, so no light is
reflected off the object.

Try to avoid using pure colors for the
Diffuse Color, so that your object always
reflects some color.

Ambience

Ambience simulates the effects of light
hitting the object from all directions. The
Ambience value controls the amount of
light that is reflected off the surface
uniformly.

Qﬁ X

Light from
all directions

? Lsaitlz(attered
A X zgi\

The large arrows represent ambient light hitting
the object’s surface. The smaller arrows
represent the light reflected off the object’s
surface.

When Ambience is set to a value higher
than zero, the object will reflect light
from all over its surface, not only from
the area hit by light. This makes the
object look brighter.

The higher the Ambience value, the
brighter an object appears. At 100%, the
object appears unnaturally bright,
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regardless of the light source. If you want
to create a realistic effect, the sum of the
Ambience and Diffusion values should

add up to 100.

—adl

Ambience set to

Ambience set to
0% 100%

Ambience controls the general brightness of an
object.

An object’s ambience is directly related to
the general ambience of the environment.
So, the ambient value you set for the
object is directly affected by the Ambient
Color you set in the Sky & Fog palette.

The Ambient Color in the Sky & Fog
palette controls how much ambient light
is available in the environment. The
Ambience channel controls how much of
the available ambient light is reflected off
the object’s surface.

So, if you set the Ambient Color in the
Sky & Fog palette to black, or 0%
ambience, then the Ambience channel
value has no effect. If you set the Ambient
Color to white, or 100% ambience, the
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Ambience channel value will control how
much of the available light is reflected off
the object’s surface.

Setting Ambience Using a Texture

When you assign a texture to the
Ambience channel, the grayscale values
from the texture’s alpha channel
determine which areas of the surface have
high ambience and which have low
ambience. Bright areas in the alpha
channel have high ambience values and
darker areas have low ambience values.

Higher Ambience
values

Lower Ambience
values

|
H_| Alpha Channel

When you use a texture to set the Ambience
channel’s value, the values are determined by
the grayscale values in the texture’s alpha
channel.

Generally, it’s best to set Ambience using
a value. However, you can get some
interesting effects using textures instead.
For example, if you use a splotchy texture,

you'll get areas of your surface that
appear to glow regardless of external
light, mixed in with normal surface areas.

Ambient Color

Ambient Color is the color that is
reflected off the surface of an object
regardless of where the light source hits it.
The Ambient Color is directly linked to
the Ambience channel setting. If the
Ambience is set to zero, the Ambient
Color is invisible.

1
SN Ambient Color 7
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Ambient Color is the color that reflects off the
entire surface of the object and is directly related
to Ambience.



The Ambient Color tints the entire
surface of the image.

Ambient Color
tints the entire
surface

Ambient Color is the color that appears no
matter where light strikes the object.

The Ambient Color channel is also
related to the ambient color you set in the
Sky & Fog palette. The ambient color of
the environment is added to the ambient
color of the object, so if your
environment is blue and your object’s
ambient color is yellow, your object
appears green.

Setting Ambient Color Using a Texture

When you assign a texture to the Ambient
Color channel, the color channel in the
texture is used as the Ambient Color. In
other words the texture’s color is applied
to any area of the object that’s in shadow.

Specularity

Specularity controls how much light is
reflected back from the surface of the
object at the viewer.

Viewer sees
highlight

Incoming Light
Reflected Light

Surface is
reflective

Specularity is the highlight reflected back at the
viewer.

Since the direct reflection creates a
highlight on the object, you can think of
Specularity as the channel that
determines the intensity of the highlight
that appears on the object, or the
“shininess” of the object.

The higher you set the Specularity, the
shinier the object appears. When the
Specularity is set to zero, the object
appears dull.

Specularity set to Specularity set to

0% 100%

Specularity controls the intensity of the highlight
of an object.

Setting Specularity Using a Texture

When you assign a texture to the
Specularity channel, the grayscale values
in a texture’s alpha channel are applied to
the object’s highlight. Bright areas of the
alpha channel increase the intensity of the
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highlight, and darker areas decrease the
intensity. The alpha channel may also
create patterns in the highlight.

High Specularity
values

Lower Specularity
values

. Alpha Channel

When you use a texture to set the Specularity
channel’s value, the highlight’s intensity is
determined by the texture’s alpha channel
values.
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Specular Color

Normally, the color of an object’s
highlight would reflect the color of the
light source. However, using Specular
Color you can set a specific color for your
highlight.

Specular Color
applied to
object’s highlight

Specular Color is the color of the object’s
highlight.

Specular Color is directly linked to the
Specularity channel. If the Specularity is

set to zero, the Specular Color is invisible.

By adding Specular Color you can make
it appear as though a colored light is
shining on the object.

Setting Specular Color Using a Texture

When you assign a texture to the Specular
Color channel, the texture’s color channel
is used as the Specular Color. In other
words the texture’s color is applied to the
object’s highlight.

Specular Halo

The Specular Halo channel lets you
control the size of the Specular highlight.

The size is controlled by the luminance
value of the component you select.
Brighter colors create larger highlights
and darker colors create smaller
highlights.

Specular Halo set
using bright colors

Specular Halo controls the size of the highlight
on your object.

Specular Halo set
using dark colors

Colors are expressed as RGB (Red, Green
and Blue) values. Specular Halo channels
use the values from each of these
channels to set the size of the highlight. If
the values are all in balance (that is, all the
same), the highlight appears uniform.
However, if one value is higher that the
rest (for example, R=200, G=100,



B=100), you'll get a highlight with a
slightly colored ring (for example, a red
ring).

Specular Halo
with balanced
color

Specular Halo with
varied RGB values

When you use a balanced color as the Specular
Halo, you get a uniform highlight. If you use a
color with varied RGB values, slight rings
appear on the highlight.

Depending on the component you use in
this channel, you may be able to set each
color value differently to create different
highlight effects. The easiest way to use
this channel is with a color.

When using a color, try picking more
desaturated colors. These colors produce
more predictable results because the
difference between RGB values is less.

r il _-‘-'-‘——_.___ R
Check out the Specularity Lesson
series in the Fast & Simple category in
the Preset Materials Library to see
Specular Halo in action.
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Setting Specular Halo Using a Texture

When you assign a texture to the Specular
Halo channel, the RGB value of the
texture’s color channel is used for the
Specular Halo.

Metallicity

The Metallicity channel value acts as a
filter for reflected light. This value
controls how much of the reflected light
is filtered through the Diffuse Color.

At 50%, half the reflected light is tinted
with the Diffuse Color; at 100%, all the
light that’s reflected is tinted.

Metallicity is linked to Reflection. If
Reflection is set to zero, the Metallicity
channel has no effect.

Metallicity set to
50%

Metallicity controls how much of the reflected
light is tinted with the Diffuse Color.

Metallicity makes objects look metallic
because it tints the color of reflections. If
you want to create specific types of metals
you need to adjust the Diffuse Color. For
example, to create gold use a yellow
Diffuse color.

Setting Metallicity Using a Texture

When you apply a texture to the
Metallicity channel, the texture’s alpha
channel is used to determine the intensity
of the Diffuse Color. Lighter areas of the
alpha channel increase the intensity of the
color, and darker areas decrease the
intensity.
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Bump Height

The Bump Height controls the height of
bumps in an object’s surface. The bumps
on an object’s surface are determined by
the texture’s Bump channel. The Bump
Height channel is linked to the Bump
channel in the texture. If you use a texture
without a Bump channel, this channel
has no effect. You can enter negative
values in this channel, which turns
bumps into dents.

Bump Height set to
-100%

Bump Height set to
+100%

Bump Height controls the height of bumps on
the surface of your object.
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Transparency

The Transparency channel controls how
much light can pass through the object’s
surface.

Direct Light

b
The amount of light that can pass through an
object’s surface is set with the Transparency
channel.

The higher the Transparency value, the
more of the surrounding environment is
visible through the object’s surface. If

there is no other light being reflected, an
object set at 100% Transparency appears

invisible.

Transparency set to

Transparency set
to 0% 100%

Transparency controls how much of the
surrounding environment is visible through the
object’s surface.

To create a realistic transparent object,
you need to pay attention to details. You'll
need to combine the effects of the other
channels to simulate a realistic object. For
example, transparent bubbles all have
highlights, so you'll need to add
Specularity. Balloons have a flatter
surface so you'll need to add more
Diffusion to the surface. Glass has a
refraction effect associated to it, so you'll
need to add Refraction to the surface.



Setting Transparency Using a Texture

When you apply a texture to the
Transparency channel, the texture’s alpha
channel is used to determine which areas
of the object are transparent. Lighter
areas of the alpha channel are not
transparent while darker areas are.

You can create some interesting effects
using textures. For instance, a
checkerboard texture will result in an
object that's alternately transparent and
solid. The final look of the Transparency
channel is determined by the Shading
mode. When the material is applied using
normal shading, Transparency creates an
optical effect.

When the material is applied using Blend
Transparency mode, Transparency creates
a punch-out effect. The areas of the
surface that are 100% transparent are
completely ignored during shading so
that they appear as gaps or holes it the
surface. Any areas that are less than a
100% result in a normal transparency
effect.

Refer to “Shading Modes” on page 225
for more on Shading modes.

Cage texture
applied to
Transparency
channel

You can create some interesting effects using
textures in the Transparency channel, like this
checkerboard object. This example was created
using regular shading.

This is what the same material looks like when
you use Blend Transparency.

Transparent Color

The Transparent Color channel
determines the color of the transparent
areas of your object. Light is filtered
through this color as it passes through the
object’s surface. As a result, anything you
can see through your object is tinted with
the Transparent Color you select.
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Transparent Color tints any light that passes
through the object.

Keep in mind that the Transparent Color
interacts with the other colors in the
material. If the Diffuse Color is white,
then the Transparent Color takes
precedence. If the Diffuse color is yellow,
and the Transparent color is red, the
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object appears orange. However, when
you're using Refraction, the Transparent
Color blends with the Diffuse Color.

Transparent
Color applied to
the object

The Transparent color tints everything you see
through the surface of your object.

Transparent Color is linked to the
Transparency channel. If the
Transparency is set to zero, the
Transparent Color is invisible.

Setting Transparent Color Using a
Texture

When you assign a texture to the
Transparent Color channel, the texture’s
color channel is applied to the
transparent areas of your object.
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Refraction

The Refraction channel determines
whether light bends when it passes
through the surface of an object.

_Ar
Light is A
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) / / / than 100
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Light may bend as it passes through an object,
depending on the Refraction value.

Higher Refraction settings produce slight
reflections as some of the light is bent
directly back at its source. Higher
Refraction settings also change the color

of the object’s surface as the colors
reflected from the environment affect the
object’s color.

Refraction set to Refraction set to
0 116

Refraction controls how much light bends as it
passes through a transparent surface.

The Refraction value is what makes
transparent surfaces look like glass.

As you increase the Refraction value, the
edges of the object will become reflective.
This simulates the effect of light being
refracted so sharply that it does not
penetrate the object’s surface.

Refraction set to
140 300

Refraction set to

In these examples you can see how the edges
become more reflective as you increase the
Refraction value.



The higher you increase the Refraction
value, the more the Diffuse Color is
blended with the Transparent Color. The
higher the value, the more Diffuse Color
is visible in the object’s surface. Any light
that’s visible through the surface of the
object is then tinted through both the
Diffuse Color and the Transparent Color.

-~ i

B
Refraction values are expressed as

100 x Refraction Index value. The
Refraction Index contains refraction
values for specific types of surfaces.
For example, the Refraction Index of
water is 1.3; this value is expressed as
130 in the Materials Lab.
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Refraction is linked to Transparency. If
Transparency is set to zero, this channel
has no effect.

Setting Refraction Using a Texture

You cannot use a texture to set the value
of the Refraction channel. You can only
use a value to set this channel.

Reflection

The Reflection channel controls how
much light, direct or indirect, is reflected
off the object’s surface. Unlike Diffusion,
which scatters light, Reflection directs
light back at its source, giving the object a
mirrorlike appearance.

Incoming Light
e

EC ol
! Surface is " Reflected Light

Reflective |
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Viewer sees object on
the surface of object

Reflection determines how much light is
reflected off the surface of the object.

The higher the Reflection setting, the
more reflective the surface. At 50%, half
the light that hits the object’s surface is
reflected, at 100% all light is reflected.

-
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Reflection set to

Reflection set to
50% 50%

Reflection controls how much light is reflected
off the surface of an object.

As you increase the Reflection value, the
color of the object changes, since you can
see more of the environment in the
object’s surface.

Setting Reflection Using a Texture

When you apply a texture to the
Reflection channel, the texture’s alpha
channel is used to determine which areas
of the object are reflective. Lighter areas
of the alpha channel are reflective, while
darker areas are not.
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Volume Material Channels

Volume materials use most of the same
channels as surface materials. These
channels all work the same as they do for
surface materials. The only difference is
that the channels control the properties
of the object’s volume, not its surface.

In addition to the channels already
discussed, Volume materials have several
specialized channels.

Volume Color

The Volume Color channel controls the
color applied to the interior of an object.
Everything inside the object will appear
tinted with this color as all light is filtered
through the Volume Color.
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The interior of an object can have color, which
you set with Volume Color.

The Volume Color interacts with the
Transparent Color. If your surface is
transparent, light is tinted by the
Transparent Color and the Volume Color.

Volume Color
applied to the
interior of the
object

The Volume color tints everything inside the
object.

Volume color is an excellent way of
creating underwater light effects.

Base Density

Base Density controls how dense the
object is. In areas where the object is very
dense, no light passes through the object.
Where the object is less dense, more light
passes through its volume. Base Density
works like Transparency in 3D space.
Areas that are less dense appear to be
more transparent.

High values create very solid objects like
rocks, while lower settings create less
dense objects like clouds.

Base Density set
to 100 to 0

Base Density set

Base Density controls the density of the area
within an object. Objects with a low density will
appear more transparent.

You should use this channel cautiously.
The more transparent objects are, the
more time they take to render.



Setting Base Density Using a Texture

When you use a texture to set this
channel, the alpha channel is used to
determine which areas of the object are
solid and which are empty.

Edge Softness

Edge Softness controls the softness of the
edges of the silhouette of objects with a
volume material. For example, a sphere
with a low Edge Softness value will have a
“hard” silhouette, meaning that you'll be
able to clearly see the edges of the sphere.
A high Edge Softness value will almost
totally obscure the edges of the sphere.

Edge Softness
setto 0

Edge Softness
set to 100

Edge Softness controls the softness of an object’s
silhouette.

This channel is useful for obscuring the
general shape of an object. Use this effect
if you want to blur the overall shape of
the object to which you're applying the
material.

Fuzzy Factor

Fuzzy Factor controls the dullness or
sharpness of a material. Values greater
than 100 adjust the dullness of the
material, and values less than 100 adjust
the sharpness of a material. At 100 there
is no dullness or sharpness applied

Fuzzy Factor set
to 0 to 200

Fuzzy Factor set

Fuzzy Factor controls dullness/sharpness of the
texture within your object.

As you increase the dullness of your
object, it becomes less dense, so you may
have to increase the Base Density to
compensate. Likewise, as you increase the
sharpness of the object it becomes more
dense.

You can use this channel to smooth
sharp-looking clouds, or sharpen dull
stone textures.

Quality/Speed

Quiality/Speed controls the render quality

of the texture. This channel represents the

inverse relationship between render

quality and rendering speed. As you

increase the render quality of the

material, you decrease the speed at which

its rendered. As you increase the speed at

which a material is rendered, you r
decrease its quality.

Quality/Speed
setto setto O

Quality/Speed
set to set to 100

The Quality/Speed value controls the quality of
the texture’s render in relation to how fast it
renders.

The material loses detail as the quality
decreases. Detail is introduced as it
increases.

For still images you probably want to
increase the quality of the material and
sacrifice speed, since the scene only has to
be rendered once. For animations, you
probably want to sacrifice quality since
the scene will have to be rendered once
for each frame in the movie.
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Material Components
This section describes the various
components you can use to set a material

channel value. It also describes how to set
the parameters for each component.

Color Components

A color component is an RGB color that
is directly applied to a channel. Colors
can only be used in the Color channels:
Diffuse, Ambient, Specular, Specular
Halo, and Volume.

When you're using a color in these
channels you cannot combine it with a
texture. If you choose a texture
component for any of the Color channels,
the color oval appears blank. The Volume
channel can only be set with a color.
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To use a color as a component:

1. Inthe Materials Lab, click the color
oval in one of the channel rows on
the Material Grid and choose a color
from the palette.

The Color oval in the channel column displays
the color palette.

+ Tochoose a color using the Color
Picker, hold down Option/Alt
when you click the color oval.

The selected color appears in the
color oval. If you click on one of the
columns, the color oval appears
blank.

Value Components

Value components are numerical values
you use to set the intensity of a channel.
Values can only be used in the Value,
Optics or Volume channels.

A value is indicated by either the
numerical field in the left side of the
channel in the Material Grid, or the slider
that extends out from the channel. The

sliders let you quickly set the value of a
channel and the numeric field shows the
current setting.

TRANSPARENCY

REFLECTION

The value slider in a channel lets you set a
numerical value for the intensity of the channel
and displays the channel’s current setting.

Values can be used with textures. In this
case the value sets how much of the
texture is applied to the channel. For
example, if you use an orange-colored
texture to set the Diffuse Color channel,
the value would indicate how much of the
texture color is used as the Diffuse Color.

A value of 100 means that all the texture
information is used in the channel; a
value of 0 means that none of the texture
is used.

Not all channels use values. The Color
channels only use colors or textures. The
Refraction channel can only be set with a
value.



To use a value as a component:

o Inthe Materials Lab, drag the slider
next to the channel whose value you
want to set. As you drag, the
numerical value appears in the
number field.

Some channels let you set negative
values.

Texture Components

When you use a texture as a component,
Bryce extracts values from the texture to
use as a value for the material channel.
There are two types of texture
components you can use: pictures and 3D
textures. Pictures are images you import
from either the Picture Library or from
another application. 3D textures are
procedural textures generated by Bryce
and stored in a texture library.

You can assign up to four textures as
components for a material. These
textures can be any combination of
pictures and 3D textures. Each texture
component is assigned a letter: A, B, C, or
D.

The texture you assign to a component is
used throughout the material, so the
texture you assign as component A in the

Diffusion channel is the same component
A used in the Ambience channel and so
on.

When you're setting channel values, you
can mix and match components. For
example, you can assign component A to
Diffusion and component D to
Ambience. You can also combine textures
within the same channel using the blend
modes AB and ABC. In this case the
texture you assigned to A is blended with
the textures assigned to Band C to set a
material channel value. Refer to
“Combining Components” on page 223
for more on blend modes.

The Texture Component Window

The Texture Component window
displays the attributes of a selected
texture component. You can have up to

four windows visible in the Materials Lab.

Display Deep

Texture Editor
Display Texture Texture Name
Transformation
Palette

Texture Library
list

Use Picture | Mapping Modes

Use 3D Texture Current Mapping Mode

The Component window displays the selected
component and its current attributes.

The six buttons on the Texture
Component window let you set the type
of component, the texture mapping
mode, access the texture transformation
controls and the Deep Texture Editor.

To use a Texture as a component:

o Click acolumn in the material grid. A
Texture Component window appears.

The component window corresponds
to the columns in the grid, so if you
click column A in the grid, texture
component A becomes active.
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3D Textures

3D textures have three different types of
outputs: Color, Alpha channel and Bump.
These outputs are used differently by the
material channels.

Color channels use the texture’s color to
set the value of the channel. For example,
if you use a texture in the Diffuse
channel, the colors in the texture appear
wherever the object reflects light
diffusely.

Diffuse color set
using a texture

Diffuse color set
using a color

When you use a texture to set the value of a
Color channel, the color information is used to
set the material channel value. In this example,
the Diffuse color was set using a texture.

Value, Optics and Volume channels use
the alpha channel information from a
texture to set the value of the material
channel. For example, when you use a
texture to set Specularity, the texture’s
alpha channel information determines
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which areas of the object are shiny. As a
result, you'll see the pattern of the texture
on the object.

Specularity set
using a value
When you use a texture to set the value of an
Intensity channel, the alpha channel
information is used to set the material channel
value. In this example, Specularity was set using
a texture.

Specularity set
using a texture

The Bump information in a 3D texture is
used only by the Bump Height channel.
The Bump channel in the texture
determines the pattern of bumps or dents

in the object. In fact, you won't be able to
see the effects of the Bump Height value
unless you assign a texture to the channel.

ump Height set B
using a value using a texture

Bump channel information from a texture is
used to determine the pattern of bumps or dents
in an object. You must assign a texture to the
Bump Height channel to see the bumps or dents.

To use a 3D texture as a component:

1. Inthe Materials Lab, click a channel
column.

A randomly selected texture appears
in the Component window.

When you select 3D texture as a component, the
Component window displays a randomly
selected texture in the preview area and shows
the texture’s current attributes.



2. If you want to change this texture,
click the triangle button next to the
texture name at the top of the
window and choose a preset texture
from the menu.

The triangle button next to the 3D texture’s

name in the component window provides access
to all the preset 3D textures available in Bryce.

The texture you selected appears in
the Component window.

2D Textures

2D textures are pictures you've created in
another application or one you've
selected from the Pictures Library. The
data in the channels of these pictures are
used as values in the material channels.

To use a 2D texture as a component:

1. Inthe Materials Lab, click a channel
column. A texture appears in the
texture component window.

2. Inthe Component window, click the
P button at the bottom of the
Component window.

The P button changes the component to a 2D
picture.

A default picture appears in the
Component window.

When you select 2D texture as a component, the
Component window displays a default picture
in the preview area and shows the picture’s
current attributes.

3. To change the picture, click the pink
button at the top of the component
window.

.. [

The pink button displays the Pictures Library.

The Pictures Library appears.

The Pictures dialog lets you select a 2D images to
use as a Pict object.

4. Click an image square to load an
image.

5. If the image you want is not in the
library:

+ Click the Load text button. The
Load Image dialog appears.

+ Use the dialog controls to locate
the picture you want to use and
click Open.

or

+ Inanother application, copy the
picture you want to use to the
Clipboard.

+ Access the Picture dialog and
click the Paste text button.
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The picture is loaded into the first
image box and its alpha channels are
loaded into the second box.

When you load a new picture into the Picture
dialog, the main image is loaded into the first
box and its alpha channel is loaded into the
second box.

You can invert the alpha channel by
clicking the invert button.

R -
6. Click the OK icon to exit the dialog.

The picture appears in the
Component window.
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Texture Mapping Modes

Once you've decided on a texture to use
as a component, you need to decide how
the texture is mapped onto your object.
The appearance of the texture can change
dramatically depending on how it’s
applied to the object.

Each texture you apply can have a
different mapping mode. When you're
mixing textures (Mode AB or Mode
ABC), you can choose which portions of
your textures you want to combine.

To select a mapping mode for a texture:

1. Inthe Materials Composer, click a
channel.

Select a mode for the channel.

3. Click the title of the Component
window and choose either 2D
Texture or 3D Texture.

4. Click the current Mapping Mode title
and choose a mapping mode from
the menu.

Object Space

In this mode, textures are scaled
proportionally to the size of your object.
If you change the size of your object, the
texture scale changes with it. The texture
also rotates along with the object. This
means that the texture does not appear to
move as you reposition or rotate the
object.

In Object Space mode, textures are applied to
the object so the texture will not move as you
move the object.



World Space

In this mode, the texture is infinitely large
3D space, and only a small portion is
applied to your object. This means that
the texture appears to change as you
move your object, since it is moving
through the texture in 3D space.

In World Space mode, the texture is applied to
the entire world, so the texture appears to move
as you move the object.

Parametric

In this mode, the texture is applied onto
the object as if it were a decal. For
example, if you use this mapping mode
on a cube, one iteration of the texture is
placed on each face.

Parametric mode applies the texture as a 2D
decal.

The texture is mapped onto the object so
it rotates and scales as the object is scaled
or rotated.

This mode works best with 2D Pict
textures.

Parametric Scaled

This mode works like the World Space
moade, only in 2D. Textures mapped using
this mode are not scaled with the object.

S=

Parametric Scaled mode applies the texture as a
decal, but does not scale the texture as you scale
the object.

Use this mode when you want to map a

2D picture onto constructed objects like
buildings.
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World Top Spherical Cylindrical

In this mode a 2D projection of the In this mode, a 2D projection of your In this mode, your texture is mapped
texture is applied to the object from texture is mapped onto a virtual sphere onto the front of your object, wrapping
directly above it. If you move your object that surrounds your object. It is then around the right and left sides all the way
or rotate it, the texture does not move projected from the sphere onto your to the back. Edge pixels going to the

with the object; it remains constant while object. center appear on the top and bottom of
the object moves through it. your object.

g

| N

\

Spherical mode applies the texture to a virtual

World Top mode applies the texture to the top of sphere and then projects it onto your object. Cylindrical mode wraps a texture around the
the world. The texture appears as a projection object starting from the front.
on top of the object and streaks down its sides.
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Reflection Map

In this mode, a 2D projection of your
texture is applied to a virtual sphere that
surrounds your scene. The texture is then
reflected off of the sphere and onto your
object.

Parametric
Scaled

Reflection
Map

Reflection Map mode applies a reverse image of
your texture to your object.

This mode works best on objects with
irregular surfaces. It also works well with
terrains.

Random

This mode randomly applies a
2D projection of the texture all over the
surface of your object.

Random mode applies the texture all over the
object in a random pattern.

Object Top

This mode applies a 2D projection of the
texture to the top of your object. The
texture rotates and scales along with the
object.

Object Top mode applies the texture to the top of
the object.
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Object Front

This mode applies a 2D projection of the
texture to the front of your object. The
texture rotates and scales along with the
object.

Object Front mode applies the texture to the
front of the object.
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Mapping Mode Modifiers

You can modify the mapping modes in
two different ways.

Symmetrical Tiling

When you tile a texture onto an object in
symmetrical tiling mode, each repeated
instance of your texture is tiled
horizontally and vertically as needed to
seamlessly produce a symmetrical pattern
over the surface of the object.

in Symmetrical Tiling mode, textures are
seamlessly tiled across the object.

Scale Pict Size

This mode modifier only affects picture
textures. When selected, the image is
scaled to cover the entire surface of the
object instead of being tiled.

Transforming Textures

Since a 3D texture exists in
three-dimensional space, it can be
transformed along the X, Y, or Z
axis—just like a 3D object. Using the
texture transformation tools, you can
scale, position or rotate your texture.

The final look of the transformation
depends on the mapping mode you use to
apply the texture to the object. In some
modes, texture transformations may not
be very noticeable, while in others, like
Parametric, transforms can have a large
impact on the look of the material.

You may find it necessary to experiment
with different settings to get the results
you want. If you find that the texture isn’t
reacting the way you want it to, try
changing the mapping mode. Refer to
“Texture Mapping Modes” on page 216
for more on mapping modes.

The transformation tools give you very
fine control over the final appearance of
the texture.

Scale

Using the Scale tool, you can control the
frequency of the texture. Increasing the
scale of a texture decreases the frequency



of the pattern, since it doesn’t have to be
repeated as many times to cover the
surface of the object.

Scale X=0% Scale X=50% Scale X=100%

Since a 3D texture exists in 3D space, you can
change its size in all three axes. Adjusting the
scale in X changes the size of the texture along
the X axis.

VY

Scale Y=0% Scale Y=50% Scale Y=100%

Adjusting the scale in Y changes the size of the
texture along the Y axis.

A e

Scale Z=0% Scale Z=50% Scale Z=100%

Adjusting the scale in Z changes the size of the
texture along the Z axis.

Rotation

Using the Rotation controls you can
control the angle of the texture on the
object’s surface. You can create very
different texture effects depending on its

orientation. Rotation Rotation Rotation
Z=0° Z=90° Z=180°
Adjusting the orientation in Z changes the angle
of the texture along the Z axis. r
You can transform a texture numerically
by adjusting the X, Y and Z coordinates !
or interactively using the transformation I
Rotation Rotation Rotation tools.
X=0° X=90° X=180° ;
Since a 3D texture exists in 3D space you can .
Position

change its orientation in all three axes.
Adjusting the rotation in X changes the angle of
the texture along the X axis.

Ve

Rotation Rotation Rotation
Y=0° Y=90° Y=180°

Adjusting the orientation in Y changes the angle
of the texture along the Y axis.

Using the Position controls, you can
control where the texture appears on the
object’s surface. When you're using a
picture as a component, placement can
be vital to the look of the material. For
example, if you're placing a decal on an
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object, use the Position controls to e e U g . As you adjust the value, the material
preview updates to show the results

of your changes.

precisely place the image in the center of

the object or on the correct face To transform a texture numerically:

1. Inthe Texture Component window,
“. click the click the first button on the
left at the top of the window.

The Transformation palette appears.

Position Position Position

X=0 BU X=50 BU X=100 BU
Since a 3D texture exists in 3D space you can
change its position in all three axes. Adjusting
the position in X changes the placement of the
texture along the X axis.

>

The material preview area updates as you
transform the texture to show your changes.

4. Click the OK icon to apply your
changes.

To transform a texture interactively:

Use the texture transformation palette to adjust :

Position Position Position the scale, position and orientation of the texture 1 In. the Text_u re Component window,
Y=0 BU Y=50 BU Y=100 BU component. click the click the first _button on the
Adjusting the position in Y changes the left at the top of the window.
placement of the texture along the Y axis.

2. Move your cursor over the
transformation you want to apply.

3. Drag the cursor over the value you 2. Move the cursor over the tool you
g want to adjust. want to use until the mode you want
| ] ) is active.
v | Drag left to increase the value or right
to decrease it. 3. Asyou pass the cursor over the tool,
the tool changes to display the

Positi it Positi . .
720 BU. P 79100 8U different modes available.

Adjusting the position in Z changes the
placement of the texture along the Z axis.

The Transformation tools appear.
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4. Drag the mouse in the direction you
want to move, scale, or rotate the
texture.

5. Click the OK icon to apply your
changes.

Editing Textures

You can edit the makeup of an existing
texture or create a completely new texture
using the Deep Texture Editor. This
editor uses some rather complex
texture-generation concepts to create
textures for Bryce. You can either choose
to learn all these concepts to create your
textures precisely, or use the editor as a
type of lab where you combine random
settings and see the results.

Refer to “Textures” on page 239 for more
information about learning
texture-generation concepts.

Combining Components

You can combine material components
using one of three blending modes:

* Mode A
* Mode AB
* Mode ABC

Mode A

In Mode A, only one component is used
to set the value of a channel. The
component can be a value, a picture or
3D texture.

Mode AB

In Mode AB, two textures are blended
together based on altitudes. At the lowest
altitudes the values from texture A are
used, at higher altitudes texture B is used
to set the value of the channel.

Altitude is based on the distance between
the ground level and the highest object in
your scene.

When you use this mode, an object’s
surface material is a blend between two
texture components. Texture B appears at
the bottom of the object and Texture A
appears at the top. In between is a blend
between texture B and texture A. Bryce
creates the blend by interpolating
between the two textures.

For example, if you use Mode AB in the
Diffuse Color channel, the color in
texture A appears at the bottom of an
object’s surface, and the color from

texture B appears at the top. A color
gradient between color A and color B
appears in the middle of the object

In this example, Mode AB was used to set the
Diffuse Color channel. Values from texture A set
the Diffuse Color channel at lower altitudes
while values from texture B set the channel at
higher altitudes.

Mode AB can be used to create snow
covered peaks on terrains or murky
depths in infinite water slabs.

To use mode AB to blend textures:

1. Inthe Materials Lab, Control/Ctrl-
click the B column of a channel.
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Component indicators appear in
both the A and B columns of the
channel.

DIFFUSE N

Component indicators in both the A and B
columns of a channel indicates that you're using
mode AB to blend texture components.

Mode ABC

In Mode ABC, two textures, texture A
and texture B, are blended based on the
alpha channel of texture C. In this mode
the alpha channel from texture C acts like
a map that tells Bryce where to apply the
values from texture A and texture B. All
the white areas of the alpha channel use
values from texture A; black areas in the
alpha channel use values from texture B.
Gray areas in the alpha channel use a
combination of both textures.
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Alpha Channel Texture Used

Texture A

Combination
of Aand B

. Texture B
In the example that follows three textures

were combined using Mode ABC in the
Diffuse Color channel.

Texture A

Texture B

Texture C

Using Mode ABC to combine the three textures,
the spot texture (A) appears in the white areas of
the checker texture’s alpha channel (C) and the
lines texture (B) appears in the black areas of the
alpha channel.

To use Mode ABC to blend textures:
1. Inthe Materials Lab, Control/Ctrl-
click the C column of a channel.

Component indicators appear in the
A, B and C columns of the channel.

Component indicators in the A, Band C
columns of a channel indicate that you're using
Mode ABC to blend texture components.
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Shading Modes

Shading refers to the process of applying
material channel values to an object.
When an object is shaded, the different
values in the material are applied to the
object. The shading modes available in
Bryce determine how material channels
are applied to create different effects.

Using a material, you can define whether a
surface is shiny, smooth, or opaque.

Using a shading mode, you determine how those
properties are applied to the object.

The shading mode cannot only determine how
the material is applied to the surface of the
object, but how it’s applied to its volume as well.

To choose a shading mode:

o Click the triangle icon next to the
material type buttons at the top of
the Materials Lab.

EhiliEis Bai
P Pend - Sivisas

Click the triangle icon at the top of the Materials
Lab to display a listing of the available shading
modes.

Surface Material Shading Modes

This section explains the surface material
shading modes.

Normal

Normal mode applies the values of the
material without modifying them in any
way. Objects are shaded according to the
values you set in the material channels.
This mode has no special effects; it
simulates a real-world appearance using
the material channel values.

This is the default mode and is
appropriate for most objects.

Blend Transparency

In Blend Transparency mode, visibility is
controlled by Transparency. When this
mode is active, areas of the object that are
100% transparent are ignored.
Transparent areas are not shaded and do
not cast shadows. These areas appear as
gaps or holes in the object’s surface.
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This mode lets you create punch-outs
when using a texture.

Using Normal Shading

This cage was created by using blend
transparency to “punch-out” areas of the object’s
surface.

Anything less than 100% Transparency
results in normal transparent areas.
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Fuzzy

Fuzzy mode changes the effective
Transparency based on the thickness of
the object. As a result, objects appear
fuzzy on the edges and solid at the center.

When you apply a material using Fuzzy shading
mode, the edges of the object appear blurred,
while the center remains solid.

Since Bryce uses depth information to
synthesize this blurry effect, it is not
available for 2D objects such as Squares
or Disks.

Use the Transparency setting to adjust the
degree of fuzziness.

Light

Light is a very specialized shading mode
best used to create visible lighting effects.
Obijects shaded with this mode appear
transparent and self-illuminating.

The Light shading mode is designed to create
simple light effects. If you apply it to a cone
object, it looks like a cone of light.

Only the Diffuse, Ambient and
Transparent Color channels are used to
determine the color of the light. All other
channels are ignored.

This mode is useful for creating point
lights without the rendering overhead
that comes with true volume light objects
(that is, light-sensitive volume materials).



Volume Material Shading Modes

This sections explains the volume
material shading modes.

Flat Shading

Flat shading mode is designed for clouds,
gases and other self-luminous gaseous
materials. Flat shading mode does not
shade an object, meaning that light
sources have no effect on the color or
brightness of the object.

The Flat shading mode applies your material as
a volume material, but does not apply any
shading.

When this mode is active, Diffusion,
Ambience, Specularity, Ambient Color,
Specular Color and Transparency Color
have no effect.

The color of the material is determined
entirely by the Diffuse Color channel.

Full Shading

Full shading mode is designed for hard
edged, sharp objects like rocks. When Full
shading mode is active, the visible
portions of the material are shaded and
can be affected by light sources.

The Full shading mode applies your material as
a volumetric material, and applies shading to
the visible portions of the material.

Since light sources can affect portions of
your material, shadows will appear
within the object. This can greatly
increase rendering time. If you don’t need
to see shadows in the object, make sure
the Receive Shadows filter is disabled.

Usually you should disable this filter
unless you're creating very specialized
effects.

Light Sensitive

Light Sensitive mode is designed for
creating visible light effects such as light
beams. Light Sensitive mode does not
shade objects, but the particles in your
material are sensitive to light.

In this mode, Density doesn’t control
density as much as it sets the light
sensitivity of material particles. Higher
values create brighter particles and lower
values create darker particles.

.l _q_-""---..__________,r

To get the best results for light objects,
use the Additive blend mode.

- _H_-""---..__________._..r

The color of the particles is determined
entirely by the Diffuse Color channel.

The result is like shining a light through a
volume. If you were shining a light
through a cloud material, you would be
able to see the clouds within the light
cone.
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When this mode is active, Diffusion,
Ambience, Specularity, Ambient Color,
Specular Color and Transparency Color
have no effect.

Use Light Sensitive shading mode to create
visible light effects like light beams.

Shading Mode Modifiers

Shading mode modifiers are not shading
modes, but they modify an existing
shading mode. When you select a
modifier it remains enabled until you
disable it. You can also apply more than
one modifier at the same time.

Additive

When this modifier is active, material
channels are applied to the environment
behind the object instead of to the
object’s surface.
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If you put an object on a bright
background, it appears almost white. For
best results, set your Ambient Color
control to zero and render against a dark,
plain background. Objects with this
shading mode modifier selected will not
cast shadows.

When you modify a shading mode using
Additive, objects appear as ghost images.

This mode is very useful for creating
planets and quarter moons, light beams,
and ghost images.

Distance Blur

This modifier is designed to minimize the
problem created by highly bumpy
textures fading into infinity (i.e., the
horizon). Often, moiré-like patterns
appear in these cases as the pixels try to
resolve the infinitely receding high

frequencies of bumpy water or grooved
sand, and so on. The Distance Blur
modifier fades the bumpiness well before
it hits the horizon.

Receive Shadows

This modifier prevents an object’s surface
from accepting shadows cast by objects
around it. The object itself will cast a
shadow, but it won’t accept them from
other objects.

When the Receive Shadow filter is disabled, no
shadows will appear on the object’s surface.

Cast Shadows

This modifier prevents an object from
casting shadows. The object’s surface still
reacts normally with light but it does not
cast any shadows.



Volume Blend-Altitude

This modifier gradually blends in the
Volume color based on altitude. Areas at
lower altitudes are tinted with the 100%
Volume Color; as you move higher up,
less of the Volume Color is added.

Using the Volume Blend-Altitude you can
simulate the effects of sinking deeper into a
volume of water. The lower you sink, the darker
it becomes.

This modifier can be used to create a
sense of depth in an infinite water slab. If
you blend between a light Diffuse Color
and a darker Volume Color, you can
create the illusion of depth as you sink
deeper into the water.

Volume Blend-Distance

This modifier blends the Diffuse and
Volume Colors of your material based on
the distance from the camera. Areas that
are closer to the camera will be tinted less
with the Volume color. As you move
further away, more of the Volume Color
is visible.

Using the Volume Blend-Distance you can
simulate the effects of looking through murky
water. Distant objects appear darker that closer
ones.

This modifier is excellent for creating
underwater depth effects. If you blend a
darker Diffuse Color with a lighter
Volume Color in an infinite slab, you can
simulate the effects of murky water on
distant objects.
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The Materials Lab

The Materials Lab is where you create and
edit your materials in Bryce. This unique
editor lets you combine a wide variety of
components and channels to create an
infinite number of different surfaces and
volumes.

To display the Materials Lab:

1. Create an object.

2. Select the object in the Working
window. A number of object

attribute icons appear to the right of
the object.

0
l@(i‘lh
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Use the quick access buttons next to a selected
object to access editors and get information
about the object.
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3. Click the M icon. Alternatively, you
can choose Object menu> Edit
Material or display the Edit palette
and click the Edit Material tool.

The contents of the composer depend on
the material currently applied to the
object. If there is no material, the default
material’s settings appear.

A Quick Tour of the Materials
Lab

The Materials Lab is set up like a visual
chart that lets you see all the different
channels that make up your material. At a
glance, you can see all the settings for
each material channel and the texture
components used to drive channel values.

In the top left corner is the mode toggle
button. This button lets you switch
between surface material and volume
material. The buttons also indicate what
type of material you're creating. Surface is
enabled by default. When you toggle to
Volume, the channels in the lab change to
display the volume channels.

L)

~4

Use the toggle button to switch between material
types.
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Material Preview Window

On the left side of the Materials Lab is the
Material Preview. This little window
shows you what your material will look
like when its applied to an object. The
preview updates as you adjust the
channels.

Copy o« Paste

The Material Preview shows you what your
material will look like when it’s applied to an
object. You can drag the preview to get a
different view of the object.

The Materials Grid

The center of the Materials Lab is call the
Material Grid. This is where you combine
values, colors and textures to set channel

values. The Materials Grid is divided into
three sections each containing logical
groups of channels.

The Material Grid gives you a one-glance view
of all the channels that make up your material.

The Color channels group contains all
the material channels that define the
colors that appear on the object surface
when it’s struck by light.

The Color group in the Material Grid contains
all the channels that define the color of an
object’s surface or volume.



Each channel in the Color group has a
color oval next to its title. This oval lets
you quickly set a color for the channel.

Use the Color oval to quickly set a color for the
channel using the Color Picker.

The Value group contains all the channels
that define how the object’s surface or
volume reacts to light. In other words,
they control whether the object is shiny,
metallic, bright or dark.

The Value group contains all the channels that
define how an object’s surface or volume reacts
to light.

The Optics group contains all the
channels that define any optical effects
associated with the object.

When you're creating volume materials,
the Optics group is replaced by the
Volume group. This group contains all
the channels that define the appearance
of an object’s volume.

All of the channels in these three groups
have sliders on the left side of its row. The
sliders lets you quickly set the value of the
channel. Values can be used in
conjunction with textures or on their
own. In the case of the Refraction
channel, you must use a value.

DIFFUSION

AMBIENCE

Use the value sliders to set a value for the
channel.

Each channel is divided into four
columns: A, B, C, and D. These columns
represent texture components you can
use to set the value of the channel. At the
top of each column is a Frequency slider.
This slider lets you quickly set the
frequency of a texture component.
Setting the frequency is the same as
scaling the texture.

When a texture component indicator
appears in a column, it means that a
component is being used to drive the
value of the channel. The column in
which the indicator appears indicates

which texture component is being used.
For example, if a texture component
indicator appears in column A of the
Ambience channel, component A is being
used to drive the Ambience value.

DIFFUSION

Component indicators let you know which
channels are being driven by a texture and
which texture component (A, B, C or D) is being
used.

Texture Component Windows

Along the right side of the lab are the
Texture Component windows. These four
windows are also labeled A, B, C, and D.
When a texture component is active,
these windows display a preview of the
texture and provide access to texture
editing tools.

Materials 231



Component A

Component B

Component C

Component D

The four Texture Component windows
correspond to the four columns in each channel
in the Materials Grid

Along the bottom of the Materials Lab are
the Animation controls. These controls
let you animate between textures or
animate the properties of a single texture
over time.

Use the Animation controls to animate a
material over time.
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Working in the Materials

Lab

This section describes how to use the

Materials Lab to create a and store

materials.

Building Materials

A material is a combination of values,
colors and textures applied through
fourteen different channels. You build
materials by selecting components
(colors, values or textures) and
combining them on the Materials Grid.

To create a new surface material:
1. Select an object.
2. Display the Materials Lab.

3. Set the material channels to define
the properties of your material.

- e
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Remember, channels can be set using
values, colors or texture components.
You may want to experiment with
different setting to see the results of
your changes.
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4. If you're using texture components,
you can:

+ Edit the scale, position or
rotation of the texture using the
texture transformation controls.

+ Edit the makeup of the texture
using the Deep Texture Editor.

+ Set a mapping mode for the
texture.

5. Choose a shading mode for the
material by clicking the triangle icon
at the top of the Materials Lab and
choosing a mode from the menu.

6. Click the OK icon. The new material
is applied to the selected object.

To create a new volume material:

1. Select an object.
2. Display the Material Lab.



Click the toggle button to switch to
Volume.

Set the material channels to define
the properties of your material.
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Remember, channel values are applied
to the object’s volume not its surface,
so adjust the material’s channels
accordingly.
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If you're using texture components,
you can:

+ Edit the scale, position or
rotation of the texture using the

texture transformation controls.

+ Edit the makeup of the texture
using the Deep Texture Editor.

+ Set a mapping mode for the
texture.

=l . — ]
You should always use a texture
component in the Base Density

channel.
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6. Choose a shading mode for the
material by clicking the triangle icon
at the top of the Materials Lab and
choosing a mode from the menu.

The shading modes for volume
materials are different from those for
surface materials.

7. Click the OK icon. The new material
is applied to the selected object.

To activate a component in the
Materials Grid:

o Click an empty channel column. A
component window appears.

To use a component in a channel:

o Inamaterial channel, click the
column that corresponds to the
component you want to use.

To switch between components:

o Drag the component indicator to a
different column.

To combine a component with a value:

1. Inamaterial channel, click an empty
column.

2. Drag over the value control for the
channel.

Copying and Pasting Materials

The Materials Lab has its own dedicated
clipboard that lets you store materials.
You can have an object in your clipboard,
then enter the Materials Lab and copy a
material without disturbing the contents
of your clipboard.

To copy a material to the Materials
clipboard:

o Click the Copy button below the
Material Preview window.

To paste a material to the Materials
clipboard:

o Click the Paste button below the
Material Preview window.
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Using the Material Preview Area

There are several different ways you can
see the effects of your material on an
object.

To switch preview modes:

o Click the triangle at the bottom of the
material preview and choose an
option from the menu:

Normal displays your object as it looks in
your scene. This is the default view of
your selected object.

Up Close displays a zoomed in view of
your object.

Render With Neutral Sky displays your
object against a plain sky. When disabled,
your preview contains the current sky
settings. This option makes it easier to see
the material without being distracted by
patterns in the sky.

Render With Neutral Ground displays
your object with a plain ground. When
disabled, the ground in your preview has
the same texture as the object.

Current Selection displays the selected
object exactly as it appears in the your
scene.
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Box displays the material applied to a
cube.

Sphere displays the material applied to a
sphere.

Cone displays the material applied to a
cone.

Cylinder displays the material applied to
a cylinder.

Terrain displays the material applied to a
randomly generated terrain object.

Ground displays the material applied to
an infinite plane.

Torus displays the material applied to a
torus object. Torus objects are good for
displaying material properties like
altitude changes, slope and height
changes, and metallicity.

To change the view angle of the
preview area:

o Drag the Preview area in the
direction you want to view it from.

The preview switches to wireframe as
you move it. The angle of the preview
does not affect the angle of the object
in your scene.

S
Material Presets
Material presets are predefined materials.
Presets contain channels values that
simulate a wide variety of commonly

used surfaces. Presets are stored in the
Material Presets Library.

Presets are a great way of understanding
how materials are made. You can open
one of the presets and see what channel
and components were used to create the
final material.

The Material Presets Library can also be
used as a cookbook. Some of the shaders
are organized as lessons that can lead you
through the process of creating
interesting effects. For example, try
opening the Specularity lessons in the
Simple & Fast category.

Using the Preset Materials
Library

The Preset Materials Library contains all
the material presets available in Bryce.
You can place them on your objects
directly and edit them just as you would
any other material.



To add a material from the Preset
Materials Library to an object:

1. Select an object.

2. In the Working window, click the
triangle icon next to the Edit text
button at the top of the Bryce
environment. The Preset Materials
Library appears.

Flerwiber Crold Swies- 17

Use the Preset Materials Library to add
pre-made materials to your object.

or

In the Materials Composer, click the
triangle icon next to the Material
Preview window

3. Click one of the Category names
along the left side of the dialog.

4. Click the thumbnail of the preset you
want to add.

5. Click the OK icon to add the selected
material to your object.
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B
You can also select presets in one
motion by dragging directly to the
desired material preset and releasing
the mouse button. You can also drag
over the category names to change
categories into the category’s presets,
and then release mouse button.
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Adding and Deleting Preset Materials

You can add the material from any object
to the Preset Materials Library. This is a
good way of saving your favorite
materials.

To add a material to the library:

1. Select the object whose material you
want to add to the library.

2. Click the triangle icon next to the
Edit text button at the top of the
Bryce environment. Your selected
object will appear in the preview area
of the Preset Material Library dialog.

The preview area displays the object you
selected.

3. Click a category name. The library
switches to the category you selected.

The new preset will be added to the
category you select.

4. Click the triangle icon at the bottom

right corner of the preview and
choose a view option from the menu.

Normal is the default view of your
selected object.

Up Close displays a close-up of your
object.

Render With Neutral Sky displays
your object with a flat sky instead of
the sky applied to your scene.
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Render With Neutral Ground
displays your object on a flat ground
plane instead of the ground used in
your scene.

Current Selection displays your
object exactly as it appears in your
scene.

Box displays your material applied to
a cube.

Sphere displays your material
applied to a sphere.

Cone displays your material applied
to a cone.

Cylinder displays your material
applied to a cylinder.

Terrain displays your material
applied to a terrain. You might want
to disable Render With Neutral
Ground as terrain materials look
better when placed on a ground plane
with the same material.

Ground displays your material
applied to an infinite plane.

Torus displays your material applied
to a torus object.

Drag the preview area to rotate the
view of your object.
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Hold down the Spacebar and drag
up, down, right, or left to pan the
your object preview.

Hold down Command/Ctrl and drag
in the preview area to zoom in and
out of the preview.

Click the Add button at the bottom of
the dialog. The Add Material dialog
appears.

Enter a name for the new preset in
the Preset Name field.

Enter a description of the preset in
the Description field and click the
OKicon.

The name and description will
appear next to the material preview
whenever the preset is accessed.

e - -~

You can edit the name and description
of any preset at any time simply by
pressing the Tab key or by clicking the
name or description.

e ——

. Click the OK icon. Your preset will be

added to the first available space
within the current category.

To delete a material preset:

1. Click the triangle icon next to the
Edit text button at the top of the
Bryce environment. The Preset
Materials Library appears.

2. Click the preset you want to delete.
or

Hold down Shift and select a
continuous series of presets.

or

Hold down Command/Ctrl and
select a discontinuous set of presets.

3. Click the Delete button at the bottom
of the Preset Materials Library dialog.

Importing and Exporting Preset
Materials
Importing and exporting presets is a

handy way to exchange custom presets
with other users.



To import a preset material file:

1. Click the triangle icon next to the
Edit text button at the top of the
Bryce environment. The Preset
Materials Library appears.

or

In the Materials Lab, click the triangle
icon next to the Material Preview
window.

2. Click the Import button at the
bottom of the Preset Materials
Library dialog. The File Open dialog
appears.

3. Locate the file you want to import
and click Import.

The contents of the file are placed
into the first available space in the
current category.

To export a preset material file:

1. Click the triangle icon next to the
Edit text button at the top of the
Bryce environment. The Preset
Materials Library appears.

2. Select the preset or presets you want
to export.

3. Click the Export button at the
bottom of the Preset Materials
Library dialog. The Save File dialog
appears.

4. Enter a name and location for the file
and click Save.

Animating Materials

Animating materials can add an exciting
new dimension to your materials—time.
Using the Animation controls, you can
interpolate between textures over time or
change the properties of a single texture
over the course of an animation.

The animation tools are a great way of
adding life to your scene. Instead of
creating an animation with simple
motion, you can create subtle effects like
changing a cube from water to ice or
changing the seasons on a mountain.

Refer to “Animating Materials” on
page 385 for complete instructions on
animating materials.

Speeding Up Materials

While there is almost an infinite number
of materials with the added complexity of
creating materials using multiple

components and adding volumes, you
need not use all the features of the lab all
at once.

The more complex your material, the
longer it takes to render so you should
use complexity only where its necessary.

Rendering Transparency, Reflection and
Refraction always require longer
rendering time, but when you add the
complexity of creating transparent,
reflective or refractive volumes, your
rendering time can increase
exponentially. If you find that your scene
is taking too long to render, you may
want to try setting the Transparency,
Reflection and Refraction values to zero.

Additionally, use Full Shading Volume
textures sparingly. This type of material
creates specific types of effects, so you
should limit these materials to specific
areas of your scene. If you spread Full
Shading Volume textures everywhere
throughout your scene, be prepared for a
long wait while the scene renders.
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Textures
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Textures and Materials

The thing that makes Bryce so unique is
its materials. A material can truly bring
any object to life, and textures are the
power behind the material. A material
can make your object shiny, dull, or
transparent, but the textures within that
material are what make it look like wood,
rock. water or clouds.

Textures define the color, pattern or
bumps within a material. A material can
contain up to four textures. These
textures can be used to drive the channels
that make up the material. So, by altering
the make-up or pattern of a texture you
can dramatically alter the appearance of a
material.
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Texture Structure

A Bryce texture can be made up of three
components. These components
contribute the raw patterns or textures
within a texture. Each component can
then contribute one of three types of
output to the final texture. These outputs
are then combined to create the final
texture.

Component 1

CIAG

COMBINED

Component 2 Component 3

Result

FINAL TEXTURE

This diagram shows the structure of a texture.

Within each component is a combination
of colors and noise that create a pattern.
Noise is what creates the pattern within
the texture. The shape of the noise inside
a component is determined by the phase
of the noise and the filter applied to it.
The filter can create coherent patterns,
random spots or anything in between.
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Refer to “Noise” on page 250, “Phase” on
page 257 and “Filtering” on page 261 for
more on Noise, Phase and Filtering.
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This diagram shows the structure of a texture
including the structure of a component.

A component can contribute one of three
types of output to the final texture: Color
output, which determine the colorsin a
texture, Alpha output, which determines
the bright and dark areas in a texture, and
Bump output, which determines the size
and pattern of bumps in the texture.

The component can contribute any
combination of outputs. So you can have
a final texture that contains Color output,
Alpha output, and Bump output, or it
can have all Color output or all Bump, or
any combination of the three.

The outputs in a texture are used by the
material, so the type of output you have
in a texture depends entirely on how you
want to use the texture in the material.
For example, if you're using the texture as
a bump map for the Bump Height
channel in a material, you’d probably
want all the components to contribute
only Bump output.

A texture can contain up to three
components. It can be made up of all
three components or just one, depending
on the type of texture you want to create.
The more components you use, the more
complex your texture.

Components are combined using Blend
Modes. These modes can create a wide
range of effects.

Component 1 Component 2

\ﬁLEND MODE

COMBINED

The way components are combined to create the
final texture is determined by the Blend Mode
you select.



Components are combined differently
depending on how many you use. If you
use one or two they are combined
according to the blend method you select.
If you use three, the first two components
are combined, and the resulting texture is
then combined with the third component
to create the final texture.

Component 1

GG

COMBINED

|

RESULT

|

FINAL TEXTURE

Component 2 Component 3

When you use three components, the first two
components (C1 and C2) combine to create a
hybrid texture which is then combined with the
third component (C3) to create the final texture.
So they’re combined using the formula
(C1+C2)+C3=FINAL.

The texture components are combined
together to form the final Combination
texture. The final texture can have its own
color scheme, noise, phase or filter. Any
changes you make to the combination

texture changes the final texture. These
types of operations are called Global
changes. Refer to “Global Changes” on
page 270 for more on global changes.

Changes
to this
texture
are global

When the components are combined they
produce the combination texture. This texture
can have its own color scheme, noise, phase or
filter. These operations are called Global
changes.

The end result of the Global changes is
the final texture which can then be used
in the Materials lab to create a material.

Components vs. Texture Components

Before you get any deeper into the
discussion of texture structure you
should understand a little terminology.

A texture is a part of a material. It can be

used to drive any of the material’s
channels. When you use a texture in a
materials it’s called a texture component.

The texture itself also has components. It
can be made up of up to three
components that determine the look an
color of the texture. The components that
make up a texture are called components.
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The difference between components and texture
components may be a bit confusing. Just
remember that when you're talking about a
texture, you're dealing with components. When
you're working with materials, you're using
texture components.
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Understanding Component
Structure

A texture can have up to three
components. When combined, the
components create the final texture. A
component consists of noise and color.

A component can have up to three colors.
The combined texture can also have a
different set of three colors which is
added to the colors from the
components. In total your texture can
contain up to twelve colors.

The noise in a component is made of base
Noise which is modified by the Phase,
which controls the complexity of the
noise, and the Filter, which determines
the shape or pattern of the noise.
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A component consists of noise and color. The
Noise is modified by the Phase and the Filter.
Each component can then produce Color, Alpha
or Bump output.
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Components and Output

A component’s output type determines
what type of information it’s going to
contribute to the final texture. The
Output type also determines the
component’s structure. A component
that does not have a Color output won't
contain any color information. The same
is true for the two other types of output.
If there’s no Alpha or Bump output
there’s no Alpha or Bump information in
the component.

Component Output

TR R LR ETE i 1

The main purpose of creating a
component is to use it as part of a
material which will then be applied to an
object. How and what a texture
contributes to a material is determined by
the type of output it produces.

A texture can produce three different
types of output: Color, Alpha and Bump.

When you apply a texture to a material,
you can see the output types in the
Texture Component Window in the
Materials Lab.

Color output Alpha output Bump output

The three boxes in the Texture Component
Window in the Materials Lab represent the three
output types available for a texture.

If a texture does not produce a particular output
the box appears gray.

Refer to “Texture Components” on
page 213 for more on using textures in
materials.



In the Deep Texture Editor, the output
type for a component is indicated by the
three output buttons along the left side of
the Component Window.

Color output

Alpha output

The three buttons along the right side of the
Component window indicate the output type for
a component. If a button appears depressed, it
means that the component produces the selected
output type.

Assigning Output Types

A texture can produce all three output
types or only one. The number of output
types for the final texture depends on the
output you assign to the components. A
component can produce one or all three
types of outputs.

You can assign more than one
component to the same output type. If
you do have more than one component

with the same output type, the output
information will be blended to produce a
final output.

For example, if you have two components
that produce Color output, when you
combine them the colors from both
components are blended together and the
result is applied to the final texture.

In order to produce an output type, a
final texture must contain at least one
component that produces the type of
output you want. For example, if you
want your final texture to contain color
output, at least one of its components
must produce color output.

Each output type contributes something
different to the final material.

Color Output

Color output is used by the color
channels of a material. The color values
you assign to a textures's components are
combined to form a final texture. The
combined values are then used to drive
the Diffuse, Ambient, Specularity,
Specular Halo, or Transparency color
channels. Refer to “Understanding
Surface Material Channels” on page 194
for more on these channels.

The colors in a texture usually appear in
the form of a pattern or grain. When you
assign the texture to a material, this
pattern appears in the final material.

Original Texture

Material containing texture

The texture in this example was applied to the
Diffuse color and Ambient Color channels of the
object’s material. You can see how the color
pattern in the texture appears in the material.

To assign Color output to a texture:
1. Display the Deep Texture Editor.

2. Inthe desired component window,
click the C button on the right side of
the component window.
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Alpha Output

Alpha output is used by the various
Intensity and Optic channels of the
material. When a texture’s Alpha output
is assigned to a material, it’s used to either
to determine an effect’s intensity or as a
guide map for combining multiple
textures.

When there is only one texture
component in a material channel, the
texture’s Alpha output is usually used to
determine the intensity of a channel
effect. For example, if you assign a texture
to the Diffuse channel, the texture’s Alpha
output is used to determine which areas
are the most diffuse and which are the
least diffuse.

Original Texture

Material containing texture

The texture in this example was applied to the
Diffuse channel of the object’s material. You can
see how the alpha pattern in the texture controls
the diffuse intensity on the object’s surface.
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1. Display the Deep Texture Editor.

2. In the desired component window,
click the A button on the right side of
the component window.

Bump Output

The Bump output is used only by the
Bump Height material channel to
determine the pattern and height of the
bumps in a material.

Original Texture

Material containing texture

The texture in this example was applied to the
Bump Height channel of the object’s material.
You can see how the bump output in the texture
controls the pattern of bumps on the object’s
surface.

To assign Bump output to a texture:
1. Display the Deep Texture Editor.

2. In the desired component window,
click the B button on the right side of
the component window.
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Component Elements

A texture is made up of components.
Each of those components can contain
several elements that determine the color,
pattern, grain or bumps in the
component.

The Component window

You can have up to three components in
your texture. As you activate
components, a component window
becomes active. Each window displays a
preview of the component elements.



Reset Component Open Filtering palette

Open Noise palette
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Component

Open P
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Randomize
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The Component window displays the selected
component and its current attributes.

The three buttons on the Component
window let you access the Noise palette,
the Filtering palette and the Phase palette.
The buttons along the right side of the
window indicate the type of output
produced by the component.

To activate a component:
1. Display the Deep Texture Editor.

2. Click the component selector in the
top-left corner of the editor.

The component selector lets you pick how many
components you want to use to build your
texture.

The selector lets you choose from 1,
2, or 3 components.

Color

The colors in a component determine its
color scheme. Each component can have
up to three colors. Colors can be chosen

using the color picker or the Color dialog.

The color in a component is affected by
the noise, phase and filter. You can create
some very interesting patterns of color by
modifying the noise. The color pattern
created by the changes in the noise is
applied directly to the final texture. So
even if Color is the only output type for
the component you'll still see a pattern in
your final texture.

When the Color Output is selected for a
component, only the color information is
combined with the other components.
Also, when you apply the texture to a
material, the colors in the component
contribute to the colors used in the Color
channels of the material.

There are two color models you can use
to create colors in the components: RGB
and HLS. RGB combines red, green and
blue to create color. HLS combines Hue,
Lightness and Saturation values to create
color. The method you choose depends
on the final output of your Bryce 3D
scene. RGB usually works best for most
types of output.

‘__. _-—,_._.__ — .- >
If the Color output is not active for a
component, changing the colors or
Color Blending Modes has no effect.

‘__. _-—‘_q_.__ >
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To activate Color output for a
component:

1. Display the Deep Texture Editor.

2. Inthe desired component window,

click the C button.

—

The three buttons along the right side of the
component window display the component’s
output type.

An output type is active when the
button appears light gray.
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To choose colors for a component:
1. Display the Deep Texture Editor.

2. In the desired component window,
make sure the C button is selected.

3. Click one of the color indicators
along the left side of the component
window and choose a color from the
palette.

The three color indicators along the left side of
the window display the colors used in the
component.

To mix colors for a component:
1. Display the Deep Texture Editor.

2. In the desired component window,
make sure the C button is selected.

3.

Option/Alt-click the one of the color
indicators along the left side of the
component window. The Color
dialog appears.

The Color dialog lets you mix a color to use in
the component by entering values or adjusting
the color sliders.

4,

Choose a color model by clicking one
of the buttons along the bottom of
the dialog.

Enter color values or adjust the
sliders to mix a new color.

Click the OK icon.



Color Blending Modes

There are several blending modes you can
use to create a color scheme.

To choose a Color Blending mode:
1. Display the Deep Texture Editor.

2. In the desired component window,
make sure the C button is active.

3. Click the triangle icon in the lower
left corner of the window and choose
a mode from the menu.
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The pop-up lists all the Color Blending Modes
available in the Deep Texture Editor.

None
No blending is applied.

Red or Hue

When the RGB model is used, this mode
outputs only red color values. When the
HLS model is used, only Hue values are

output.

_.-"-. - _-E_-_-_\_ 2o _-,
This mode and the Green or Light, and
Blue or Saturation mode are available
so that you can separate color values
among the components. For example,
you could set each component to
output one of the different color values.

o e —

Green or Light

When the RGB model is used, this mode
outputs only green color values. When
the HLS model is used, only Lightness
values are output.

Blue or Saturation

When the RGB model is used, this mode
outputs only blue color values. When the
HLS model is used, only Saturation
values are output.

Spline Interpol

This mode creates a blend between all the |
colors in the component. k

This is what a color blend looks like using Spline
Interpol.

Linear Interpol 2

This mode creates a linear blend between
the first two colors selected for the
component.

This is what a color blend looks like using Linear
Interpol 2.
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i Linear Interpol 3 Earth Map values are applied next and colors with
the highest values (i.e. bright colors) are

all the colors in the component. according to the contours of the applied closest to the center.

component’s bump map. The three colors
you selected for the component are
applied to the middle range of the bump
map. Blue is applied to the lowest bump
values and white is applied to the highest
values to simulate polar caps. Earth Map
is excellent for creating planets.

r‘j This mode creates a linear blend between In this mode extra colors are generated

This is what a color blend looks like using

This is what a color blend looks like using Linear Banded.
Interpol 3.

. Perturbed
Randomized

In this mode colors are applied in

In this mode the three colors are blended irregular patterns.

and then applied randomly throughout
the component.

This is what a color blend looks like using Earth
Map.

Banded

In this mode colors are applied in bands.
The bands are determines by color values.
Colors with the lowest value (i.e. dark L oo

. This is what a color blend looks like usin
colors) are applied to the bands furthest Perltulrbve\:ld. 1@ using

This is what a color blend looks like using from the center, colors with middle range
Randomized.
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Interferences

In this mode the red, green and blue
values of the first color in the component
are used to create a repeating pattern
around the contours of the component’s
noise.

This is what a color blend looks like using
Interferences.

Interpol + Interferences

This mode is a combination of Linear
Interpolation and Interferences.

This is what a color blend looks like using
Interpol + Interferences.

Altitude

In this mode a white layer is added above
the colors at high altitudes. Any portion
of the object below ground is
automatically colored blue. Altitudes are
based on the object’s height.

This is what a color blend looks like using
Altitude.

Spline with Snow

This mode performs a spline
interpolation of the colors in the
component, but adds a white layer above
the colors at high altitudes. Altitudes are
based on the object’s height.

This is what a color blend looks like using Spline
with Snow.

Slope

In this mode the three colors are applied
to the object depending on its slope.

This is what a color blend looks like using Slope.

Orient

In this mode the three colors are applied
to the object according to its east-west
orientation.

This is what a color blend looks like using
Orient.
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Noise

Noise is the basis of all the textures. It is
the background turbulence that creates
the basis for texture patterns.

In audio terms you can think of noise as
the background static that you hear on
old recordings. Sound is layered on top of
this noise to create music. Like in audio,
you layer other functions on top of the
noise in your texture to create the final
pattern or look of your texture.

There are two ways of creating noise: the
Noise palette or the Noise Editor.

The Noise palette can increase or decrease
the amount of noise in any of the texture
components. However, using the palette,
you can only edit the existing noise.

Component Indicator

Open Noise
Editor

Noise slider

The Noise palette lets you increase or decrease
the amount of noise in a component.
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To display the Noise palette:
1. Display the Deep Texture Editor.

2. Click the Noise button at the bottom
of the editor. The Noise palette
appears.

#7 Phase

f[: Noise @ Filter

The three buttons at the bottom of the Deep
Texture Editor let you display the Noise, Phase
and Filter palettes.

or

+ Click the Noise button in the
top-left corner of on any of the
component windows.

The three buttons along the outside of a
component window let you display the Noise,
Phase and Filter palettes.

The Noise Editor is much more powerful
than the Noise palette. It contains
controls for creating noise from scratch.

Octaves Noise Mode

Noise Type Noise Preview

No. of Dimensions

Frequency Controls

Direction Controls

The Noise Editor lets you create noise and adjust
its properties.

To display the Noise Editor:
1. Display the Deep Texture Editor.

2. Click the Noise button at the bottom
of the editor. The Noise palette
appears.



3. Click the top-left corner of the
palette. The corner turns green as you
ppass your cursor over it.

The top-left corner of the Noise palette lets you
display the Noise Editor.

Creating Noise

The Noise editor is the tool you'll use to
create noise with a component or
combined texture. The noise creation
process involves several steps:

*  Choose the number of dimensions in
the noise.

» Choose a Noise Type. This will give
the basis for creating a noise pattern
or grain.

* Adjust the frequency of the noise.
* Adjust the orientation of the noise.

+  Apply a modifier to your noise, by
choosing a Noise Mode.
The following sections describe the

various parts of the editor and how to use
them in the noise creation process.

Noise Dimensions

Texture in Bryce can exist in 3D so your
noise can have up to three dimensions.
Noise dimensions determine which axes
you can use to adjust the orientation and
frequency of the noise.

-r'__. = _-_hh_l___\_ e i
Its easier to see the number of
dimensions for your noise if you use a
cube in the Noise Preview.

o _-_'-'-l.q____ _—
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1D Noise 2D Noise 3D Noise

These three examples show the difference
between 1D, 2D and 3D noise.

To choose the number of dimensions
for your noise:

1. Display the Deep Texture Editor.
2. Display the Noise Editor.

3. Click one of the dimension buttons at
the bottom of the editor.

The three buttons at the bottom of the editor let
you choose between 1D, 2D and 3D noise.

Noise Type

There are 27 different types of noise
available in the Noise Editor. Random
noise is the default (RND).

Each noise type provides you with a
different basic pattern to start your
texture. Some are more linear or
geometrical while others are more
random.

More complex noise types require more
rendering time. The time it takes to
render the preview is a good indication of
how long the final texture will take to
render.
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You should use the more complex noise
types cautiously.
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These are examples of the some of the types of
noise available.

The best way of choosing a noise type is
to apply a few to your component and see
how they look. Remember that this noise
is only the basis of the texture. You can
still edit this noise using the other
controls in the editor, so don’t discard a
noise type because its not perfect. The
other controls can help you fine-tune the
noise.
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To choose a noise type:
1. Display the Deep Texture Editor.
2. Display the Noise Editor.

3. Click the type field at the top of the
editor and choose a noise type from
the menu.

Type | RND Continuous

The Type area at the top of the editor displays
the name of the currently selected noise type.

Noise Frequency

Noise Frequency determines how often
the pattern within a texture repeats.
Frequency is like scaling the noise. Higher
frequencies decrease the scale of the noise
S0 you can see the pattern more often.
Lower frequencies increase the scale of
the noise so the pattern repeats less often.

You can change noise frequency using the
Frequency fields. The fields let you enter
numerical values to adjust the noise
frequency along the X, Y or Z axis. You
can also adjust the values using the scroll
arrows.

The number of dimensions in the noise
determines how many axes you can use to
adjust the frequency. For 1D noise you
can only use the X axis. With 2D noise
you can use both the X and Y axes. For
3D noise you can use all the axes.

If you try to adjust the Z axis frequency
for a 2D noise, your changes will have no
effect.

The Frequency fields let you enter values to
precisely control the noise frequency along the X,
Y or Z axes.



Adjusting the frequency can radically
change the look of your noise. If you
adjust the frequency in separate axes, you
can achieve even more interesting effects.

- =

Frequency Frequency Frequency
=10 =50 =100

Noise frequency settings control the repetition of
patterns in a component.

Frequency X=10 Y=80 Z= 10

In this example, the noise frequency was
changed in only the Y axis.

To change the frequency of noise:
1. Display the Deep Texture Editor.
2. Display the Noise Editor.

3. Drag over the X field in the
Frequency area to set the noise
frequency in the X axis.

Drag left to decrease the value or
right to increase it.

4. Dragoverthe field in the Frequency
area to set the noise frequency in the
Y axis.

5. Drag over the Z field in the
Frequency area to set the noise
frequency in the Z axis.

— _-‘-l—--_‘__l___‘_ i

You can also drag over the scroll
arrows to speed up the increments.

— _-‘-l—--_-__‘___‘_ i

Noise Orientation

Noise Orientation controls the direction
of the noise. Noise has a grain or a fixed
up and down, when you adjust the
orientation you change how the noise is
laid out within the texture.

When you apply a texture, the direction
of the noise within the texture remains
constant regardless of the orientation of
the object.

Since noise can exist in three dimensions,
you adjust the direction of the noise in
the X, Y, or Z axis.

The number of dimensions in the noise
determines how many axes you can use to
adjust the orientation. For 1D noise you
can only use the X axis. With 2D noise
you can use both the X and Y axes. For
3D noise you can use all the axes.

You can edit the noise orientation using
the Direction numerical fields.The fields
let you enter precise angles for noise
orientation. You can also use the scroll
arrows to set the angle in increments.

The Direction fields let you enter rotation angles
to precisely control the noise direction along the
X, Y or Z axes.
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Changing noise orientation can
dramatically change the look of your
noise. You'll see just how different your
noise can look when you rotate it along a
single axis.

Rotation in XYZ

Rotation in Rotation in
X XY

Noise orientation controls the direction of the
noise.

To change the orientation of noise:
1. Display the Deep Texture Editor.
2. Display the Noise Editor.

3. Drag over the XY field in the
Direction area to set the noise angle
in the X and Y axes.

Drag left to decrease the value or
right to increase it.

4. Drag over the YZ field in the
Direction area to set the noise angle
inthe Y and Z axes.
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You can also drag over the scrow
arrows to speed up the increments.
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Noise Octaves

Noise octaves are like musical octaves. In
a musical scale, if you play F and then F
an octave down, you're playing the same
note, only it sounds lower. If you play
both notes at the same time, the sound is
more complex than if you played only
one note. The same is true of noise. When
you add an octave to noise it becomes
more complex but the type of noise
remains the same.

< =

2 Octaves

1 Octave 3 Octaves

These examples use RND Continuous noise and
RND Linear noise to show the effects of
increasing octaves.

- _-_'-'"-l--—___ =l
Increasing the octaves adds
processing time to the component.
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To change the number of octaves:
1. Display the Deep Texture Editor.
2. Display the Noise Editor.

3. Drag over the octaves field at the top
of the editor.

|

The octaves field at the top of the editor displays
the number of octaves currently applied to the
noise.

Noise Modes

Noise modes modify the octaves of a
noise. As you add complexity by
increasing the octaves, the Noise Modes
let you modify the additional noise so
that it produces different effects.

Many of the Noise modes use dark and
light values to modify the existing noise.
Also, you may not see the effects of the
modes if the Octave is set to 0.

To choose a Noise Mode:
1. Display the Deep Texture Editor.
2. Display the Noise Editor.



3. Click the Mode field at the top of the
editor and choose a mode from the
menu.

There are thirteen noise modes available:

Standard

This mode adds a new octave to the noise
at half the frequency and twice the
amplitude. This is the default mode.

In this example, Standard mode was applied to
RND Continuous noise.

Irregular

This mode adds a new octave to the noise
at half the frequency and twice the
amplitude. However, in this mode higher
frequency noise is modified more that the
rest. The end result is that more detail is
added to the noise.

In this example, Irregular mode was applied to
RND Continuous noise.

More Irregular

This mode works exactly like Irregular
except that this mode is more intense.

In this example, More Irregular mode was
applied to RND Continuous noise.

Maximum

This mode uses the only the highest
values, or lightest areas, to produce the
modified noise.

In this example, Maximum mode was applied to
RND Continuous noise.

Mulitfractal

In this mode lighter areas create higher
contrast noise.

In this example, Mulitfractal mode was applied
to RND Continuous noise.

With Rotation

In this mode each additional octave is
rotated. With Rotation mode it’s easier to
see linear noise types.

In this example, With Rotation mode was
applied to RND Linear noise.
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Minimum

This mode uses only the lowest values, or
darkest areas, to produce the modified
noise.

L
—

In this example, Minimum mode was applied to
RND Continuous noise.

Multiply

In this mode all the values in the noise are
multiplied together. The results is a
darker noise.

In this example, Multiply mode was applied to
RND Continuous noise.
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Difference

In this mode all the values in the noise are
evaluated. All the values that are equal
create black areas. When the values are
different, the lower value becomes darker.
The more octaves you have in the noise,
the darker the modified noise. Difference
works even at 0 octaves.

In this example, Difference mode was applied to
RND Continuous noise.

Minimum 90

This mode repeats the noise at a 90° angle
from its original orientation and
combines the original and copy using
only the highest values. This mode is
good for creating woven patterns.

In this example, Minimum 90 mode was applied
to RND Continuous noise.

Maximum 90

This mode repeats the noise at a 90° angle
from its original orientation and
combines the original and copy using
only the lowest values.

In this example, Maximum mode was applied to
RND Continuous noise.

Auto-phased

This mode automatically introduces
phase shifts into the noise.

E
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In this example, Auto-phased mode was applied
to RND Continuous noise.




Displaced Max

This mode creates a copy of the noise and
displaces noise by a small amount and
then lightens any areas where the two
overlap. This mode is good for creating
stone textures.

In this example, Displaced Max mode was
applied to RND Continuous noise.

Phase

Phase introduces turbulence into your
noise. The phase displaces the grain or
patterns within the your noise. When you
design the phase, you're creating a
displacement map along which the noise
will be modified.

You can control how the phase interacts
with your noise using the Phase palette.
You can design your phase using the
Phase Editor.

The Phase palette controls the amplitude.
The phase amplitude controls the
intensity of the displacement. As the
amplitude is increased, there is more
interference with the original noise.

Open Phase Editor
Component Indicator

|
Amplitude Slider

The Phase palette lets you increase or decrease
the amplitude of the phase in a component.

You won't have to increase the amplitude
very much before you start seeing the
phase pattern you designed interfere with
the existing noise. In fact, it’s probably a
good idea to keep the phase amplitude
low so that the phase pattern doesn’t
overwhelm the noise.

Original Noise

Phase=50 Phase=250

This graph shows how the phase interacts with
the noise at different amplitude settings.
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To display the Phase palette:

1. Display the Deep Texture Editor.

2. Click the Phase button at the bottom
of the editor. The Phase palette
appears.

& Noise £ Filter

-

The three buttons at the bottom of the Deep
Texture Editor let you display the Noise, Phase
and Filter palettes.

or

+  Click the Phase button in the
bottom-right corner of any of the
component windows.

The three buttons along the outside of a
component window let you display the Noise,
Phase and Filter palettes.

The Phase Editor looks a lot like the
Noise Editor. It has the same type of tools
and they work exactly like they do in the
Noise Editor. The difference is that you're
using noise patterns, orientations,
frequencies and modes to design how the
basic Noise will be displaced.
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Using the Phase Editor you can perform
several functions:

* Create 1D, 2D, or 3D phase

»  Change the type of noise

»  Change the frequency of the phase

+ Change the orientation of the phase
+  Change the noise octaves

+ Change the noise modulations.

—Octaves

Noise Mode

Noise T
olse Type Phase Preview

Frequency

Number of Dimensions Controls

Direction Controls

The Phase Editor lets you create noise to use as
phase.

While the Phase Editor lets you create the
noise pattern or grain within the phase,
the Phase palette controls how that phase
is applied to the component or the
combined texture.

To display the Phase Editor:
1. Display the Deep Texture Editor.
2. Click the Phase button at the bottom

of the editor. The Phase palette
appears.

3. Click the top left corner of the
palette. The corner turns green as you
pass your cursor over it.

The top left corner of the Phase palette lets you
display the Phase Editor.

Creating Phase

Phase is designed using the Phase Editor.
The phase creation process involves
several steps:



*  Choose the number of dimensions in
the phase.

+ Choose a noise type. This gives the
basis for creating a phase pattern or
grain.

+ Adjust the frequency of the noise.
» Adjust the orientation of the noise.

*  Apply a modifier to the noise by
choosing a Noise Mode.

You'll notice that many of the steps for
creating the phase are the same as those
for creating noise. That’s because you are
creating noise. The difference is that
instead of applying the noise to the
texture, the noise you create for the phase
is used to displace the existing noise.

The following sections describe the
various parts of the editor and how to use
them in the noise creation process.

Phase Dimensions

Just like noise, you can set the dimensions
of the phase. The number of dimensions
determines which noise axes will be
displaced when you apply the phase. For
example, if you apply a one-dimensional
phase to a three- dimensional noise, only
the X axis of the noise will be displaced.

- e

—
Its easier to see the number of
dimensions for your phase if you use a
cube in the Phase Preview.
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Combined Texture

3D Noise 1D Phase

In this example, a 1D phase was applied to a 3D
noise.

To choose the number of dimensions
for your phase:

1. Display the Deep Texture Editor.
2. Display the Phase Editor.

3. Click one of the dimension buttons at
the bottom of the editor.

The three buttons at the bottom of the editor let
you choose between 1D, 2D and 3D phase.

Phase Noise Type

There are 27 types of noise available in
the Phase Editor. Random Noise is the
default (RND).

Each noise type provides you with a
different basic pattern for the phase. The
noise types available in the Phase Editor
are the same as those in the Noise Editor,
S0 you can refer to “Noise Type” on

page 251 for more on noise types.

Phase Frequency

Phase frequency determines how often
the pattern within the noise repeats.
Frequency is like scaling the noise. Higher
frequencies decrease the scale of the noise
S0 you can see the pattern more often.
Lower frequencies increase the scale of
the noise so the pattern repeats less often.

You can change phase noise frequency

using the Frequency numerical fields.
The fields let you enter numerical values
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to adjust the noise frequency along the X,
Y or Z axis. You can also adjust the values
using the scroll arrows.

The number of dimensions in the phase
determines how many axes you can use to
adjust the noise frequency. For 1D phase
you can only use the X axis. With 2D
phase you can use both the X and Y axes.
For 3D phase you can use all the axes.

Adjusting the frequency of the Phase
noise disproportionately can have some
very interesting effects on your noise.

Frequency X=10 Y=80 Z= 10

In this example, the phase noise frequency was
changed in only the Y axis and then applied to
3D noise.
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To change the frequency of phase
noise:

1. Display the Deep Texture Editor.
2. Display the Phase Editor.

3. Drag over the X field in the
Frequency area to set the phase noise
frequency in the X axis.

The Frequency fields let you enter values to
precisely control the noise frequency along the X,
Y or Z axes.

Drag left to decrease the value or
right to increase it.

4. Dragoverthe field in the Frequency
area to set the Phase noise frequency
in the Y axis.

5. Drag over the Z field in the
Frequency area to set the Phase noise
frequency in the Z axis.

_..-"- = _-‘---.-_l___-_ E o
You can also drag over the scroll
arrows to speed up the increments.
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Phase Noise Orientation

Phase noise orientation controls the
direction of the noise within the phase.

The number of dimensions in the phase
determines how many axes you can use to
adjust the orientation.

You can edit the noise orientation using
the Direction numerical fields.The fields
let you enter precise angles for noise
orientation. You can also use the scroll
arrows to set the angle in increments.

The Direction fields let you enter rotation angles
to precisely control the noise direction along the
X, Y or Z axes.



Like frequency, changing the orientation
of the phase noise in only one or two axes
can create some very interesting results.

In this example, the phase noise orientation was
changed in only the Y axis and then applied to
3D noise.

To change the orientation of phase
noise:

1. Display the Deep Texture Editor.
2. Display the Phase Editor.

3. Drag over the XY field in the
Direction area to set the noise angle
in the X and Y axes.

Drag left to decrease the value or
right to increase it.

4. Drag over the YZ field in the
Direction area to set the noise angle
in the Y and Z axes.

- S o

B
You can also drag over the scroll
arrows to speed up the increments.
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Phase Noise Octaves

Phase noise octaves work exactly like the
noise octaves. They introduce an extra
level of complexity to the noise. Refer to
“Noise Octaves” on page 254 for more on
octaves.

Phase Noise Modes

Phase noise modes work exactly like the
noise modes. They modify the octaves of
a noise. Refer to “Noise Modes” on

page 254 for more on octaves.

Filtering

The filter you apply to the noise in a
component can change the entire look of
the noise. The filter refines the noise so
that it has more or less detail, increases its
contrast, applies it only at high altitude or
changes its spatial orientation. Whatever
the change, the filter has a profound
effect on the final look of your texture.

Filters are expressed as equations with
variables. When the equation is applied
to the noise, it changes some aspect of the

noise. You can control how the equation
affects the noise by changing the values of
the variables.

The filter only affects the noise. The
phase cannot be altered using a filter. The
phase is blended with the noise.

Filters are edited using the Filtering
palette. The palette displays the current
filter and provides tools for editing the
filter graph.

Component Indicator

Filtering Equation Filtering graph

“ Filter

Mone

Rest button Filter Variables

The Filtering palette displays the current filter
and provides tools for editing it.
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To display the Filtering palette:
1. Display the Deep Texture Editor.

2. Click the Filtering button at the
bottom of the editor.

#" Noise ﬂ[ﬁ Filter

The three buttons at the bottom of the Deep
Texture Editor let you display the Noise, Phase
and Filter palettes.

# PHase

or

+  Click the Filtering button in the
top right corner of any of the
component windows.

The three buttons along the outside of a
component window let you display the Noise,
Phase and Filter palettes.

Editing the Filter

Filters are equations which have
variables. Each equation can have up to
three variables labeled a, b and c. The
values for each variable are displayed at
the bottom of the palette. Generally, a
controls the intensity of the filter effect
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while b controls the overall height. In
some filters a and b may stand for other
things.

There are two ways you can adjust a filter:
by changing the variable values or by
changing the shape of the graph (which
automatically changes the variable
values). The method you use depends on
how much you know about a particular
filter. If you're not sure what the filter
does, change the graph—it’s a much
more intuitive way of working.

To edit the Filtering graph:
1. Display the Filtering palette.

2. Drag over the Filtering graph area.
The shape of the graph changes as
you drag.

The graph area of the Filtering palette lets you
interactively adjust the filtering effect.

Notice that the variables also changes
as you move the graph.

+ Dragging horizontally changes
the value of a.

+ Dragging vertically changes the
value of b.

To change variable values:
1. Display the Filtering palette.

2. Drag over the variable field you want
to change. Drag left to reduce the
value or right to increase it.

The shape of the graph changes as you
adjust the values.

Choosing a Filter

Each filter available in the Filtering
palette offers something unique. The best
way of choosing which filter you want to
use is to apply it to a component and see
what happens.

To choose a filter:
1. Display the Deep Texture Editor.
2. Display the Filtering palette.

3. Click the Filtering Equation area and
choose a filter from the menu.



There are fourteen filters available. The
following sections describe the filters and
gives you some idea of how to edit them.

None

This option deactivates the filter. No
filtering is applied to the component.

Quantize

This filter works like a Posterize effect.
When its applied, gray values jump from
one value to the next, creating a blocky
stair-step type of effect.

In this filter a and b control the contrast
and height, while ¢ controls the number
of levels between white and black.

RND Contmuous
Noise Noise + Quantize

RND Continuous

In this example, Quantize was applied to RND
Continuous noise.

Saw Wave

When the graph for this filter has only a
small curve, it acts like a contrast filter. As
it approaches the height limits (set by b),
it bounces back on itself. This creates
high-contrast breaks in the noise.

For color output use this filter to get areas
of high-contrast alternating color.

When you set the value of a to a high
number you'll get areas with a larger
amount of noise.

In thls example, Saw Wave was applied to RND
Continuous noise.

Sine Wave—Sin (aX) + b

This filter creates noise that appears as
large number of lines that are oriented in
the same direction. Use this filter to
generate wood grains.

The a variable controls the number of
lines. Higher values create a better effect.

In this example, Sine Wave was applied to RND
Continuous noise.

Absolute—Abs(aX + b)

This filter works like a Difference effect.
When it’s applied, you'll get more light
areas in your noise and a higher level of
detail in a bump map.

To get additional bump information
using this filter, setato 2 and b to -1.

In this example, Absolute was applied to RND
Continuous noise.
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XPower—(X PWR a) +b

This filter smooths out the darkest areas
of your noise. However it has less effect
on lighter areas and no effect on white.

In this example, XPower was applied to RND
Continuous noise.

Gaussian—(a(X + b))

This filter smooths out darker areas of
your noise and makes lighter areas
noisier. White areas become the noisiest.

In this example, Gaussian was applied to RND
Continuous noise.
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ClipaX+b

Clip is probably the filter you'll use most.
It’s a contrast filter.

The a variable controls the contrast and b
controls the overall brightness.

For a low contrast effect make the wave in
the graph smaller. Decrease the value of a
to reduce the size of the wave and
increase b to move the wave up. Using
this wave, all the values will be expressed
as mid-gray.

For a high contrast effect, adjust the wave
so that it hits both the top and bottom
edges of the preview. Increase the value of
a and make b negative to move the curve
down.

To invert the colors in your noise, make a
negative and increase b.

In this example, different levels of Clip were
applied to RND Continuous noise.

Altitude Minus Slope—Xb + a
(Altitude-Slope)

This filter applies noise only at certain
combinations of slope and altitude.
When a is positive and b is negative, noise
is applied at high altitudes and on flat
surfaces.



When a is negative and b is positive, noise
is applied at low altitudes and on steep
slopes.
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The Altitude Minus Slope filter works
on the slope and altitude of an object
in World Space.
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In this example, Altitude Minus Slope was
applied to RND Continuous noise and then to
objects in a scene.

Slope—X(a * Slope + b)

This filter applies noise based on an
object’s slope. Slope can range anywhere
from flat and horizontal to steep and
vertical. This is an excellent filter to use if
you want to isolate a texture to vertical
cliffs or flat surfaces.

In this filter a determines the steepness of
the noise (-4 is flat, 4 is vertical). The b
variable controls the starting point of the
transition.

+ To place noise on vertical surfaces
make a=4 and b=2.

* To place noise on flat surfaces make
a=-4 and b=1.5.

_..-'"- _-‘-l—--_.___-_‘_ R o
The Slope filter works on the slope of
an object in World Space.
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In this example, Slope was applied to RND
Continuous noise and then to objects in a scene.

Altitude—X(a* Altitude + b)

This filter modulates the scale of the noise
according to an object’s altitude.

In this filter a determines how fast the
noise is scaled by altitude. A lower value
creates a gradual transition, while higher
values create sharper transitions.

To apply noise at higher altitudes make
sure a is positive. At high altitudes b
controls the transition. The higher the
transition, the lower the number. So, at
high altitudes b should be a negative
number.

To apply noise at lower altitude, reverse

the variables so that a is negative and b is
positive.
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The Altitude filter works on the altitude
of an object in World Space.

In this example, Altitude was applied to RND
Continuous noise and then to objects in a scene.
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Orientation—X(a * Orientation + b)

This filter applies noise based on an
object’s east-west orientation.

In this example, Orientation was applied to
RND Continuous noise and then to objects in a
scene.

Smooth Clip

This filter works exactly like the Clip
filter. It’s also a contrast filter, except that
this filter smooths out the transitions
between darks and grays.

The a variable controls the contrast and b
controls the overall brightness.

In this example, Smooth Clip was applied to
RND Continuous noise.

Snow Puddles

This filter turns noise into snow patches.
Snow is applied according to an object’s
slope and altitude.

The a variable controls how much the
noise interferes with the smoothness of
the snow. When a=0 the noise doesn’t
interfere at all so the snow is perfectly
smooth. When the a value is higher, the
snow starts looking like the noise.

The b variable shifts the altitude or snow
level. It sets where the snow begins.



The c variable controls how steep an
object has to be before the snow appears
on its surface. The higher the number, the
flatter an object has to be before snow
appears on its surface.

In this example, Snow Puddles was applied to
RND Continuous noise and then to objects in a
scene.
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Combining Components

The Deep Texture Editor gives you
unparalleled control over the look and
feel of each one of the components that
make up a texture, but the control doesn’t
stop there. The Deep Texture Editor also
lets you control how those components
are combined to create the final texture.

Blend Modes

Components are combined using Blend
modes. These modes are filters applied to
the components to determine how the
properties in each component are
combined with the other components’
properties to form the final texture.

The number of blend modes you can use
varies depending on how many
components you're using to build the
texture.

If you're using only one component, the
properties in the component are applied
directly to the final texture. When you're
using two components, they’re blended
using a single blend mode, and the result
is then applied as the final texture.

When you're using three components, the
first two components are blended
together using a blend mode, then the
result of that blend is combined with the

third component using a second blend
mode. The result of all the blending is
then applied as the final texture.

Component 1 Component 2

CI)E
w/BLEND

RESULT

Component 3

BLEND

FINAL TEXTURE

This diagram explains when the blend modes
are applied as you combine components to form
a texture.

Depending on the Blend mode, the
different types of output can affect each
other during the combination process. So
its possible that the Bump output of one
component may affect the Color output
of another.
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To apply a blend mode:
1. Display the Deep Texture Editor.

2. Click the Arrow between components
and choose a mode from the menu.

The arrows between components in the Deep
Texture Editor provide access to the Blend
Modes menu.

*  Click the arrow on the left to

choose a Blend Mode to combine
components 1 and 2.

+  Click the arrow on the right to
choose a Blend Mode to combine
the results of Component 1 and 2
with 3.

There are nineteen blend modes you can
use to combine your components:

Parallel

This mode does not blend components.
Use it when each component has a
different output type. If two components
share an output type, only the first output
will be applied to the final texture.
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For example, if Component 1 has
output= Color and Bump, and
component 2 has output=Color and
Alpha, only the color from Component 1
will be applied to the texture.

Combine

Combine is a blend mode for colors only.
When you use this blend mode, the first
color in Component 2 is used as an alpha
channel. Wherever that color appears in
Component 2, it is replaced with the
colors from Component 1.

For example, lets say Component 2 has
Yellow, Green and Blue and Component
1 has Orange, Purple and Black as its
color scheme.

When you combine them using the
Combine blend mode, Yellow disappears
from Component 2. Everywhere that
Yellow appeared, you'll see Orange,
Purple and Black.

Average

Average is normal blend mode where all
the component values are mixed with
equal weight. So if one component is
white and the other is black, the result is

gray.

This is a good all-purpose blend mode to
use for creating textures.

Multiply

When you use this blend mode to
combine components, you'll get a darker
result. In this mode, when a black
component is combined with a gray
component, the result is black. When a
gray component is combined with a
white component, the result is gray.
When two shades of gray are combined,
the result is proportionally darker.

In the case of Bump output, this mode
will flatten most areas since black is flat
and darker values create flatter bumps.

Maximum

When two components are combined
using Maximum, the two components
are compared and the one that’s lighter
becomes the result.

Blend Maximum

Blend Maximum works the same as
Maximum, except that it creates blurring
at points of sharp transition.



When Blend Maximum is applied to
Bump output, the resulting bump map
will have many high points and few deep
pits.

This mode works best on Bump output.

This mode is the opposite of Maximum.
When two components are combined,
they’re evaluated and the darker areas of

both are combined to produce the result.

Blend Minimum

Blend Minimum works the same as
Minimum except that it creates blurring
at points of sharp transition.

When Blend Maximum is applied to
Bump output, the resulting bump map
will have mostly low areas with very few
high points.

Add

Add combines colors so that they appear
dramatically lighter. However, it doesn’t
have the same effect on Bump output.

Subtract

When you combine grayscale
components using Subtract, they tend to
turn out black or very dark. When you
use it with colored components, the
result is brilliant colors that tend to
compliment the original colors.

Blend v1 and v2

These two blend modes let you use one of
the components as an alpha channel for
blending.

When you choose Blend v1, the noise in
the first component is used as an alpha
channel to blend the two components.

When you choose Blend v2, the noise in
the second component is used as an alpha
channel to blend the components.

Blend Slope

Using Blend Slope, components are
combined according to an object’s slope.
The first component is applied to areas
that are flat and the other is applied to
areas that are steep.

Fast Slope

Fast Slope works exactly like Blend Slope
except that the transition from one
component to the other is more abrupt.

Blend Altitude

This mode blends components according
to an object’s altitude. The first
component appears at low altitudes and
the second appears at high altitudes.

Blend Orientation

In this mode, one component is applied
in all directions, while the other is applied
in only one direction. You can use this
mode to simulate things like moss that
only grow on one side of a tree.

Blend Random

This mode introduces an extra layer of
noise and uses it as an alpha channel for
combining the two components.
Component 1 appears in some areas of
the new noise, and Component 2 appears
in other.

Since this mode adds another layer of
noise, you're also adding more processing
time.

Procedural Blend

Procedural Blend combines two
components so that the color and values
of Component 1 are applied to
Component 2 based on the gray values in

Textures 269



'
'i. n

Component 2. In essence, the Alpha
output from Component 2 is used as a
guide for blending.

Where Component 2 is light, Component
1 is not applied. Where Component 2 is
dark, Component 1 is made darker.
Where Component 2 is gray, Component
1 is applied without change.

This mode usually results in more
saturated colors.

Difference

Difference finds the difference between
the noise in the two components and
displays the result.

This mode only works on output of like
types. So if Component 1 has Alpha and
Color output while Component 2 has
only Alpha, the two Alpha outputs are
combined and the Color output is left
unchanged.

Global Changes

The component window in the center of
the editor, called the Combination
component, represents the final
combined texture. Any changes you make
to this final component are considered
global changes since they affect the entire
texture.
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The Combination component can have
its own color scheme, filter, noise pattern
or phase. These attributes are applied to
all the component elements. For
example, the Combination noise values
affect the noise within each component.

Global changes give you a way of
applying a last layer of complexity to your
texture.

Global Colors

The colors in the Combination
component interact with the combined
colors in the three components. They act
as a final color filter for the texture. After
the colors in each component are
combined, they are blended with the
combination component colors to
produce the colors in the final texture.

You can also apply a final Color Blending
method to the combination component.
The Blending method you apply to the
combination component is applied on
top of the other modes used in the
components.

For example, if you choose Altitude in the
Combination component, the texture
color is applied using the blend modes in
the components and then also applied by
altitude.

This example shows a texture containing a
texture with different Color Blending modes in
it.



To add colors directly to a texture:

1. Click the top color circle in the
combination component window
and choose a color from the palette.

The color circles in the Combination component
window let you apply colors directly to the final
texture.

2. Repeat for each of the other two color
circles.

Global Noise

When you change the noise in the
Combination component, (i.e., globally)
it applies to all the components equally.
So if you increase the noise in the final
component, the noise in each of the
components increases. Likewise, when
you decrease the noise globally, the noise
in each individual component decreases.

Global noise can be different than
component phase, so you can introduce a
completely different type of noise into the
texture.

-~ B

= e - - i
Use this option cautiously. The more
noise you introduce into your texture,
the longer it takes to render and draw.
If you introduce too much complex
noise patterns into a texture, you may
find your render time increased
significantly.
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You can adjust global noise in the same
way you would for a single component,
using the Noise palette or the Noise
editor.

To adjust noise globally:

1. Click the top left button in the
combination component window.

The Noise palette appears.

The three buttons along the outside of the

Combination component window let you access

the editing palettes.

2. Drag the slider to adjust the noise
value.

or

Click the top left corner of the Noise
palette to display the Noise Editor.

+  Use the editor’s controls to design
the global noise pattern or grain.

Global Phase

As you adjust the Global Phase value, new
phase is introduced into each of the
components.

Global phase can be different than
component phase, so you can introduce a
completely different type of phase into
the texture.
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You can adjust global phase in the same
way you would for a single component
using the Phase palette or the Phase
Editor.

To adjust phase globally:
1. Click the bottom right button in the
combination component window.

The Phase palette appears.

The bottom right button on the outside of the
Combination component window accesses the
Phase palette.

2. Drag the slider to adjust the phase
amplitude.

or

Click the top left corner of the Phase
palette to display the Phase Editor.

¢+ Use the editor’s controls to design
the global phase.
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Global Filtering

The Filter affects the final look of the
noise within a component. The Global
Filter affects the look of the combined

noise. The Global Filter is applied to the

noise in the Combination component.

The global filter only affects the noise,

not the phase in the component. Any of

the filters you used in the components
can be used as the global filter.

- iy

Use this option cautiously. The more
complex the noise in your texture, the
longer it takes to render and produce.
If you introduce too much complexity,
you may find your render time
increased significantly.

- e —
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To filter noise globally:

1. Click the top right button in the
combination component window.

e = - -~

-~

The Filtering palette appears.

The top right button on the outside of the
Combination component window accesses the
Filtering palette.

2. Choose afilter and adjust its variables
to create the desired effect.
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The Dééb Texture éditbr

The Deep Texture Editor can be a source
of incredible power or incredible
frustration. It all depends on how you
jump into it.

The editor can be used in two ways. If
you're comfortable with equations and
algorithms, it gives you the freedom to
create any textural pattern or surface you
can imagine. If you're not so
mathematically inclined, playing around
with these deep functions can get you lost
rather quickly.

For those who don’t want to learn to
calculate and postulate, the Deep Texture
Editor can be used as a large palette. Take
a little of this and little of that, blend



them all together and see if you like the
result. If it'’s a magnificent work of art,
keep it; if not, discard it.

The only real penalty you may encounter
when using the Deep Texture Editor
unawares, is that you may inadvertently
create a very complex texture that could
add considerably to your rendering time.
This is an easy pitfall to avoid however.
The last section of this chapter gives you
some tips on reducing the complexity of
your textures. Refer to “Tips for Speeding
Up Textures” on page 277 for more.

Before you start creating textures, you
may want to familiarize yourself with this
incredible tool.
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Tip: When you're just exploring the
editor, set all the component outputs

to Alpha. This lets you see the effects
of your changes more clearly.
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To display the Deep Texture Editor:
1. Display the Materials Lab.

2. Click the A, B or C column of the
material channel to which you want
to assign a texture.

A component window becomes
active.

3. Click the pink button at the top of the
Component window.

The Deep Texture Editor appears.

A Quick Tour: The Deep Texture
Editor

The layout of the Deep Texture Editor is a
visual representation of the texture
creation process. The three components
along the top combine to form the final
texture, shown in the middle. The layout
makes the editor very easy to use.

Along the top of the editor you'll see the
preview options. These three icons let
you choose how you want to display the
component.

The three icons at the top of the editor let you
choose a preview mode.

Below the preview control on the left,
you'll see the component selector. This
tool lets you choose the number of
components you want to use to build
your texture.

The component selector lets you choose how
many components you want to use to build a
texture.

The rest of the editor displays the
component window. The three windows
along the top represent the three
components you can use in a texture and
the center window represents the
combined texture.

The three windows along the top of the editor
represent the components, and the window in
the center displays the final combined texture.
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The arrows between windows represents
the blend modes.

Elend Slope

The arrows between components in the Deep
Texture Editor provide access to the Blend
Modes menu.

The three buttons along the bottom of
the editor let you display the three editing
palettes. The palettes let you control the
noise, phase and filtering applied to the
texture.

& Noise L

The three buttons along the bottom of the editor
let you display the editing palettes.

#" Phase

Filter

You can access the Noise and Phase
Editors from within the Noise and Phase
palettes.
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Working in the Deep Texture
Editor
This section describes how to use the

Deep Texture Editor to create and store
textures.

IR AL

Building Textures

A texture is a combination of
components. You build textures by
designing or editing components (i.e.,
colors, noise, phase or filters) and
combining them using Blend modes.

To build a texture:
1. Display the Deep Texture Editor.
2. Click the Component Selector to

choose the number of components
you want to use to build the texture.

The component windows become
active.

3. Inthe first component window, click
one of the Output buttons to choose
an output type.

4. If your component contains color,
click one of the color circles and

choose a color to apply to the texture.

7.

You can choose up to three colors for
each component.

Click the triangle icon below the
color circles and choose a Color
Blending mode for your colors.

Click the Noise button at the bottom
of the editor. The Noise palette
appears.

Adjust the noise in the component

by:

+ Dragging the Noise slider on the
Noise palette to increase or
decrease the amount of noise in
the component.

¢+ Click the top left corner of the
palette to display the Noise
editor, then use the editor
controls to design or edit the
noise in the component.

Click the bottom right button on the
Component window. The Phase
palette appears.

Adjust the phase in the component

by:

+ Dragging the Phase slider on the
Phase palette to increase or
decrease the amplitude of the
phase in the component.



+  Click the top left corner of the
palette to display the Phase
editor, then use the editor
controls to design or edit the
phase in the component.

10. Click the Filtering button at the
bottom of the editor. The Filtering
palette appears.

11. Choose a filter to apply the
component noise and adjust that
filter’s variables.

12. Repeat steps 3-11 for each
component in the texture.

As you edit the noise, phase, or filter
of the remaining components, make
sure you move the component
indicator at the top of each palette to
be sure you’re editing the right
component’s attributes.
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The component indicator at the top of each

palette lets you know which component you're

editing.

13. Click the arrow between Component
1 and Component 2 and choose a
Blend mode from the menu.

14,

15.

16.

17.

18.

If you have more than two
components, click the arrow between
Components 2 and 3 and choose a
second blend mode.

The result of blending all the
components appears in the
Combination window.

Click the color circles in the
Combination component window,
and choose colors for the final
texture.

* You can also choose a Blending
mode.

If you want to change the noise of
combined component, display the
Noise palette.

If it’s already displayed, make sure
the component indicator is on the
fourth component.

If you want to change the phase of
combined component, display the
Phase palette.

If it’s already displayed, make sure
the component indicator is on the
fourth component.

If you want to change the filter of
combined component, display the
Filtering palette.

If it's already displayed, make sure
the component indicator is on the
fourth component.

19. Click the OK icon at the bottom of
the editor. The texture appears in one
of the component windows in the
Materials Lab.

Using Drag and Drop in the
Editor

The Deep Texture Editor lets you drag
and drop component elements between
component windows. This a quick way of
copying elements between components.

For example, if you were setting up a red,
green and blue separation of the colors in
your texture, you could drag the same
elements to all three component windows
and change the Color Blending mode.

To drag and drop between windows:

o Drag from the window you want to
copy to the window where you want
the elements to appear. Release the
mouse button to drop the
component elements.
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The elements you drop into a
window replace the existing
elements.

Changing Component Preview

Each component window has a preview
of the component’s elements. You can
choose to display the elements mapped
onto a flat surface, a cube or a sphere.

Displaying the component on a cube
makes it easier to see 3D noise and phase
changes.

To choose a preview mode:

o Click the flat surface, cube or sphere
in the top-right corner of the editor.

The three icons at the top of the editor let you
choose a preview mode for the component
windows.

Randomizing Textures

A quick way of designing a texture
without going into designing noise or
filters is to create random components.
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The randomize buttons in the
component windows let you randomize
the elements in the component window.
The type of output you choose for the
component determines what part of the
component is randomized.

This is an excellent way of exploring the
editor. Just randomize the components
elements and combine them to see what
happens.

To randomize component elements:

o Click the knob in the bottom right
corner of the component window.

The knob in the bottom right corner of the
component window randomizes the elements in
the component.

Undoing Changes

The Reset control lets you undo all the
changes you've applied to a component
and returns to the component displayed
when you first entered the editor.

To reset a component:

o Click the knob in the bottom right
corner of the component window.

The knob in the top-left corner of the component
window resets the component to the way it
looked when you first opened the editor.



Saving Textures

You can save your texture as part of
texture list so you can access it quickly
from the Materials Lab.

To save a texture:

1. Inthe Combination component
window, click the knob in the top
right corner of the component
window.

The knob in the top right corner of the
Combination component window lets you save
your texture.

The Save Texture dialog appears.

2. Enter a name for the new texture and
click the OK icon.

The new texture appears at the
bottom of the texture list. The list can
be accessed from the Materials Lab.

-
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Tips for Speeding Up
Textures
Textures can be the most powerful effects
you create in Bryce. They can also be the
most costly. The more complex the
texture, the longer it takes to calculate
and the longer it takes to apply to an
object, which finally increases the
rendering time.

When you're creating the texture, you
always have to keep in mind that it’s part
of a material, which is part of an object.
All these parts can contribute to the
rendering time:

*  The material that contains the texture
may have several complex attributes
of its own, like Transparency and
Reflection.

*  The size of the object may also
contribute to the rendering time.

Consider the effect of applying a complex
texture to a complex material onto an
infinite plane. The time to calculate this
object would be staggering.

A good rule of thumb when working with
complex objects and textures is to make
the texture element as simple as possible.

- —————
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These tips are meant only as a
precaution to prevent you from
inadvertently creating a huge texture.
That doesn’t mean that you shouldn’t
use the more complex features as well,
after all they were created for a reason.
You should just use them cautiously.

- —————
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Noise

« Use asimpler noise type. Some noise
types (like Vortex) require more time
to process than others.

+ Restrict the amount of noise you add
to each component. in fact, not all
the components need to have noise.

« Watch the frequency of the noise.
Higher frequency noise requires
more time to calculate then lower
frequency noise.

»  Watch the number of octaves in the
noise. Each octave adds another level
of complexity.

Phase

«  When you're designing the phase, you
may want to use simpler noise.
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Cut down on the number of phase
types you combine. If each
component has a different type of
phase, combining them can increase
calculation times.

Watch the amplitude of the noise.
Higher amplitude phase takes much
longer to calculate.

Apply Global Phase cautiously. This
is the quickest way of increasing the
complexity of your texture because
global phase introduces more
complexity into each component
simultaneously.

Filtering

Filtering introduces complexity or
detail into the noise of a component.
Make sure that you aren’t using a
filter unnecessarily. Not all noise
needs filters.

Be careful when you apply a Global
Filter as this adds even more
complexity to the noise.

278 Chapter @ Bryce 3D



Arranging Objects

Arranging Objects in a
Scene

In a scene, the arrangement of objects is
as important as their form. You can
design beautiful landscapes, or build
complex models, but if they’re the wrong
size or in the wrong position, they won't
look right in the scene. To get the right
look, you'll need to position or rotate the
objects to make sure they are in the right
places within the scene, or you may need
to resize an object so that it is in
proportion with the rest of the objects.
These kinds of operations are called
transformations.

Bryce supports three basic types of
transformations: size, position, and
rotation. The tools in the Edit palette let
you interactively perform these
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operations on any object in your scene.
As well, the Object Attributes dialog lets
you transform objects numerically for
more precision.

As you arrange objects, you'll probably
need to create some kind of object
hierarchy. An object hierarchy lets you
create a structure in your scene that
organizes objects according to their
spatial or logical relationships. The
structure can make arranging objects
much easier and faster.

You can create an object hierarchy by
grouping and linking objects.

This chapter describes how to use the
transformation tools and the Object
Attributes dialog to resize, reposition,
rotate, align and randomize objects. It
also describes how to create object
hierarchies.
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Bryce and 3D Space

Since all the objects in your scene exist in
3D space (defined by XYZ), any
transformation you perform is a 3D
transformation. This means that you're
changing the attributes of the object in
each axis.

Bryce has three ways of defining 3D
space: World space, which is constant,
Object space, which changes as the object
changes and Camera space, which
changes as the camera changes.

When you're using the interactive
transform tools on the Edit palette you
can use any one of the 3D space
definitions. Refer to “Transformation
Tools” on page 285 for more on using
these tools.

World Space

World Space is the coordinate system that
defines all the space in the Bryce universe.
It is constant and cannot be modified. It
is also the default space used for
transformations.

World Space is defined by three axes, X, Y
and Z, that all meet at world center. This
center is defined numerically as 0, 0, and
0 for the X, Y and Z axes. By default, all
new objects appear at world center.

TheY axis that extends from world center
defines all vertical space. Positive values
represent distances above ground level
and negative values represent distances
below ground. The X axis represents
distances left and right and the Z axis
represents distances backwards and
forwards.

So>

World space is defined by three axes that extend
out infinitely from a center point called world
center.



When you use World Space for
transformations, objects move in relation
to this absolute coordinate system.

When you transform objects in relation to world
space, they move along the three absolute axes.

Object Space

When Bryce creates an object, it defines
the up, down, right, left, back and front
of the object. These definitions remain
with the object no matter what
transformations you apply to it. So in a
sense, each object carries with it its own
coordinate system.

Object space is defined by three axes that extend

out from the center of the object.
When you transform an object using

Object space, the object moves in relation

to its internal coordinate system. For
example, you can increase the height of
an object based on its own Y axis.

When you transform an object using Object
space, it moves along an axis that extends from
its center, not an absolute axis.

Because Object space ignores the absolute
coordinates, the object becomes taller
without being skewed. If you used World
space, the object would become
deformed since it increases along the
absolute Y axis.

e
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This is an example of an object transformed
using World Space and then using Object Space.
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Camera Space

Camera Space is defined by three axes, X,
Y and Z, that extend out from the camera
center. Wherever you move the camera,
these axes move along with it.

T-Y

Camera space is defined by three axes that
extend out from the center of the camera.

When you use Camera Space for
transformations, you’re moving objects
in relation to the camera. When you drag
along the X axis in camera space, you're
moving left or right from the camera.
When you move along the Y axis in
camera space, you're moving up or down
from the camera. When you move along
the Z axis, you're moving away or towards
the camera.
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Since the camera can be rotated and
repositioned, it can sometimes be hard to
tell which way is up, left or right, because
your view from the camera is no longer
aligned to the absolute XYZ axes.

Suppose you've rotated the camera and
then you move an object along the Y axis
in World Space. Instead of moving up, it
may appear to move off to the left, since
your view of the scene is not aligned to
the World Space Y axis. However, in
Camera Space, the object will move up,
because the object moves along the
camera’s Y axis.

When you transform objects using Camera
space, they move along an axis that extends
from the center of the camera.

To choose a 3D spatial option for
transformations:

1. Click the Edit button at the top of the
Bryce window to display the Edit
palette.

2. Click the triangle icon below one of
the transformation tools and choose
a 3D spatial option from the menu.

Each of the transformation tools has a triangle
icon below it, which lets you access addition tool
options.

Bryce Units

Bryce maintains an invisible, absolute,
infinite 3D grid internally. This grid is
comprised of 3D cube increments, each
2048x2048x2048 “Bryce units” in size. All
primitive objects (spheres, cubes, etc.) are
created at the same size as a 3D cube
increment (2048x2048x2048) called
unity.



Unity is the base size of all primitive objects
created in Bryce. Unity is always
2048x2048x2048.

All interactive 3D transformations are
relative to an absolute (unity) size,
position, and orientation for all objects.
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To reset object to unity:

o Hold down Command-Option/
Ctrl+Alt and click one of the object’s
control points. The object is reset to
2048x2048x2048.
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Coordinate Systems

When you're transforming objects
numerically, in the Object Attributes
dialog, you can use one of two coordinate
systems: Absolute Coordinates or Object
Coordinates.

Absolute Coordinates

Absolute Coordinates use the World
Space axes as the reference for object
transformations. When you enter
transformation values using Absolute
coordinates, you're defining how the
object is transformed along the World
Space, or absolute, X, Y and Z axes.

(2,2,3) ’ '

Absolute Coordinates use the World Space axes
as reference, so you're repositioning the object
along the absolute X, Y, and Z axes.

Object Space Coordinates

Obiject space coordinates define how an
object is actually created. In object space,
the origin of the object is located at X=0,
Y=0, Z=0. All the other points in the
object are defined by coordinates along
the object’s internal X, Y and Z axes.

Object Space coordinates define how an object is i - o
created. The origin is at 0, 0, 0, while all the
other points that define the object’s shape and
size are coordinates along the X, Y and Z-axes
within the object.

This coordinate system uses the object’s
internal axes as a reference for
transformations. When you enter
transformation values using this system,
you change how the object is defined, so
that includes where its origin is
positioned, it's size, and orientation.
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Object Space Coordinates use the object’s

internal axes as reference, so you're redefining
the object’s position along its internal X, Y, and

Z axes.
In Object Space transformations, the

origin point of the object always remains
at Object Space 0, 0, 0. As you move or

scale the object, it changes, moves or
grows along its internal axes, but the

origin remains at 0, 0, 0. This can cause
some unpredictable results. For example,
if you scale an object using Object Space

coordinates, the origin point will no

longer be in the exact center of the object,
so if you rotate the object, it won't rotate

around its center.
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In this example, an object was scaled using
Object Space coordinates and then rotated. You
can see that it no longer rotates around its
center.

- B i

Transforming using Object Space
coordinates is not the same as using
Object Space with one of the
Transformation tools. When you
choose Object Space for one of the
transformation tools, transformations
are performed using Object Space axes
as a reference, but the final position, or
size, is calculated using Absolute
Coordinates. So in this case the object
origin and all its points move along
with the object.

When you use Object Space
Coordinates to transform an object,

you're redefining how the object is
created, so its origin does not change
as the size and position change.

——
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Relative Coordinates

Relative Coordinates use the World Space
axes as reference for object
transformations, but the values represent
changes relative to the object’s current
position, or size. For example, if you
enter a position change of 2 units, the
object moves two units from its current
position along one of the World

Space axes.

Y 2

z

Relative Coordinates use the World Space axes
as reference, but transformations are relative to
the current position or size of the selected object.



Relative Coordinates are the only
coordinate systems available in the 3D
Transformation dialog.

e ®

Transforming Objects

Transformation Tools

The transformation tools let you perform
all the object transformation operations
available in Bryce. The tools act as
interactive controls. As you drag over the
tool, the operation is performed on the
selected object.

The transformation tools are located on
the Edit Palette.

To select a tool:

1. Click the Edit button at the top of the
Bryce window to display the Edit
palette.

2. Select an object.

3. Drag over the tool to perform a
transformation operation.

Resize Tool

Use the Resize Tool to resize objects along
one of the three axes.

Rotate Tool

Use the Rotate tool to rotate objects in 3D
space.

Reposition Tool

Use the Reposition tool to reposition
objects along any of three axes.

Align Tool

Use the Align tool to align objects along
their tops, bottoms, left sides, right sides,
fronts, backs or centers.

Randomize Tool

Use the Randomize tool to scatter or
disperse objects in 2D or 3D space.

Arranging Objects 285




st ST b
it ;

Object Origin Points

Every object in Bryce has an origin point.
This point defines the object’s center of
rotation.

The object’s origin point defines the object’s
center of rotation.

In the Working window, the Origin point
appears as a small dot. By default the
origin point appears at the center of the
object’s bounding box. You can adjust the
position of the origin point to any point
along the object’s surface or outside of
the object.

Where you place the origin point
depends on the effect you want to create.
For example, if you rotate an object when
its origin point is at its center, it spins in
place. When the point is placed outside
the object, it rotates around the origin
point like a planet around the sun.
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When the origin point is at the center of the
object it rotates in place. When you move the
origin point outside the object, it orbits around
its point.

Nano-Edit Mode

Nano-Edit Mode activates the
Nano-Editor which lets you perform
transformations on a small preview of
your scene, instead of the full scene.

When this mode is active, the
Nano-Editor appears any time you
perform a camera or object
transformation. The Nano-Editor
window displays a small preview of your
scene. The transformation is applied to

the preview. When you close the editor,
the transformation is applied to the full
scene.

Pk e
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Use the Nano-Edit mode to quickly see the
effects of transformation on a preview of your
image.

This mode is useful when you're working
on a large scene, as it saves on redraw
time.

To activate Nano-Edit Mode:
o Click the Nano-Edit button on the
Display palette.

When the smaller square inside the
icon (which represents an active
Nano-Editor) is red, the Nano-edit
mode is on; when it is white, it is off.



To temporarily activate Nano-Edit
mode:

o Hold down Option-Spacebar/Alt +
Spacebar before you perform
transformations. The Nano-Editor
appears only during the operation.

il
Resizing Objects
When you create an object, it appears at a
default size. Once you place it in your
scene you'll need to resize it make it
proportional to the other objects in your
scene. If the tree is larger than the terrain,
one of them is at the wrong scale.

There are three ways of resizing objects in
Bryce:

*  Using the Resize tool, in the Edit
palette, to resize an object along
different axes.

*  Using the 3D Transformation dialog
which lets you enter precise values to
resize objects.

»  Using the control points on the
object’s bounding box to interactively
resize the object.

Objects are measured in Bryce units.
When you resize an object you're
increasing or decreasing its size based on
unity size. When you resize an object to
150%, you're sizing it to 150% of unity.
Refer to “Bryce Units” on page 282 for
more.

Using the Resize tool

The Resize tool lets you resize a selected
object along any axis. Objects are resized
from their origin point.

The Resize tool has seven different states.
As you move the pointer over the tool
each state becomes active.

Ressize Y up

Ressize X left Ressize Z back

Ressize Z front Ressize X right

Ressize XYZ
from center
Ressize Y down

The resize tool has seven states. As you move
your cursor over the tool each state becomes
active.

The different states let you resize the
object along different axes. Resizing along
the Y axis increases/decreases the object’s
height. Resizing along the X axis
increases/decreases the object’s width.
Using the Z axis for resizing increases/
decreases the object’s depth.

To resize an object along a specific
axis:

1. Make sure the Edit palette is visible. If
it's not, click the Edit text button at
the top of the Working window.

2. Move the Cursor over the Resize tool.

3. When the state you want to use
becomes active, drag to resize the
object.

For example, if you're using Resize Y
Up, drag to the left increase the
object’s height in the Y axis. The
more you drag, the taller the object
becomes.

Hold down Shift to constrain the
resize increments to 50% intervals.
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g To resize an object in all directions:
1
W"' 1. Make sure the Edit palette is visible. If
s it's not, click the Edit text button at
iq,.‘:-. the top of the Working window.
%2, 2. Click the center of the Resize tool and
X drag left to increase the size of the
e object, or right to decrease it.
To resize an object from two directions
along a single axis:

'_. 1. Make sure the Edit palette is visible. If
it's not, click the Edit text button at
the top of the Working window.

2. Move the cursor over the Resize tool.
, 3. When the state you want to use
-3 becomes active, hold down Option/
R Alt drag in the direction you want to

resize the object.

For example, if you're using Resize Y
Up, when you hold down Option/Alt
as you drag, the object becomes
longer both up and down along the Y
axis.

Objects can be resized using any of the
three spatial definitions (World, Object
or Camera). The definition you choose
depends on the effect you wish to create.
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To choose a spatial option for resizing:

1. Make sure the Edit palette is visible. If

it’s not, click the Edit button at the
top of the Bryce window.

Click the triangle icon next to the
Resize tool and choose an option
from the menu:

« World fmoce
Lamura Space

inarais
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Object Space resizes your selection
relative to itself (see “Object Space”
on page 281).

World Space resizes your selection in
absolute world coordinates (see
“World Space” on page 280).

Camera Space resizes your selection
relative to the camera (see “Camera
Space” on page 282).

o B o

—
When you set Object, World, or
Camera space for the Resize tool, it is
also the option set for the other two
transformation tools. However, spatial
options are global for the
transformation tools only. The option
you select in the Edit palette does not
affect the 3D Transformations dialog.

——
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Flipping Objects

Flipping is not the same as rotating an
object 180°. Flipping mirrors an object
along an axis instead of rotating it.



Original object

Rotated 180° in X

Flipped in X

This example shows an object that has been
rotated 180° and the same object flipped in X.

To flip an object:
1. Make sure the Edit palette is visible. If

it's not, click the Edit button at the
top of the Bryce window.

2. Click the triangle icon next to the
Resize tool and choose a flip option
from the menu:

Flip X inverts your object’s
dimensions along the X axis.

Flip Y inverts your object’s
dimensions along the Y axis.

Flip Z inverts your object’s
dimensions along the Z axis.

To undo resize operations:

1. Make sure the Edit palette is visible. If
it's not, click the Edit button at the
top of the Bryce window.

2. Select an object.

3. Click the triangle icon next to the
Resize tool and choose Unscale from
the menu.

Numerical Resizing

Sometimes you will need more precise
control over the size of your object. The
3D Transformations dialog lets you enter
specific resize values for a selected object.

All transformations you enter in this
dialog are performed in World Space
regardless of the spatial option you chose
for the Resize tool.

Resize values are expressed as a
percentage of the current size of the
selected object. You can not enter
negative numbers in this dialog.

To resize an object numerically:

1. Make sure the Edit palette is visible. If
it's not, click the Edit button at the
top of the Bryce window.

2. Select an object.

3. Click the triangle icon below the
Resize tool and choose 3D
Transformations from the menu. The
3D Transformations dialog appears.

3D Transformations
Relative Coordinates

omset | 0 |[ o ][ o |°

Rotate | 0 || o [ o |°

size (NCEM] 100 | [ 100 ]°
X ¥ Z

Use the 3D Transformation dialog to resize an
object using numerical values.

4. Enter a percentage in one or all of the
axis fields.

The percentage determines the new
size of the object based on its original
size. For example, to double the
object’s size in all directions, enter
200inthe X, Y, and Z fields. To resize
along a single axis, enter values in
only one axis field.
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Since you are dealing with World
Space transformations in this dialog, if
you resize an object along only one or
two axes you may unintentionally skew
the object’s shape.

To resize the object without skewing it,
use the numeric entry fields in the
Object Attributes dialog. Using this
dialog can resize the object based on
its original position, with no
unintentional skewing. Refer to “Object
Space Coordinates” on page 283 for
more.

- ——
-
- PR—— "

Interactive Resizing

While you can resize objects using the
Resize tool or the 3D Transformation
dialog, there are resize controls on the
object’s bounding box that let you resize
objects directly in the Working window.
You may find this a much more intuitive
way of transforming your objects.

When you select an object, a bounding
box appears surrounding your selection.
At each corner of the box, and at the
center of each face, is a control point.
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Control
Points

.
u
An object’s bounding box has control points at

the corners and at the center of each face that
can be used to resize the object.

As your cursor passes over the corner
control points, it changes to a generic
Resize cursor. As it passes over the control
points on the faces, it changesto an X, Y
or Z. This indicates the axis along which
you can resize the object by pressing and
dragging at that point.

=
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The corner control points resize the object along
all three axes. The control points on the faces of
the bounding box resize the object along a single
axis.

To resize an object along a single axis
interactively:

1. Select an object.

2. Drag one of the control points at the
center of a bounding box face.

As you pass your cursor over the face,
the cursor changesto an X, Y or Z to
indicate the axis you're resizing
along.

To enlarge or shrink an object
interactively:

1. Select an object.

2. Drag one of the control points on the
corners of the bounding box.

Drag right to enlarge it, or left to
shrink the object.

* Hold down Command/Ctrl while
dragging to resize in the opposite
direction from the selected
corner point.

+ Hold down Option/Alt while
dragging to resize from the center
of the object.

+ Hold down Shift to constrain
resizing to 50% increments.



To resize an object from the bottom
center:

1. Select an object.

2. Click the Y facial control point and
hold down the mouse button, then
press Command-Option/Ctrl+ Alt
and drag the point.

The object resizes in all directions
from the bottom center of the object.
This transformation may be useful if
the object is on the ground and you
want it to remain there.

Using the Keyboard

You can also you use the keyboard keys to
resize objects:

*  doubles a selected object’s size.

/ halves a selected object’s size.

= returns the object to unity size
and snaps it to the Grid.

Rotating Objects
Most object have a specific up, down, left,

right, back and front associated with
them when you create them. When you

place the object in a scene, its orientation
may need to be altered to achieve a
desired effect. For example, an airplane
that’s taking off should be tilted upwards,
or tilted downwards when it’s landing.

There are three ways of rotating objects in
Bryce:

» Using the Rotate tool to resize an
object along different axes.

» Using the 3D Transformation dialog,
which lets you enter precise rotation
angles.

* Using the object’s control points to
interactively rotate the object.

Using the Rotate tool

The Rotate tool lets you rotate a selected
object along any axis. Objects can be
rotated in World Space, Object Space or
Camera space.

The Rotate tool has three different states.
As you move the pointer over the tool,
each state becomes active.

Rotate
around X

Rotate
around X

Rotate
around Z

As you move your cursor over the tool each
rotation state becomes active.

To rotate an object around a specific
axis:

1. Make sure the Edit palette is visible. If
it's not, click the Edit button at the
top of the Bryce window.

2. Move the cursor over the Rotate tool.

3. When the state you want to use
becomes active, drag in the direction
you want to rotate the object.

Hold down the Shift key while
dragging to constrain rotation
operations to 45 degree increments.

You can rotate an object using any of the
three spatial options (World Space,
Object Space, Camera Space.)
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W"' 1. Make sure the Edit palette is visible. If
s it's not, click the Edit button at the
iq,.‘:-. top of the Bryce window.
Ty 2. Click the triangle icon next to the
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Object Space rotates your selection
relative to itself (see “Object Space”
on page 281).

o, World Space rotates your selection
3 . .

e in absolute world coordinates (see
“World Space” on page 280).

Camera Space rotates your selection
relative to the camera (see “Camera
Space” on page 282).

e _-'_—.-____-_ R
The three spatial options are also
available for the Resize and Reposition
tools. When you select Object, World,

or Camera space for the Rotation tool,
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it is also set for the other two tools.
Spatial options are global for all
transformation. The option you choose
in the Edit palette does not affect the
3D Transformations dialog.

B
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To undo rotation operations:

1. Make sure the Edit palette is visible. If
it's not, click the Edit button at the
top of the Bryce window.

2. Click the triangle icon next to the
Rotate tool and choose Unrotate
from the menu.

Numerical Rotation

In a complex scene, orienting objects may
require more precision than the Rotation
tool offers. The 3D Transformations
dialog lets you enter specific rotation
angles for a selected object.

All transformations performed using this
dialog use World Space coordinates
regardless of the spatial option you chose
for the Rotate tool.

Rotation values are expressed as degrees,
with 360° being a single full rotation.
Since rotations are relative, you may enter
negative values and cumulative values
(greater than 360° or less than -360°).

=l B -

In this dialog, Bryce units have been
transposed for the sake of simplicity.
For instance, an object at Unity size of
2048x2048x2048 is seen in the 3D
Transformations dialog box as
20.48x20.48x20.48.

Moving the decimal two points to the
left lets you have a full range of
resolutions without having to enter
either excessive integer values or
values with excessive places to the
right of the decimal point.

B,
- e — —

To rotate an object numerically:

1. Make sure the Edit palette is visible. If
it'’s not, click the Edit button at the
top of the Bryce window.

2. Select an object.



3. Click the triangle icon next to the
Rotate tool and choose 3D
Transformations from the menu. The
3D Transformations dialog appears.

4. Enter a degree value in one or all of
the Rotate fields.

3D Transformations

orset M| |_ o || o |°

Rotate | 0 |[ o J[ o |°
|8

Size | 100 || 100 || 100
X Y F4

Enter a degree value in the Rotate fields to rotate
objects by a specific angle.

The degrees determine the angle of
rotation. For example, to rotate an
object 45°around Y, enter 45 in the
Rotate Y field. To rotate around
other axes, just enter values in the
appropriate fields.

- _-_'-'-l—-u______ o
Since you're dealing with World Space
transformations, objects are rotated
with respect to the World Space X, Y,
and Z axes.

-~ _-‘—l—-|_.h_____ i
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You can also rotate an object
numerically using the Object Attributes
dialog. The values in the Attributes
dialog rotate the object using either
Absolute coordinates or Object space
coordinates. Refer to “Absolute
Coordinates” on page 283 and “Object
Space Coordinates” on page 283 for
more on the these coordinate systems.

- _-_'-'-l—-u_____ i

Interactive Rotation

Using the control points on an object’s
bounding box, you can freely rotate an
object directly in the Working window.

Rotation control points appear when you
hold down Command /Ctrl and pass
your cursor over the object’s bounding
box. The corner control points let you
free-rotate your object. The control
points at the center of each face rotate the
object along a single axis.

Control
Points

An object’s bounding box has control points at
the corners and at the center of each face that
can be used to rotate the object.

To rotate around a single axis:
1. Select an object.

2. Hold down Command /Ctrl and drag
on any face control point.

You can tell which axis you're
rotating around by releasing the
Command /Ctrl key for a moment.
The cursor changes to an X, Y or Z.

To free rotate an object:
1. Select an object.

2. Hold down Command /Ctrl and drag
on any corner control point.

* Hold down Option/Alt to rotate
in very fine increments
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* Hold down Shift to constrain
rotations to 45° increments.

e
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Positioning Objects

The composition of your scene depends
on the position of the objects relative to
other objects. In most cases, you'll need
to use the Reposition tool in conjunction
with the Resize and Rotation tools to
create the desired relationships.

Positioning applies to objects, groups and
families as well as lights and the camera.
In this section the term “object” also
refers to the camera and lights.

Bryce lets you position objects in four
ways: using the Position tool to move
objects along a specific axis, using the 3D
Transformation dialog to enter specific
offset positions, by dragging the object to
a different location, or by using the arrow
keys to nudge objects.
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Using the Reposition Tool

The Reposition tool has six different
states. As you move the pointer over the
tool each state becomes active.

Reposition Y up

Reposition X left

Reposition Z back

Reposition Z front Reposition X right

Reposition Y down

The rotate tool has six states. As you move your
cursor over the tool each state becomes active.

To position an object along a specific
axis:

1. Make sure the Edit palette is visible. If
it's not, click the Edit button at the
top of the Bryce window.

2. Move the cursor over the Reposition
tool.

3. When the state you want to use is
active, drag in the direction you want
to move the object.

To choose a spatial option for
repositioning:

1. Make sure the Edit palette is visible. If
it's not, click the Edit button at the
top of the Bryce window.

2. Click the triangle icon next to the
Reposition tool and choose an option
from the menu:

el e
< W Space
Casmers Space

Beregasifion

30 Trassformafions

Object Space moves your selection
relative to itself (see “Object Space”
on page 281).

World Space moves your selection in
absolute world coordinates (see
“World Space” on page 280).

Camera Space moves your selection
relative to the camera (see “Camera
Space” on page 282).
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The three spatial options are also
available for the Resize, and Rotate
tools. When you select Object, World,
or Camera space for the Rotation tool,
it is also set for the other two tools.
Spatial options are global for all
transformation. The option you choose
in the Edit palette does not affect the
3D Transformations dialog.
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To undo position operations:

1. Make sure the Edit palette is visible. If
it's not, click the Edit button at the
top of the Bryce window.

2. Click the triangle icon next to the
Reposition tool and choose
Unreposition from the menu.

Numerical Repositioning

The most precise method of positioning
objects is by using the 3D
Transformations dialog. This dialog lets
you enter specific offset values for a
selected object.

All transformations performed using this
dialog use World Space coordinates
regardless of the spatial option you chose
for the Reposition tool.

Offset values are expressed in Bryce units
of measure (refer to “Bryce Units” on
page 282). You may enter negative
numbers in the Reposition fields.

J". _-—.‘_L.__ — -
In this dialog, Bryce units have been
transposed for the sake of simplicity.
For instance, an object at Unity size of
2048x2048x2048 is seen in the 3D
Transformations dialog box as

20.48x20.48x20.48.

Moving the decimal two points to the
left lets you have a full range of
resolutions without having to enter
either excessive integer values or
values with excessive places to the
right of the decimal point.

o B

To reposition an object numerically:

1. Make sure the Edit palette is visible. If
it's not, click the Edit button at the
top of the Bryce window.

2. Select an object.

3. Click the triangle icon next to the
Reposition tool and choose 3D
Transformations from the menu. The
3D Transformations dialog appears.

4. Enter avalue in one or all of the
Offset fields.

orset IIETIN

Enter a value in the Offset fields to move objects
by a specific number of units.

1024 || o |°

The value determines the number of
Bryce units the object is offset from
its current position.

‘__. _-—.._._.__ — .- >
Remember that since this dialog only
performs transformation in world
space, you are moving the object

relative to world X, Y, and Z

coordinates.
‘._. _-—.‘_u__ >
—
‘__. _-—‘_q_.__ >
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You can also position an object
numerically using the Object Attributes
dialog. The values in the Attributes
dialog position the object using either
Absolute coordinates or Object space
coordinates. Refer to “Absolute
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Coordinates” on page 283 and “Object
Space Coordinates” on page 283 for
more on the these coordinate systems.
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Interactive Repositioning

The simplest way of positioning objects is
by dragging them to different locations in
your scene.

When you drag an object, you're
repositioning it with respect to the
camera.

To reposition objects by dragging:
o Pass you cursor over an object. When

it changes to a crossed arrow, drag the
object to a new location.

+ Hold down Command-Option /
Ctrl+Alt while dragging to
constrain movement to the X
axis.

+ Hold down Option/Alt while
dragging to constrain movement
to the Y axis.

+ Hold down Command /Ctrl
while dragging to constrain
movement to the Z axis.
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You can change modifiers mid-drag as
you like.

Nudging Objects

Nudging lets you move objects by
pressing the arrow keys and the PageUp
and PageDown keys.

Nudging uses World Space coordinates to
reposition objects. Each time you press a
key, the object is moved in 1/4 unity size
increments (512 Bryce units). Refer to
“Bryce Units” on page 282 for more on

Unity.

I - PageDown

Up o) pig
Left _"”f \"" Down

PageUp

Use the Arrow, PageUp and PageDown keys to
nudge objects in World Space.

To nudge an object along the X axis:

1. Select one or more objects.

2. Press either the Right or Left arrow
keys.

* Hold down Shift to nudge objects
in 1/2 unity size increments
(1024 Bryce units)

+ Hold down Option/Alt to nudge
objects in 1/256 unity size
increments (8 Bryce units).

To nudge an object along the Y axis:
1. Select one or more objects.

2. Presseither the PageUp or PageDown
arrow keys.

+ Hold down Shift to nudge objects
in 1/2 unity size increments
(1024 Bryce units)

+ Hold down Option/Alt to nudge
objects in 1/256 unity size
increments (8 Bryce units).

To nudge an object along the Z axis:
1. Select one or more objects.
2. Press either the Up or Down keys.

+ Hold down Shift to nudge objects
in 1/2 unity size increments
(1024 Bryce units)



* Hold down Option/Alt to nudge
objects in 1/256 unity size
increments (8 Bryce units).
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Aligning Objects

Bryce 3D’s alignment features let you
position several object with respect to
each other.

Alignment transformations are
performed with respect to the Grid. Bryce
maintains an internal grid that is
comprised of 3D cube increments,
2048x2048x2048 Bryce units in size.

The Grid gives you a common reference for all
alignment operations. If all your objects are at
unity size you can use grid units to precisely
align objects.

The Grid is used for Snap To operations
and acts as common reference for
alignment operations. One grid unit is
equal to unity size, and unity position is
always snapped to a position on the grid.

Using the Grid

The Grid can be used as a guide to help
you precisely position objects in your
scene.

The following example illustrates how the
grid can be used to position a pyramid
beside a cube:

To precisely position objects using the
grid:

1. Make sure all the objects are unity
size.

*  When you create primitives like
cubes or spheres, they are unity
size (2048x2048x2048 Bryce
units).

* You can return existing objects to
unity by holding down
Command-Option/Ctrl+Alt and
clicking one of its control points.

’ 8

First, return all the objects you're aligning to
unity, they fill exactly one grid unit...
This returns the objects to a perfect
multiple of Bryce’s grid units.

2. Determine the objects’ positions
relative to the grid.

* When you create an object, it
usually appears at World center
or0,0,0.

+ For existing objects, use the Snap
to Grid option in the Edit palette
to move the object to a point on
the grid.

48

...then move the objects to grid using the Snap
To Grid option...
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3. Use the nudge controls to move the
object. Nudging moves objects in
grid increments.

To place the sphere precisely on top
of the cube, press the up arrow four
times. The cube moves up exactly 1
grid unit.

g s

Finally, use the Nudge controls to move in
precise increments along the grid.
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Using the Align Tool

The Align tool has ten different states. As
you move the pointer over the tool each
state becomes active.

Align X left
Align X cent
Align Ytop —. .
Align X right
Align Y center
Align Y bottom |Align XYZ center

Align Z back

Align Z front Ali gn Z center

As you move your cursor over the Align tool
each of its states becomes active.

To align objects along a specific axis:

1. Make sure the Edit palette is visible. If
it's not, click the Edit button at the
top of the Bryce window.

2. Select two or more objects.
Move the cursor over the Align tool.

4. When the state you want to use is
active, click the mouse button.

Anchor Objects

An anchor object is the object in an
alignment operation that does not move.
All the other objects move in relation to
the anchor object. The anchor object is
the first object you selected.

Snap To Options

Bryce’s snap to options let you
automatically align objects to the grid,
world center, ground or a land object.

To snap objects to the Grid:
1. Make sure the Edit palette is visible. If

it’s not, click the Edit button at the
top of the Bryce window.

2. Select an object.

3. Click the triangle icon next to the
align tool and choose Snap to Grid.

Refer to “Using the Grid” on
page 297 for more on the grid.

To snap objects to the center of the
anchor object:

1. Make sure the Edit palette is visible. If
it's not, click the Edit button at the
top of the Bryce window.



2. Select an object.

3. Click the triangle icon next to the
align tool and choose Snap Together.

The X, Y, and Z centers of all selected
objects are aligned the X, Y, and Z
center of the anchor object in the
selection.

To snap object to the World Center:

1. Make sure the Edit palette is visible.
If it's not, click the Edit text button at
the top of the Working window.

2. Select an object.

3. Click the triangle icon next to the
Align tool and choose Snap to World
Center.

The selected objects move to
coordinate X=0, Y=0, Z=0, or World
Center.

To drop or lift objects to ground level:

1. Make sure the Edit palette is visible. If
it's not, click the Edit button at the
top of the Bryce window.

2. Select an object.

3. Click the triangle icon next to the
Align tool and choose Snap to
Ground.

Landing Objects

The Land Selection align option lets you
snap an object to any object directly
below it, much like creating a gravity
effect.

When you activate the Land Section
option, Bryce looks snaps the selected
object to the top of any object directly
below its center “Y” control handle.

Using Land Selection, a selected object snaps to
the top of any object that’s directly below its Y
control handle.

The second object must be directly below
the Y control handle, otherwise the object

lands on the ground plane

In this example, a corner of the selected object is
over the “land” object, but since there are not
objects directly under its Y control handle, the
selected object lands on the ground.

If the selected object is below the ground
plane, it snaps up to the bottom of any
object directly above its top center Y
handle.

When the selected object is below ground, it
snaps up to the bottom of an object directly
above its Y control handle.
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Landing operations work best with
objects that have not been rotated, and
that have no sloped characteristics.

. _-l-""-ln-q_____ _—
This option can create many interesting
effects. For example, you can quickly
create falling rock animations by placing
rock objects throughout your scene with
a terrain below them in one frame. Then,
in a different frame, select all the rocks
and choose the Land Selection option.
When you run the animation, all the
rocks will appear to fall onto the terrain.
Refer to “Animating” on page 351 for
more on animation.
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These objects were aligned using the Land
Selection option.

To snap object to the top surface of an
object below it:

1. Make sure the Edit palette is visible.
If it’s not, click the Edit text button at
the top of the Working window.

2. Select an object.

3. Click the triangle icon next to the
Align tool and choose Land Selection
from the menu.

or

Click the Down arrow icon that
appears next to the object’s bounding
box.

Aligning Numerically

The most precise method of aligning
objects is by using the 3D
Transformations dialog. The dialog uses
Bryce units for positioning, so you can
use these increments to align objects
based on grid increments (20.48=one
grid unit).

" i . _-l-‘-hl-q___‘_ i
In this dialog, Bryce units have been
transposed for the sake of simplicity.
For instance, an object at Unity size of
2048x2048x2048 is seen in the 3D
Transformations dialog box as

20.48x20.48x20.48.

Moving the decimal two points to the
left lets you have a full range of
resolutions without having to enter



either excessive integer values or
values with excessive places to the
right of the decimal point.
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Randomizing Objects

The Randomize tool is a great way of
randomly dispersing objects throughout
your scene without having to manually
position each object.

Using the Randomize Tool

The Randomize tool has eight different
states. When you click on the tool, it
cycles though its different modes.

To randomize objects:

1. Make sure the Edit palette is visible. If
it's not, click the Edit button at the
top of the Bryce window.

Select a number of objects.

3. Click the Randomize tool repeatedly
until the mode you want to use is
active.

2D Disperse

2D Disperse/Rotate

2D Disperse/Size

2D Disperse/Size/Rotate

3D Disperse

3D Disperse/Rotate

3D Disperse/Size

3D Disperse/Size/Rotate

oSS a g aa
| b

As you click the Randomize tool each of its
states becomes active.

There are eight modes available:

2D Disperse scatters your selection
randomly along the horizontal (X
and Z) plane.

2D Disperse/Rotate scatters and
rotates your selection randomly
along the horizontal (X and Z) plane.

2D Disperse/Size scatters and resizes
your selection randomly along the
horizontal (X and Z) plane.

2D Disperse/Size/Rotate scatters,
resizes and rotates your selection
randomly along the horizontal (X
and Z) plane.

3D Disperse scatters your selection
randomly in 3D space.

3D Disperse/Rotate scatters and
rotates your selection randomly in
3D space.

3D Disperse/Size scatters and resizes
your selection randomly in 3D space.

3D Disperse/Size/Rotate scatters,
resizes and rotates your selection
randomly in 3D space.

Click the Randomize Sphere.
The selected objects are randomized.
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To randomize objects interactively:
1. Select a number of objects.

2. Drag over the Randomize sphere.
Release the mouse button when you
achieve the desired effect.

A
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Object Hierarchies

An object hierarchy lets you create
relationships between objects, by
grouping a linking object together.

A hierarchy adds structure to the objects
in your scene. This can make arranging
and animating objects much easier. When
you're arranging objects a hierarchy can
make positioning and rotating easier
since you can transform an entire
hierarchy all at once instead of separately.
The same is true for animating. You can
quickly create motion animations by
changing the position of a parent object,
since all its children will move with it.

Hierarchies can be created by either
grouping or linking objects.
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Grouping vs. Linking

Both grouping and linking let you create
functional or spatial relationships
between objects. The difference is how
the objects within each hierarchy work.
Within a group all the objects act as one.
If one moves they all move. If one object
is rotated, they all rotate. This type of
hierarchy is good for creating complex
objects with static parts, like a tree or a
large terrain.

Group hierarchies are good for creating complex
objects that have no moving parts like this
terrain group. As you move the group all the
objects in the group move.

Within a linked hierarchy objects behave
differently depending on which object
within the hierarchy is being
transformed. Any transformation you
apply to the parent object is applied to all
its children. However, transformations
applied to a child object do not affect the
parent. This type of hierarchy is good for

creating objects that have moving parts
or animating two objects with the same
motion.

Linked hierarchies are good for creating objects
that have moving parts like this grandfather
clock. As you move the parent all the objects in
the hierarchy move, as the child moves the
parent remains unchanged.

_--__L
r il = ~

You can control exactly which
transformations are applied to a child
object using the options on the Linking
tab in the Object Attributes dialog.

_-——_-__
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Hierarchical Structure

A hierarchical structure consists of a
parent object or objects and its
descendants. In the case of linking, the
parent object is at the top of the hierarchy
and its children are below it. Children in
the hierarchy can also have children
creating a branched hierarchy.

In a hierarchy created using links, the
parent object is obviously the parent
object in the link. The children are any
object linked to the parent. If you have
multiple linked objects in a hierarchy, the
parent object at the top of the hierarchy is
the parent object in the first link you
created.

Parent
Object

v Sphere 1
w Sphere 2

w Sphere 3
1

Child Object "

In this link hierarchy the parent object has one
child and that child has two children one of
which also has a child. So if you were to
transform this hierarchy, any operation you
perform on the Parent at the top of the hierarchy
is applied to all its children.

Cube 2
Cube 1

In a hierarchy created using groups, the
parent object is the group. All the objects
within the group are the children. If you
have multiple groups within a group, the
parent object is the final group you
create.

¥ Sphere 2
Cube 3
Cube 2
Cube 1

Parent Object

w Sphere 3

Cube 4

Child Object

In this group hierarchy the parent group has
four children one of which is a group that
contains four children. If you were to transform
this hierarchy, any operation you perform on the
parent group would be applied to all the
children.

A hierarchy can be made up of both
linked and grouped objects. One way of
creating this type of hierarchy is by
grouping the parent objects from
different link hierarchies together. In this
case, the final group you create would
become the parent object of the
hierarchy.

o _-'---.___-_‘_ —
You cannot create a group using a
child object. Only parent objects can
be part of a group. When the parent is
in a group all its children are also part
of the group since they must follow the

parent.

I _-'-‘---L.‘___‘_ i
You could also create a hierarchy where a
group is linked to a parent object. In this
case, the parent object of the hierarchy
would be the parent from the first link
you created.

Parent Object

¥ Sphere 1

- Sphera 2
Cube 5
Cube 4

Cube 1
Cube 2

Cube 3

1
Child Object ' '

In this hierarchy the parent object is a group that
has four children one of which is the parent
object of a link hierarchy that has two children.
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Viewing Object Hierarchies

The Hierarchy list area of the Advanced
Motion Lab lets you see a list of all the
objects in your scene. Object hierarchies
are indicated by indents. A parent object
is listed at the far left of the area; its
children appear indented beneath it.

The name of an object that appears in the
Hierarchy listing can be set using the
Object Attributes dialog. If no name is
set, a default name is used (for example
Sphere 1).

These names are unique for each item in
the scene, and are not reused regardless of
the number of objects you create or
whether the object has been deleted.

Parent Object

Child Object
Child Object

An indented listing indicates that there is a
parent-child relationship between objects.

To view a listing of the hierarchy:

1. In the Working window, make sure
there are no objects selected. This will
let you see all the hierarchies in your
scene.

304 Chapter @ Bryce 3D

2. Click the Advanced Motion Lab
button at the bottom of the window.
The Advanced Motion Lab appears.

&

The Advanced motion Lab buttons displays the
Advanced Motion Lab where you can see the
hierarchy listing for your scene.

The Hierarchy List area, located
along the bottom-left side of the lab,
displays all the hierarchies in your
scene.

Expanding and Collapsing a Hierarchy

The arrow buttons next to an object’s
listing indicate whether the hierarchy is
expanded or collapsed. A collapsed
hierarchy shows only the parent objects
in the hierarchy. An expanded hierarchy
shows a listing for all the children.

Expanded Hierarchy

Parent Object

v Sphere 1
Cube 1
Posibon

Child Object

Ratakion

Collapsed Hierarchy

The arrows along the left side of the hierarchy
list indicate whether the hierarchy is open or
closed.

To expand/collapse a hierarchy listing:

o Click the arrow icon that appears
next to a listing’s name to expand it.

Click the arrow again to collapse the
listing.



Linking Objects

When you link two objects, you connect
them so that when one object moves, so
does the other. This is called a Parent/
Child link.

In a parent-child link, the parent controls
the actions of the child. This means that
when the parent object moves, so does
the child object. However, when the child
object moves, the parent object does not.

Parent moves
M‘” Child move;

In a parent-child link, the movement of parent
object dictates the movement of the child.

. Parent doesn’t move

cﬁild moves

However, the parent object is unaffected by the
child object.

A child object will start its movement
from it original position and always
maintain a constant distance from the

parent. The distance is determined by the
original positions of the objects before
they were linked.

The movement of the child object
depends entirely on the type of
transformations you apply to the
parent object.

If you rotate the parent, the child will orbit
around it like a moon around a planet.

«
h @

If the parent is moving along a path, the child
will match the trajectory of the parent’s path,

but maintain a constant distance from the
parent object.

0g

If both the parent and the child are moving
along a path, the child object moves along its
path while matching the trajectory of the parent
object’s path.

To link objects in the Working window:

1. Select the object you want to set as
the child object. A series of icons
appear next to the object’s
bounding box.

FEEHSE>

The icons along the right side of the object’s
bounding box let you interactively link objects.
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g I 2. Click the Link icon and drag the
e linking line to the object you want to
o use as the parent object.
11' .| . |
| b W " _-_-l—l___________,
“t You cannot create a link where the
1 parent object is the child of its own
iy child object (i.e.; a loop).
ol -"_.' - _-_ﬁ_\___-__ = L
L The parent object turns blue.
T
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The object you select first becomes the child
object. The object you drag the link line to
becomes the parent object.
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Attributes dialog:

1. Select the object you want to use as
the child object.

2. Click the A icon that appears next to
the object’s bounding box. The
Object Attributes dialog appears.

3. Click the Linking tab.

Object Attributes
Linking

General

Object Parent Name
[ Cylinder 1 ]
Propagate ® Distance @ Aolation
& Offsel o Size

Track Object Name
[ Sphere 1 ]
Orientation ® +X Y 9 +Z
P X d ¥ 92

Use the options on the Linking tab of the Object
Attributes dialog to setup the linking
relationships between objects.

4. Click the Object Parent Name menu
and choose the name of the object
you want to use as the parent object.

5. Click the OK icon to link the two
objects.

To break a link:
1. Selecta child object.

2. Click the A icon that appears next to
the object’s bounding box. The
Obiject Attributes dialog appears.

Click the Linking tab.

4. Click the Object Parent Name menu
and choose None.

5. Click the OK icon to unlink the two
objects.

Linking Options

Using the options available in the Linking
tab on the Object Attributes dialog, you
can control which parent object
transformations are applied to child
objects and how objects are constrained
when they're linked to a path.

Parent to Child Transformations
Options

Once you've created a link you can
determine exactly which transformations
applied to the parent will affect the child.



To set which parent object
transformations are applied to a child:

1. Display the Object Attributes dialog.
2. Click the Linking tab.

3. Disable the buttons for the
transformation you don’t want
applied to the child.

Object Parent Name
Sphere 1

& [hslamnce
& Offset

& Holalion
o Size

Propagate

The enabled buttons on the linking portion of
the Linking tab represent the transformations
that will be applied to child object.

Geometric Path Linking Options

A Geometric path is an object that acts a
kind of track for controlling the motion
of objects. Normally when you link an
object to a Geometric Path it is
constrained to the path. However, using
the linking options in the dialog you can
disable or enable constraining.

When an object is constrained to the
path, it can only move along the path.
When its not constrained it acts like a
regular child of the path. Its movement is
not constrained to the path.

The options in this dialog also let you set
where on the path a object begins its
motion.

_ ——
= =
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Refer to “Creating Geometric Pa-ths”
on page 124 for more on Geometric
Paths.

——
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To constrain/unconstrain an object to a
geometric path:

1. Select an object linked to a geometric
path.

2. Display the Object Attributes dialog.
Click the Linking tab.

4. Enable the Constrain to path button
to constrain the object to the path.

* Disable the button to
unconstrain it.

ps— -3
To set where the object sits on the -
path: "*?‘i
1. Select an object linked to a geometric L r
path. k:’-.p-

2. Display the Object Attributes dialog.
Click the Linking tab.

4. Enter a percentage in the Position
field. i

100% places the object at the end of
the path, and 0% places it at the
beginning.

Grouping Objects

As your scene becomes more complex

you'll want to group objects. Grouping

lets you control a set of objects as a single k5
unit. When you perform a
transformation on a group all the objects
are equally affected. If you scale a group,
all the objects change size, or if you rotate
a group, all the objects rotate around a H
single axis. § e

The objects you place in a group depend
on how you want to organize your scene.
You may want to group the objects that
comprise more complex objects, like the
walls and turrets of a castle.
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You can group objects to keep all the components
of a complex object like this castle together.
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You can also create groups to maintain
the spatial relationships between objects
as you transform them.

You can also create a group to maintain the
spatial relationships between objects as you
transform them, like the boards in this fence.

You can place as many objects as you like
in your group. You can even nest groups
within groups. Nesting can be an easy
way of managing more complex scenes.

Groups are essential to creating Boolean
objects. Boolean operations will not work
unless the objects are part of a group.
Refer to “Creating Boolean Objects” on
page 121 for more on Booleans.

" i } _-"--.___-_‘_ —
You cannot create a group using a
child object. If a child object is part of
your selection the “G” icon will not
appear, meaning that you can't create
a group from the objects.

_',.d" _H-h__‘__ e

To create a new group:

1. Select all the objects you want to
group.

2. Choose Objects menu>Group, or
press Command/Ctrl-G. You can also
click the G button next to the selected
objects’ bounding box.

&

Click the G button next to a selection’s bounding
box to create a group.

To select objects within a group:

o Hold down Control/Ctrl and click on
the object inside the group bounding
box.



Families

Families are a way of creating “logical
groups.” Unlike regular groups, families
are not treated as a single unit for
transformations. Families help you keep
track of elements in you scene, and can be
used for selection purposes. For example,
you can put all the elements that make up
the background of your scene in to one
family, all the items with a particular
material in an another, all trees in
another and so on.

Each family has a different object color.
The color appears only when the object is
not selected, since a selected object’s
bounding box appears red.

You can easily see which objects belong to the
same family when there no objects selected in the
Working window.

To create a new family:

1. Select all the objects you want in the
family.

2. Click the colored box next to the
selection’s bounding box. The Family
dialog appears.

Click the gray box next to a selection’s bounding
box to create a family.

3. Click on acolor. The color is applied
to the bounding box of all the objects
in the family.

4. You adjust these colors by dragging
the rectangular color swatch at the
bottom of the dialog. It’s best not to
use black or white since they are
difficult to see, or red since it’s the
color of a selected object.

5. Enter a name for the family in the
text field.

To select a family: =

1. If the Animation controls are visible
at the bottom of the Bryce window, ey

click the Swap button to display the .F_:"-.p-
Selection palette. =
» If there is nothing at the bottom

of the window, move your cursor

over the bottom area. The

Selection palette appears. i

2. Click the Family button and choose
the name of the family you want to
select from the menu.

e

The Families button in the selection palette
displays a list of all the families in your scene.
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Editing Objects

W i e
Overview T
Every object in Bryce has attributes that y
allow you to control everything from its
position in the scene to how it animates
along a path. Some objects have special
editors that are specifically designed to %
adjust the attributes that are unique to ol
the object type. il
This chapter describes how you edit - L
object properties and also covers how to S
use the Torus and Stone editors. R
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Restormg Objects

Every object in Bryce has a default size
and shape. When you create an object,
the default size is used to define its size
and placement.

As you transform and edit objects these
default properties are discarded and
replaced. However, you can return an
object to its original state at any time.

The restore control returns the object to
its default size and orientation, regardless
of the number of transformations you've
applied to it.

When you use the restore control, the cursor
changes to a 1 when passed over the object’s
bounding box.

To restore an object:

o Hold down Control-Option/
Alt+Shift and click one of the
bounding box handles.
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Edltmg Object Attrlbutes

Every object in Bryce has several
attributes that let you control the object’s
size, position, rotation, Boolean state,
preview and whether or not it’s locked.

There are two ways of editing an object’s
attributes: the Object Attributes dialog
and the Object Attribute controls that
appear next to the object’s bounding box.

Object Attributes Dialog

The Object Attributes dialog contains
three tabs which let you set various object
properties:

» General contains options that let you
set the object name, position, size,
rotation and display quality.

+ Linking contains options that let you
set up a link between two objects. You
can also use this tab’s options to set
up a tracking link.

* Animation contains options for
controlling the display of motion
paths and setting motion path type.

Oibjer Attribuies

s |

Use the Object Attributes dialog to set
transformation, linking and animation object
properties.

To display the Object Attributes dialog:

1. Select an object.

2. Choose Object menu> Edit
Attributes, or press
Command-Option-E/Ctrl+Alt+E, or

click the A button next to the object’s
bounding box.



Object Attribute Icons

The Object Attribute icons appear as a list
of buttons along the right side of an
object’s bounding box. The icons that
appear in this list vary depending on the
type and number of objects selected.

These icons let you:

*  Access the Object Attributes dialog,
the Material Composer and any
editors associated with the object

+ Group objects in a selection
* Add objects to families

+  Align objects

* Link objects

+  Set up object tracking

WA
| |
i

=1
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The Object Attribute icons that appear next to

an object’s bounding box let you access different
editors and set object attributes.

If your selection falls outside of your
Working window, the icons appear in the
rightmost area available on the screen.

To display Object Attribute icons:
o Select an object or group of objects.

There may be up to six controls available.

Object Attributes Icon

Al

This control displays the Object
Attributes dialog. When the dialog opens,
it shows the current name, position,
orientation and scale of the object.

To display the Object Attribute dialog:
1. Select an object or group of objects.

2. Click the A icon that appears next to
the object’s bounding box.

Families Icon

This control indicates the family to which
the object belongs. It also displays the
Family dialog. Refer to “Families” on
page 309 for more information.

To add selected objects to a family:

1. Select all the objects you want to add
to the family.

2. Click the Family icon that appears
next to the object’s bounding box.
The Family dialog appears.

3. Choose a color that represents an
existing family, or enter a name to
create a new family.

Family

8-

Crefault Farnily

Use the Families dialog to add an object to an
existing family or create a new one.

4. Click the OK icon. The color you
select becomes the object’s
wireframe color.
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Linking Icon

l

This control lets you set up a parent-child
link between two objects. When the
objects are linked, the transformations
you apply to the parent object affect the
child. Refer to “Linking Objects” on

page 305 for more information.

To link one selected object to another:

1. Select the object you want to be the
child object within the link.

2. Click the Link icon and drag it to the
object you want to be the parent
object. Release the mouse button
when the parent object turns blue.

A link line extending from the child
object to the parent appears as you
drag.
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As you drag the Link icon, a link line extends
from the child object.

Tracking Icon

(-]
rih

This control lets you set up a Tracking
link between two objects. When an object
tracks another, the selected object pivots
as the target object changes position so
it’s always faces its target. Refer to
“Tracking Objects” on page 378 for more
on tracking.

To set a selected object to track
another:

1. Select the object you want to be the
stationary object.

2. Click the Tracking icon and drag it to
the object you want to be the target
object. Release the mouse button
when the target object turns blue.

A tracking line extending from the
stationary object to the target appears
as you drag.

gl 3

.
-

As you drag the Tracking icon, a tracking line
extends from the stationary object.

Group Icon

<]

This control appears only if your
selection contains multiple objects. When
you click this control all the objects in the



selection are grouped. Refer to “Grouping
Objects” on page 307 for more on
grouping.

If this icon does not appear when you
have a multiple selection, it means that
you can’t group the selected objects
because of some kind of object hierarchy
conflict. Refer to “Object Hierarchies” on
page 302 for more information.

To group selected objects:

1. Select all the objects you want
grouped.

2. Click the G icon that appears next to
the object’s bounding box. A group
bounding box appears around all the
objects.

S

A large bounding box around a number of
objects indicates a group.

Ungroup Icon

Ui

This control only appears if you've
selected a group or a number of objects
contained in a group. When you click this
control, any group in the selection is
ungrouped. If the selection contains
nested groups, you can continue clicking
this control until all the groups are
ungrouped, or until the control
disappears.

To ungroup a selected group of objects:

1. Select all the objects you want
ungrouped.

2. Click the U icon that appears next to
the object’s bounding box.

Material Icon

M

This control displays the Materials Lab.
Refer to “Materials” on page 193 for more
on Materials. When you use this control,
the Materials Lab displays the material
currently applied to the selected object,
and the object appears in the Material
Preview area of the lab.

To display the Materials Lab:
1. Select an object or group of objects.

2. Click the M icon that appears next
the bounding box.

Edit Object Icon

E|

This control only appears if the object
you selected is a terrain, a symmetrical
lattice, a torus, a stone, an imported
polyhedron object or a light. When you
click this control, the editor for the object
type you have selected opens.

To display an object’s editor:
1. Select an object or group of objects.

2. Click the E icon that appears next to
the bounding box.

Land Object Icon
*

This control appears as either an arrow
pointing up or down, depending on the
position of the object selected.
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When you click this control, the object
snaps to the top of the object below it.
This control works like the Land
Selection option available in the Edit
palette. Refer to “Landing Objects” on
page 299 for more.

To land a selected object:
1. Select the object you want to land.

2. Click the Arrow icon that appears
next to the object’s bounding box.
The object snaps to the top of the
object directly below it.

If the selected object is below ground,
it snaps to the bottom of the object
directly above it.

Editing Object Names

The Object Name field in the General tab
of the Object Attributes dialog lets you
name a selected object. An object’s name
identifies it within the scene.

Object Name
| Easkethall ]

The Object Name Field lets you enter a name for
the selected object.
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When you have many objects of the same
type, object names are used to select a
specific object. The name is also used to
identify an object in a hierarchy. Object
hierarchies appears in the Hierarchy List
area of the Advanced Motion Lab. Refer
to “Object Hierarchies” on page 302 for
more on hierarchies.

Editing Boolean Attributes

Boolean attributes, listed in the General
tab of the Object Attributes dialog,
control how an object acts in a Boolean
operation. For example, if a boolean
attribute is set to Negative, the object
subtracts an area from a positive object.

These are examples of some of the objects you
can create using Boolean operations.

Refer to “Boolean Operations” on
page 121 for a complete discussion of
Boolean operations.

To set an object’s Boolean attributes:
1. Display the Object Attributes dialog.

2. Make sure the General tab is
displayed.

3. Enable one of the checkboxes at the
top of the dialog:

® Meutral

4 Posiliva
J Negalive
S inlersect

The four options on the top right side of the
General tab let you set an object’s Boolean
attributes.

Neutral defines any selected object,
objects, or group as non-Boolean. No
Boolean operation can be performed
on a neutral object.

Positive defines any selected object,
objects, or group as solid when
grouped; this is the default setting for
all objects.

Negative defines any selected object,
objects, or group as negative when
grouped. Think of a negative object
as a “cutting object.”

Intersect defines any selected object,
objects, or group as an intersecting
object when grouped.



Editing Display Quality Attributes

The display options available in the
General tab of the Object Attributes
dialog let you control how the object
appears in the Working window. Some of
these options can speed up the redraw of
your scene.

o Hidden

4 Locked

2 Show As Box

o Shew Ovigin Hamdle

The four options on the top left side of the

General tab let you set how the object is
displayed in the Working window.

Hidden

When you apply this option to an object,
it is not rendered when you render your
scene. The object remains visible in the
Working window, where you can still
select and edit it, but it will not be visible
in the final render.

To hide an object:
1. Display the Object Attributes dialog.

2. Make sure the General tab is
displayed.

3. Enable the Hidden button.

Locked

This option locks any selected object,
objects, or group, preventing
unintentional changes to size, position,
rotation, or material assignment. Locked
objects appear grayed-out in your
wireframe view.

To lock an object:
1. Display the Object Attributes dialog.

2. Make sure the General tab is
displayed.

3. Enable the Locked button.

To unlock an object:

1. Click the Swap button at the bottom
of the Working window to display the
Selection palette.

Use the Swap button to switch between the
Animation controls and the Selection palette.

wE

2. Click an object type button or hold
down the mouse while passing the
pointer over an object type button
and choose the desired object from
the menu that appears.

Show as Box

This option displays any selected object,
objects, or group as a box. This is useful
when you just want to work with the
object’s position, but don’t need more
details. It can speed up work in a complex
scene because it displays simpler objects.
You can still manipulate your object
using the bounding box control points.

To display an object as a box:
1. Display the Object Attributes dialog.

2. Make sure the General tab is
displayed.

3. Enable the Show as Box button.

Show Origin Point

This option displays the selected object’s
origin point. Once its displayed, you can
edit the position of the point to change
the object’s center of rotation. Refer to
“Object Origin Points” on page 286 for
more on origin points.

To display an object’s origin point:
1. Display the Object Attributes dialog.
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2. Make sure the General tab is
displayed.

3. Enable the Show Origin Point button.

Editing Transformation
Attributes

The numeric entry fields on the General
tab of the Object Attributes dialog
describe an object’s position, orientation,
and size in 3D space. You can adjust these
attributes by entering values in one or all
of the numeric fields.

Origin “l u} | u} |':I
Paosition a | 10.24 | u} | 2
Rotate | 0o |[ o [ o |°

size | 2042 || 2048 || 2048 |®
X Y Z

The Offset, Rotate and Size fields let you
numerically transform the selected object.

The values in this dialog use either
Absolute or Object Space coordinates for
transformations. Absolute coordinates
use the World Space X, Y, and Z axes as a
reference for transformations. Object
Space coordinates redefine how the
object is created in Object Space. Refer to
“Coordinate Systems” on page 283 for
more on these coordinate systems.
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Using Object Space coordinates can
create some unpredictable results
because you're redefining the entire
object when you change the Offset,
Rotate and Size values.

= e

To set an object’s origin point:

1. Display the Object Attributes dialog.

2. Make sure the General tab is
displayed.

3. Enter values in the Origin X,Y and Z
fields.

To set an object’s position:
1. Display the Object Attributes dialog.

2. Make sure the General tab is
displayed.

3. Enteravalue in the Position X field to
set the object’s position on the X axis.
This axis moves the object left or
right.

4. Enter avalue in the Position Y field to
set the object’s position on the Y axis.
This axis moves the object up or
down.

5. Enter avalue in the Position Z field to
set the object’s position on the Z axis.
This axis moves the object backwards
or forwards.

When you select multiple objects and
access this dialog, there are no values
displayed in the Position fields. If you
then enter a value in any offset field,
the selected objects are moved to the
new coordinate, essentially aligning
them in the same place relative to the
designated axis or axes.

To rotate an object:
Display the Object Attributes dialog.

2. Make sure the General tab is
displayed.

3. Enter avalue in the Rotate X field to
set the object’s rotation around the X
axis.

You can enter negative values, values
greater than 360 or values less than
-360. Bryce reduces the value to an
absolute value within a range of
0-360.

4. Enter avalue in the Rotate Y field to
set the object’s position on the Y axis.



5. Enter avalue in the Rotate Z field to

set the object’s position on the Z axis.

To set an object’s size:
1. Display the Object Attributes dialog.

2. Make sure the General tab is
displayed.

3. Enter avalue in the Size X field to set
the object’s size in the X axis.

You can enter negative values here if
you need to.

4. Enter avalue in the Size Y field to set
the object’s size in the Y axis.

5. Enter a value in the Size Z field to set
the object’s size in the Z axis.

When you select multiple objects and
access this dialog, there are no values
displayed in the Size fields. If you
then enter a value in any Size field,
the selected objects are scaled to the
new coordinate.

Editing Link Attributes

Link attributes control how an object is
linked to another. The controls on the
Linking tab of the Object Attributes
dialog let you set parent-child link
attributes and tracking attributes.

Linking

When you link an object to another, you
create a parent-child relationship.
Transformations applied to the parent
object affect the child, but
transformations applied to the child
object do not affect the parent. Refer to
“Linking Objects” on page 305 for more
on linking.

The Link options let you set the parent
object for the selected object and choose
which parent object transformations will
affect the child.

Object Parent Name

Sphere 2 |
® Distance  ® Rolation

& Offset % Size

Propagate

The Link options let you set up the attributes of
a parent-child link.

To link objects:
1. Display the Object Attributes dialog.
2. Click the Linking tab.

3. Click the Object Parent Name field
and choose a name from the menu
that appears.

Choose None to break a link.

4. Enable a Propagate option. These
options control which Parent object
transformations affect the child.

Tracking

When you set up a tracking link, the
stationary object tracks the target object
as it moves or rotates. Whenever the
target object moves, the stationary object
pivots so that its always facing the target.

The Tracking options let you set the
target object for the selected object and
define which axis of the stationary object
will face the target.

Track Object Name
Cube 1 |

Orientation ® +X J+Y J +Z
J =X 4 =¥ d £

The Tracking options let you set the attributes
for a link between a stationary object and its
target.

To set an object to track another:
1. Display the Object Attributes dialog.
2. Click the Linking tab.
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3. Click the Track Object Name field
and choose a name from the menu
that appears.

Choose None to break a tracking
link.

4. Enable one of the Orientation
options. These options set which
object axis will track the target.

Editing Animation Attributes

Animation attributes control the display
of an object’s motion path. A motion
path is a graphical representation of an
object’s trajectory over the course of the
animation. Refer to “Motion Paths” on
page 372 for more on motion paths.

The options on the Animation tab of the
Object Attributes dialog let you control
how an object’s motion path is displayed
in the Working window and how that
path is drawn.

Motion Path Display Options

Normally, a motion path is displayed as it
is being drawn and when the object is
selected. The motion path display options
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on the Animation tab of the Object
Attributes dialog let you control when the
motion path is displayed.

The Motion Path Display options let you control
when an object’s motion path appears.

To set motion path display options:
1. Display the Object Attributes dialog.
2. Click the Animation tab.

3. Enable one or all of the display
options:

Show Trajectory enables or disables
the display of the motion path. When
it is disabled, no motion path is
drawn.

Show When Selected displays the
motion path only when the object is
selected.

Show Always displays the motion
path at all times, even when the
object is not selected.

Motion Path Attributes

When a motion path is created, it looks
like a curve that extends out from an
object. The motion path attributes let you
display additional information on a
motion path.

J Hide Trajactory & Show Hanoles
J Show When Selecled ) Show Tangenis
& Show Always J Show As Ribbor

The Motion Path Attributes let you control the
appearance of an object’s motion path.

To set motion path attributes:

1. Display the Object Attributes dialog.
2. Click the Animation tab.

3. Enable one or all of the attributes:

Show Handles displays or hides the
path’s control handles. The handles
represent key frames.

Show Tangents hides or displays
lines extending from each control
handle. Tangents help you see the
slope of the curve.

Show as Ribbon displays the motion
path as a flat ribbon in the working
window. This makes the path easier
to see when you move the camera.



Align Options

Normally, unless you apply a rotation, an
object’s orientation remains constant as it
moves along a motion path. The align
options let you force the object’s
orientation to match the slope of the
motion path so that as the path curves
up, the object tilts up.

& Do Not Align

b Align

o Aligry with Twisting
b Aligrr with Aulo-Barnk

The Align options let you control how an object
is aligned to its motion path.

To set align options:

1. Display the Object Attributes dialog.
2. Click the Animation tab.

3. Enable one or all of the options:

Do Not Align disables aligning. The
shape of the curve has no effect on
the object’s orientation.

Align adjusts the object so that its
orientation matches the shape of the
path.

Align with Twists changes the
object’s orientation along any twists
in the motion path.

Align with Autobanking
automatically banks the object from
side to side according to the shape of
the motion path.

Motion Path Geometry Options

The shape of a motion path is determined
by the position of the object as it moves
through the animation. The motion path
geometry options let you change the
shape of the path to create different
effects.

J Make One-Shot
J Make Hepeal
J Make Pendulum
J Make Chrouwlar

The Motion Path Geometry options let you
control the shape of an object’s motion path.

To set motion path geometry options:
1. Display the Object Attributes dialog.
2. Click the Animation tab.

3. Enable one or all of the options:

Make One Shot restores the path to
its original shape, meaning the shape
created by changes in the object’s
position.

Make Repeat creates a loop in the
action. The motion on the path will
continuously repeat.

Make Pendulum creates a repeating
cycle in the action along a path. The

object will move forward on the path
and then back.

Make Circular closes the path to
create a circular path. The object will
move along the path until it reaches
the end. It then swings around to the
front of the path and starts over.
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Editing Toruses
A torus object is any pre-made
donut-shaped object in Bryce. The Torus

editor lets you adjust the inner radius of
any torus object.

Edit Torus |

1 | 100 | Facius

Use the Torus editor to adjust the inner radius of
a torus object.

To display the Torus editor:
1. Click a Torus object.

2. Click the E button that appears next
to the object’s bounding box.

To adjust the inner radius:

o Pressand drag on the spinning Torus.
Release the mouse when the radius is
the size you want.

322 Chapter @ Bryce 3D

To accept your changes and exit the
Torus Editor:

o Click anywhere outside the Torus
Editor, or press the Return/Enter key.

To exit the Editor without accepting any
changes:

o Press the Escape key.

Editing Imported
Polyhedrons and Stones
Imported objects (such as DXF or 3DMF

objects) and Bryce’s Stone objects are
both treated as polyhedrons inside Bryce.

The Polyhedron Editor lets you adjust the
smoothness of an object’s surface. You
can smooth objects that are very rough or
remove the smoothing previously applied
to DXF objects.

It is not a good idea to smooth or
unsmooth Stones. These objects are
highly dependent upon the clumpiness of
the polyhedral shape as well as the
bumpiness in the assigned procedural
texture to retain their realism. Smooth
stones look very unnatural.

To smooth imported objects or stones:
1. Click the imported object or stone.

2. Click the E button that appears next
to the object’s bounding box.

3. Adjust the value of the smoothing
range by dragging the gauge along
the left side of the dialog.

The gauge sets the maximum angle
you wish to be smoothed.

For instance, you may wish to
smooth all angles under 90° (to
preserve the sharpness of cubes,
perhaps). In that case, set the
maximum angle to 85 before
smoothing.

4. Click the Smooth button until you
achieve the desired effect. The more
you click, the smoother the object
becomes.

To unsmooth imported objects or
stones:

1. Click the imported object or stone.

2. Click the E button that appears next
to the object’s bounding box.



3. Adjust the value of the smoothing
range by dragging the gauge along
the left side of the dialog.

The gauge sets the maximum angle
you wish to be unsmoothed.

For instance, you may wish to
unsmooth all angles under 90°. In
that case, set the maximum angle to
85 before unsmoothing.

4. Click the Unsmooth button until you
achieve the desired effect. The more
you click, the sharper the object
becomes.

Converting Objects
The Convert tool in the Edit palette lets
you covert any type of object into another
type of object with a single click. So you
can change a square into a light, a terrain

into a sphere, or an infinite plane into a
cone.

Any transformations you applied to the
original object are preserved through the
conversion.

The Convert tool lets you quickly turn any object
into any other. In this example, the object
changed from an Egyptian pyramid...

...to a rocky desert by converting the pyramid
primitive into a plane.

f_,.— _-'-'-'--.-_-______.__J
Conversions cannot be animated. You

can’t have a box that turns into a cone
over time.

e

To convert an object to another type of
object:

1. Select the object you want to convert.

2. Click the Edit button at the top of the
Bryce window to display the Edit
palette.

3. Click the double-headed arrow in the
top left corner of the palette and
choose an object type from the
pop-up palette that appears.

-y

The pop-up palette that appears in the Edit
palette displays all the object types you can
convert your selected object to.
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The Camera and
Lights

™
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The View of Your Scene and
Lighting in Bryce 3D

You can think of the view of your scene as
the view seen through a window onto a
whole new world. The view you see
through this virtual window is
determined by the orientation and
position of a camera. As you move the
camera, you get a different view of your
world.

How much of the world is visible is
determined by the lighting. The position
of the light sources in your scene can
determine everything from visibility to
the time of day to the color of the
atmosphere.
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The View of Your Scene

The view of your scene refers to the
portion of the scene visible in the
Working window. There are eight views
of your scene available in Bryce: the
Camera View, which is the view produced
by the Camera in the scene, the Director’s
View, which shows your scene from the
perspective of a director sitting outside of
the scene, and the orthogonal projections
(Top, Bottom, Left, Right, Back and
Front) which are perspective-free views
of your scene.

Camera View

Camera View is produced by the Camera
which exists in 3D space, meaning that
you can view your scene from anywhere
within your Bryce environment—even
underneath it. The Camera View can be
positioned using the positioning tools or

by repositioning the Camera in the scene.

The Camera has a wireframe which can
be dragged in the Working window and
its motions can be recorded as an
animation. However, the wireframe is
only visible in the Director’s View or one
of the orthogonal views.
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Director’s View

The Director’s View gives you the
freedom to look at your scene from any
perspective, while still being able to
manipulate the Camera as an object.

The Director’s View motions are not
recorded as part of an animation. This
means that you can move to any position
without inadvertently changing the view
of your scene in the animation. The
Director’s View can also be an invaluable
tool for animating the view of your scene.
While in this view, you can select the
Camera and reposition it anywhere in the
scene to create camera motions.

Director’s View is the default view of
the scene.

This is what your scene looks like when you view
it in Director’s View.

Orthogonal Views

These six views you let you see the scene
from all sides. They do not show you any
perspective, but you can see all the
objects in the scene including the camera.

These views are only flat projections of
the scene, so you can’t move around them
using the positioning tools.

i
Lights
Lighting is what makes your scene visible.
Different types of lighting can

dramatically alter the appearance of your
scene and the objects in the scene.

In Bryce, most of the lighting in your
scene is provided by either the sun or the
moon. As in nature, the position of the
Bryce sun controls the general brightness
and ambient color of scenes. However,
you can add additional light sources to
create a variety of effects, like adding
headlights to a car, or creating the glare of
a distant city.



You can use light sources to shine light from
areas where sunlight couldn’t shine, like the light
from inside a lighthouse.

Refer to “Working with the Sun” on
page 149 for more on positioning and
setting up the sun.

Viewing Lights

In Wireframe mode, lighting effects are
not visible. Instead, all objects are
displayed as wireframes to make it easier
and faster for you to edit and position
objects. Lighting appears in three places:
the Shaded Preview mode, the final
rendered scene, or in the Nano-Preview.

In Nano-Preview, you can see a small
preview of your lighting effects. This is
the only preview available in
Wireframe mode.

Lighting effects also appear in the
Nano-Preview.

In Shaded Preview mode, all the objects
in your scene appear as flat solids. Any
lighting you apply creates simple
highlights on the surface of the object.
This mode does not show materials.

In Shaded mode the objects in your scene are
displayed as solids. You can also see the effects of
different lighting.

- "‘_-I-.-.-_-_l___-_ o

Shaded Preview mode is only available
if you have a system that supports
OpenGL. Refer to “Display Modes” on
page 23 for more on this mode

_.l"'"-- -"_H‘__-_ _"u’_

If you want to see the effects of lighting
on object materials, you'll need to render
the final image.

—
—
—
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When you render your scene you can see the
effects of light position and color on your object’s
materials.
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Visible Lights

One of the most spectacular uses of light
sources is visible light. Visible light effects
are like cones of light that appear in your
scene, like a searchlight cutting through
the fog.

The effect of a searchlight cutting through the
fog can be created using a visible light.

There are two types of visible lights:
surface visible lights and volume visible
lights.

Surface visible lights make the light
object visible in the scene, but the light
does not interact with the environment,
S0 you get a light cone or sphere. Volume
visible lights interact with the
environment, affect all the object s that
they strike, and are directly affected by
environment color and brightness. For
instance, volume visible lights can show
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shadows thrown through the air that the
light illuminates. Surface visible lights
cannot.

The volume visible light source interact with the
other light sources in the scene.

f__ —-_----‘-__-_ 2 _.‘u’.
Refer to “Creating Visible Lights” on

page 347 for more on setting up
surface and volume visible lights.

I _,____-‘..-_-___.‘F*
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Setting Up the View of Your
Scene

There are eight different views of your
scene available in Bryce: Camera View,
Director’s View, and the six orthogonal
views. The Camera View and Director’s
View let you see the scene from any
perspective, while the orthogonal views
let you see projections of the scene from
the top, bottom, left, right, front and
back.

Camera View

This view of your scene in the Working
window is as seen through the lens of the
Camera object in your scene.

Since your scene exists in 3D, you can
view it from any vantage point: above,
below, or even from inside an object. To
see these different perspectives, you
change the position of the Camera. The
positioning tools available in the Control
palette let you position the Camera along
specific axes and change its orientation.

As you create and position the objects in
your scene, you can use the position and
orientation of the camera (called Camera
Space) as a reference for several
transformation operations. You can



rotate, position and resize objects using
Camera Space. Refer to “Camera Space”
on page 282 for more information.

When you've completed your scene, the
Camera View can be used to create the
final rendered image or animation. You
can reposition the camera again and
render the scene from several different
viewpoints.

The camera can also be animated just like
any other object.You can record changes
in its position at different points along
the timeline. When you run the
animation, the view from your camera
appears to change like the view seen from
an airplane as it flies through a landscape.
Refer to “Animating the Camera” on
page 379 for more on animating the
camera.

When you're in Camera View, a small
camera icon appears in the View control.

‘(‘_-;l

The camera icon in the View Control indicates
that you're in Camera View.

To switch to Camera View:

o Click the triangle icon next to the
View Control icon and choose
Camera View from the menu.

or

o Drag over the View Control until the
Camera icon appears.

Setting Camera Object Properties

Since the Camera acts as an object, there
are several object properties you can use
to set how it’s displayed, linked or
animated.

Refer to “Editing Link Attributes” on
page 319 for more on linking properties
and “Editing Animation Attributes” on
page 320 for more on Animation
properties.

To hide the camera wireframe:

1. Switch to Director’s View or an
orthogonal view so you can see the
camera’s wireframe.

2. Select the camera in the Working
window.

3. Click the A icon that appears next to
it. The Camera & 2D Projection
dialog appears.

4. Enable the Invisible option.

To display the camera’s field of view:

1. Switch to Director’s View or an
orthogonal view so you can see the
camera’s wireframe.

2. Select the camera in the Working
window.

3. Click the A icon that appears next to
the camera object. The Camera & 2D
Projection dialog appears.

4. Enable the Show FOV option.

To lock the camera position:

1. Switch to Director’s View or an
orthogonal view so you can see the
camera’s wireframe.

2. Select the camera in the Working
window.

Click the A icon that appears next to
its bounding box. The Camera & 2D
Projection dialog appears.

4. Enable the Locked option.
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Director’s View

Director’s View lets you view your Bryce
environment through the eyes of a
director sitting outside the scene
directing the action of all the
objects—including the camera. The
camera that generates the Director’s view
cannot be seen or positioned like an
object. You have to use the positioning
controls to move this view. As well, the
motion of this view is not recorded as
part of an animation.

When you're working on a still image,
you can use Director’s View to get a
second perspective on your scene. You
can also render your image from either
camera.

The real power of the Director’s View
becomes obvious when you're working
on camera animations. Animating
camera motions while in Camera View
can be tricky at best and very
unpredictable at worst. However, in
Director’s view you can see the camera as
an object, which means that you can set
up camera motion just like you would
any other object.
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Camera View
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Director’s View

In a still image, you can use both the Director’s
View and the Camera View together to get
different perspectives on your scene.

To switch to Director’s View:

o Click the triangle icon next to the
View Control icon and choose
Director’s View from the menu.

Swapping Director’s Views for Camera
View

The Director’s View and the Camera View
are interchangeable. So you can move the
Camera View to the position of the
Director’s View, or vice versa.

-F. _-—.|_..___ — - >
Even though you can'’t directly position
the camera that produces the
Director’s View in the Working window,
you can set up a Director’s camera
position by dragging the Camera to a
position in the scene and then
swapping the Camera position with the

Director’s View position.

To swap the Director’s View position for
the Camera View position:

o Click the triangle icon next to the
Camera Cross controls and choose
Match to Camera View from the
menu.



Orthogonal Views

There are six other views available
through the View controls, but these
views are not generated by any camera.
The other views (Top, Bottom, Left,
Right, Back and Front) are
perspective-free views of your scene
called orthogonal projections. When you're
using one of these views you cannot use
the Camera controls.

Refer to “Orthogonality and Views” on
page 31 for more on orthogonal views.

The orthogonal views are another way of
seeing the camera as an object in the
scene. This can be invaluable when you're
animating the camera, or setting up a
complex scene.

Using the orthogonal views, you can quickly
move to different views of your scene. These

views also let you see the camera as an object.

e e

If you hit the Render button Whil-e inan
orthogonal view, Bryce moves the
camera to the position you need, and

e

renders your image. Refer to

“Rendering” on page 399 for more on

rendering.
-~ e

-
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Positioning the View of Your
Scene

When you position a view, you're
affecting the position and orientation of a
camera, not the scene. The scale and
position of objects remains constant; only
your view of the scene changes.

The controls described in this section can
be used to position either the Camera
View or the Director’s View. However,
some controls, like the Trackball, are
limited when you're in Camera View.

The controls behave differently
depending on the Camera Mode you
select.

Bryce has two sets of controls for
positioning your view of the scene: the
Trackball and the Camera Cross controls.

The Trackball lets you adjust the position
of the camera, as well as its orientation.
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Field of View

4

Banking Control

Camera Trackball

The Trackball lets you adjust the position and
orientation of the camera.

The Camera Cross controls change the
position of the camera along the X, Y and
Z axes.

Y-Z Cross

X-Z Cross X-Y Cross

The Camera Cross controls let you adjust the
position of the camera in the X, Y and Z axis.
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Camera Modes

The cameras in Bryce have four modes
that affect the behavior of the all the
positioning controls. Three of the modes
are only available when you're in
Director’s View. The only mode available
in Camera View is Free.

Trackball Mode

In this mode the camera orbits around
your scene. The center of the orbit, or
origin, is the center point of a box which

encompasses all the objects in your scene.

3 l'g

In Trackball mode the camera orbits around the

center point of a box that surrounds all the
objects in your scene.

g

When the size of your scene changes, so does the
center of rotation of the camera.

As the size of your scene changes, so does
the size of the box, which changes the
box’s center point. As a result, the center
of rotation for the camera also changes as
you change the size of your scene. In fact,
in this mode the camera’s center of
rotation is constantly updated so that it
always remains in the center of the scene.

Center to Selection Mode

In this mode the camera also orbits
around the scene. The center of the orbit,
in this mode, is a selected object. The
selected object becomes the pivot point
for the camera. As the object moves so
does the camera’s center of rotation. This
mode is the best way of making sure that
specific objects always remain in view.



Tripod Mode

In this mode the center of rotation is
fixed at the center of the camera, so it
actually pivots in place. As its name
suggests, the camera acts like it's on a
tripod. It can rotate around, or tilt up and
down, but it always remains in place.

J‘-. _-—.|_.._.__ — -
Use the Tripod mode in conjunction
with the Eye Level Camera command
to get a sense of height. Refer to
“Camera Cross Options” on page 335
for more on this command.

- e —
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Free Mode

In this mode the camera is completely
unconstrained. Its center of rotation can
exist anywhere, from its center to a point
somewhere in the scene. Since the
placement of the camera’s center of
rotation is not limited, this mode can
simulate any of the other modes. For
example, if you place the camera’s origin
point in its center, it acts like its on

a tripod.

e

In Free mode the camera can move to any point
and can rotate around its center or any other
point in the scene.

J‘-. _-—.‘_.._.__ — -
Refer to “Manually Positioning the
Camera” on page 338 for more on
positioning the camera’s origin point.

-~ T ———

To choose a camera mode*:

1. Double-click either the Trackball or
one of the Camera Cross controls.
The Camera & 2D Projection dialog
appears.

2. Make sure the General tab is visible.

3. Click one of the mode buttons at the
top of the dialog.

- —————
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You can also switch between modes by
clicking the triangle icon next to the
Trackball and choosing a mode from
the menu.

_ ————
= o
- e - > - -

Using the Trackball

The Trackball lets you rotate the camera
around its origin point. The position of
the origin depends on the Camera mode
you select. Refer to previous sections for
more on these modes.

The Trackball doesn’t rotate the scene, it
only changes the camera’s location
(Offset) and orientation (Rotation)
relative to your scene.

To move the camera using the Camera
Trackball:

o Drag the mouse over the Camera
Trackball control. The view of your
scene moves in the direction
you drag.
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Using the Cross Controls

Camera Cross controls let you move the
view of your scene along specific axes.
When you're using these controls, the
view does not tilt or rotate from its
original position. It only moves up,
down, back or forward.

. ———
. =
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Camera controls are not available if
you are in any Orthogonal View. When
unavailable, these controls turn white.
If you are in an Orthogonal View, you
must use the Zoom and Pan tools for
navigation. Refer to “Orthogonality
and Views” on page 31 for more on
these views.

o e
o E
- e - . -~

The Camera Cross controls behave
differently depending on Camera Mode
selected:

+ In Trackball and Center to Selection
modes the Cross controls change the
position of the camera, but the origin
point remains the same. So in this
mode the controls are actually
adjusting the radius of the
camera’s orbit.
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* In Tripod mode the controls change
both the position of the camera and
the origin point.

* In Free mode, the controls change
position of the camera and its origin
point at the same time. In this mode
the relative positions of the camera
and the origin point remain the
same. So, if the camera’s origin point
is offset, it will remain offset when
you use the Camera Cross controls.

= ey r
If you hold down Option/Alt Whiie in
this mode, the origin point will

remain fixed.

o R
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There are three Camera Cross controls
available:

X-Y Cross

The X-Y Cross provides control for
horizontal and vertical motion. The
sphere at the center of the cross lets you
move the camera in both the X and Y
axis. The arrows let you constrain
movement either horizontally or
vertically.

This control affects your camera’s
position (Offset) only, not its orientation
(Rotation).

X-Z Cross

The X-Z Cross provides control for
horizontal and depth motion. The sphere
at the center of the cross lets you move
the camera in both the X and Z axis. The
arrows let you constrain movement either
horizontally or vertically.

This control affects your camera’s
position (Offset) only, not its orientation
(Rotation).

Y-Z Cross

The Y-Z Cross provides control for
vertical and depth motion. The sphere at
the center of the cross lets you move the
camera in both the X and Z axis. The
arrows let you constrain movement either
horizontally or vertically.

This control affects your camera’s
position (Offset) only, not its orientation
(Rotation).



To move the camera in two axes at

. once:
- #
1. Drag the sphere at the center of one
- of the Camera Cross controls. The
\_ﬂ_’- cursor becomes a four-way arrow.
S The motion of your mouse
Use these controls to move the camera along the determines the direction of the
Y axis. camera movement:

X-Y Cross: moving up, down, left
' and to the right, moves the camera
’ m up, down, left and to the right.
- X-Z Cross: moving up, down, left
w o, and right moves the camera forward,
backward, left and to the right.

L Y-Z Cross: moving up, down, left
Use these controls to move the camera along the and right, moves the camera up,
X axis down, forward, and backward.

o Drag along the tip of an arrow.

When you move the cursor over an
arrow point, it changes to a letter to
identify the axis of constraint.

o

Use these controls to move the camera along the
Z axis

To move the camera along a single axis:

k
When you pass over a the tip of an arrow, the
cursor changes to a letter to identify the axis of
constraint.

Camera Cross Options

The Camera Cross controls have three
options that lets you move the camera to
create specific views.

To use a Camera Cross control option:

o Click the triangle icon next to the
Camera Cross controls and choose an
option from the menu:

L=

-“.r IrackBall

L[.{ LL :::‘:: b ] b

Iree Camera

Click the triangle icon next to the Camera Cross
controls to display the options menu.

Center Scene rotates the camera so
that all items in your scene are
centered in the Working window.
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This option only affects the camera’s
rotation, not its offset. If you can’t see
all the objects in your scene after
using this option, try pulling your
camera back a bit with one of the Z
Crosses.

Center Selection rotates your camera
such that any selected object or
objects will be centered in your view.
This option does not reposition the
object itself, only the camera’s
rotation relative to the selected
object.

Eye Level Camera repositions the
camera to just above ground level.
Use this command (especially in
conjunction with the Trackball’s
Tripod mode) to create the feeling of
large, looming mountains or other
objects. This is also effective in
concert with the Field of View
control.
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Banking Controls

The Banking control sphere tilts your
Camera (really rotating the camera on
the Z axis), creating the effect of a tilted
horizon. This control is great for creating
tilted airplane cockpit views. Banking
simulates a Roll action.

This scene was created by banking the camera.

To bank the camera:

o Drag the Bank control. Drag right to
bank to the right and left to bank to
the left.

Press Option/Alt-click in this control
to reset to normal. The normal, or
default, setting is zero.

Field of View

The Field of View control sphere acts like
a wide-angle lens control. The higher the
setting, the wider the field of view for
your lens.

Because you are admitting more
information into your lens, it will create
the illusion that objects are receding from
view, or getting smaller. That is not the
case. Since you're admitting more
information, existing objects necessarily
occupy a smaller percentage of space
within your field of view.

This scene was created by increasing the
camera’s field of view.

If you drag the Camera Z cross to bring
your “receding” objects back up to a
larger area in your view, perspective
distortion effects appear. This is
particularly effective for creating broad,
swooping cloud scenes.



When you view the camera in Director’s
View or one of the orthogonal views,
you'll be able to see the camera’s Field of
View displayed as a 3D pyramid that
extends out from the camera wireframe.

The large triangle that extends out from the
camera’s wireframe represents its field of view.
As the field of view changes so does the shape of
the triangle.

To increase/decrease the camera’s
field of view:

o Drag the Field of View control. Drag
right to increase the field of view and
left to decrease it.

Option/Alt-click on this control to
reset to normal. The normal, or
default, setting is 60°.

Positioning the Camera
Numerically

The most precise way of positioning the
view of your scene is by using the Camera
& 2D Projection dialog. This dialog lets
you enter values to set the camera
position, the position of the camera’s
origin point, rotation and field of view.
The dialog can be used to adjust either
the Camera View or the Director’s View.

When you display the dialog, you can see
the numerical position of the camera and
the position of its origin point. You can
also see the currently active Camera
Mode.

Camern & 20 Progection

| Ll RaRiE

The Camera & 2D Projection dialog lets you
view and set position, camera mode and origin
point position options for the current camera.

The dialog uses ether Absolute or Relative
coordinates for positioning values.

There are different options available in
the dialog depending on whether you're
in Camera View or Director’s View. When
you're in Camera View, the only Camera
Mode available is Free. As well, the Origin
fields are only available if you're using
Free Mode.

Since the camera is an object, there are
several more controls available when
you're in Camera View. These controls let
you set linking and animation options.
Refer to “Setting Camera Object
Properties” on page 329 for more.

To position the camera’s origin point
numerically:

1. Double-click either the Trackball or
one of the Camera Cross controls.
The Camera & 2D Projection dialog
appears.

2. Make sure the General tab is visible.
Click the Free Mode button.

4. Enter values in the Origin X,Y and Z
fields.
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To set the position of the camera
numerically:

1. Double-click either the Trackball or
one of the Camera Cross controls.
The Camera & 2D Projection dialog
appears.

2. Make sure the General tab is visible.

3. Enter values in the Position X, Y and
Z fields.

You can enter negative values here.
Technically, since the Bryce
environment is infinite, the range is
infinite as well, but higher values can
create unpredictable results. The
default values are 100, 30, and -100.

To rotate the camera numerically:

1. Double-click either the Trackball or
one of the Camera Cross controls.
The Camera & 2D Projection dialog
appears.

2. Make sure the General tab is visible.
3. Enter values in the Rotate X,Y and Z

fields. Values are expressed in degrees.
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X.Y and Z rotations are also known
as Yaw, Pitch and Roll. The Z
rotation, or Roll, field, describes the
current value for the Banking
control.

You can enter negative values in these
fields. The effective range is +/- 999.
Default values are 0, 45, and 0°.

To set the Field of View numerically:

1. Double-click either the Trackball or
one of the Camera Cross controls.
The Camera & 2D Projection dialog
appears.

2. Make sure the General tab is visible.

3. Enter a value in the Field of View
field.

The value in this field, expressed in
degrees, describes current settings for
the Field of View control. The
effective range is 1 to 180°, and the
default value is 60°.

Manually Positioning the
Camera

You can manually position the camera by
adjusting the position of the camera
wireframe in the Working window. The
camera wireframe is only visible when
you're in Director’s View or one of the
orthogonal views.

In the Director’s View, top, right, front,
left, back and bottom views (also known
as orthogonal), you will see a blue
Camera wireframe, which represents the
location of your Camera. You can then
drag the Camera wireframe to change
Camera position. The Nano-Preview
updates to reflect your changes.

The camera indicator only appears in either the
orthogonal views or the Director’s View. Drag
the indicator to adjust the camera’s position.



Camera Origin Point

In its default state, the Camera’s origin
point is not visible and is located at its
center.

When the Camera’s origin point is visible,
it appears as a green dot in the center of
camera’s wireframe.
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Origin Point
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The green dot in the center of the camera
wireframe represents its origin point.

You can simulate any of the camera
modes by dragging the camera’s origin
point to different locations in the scene:

+ Ifyou position the origin pointin the
center of the scene, the camera acts
like it’s in Trackball mode. When you
rotate the camera, it moves around
the position of the origin point.

+ If you position the origin point over
an object in the scene, it acts like it's
in Center to Selection. When you

rotate the camera object, it will pivot
around the object under the origin
point.

+ If you leave the origin point
positioned at the center of the camera
object, it acts like it's in Tripod mode.

Once you offset the origin point, all the
camera’s movements will be altered, so
when you switch to Camera View, the
camera may not move as expected.

To display the camera’s origin point:

1. Switch to one of the orthogonal views
or Director’s View.

2. Click the camera wireframe.

3. Click the A icon that appears next to
the camera’s wireframe. The Object
Attributes dialog appears.

4. Click the General tab and enable the
Show Origin option.

To position the camera manually:

1. Switch to Director’s View or an
orthogonal view.

2. Drag the camera wireframe to a
location in the scene.

or

*  Click the camera wireframe and
use the tools in the Edit palette to
move, or rotate it.

To position the camera’s origin
manually:

1. Inthe Object Attributes dialog,
display the camera’s origin point.

2. Drag the green point to a location in
the scene.

* Hold down Shift and click the
origin point, to reset it the center
of the camera object.
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Camera’s current aim. By dragging this

handle to a point in your scene, you can

Aiming the Camera | |
The only problem with positioning the // T change the Camera’s aim.
i ¥ .

Camera using the Orthogonal, or
Director’s views is that the view from the
Camera remains fixed as you adjust its
location, so you may inadvertently lose
the objects you were looking at when the
position of the Camera changes.

The handle that extends out from the front of
the Camera, lets you aim the camera.

il
v

When you change the aim of the Camera,
it rotates to face the new target, but
remains in the same position.

L T T T T e T T T T e T TR T YT

To change the Camera’s aim in an
orthogonal view:

- — = 1. In the Working window, click the
When you move the Camera, it’s still pointing in triangle icon next to the View
the same direction but from its new position, Control and choose top, left, right,
only one of the objects in the scene is visible. bottom, front or back from the
To solve this problem, Bryce lets you menu.
adjust the aim of the camera as you adjust

2. Drag the end of the control handle to
the point in you scene where you

When you look at the Camera as an want the camera to aim.
] . object, you'll see that there is a control

For example, at the beginning of this animation ~ handle extending out from the front of

the Camera is pointing at the object in the center the object. This handle represents the

of the scene. The view from the Camera shows

all the main objects in the scene.

its position.
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As you drag, the end of the handle
changes to a red dot so you can see
the aiming point better.

Y. 7
L I

As you drag the end of the camera’s control
handle, it changes to a red dot. The dot
represents the point where the camera will aim.

Saving Camera Positions

You can save your favorite camera
positions using the Memory dots. The
dots let you store up to seven different
views of your scene

@l —— Default position

_‘, Saved positions

Memory dots let you save views of your scene for
later use.

The uppermost dot, slightly separated
from the rest, is a quick way to return to
the default Bryce camera position. There
is no way to clear this dot. It will always
contain the default Camera settings.

Dot settings are saved with your scene
file, so if you open a previously saved
scene, your dot settings from the previous
session remain in place.

When you click on a full dot to activate it,
the saved position becomes the current
Camera View. If you switch to an active
dot, and then want to return to your
previous Camera View, undo the
operation.

To return to the default camera
position:

o Click the top memory dot.

The view returns to the default,
regardless of how many changes
you've made.

To save a camera position to a memory
dot:

o Click an empty dot. Empty dots
appear gray. Full dots appear
turquoise.

To switch between saved positions:
o Click a full (turquoise) dot.

Active dots appear turquoise with a
white dot in the middle.

To clear a full dot:

o Option/Alt-click a full dot. The dot
turns gray.

To switch between positions using the
keyboard:

Press #1 to activate

Press #2 to activate

Press #3 to activate

Press #4 to activate

Press #5 to activate
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Saved View #1: “5”
Saved View #2: “6”
Saved View #3: “7”
Saved View #4:“8”
Saved View #5: “9”

There are no keyboard shortcuts for the
remaining two dots.
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Setting Up Lights

There are two types of lights in
Bryce—natural and direct. Natural
lighting is provided by the Sun. By default
every scene contains a sun. Direct light is
provided by light sources.

The light from direct light sources can be
used to either add hyperrealism to
natural scenes, or add light to objects that
cast light in the scene, like lamps. The
lighting setup you choose can greatly
affect the look of your scene, so
experiment with various lighting setups.
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Creating Direct Light Sources

There are five types of direct lights you
can create: Radial, Spot, Square Spot,
Parallel and Cylindrical Parallel

You can create as many light sources as
you need. The only limit is your system’s
memory. Creating additional lights
sources may add significantly to the
render time for your scene.

The size, position, and orientation of a
light source can be edited exactly like any
other object. Refer to “Transforming
Objects” on page 285 for more on
transforming objects.

You can also link lights to specific objects
so that a light source moves as the object
moves, or you set a light to track an
object. When it’s tracking an object, the
light reorients itself so that it's always
facing the object no matter where it
moves. Linking and tracking are quick
ways of animating light positions.

The motion of all the light sources in this
example were animated using the track feature.

Light attributes can be edited in the Edit
Lights dialog.



Radial Light Spotlight Square Spotlight

Radial Lights throw light equally in all Spotlights throw light along a Square Spotlights are the same as
directions. Use this as a general light cone-shaped path, creating the classic spotlights, except they cast light along a
source, and remember that you can make “stage spot” effect. pyramid-shaped path, creating a square
these lights as tiny as you like, as many as spot where the light falls.

you need.

The lighting in this scene was created using a
Spotlight The lighting in this scene was created using a
The lighting in this scene was created using a Square Spot Light

Radial Light.

The Camera and Lights 343




Parallel Light Cylindrical Parallel Light 2. Click one of the create light tools:
Parallel Lights cast parallel rays, resulting Cylindrical Parallel Lights work exactly Creates Radial lights

in no spatial distortion of shadows. This like parallel lights except that they
type of light is very useful for creating produce cylindrical tubes of light and cast
specific shadow patterns, or when used circular spots where the light falls.

Creates Spotlights

with gels, for creating a slide projector.

Creates Square Spotlights

Creates Parallel lights

Creates Cylindrical Parallel
Ctrl Jights
The lighting in this scene was created using a

The lighting in this scene was created using a Cylindrical Parallel Light.
Parallel Light.

To create a light source:

1. Make sure the Create palette is
visible. If it's not, click the Create
button at the top of the Bryce
window.
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Editing Light Attributes

You can edit the attributes of any light
using the Edit Lights dialog. This dialog
lets you control the color, intensity and
sharpness of a light source.

Light Intensity Light Preview

Edit Lights

Pict Gels  Text

Softness  Light Color

Use the Edit Lights dialog to adjust the
brightness, color and hardness of a light.

Options

To access the Edit Lights dialog:
1. Select a light. The Object Attribute

controls appear next to the light's
bounding box.

2. Click the E button.

To adjust light intensity:
o Inthe Edit Lights dialog, drag the
Light Intensity control.

Drag right to increase light intensity
and left to decrease intensity.

To set a light’s color:

o Inthe Edit Lights dialog, click the
Light Color control and choose a
color from the picker.

To disable shadow casting for a light
source:

o Inthe Edit Lights dialog, click the
triangle icon at the bottom right
corner of the preview area, and

choose Disable Cast Shadows option.

The light from this source can
illuminate the surface of an object,
but does not create shadows.

Light Preview
The Light Preview area displays the

effects of your changes to the intensity
and edge softness of a light.

You can have this preview display the
light against a neutral background, or
show the light in the scene.

To set the preview options:

o Inthe Edit Lights dialog, click the
triangle icon at the bottom right
corner of the preview area, and
choose a preview option:

Render In Scene displays your scene
in the Preview area. This lets you see
how the changes you make to the
selected light will impact your entire
scene.

Render Against Neutral displays the
light against a flat background. This
lets you isolate the light so you can
clearly see subtle changes.
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Light Attributes

The light editor lets you adjust three
attributes which let you create more
realistic-looking light sources:

* The light’s spread

Edge Softness
+  Fall-off

The spread of the spotlight (also called
the Half Angle) controls the size of the
light cone projected.The size of the light’s
wireframe determines the spread of the
light. The bigger the wireframe, the larger
the spread.

The size of a light's wireframe controls the light’s
spread.
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To adjust the spread of a spotlight:
1. Select a spotlight.

2. Drag the one of its bounding box
control points to set the wireframe’s
size.

Increase the size to increase the
spread and decrease its size to
decrease the spread.

The Edge Softness attribute lets you set
the sharpness/softness of the edges of the
spot projected by the light.

To adjust a light’s edge softness:
o Inthe Edit Lights dialog, change the

position of the Edge Softness control.

Drag right to sharpen the edges and
left to soften the edges.

Light Fall-off

The Fall-off a light controls its range.
Fall-off refers to the point where the
illumination from the light falls-off, or
loses its effect.

In Bryce there are two types of fall-off
you can apply to a light:

+ Linear Fall-off which causes the
light’s illumination to fall off at a
constant rate. When you use this type
of fall-off the light’s range is rather
large. This type of fall-off is good for
outdoor lights like a searchlights.

» Squared Fall-off which causes the
light's illumination to fall off rapidly.
When you use this type of fall-off, the
light's range is quite limited. Use this
type of fall-off for indoor lights like
lamps.

To adjust a light’s fall-off:

o Inthe Edit Lights dialog, click the
triangle icon at the bottom of the
dialog and choose either Linear

Fall-off or Squared Fall-off from the
menu.



Creating Visible Lights

Visible lights make your light source
visible in the scene, like the ball of light
that appears around a lamppost on a
foggy night.

There are two types of visible lights:

+  Surface Visible Lights
*  Volume Visible Lights

When you create a surface visible light,
the light from the object appears as a
semi-transparent shape extending out
from the light source.

Surface Visible lights have the same
attributes as a non-visible light, so you
can use the Edge Softness control to make
the shape that extends from the light
fuzzier at the edges, to give it a more
realistic feel, or the Fall-off options to
adjust the range the light.

The properties within the light are
controlled by the default Surface Material
applied to the light object. The material
can be edited in the Materials Lab. By
changing the material, you can change
the color of the light, the intensity of the
light’s color and many other properties.

When you create a surface visible light source, it

appears as a semitransparent object in the scene.

When you create a Volume Visible light
source, a preset Light-sensitive Volume
Material is applied to the light source.
This makes the light coming from the
light source appear visible in the scene, so
in the case of a spotlight, the light would
appear as cone. The light also becomes
volumetric and reacts to other lights
around it. Objects within the cone
interact with the light. They can block it
reflect it, etc. Any textures applied to the
light also have volume.

The material applied to the object is
pre-defined for you, but you can edit its
properties in the Materials Lab. By
editing the material you can change the
light's intensity, color and transparency.

e

When you create a volume visible light source,
the light emanating from the light source is
visible in the scene. This light has volume and
interacts with the object inside it.

The real difference between the two types
of lights becomes apparent when you
apply a gel to the light. In Surface Visible
lights, the gel texture is wrapped around
the light cone like a skin. Making it
semitransparent makes it look more real,
but it doesn't make it interact with
objects inside the cone.

On the other hand, volume visible lights
create a real illuminated volume. The
texture gel exists everywhere inside the
cone, and the objects within the cone are
directly affected by the texture. The light
also interacts with the surrounding light
sources.
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To create a surface visible light:
1. Create a light source.

2. Select the light in the Working
window.

3. Click the E button that appears next
to the light’s bounding box. The Edit
Lights dialog appears.

In this example, the same objects were

illuminated by first a surface visible light... 4. Click the triangle icon below the light

preview and choose Surface Visible
Light from the menu.

A number of preset Surface material
properties are applied to the light.

+  Click the triangle again and
choose Infinite light from the
menu if you want to extend the
light's range.

...and then a VOIUme ViSibIe ||ght WA 0 0 W 0 WD 0N Y
To create a volume visible light:

T e 1. Create a light source.

It's a good idea to choose to apply the

Infinite Light option to both types of 2. Se_lect the light in the Working
visible lights, as this option extends the window.
light's range. This gives the light a 3. Click the E button that appear next to

more realistic look. the light's bounding box. The Edit

T — R Lights dialog appears.
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4. Click the triangle icon below the light
preview and choose Volume Visible
Light from the menu.

A number of default Volume
material settings are applied to the
light source.

+  Click the triangle again and
choose Infinite light from the
menu if you want to extend the
light's range.

Editing Visible Light Materials

The materials applied to a visible light
control many of its properties. Although
these materials can be edited, just like any
other object’s material, you should keep
in mind that when you're editing a light’s
material in the Materials Lab, you're
changing how the light source will appear
in the scene.

Any texture components you apply to the
light’s material will appear as gels.

For Surface Visible lights, the light's
material is a Surface material. For a
Volume Visible light the material is a
Volume Material.



Refer to “Surface Material Channels” on
page 200 for more on editing Surface
materials, and “Volume Material
Channels” on page 210 for more on
editing Volume materials.

Applying Gels

Gels are filters which are placed directly
in front of lights to change the colors cast
by the light, or to cast specific kinds of
shadows.

In Bryce, you can use any picture or
procedural texture as a gel. Once you've
assigned a gel to a light source, you'll be
able to see the pattern of the gel on any
object it shines on. For example, if you
apply a picture to a Square Spotlight, you
can create a slide projector, or you can
throw a wild texture across your entire
scene by assigning a Texture gel to a
Radial Light.

This lighting effect was created using a gel.

When you apply a gel to a visible light,
the texture’s pattern is visible throughout
the visible light.

To use a picture as a gel:

1. Inthe Edit light dialog, click on the
Pict Gels text button at the bottom of
the dialog. The Pictures dialog
appears.

2. Choose a picture from the preset
library, or click the Load button and
load a picture.

Refer to “Working with Pictures” on
page 114 for more on the Picture
dialog.

3. Click the checkmark. The picture is
applied as a gel.

To use a texture as a gel:
1.

In the Edit Light dialog, click on the
Texture Gels text button at the
bottom of the dialog. The Preset
Materials Library appears.

Select a material from one of the
categories available.

Refer to “Using the Preset Materials
Library” on page 234 for more on the
Preset Materials Library.

Click the checkmark. The texture in
the material is applied as a gel.

To use a texture as a Gel, you must
select a preset that contains a texture.
Preset materials that contain only
color or optic information (such as
many found in the Simple & Fast
category) will have no effect.

- — -\_--h-‘..___-_ _.__.-\..-*'
If you selected a color other than white
in the Edit Light dialog, that color
overrides colors from Texture gels.
However, the luminance patterns are
still used.

- "‘_-I-.-.-_-_l___-_ o
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Positioning Lights

Light wireframes can be edited exactly
like any other object, either directly in the
scene using its bounding box, or
indirectly using the tools in the Edit
palette.

Refer to “Positioning Objects” on
page 294 for more on positioning objects.

Linking and Tracking with Lights

Since lights act just like other objects, you
can link them to other objects, or have
them track other objects in the scene.

In an animation, lights that track an
object can create some very complex
lighting effects.

Refer to “Linking Objects” on page 305
for more on linking, and “Tracking
Objects” on page 378 for more on
Tracking.

350 Chapter @ Bryce 3D



Animating

Key Event Animation and
Bryce 3D

Animation is process of simulating time.
In the real world, we perceive time
through the changes in our environment.
The most obvious type of change is
motion. When an object changes position
at different points in time, it appears to
be moving. But, an object doesn’t have to
be moving to indicate the passage time. A
change in color, texture or geometry also
indicates that time is passing. These
changes in the environment are called key
events.

You create an animation, in Bryce 3D, by
moving to different points in time and
changing the properties of a scene to
define the action at that point in time.
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Bryce automatically fills in the gaps
between these key events to create the
illusion of time passing.

—

Animation can simulate the passage of time by
changing the position of an object at different
points in time. Here an airplane is at the top of
the scene at one point in time...

...and at the bottom of the scene at another
point...
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...by filling in the gaps between the two points, or
key events, Bryce simulates motion.

‘
The same principle applies to other scene
properties. Here, the illusion of time is created

by changing the geometry of a terrain object at
two different points in the animation.

You can use key event animation to
animate most of the properties in
your scene:

*  The motion of object, lights and the
camera.

*  Object size, shape and orientation.
+ Camera and light parameters.

*  Object Material properties.

* Terrain object geometry.

* Environment properties.

Time-Based Animation

In Bryce 3D, key events are tied to
real-world time increments (minutes
and seconds) rather than individual
animation frames. This means that you
can create key events at specific points in
time without worrying about the number
of frames in your final animation.

Bryce automatically creates all the frames
necessary to move from one key event to
another. If you change the frame rate,
Bryce adjusts the number of the frames
between key events to match the new
frame rate.

For example, lets say your frame rate is
set to 15 fps (frames per second) and then
you set up two key events, one at 1 second



and the other at 2 seconds. Bryce
automatically fills in the 15 frames
necessary to move from the key event at 1
second to the key event at 2 seconds. If
you change the frame rate to 30 fps, Bryce
will add another 15 frames between the
two key events to match the new

frame rate.

Animation and Motion Paths

As you change the position, of an object,
Bryce creates a motion path which shows
you the path the object will take as it
moves from one key event to another.

An object’s motion path shows you the trajectory
of the object as it moves from one key event to
another.

You can edit an object’s motion path to
adjust its trajectory throughout the
course of the animation.
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Refer to “Editing Motion Paths” on
page 374 for more on motion paths.
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Animatable Properties

Each characteristic of an object or effect
that can be animated is called a property.
Most objects have many animatable
properties. Properties like position, size
and orientation are common to all
objects. Other properties are specific to
certain types of objects.

Lights have special properties like
brightness, fall-off and gels.

Skies have their own set of properties that
control everything from cloud coverage
to the time of day.

The properties of individual objects can
change depending on the material you
apply. The color, texture, and density of
an object can also be animated.

Some properties can be animated directly
in a specific editor. Object material
properties can be animated from within
the Materials Lab and terrain geometries
can be edited from within the Terrain
Editor.

Properties in the Sequencer

Every time you change an object’s
property, it appears as a key event in the
animation’s Sequencer. In the Sequencer,
each property of an object can be viewed
on a separate timeline. You can expand an
object’s listing to see all the
transformations or changes that have
been applied to its properties. If you have
not performed a transformations on the
object, it cannot be expanded.

- D

Refer to “Editing Property Timelines in
the Sequencer” on page 365 for a
complete discussion of the Sequencer.
- i
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You can expand an object’s listing to see the
timelines for the transformation applied to it.

Animating 353



To expand a listing in the Sequencer:

1. Make sure the Advanced Motion Lab
is visible. If it’s not, choose Object
menu> Advanced Motion Lab.

2. Click the object’s listing.
A
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Creating Animations
The Animation controls are the tool
you'll use most often when creating

animations. The palette provides tools for
most of the basic animation functions:

+ viewing the timeline

* moving the current time

+ setting the length of the animation
+ specifying the Working Area

+  previewing the animation

» recording key events

+ adding/deleting key frames
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Current Time Indicator
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Animation Preview Controls
Key Frame Controls

The Animation controls let you move through
your animation’s the timeline and create key
frames.

The Animation controls appear at the
bottom of the Working window as well as
in the Terrain Editor and the

Materials Lab.

Besides the Working window, the Animation
controls also appear at the bottom of the Terrain
Editor....

...and at the bottom of the Materials Lab.

The Animation controls are made up of
three areas:

The Timeline, located at the top of the
palette, displays a visual representation of
the time in your animation. The indicator
on the timeline (called the Current Time
Indicator) represents the current time.

The Animation Preview Controls, located
below the Timeline, let you preview your
animation in the Working window.

The Key Frame Controls, located at the
right edge of the palette, let you add and
delete key frames.

To display the Animation controls in the
Working window:

o By default the Animation controls are
located at the bottom of the Working
window. If the Selection palette
appears the bottom of the window,
click the Swap button in the
bottom-right corner of the Bryce
window.

Use the Swap button to switch between the
Animation controls and the Selection palette.



The button switches between the
Selection palette and the Animation
controls.

Setting Up an Animation

Before you start setting up key frames or
adjusting the timeline, you should set up
some general parameters for your
animation. The Animation Attributes
dialog lets you set up the duration, the
frame rate and whether you want to
display animation time as SMPTE (i.e.;
hours:minutes:seconds:frames) or Frame
numbers.
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The Animation Attributes dialog can used to set
the duration of your animation or to move to a
specific point in the timeline.

To set the duration of your animation
numerically:

1. Choose File menu> Animation
Setup or double-click the Current
Time Indicator. The Animation
Attributes dialog appears.

2. Click the Set Timeline button. This
switches the Duration fields to set the
duration of your animation.

3. Inthe Duration fields, enter the total
length of your animation in hours,
minutes, seconds and frames.

When you enter a duration, Bryce
automatically calculates the number
of frames in the animation, based on
the current frame rate. The number
of frames is displayed in the

Frame # field.

Setting the Frame Rate

The Frame rate for your animation can
have a large impact on the final quality of
your rendered movie. A low frame rate, is
faster to render but may produce more
jerky type motion, while a higher frame
rate produces much smoother motion.

Bryce displays frames as Frames per
Seconds (fps). 15fps is usually good
enough for emotions displayed on a
computer. 30fps is video quality.

To set the frame rate for your
animation:

1. Choose File menu> Animation
Setup or double-click the Current
Time Indicator. The Animation
Attributes dialog appears.

2. Enter a frame rate in the FPS field.

Working with the Timeline

The Timeline for your animation shows
you:

»  Agraphical representation of time.

« The total length of the your
animation within that time

* The current time.
*  The Working Area
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The timeline represents time in your animation.

It can be used to set the length of the animation
and to move the current time.

The Timeline appears in three places in
Bryce: the Working window, the Terrain
Editor and the Materials Lab.

All three timelines represent the same
time. The only difference is that when
you're in an editor, you can only add
frames for properties associated with the
editor. For example, in the Terrain Editor
you can only add key frames associated
with terrain properties.

-~ e
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Refer to “Animating Terrains” on

page 393 for more on working with the
timelines in Terrain Editor and
“Animating Materials” on page 385 for
more on working with the timeline in
the Materials Lab.
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When you preview a timeline in the
Working window, you'll be able to see all
the changes in your scene, including any
changes you may have made in other
editors or the Advanced Motion Lab.

Working with Time

The light grey area in the Timeline is
called the Available Time Area and it
represents all time. This area is unlimited,
you can scroll the time area infinitely.

The white tick marks within the time are
visual cues that let you know when the
time area is moving. If you move the
Current Time Indicator off the screen
you'll see these white ticks move along the
time area.

The light gray area in the timeline represents
time. The white tick marks in the time area are
visual cues to let you know when the area is
being scrolled.

To scroll the time area:

o Drag the Current Time Indicator off
the screen to the right.

You'll see the white tick marks move
along the time area to the left.

Setting the Animation Range in the
Timeline

The dark grey within the light grey area
of the Timeline represents the total length
of your animation. This area is usually
hidden by the Working Area, so you may
need to shorten the Working area to
adjust the Animation Range.

This area is automatically generated as
you set up key events. The time of the
final key event automatically creates the
limit of the animation range. However,
you can manually extend or shorten the
area to set the range of your animation.

The dark gray area of Timeline represents all the
range of your animation.
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You cannot shorten the Animation
Range below the last frame in the
scene since you can'’t have frames
outside the animation range.
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To manually set the Animation Range:

o Inthe timeline, drag the light green
handle that appears at the end of the
Animation range to the point where
you want the animation to end.

The handle may be obscured by the
Current Time Indicator, so you
might have to move the indicator to a
different position.

Setting the Current Time for an
Animation

The large green handle in the Timeline is
called the Current Time Indicator. It sets
the current time of the animation.

The Current Time Indicator is the most
important tool of the Animation
controls. When you're creating key event
the Current Time Indicator controls
when the key event occurs in the
animation.
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Refer to “Recording Key Events” on
page 360 for complete instruction on
creating key events.
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As you move the Current Time Indicator
the Text Display Area shows you the
current time. If you're using SMPTE
time, the current time is displayed as:

00:00:02.13

Hours Minutes Seconds Frame #

The Frame # changes as you change the
frame rate for the animation. For
example, at 15fps Bryce will insert 15
frames within each second.

If you're using Frame number, the

number of the current frame is displayed.

You can also move to a specific point in
time using the Animation Attributes
dialog. In this dialog, you can move to
either a specific time or frame.

To move to a specific frame manually:

o Drag the Current Time Indicator
along the Timeline.

As you drag, watch the Text Display
Area. You'll notice that the final
number cycles through each frame in
the second of animation time. So at
15fps the final number will cycle
through frame 0-14 between seconds.

Release the mouse button when the
Frame # reaches the desired frame.

The Current Time Indicator also controls
which portion of your animation is being
displayed in the Working Window.

When the indicator is at the beginning of
the animation, you're seeing the first
frame of the animation in the Working
window. When you move the indicator,
the Working window displays a different
portion of the animation. So, when you
move the indicator to the center of your
animation range, you're seeing what the
animation looks like at the middle of the
movie.

P

Use the Current Time Indicator to move the
current time to different points along the
timeline.

To move the current time manually:

1. Make sure the Animation controls are
visible. If it's not, click the Swap
button.

2. Drag the Current Time Indicator
along the Timeline. Release the
mouse button when the Text Display
Area shows the desired time.
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To move the current time numerically:

1. Choose File menu> Animation
Setup. The Animation Attributes
dialog appears.

2. Inthe Current fields, enter the hour,
minutes, seconds and frame you want
to move to.

The Frame # field displays the
number of the frame located at the
specified time.

To save the position of the Current
Time Indicator:

1. Make sure the Animation controls are
visible. If it’s not, click the Swap
button.

2. Move the Current Time Indicator to
the position you want to save.

3. Click on an empty Memory Dot at
the bottom of the Animation
controls.

A dot is empty when it appears grey.

Use the Memory Dots to save the position of the
Current Time Indicator.
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To move the Current Time Indicator to
a saved position:

1. Make sure the Animation controls are
visible. If it’s not, click the Swap
button.

2. Click the Memory dot for the
position you want to use.

To delete a saved position:

1. Make sure the Animation controls are
visible. If it’s not, click the Swap
button.

2. Option/Alt+click on a full
memory dot.

A full dot appears purple.

Setting Up the Working Area

The green portion of the Timeline
represents the Working Area. This area
highlights the portion of the timeline
you're currently working on.

[

Use the Working Area to isolate the portion of
the timeline you're currently working on.

When you're previewing your animation,
only the portion of the timeline within
the working area is previewed.

The Working Area is most useful when
you're working on a long animations as it
saves on preview time, or when you're
refining a specific portion of your
animation.

When you're rendering the animation,
you can choose to render the entire
animation, or just the Working Area
portion.

You can also use the Working Area to
render out sections of the timeline while
your setting up the animation, and then
render the entire Animation Range when
you're creating the final animation.

To set the range of the Working Area
manually:

1. Make sure the Animation controls are
visible. If it’s not, click the Swap
button.

Drag either end of the existing
Working area. Release the mouse
button when the Working area is the
desired length.
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The Working Area cannot be extended

past the end of the Animation Range.
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To set the range of the Working Area

numerically:

1. Choose File menu> Animation
Setup or double-click the Current
Time Indicator. The Animation
Attributes dialog appears.

2. Click the word “Current” at the top of
the dialog and choose Working Range
Low from the menu.

3. Enter the starting time for the
Working Range.

4. Click the word again and choose
Working Range High.

5. Enter the ending time for the
Working Range.

Setting Timeline Scale
The scale indicator at the right edge of

the timeline let you adjust the scale the
timeline.

If you have a very long timeline, you can
use this controls to scale it down so you
can see the whole timeline at once. If you
have a very short timeline, you can use
the control to scale it up so it extends
across the length of the palette.

Use the scale indicator to scale the timeline.

To set the scale of the timeline:

1. Make sure the Animation controls are
visible. If it's not, click the Swap
button.

2. Drag the scale indicator.

Drag right to increase the scale and
left to decrease it.

The scale of the timeline does not affect
its length, only how its displayed in the
Animation controls.

Scaling Animation Duration

You can adjust the length of your
animation, by scaling its duration to fit
within a certain amount of time. For
example, you created an animation that’s
5 seconds long, but only want it to take
up 3 seconds, you can scale the entire
animation to last only three seconds.

When you scale the animation, all the
events in the animation are compressed
or starched to fit within the desired
amount of time. If you increase the scale,
the events are starched out, so they take
longer to complete. If you decrease the
scale, the events are compressed to the
action speeds up.

To set the scale of the entire animation
manually:

1. Make sure the Animation controls are
visible. If it's not, click the Swap
button.

2. Hold down Option/Alt and drag the
animation range handle. Release the
mouse button when the duration of
the animation is the desired length.

P —

Option/Alt-drag the animation range handle to
scale the animation down or up.
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To scale the animation numerically:

1. Choose File menu> Animation
Setup or double-click the Current
Time Indicator. The Animation
Attributes dialog appears.

2. Click the Scale Animation button.

3. Enter the desired animation duration
in the Duration fields.

Recording Key Events

You can record key events by enabling
Auto-Record mode. The Animation
options menu, located at the left edge of
the controls, lets you enable or disable
Bryce’s automatic animation system.

+Auto Key

k Ticker Marks

Use the Animation options menu lets you to
enable or disable animation.

When you enable Auto-Record mode
every object transformation, or change of
property you perform is recorded as a key
event.
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A key event can store any change in size,
position, orientation, material property,
sky property, light property or geometry.

However, a key event can only store one
change per property at specific point in
time for each object in the scene. This
means that at a single point in time, you
can only have one change in position,
size, material or geometry per object
recorded as a key event.

If you keep changing the same properties
at the same point in time, the changes are
recorded on top of existing changes. Only
the last change you perform is recorded
as the key event.

To record more than one change in the
same object’s property you have to move
to a different point in time. Then each
change can be recorded as a separate key
event and applied to the animation.

For example, if you move an object up and down
at the same point in time, only the last
transformation is recorded as the key event...

=

...but if you move the object up at one point in
time and then move the object down at a
different point in time, both transformations are
recorded.

When Auto-Record mode is disabled, the
animation system is off. This means that
your changes are not recorded as key
events, and changes in the timeline do
not effect your view in the Working
window.

You can continue changing object and
scene properties, but they won't be
recorded as key events. If you want to



record a setting or transformation you'll
have to manually add a key frame using
the Add Frame button.Refer to “Adding
and Deleting Key Frames” on page 362
for more on adding frames.

To enable or disable Auto-Record mode:

1. In the Working window, make sure
the Animation controls are visible. If
it's not, click the Swap button.

2. Click the triangle icon to the left of
the controls and choose Auto-Key.
The animation system is on when the
option has a checkmark next to it.

Choose Auto-Key again to turn off
the animation system.

Recording Key Events in the Editors

When you record a key event in either the
Materials Lab or the Terrain Editor,
you're only recording a change to the
properties associated with the editor.

* Inthe Materials Lab only changes to
an object’s material properties are
recorded.

* Inthe Terrain Editor only changes to
a terrain object’s geometry are
recorded.

Previewing Animations

The Animation Preview Controls let you
preview your animation in the Working
window.

When you play an animation, all the
frames in the animation within the
Working Area are displayed. The preview
is shown in Wireframe display mode.

Plays the animation. Click
during play to pause the
animation.

Stops the animation.

]
Moves to the beginning of

Y the Working area.

+ Shift moves to the

beginning of the

animation.

Moves to the end of the

Working area.

+ Shift moves to the end of
the animation.

Moves one key frame

"’!I'-H‘ forward in the animation.
+Shift moves one frame
forward.

T Moves one key frame

Al backward in the animation.

+Shift moves one frame
back.

Setting Previewing Options

There are three options you can use to
alter the preview of your animation. You
can preview the animation only once. You
can play the animation continuously, or
you cycle forward through the animation,
and then back.

To set a preview option:

1. Choose File menu> Animation
Setup. The Animation Attributes
dialog appears.

2. Enable a Play option:
Once plays the animation only once.

Repeat plays the animation
continuously.
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Pendulum plays the animation
forwards then backwards, then
forwards, continuously

Adding and Deleting Key Frames

Usually you use the Auto-Record mode to
add key frames to your animation, but
there are some cases when you would
need to force the system create a key
frame. For instance, if you accidentally
make a number of changes while
Auto-Record mode is disabled, you'll
have to create a key frame to store your
changes, or they’ll be discarded when you
move to a different point in time.

The Key Frame controls let you add or
delete key frames from the timeline. The
key Frame indicator, changes color when
the Current Time Indicator is over a key
frame.

Add Key Frame Delete Key Frame

| e

Key Frame Indicator

The Key Frame controls let you add and delete
key frames from your animation.
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Adding Frames

Bryce adds keys frames differently
depending on what your selection in the
Working window.

If you have an object selected, Bryce only
records the changes in property for the
selected object. If you have nothing
selected, Bryce only records the changes
in the sky (i.e. changes you make in the
Sky & Fog palette).

You can also modify the add key frame

operation so that, for a selected object,

only a specific property is recorded as a
key event.

To add a key frame:

1. Move the Current Time Indicator to
the point where you want to add a
key frame

or

If you need to force Bryce to
overwrite an exiting key frame, leave
the Current Time Indicator where
itis.

2. Click the Add Key Frame button.

Any changes you made at this point
are recorded in the key frame.

To a add a frame for a certain type of

property:

1. Select an object.

2. Hold down the mouse button over
the Add Key Frame button and

choose an object property from the
menu that appears.

To add a key frame for sky properties:

o Make sure there is nothing selected,
and click the Add Key Frame button.

or

o Hold down the mouse button over
the Add Key Frame button and
choose Sky from the menu.

Deleting Frames

As with adding frames, Bryce deletes
frames differently based on your current
selection.



If you have an object selected, Bryce only
deletes the changes in property for the
selected object. If you have nothing
selected, Bryce deletes the changes
recorded for your scene’s sky.

You can modify the Delete Fey Frame
button’s function so that only a certain
type of object property is deleted.

-~ e — -
Adding or deleting frames will effect
the shape of an object’s motion path.
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To delete a key frame:

1. Use the Animation Preview controls
to move through the key frames until
you find the frame you want to
delete.

2. Click the Delete Key Frame button.

L=

All the properties recorded at that
point in time are deleted.

To delete a frame for a specific object
property:
1. Select an object.

2. Hold down the mouse button over
the Delete Key Frame button and
choose the object property from the
menu that appears.

Adding and Deleting Frames in the
Editors

When you add a frame in the editors,
only the properties associated with the
editor are recorded as a key frame.

When you delete a frame in the editors
only the properties associated with the
editor are deleted. For example, it you
delete a frame that contains position,
material and scale data in the Materials
Lab, only the material data is removed
from the key frame.

"
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The Advanced Motion Lab provides tools
for refining your animations. In this
window you can:

» view the hierarchical structure of
your scene

+ rearrange the sequence of key events
for individual object properties

* remap the time it takes to move from
one key event to another

*  preview your animation.
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Time Mapping Editor Preview Area

Hierarchy List Area

The Advanced Motion Lab lets you adjust the
hierarchy of your scene, the speed of objects, and
preview the results.

The Advanced Motion Lab is divided into
four areas:

Sequencer Area

The Hierarchy List area, located in the
bottom-left corner of the window,
displays a visual representation of the
object hierarchies in your scene.

The Sequencer area, in the bottom-center
of the window, displays timelines
containing all the key events in your
animation. A timeline is displayed for
each object or scene property in the
animation.
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The Time Mapping Curve Editor, located
at the top-left of the window, displays a
curve for each object or scene property
that represents the time mapping filter
applied to the property. You can adjust
how long it takes to complete an action
by changing the shape of the curve.

The Preview area, located at the top right
of the window, contains tools for
previewing you animation.
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All the changes you make in the
Advanced Motion Lab are
automatically applied to your
animation.
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Viewing Object Hierarchies

The Hierarchy List area displays the
hierarchical structure of your scene. The
term “hierarchy” refers to the structure of
object links and groups in the scene.

The Hierarchy List area is used to control
the display of both the object hierarchies
and object property timelines. If you
want to view only your scene’s object
hierarchies you'll have to hide all the
properties for all objects.
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Refer to “Object Hierarchies” on

page 302 for more on object
hierarchies.
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To hide an object’s property timelines:

o Click the name of the object whose
properties you want to hide.

To hide all the property timelines,
hold down Option/Alt while you
click.

Once all the object timelines are hidden,

the only thing displayed in the Hierarchy
Area is the hierarchical structure of your
scene.



Object Name

Collapsed p Cone 1
Listing Parent
w Cylinder 2 j
Expanded y Ob!ect
Listing Cube 2 Child
Object

Position

Animatable Rotakion

Object Scale

Properties T

Shear

Ciigin

This is what the Hierarchy List area looks like
when you've hidden all the property timelines.

The hierarchy list can be viewed in two
ways: collapsed or expanded. You can use
the arrow icons to expand or collapse the
Hierarchy. When the Hierarchy list is
collapsed you can only see the Parent
objects in the object hierarchies.

p Cone 1

F Cylinder 2

When the Hierarchy listings are collapsed, you
can only see the names of the Parent Objects in
the scene.

When its expanded you can see all child
objects in the hierarchy.

¥ Sphere 1
Cylinder 1

When the Hierarchy listings are expanded, you
can view the parent objects and their children.

The indents indicate Parent-child links or
groups. The parent is align to the far-left,
and its children are indented from there.

To expand/ collapse the hierarchy list:

o Click the Arrow icon beside an
object’s listing.

+ To expand the entire hierarchy,
hold down Option/Alt and click
an arrow.

A right facing arrow indicates a
closed hierarchy, and a down-facing
arrow indicates an expanded listing.

Editing Property Timelines in the
Sequencer

Each object in the Hierarchy list has a
number of timelines associated with it.
When you display an object’s properties
you can see the timelines associated with
each object.

To display object’s property timelines:

o Click the name of the object whose
properties you want to display.

+ Todisplay all the property
timelines, hold down Option/Alt
while you click.

These timelines represent the various
animatable properties for an object type.
Different types of objects have different
animatable properties.
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Recorded Key Event

Object

Naj:; Sphere 1
Positian

Animatable | Diaad

properties

Shear

For example, this is the listing for a sphere
object. When the object ‘s property timelines are
displayed, you can see the key events recorded
for each property.

Recorded Key Events

Object Terrain 1
Name
Positsan
Rotation
Animatable Scale
Properties

Shear

Crigin

Gradient

Cieometry

This the listing for a terrain object. Here you can
see that there are several different animatable
properties. Some properties like position, size,
and rotation are common to all objects.

The white tick on a property timeline
indicates that a key event has been
recorded for the property.
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The ruler at the top of the Sequencer lets
you see the exact point in time when the
key event was recorded.

Time Ruler

0.0 .5 0.9 1.4 149
G ey v ey e e s s s

You can tell exactly when an event was recorded
by lining the key event marker up with the ruler
at the top of the Sequencer area.

In this example, a position key event was
recorded at time 00:00:01.25 (or 1 second and
25 frames)

By moving these key events you can
control precisely when events occur.

This sequence represents an animation where a
ball moves up and down four times, rotates as it
makes its third jump and shrinks when its done
bouncing.

D

If you move the position key events closer
together the bounces occur faster, but the
timeline remains the same.

Sphere 1
Position

Rotation

If you move the fourth position key event in
front of the third event, you're changing the
shape of the motion path, because the ball
bounces up before it bounces down.
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Position is not the only key events you can
arrange, here both the rotation and scale key
events have been repositioned. Now, the ball
grows large as it bounces and rotates only at the
end of the animation.

You should take care when rearranging
Position key events as they can greatly
alter the trajectory of your object,
resulting in unpredictable results.

- _-_——____-_ -

It's a good idea to activate the
continuous preview while your editing
the timeline, so you can quickly see
the effects of your changes. Refer to
“Previewing the Animation” on

page 370 for more on previewing.
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The amount of time available in the
Sequencer area is not limited by the
current Animation Range. If you position
a key event past the current limit of your
animation, the Animation Range is
automatically extended.

timelines:

o Click the name of the object whose
properties you want to display.

To move a key event on a timeline:
1. Expand the listing you want to edit.

2. Click the white tick mark on the
listing’s timeline.

3. Drag the key event to a new position.

To move a group of key events:

1. Drag a marquee around all the key
events you want to select or hold
down Shift and click each of the key
events you want to move.

You can select key events on different
timelines.

2. Drag one of the selected key events.
All the other selected key events
move also.

To delete a key event from a timeline:

1. Select the key event, or group of
events you want to delete.

2. Press Delete. The key event is
removed from the timeline.

To copy a key event on a timeline:

1. Hold down Option/Alt and drag a
key event. The original remains in the
same place, but the copy moves as
you drag.

Time Mapping Curves

The Time Mapping editor displays a
curve which represents the time mapping
curve applied to the events in a property
timeline. Each property in the Hierarchy
List can have its own time mapping
curve. By adjusting the shape of this
curve you can change when events occur
and how long it takes to complete an
event.
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The curve acts like a filter. Time from the
actual animation is remapped according
to shape of the curve to produce the final
time. Depending on the shape of the
curve, events can occur faster, or slower.
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Time Mapping curves can only remap
the time available in the animation.
You cannot add more time, or reduce
the amount of time in an animation.
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Editing Time Mapping Curves

The horizontal axis in the editor displays
all the time in the animation. The vertical
axis displays the time map for the
properties’ timeline. The key events
recorded for an object property are
displayed as horizontal dotted lines. The
curve in the middle represents the time
mapping filter. The point where the curve
intersects a key event line tells you exactly
when an event occurs.
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Animation Time

Time Map

At point A in the this timeline, an event that
occurred at 2 seconds in the original animation,
will occur at 3 seconds after it’s passed through
the filter.

The default time mapping curve for any
property is a diagonal line. In this curve,
time is not being remapped since events
occur at the same time along both the
horizontal and vertical axes.

At point A in the default timeline, an event that
occurred at 2 seconds in original animation, also
occurs at 2 seconds in the time map.

When you change the shape of the default
curve, you're remapping time.

For example, if you make the curve
convex, events occur later in the
animation, but they're closer together
which means the action in your
animation will speed up.

In this example you can see that at point A an
event that occurred at 1.5 seconds now occurs at
3.1 second. At point B an event that occurred at
2.5 seconds now occurs at 3.9 seconds.

Although both events now occur later, there’s
much less time between them, so the action in
you animation occurs later but faster.



A concave curve would create the same type of
effect, except that the events occur earlier. Here,
event A and B occur much earlier, within the
first second, and the amount of time between
them is much shorter.

Different curve shapes represent different
time mapping effects. A flat curve means
that no motion is occurring since all the
events on the curve are happening at
exactly the same point in time.

This curve indicates that a pause, or stop of
motion occurs during the course of the
animation.

A steep jump in the curve indicates a
sharp increase in speed, as many events
occur in a very short time.

ﬂl.l] 04
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This curve indicates a sharp increase in speed.

An oscillation in the curve, indicates that
events repeat, since they intersect the
curve more than once.

In this curve event A occurs once at 1.5 seconds
and again at 3.5 seconds.

You can combine any variation of curve
slopes to create different velocity effects.

While you're editing a Time Mapping
curve, you may want to continuously run
the animation preview. As the preview
runs, the cross-hairs in the Time
Mapping editor moves from the
beginning or the animation to the end.
This way you can quickly see the effects of
your edits. Refer to “Previewing the
Animation” on page 370 for more on
continuous preview.

The counter at the bottom of the editor
shows you the current time of the
animation. As the animation runs, the
counter updates to continuously show
the current time.

4 00:-00:00.00

Watch the counter as you preview your
animation to see the current time.

You can also move the current time by
dragging the Current Time bar in the
Hierarchy area.

To edit a Time Mapping curve:
1. Display the Advanced Motion Lab.

2. Click the name of the object whose
properties you want to remap

3. Click the name of the property you
want to remap.
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4. Inthe Time Mapping Editor, click a
point on the curve and drag it to a
new location.

+ If you move over an existing
point the cursor changes to a
cross-hairs.

+ If there is not point on the curve,
the cursor turns into a pen.

5. Continue dragging points until you
achieve the desired shape.

To zoom into an area of the Time
Mapping curve:

1. Move the cursor over the curve in the
Time Mapping Editor.

2. Drag over an area of the curve. When
you release the mouse, the area is
enlarged.

To zoom out of an area in the Time
Mapping curve:

o Hold down the Shift key and click
inside the Time Mapping editor.

To pan the Time Mapping curve:

o Pressthe Spacebar and drag the curve
in the editing window.
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Previewing the Animation

The Preview Area in the Advanced
Motion Lab lets you see a preview of your
animation as you edit the Hierarchy or
the Time Mapping curves.

Laanill
The Preview Area in the Advanced Motion Lab
displays the results of your changes to the
Hierarchy or Time Mapping curves.

Any change you make in the lab is
automatically applied to the preview.
When you play the preview you see the
effects of your changes.

Once a start playing the animation, it will
run continuously until your press the
Stop button. Running the preview also
moves the Current Time Bar in the
Sequencer area and the cross-hairs in the
Time Mapping editor. As well, the

counter at the bottom of the Time
Mapping editor displays the current time
of the animation as it plays.

To preview an animation:

o Click the Play button in the Preview
Area controls.

The animation starts running. It will
continue playing until you press the
Stop button.

Click the stop button to stop the
preview.

The controls along the left side of the
Preview Area control several options for
your animation preview.

To switch between Camera View and
Director’s View in the preview:

o Click the Swap Views button next to
the Preview Area.

F—



When you first open the Advanced
Motion Lab, the Preview Area
displays the current camera view.

In Director’s View you'll be able to
see the camera in the scene.

Camera View

.

P

Director’s View
When you switch to Director’s View in the
Preview area you can see the camera in the
scene.

+  Click the button again to switch
back to Camera View.

- _-_'-'-ll-u...____ -

Changing views in the Preview ;rea
doesn't affect the view in the Working
window.
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To change the view in the Preview Area:

o To orbit around your scene, drag the
preview in the direction you want to
move the view of your scene.

o To change the position of camera,
hold down Option/Alt and drag the
preview.

To zoom in and out of the preview:

o Click the + button next to the
Preview Area. The view of the scene
enlarges.

T

* Hold down Shift and click the
+ button to zoom out.

To reset the view in the preview area:

o Click the Reset button next to the
Preview Area.

The view switches back the view
displayed when you first entered the
Advanced Motion Lab.

To pan the Preview Area:

o Drag the cursor over the Pan button
next to the Preview area.

s
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Hiding and Displaying Objects

The left side of the hierarchy area displays
a list of all the objects in your scene. The
icons on the left side of the listing
indicates whether or not the object is
displayed in the preview area.

Visible Object

Hidden Object

The eye icon indicates whether or not an object
is hidden.

When you hide an object it does not
appear in the Preview area at the top of
the Advanced Motion Lab. This setting
has no effect outside the lab. Objects that
are hidden in the lab will be visible in the
Working window and will still render
normally.
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You can use this feature to isolate objects
that your editing in the Sequencer or
Time Mapping areas.

To hide/display an object:
o Click the Eye icon to hide the object.

Click the icon again to display the
object.

Saving Preview Positions

The Memory dots next to the Preview
Area let you save specific camera
positions in the preview for later use.

The Memory Dots on the right side of the
Preview Area let you save positions in the
Hierarchy area and the animation preview.

To save a position:

1. Play the animation and then stop it at
the point you want to save.

or
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Move the Current Time bar in the
Hierarchy area to the position you
want to save.

2. Click on an empty Memory dot on
the right side of the Preview Area.

A dot is empty when it appears grey.

To move to saved position:

o Click on a full Memory dot. A dot is
full when it appears purple.

To delete a saved position:

o Option/Alt+click on a full
Memory dot.

S
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Motion Paths
A motion path is a visual representation

of an object’s trajectory as it moves
through time.

An object’s motion path is automatically
generated as you create key events. Each
new key event adds a new point to the
path.

The shape of the curve is determines by
the interpolation performed by Bryce. In
most cases Bryce tries to create smooth
motion so the path is drawn as a curve.

An object’s motion path is automatically
generated as you create key events. As you move
the object at a specific point in time, the motion
path line extends out from the object’s
wireframe.

As you add key events, the curve is
adjusted to include the new motion.

T3

As you add more key events to your animation,
the path changes shape to include the new
motion. Bryce always keep the motion smooth,
so each new point is added as a curve.



Motion paths exist in 3D space so they
can be view from any angle. If you move
the camera, you can see how the object
moves along the X, Y and Z axes.

ar

If you move the camera to different views, you'll
be able to see the object’s trajectory along all
three axes.

The default state of the motion path can
be difficult to see in a complex scene. You
can give your motion path some extra
depth by displaying it as a ribbon.

3 1

The ribbon lets you see the motion path as a flat
track running through the scene.

By default, the motion path for an object
only appears when the object is selected.
Otherwise the path is invisible. As well, it
does not render in the final animation.
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You can change the display moae of
the motion path in the Animation tab of
the Object Attributes dialog.

R
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To show the motion path as a ribbon:
1. Select the object.

2. Click the A icon that appears next to
its bounding box. The Object
Attributes dialog appears.

Click the Animation tab.

4. Enable the Show as Ribbon option
and click the OK icon.

To display the path only when the
object is selected:

1. Select the object.

2. Click the A icon that appears next to
its bounding box. The Object
Attributes dialog appears.

3. Click the Animation tab.

4. Enable the Show Only when Selected
option and click the OK icon.

To display the path at all times:
1. Select the object.

2. Click the A icon that appears next to
its bounding box. The Object
Attributes dialog appears.

Click the Animation tab.

4. Enable the Show Always option and

click the OK icon.
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Editing Motion Paths

Changing the shape of the motion path
changes the trajectory of the object. The
path acts like a Bezier curve. You can
change its shape by dragging its control
points.

You don’t have to be in Auto-Record
mode to edit the path. The changes you
make to the path’s shape are applied
directly to path the in real time.

Changing the shape of a path does not
affect when key events occur. A key event
that occurs at 00:00:01.00 will still occur
at the same time regardless of where it

Since Bryce treats the motion path as a
Bezier curve, you can edit it just as you
would any curve in any 2D illustration
application. You can also display the
curves tangents which indicate the angle
of the curve.
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For example, the events on the path above occur
at 00:00:00.01, 00:00:01.00 and 00:00:02.00.
When you change the shape of the path, the
direction in which the object travels changes, but
all the events still occur at the same they did in
the original path.

When you display the path’s tangents you can
see the angles of its curve points.

Motion Path Modifiers

There are a number of modifiers you can
apply to the path change the way motion
occurs along the path.

Normally an object moves from the first
key event on the path to the last over the
course of the animation. If you want the
object to move backwards along the path,
or repeat its action, you would have to
reposition the object and set up new key
events. The modifiers let you create these
types of effects automatically.

For example, if you wanted to animate
the motion of a grandfather clock
pendulum, you have to set up the forward
motion, and then the backward motion.

However, using the Pendulum modifier
you just have to set up the forward
motion path. Since the modifier changes
the object’s behavior so that it moves
forward than back along the same path



during the course of the animation. All * Make Pendulum creates a repeating
you have to do to see the new motion is cycle in the action along a path. The
extend the duration of the animation. object will move forward on the path,
then back and then forward
continuously.

* Make Circular closes the path to
create a circular path. The object will
move along the path and when it hits
the end, it'll swing around to the
front of the path and start all over.

To apply a modifier to a motion path:
1. Select the object.

2. Click the A icon that appears next to
its bounding box. The Object
Attributes dialog appears.

The motion of this clock’s pendulum was created . . .
using the Pendulum modifier. 3. Click the Animation tab.

. . 4. Enable a modifier.
There are four modifiers available:

. Extend the duration of the animation
* Make One Shot restores the motion S0 you can see the change in motion.
of the path its original configuration,
meaning the action along the path
only occurs once.

+ Make Repeat creates a loop in the
action. The motion on the path
repeats continuously.

Moving the Path

You can also move the path, by dragging
it to a new location. When you drag the
path, all the events on the path shift
position. Changes in motion path
position are not recorded as key events.

sEp-EF

When you drag the motion path, you're not
changing its shape, you're adjusting the position
of all the events on the path, so this animated
ball occurs at a higher altitude.

To move a motion path:

o Click on a section of the path that
does not contain any control points
and drag it to new location.

You have to click on a part of the
path without control points,
otherwise you’ll change its shape.
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Aligning Objects to the Path

Normally, the center of object remains
perpendicular to the motion path as it
moves from point to point. Using the
aligning option you can have the object’s
center remain parallel to the path so that
it reorients itself as moves from point

to point

You can use this option to create more
realistic motion for objects that have a
distinct front and back.

For example, the motion of this airplane looks
rather unrealistic since its rising and falling
without tilting.
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If you align the airplane to its path, the
airplane’s nose tilts down as it moves down and
up as it moves up.
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There are four align options available:

* Do Not Align disables aligning. The
shape of the curve has no effect on
the object’s orientation.

+ Align adjusts the object so that its
orientation is matches the shape of
the path.

+ Align with Twists changes the
object’s orientation along any twists
in the motion path.

+ Align with Autobanking
automatically banks the object from
side to side according to the shape of
the motion path.

To align an object to a motion path:
1. Select the object.

2. Click the A icon that appears next to
its bounding box. The Object
Attributes dialog appears.

Click the Animation tab.

4. Enable an alignment option and click
the OK icon.
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Introduction

Bryce has several features you can use to
add realism to your animations. The
techniques covered in this chapter can be
used together to help you develop more
exciting, natural and dynamic
animations.

In this chapter you'll learn how to
animate objects using the Tracking
feature. You'll also learn how to animate
several different properties of your scene
like material channel properties, which
can dramatically alter the look of your
objects, and terrain object properties,
which can alter the layout of your
landscape.
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Tracking Objects

Tracking lets you connect an object to
another, called the target, so that the
object remains pointed at the target
throughout the animation.

As the target moves, the original object
pivots around its origin so that it remains
pointed at the target. Normally, the
original object does not change position,
only orientation. However, if you offset
the object’s origin point, it might change
location as it rotates around the

offset point.

o

When an object tracks a target object, it remains
pointed at the target object no matter where it
moves in the scene.
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You can use tracking to quickly set up the
animation of a number of objects at once.
When an object is tracking another, you
only have to set up the motion path of the
target object. The motion of the objects
tracking the target are automatically
created.

i -|II|

The original object pivots around its origin point
so that it's always facing the target object.

For example, in this scene the motion of all the
lights is created when you move the target object.



You can also use this feature to ensure
that a light or the camera remains
pointed at an object during the entire
course of the animation. You can also use
it to create motions like a radar dish
following a satellite or a sunflower
following the sun.

-~ . e -
A parent object cannot track its _child
object.
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To set up object tracking interactively:

1. Select the object you want to remain
stationary (that is, the one that tracks
the target object).

2. Move the cursor over the target icon
that appears next to the object’s
bounding box.

3. Drag the Target line from the icon to
the target object. The target object
turns blue.

As you drag the Tracking icon from the tracking
object to the target, a tracking line appears.

To set up object tracking using the
Object Attributes dialog:

1. Select the object you want to remain
stationary.

2. Click the A icon that appears next to
the object’s bounding box. The
Object Attributes dialog appears.

Click the Linking tab.

4. Click the Target Object Name menu
and choose the name of the target
object.

-
Animating the Camera

When you animate the camera, you're
changing the view of you scene over the
course of the animation. Since you're in
3D space you can move the camera to any
position in the scene. You can have your
camera circle around the scene, zoom
into it or even fly under it.

There are two ways of animating the
camera in Bryce: using the Camera
Position controls, or by moving the
camera as an object.

The easiest way of animating the camera
is to use the Trackball, (or other Camera
Position controls) in Camera View while
Auto-Key mode is enabled. Any changes
you make to the position of the camera
are automatically recorded as part of a
key event. When you play the animation,
your camera changes are added to all the
other changes in scene properties to
create the action in your animation.

While working in Camera View may be
the easiest way of animating the camera,
it's not the most precise. Because of the
view’s first person perspective, it can be
hard to see the exact path of the camera
as it moves. This can make creating a
precise motion difficult.
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However, if you switch views, to an
orthogonal view or the Director’s View,
you'll be able to see the camera as an
object in the scene. Then you can select
the camera and set up key events for its
position, just as you would for any other
object. Also, you can display the camera’s
motion path so you can make precise
adjustments to its movements.

After you're done setting up the key
events for the camera, you can see the
changes in the Sequencer in the Advanced
Motion Lab. There you can rearrange the
order of events or change how long it
takes to move between camera positions.
Refer to “Object Hierarchies” on

page 302 for more on working in the
Hierarchy, or “Time Mapping Curves” on
page 367 for more on remapping time.

After you're done adjusting the position of the
camera, you can see the events recorded for the
changes in the Hierarchy Area.
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Camera Motion and Skies

The motion of sky elements can affect
how fast the action in your animation
appears. For example, in time-elapsed
movies, the clouds and sun fly by quickly
as the objects stay in the same position.
You could inadvertently create this type
of action in your scene if you move only
the camera in the scene without
considering the static nature of the sky
elements. Since the clouds stay in exactly
the same position as you move the
camera, they’ll appear to be moving
much faster than the objects in the scene.

To avoid this problem, Bryce lets you link
the clouds to the camera. This way,
whenever the camera moves, the cloud
positions also move, so they look like
they’re staying in the same position.

Although you can also link the sun to the
camera, it’s not a very good idea to link
the two during an animation since any
change in the camera position will
change the time of day.

To link clouds to the camera:

=

Display the Sky & Fog palette.

N

Click the triangle icon in the bottom
right corner of the palette and choose
Edit Sky & Fog from the menu. The
Environmental Attributes dialog
appears.

Click the Cloud Cover tab.

4. Click the Link Clouds to View button
at the bottom of the palette.

5. Click the OK icon to exit the palette.



Using the Orthogonal Views

In Camera View you can't see the physical
position of the camera in the scene since
you're looking through it, but using one
of the Orthogonal views (Top, Bottom,
Left, Right, Front and Back) you'll be able
to see the camera as an object.

In this example, the scene is displayed in Top
view. Here you can see the exact position of the
camera in the scene.

In these view you can animate the camera
by changing its position at different
points in time. When you run the
animation, Bryce fills in the gaps between
positions to create smooth camera
motion.

To animate the camera in an
orthogonal view:

1. In the Working window, click the
triangle icon next to the View
Control and choose an orthogonal
view from the menu: Top, Left, Right,
Bottom, Front or Back.

2. Move the Current Time Indicator in
the Timeline to the point where you
want to start changing the Camera
View.

3. Click the triangle icon in the
Animation controls and make sure
Auto-Key is enabled.

4. Drag the Camera wireframe in the
Working window to a new position.

5. If you want to see the results of your
changes, choose Camera View from
the View Control menu and click the
Play button in the Animation
controls.

Using Director’s View

Director’s View is similar to Camera
View, except that in this view, you can see
the camera as an object in the scene and
the movements of the Director’s camera
are not recorded as key events.

&

In Director’s View you see the camera as an
object in the Working window. You can change
this view using any of the Camera Position
controls in the Control Palette.

In Director’s View, you can move the view
of the scene using the Trackball or the
Camera Position tools. The view of the
scene changes in the Working window,
but no new key events are created.

You can also preview the animation while
in Director’s View. In the Working
window you can see all the object’s
moving along their motion

paths— including the camera.
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To animate the camera using Director’s
View:

1. Inthe Working window, click the
triangle icon next to the View
Control and choose Director’s View
from the menu.

2. Move the Current Time Indicator in
the Timeline to the point where you
want to start changing the position of
the camera.

3. Click the triangle icon in the
Animation controls and make sure
Auto-Key is enabled.

4. Drag the Camera wireframe in the
Working window to a new position.

5. If you want to see the results of your
changes, click the Play button in the
Animation controls.

Displaying the Camera’s
Trajectory

If you're setting up a precise path for the
camera, you may want to display its
motion path. Just like with other motion
paths, you adjust the trajectory of the
camera by adjusting the shape of the
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path. Refer to “Editing Motion Paths” on
page 374 for more on working with
motion paths.

Ll

When you display the camera’s trajectory, you
can see the exact path it will take during the
course of the animation.

To display the camera’s trajectory:

1. Inthe Working window, click the
triangle icon next to the View
Control and choose: Top, Left, Right,
Bottom, Front or Back from
the menu.

2. Select the Camera in the Working
window.

3. Click the A icon that appears next to
the camera’s bounding box. The
Camera & 2D Projection dialog
appears.

4. Click the Animation tab.

5. Click the Show Trajectory option and
click the OK icon.

Linking and Tracking with the
Camera

Since Bryce lets you treat the camera as
an object, you can also link the camera to
an object, or you can have it track an
object.

When you link the camera to an object,
the view of the scene changes as the
position of the parent object changes.

.;.}.

For example, if you link the camera to an
airplane, the view of the scene will follow the
airplane’s trajectory as it moves long its motion
path.

When the camera is linked to an object,
both its aim and position change as the
object changes.



When you set the camera to track an
object, the camera remains pointed at the
target object no matter where the object
moves in the scene. This means the
Trackball is disabled because the
orientation of the camera is controlled by
the position of the target object. Also, you
can’'t change the aim of the camera
because it always aims at the target object.

However, you can position the camera
using the Camera Cross controls as these
controls change the position of the
camera not its orientation.

"

-

For example, if you link the camera to an
airplane, the view of the scene will follow the
airplane’s trajectory as it moves long its motion
path.
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Linking the camera can cause
unpredictable movements when you’re
in Camera View. If you change the
position of the target object, the view of
the scene will also shift.
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To link the camera to an object using
the Camera & 2D Projection dialog:

1. Switch to an orthogonal view or
Director’s View.

2. Select the Camera.

3. Click the A icon that appears next to
the camera’s bounding box. The
Camera & 2D Projection dialog
appears.

You can also access the dialog by
double-clicking the Trackball, or
choosing Edit menu> Current
Camera

4. Click the Linking tab.

Click the Object Parent Name menu
and choose the name of the object
you want to use as the parent object.

6. Click the OK icon to link the two
objects.

To link the camera to an object
interactively:

1. Switch to an Orthogonal view or
Director’s View.

2. Select the Camera.

3. Move the cursor over the Link icon
that appears next to the camera’s
bounding box.

4. Drag the linking handle from the
icon to object you want to use as the
parent object.

To force the camera to track an object
using the Camera & 2D Projection
dialog:

Switch to an orthogonal view or
Director’s View.

2. Select the Camera.

3. Click the A icon that appears next to
the camera’s bounding box. The
Camera & 2D Projection dialog
appears.

4. Click the Linking tab.
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5. Click the Track Object Name menu
and choose the name of the target
object.

6. Click the OK icon.

To force the camera to track an object
interactively:

1. Switch to an orthogonal view or
Director’s View.

2. Select the Camera.

3. Move the cursor over the Tracking
icon that appears next to the camera’s
bounding box.

&
4. Drag the tracking handle from the
icon to the object you want to use as

the target object.
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Creating Camera Orbits

The camera’s origin point controls its
center of rotation. When the origin point
is at the camera’s center, it rotates around
in place. When the origin is positioned
somewhere in the scene, it will orbit
around the origin point. During an
animation, the view of your scene will

orbit around a specific point in the scene.

In this example, the camera’s origin point was
positioned in the center of the scene. During the
course of the animation, the camera appears to
orbit around the entire scene.

To create a camera orbit:

1. Switch to Director’s View or one of
the orthogonal views.

Click the triangle icon in the
Animation controls and make sure
Auto-Key is enabled.

Click the Camera wireframe in the
Working window.

Click the A icon that appears next to
the camera wireframe. The Camera &
2D Projection dialog appears.

Click the General tab.

Click the Show Origin Handle button
and click the OK icon.

Drag the ring handle to a position in
the scene.

Rotate the object using the Rotation
tool in the Edit palette or the
Trackball.



T the properties of a material at once. Using interpolates between the properties to

R this technique you can change an object create a transition from one material to A
Animating Materials from marble to metal, or glass to wood. the other. .
The action in your scene can include You can animate any property of a Tl
much more that just motion. Many material: !

subtle or dramatic effects can be created
by changing the properties of an object’s
surface over the course of the animation.

Colors

(

Channel values

- e — - +  Texture component usage (that is,
This section assumes that you're switching between components A, B,
familiar with the concepts and Cand D)
procedures involved in creating = - .
material and textures. Refer to . *  Texture properties
“Building Materials” on page 232 for «  Volume Material properties
more on creating materials and
“Textures” on page 239 for more on
editing textures. il e — it
- — - ’ Take care when you’re choosing which \
Fe—— properties to animate. Some X
By animating an object’s texture you can prop erne_s, like transparency, ?”d L
create subtle effects like changing the In this animation, the illusion of a banana volumetric effects can greatly increase B
color of an object to simulate things likea  ripening was created by changing the color and the rendering time or your animation.
tomato ripening. You can also create texture of a material over time. - e

more dramatic effects like changing all . L
In Bryce, animating materials is a rather

straight-forward process. Using the
animation tools in the Materials Lab you
set the properties of a material at
different points along the Timeline.
When you run the animation, Bryce
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Material animations are created using the
Animation controls at the bottom of the
Materials Lab.

Timeline

Current Time
Indicator

Preview controls

Key frame controls
The Animation controls at the bottom of the
Materials Lab lets you move along the Timeline
and preview your animation.

These controls let you move along your
animation’s timeline. This timeline is the
same as the one at the bottom of the
Working window. It contains all the same
key events as the Working window
timeline. The Animation controls in the
Materials Lab can perform all the same
features as the Animation controls in the
Working window.
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Animating Material Channel
Values

By animating the channels in a material
you can alter the properties of a material
without changing its basic function.
Using this technique, a rock material
would still look like a rock, but change
color, or glass would still look like glass
except become shinier.

In this example, the effect of a cat’s eyes growing
brighter as the sunlight fades, was created by
animating the Ambience channel value.

This is the simplest way of animating a
material and it requires the least amount
of processing time.

To animate a material’s channel values:
1. Select an object.

2. Click the M icon that appears next to
the object’s bounding box. The
Materials Lab appears.

3. Click the triangle icon in the
Animation controls and make sure
Auto-Key is enabled.

4. Move the Current Time Indicator to
the point where you want to start
changing the material.

5. Change the values of the material
channels using the Value controls.

or

Change the color used for a channel
by using the color picker.

6. Move the Current Time Indicator to a
different point on the Timeline.

The current time appears in the
counter next to the preview controls.

~

Change the channel values again.



8. Continue moving the Current Time
Indicator and changing channel
values until you achieve the effect you
want.

9. Click the OK icon to exit the
Materials Lab.

Animating Texture Components

Animating a texture component is an
effective way of creating motion within a
material. When you change the
orientation, position or scale within a
texture component, the texture elements,
(like dots, checks or patterns) will appear
to move.

You can use this technique to create
realistic wave motion in a water texture. If
you change the position of the texture
pattern at different points in the
Timeline, the waves will appear to move
over the surface of the object.

UL

This tide effect was created by changing the
makeup of the water texture in the material
applied to the water slab.

If you wish to avoid unexpected texture
movement during a texture animation,
use Object Space mapping mode for the
texture. This way the texture moves as the
object moves. However, you can create
some very interesting effects using World
Space.

You can also animate a texture
component by altering the makeup of the
texture using the Deep Texture Editor.

Using the editor you can change the
make-up of any or all of the four texture
components in a material.

To animate a material’s texture
components:

1. Select an object.

2. Click the M icon that appears next to
the object’s bounding box. The
Materials Lab appears.

3. Click the triangle icon in the
Animation controls and make sure
Auto-Key is enabled.

4. Move the Current Time Indicator to
the point where you want to start
changing the material.

5. Click the button in the upper left
corner of the texture component
window. The Edit Texture palette
appears.

Click the button in the upper left corner of the
Texture Component window to display its
transformation controls.
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6. Adjust the position, orientation or
scale of the texture and click the OK
icon to exit the controls.

7. Click the pink button in the
upper-left corner of the texture
component window. The Deep
Texture Editor appears.

Click the pink button in the upper left corner of
the Texture Component window to display the
Deep Texture Editor.

8. Adjust the values of the texture’s
components and click the OK icon to
close the editor.

9. Move the Current Time Indicator to a
different point on the Timeline.

The current time appears in the
counter next to the preview controls.

10. Change the texture properties again.

11. Continue moving the Current Time
Indicator and changing texture
properties until you achieve the effect
you want.

12. Click the OK icon to exit the
Materials Lab.
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Animating Between Materials

Animating channel values or texture
components is a good way of creating
subtle effects in a material, but to create
more dramatic action, you'll need to
animate between two completely
different materials.

This is how you create a transition from
rock to glass, or wood to metal.
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The transition between rock and glass in these
temple columns was created using two
completely different materials.

Animating between materials is exactly
like creating two different materials for
the same object. As long as the Auto-Key
mode is enabled, all your settings are
recorded as key events, so you can set up
a material at one point in time and then
move to a different point on the Timeline
and create a completely different
material.

There are two quick ways of creating
different materials:

* By switching the Texture
Component used to set a material
channel, you can completely change
the color, pattern, or bumpiness of a
texture.

*  Using the Preset Materials Library,
you can quickly apply a different
material to the object.

To animate between materials:
1. Select an object.

2. Click the M icon that appears next to
the object’s bounding box. The
Materials Lab appears.

3. Click the triangle icon in the
Animation controls and make sure
Auto-Key is enabled.



4. Move the Current Time Indicator to
the point where you want to start
changing the material.

5. Set up a material by setting channel
values and texture components.

6. Move the Current Time Indicator to a
different point on the Timeline.

The current time appears in the
counter next to the preview controls.

7. Set up a different material by
choosing different components or
applying a preset.

8. Click the OK icon to exit the
Materials Lab.

Previewing Material Animations

Any change you make to a material’s
properties are displayed in the Material
Preview area. When you play a material
animation, the same preview area shows
you the transition of the material from
one key event to the other.

- _-_‘-—|_____ -

This is not the most effective way to
see a material aniamtion.The best way
of seeing a material transformation is
by rendering the scene.

The Material Preview area displays the preview
of your material animation.

To preview a material animation:

o Click the Play button in the
Animation controls at the bottom of
the Materials Lab.

Click the Stop button to stop the
preview.

b '."'
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Animating Skies

All the properties of a Bryce sky can be
animated. This means that any attribute
you can set in the Sky & Fog palette or the
Environment palette can be animated
using the Animation controls on the
Timeline.

r e -
This section assumes that you're
familiar with the concepts and
procedures involved in creating skies.
Refer to “Creating Skies” on page 129
for more on creating skies.

- _-——-._____ o

By changing the attributes in the Sky &
Fog palette at different points in the time,
you can animate everything from the
position of the sun to the color of the
clouds.
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For example, you can simulate changes in the
time of day by changing the position of the sun
over time.

There are several technigques you can use
to add motion to your skies. You can
animate all or some of the properties of
your sky. You can activate and deactivate
sky effects at different points in the
animation. You can also animate the
position of the sun or moon.

Sky animations are created using the
Animation tools in the Working window

and the Environmental Attributes dialog.
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Animating Sky & Fog settings

Animating Sky & Fog settings changes the
properties of a sky over time. For example
a scene can become cloudier, or darker
during an animation. The intensity of the
change depends on how many properties
you adjust and the amount of each
adjustment.

In this example, the animation of approaching
storm clouds was created by changing the Cloud
Frequency and Amplitude value and the Cloud
Color at different points in the Timeline.

Most Sky & Fog properties can be
changed using the thumbnail controls.
Other settings are available in the
Environment palette.

You won't be able to see the effects of a
sky animation until you render the entire
animation.

To animate Sky & Fog settings:

1. Click the triangle icon in the
Animation controls and make sure
Auto-Key is enabled.

2. Move the Current Time Indicator to
the point in the Timeline where you
want the sky to change.

3. Adjust the sky’s properties using the
Sky & Fog palette controls.

4, Move the Current Time Indicator to a
different point on the Timeline.

5. Change the properties of the sky
again.

6. Continue moving the Current Time
Indicator and changing the sky’s
properties until you achieve the
desired effect.



Animating Couds

You can create the effects of wind in your
environment by setting up cloud motion
parameters. Based on your settings, Bryce
automatically moves the clouds in your
environment to create motion.

Cloud motion parameters are set in the
Environmental Attributes dialog.

Cloud Direction
controls

Speed control

Cloud +ntinn

Turbulence control

The Cloud Direction control lets you set the
direction for cloud motion, while the other
controls set the speed and distortion of the
clouds.

o +X

To animate clouds:

1. Click the triangle icon in the
Animation controls and make sure
Auto-Key is enabled.

2. In Sky & Fog palette, click the
triangle icon and choose Edit Sky &
Fog from the menu. The
Environmental Attributes dialog
appears.

Click the Cloud Cover tab.

4. Move the direction indicator in the
Cloud Motion controls to set a
direction for the clouds as they move
in the animation.

5. Adjust the speed control to set how
fast the clouds move. You can also
enter a speed value.

6. Adjust the Turbulence control to set
how much the clouds will distort as
they move. You can also enter a
turbulence value.

Animating Environmental Effects

Many environmental effects like rainbows
and fog are not permanent features of
sky. They appear for a brief time and then
fade way. You can simulate this action by
changing the properties of the
environmental effects at different points
along the Timeline.

The natural appearance and disappearance of
this rainbow was created by changing the
rainbow density over time.
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Environmental effects controls are
located on the Atmosphere tab of the
Environmental Attributes dialog. You can
also animate the various settings for an
effect. For example, the radius of moon
rings can increase or decrease during the
course of your animation.

To animate environmental effects:

1. Click the triangle icon in the
Animation controls and make sure
Auto-Key is enabled.

2. Move the Current Time Indicator to
the point in the Timeline where you
want the sky to change.

3. Display the Environmental Attributes
dialog: Atmosphere tab and change
the properties of an effect.

4. Move the Current Time Indicator to a
different point on the Timeline.

5. Change the properties of the effect
again.

6. Continue moving the Current Time
Indicator and changing the effect’s
properties until you have the desired
effect.
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Animating Sun or Moon Position

One of the most spectacular effects you
can create using the scene’s sky is elapsed
time. In the great outdoors we perceive
time in relation to the position of the sun
and the brightness of the sky. By
changing the position of the sun or moon
you can simulate time passing in terms of
days or months.

In this example, the passage of time is simulated
by the change in the sun’s position.

Since all the elements in the sky are
linked, the other properties of the sky like
Ambient Light change as the position of
the sun changes, adding to the realism of
the effect.

For the moon, you can also change its
phases, so you simulate the passage of an
entire month just by adjusting the moon
attributes.

To animate Sun or Moon position:

1. Click the triangle icon in the
Animation controls and make sure
Auto-Key is enabled.

2. Move the Current Time Indicator to
the point in the Timeline where you
want the sky to change.

3. Adjust the position of the sun or
moon using the Sun Position control
in the Sky & Fog palette.

4. Move the Current Time Indicator to a
different point on the timeline.

5. Change the position of the sun or
moon again.

6. Continue moving the Current Time
Indicator and changing the sun or
moon position until you achieve the
desired effect.
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Animating Terrains

Terrain objects are animated by changing
their properties in the Terrain Editor.

o B

‘ el
This section assumes that you're
familiar with the concepts and
procedures involved in creating
terrains. Refer to “Creating Terrains”
on page 170 for more on creating and
editing terrains.
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By changing the shape of your landscape
at different point on the Timeline you can
simulate geological events like
earthquakes or erosion.

The appearance of cracks in the earth during an
earthquake, can be created by animating the
geometry of the terrain.

There are several technigques you can use
to control how the shape of your terrain
changes. You can use the grayscale
paintbrush to totally change the
geometry of the terrain by adding new
peaks and valley, or you can use the
Filtering tools to add small changes in
elevation to the terrain.

Terrain animations are created using the
Animation controls that appear at the
bottom of the Terrain Editor.

Timeline

Current Time
Indicator  preview controls

Key frame controls

The Animation controls at the bottom of the
Terrain Editor lets you move along the Timeline
and preview you animation.

The Timeline in the Terrain Editor is the
same as the one in the Working window.
All the key events recorded for object
transformations and material changes are
displayed in the Timeline. The Animation
controls in the Terrain Editor can
perform all the same functions as the
those in the Working window. Refer to
“Creating Animations” on page 354 for
more on using the animation controls.
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Animating Terrain Geometry

There are two ways of changing the
geometry of a terrain object: by painting
directly on the Terrain Canvas or by
applying an elevation effect. When you
paint on the canvas you create large
changes in the terrain like the creation of
new mountains or valleys.

\
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The violent motion of great rock columns
shooting up from the ground was created by
painting a new peak onto an existing terrain at
different points along the timeline.
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The appearance of foot prints in the sand was
created by painting dark footprint shapes in the
Terrain Canvas at different points in the
Timeline.

When you apply an effect you create
smaller more subtle changes like a
mountain eroding over time.

The rolling motion in this terrain was created by
applying the erode effect at one point in the
Timeline and then undoing it in another.

You can also use this technique to record
how a terrain object was formed. By
adjusting the Current Time as you add
elements to the terrain, you'll have a
complete record of all your steps.



To animate terrain geometry:

1.
2.

Click a terrain object.

Click the E icon that appears next to
the terrain object’s bounding box.
The Terrain Editor appears.

Click the triangle icon in the
Animation controls and make sure
Auto-Key is enabled.

Move the Current Time Indicator to
the point in the Timeline where you
want the terrain to change.

Paint new areas in the terrain using
the Grayscale paintbrush.

or

Apply one of the effects in the
Elevation tab.

Move the Current Time Indicator to a
different point on the Timeline.

Change the shape of the terrain again
using an effect or the paintbrush.

Continue moving the Current Time
Indicator and changing the terrain’s
shape until you achieve the desired
effect.

Click the OK icon to exit the editor.

Animating Terrain Filtering

By animating the shape of a terrain
object’s filtering graph you can create
some very specific geometry effects.

For example, you can make specific areas
of your terrain sink to simulate the
damage caused by an earthquake. To
create this effect you would darken only
areas you want to sink in the Filtering
graph. Likewise, you create the effect of
ridges forming by lightening specific
areas of the graph.

The gradual appearance of stairs in this terrain [
was created by adjusting the filtering graph at e
different points in the timeline. § PRy
- ey
You can also use the Filtering graph to =
gradually raise or lower the entire terrain o

over the course of your animation.
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Animating Terrain Clipping

To animate terrain filtering: The setting of the Terrain Clipping To animate terrain clipping:
bracket can also be animated. As areas of 1
the terrain are clipped, they’re removed '
from the terrain object in the scene. Your 2.

terrain will look like it's breaking up, or

1. Click aterrain object. Click a terrain object.

2. Click the E icon that appears next to
the terrain’s bounding box. The

Click the E icon that appears next to
the terrain’s bounding box. The

Terrain Editor appears.

like portions it are falling into the sea.

Terrain Editor appears.

Click the Filtering tab. 3. Click the triangle icon in the
4. Click the triangle icon in the Animation controls and make sure
' o Auto-Key is enabled.
Animation controls and make sure
Auto-Key is enabled. 4. Move the Current Time Indicator to

5. Move the Current Time Indicator to the gg;]nttm th_e '[lmﬁlme where you
the point in the timeline where you want the terrain to change.
want the terrain to change. 5. Adjust the width of the clipping

6. Adjust the shape of the Filtering brackst.
graph. 6. Move the Current Time Indicator to a

7. Move the Current Time Indicator toa different point on the timeline.
different point on the timeline. 7. Change the width of the bracket

8. Change the shape of the graph again. again.

9. Continue moving the Current Time 8. IC%r]tlr;ue mc:jwﬂg th_e ngren?d?hmi
Indicator and changing the terrain’s tE lga OIE atn ?[_Ianglngh_ € thh °
graph until you have the desired € bracket until you achieve the
effect. desired effect.

10. Click the OK icon to exit the editor. 9. Click the OK icon to exit the editor.

The gradual destruction of this island was

created by changing the length of the clipping

bracket at different points in the Timeline.
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Previewing Terrain Animations

Any change you make to a terrain’s
properties appear in the 3D Terrain
Preview. When you play a terrain
animation, the same preview area shows
you the transition of the terrain from one
key event to the other.

The 3D Terrain Preview displays the preview of
your terrain animation.

To preview a material animation:

o Click the Play button in the
Animation controls at the bottom of
the Terrain Editor.

Click the Stop button to stop the
preview.

Animating Techniques
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= . What is Rendering?
_---""':J-—n AN YAV AN Rendering is the process of capturing a
view of your 3D scene and saving it as a
2D image. Once you've rendered the h
image, it can be used in other image __,

editing or page-layout applications.

Bryce’s rendering process uses multiple
passes to generate the final rendered
image. On the first pass, the image is
rendered in large pixel blocks, and then,
in successive passes is refined to produce
finer detail. The final pass of the
rendering is an AntiAliasing pass.
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Using this method you can quickly see
how the final image will look.Things like
colors and light/object placement are
very easy to see even during the first pass
or two.

Bryce renders images using multiple passes. On
the first pass object placement and color are
easily visible...

vy i) |

13 WY

...0Nn successive passes, the image becomes more

refined.
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Rendering an image requires a great deal
of computation. Scenes with multiple
terrains (at 512x512 each or more) can
generate hundreds of thousands of height
points, plus the bump elevations in the
textures. This can yield millions of
polygons to hit with the rays.

Raytracing

Bryce renders images using a technique
known as Raytracing. With raytracing,
every pixel in an image has a certain
color. In the case of a photograph, any
given pixel’s color is the result of light
coming from a scene, through a lens, and
onto the film. Raytracing does the
inverse. Virtual rays of light are shot from
the virtual “film” through a mathematical
“camera” and out into a 3D scene. As they
pass through the scene, these rays collide
with objects. The object they collides
with is assigned a color. For example, if it
hits a gray object, then that gray color
ends up on that portion of the “film” or
your final image.

Raytracing becomes much more complex
when the beam strikes an object that has
reflective, transparent, refractive, or other
complex optical properties. These
properties can cause the ray to be traced
further into your scene, where it could
end up bouncing from mirrors,
dissipating through fog, or bending

through a chunk of dense glass.
Eventually, a final color is determined for
each and every pixel, one by one.

This technique can involve staggering
amounts of computation which might
make it impractical or impossible to use,
but Bryce contains raytracing algorithms
optimized for the task of creating natural
and supernatural landscapes of all kinds.

The Rendering Procedure

Before you render your final image, you'll
need to complete the following steps:

o Create and transform the objects in
the Working window to create a
scene. Refer to “Creating Objects” on
page 101 for more on creating
objects. Refer to “Transforming
Objects” on page 285 for more on
transforming objects.

o Add asky and lights to illuminate
your scene. Refer to “Creating Skies”
on page 129 for more on creating
skies. Refer to “Setting Up Lights” on
page 342 for more on creating lights.



o Adjust the position of the camera to
get the best view of your scene. Refer
to “Positioning the View of Your
Scene” on page 331 for more on
positioning the camera.

o Set rendering options using the
options menu and the Document
Setup dialog. Refer to “Setting
Render Options” on page 401 for
more on setting render options.

o Choose a Render Mode. Refer to
“Render Modes” on page 403 for
more on choosing rendering options.

o Use the Render Controls to produce a
rendered image. Refer to “Using the
Render Controls” on page 406 for
more on using the Render Controls.

e
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Setting Up a Render

Bryce offers a number of options and
controls that let you control rendering.

As you're working on creating the scene,
you should use settings that produce fast
renders, but when you're ready to
produce your final image, you'll want to
choose settings that produce the highest
quality image.

Setting Render Options

These options let you control the quality
and size of the rendered image.

AntiAliasing

AntiAliasing removes the jaggies on the
edges of objects within the image. In
Bryce, AntiAliasing is performed using a
super-sampling method. This means that
for every pixel that's raytraced, more than
one ray is used to determine the pixel’s
color. The increase in rays increases the
quality of the raytraced object.

AntiAliasing can greatly improve the
quality of your image, but it is time
consuming. It can also eliminate some
desired roughness from high frequency
textures. AntiAliasing is performed on
the last pass of the rendering process.

An image rendered without antialiasing....

...and the same image rendered using
AntiAliasing.

There are three AntiAliasing modes
available in Bryce: AntiAliasing Off,
AntiAliasing Normal Quality and
AntiAliasing Fine Art.

Rendering
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AntiAliasing Off

In this mode there is no AntiAliasing
performed on the image.

AntiAliasing [Normal Quality]

In this mode after the image is rendered,
Bryce scans the entire bitmap to
determine which areas require
AntiAliasing. Only the areas of high
concentration are antialiased. In this
mode AntiAliasing is performed in only
the last pass of the rendering process.

AntiAliasing Fine Art [Slow]

In this mode, Bryce uses 16 rays to trace
every pixel in the image. This produces a
higher quality image, but it slows down
the entire rendering process from start to
finish.

You should probably only use this mode
to render showcase type artwork—not
normal working images.

To enable AntiAliasing:

o Click the triangle icon next to the
Render Controls and choose either
Normal or Fine Art from the menu.
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An option is enabled when a
checkmark appears next to its name.
Normal antialiasing is enabled by
default.

To disable AntiAliasing:
o Click the triangle icon next to the

Render Controls and choose
AntiAliasing from the menu again.

The option is disabled when there is
no checkmark next to its name.
When AntiAliasing is disabled, the

final rendering pass is not performed.

Render Resolution

The render resolution options control the
resolution of your final image. These
options do no effect the resolution of
your working document: only the final
rendered image.

Resolutions are expressed in terms of
aspect ratio and pixels.

To choose a render resolution:

1. Double-click the Render all control,
or choose File menu> Document
Setup.

2. Click one of the render resolutions at
bottom of the dialog. The selected
resolution appears highlighted.

3. Click the checkmark button.

Spatial Optimization

This option changes the number of rays
used to raytrace your image depending
on the contents of your scene. This
option has three modes:

Spatial Optimization Off

This mode is best used for very simple
scenes with less than 5 objects. When in
this mode, Bryce predetermines the areas
where your objects reside and shoots rays
only through that area.

Spatial Optimization Low

This is best mode to use for most scenes.
In this mode Bryce determines where
your objects reside and then go out from
there to a larger area to examine the
concentration of objects within a larger
area, This eliminates the expenditure of
unnecessary rays.



Spatial Optimization High

This mode is more extreme version of
Spatial Optimization Low. It is best used
for complex scenes with localized
concentrations of objects. If you have
imported DXF objects in your scene, this
mode will help speed up rendering
considerably.

To use Spatial Optimization:

o Click the triangle icon next to the
Render Controls and choose either
Spatial Optimization Off, Spatial
Optimization Low or Spatial
Optimization High from the menu.

Render Reporting

This option, when selected, produces a
summary report when your image is
finished rendering.

The report tells you how long the render
took, including the antialiasing pass. It
also provides statistics on how many rays
were shot to create the image and
breakdowns for the different types of
rays, including a per-pixel breakdown.

To produce a render report:

o Click the triangle icon next to the
Render Controls and choose Render
Reporting from the menu.

Document Resolutions

The menu commands at the end of the
Render Options menu are quick ways to
resize your document. Values shown are
expressed in pixels. For customizing the
size and aspect of your document and
resulting render.

Render Modes

Bryce offers several rendering modes that
let you produce images that can be used
to create different effects. For example,
the Mask Render mode lets you produce
an image that can be used as an alpha
channel in other graphics applications.

To choose a Render mode:

o Click the triangle icon next to the
Render controls and choose a mode
from the menu.

Perspective Render

This mode renders a fully raytraced color
image, based on your current camera’s
position and view.

Mask Render

This mode renders any selected object or
objects in as antialiased white shapes
against a black background. You can use
this image as a mask or alpha channel in
other 2D image editing programs.

An example of an image rendered as a mask
using Mask Render mode.
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360° Panorama

This mode produces an image that looks
as if your camera had a 360° lens. The left
and right edges of the resulting image
join seamlessly.

=

An example of an image rendered using 360°
Panorama Render mode.

This feature is intended for use with the
Bryce 360° scrolling screensaver, or
Apple’s QuickTime VR™ technology.
Refer to “QuickTime VR” on page 417 for
a description of Apple QuickTime VR.

-~ £ —-\—l-_._‘_-___\_ —_
Rendered 360° images will have little
resemblance to the wireframe working
window behind it; this makes flipping
back and forth between wireframe and
bitmap modes during composition
fairly difficult. For this reason, we
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recommend working in standard
Perspective Render mode as you
compose your image.

" e -

For a good 360° panoramic image, you
need a natural distribution of objects on
all sides of the camera.

Before beginning a 360° panoramic
render you should follow these steps:

1. Switch to the Top view using the View
controls and position objects around
the camera while in Perspective
Render mode.

2. Display the Document Setup dialog
using File menu> Document Setup,
and either select the Panorama preset
aspect ratio, or type in the
dimensions that you wish.

3. Do aquick test render in Perspective
Render mode to check composition.

The horizon should be level at the
vertical midpoint of your window. If
it is not, double-click the Trackball,
enter “0” in the Rotate X field and
exit the dialog.

4. Alter your camera position and Y/Z
rotation

5. Switch to 360° Panorama render
mode and render your image.

Distance Render

This mode results in a grayscale image,
with objects represented in shades of gray
based upon their distance from the
camera. Nearby objects are black, distant
objects are white, and objects in-between
are progressive shades of gray.

An example of an image rendered using
Distance Render mode.



You can use the Distance render image to
produce depth-of-field effects using a 2D
graphics application.

The purpose of this mode is to produce a
distance mask that you can use to create
several depth of field effects. Refer to
“Adding Depth” on page 413 for more on
using Distance Render images.

Altitude Render

This mode results in a grayscale image,
with objects represented in shades of gray
based upon their height.

You can use Altitude Render images in
the same way you can Distance Render
images to create special effects in other
applications.

An example of an image rendered using Altitude
Render mode.

Preview Render Modes

Preview Render modes are accessed using
the Render Controls and provide lower
quality renders that you can use to
preview you image.

Fast Preview

When this mode is enabled, the rendering
ignores areas of low frequency and
raytraces areas to high frequency only.
This results in accelerated renders that are
great for previewing during a session.
However, it also results in some
patchiness in certain mid-frequency
areas, so it should not be used for final
output.

. x -
To enable Fast Preview Mode: s
1. Click the Fast Preview button in the

Render Controls.

When the button appears depressed,
the mode is enabled. When its
unpressed, the mode is off.

Textures On/Off

When this mode is enabled, all textural
parameters are disabled. This mode
performs the following procedures to
speed up a rendering:

«  Objects with properties like
transparency, reflection, and bumpy
textures are rendered in flat opaque
shades

+ Fog, Haze and Clouds are disabled

« Any item with a procedural texture is
rendered with a color drawn from the
ambient color channel in the
Materials Composer

*  Any item with a simple color texture
is rendered in that color.

—

The Textures On/Off mode works in any
mode.

Rendering 405



To enable Textures On/Off Mode:
1. Click the Textures On/Off button in
the Render Controls.

When the button appears depressed,
the mode is enabled. When its
unpressed, the mode is off.

Rendering a Scene

Once you've selected any rendering
options you want to use and chosen a
rendering mode, you're ready to start
rendering. You render your entire image
using the Render Controls, or, if you've
rendered your image at least once, use the
Plop Render controls to render areas of
your image.
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Using the Render Controls

The Render Controls let you start a
rendering of your image. There are
controls for starting a rendering,
resuming a rendering, and starting two

types of fast renders.

Render All
Fast Preview Mode Resume Render
Textures On/Off Clear and Render

Use the render controls to control the rendering
of your scene.

To start a rendering of the entire scene:
1. Click the Render All button.

If you have already rendered any
portion of your scene, it is cleared
before the rendering begins.

You can interrupt any rendering in
progress by clicking the mouse.

To resume a rendering:

o Click the Resume Render control or
press Command/Ctrl-R.

If you're rendering only a selected
area using the Plop Render controls,
the rendering resumes only in the
selection.

To clear a selection and start a
rendering:

o Click the Clear& Render control or
press Command/Ctrl+Option/Alt-R.

This control clears the contents of
any marqueed region, and starts a
render of the selected region. Refer to
plop-rendering below for more on
rendering regions.



Plop-Render Mode

If you've rendered your image at least
once, you can use the Plop-Render
controls to render specific areas of your
image. You can use this mode to quickly
see the results of repositioning and
transformation operations.

Use Plop-Render mode to render specific areas of
your image.

Plop-render mode is enabled by default,
but can be turned off using the Display
palette.

To enable/disable Plop-Render Mode:
o Click the Plop-Render On/Off toggle
in the Display palette.

When the small rectangle inside the
icon (which represents an active
Plop-Renderer) is red, Plop-Render
mode is on. When it is white, the
mode is off.

To render an area of your scene:

1. Make sure Plop-Render mode is
enabled.

2. Switch to Bitmap display mode by
clicking the display mode icon on the
right side of the Bryce window.

3. Drag a marquee around an area of
your image.

The selection is outlined in a thin
white line and is separated from the
rest of the image by a drop shadow.

4. Click the top button that appears
beside the selection.

You can interrupt the rendering by
clicking the mouse.

To resume a render:

o Click the second button that appears
beside the selection.

To scale the selected area to fill the
working window:

1. Make sure Plop-Render mode is
enabled.

2. Switch to Bitmap display mode by
clicking the display mode icon on the
right side of the Bryce window.

3. Drag a marquee around an area of
your image.

The selection is outlined in a thin
white line and is separated from the
rest of the image by a drop shadow.

4. Click the triangle icon below the
render buttons and choose Zoom to
Selection from the menu.

The command centers the selected
portion of your wireframe scene and
scales it up to fit your window. This is
a pan & zoom operation, and
therefore does not affect your camera
position.
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Rendering a Movie

Rendering an animation is a lot like
rendering a still image. Each frame in the
animation is processed exactly like a still
image. You can use the same rendering
options you used to render still images
for movies.

Besides the standard still image rendering
options, there are several options you can
set for movie files: you can choose a file
type, a compression option, and a range
of frames to render. You set movie
rendering options using the Render
Movie dialog.
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The Render Movie dialog

This dialog contains all the options you'll
need to render your scene as a movie.
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The Render Movie dialog lets you set options for
rendering your scene as a movie file.

Name

This control lets you set a name and
location for the rendered movie. The
default name and destination is the same
as the scene file.

File Type

This control lets you choose the type of
movie file you want to produce.

*  Onthe Mac you can render a scene as
a QuickTime (MOV) file, or as
sequenced frame images.

¢+ Onthe PC you can render your scene
as a MOV, AVl file, or as sequences
frame files.

Compression

This menu lets you access all the available
compressors. The items listed in this
menu depends on the compressors you
have on your system. Refer to the
documentation that came with the
compressor or your system software for
instructions on using a specific
compressor.

Render Range

These options let you choose a range of
frames to render as the final movie. You
can choose to render all the frames in
your animation, a specific range of
frames, or only the frames within the
Working Area of your animations
timeline. Refer to “Setting Up the
Working Area” on page 358 for more on
the Working Area.



To start the rendering of a movie:

1. Choose File> Render Movie. The
Render Movie dialog appears.

2. Enter destination and name for the
movie.

Choose a file format for the movie.

4. Choose a compression option from
the menu.

5. Enable a render range option.
If you choose Frames, enter a start

and end frame number for the range.

6. Click the OK icon. Bryce starts
rendering each frame in the movie.

.
Batch Rendering

Batch Rendering lets you render a
number of files at the same time. This
way, instead of rendering each scene as
you create it, you can set up a number of
scenes, save them and then render them
all at once at a convenient time

To perform a batch render:
1. Save a number of scenes to a folder.

2. Dragall the files on the Bryce
application.

Bryce opens the file, renders it, saves
it and then opens and renders the
next file. You can render any number
of files this way.

-
Fast Render Strategies

There are several technigques you can use
to speed up the rendering process. These
techniques are most useful when
rendering animations, where you may
have a large number of images to render.

You can greatly increase the speed of a
render just by using the Preview Render
modes. Below is a table showing the time
it takes to a render a scene, containing
complex materials and lights, using
normal rendering and then using the
preview modes.

Render Option % of standard
time

Full Render 100%

Fast Render 41.7%

Textures Off 35.4%

Fast Render w/ 8.3%

Textures Off

Fast, Textures Off, 2.1%
AntiAliasing Off

Patch Rendering

Using the Plop-Render mode, you can do
a patch render of image. Patch rendering
involves the rendering of background and
flat elements using normal rendering and
then using the Plop-Render controls to
render areas that contain more complex
elements.

There are two thing you should
remember when using patch rendering:

«  Make sure you use Clear & Render
when you make changes with a
partially rendered image. If you stop
a rendering, make changes and then
click Resume Render, you'll end up
with noise instead of an image.
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+ If you changed elements that don’t
affect a large area of your scene, you
don’t have to render the entire scene
again. For example, if you render a
scene with a floating sphere, and then
delete it, you don’t need to re-render
the scene, only the area where the
sphere was.

To patch render your image:
1. Startarender as normal.

2. Let the rendering proceed for two or
three passes and then click the
mouse.

3. Switch to Bitmap display mode.

4. Drag a marquee around key portions
of your scene and then render those
areas using the Plop-Render controls.

You can also speed up rendering using
these techniques:

+  Limit the number of lights.

+  Keep objects near the background
simple.

¢+ Limit the number of volume
materials you apply.
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+  Limit the number of transparent and
reflective objects.

+  Limit the number of frames per
second to 15, which is adequate for
QuickTime movies. Video uses 30 fps
and film 24 fps.

+ Divide animations into smaller files
and eliminate objects that won’t be
seen on-screen.

+  Turn off AntiAliasing when
previewing animations.

il
Working with Rendered
Images
Once your scene is rendered, it becomes a
2D image that you can save as different

formats and edit in other 2D image
applications.

In Bryce, the 2D image is used as the
Bitmap display mode. You can use the
bitmap as guide for move objects, or as a
preview of your final image.

Scaling Your Image

The Pan and Zoom tools work
independently in wireframe display mode
and in bitmap display mode. So if you use

the Zoom tool to scale your wireframe
scene down, your rendered image
remains unchanged.

You can then use the same tools and
commands to scale your rendered image
up or down, independent of the scale of
your wireframe scene. If the image is
scaled up sufficiently, you can use the Pan
tool to pan through the enlarged image.

Refer to “Panning” on page 33 and
“Zooming In and Out” on page 32 for
more on the Pan and Zoom tools.



Post Production

o)

The rendering process creates a 2D image
from your 3D scene. The effects you add
to this image are considered post
production. Post production includes
things like compositing, filtering and
retouching the image in a image-editing
application.

Overview

When you're working with animations,
post production can include all of the still
image operations, or it can include more
advanced editing, like combining clips
and adding sound effects.
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Post Production
Applications

Bryce is a 3D application that creates
landscapes, it is not a image-editing
program. As such you won't find any
useful image-enhancing capabilities
you'll find in an image editor. For post
production operations you'll need to use

applications like Painter®, Corel

PHOTO-PAINT® or Adobe Photoshop®.
You can use these applications to adjust
colors, contrast or brightness. You can
even paint in elements that were not in
the original scene.

Bryce 3D’s rendered images can be saved
in formats compatible with almost any
image-editing application.
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Exporting Image

Bryce 3D can export your final rendered
image as a bitmap/PICT file.

To export an image:
1. Render you scene.

2. Choose File menu> Export. The
export dialog appears.

3. Choose a format for your image and
click OK.

Compositing

Compositing is the process of pasting one
image into another. For example, if you
create a farm scene in Bryce and then
create a mask for that scene, you could
paste it into a scanned image of a
tornado. With a little creativity you can
make the farm appear as though it were
about to be eaten by the storm.

The shape of the foreground image is
taken from a black and white image that
contains the shape of your scene. This
image is a called a mask. You can generate
a mask in Bryce by using the Mask
Render mode.

Using compositing, you can take the scene you
created in Bryce....

...render it as a mask, using Mask Render
mode...



...and then use the image as a selection mask in
a 2D image-editor. Once selected, you can place
your Bryce scene into a scanned image.

To render a scene as a mask:

1. Click the triangle next to the Render
controls and choose Mask Render
from the menu.

2. Choose File menu> Export and
choose either BMP/PICT.

Using Painter

The following compositing procedure
uses Painter as a post production
application. The steps for Adobe
Photoshop would be almost the same.

To composite using Painter:

1. Render the scene normally using
Perspective Render mode.

2. Save the image in a convenient
location.

3. Render the scene again, this time
using Mask Render mode.

4. Save the mask image to the same
location.

5. Open the Perspective Render image
in Painter (or another image-editing
application).

6. Choose Select menu> Load
Selection.

7. Inthe dialog, select the Mask Render
image. Click OK.

Painter selects the objects in your
scene.

8. Choose Edit menu> Copy.

9. Open the background image (the
image you want to paste your Bryce
scene into.)

10. Choose Edit menu> Paste.

The selection is pasted into the image
as a floater.

11. Position the floater where you
want it.

- _-—l-.._‘_____\_ =
Refer to the documentation that came
with your image-editing application for
more information on working with
masks.

- D L

Adding Depth

Bryce’s Distance Render produces an
image that can be used as a distance mask
in most image-editing applications. The
Distance Render image contains grayscale
representations of all the images in your
scene. Objects closer to the camera
appear black, while those furthest away
appear white. The objects in between are
various shades of gray depending on their
distance from the camera.

This grayscale information can be used to
create photographic depth of field effects.
For example, if you take an image that
has a lighthouse in the foreground and a
fishing village in the background and
render it using Distance render mode,
you can take the image into Adobe
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Photoshop® and create an image where
the lighthouse is in sharp focus while the
village is blurred.

To create depth of field using
Photoshop:

1. Render the scene normally using
Perspective Render mode.

2. Save the image in a convenient
location.

3. Render the scene again, this time
using Mask Render mode.

and using an image-editing application to place 4

the distance mask into the original image’s Save the mask image to the same

alpha channel. Once the Distance render is in location.
the alpha channel you can apply filters to create 5. Open the Perspective Render image
; photographic depth of field. ' . .
You can add depth to your scene by taking a and the Distance Render in
scene you created in Bryce.... . : Photoshop.
To render a scene as a distance mask: 6. Place the Distance Render image into
1. Click the triangle next to the Render the alpha channel of the Perspective
controls and choose Distance Render Image.
from the menu. 7. Load the alpha channel as a selection.
2. Choose File menu> Exportand 8. Apply Gausian Blur.
choose PICT. . .
Objects close to you will appear sharp
while objects farther away will
Using Photoshop become progressively more out of
The following procedure uses Adobe focus.
..rendering it as a distance mask, using Photoshop® as a post production * You can also invert the selection
Distance Render mode... application. The steps for Painter would and apply Motion Blur to the

be almost the same. image. In this case, objects in the

foreground would be motion
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blurred, and the background ,f"':}
would be sharp, as if you took T '
your a picture from amoving car. ~ Printing Images

+ If you take the Distance Rendered You can print rendered images directly

alpha channel and, in from Bryce. If you need color separations,
you'll have to use a image-editing or
pre-press application.

Photoshop’s Curves dialog,
remap the gray values, you could

determine very specifically You can specify printing options such as
which objects in your scene are in print quality, number of copies, print
focus and which are not. Just grayscale, im_age type (\_/ector V\_/ireframe
remap black input to lighter or rendered image), printer driver or
output, and the gray value of the postscript, as well as printer options such
. A as intensity, halftoning, bleed control,
desired focal object to black. and color matching. You can also preview
e a job before sending it to the printer.

To print an image:

1. Choose File menu> Print, or press
Command-P/Ctrl+P. The print
dialog appears.

2. Choose the options you want to use.

You can select any of the four
optional drivers or print either your
rendered image or your wireframe

You can change the focus of images by

remapping the gray values in the alpha channel
of your image. document.
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QuickTime VR

With the advent of Apple Computer's
QuickTime™ VR technology, it is now
possible to make some remarkable new
uses of 3D information from Bryce 3D.

QuickTime VR allows you to take a 360°
panoramic image, and make it into a VR
Movie; this unique movie will translate
the 2D panoramic representation of your
3D world, and allow point and click
navigation through the world. You can
look up, down and around your rendered
scene as though you were a camera on a
tripod.

Further, QuickTime VR lets you create
“Nodes,” or hotspots in the movie where
you can click and go to another linked
movie. This means you can look around a
landscape, and seeing an interesting rock
formation in the distance, click on it to
view the entire landscape from that new
vantage point.
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These nodes can also contain “Object
Movies;” another specialized technology
from Apple that allows you to click and
drag to, in effect, “pick up” any object in
the VR movie and examine it from all
sides, as if you literally picked it up and
turned it around and around in your
hands.

-
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QuickTime VR and Bryce 3D

Bryce has been ready for QuickTime VR
for over a year now, just waiting for the
technology to arrive. Bryce 2 allowed you
to generate seamless 360° images since it
was first shipped. These images were very
interesting, but there wasn't much you
could do with them other than playing
them in the Panorama Screensaver that
shipped with Bryce.

Bryce 3D stills generates these seamless
panoramas, and includes a number of
enhancements that make it very easy to
render these images ready to drag and
drop onto Apple's Make QTVR
Panorama tool.
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Creating VR Panoramas
The process of creating a panorama
involves completing a few easy steps.

To create VR panoramas:

1. Choose Default in the Document
Setup dialog.

2. Click on the uppermost Views
Memory Dot in the control palette, to
make sure your camera is level.

3. Set up your scene.

The important thing to remember is
that for a successful 360° scene, you
need interesting objects all around
your camera. The best way to work
on this is to go to the Top View, and
position objects all the way around
the camera.

4. Keep the Nano-Preview in Camera
View mode to check your view while
you are working in Top View.

5. Drag the tip of the camera around in
the Working window to check the
scene the view of your scene from all
directions.

6. Switch back to Camera View and do a
quick test render, once you have a
good distribution of objects in a
visually interesting scene.

7. After the render, make any required
position changes.

8. Choose File> Document Setup and
select QTVR Panorama.

This aspect ratio is optimized for use
with Apple's Make QTVR Panorama
tool, though many aspects will work.

The preferred aspect is 13:4. Width
must be divisible by 96, and height
must be divisible by 4. The QTVR
Panorama option makes sure your
image meets these criteria.

9. Click the triangle icon next to the
Render controls and choose Select
360° Panorama from the menu.

10. Click the Render button to do a quick
test render.

The panoramic render mode
necessarily introduces some
distortion into your image, and this
may change the way you want your
objects to appear.

11. Make any position changes you like.
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When you do a panoramic render, your
wireframe scene will bear little
resemblance to the rendered scene.
This is why you should work on your
scene in standard Default mode, and
switching to Panoramic rendering
after everything is set up.

" e -

12. Choose File menu >Render To Disk.
The Render to Disk dialog appears.

13. Leave the default settings.

The Output Size in Pixels was set by
the QTVR Panorama option in the
Document Setup dialog.

The Print Resolution defaults to
72dpi, which is the only acceptable
setting for the screen-resolution VR
movies; and the Output Size in
Inches is extra information. You can,
however, use these features to your
benefit if you need to print outa 2D
version of your VR scene.

14. Select the 90° counterclockwise
auto-rotate for Quicktime 360°
Panorama images option.

VR scenes need to be rotated 90°
counter-clockwise prior to use with
Apple's Make QTVR Panorama tool.

-~ 2 _-l—-_.__-__ R o
In the event that you have manually
typed in a size that will not work with
Apple's tool, Bryce will ask you if you
would like to automatically adjust the
size.

. e e

15. Click the OK icon.
16. Click the Render button.

17. When the rendering is done, choose
File menu >Export Image and select
a location and file format for the
saved the image.

VR images must be saved in PICT
format.

18. On your desktop, drag the image
onto Apple's Make QTVR Panorama
tool, accept their default values, and
make a VR Movie.

Further VR Exploration

This is a quick way to get started with
simple, single-node QTVR
movie-making. To create movies with
other embedded nodes, or to get deeper
into the world of QuickTime VR, contact
Apple Computer via the World Wide Web
or any normal channel, and ask them for
further information.

QuickTime VR
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Glossary

2D projection Your 3D scene must be
interpreted as a 2D projection; that’s how
it is translated to your 2D screen! Pretend
your 3D scene is a drawing on a (2D)
piece of paper, which is in front of your
camera lens; you have control over the
right/left up/down position of the paper
(Pan controls), and over the scale of the
drawing (Zoom/Scale tools). 2D
Projection values are an important factor
in defining a View for your scene.

3D transformation This is a term that
refers to any operation relating to the size,
rotation, and position of any object.
There are in fact other types of 3D
transformations that are possible in 3D
space, such as deformations, sweeps, and
lathing; but Bryce is not a modeler, and
supports only the basic three: size,
rotation, and position.
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3DMF Apple’s 3D MetaFile format for
exchanging 3D geometry between
applications.

absolute coordinates Values which
express an absolute location, rotation, or
size, whether they are location
coordinates, degrees of rotation, or units
of measure.

additive mode A color blending
algorithm which adds the brightness
value of colors from one item to the
brightness values of another.

algorithm A finite step-by-step
problem-solving procedure.

aliasing A visual artifact caused by low
resolution sampling that can cause hard
edges or areas of high frequency in an
image to look jagged (often referred to as
“jaggies”). See “antialiasing.”

alpha channel A separate grayscale
channel accompanying any PICT/BMP
file that can determine which areas of the
PICT/BMP will be visible in the final
image and which will not. Typically,
white areas in the alpha channel describe
the areas in the corresponding image that
will be visible, while black areas in the
alpha channel describe the areas in the
corresponding image that will not be

422  Appendix B Bryce 3D

visible. Also referred to as a mask. In the
absence of an alpha channel, Bryce can
use the luminance values of any 2D PICT
or 3D solid texture as alpha information.

altitude A measurement of height. In
Bryce, many textures will change their
behavior based on altitude.

ambient Light that has no point of
origin or specific direction, and is
presumed to strike every point on every
object with equal intensity. Since it is not
affected by other environmental light, it
tends to affect objects in shadow, and can
make objects visible even with no specific
light source.

amplitude In Bryce, this refers to the
intensity of the cloud definition.
Increasing the amplitude will make cloud
contours harder, while decreasing it will
result in softer-edged, more diffuse cloud
formations.

antialiasing The process of eliminating
aliasing by higher resolution sampling, so
that hard but jagged edges appear smooth
and clean.

aspect ratio The relationship between
the width and height of your document,
expressed in pixels as a width to height
ratio.

auto-update A feature in Bryce’s Sky &
Fog palette and Nano-preview which will
automatically update your changes into
your rendered scene or Nano-preview,
respectively.

banking Camera rotation around its Z
axis; kind of a left/right tilt. Also known
as roll, it creates the illusion that your
horizon is tilted.

batch rendering A process that will
allow you to automate the rendering of
multiple scenes. Just drag and drop a
group of scene files on the Bryce
application icon, and Bryce will do the
rest.

bitmap Literally, a “map of bits.” Your
screen is comprised of pixels, and each
one of those pixels expresses a level of
color, whether it is one bit (black and
white) or 24-bit (millions of colors). Your
image, when rendered, can be thought of
as a pixel-by-pixel map of color, hence
the term “Bitmap”.

boolean rendering A rendering
process wherein either the space taken up
by “negative” objects is subtracted from
“positive” objects, yielding an object with
portions removed; or two or more objects



are combined to form a composite object
combining the mass and dimensions of
all contributing objects.

boolean A fancy word that is used to
describe a system where there are two
possible states: On/Off, Yes/No, 0/1, True/
False, and so on. With respect to Bryce
rendering, a Boolean attribute such as
Negative or Intersect will determine
whether a particular part of a group of
objects will be Rendered/Not Rendered.

bryce units of measure An arbitrary
system of measurement for 3D objects in
Bryce 3D. Most Bryce objects when they
are created are a default size of
2048x2048x2048 Bryce units.

bump mapping A process that
interprets changes in an object’s surface
luminance or color values and, without
actually affecting the object’s geometry,
expresses them as perturbations on the
object’s surface.

camera space A method for
representing objects in 3D space. It uses a
set of Cartesian coordinates which are
relative to your camera.

camera A metaphorical “tool” for
viewing areas in a scene. The metaphor
refers to the conical projection of the
scene onto a 2 dimensional plane along a
specific direction.

center scaling The ability to perform
resizing or rotating operations on an
object based on the object’s center, rather
than an alternate point, such as its base.

CMKY color A well known subtractive
color standard widely used in the print
industry. CMY color models blend Cyan,
Magenta, and Yellow to approximate
colors for print; almost always used with
a fourth ink, black (K), to compensate for
ink impurities.

conversion The process of changing an
object of one type into an object of
another type. Use the little arrow in the
Edit palette...

deformation A special form of 3D
transformation which will deform an
object’s geometry, creating bulges, twists,
bends, and more. Bryce 3D does not
support this kind of transformation; but
you can certainly import deformed
objects from other modeling applications
via Bryce’s Import DXF and 3DMF
feature.

depth cueing The effect we use to
create the appearance that wireframes far
away are dimmer than wireframes closer
to the camera. This effect is adjustable.

derivative objects Most primitives
available in the Create palette also have a
few derivative objects as well. For
instance, the Sphere is accompanied by
an Ellipsoid and a Squashed Sphere; both
are considered to be Spheres by Bryce,
but they have had some post-processing
applied to change their sizes.

diffuse Light that is evenly reflected
from an object’s surface, visible regardless
of the angle from which it is viewed.
Diffuse is associated with matte objects.

document resolution The actual size of
your working document area, expressed
in pixels. When your Render Resolution
is set to 1:1, the Render resolution is the
same.

DXF Originally developed for use with
AutoCad™, this is the most common 3D
file exchange format.

edit Any action performed on an object
after its initial creation. Includes moving,
resizing, rotating, copying, assigning
textures, pasting, and more.
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family A kind of logical association,
assigning a Family attribute to a set of
objects allows you to select and display
sets of objects based on an assignable
wireframe color and associated family
name. This way, objects which share
some characteristic such as distance,
structure, material, or other, can be easily
seen, selected, soloed, and so on.

field of view Field of View values
describe the range, from 1 to 180°, which
your camera is allowed to take in.

frequency A measurement of the
number of times certain textural
characteristics repeat themselves within a
fixed area.

gel A texture or picture which is
applied to a light and treated as a
transparency or slide, enabling the light
to project colors, textures, or images onto
objects in your scene.

grayscale-to-height mapping A
process that interprets a grayscale range
from black to white and expresses that
range as height, from low to high.
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group Grouping, a kind of spatial
association, allows a set of objects to be
treated as one. To achieve Boolean
rendering effects, objects must be
grouped.

HLS color An alternative color model:
Hue, Lightness, and Saturation.

HSV color An alternative color model:
Hue, Saturation, and Value.

illumination In Bryce 3D, any property
or characteristic related to how an object
responds to light. This includes Ambient,
Color, Diffuse, Reflectivity, Refraction,
Specular, and Transmitivity.

image resolution Since Bryce renders
bitmaps at 72dpi, the only image
resolution you need to determine is the
height to width ratio of your image.

infinite plane A two dimensional
surface that extends infinitely along the X
and Z axes. Bryce 3D’s Ground, Cloud,
and Water Planes are all infinite planes,
though they exhibit different textural
properties and are placed in the scene at
different altitudes.

landing Dropping an object straight
down onto the object directly beneath it.
Usually used to “land” an object on the
ground.

link to view A Bryce feature which
locks the sun’s position to the camera
position. This way you can use the sun
control to set your sun position, and you
will not lose that position if you move the
camera.

location An object’s position in 3D
space. Synonymous with position and
offset.

mapping The process of interpreting
data input of one kind and expressing it
as another. See Bump Mapping,
Grayscale-To-Height Mapping, Pict
Mapping, and Texture Mapping.

marquee selection Marquee is a noun
which refers to a tool, in many
applications, which will create a selection
area; it can also be used to refer to the
selection itself. Bryce has no marquee
tool per se, but you can click and drag in
the wireframe window to marquee a
selection (here the term is used as a verb),
and you can click and drag in the
rendered image to marquee a selection
for discrete rendering.



material In Bryce 3D, the sum of up to
four textural elements, either 3D
procedural or 2D picture-based, used to
drive various effect channels, plus post
processing, used as a surface property for
Bryce objects.

materials channel The rows in the
Materials Grid, grouped as Light, Effect,
and Color; can be driven independently
or by Texture Components.

materials grid The gameboard-like
area in the Materials Lab where Texture
Components drive parameters in the
various Channels in the Grid to make a
Material.

matrix The term is used only in the
Bryce Edit menu, for the Copy/Paste
Matrix commands. When you use these
commands, you are copying and pasting
an object’s position, rotation, and size;
you are not copying size, rotation, or
position alone, but the matrix of all
coordinates, hence the name.

memory dots A feature created by
MetaCreations, and used in many
MetaCreations products, it is available in
the Control palette for use with Views,
and in the Sky & Fog palette. This feature

allows you to simply click on a Memory
Dot to save the state of the parameters to
which it pertains.

nano-editor The Nano Editor is a small
version of your wireframe window, which
you can use to edit your scene quickly.

nano-preview A small preview of an
object or scene. The Nano-preview
window is at the top of the Control
Palette.

object space A method for
representing objects in 3D space. It uses a
set of Cartesian coordinates which are
relative to a given object.

object type Though Bryce creates and
imports many kinds of objects, for the
purpose of selections and conversions it
must sort these objects into types. These
types can be clearly seen in the
Conversion option and in the Edit
palette. Cubes and their derivatives are all
of the Cube type; Cloud, Water, and
Ground planes are all of the Infinite Plane
type; Pict objects and 2D Faces are all of
the 2D Face type; all imported objects are
of the Polyhedron type.

offset An object’s position in 3D space.
Synonymous with position and location.

opacity The degree to which light
cannot pass through an object. In Bryce,
the term primarily refers to the opaque
portions of alpha-channels.

orientation An object’s orientation in
3D space, expressed in degrees;
synonymous with rotation.

orthogonal A special projection of your
scene which has no perspective
distortion. Kind of a perspective-free
drafting board view, used for precise
alignments. All Views with the exception
of the Camera View are Orthogonal. The
term can be used interchangably with the
term orthographic.

output resolution Available in the
Export Render dialog, you can set the
print resolution of the resulting rendered
image expressed in dots per inch.

parallel light A light which cast rays
that are perfectly parallel to one another.

patch rendering A technique you can
use in Bryce 3D: select a specific area, or
patch, of your image for further
rendering. Useful to examine areas for
detail before doing a final render, or for
re-rendering specific areas after making a
change, thereby avoiding having to
re-render your entire image.
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pict mapping A process that interprets
a 2-dimensional Pict and expresses it as
the surface of a 3-dimensional object,
according to a specified algorithm.

pitch Camera rotation around its X
axis; kind of a tilt forward or back.

plop-render Just a cute name for our
way of representing a marqueed selection
of your rendered image. Selections
appear to “plop” forward, with attendant
drop shadows and rendering controls.
This feature can be enabled, disabled, or
hidden, as you wish.

polygon All 3D objects in Bryce 3D are
built from multiple-sided (in Bryce, we
use 4 sides) geometric surfaces, and are
therefore inherently polygonal in nature.

polyhedron Used in reference to
imported geometry as well as Bryce’s
internally created Stone objects. Similar
to Polygon, but polygonal faces have been
diagonally split, or triangulated.

primary rays The quantity of virtual
rays of light that are initially "shot" into
the Bryce scene.
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primitive A basic geometric form, such
as a cube or sphere, used as a basis for
constructing compound 3D objects such
as buildings, rocket ships, or snowmen.

primitives Like primary colors,
Primitives are Bryce’s primary objects.
Spheres, cubes, cylinders, pyramids,
cones, disks, squares, and toruses are all
primitives.

procedural objects Procedural objects
are object that require special
constructions or “procedures” to create
them. Procedures can include operations
such as preassignment of materials,
randomization of internal parameters or
assignment of light properties. For
example, terrains.

radial light A light which casts rays
equally in all directions.

ray hits The total number of times all
rays strike objects in your scene. Note:
The total of Ray Hits and Misses is not
equal to the total of Primary and Shadow
rays because secondary rays are not
quantified in the Render Report.

ray misses. The total number of rays that
are fired, but strike no objects in your
scene. Note: The total of Ray Hits and

Muisses is not equal to the total of Primary
and Shadow rays because secondary rays
are not quantified in the Render Report.

raytracing An image synthesis
technique by which a virtual beam of
light is projected from a virtual camera
into a 3D scene in order to evaluate
shading and visibility. The virtual beam
may be absorbed, reflected, or otherwise
affected to some degree by every object it
strikes. For instance, if it hits your sky,
then a blue sky color ends up on that
portion of your virtual “film” your image.
In this way, a final color is determined for
each pixel in your image.

reflectivity The degree to which an
object bounces light back from its
surfaces.

refraction As a light wave passes from
air through another medium such as
water or thick glass, it seems to bend or
turn to a certain degree. This
phenomenon is known as refraction, and
the degree to which light bends or turns
in these situations is controlled by the
Refraction channel in the Materials Lab.

relative coordinates \alues which
express location, orientation, or size
relative to the current location,
orientation or size.



render The complex process of
building a 2-dimensional bitmapped
image from all the information contained
in your 3-dimensional wireframe scene.

render resolution The size of your
rendered image, expressed in pixels, or as
a multiple of your Document Resolution.
The implication here is that your
rendered image can be larger or smaller
than your Document Resolution.

replicate While Duplicate will create a
copy of your selected object, Replicate
will create a copy of the object and the
last 3D transformations applied. If you
create an object, move it up a bit and
rotate it a bit, selecting Replicate will
create a copy, move it and rotate it for
you; Multi-replicate will do the same with
multiple copies in one step.

roll Camera rotation around its Z axis;
kind of a left/right tilt. Also known as
banking, it creates the illusion that your
horizon is tilted.

rotation An object’s rotation in 3D
space, expressed in degrees; synonymous
with orientation.

scale Values that express the space an
object occupies; synonymous with Size,
though Size implies an absolute space.

scene a) The complete content of your
Bryce world; b) The two-dimensional
screen projection of your 3D scene; ¢)
The file that Bryce saves, containing all
information regarding your landscape.

secondary rays \When a primary
virtual light ray strikes an object, if that
object is reflective or transparent, another
secondary ray is fired from that location
(either bounced, if reflective, or bent, if
transparent/refracted) to continue
through the scene. This process is
repeated up to six times, to find a home
for the ray, and therefore a final color for
a pixel in your scene. Secondary rays are
not quantified in the Render Report.

shadow rays Once a primary or
secondary virtual light ray has found a
final resting place, it must determine
whether or not to create a shadow behind
the object. To do so, another ray is fired
from that location, and this is a shadow
ray.

size Values that express the space an
object occupies; synonymous with Scale,
though Scale implies a relative size.

sky dome A secondary environmental
ambient light, used to create a color cast
in a scene where there is little visible
global light.

smoothing Imported objects consist of
polyhedral faces, which, when rendered,
appear quite chunky. This is not, in most
cases, desirable. Use the smoothing
command to eliminate this chunkiness.
You can set a threshold angle for
smoothing as well.

snap to A special form of 3D
Transformation changes the selected
object’s position based on the Snap To.
command you select. These commands
are located in the Edit palette, in the
Alignment Options menu.

solid texture A three-dimensional
mathematical description of an object’s
textural characteristics. Often referred to
as procedural texture.

specular The “highlight” of any object
with a shiny surface; light that reflects
non-uniformly in specific directions
depending on the surface roughness.
“Specular highlight” refers to the point
where specular reflection is most
pronounced.

spotlight A light which casts rays in a
cone shaped spread; often used top create
the classic “Hollywood spotlight” effect.
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square spotlight Similar to the
SpotLight, but casts rays in a
pyramid-shaped spread; think of itas a
slide projector.

symmetrical lattice A procedural
Bryce Terrain object which has another
Terrain mirrored at the base.

terrain  An object used in Bryce as the
basis for mountains, islands, plateaus,
and other landscape objects.

terrain canvas The area in the Terrain
Editor onto which you paint and apply
effects. Terrain data can be rendered at
many levels of detail, from 16x16 to
1024x1024. This resolution does not refer
to the wireframe that is used to represent
the terrain, but instead to the grayscale
data used to determine the internal level
of detail used to generate the terrain.
Terrains with lower resolutions will
appear chunky, and will render very
quickly; use these for terrains that are far
in the background or where detail is not
so important. Terrains with higher
resolutions will show increasing levels of
detail, and will take much longer to
render; use these for foreground terrains,
or in other cases where detail is
important.
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terrain resolution Terrain geometry
can be rendered at several levels of detail.
At very low settings, you may see
geometric “facets” in your terrains, even
with “smooth surfaces” selected. In this
case, increase your terrain resolution.
Low resolution rendering is often best for
items in the far background, where detail
is not so important.

texture component a part of an
object’s material. Texture Components,
which can either be a 2D Picture or 3D
Texture.

texture mapping A process of applying
detail to a surface without actually
affecting the object’s geometry. Values
from the texture can determine or affect
any surface characteristic, including
color, reflectivity, transparency, or
bumpiness.

torus A Bryce primitive that looks like a
donut.

transparency The measure of an
object’s ability to transmit light through
its surfaces. Also referred to as
transmitivity.

triangulation The process of splitting
up geometric faces into triangles for
greater flexibility.

unity The state a Bryce object is in
when it is first created, or just after the
Unity button has been pressed;
positioned within a “cube” of fixed size in
an invisible 3D grid, with no rotation
applied.

view The sum of camera position in 3D
space, plus 2D Projection pan and scale
values.

wireframe A mesh representation of a
3D object.

wireframe resolution Your onscreen
wireframe objects can be displayed at
various levels of detail; this display
resolution can be set discreetly for static,
selected, and moving wireframes. This
resolution has no relevance to document,
render, or output resolution.

world space A method for
representing objects in 3D space. It uses a
fixed, or absolute, set of arbitrarily
determined Cartesian coordinates.

yaw Camera rotation around its Y axis;
kind of turning to look right or left.



Troubleshooting

Paint and unpaint brush behavior in
the Terrain Editor show no effects.

The paint and unpaint brush behavior
works only after you've applied an effect
to it. For example, erode your terrain and
then you can unpaint the effect in any
area you choose. If you “unpaint” too
much, you can “paint” the effect back in.

Spheres look like ovals in Panorama
Render.

In order to have objects not appear
squished after performing a Panorama
Render, please follow this formula:

Scale the height (vertical dimension) by a
factor of 2 before rendering. Therefor, if
you want your panorma to be sized at
1800x450, set your size at 1800x900 and
render, then use Photoshop (or a similar
application) to scale vertically 50%.
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Missing faces in DXF imported objects.

What you are experiencing, is a limitation
with the DXF file format. This format is
preferred for irregular shapes due to the
nature of polygons. The DXF file format
has a problem generating perpendicular
planes because of the polylines. It’s best
to use the primitives provided in Bryce 2
for the basic shapes.

Imported objects and stones do not
behave like Bryce primitives.

Imported Objects and Stones (all
polyhedral objects) exhibit some
idiosyncratic behavior, due to the nature
of their construction. Using the Snap To
Land command or arrow icon will drop
polyhedral objects to the ground, same as
Snap to Ground function. Textures which
require volume/depth information to
create certain effects (such as cloudy
textures) may not render on polyhedrons.
Boolean operations are erratic at best
with polyhedrons.

The family color of an object will not
change.

No changes can be made to an object that
is locked. Check the object attributes box
and make sure it is not locked.
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Objects are not rendering properly, yet
they appear to be aligned when viewed
in wire frame

Sometimes objects look aligned when in
the camera view, yet the top view will
show some objects are further from the
camera than others. This causes the
difference in rendering. Make sure all
objects are aligned properly from the top
view.

Objects appear to be on the wrong side
of the screen in camera view after
positioning them in top view.

Positioning objects using the bottom
view causes this effect. The bottom view
is almost identical to the top view. Use
the view pull down menu to check which
one is active. Make sure that objects are
positioned when using the top view and
not the bottom view.



MetaCreations License Agreement

THIS LICENSE AGREEMENT IS A LEGAL
AGREEMENT BETWEEN YOU,THE END
USER,AND MetaCreations Corporation.
IT IS A LICENSE AGREEMENT AND NOT
AN AGREEMENT FOR SALE.PLEASE
READ THIS LICENSE AGREEMENT
CAREFULLY BEFORE OPENING THIS
SEALED PACKAGE.IFYOU DO NOT
AGREE WITH THE TERMS AND
CONDITIONS OF THIS LICENSE
AGREEMENT,PROMPTLY RETURN THE
PACKAGE UNOPENED TO THE PLACE
YOU OBTAINED IT AND YOUR MONEY
WILL BE REFUNDED.

MetaCreations Software License

1) License

This software can only be used on a
single computer at any one time.This
means that the software should be loaded
on only one hard drive at a time.If you
wish to use this software on more than
one computer,you must either erase the
software from the first hard drive when
you move the software to a second hard
drive, or else purchase two copies of the
software.You may not under any
circumstances have this program loaded
onto the hard drives of two or more
computers at the same time.You also may
not copy this software onto a hard drive
and then use the disks on another
computer.The software may be executed
from a common disk shared by multiple
computers provided that one authorized
copy of the software has been licensed
for each computer executing the
software.

2) Copyright

This software is owned by MetaCreations
and is protected by United States
copyright laws and international treaty.By
law,you, the end user,may do the
following:

a) make a copy of the software solely for
backup or archival purposes; or

b) transfer the software to a single hard
disk, provided you keep the original
solely for backup or archival purposes.

United States copyright laws prohibits you
from making any other copy of the
software for any reason without our
permission.These federal copyright laws
also prohibit you from copying the
written materials accompanying the
software without first obtaining our
permission.

3) Restrictions

You may not rent,lend, lease, or assign
this software.You may, however, transfer
the software and the accompanying
written materials on a permanent basis.
When you transfer the software on a
permanent basis,you may not keep any
copies,and you must remove the
software from your hard disk.Also, the
person to whom you transfer the software
must agree to the terms of this License.

You may not alter, modify or adapt the
software or accompanying materials. In
addition,you may not translate,
decompile,disassemble or reverse
engineer the software.You also may not
create any derivative works based on this
software.A derivative work is defined as a
translation or other form in which the
software may be recast, transformed or
adapted.

4) Limited Warranty

MetaCreations Corporation warrants that
this program will perform in substantial
compliance with the published
specifications and documentation
supplied in this package, provided it is
used on the computer hardware and with
the operating system for which it was
designed.This warranty is limited to a
period of 90 days from the date of the
original purchase.

MetaCreations Corporation warrants that
the original disks and documentation are
free from defects in material and
workmanship, assuming normal use, for a
period of 90 days from the date of
purchase.

5) Remedies

If you report a significant defect in
performance of the software in writing,
within 90 days of purchase,
MetaCreations Corporation will attempt
to correct it or,at its option, authorize a
refund of your license fee.

If a defect in the disk or documentation
occurs during this period,you may return
the faulty disk or documentation, along
with a dated proof of purchase,and
MetaCreations Corporation will replace it
free of charge.

6) No Other Warranties

Except as specifically provided
above, MetaCreations Corporation
makes no other warranty or
representation, either express or
implied, with respect to this software,
the disks or documentation,
including their quality,
merchantability, or fitness for a
particular purpose. In no event will

MetaCreations Corporation be liable
for direct, indirect, special,
incidental, or consequential damages
arising out of the use or inability to
use the software or documentation,
even if MetaCreations Corporation
has been advised of the possibility of
such damages.

The warranties and remedies set forth
above are exclusive and in lieu of all
others,oral or written, express or implied.

MetaCreations Corporation is not
responsible for any costs including, but
not limited to,those incurred as a result
of lost profits or revenue, loss of time or
use of the software, loss of data, the costs
of recovering such software or data, the
cost of substitute software, claims by third
parties, of other similar costs.In no case
will MetaCreations Corporation’s liability
exceed the amount of the license fee.

The warranties provided give you specific
legal rights.You may have other rights
which vary from state to state.Some states
do not allow the exclusion of incidental
or consequential damages, or the
limitation of how long an implied
warranty lasts,so some of the above may
not apply to you.

7) U.S. Government Restricted Rights

MetaCreations Bryce 3D and
documentation thereto are provided with
RESTRICTED RIGHTS. Use, duplication or
disclosure by the Government is subject
to restrictions as set forth in subparagraph
(c)(2)(ii) of the Rights in Technical Data
and Computer Software clause at 52.227-
7013.The contractor/manufacturer of
Bryce 3D and documentation thereto is
MetaCreations Corporation, PO.Box
66959, Scotts Valley,CA 95067-6959,

(408) 430-4000.
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Align with twists option 321
Aligning numerically 300
Aligning objects 297
along motion paths 321
landing 299
snap to options 298
using the align tool 298
using the grid 297
Alpha channel
defined 115
images
adding information 118
creating 119
pasting 119
viewing 116
inverting 114, 120

Alpha channels
defined 422
materials 199
Pict objectsand 113
Altitude
clouds 146
defined 422
Altitude render 405
Ambiece
defined 422
Ambience 201
setting using textures 202
Ambient color 202
setting using texture 203
skies 137
Amplitude
clouds 147
defined 422
Angles
different display 31
Animating
between materials 388
camera 379
clouds 391
director’s view 381
editing object attributes 320
environmental effects 391
material channel values 386
materials 48, 385
objects 86
skies 49, 389
sky and fog settings 390
sun/moon 392
techniques 377
terrain geometery 394
terrains 48, 393
texture components 387
using orthogonal views 381

Index
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Animation

advanced motion lab 19

compression 408

managing your project 49

motion and timing principles 50

new features ix

overview 43

preparing scenes for 50

previewing 389, 397

process 44

rendering 50, 408

simplifying 50

storyboarding 49

tab 107

terrains 166
Animation controls 17, 44

Advanced Motion Lab button 46

Keyframe controls 45

options 45

preview controls 45

Swap button 46

terrain editor 166

Time Dots 45

Timeline 44
AntiAliasing 401

defined 422

fine art slow 402

normal quality 402

off 402

rendering 399
AntiAliasing Fine Art (Slow) 402
AntiAliasing Off 402
Application

launch state 22

preferences 22
Arc movement 51
Arranging

objects 58, 279
Aspect ratio

defined 422

documents 29

preset values 29
Atmosphere Off 134
Atmosphere tab

environmental attributes dialog 157, 159
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Attributes
command 107
editing 123
skies 135
Wireframe mode 24
Auto Update 31
Auto-key 45
Auto-Update
defined 422
AVl files 408

Back view 35

Background
color 26
texture 26
Backgrounds
paper texture 26
window 26
Banking
controls 336
defined 422

Base Density 210
setting using a texture 211
Basic Noise
terrain effect 175
Basic tools
basic noise 175
gaussian edges 174
height noise 176
raise/lower 173
round edges 175
sharpening 173
slope noise 175
smoothing 174
square edges 174
terrains 173
Batch Rendering 409
defined 422
Behaviors
paintbrush 182

Bitmap
defined 422
display mode 23
preview mode 105
saving 22
Blending
fog color 138
haze color 141
pictures 188
Blob Maker
terrain effect 179
Boolean
compound 123
defined 423
intersection 122
neutral 121
objects 121
operations 121
rendering,defined 422
subtraction 122
union 121
Booleans
editing attributes 316
intersect 316
negative 316
Nuetral 316
positive 316
Bottom view 35
Bounding Box preview mode 104
Boxes
displaying objects as 30
Brickoids
creating 112
selecting 37
Brughtness
moon 155
Bryce
interface 26, 54
setting up windows 22
Bryce 3D overview 13
Bryce and 3D space
coordinate systems 283
Bryce units
defined 423
Bubble Ridges
terrain effect 181
Building Textures 274



Bump Height 206
Bump mapping
defined 423

C

Camera 325
aiming 340
animating 379
banking 336
controls 15
defined 423
field of view 329, 336
hiding 329
link tosun 152
linking 382
linking to clouds 149
locking 329
modes 332
orbits 384
origin point 339
positioning 55, 334
positioning controls 15
positioning manually 338
positioning origin point 337
rotating 333
saving positions 341
setting properties 329
tracking 382
trajectory 382
Camera and 2D projection dialog 337
Camera Cross controls 334
options 335, 336
X-Y cross 334
X-Zcross 334
Y-Zcross 334
Camera modes 332
center to selection 332
choosing 333
free 333
trackball mode 332
tripod mode 333
Camera space 282
defined 423

Camera trackball 333
Cameraview 35, 326
banking 336
field of view 336
overview 328
positioning numerically 337
swapping with Director’s view 330
Canvas
blending with filter 186
mapping colorsto 190
terrain editor 165
Center scaling
defined 423
Center Scene option 335
Center Selection 336
Center to Seletion Mode 332

Changing

object display 30
Channels

alpha 115

animating 386
materials 194
Clear command 40
Clipping
bracket 190
moving bracket 191
resetting 191
setting range 191
terrains 190
Closing files 42
Cloud Coverage 145
Cloud plane tool 109
Cloud planes 109
Cloud tab
environmental attributes 143
Clouds 141
adding 142
altitude 146
animating 391
coverage 145
cumulus 142
editing texture 143
fixed plane 149
frequency and amplitude 147
linking to camera view 149
stratus 142

CMYK color
defined 423
Color
adding to terrains 189
ambient, skies 137
blending fog 138
blending haze 141
fog 138
haze 140
light, editing 345
mapping to canvas 190
selecting background 26
sky dome 147
sun 152
switching to grayscale 190
Color blending modes 247
altitude 249
banded 248
blue or saturation 247
earthmap 248
green or light 247
interferences 249
interpol + interferences 249
linear interpol 2 247
linear interpol 3 248
none 247
orient 249
perturbed 248
randomized 248
red or hue 247
slope 249
spline interpol 247
spline with snow 249
Color channels 196
ambient color 202
diffuse color 200
specular color 204
transparent color 207
Color/Grayscale toggle 190
Combining texture components 267
Components
animating 387
materials 198, 212
textures 244
textures, color 245
Compositing 412

Index
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Compound
Boolean 123
Compression
rendering movie 408
rendering without 50
Cones
creating 111
derivatives 112
selecting 37
Constrain Proportions button 29
Control handles 102
Control palette
View Control 15
Control points 290, 296
rotation 293
Controls
animation 17,44
Animation Preview 45
camera 15
Keyframe controls 45
positioning 15
rendering 16
Time Dots 45
view 15
views 34
Conventions, user guide  Xi
Conversion
defined 423
Converting
objects 323
paths 125
Coordinate systems 283
absolute coordinates 283
object space coordinates 283
relative coordinates 284
Copy command 39
Copy Material command 39
Copy Matrix command 40
Copying
Alpha channel information 119
pictures 118, 188
RGB information 119
Coverage
clouds 145
Create palette 16
Picture Library and 116
Create Path command 125
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Creating
2D faces 112
alpha channel images 119

brickoid 112
cones 111
cubes 111

cylinders 111
cylindrical parallel lights 344
derivative primitives 112
discs 112
documents 28
ellipsoids 112
geometric paths 124
infinite planes 108
lights 342
materials 18, 74
object hierarchies 303
objects 63
orbits 384
parallel lights 344
Pict objects 112
primitives 111
pyramids 111
radial lights 344
RGB images 119
scenes 28
skies 68, 129
spheres 111
spotlights 344
square spotlights 344
stones 110
symmetrical lattices 111
terrains 18, 64, 167, 170
textures 274
toruses 111
tuboids 112
VR panoramas 418
Creative support  Xii
Cross Ridges
terrain effect 180
Cross Ridges 2
terrain effect 180
Cubes
creating 111
derivatives 112
selecting 37

Cumulus
adding 143
clouds 142
Cursor 102
Cut command 39
Cutting
materials 39
matricies 40
objects 39
Cylinders
creating 111
derivatives 112
selecting 37
Cylindrical parallel light 344
creating 344

Dampen
terrain effect 177

Darker Sky 134

Day/Night toggle 151

Deep texture editor 76
blend modes 267
building textures 274
component elements 244
component outputs 242
component previews 276
dragand drop 275
overview 272
randomizing components 276
working with 274

Deformation
defined 423

Delete button 120

Delete Key button 45

Deleting
objects from a selection 36
pictures 120
Preset objects 127
preset skies 160

Depth
adding 413



Depth Cue 24
defined 423
icon 25
Derivative primitives 112
defined 423
Deselect All command 36
Detail
reducing 50
Diffuse color 200
Diffusion 200
defined 423
Director’s view 35, 326
animating 381
banking 336
field of view 336
overview 330
positioning numerically 337
swapping with camera view 330
Disabling
sun 153
Discs
creating 112
Display
changing 30
palette 17
text 16
textand 27
Display Mode tool 23, 24, 27
Display modes
bitmap 23
Flat Shaded Preview 24
setting 23
switching 23
wireframe 23
wireframe/bitmap 24
Displaying
different angles 31
interface information 27
object statistics 27
objects 317
objects as boxes 30
objects as wireframes 30
palettes 26, 27
pictures 117
pop-up dialogs 28
rendered image information 27
scenes 30

Selection palette 37
show as box 317
submenus 28
VCR Controls 38
Distance render 404, 413
Do not align option 321
Document resolutions 403
defined 423
Documents
aspect ratio 29
creating 28
preset resolutions 29
resolution 29
working with 28
Duplicate command 40
Duplicating
objects 40
DXF file format
defined 423
importing 120
plug-ins 121
DXF objects
smoothing 322

E

Edge softness 211
lights 346
Edit Attributes command 123, 124, 312
Edit button 323
Edit lights dialog 345
Edit palette 16
Editing
attributes 123
cloud textures 143
imported polyhedrons 322
light attributes 345
materials 18
stones 322
terrains 18
visible light material 348
Editing objects 311
aniamtion attributes 320
attributes 312

boolean attrbutes 316
converting 323
display attributes 317
icon 315
linking attributes 319
names 316
restoring 312
torus attributes 322
tracking attributes 319
transformations 318
Editor
terrain 164
Effects
applying locally 182
elevation tools 171
eroding 168
geometry 178
image filtering 176
removing locally 182
Elevation
basic tools 173
image filtering effects 176
painting 181, 182
source generators 172
switching sets 171
tools 171
using tools 171
Elevation tab
terrain editor 165

Ellipsoids
creating 112
selecting 37

E-mail support  Xi
Environment controls
new features X
Environmental attributes dialog 131
atmosphere tab 157, 159
cloud tab 143
sun/moon tab 149, 153
Environmental effects 156
animating 391
rainbows 157
stars 158
sun/moon illusion 157
sun/moon rings 156
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Environments

adding clouds 142

creating 129

effects 156

rainbows 157

stars 158

sun 149

sun/moon illusions 157

sun/moon rings 156
Equalize

terrain effect 177
Erasing

Marker Pen lines 41
Eroded

terrain effect 172
Eroding

locally 182

terrains 168
Exaggeration 51
Expanding/collapsing object hierarchies 304
Exporting

images 412

Preset objects 128

sky presets 161
Eye Level Camera 336

F

Faces
creating 112
Fall-off 346
linear 346
squared 346
Families 309
defined 424
icon 313
tool 37
Fast preview 405
Fast render strategies 409
patch rendering 409
Fax support  Xxii
Field of View 336
defined 424
setting 329
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File Type

rendering movie 408
Files

closing 42

opening 29

saving 22,41
Filtering 261

absolute—abs(aX +b) 263
altitude minus slope—Xb + a
(altitude-slope) 264
altitude—X(a* altitude + b) 265
applying changes to preview 186
blending with canvas 186
choosing filter 262
clipaX+b 264
editing filter 262
gaussian—(a(X + b)) 264
how it works 183
none 263
orientation—X(a * orientation + b) 266
quantize 263
saw wave 263
sine wave—sin (aX) +b 263
slope—X(a * slope + b) 265
smooth clip 266
snow puddles 266
tab 184
terrains 183
xpower—(X PWR a) +b 264
Filtering Graph
altering 185
softening 185
terrains 185
Filteringtab 184
graph 185
presets 186
terrain editor 165
Fixed cloud plane 149
Flat Shaded Preview display 24
Flipping objects 288
Fly-around view 34
Fly-around view icon 34
Fog
adding 137
attributes 137
color 138
hieght 138

linking to Sun 138

localized 139

setting amount 138
Fog color

blending 138
Fractal

terrain effect 172
Free Mode 333

Frequency
clouds 147
defined 424

Front view 35
Full Scene mode 31
Fuzzy Factor 211

G

Gaussian Edges
terrain effect 174
Gels 115, 349
defined 424
using picture 349
using texture 349
General tab 107
Generators
terrains 172
Geometric paths
convertingto 125
creating 124
linking options 307
linking to objects 125
Geometry
animating 394
Geometry effects
blob maker 179
bubble ridges 181
cross ridges 180
cross rodges 2 180
raise edges 179
relief noise 179
subplateaus 180
terrains 178



Global texture changes 270
colors 270
filtering 272
noise 271
phase 271
Glossary 421
Gradients
applying to diffuse channel 190
for terrains 189
Graph
filtering 185
Gray levels
darkening 183
lightening 182
painting 182
Grayscale
paintbrush 181
switching to color 190
to-height mapping,defined 424
Grid 297
units 297
Ground plane tool 109
Ground planes 109
Grouping objects 302, 307
defined 424
families 309
icon 314
ungroup icon 315
Groups
selecting objects 36

H

Handles 102
Haze
adding 137
attributes 140
color 140
intensity 140
linking to Sun 141
Haze color
blending 141
Height Noise
terrain effect 176

Hidden 317
object 317
Hidden objects
selecting 36
Hiding
interface 26
palettes 26
Hierarchies 302
expanding/collapsing 304

families 309

grouping 307

linking 305

structure 303

viewing 304
Hierarchy List 46
HLS color

defined 424
Horizon

sun/moon illusion 157
HSV color

defined 424

Icons
editing objects 315
families 313

grouping 314
landing objects 315
linking 314

material 315

object attributes 313
tracking 314
ungroup 315

Illumination
defined 424
Image filtering effects 176
dampen 177
equalize 177
mosiac 178
mounds 176

posterize 177
sawtooth 178
spikes 176
subcontours 178

Image resolution
defined 424
Images
compositing 412
exporting 412
printing 415
rendered information 27
working with rendered 410
Import command 120
Imported objects
smoothing 322
Importing
objects 120
Preset objects 127
sky presets 161
Infinite planes 108
defined 424
Infinite slabs 109
new features X
selecting 37
Information
adding to pictures 118
interface 27

objects 27
rendered images 27
Intensity

light, editing 345
setting haze 140
shadows 136

Interactive
repositioning 296
resizing 290
rotation 293

Interface
Bryce 54
hiding 26

information 27
Intersecting

objects 122,124
Intersection

boolean 122, 316
Invert button 114, 120
Inverting

Alpha channel 120

alpha channel 114

terrains 167
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K

Key events 351
Keyframes
controls 45

L

Labs
Advanced Motion Lab 19
Materials Lab 18

Lag 51

Landing objects 299
defined 424
icon 315

Landscapes 163
creating 170

filtering 183
painting 181
Lattices

symmetrical 111
wireframe mode 104
Launch state 22
Left view 35
Library
adding picturesto 117
Light Editor
Picture Library and 116
Lights 325
adjusting color 345
adjusting intensity 345
creating 342

cylindrical parallel lights 344

edge softness 346
editing attributes 345
fall-off 346

gels 349

linking 350
overview 326
parallel lights 344
positioning 350
previewing 345
radial 343
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settingup 342

spotlight 343

spread 346

square spotlights 343

tracking 350

viewing 327

visible 328, 347

volumetric world 159
Linear Fall-off 346

Lines

erasing 41
Link icon 125, 314
Linking

camera 382
geometeric paths 307
objects to paths 125
propagate 306
to view,defined 424
Linking objects 302, 305
editing attributes 319
icon 314
lights 350
options 306
Linking tab 107
Lists, pictures 120
Load button 113
Loading
pictures 187
pictures into library 117
Localized fog 139
Location
defined 424
Locked 317
object 317
Locked button 317
Logical groups 309

Make circular option 321
Make one shot option 321
Make pendulum option 321
Make repeat option 321

Manually Positioning the Camera 338

Mapping
defined 424
Mapping color
to terrain canvas 190
Marker Pen tool 41
MarkerPen tool
erasing lines 41
Mask render 403
Masks 115
Materials 193
3D textures 75
alpha channels 199
animating 48, 385
animating between 388
channels,defined 425
components 198, 212
creating 74
cutting 39
defined 425
editor 18
grid, defined 425
icon 315
new features iX
pasting 39
picturesas 114
structure 194
surface material channels
volume 18
volume material channels
Materials Lab
displaying 315
overview 18
Picture Library and 116
Matrices
cutting 40
defined 425
pasting 40
Maximize
windows 22
Maximum
paintbrush behavior 182
Memory dots 15
camera positions 341
defined 425
Menu bar 20
Merge command 30

194, 200
197, 210



Merging
scenes 30
Mesh objects
selecting 37
MetaCreations ~ Xii
Metallicity 205, 210
setting using a texture 205
Minimum
paintbrush behavior 183
Modes
360 panorama 404
altitude render 405
bitmap 23
camera 332
center to selection 332
display 23
distance render 404
Flat Shaded Preview mode 24
free 333
mask render 403
perspective render 403
preview render 405
render 403
switching 24
trackball 332
tripod 333
wireframe 23
wireframe/bitmap 24
Modifier keys  Xi
Moon
animating 392
brightness/sharpness 155
phases 155
positioning 153
working with 153
Moon rings 156
secondary 157
Mosaic
terrain effect 178
Motion path
converting to geometric path 125
Motion paths
align options 321
display options 320
editing attributes 320
geometry options 321
Motion principles 50

Mounds
terrain effect 176

MOV files 408
Moving
palettes 26

Multi-Replicate command 40

Name
rendering movie 408
Naming
objects 107, 316
Nano-edit mode 286
Nano-editor
defined 425
Nano-Preview 15, 105
Full Scene mode 31
memory dots 15
Sky Only mode 31
using 30
Wireframe Only mode 31
Nano-preview
Auto Update mode 31
defined 425
Negative boolean 122, 316
Neutral
boolean 121, 316
New command 28
New features iX
Noise
auto-phased 256
difference 256
dsisplaced max 257
irregular 255
maximum 255
maximum 90 256
minimum 256
minimum 90 256
modes 254
more irregular 255
mulitfractal 255
multiply 256
octaves 254

standard 255
with rotation 255
Normal Quality
antialiasing 402
Nudging 296
Numerical
alignment 300
panning 33
positioning camera 337
replicating 40
repositioning 295
resizing 289
rotation 292
zooming 33

0

Object attributes
camera 329
dialog 312
editing 312
icons 313
Object Attributes dialog 107, 379
Object hieracrhies 280
Object hierarchies 302
expanding/collapsing 304
families 309
grouping 307
linking 305
viewing 304
Object space 281
coordinates 283

defined 425
Objects
adding 59

adding Preset objects 126
adding to a selection 36
aligning 297

alpha channels and 113
animating 86

arranging 58

as boxes 30

as wireframes 30
attributes 312
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Boolean 121
changing display 30
converting 323
creating 63

cutting 39

deleting Preset objects 127

deselecting 36
duplicating 40
editing 311

hiding 317
hierarchies 302
importing 120
intersecting 122, 124

linking 305
linking to paths 125
locking 317

materials 193
names 316
naming 107
negative 122
origin points 286
pasting 39
placement 22, 106
positioning 60, 294
preview 103
preview modes 104
randomizing 301
replicating 40
resizing 287
restoring 312
rotating 61, 291
scaling 62
selecting 36

by family 37

by type 37

hidden 36
shadows 103
statistics 27
stones 110
subtracting 123
tracking 378
transforming 285
types,defined 425
VCR controls and 38
wireframe attributes 24

Offset 425
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Opacity
defined 425
Open command 29
Open List button 120
OpenGL accelerator card 104
Opening
files 29
Pictures Lists 120
Operations, Boolean 121
Optics channels 196
reflection 209
refraction 208
transparency 206

Oribits
creating 384
Orientation
defined 425

tracking option 319
Origin points 102, 286

camera 339

setting camera point 337

showing 317
Orthogonal
defined 425

Orthogonal projection 32
Orthogonal Views 331
overview 31
using in animations 381
Orthogonal views 326
ouds 391
Output
alpha 244
bump 244
color 243
resolution,defined 425
types 243
Outputs
textures 242
Overlap 51
Overview
Bryce 13

P

Paintbrush
applying locally 182
behaviors 182
grayscale 181
modifying behavior 183
painting 182
removing locally 182
setting attributes 181

Painting 181
elevations 182
erosions 182
terrains 181

Palettes

Advance Display palette 17

Create palette 16
displaying 26, 27
Edit palette 16
hiding 26
moving 26
resetting 26
Selection palette 17, 36
Sky & Fog palette 17
sky and fog 131
tools 16
Panning 33
numerically 33
setting values 33
Panoramas
creating 418
Paper
backgrounds 26
Parallel light 344
creating 344
defined 425
selecting 37
Paste command 39
Paste Material command 40
Paste Matrix command 40
Pasting

Alpha channel information 119

materials 39
matricies 40
objects 39

pictures 118



RGB information 119
Patch rendering 409
defined 425
Paths
converting 125
geometric 124
linking to objects 125
Perspective render 403
Phase 257
creating 258
dimensions 259
frequency 259
noise modes 261
noise octaves 261
noise orientation 260
noise type 259
Phases
moon 155
Phone support  Xi
Pict file format
saving 22
Pict mapping
defined 426
Pict Object tool 113
Pict objects
alpha channels and 113
creating 112
Picture
terrain effect 172
Picture Library 116
accessing 116
adding pictures 118
displaying pictures 117
Picture Lists 120

opening 120
saving 120
Pictures

adding to Library 117
adding to Picture Library 118
asgels 115

as material 114

as terrains 187

blending 188

copying 118, 188

deleting 120

dialog 113

displaying 117

lists 120

loading 187

pasting 118

previewing 116

terrain editor tab 187

thumbnails 116

working with 114
Pictures tab

terrain editor 165
Pitch

defined 426
Placement

objects 22, 106
Plane tools 108

Planes
ground 109
infinite 108
infinite slabs 109
selecting 37
water 108
Plop-render
defined 426

Plop-Render mode 407
enabling/disabling 407
Plug-ins 121
Polygons
defined 426
Polyhedrons
defined 426
smoothing 322
Polymesh objects

selecting 37
Pop-up dialogs, displaying 28
Positioning

animating 392

camera 15,55

lights 350

moon 153

objects 60, 294

sun 150

the camera, numerically 337

the view of your scene 331
Positive boolean 316
Post production 411

compositing 412
Posterize

terrain effect 177

Preferences
setting 22
Working window 23
Preferences command 22
Preset Materials Library
overview 20
Preset Object Library 125
Preset objects
adding 126
deleting 127
exporting 128
importing 127
using 126
Preset Objects Library 59
adding objects 59
overview 20
Preset Skies Library
overview 20
Presets
adding skies 160
deleting skies 160
exporting skies 161
importing skies 161
resolution 29
skies 160
terrain filtering 186
Preview
applying fitlering changes 186
Nano-Preview 15
Preview controls
animation 45
Preview modes
Bounding Box 104
Rendered Preview 105
Shaded Preview 104
Preview render modes 405
fast preview 405
textures on/off 405
Previewing
Advanced Motion Lab 47
material animations 389
modes 104
objects 103
pictures 116
terrain animations 397
terrains 166
texture components 276
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thumbnails
Previewing lights 345
Render Against Neutral
Render In Scene 345
Primitives 105
creating 111

116

defined 426

derivative 112
Printing

images 415
Procedural objects 105

defined 426
Propagate

linking option 319

options 306
Pyramids

creating 111
derivatives 112

selecting 37

Q

Quality/Speed 211

QuickTime VR 417
creating panoramas 418
inBryce 3D 418

Quit command 42

Radial light 343

creating 344

defined 426
selecting 37

Rainbows 157
animating 391
Raise Edges
terrain effect
Raise/Lower
terrain effect
Randomize tool
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179

173
285, 301

345

Randomizing
objects 301
skies 133
texture components 276
using randomize tool 301
Raytracing 400
defined 426
rendering 400
Redo command 41
Reducing
detail 50
Reflection 209
setting using a texture 209
Refraction 208
defined 426
setting using texture 209
Relative coordinates 284
defined 426
Relief Noise
terrain effect 179
Render button 23, 32
Render Controls 16, 406
Render modes 403
Render Movie dialog 408
compression 408
file type 408
name 408
render range 408
Render Range 408
Render reporting 403
Render resolution 29, 402
defined 427
Render With Neutral Sky option 127
Rendered Preview preview mode 105
Rendering 399, 406
animation 50
batch 409
controls 16, 406
defined 427
fast rendering strategies 409
images 410
movies 408
plop-render mode 407
procedure 400
raytracing 400
resuming 407
settingup 401

spatial optimization 402
spatial optimization high 403
spatial optimization low 402
spatial optimization off 402
without compression 50
Replicate command 40

Replicating
numerically 40
objects 40

Reposition tool 285, 294
Repositioning objects

interactively 296

nudging 296

numerically 295

using reposition tool 294
Reset Palettes command 26
Resetting

pan values 33

views 36

zoom values 33
Resize tool 285, 287
Resizing objects 287

interactively 290

numerically 289

using resize tool 287

using the keyboard 291
Resolution

documents 29

preset value 29

render 29

rendering 402

setting 170

terrains 170

wireframes 25
Resolution tool 25
Restoring objects 312
Revert to Saved command 41

RGB images
creating 119
pasting 119
replacing information 118
viewing 116
Right view 35
Roll
defined 427

Rotate tool 285, 291



Rotating objects 61, 291
interactively 293
numerically 292
using rotate tool 291

Rotation
defined 427

Round Edges
terrain effect 175

S

Sample project X
Save As command 41
Save command 41
Save List button 120
Saving

files 41

Pictures Lists 120

preferences 22

terrains 192

textures 277
Saving camera positions 341
Sawtooth

terrain effect 178

Scale

defined 427
Scaling

objects 62

rendered images 410
Scenes

creating 28

defined 427

displaying 30

merging 30

rendering 399, 406

simplifying for animation 50

viewing 31
Secondary motion 51
Select All command 36, 38
Select by Type icons 37, 38
Select Color command 26

Selecting
2D Disks 37
2D Faces 37

2D PICTs 37
background color 26
background texture 26
brickoids 37
cones 37

cubes 37

cylinders 37
ellipsoids 37
hidden objects 36
Infinite slabs 37
Mesh objects 37

objects 36
by family 37
by type 37

VCR controls 38
Parallel Light objects 37

planes 37

Polymesh objects 37
pyrimids 37

Radial Light objects 37
spheres 37

Spotlight objects 37

Square Spotlight objects 37
Stone objects 37

Symmetrical Lattice objects 37
Terrain objects 37

Torus objects 37

tuboids 37
within groups 36
Selection

adding objectsto 36
deleting objects from 36
Selection palette 17, 36
displaying 37
Sequencer 46
overview 19
Setting
display modes 23
display preferences 22
preferences 22
Working window preferences 23
Setting Palette Options 132
Setting up
lights 342
rendering 401
Shaded Preview preview mode 104

Shadows 103
control 135
setting intensity 136
skies 135
Sharpening
terrain effect 173
Sharpness
moon 155
Show always option 320
Show as box 317
Show as Box button 317
Show as ribbon option 320
Show handles 320
Show Object as Box command 30, 104
Show Object as Lattice command 30, 104
Show origin point 317
Show tangents option 320
Show trajectory option 320
Show when selected option 320
Size
defined 427
Skies
adding fog 137
adding haze 137
ambient color 137
and camera motion 380
animating 49, 389
animating clouds 391
clouds 141
creating 68, 129
environment attributes dialog 131
environmental effects 156, 157, 158
fog 137
haze 140
preset library 160, 161
randomizing 133
shadows 135
sky attributes 135
sky dome color 147
sky modes 133
sun 149
sunrise 151
sunset 151
Sky and Fog palette 17, 131
ambient color 137
animating settings 390
attributes 135
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cloud altitude 146
cloud coverage 145
control thumbnails 132
day/night toggle 151
fog 137

frequency and amplitude 147

haze 140
options 132
positioning sun 150
saving settings 133
shadows 135
sky dome color 147
sky modes 134
working with 132
Sky dome
defined 427
Sky dome color 147
Sky modes 133, 134
atmosphere off 134
darker sky 134
soft sky 134
Sky Only mode 31
Slope Noise
terrain effect 175
Smoothing
defined 427
imported objects 322
terrain effect 174
Snap To options 298
defined 427
Soft sky 134
Softening
filtering graph 185
Solo Mode button 39
Source generators
eroded 172
fractal 172
picture 172
terrains 172
Spatial Optimization 402, 403
high 403
low 402
off 402
Specular
defined 427
Specular color 204
setting using texture 204
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Specular Halo 204

setting using texture 205
Specularity 203

setting using texture 203
Speeding up textures 277
Spheres

creating 111

derivatives 112

selecting 37
Spikes

terrain effect 176
Spotlight 343

creating 344

defined 427

selecting 37
Sgaured Fall-off 346
Square Edges

terrain effect 174
Square spotlights 343

creating 344

selecting 37
Squashing 51
Star fields 158
Static resolution 25
Statistics

object 27
Status

text display area 27
Stones

creating 110

editing 322

selecting 37
Storyboarding 49
Straight Line movement 51
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	6. Click the triangle icon in the top right 6. cor...
	7. Click the A column in the Ambient, 7. Specular ...
	8. Leave Specular Halo as is.
	9. Option/Alt-click the Volume Color 9. oval and e...
	10. Click the A column in the Diffusion 10. channe...
	11. Click the A column in the Ambient 11. channel,...
	12. Click the A column in the Specularity 12. chan...
	13. Click the A column in the Base 13. Density cha...
	14. Drag the slider in the Edge Softness 14. chann...
	15. Drag the slider in the Fuzzy Factor 15. channe...
	16. Leave Quality/Speed at the default.
	17. Click the OK icon to exit the lab.
	Moving On



	Adding Lights
	The Story So Far
	What You’ll Need
	To open the light tutor file:
	1. Choose File menu> Open.
	2. Locate the file Light Tut in the 2. Tutorial fo...

	To set the Nano-Preview to Auto-Update:
	Lesson 1: Adding Lights
	To add a light:
	1. Click the Create button to display the 1. Creat...
	2. Click the Spotlight tool.
	3. Click the light to select it.
	4. Click the E icon that appears next to 4. its bo...
	5. Click the triangle icon below the light 5. prev...
	6. Click the Texture Gel button at the 6. bottom o...
	7. Click the Tutorial category.
	8. Click Tutorial Light Gel and click the 8. OK ic...
	9. Click the OK icon to exit the Edit 9. Lights di...

	To position lights:
	1. Select the light in the Working 1. window.
	2. Click the A icon that appears next to 2. its bo...
	3. Make sure the General tab is visible.
	4. Enter Position: X=-20.52, Y=34.47, 4. Z=28.68, ...
	Moving On



	Animating Objects
	The Story So Far
	What You’ll Need
	To begin the animation tutorial:
	1. Choose File menu > Open. The 1. Open dialog app...
	2. Locate the file Animate Tutor in the 2. Tutoria...
	3. Click Open.

	To setup your animation:
	1. Choose File menu> Animation 1. Setup or double-...
	2. Enter 24 in the FPS field.
	3. In the Duration fields enter 3. 0:00:03:00. Thi...
	4. Enable the Once button in the Play 4. area to h...
	5. Enable the SMPTE Time button in 5. the Display ...

	Lesson 1: Creating Key Frames
	To create key frames:
	1. Click the triangle icon to the left of 1. the a...
	2. Drag the Current Time Indicator to 2. time 00:0...
	3. Click the ball and move it down and 3. to the r...
	4. Move the Current Time Indicator to 4. time 00:0...
	5. Drag the ball in the scene up and to 5. the lef...
	6. Move the Current Time Indicator to 6. time 00:0...
	7. Drag the ball in the scene down and 7. to the r...
	8. Move the Current Time Indicator to 8. time 00:0...
	9. Drag the ball in the scene up and to 9. the rig...
	10. Move the Current Time Indicator to 10. time 00...
	11. Drag the ball in the scene down and 11. to the...
	12. Move the Current Time Indicator to 12. time 00...
	13. Drag the ball in the scene to the right.

	To preview an animation:
	1. Click the First Frame button. The ball 1. jumps...
	2. Click Play.


	Lesson 2: Editing Time Mapping Curves
	To display the Advanced Motion Lab:
	1. Click the ball in the Working 1. window.
	2. Make sure the animation controls are 2. visible...
	3. Click the Advanced Motion Lab 3. button. The Ad...

	To edit time mapping curves:
	1. Drag the first point on the curve up 1. to the ...
	2. Drag the second point up and to 2. right so tha...
	3. Drag the third point up as shown.
	4. Drag the fourth point up and to the 4. right as...
	5. Leave the fifth point as is.
	6. Drag the sixth point down slightly as 6. shown....
	Moving On



	Animating the Camera
	The Story So Far
	What You’ll Need
	Lesson 1: Animating the Camera
	To aim the camera:
	1. Move the cursor over the line that 1. extends o...
	2. Drag the tip of the line, or the Aim 2. control...

	To animate the camera position:
	1. Make sure you’re in Director’s View. 1. If you’...
	2. Click the triangle icon next to the 2. View Con...
	3. Click the Camera icon in the scene.
	4. Click the triangle icon to the right of 4. the ...
	5. Move the Current Time Indicator to 5. time 00:0...
	6. Drag the camera icon to the position 6. shown.
	7. Change the aim so that the camera is 7. facing ...
	8. Move the Current Time Indicator to 8. time 00:0...
	9. Drag the camera icon to the position 9. shown.
	10. Change the aim again so that the 10. camera fa...
	11. Move the Current Time Indicator to 11. time 00...
	12. Drag the camera icon to the position 12. shown...
	13. Change the aim so that the camera 13. faces th...
	14. Move the Current Time Indicator to 14. time 00...
	15. Change the aim so that the camera is 15. facin...
	16. Click the triangle icon next to the 16. View C...
	17. Click the First Frame button in the 17. Animat...
	Moving On



	Animating Materials
	The Story So Far
	What You’ll Need
	To begin animating materials:
	1. Choose File menu >Open. The Open 1. dialog appe...
	2. Locate the file Animate Mat in the 2. Tutorial ...
	3. Click Open.

	Lesson 1: Animating Between Materials
	To animate between materials:
	1. Click the sphere object in the fire pit.
	2. Click the M icon that appears next to 2. the sp...
	3. Click the First Frame button in the 3. Animatio...
	4. Click the triangle icon to the right of 4. the ...
	5. Drag the Current Time Indicator to 5. 00:00:02....
	6. Drag the slider in the Fire material’s 6. chann...
	7. Click the Add Frame button to store 7. your cha...
	8. Click the First Frame button to move 8. to the ...
	9. Click the Play button to preview the 9. animati...
	Moving On



	Rendering
	The Story So Far
	What You’ll Need
	To open the preset file for rendering:
	1. Choose File menu > Open.
	2. Locate the file Rendering Tut in the 2. Tutoria...
	3. Click Open.

	Lesson 1: Rendering an Image
	To choose a rendering resolution:
	1. Double-click the Render button in 1. the Render...
	2. Click 480 x 360 at the bottom of the 2. dialog....
	3. Click the OK icon.

	To choose rendering options:
	1. Click the triangle icon next to the 1. Renderin...
	2. Make sure Texture On/Off is 2. disabled.
	3. Make sure Fast Render mode is off.
	4. Click the triangle icon next to the 4. Render c...
	5. Click the triangle icon next to the 5. Render c...

	To start rendering your final image:

	Lesson 2: Rendering an Animation
	To render an animation:
	1. Choose File menu> Render 1. Animation. The Rend...
	2. Click the Set Destination File if you 2. want t...
	3. Click the Output Type popup to 3. choose a form...
	4. Click the Set Compression button if 4. you want...
	5. Set a range of the animation to 5. render.
	6. Click OK and the render of the 6. animation beg...
	Moving On



	Wrapping Up
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	Cloud
	To create a Cloud plane:
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	Infinite Slabs
	To create an Infinite Slab:
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	3. Click the A�icon that appears next to 3. its bo...
	4. Enter a depth value in the Size Y field 4. and ...
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	To create a Stone Object:
	To change a stone’s preset material:
	1. Click the second Triangle icon at the 1. top of...
	2. Choose a library and material then 2. click the...
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	To create a Pict object:
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	Alpha Channels
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	To access the Picture Library from the Create pale...
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	1. Select an object.
	2. Click the M�icon that appears next to 2. the ob...
	3. Click on one of the columns in the 3. grid to a...
	4. In the window, click the P�button in 4. the bot...
	5. Click the Pink button at the top of 5. the wind...

	To access the Picture Library from the Light Edito...
	1. Select a light source.
	2. Click the E�icon that appears next to 2. the ob...
	3. Click the 2D Texture button at the 3. bottom of...
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	Picture Thumbnails

	To display an image in the library:
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	To replace the RGB information in a picture:
	1. Click the thumbnail of the picture 1. you want ...
	2. Click the Load button on top of the 2. RGB Imag...
	3. Use the dialog controls to locate the 3. desire...

	To replace the Alpha channel information in a pict...
	1. Click the thumbnail of the picture 1. you want ...
	2. Click the Load button on top of the 2. Alpha Ch...
	3. Use the dialog controls to locate the 3. desire...

	To load a new picture into the Library:
	1. Click an empty picture slot in the 1. bottom of...
	2. Click the Load button on top of the 2. Combined...
	3. Use the dialog controls to locate the 3. desire...
	Copying and Pasting Pictures

	To copy and paste RGB information in a picture:
	1. Click the Copy button below the RGB 1. Image wi...
	2. Click the Paste button below the 2. window wher...

	To copy and paste Alpha Channel information in a p...
	1. Click the Copy button below the 1. Alpha Channe...
	2. Click the Paste button below the 2. window wher...
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	1. Click the Copy button below the RGB 1. Image wi...
	2. Click the Paste button below the 2. Combined wi...

	To create a new picture using Alpha channel inform...
	1. Click the Copy button below the 1. Alpha Channe...
	2. Click the Paste button below the 2. Combined wi...
	Deleting Pictures

	To delete a picture from the library:
	1. Click the thumbnail for the picture 1. you want...
	2. Click the Delete button above the 2. Combined w...
	Inverting the Alpha Channel

	To invert an alpha channel:

	Picture Lists
	To open a picture list:
	1. Click the Open List button at the 1. bottom of ...
	2. Use the dialog controls to locate the 2. desire...

	To save a picture list:
	1. Click the Save List button at the 1. bottom of ...
	2. Enter a name for the list and click 2. save.



	Importing Objects
	To import an object:
	1. Choose File menu> Import. The 1. Open dialog ap...
	2. Bryce searches for available DXF or 2. 3DMF fil...
	3. Select the file you want and click OK.
	4. You can disable automatic format 4. checking, w...
	Some Notes on Imported Files
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	To subtract one object from another:
	1. Select an object.
	2. Click the A�button next to the object’s 2. boun...
	3. Enable the Negative checkbox.
	4. Move the negative object so that it 4. intersec...
	5. Make sure that the second object’s 5. Boolean a...
	6. Select both objects and click the 6. G�button n...

	To create an object that is the intersection of tw...
	1. Select an object.
	2. Click the A�button next to the object’s 2. boun...
	3. Enable the Intersecting checkbox.
	4. Move the intersecting object so that it 4. inte...
	5. Make sure that the second object’s 5. Boolean a...
	6. Select both objects and click the 6. G�button n...



	Creating Geometric Paths
	To create a geometric path:
	To convert a motion path into a geometric path obj...
	1. Select an object with a motion path.
	2. Choose Object menu> Create Path.

	To link an object to a path:
	1. Select the object you want to attach to 1. the ...
	2. Move the cursor over the Link icon 2. that appe...
	3. Drag the linking control handle from 3. the obj...
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	To add an object from the Preset Object Library to...
	1. Click the Triangle icon next to the 1. Create b...
	2. Click on a category name (Boolean 2. Objects, M...
	3. Click on the preset thumbnails to 3. view prese...
	4. Click the OK icon to add the selected 4. object...

	Adding and Deleting Preset Objects
	To add an object to the preset library:
	1. Select the object you want to add to 1. the lib...
	2. Click the Triangle icon next to the 2. Create b...
	3. Click a category name. The library 3. switches ...
	4. Click the Triangle icon in the bottom 4. right ...
	5. Set up the preview of the object:
	6. Click the Add button at the bottom of 6. the di...
	7. Enter a name for the new preset in 7. the Prese...
	8. Enter a description of the preset in 8. the Des...
	9. Click the OK icon. Your preset is 9. added to t...

	To delete an object preset:
	1. Click the Triangle icon next to the 1. Create b...
	2. Click on the preset you want to 2. delete, or h...
	3. Click the Delete button at the bottom 3. of the...


	Importing and Exporting Preset Objects
	To import a Preset object file:
	1. Click the Triangle icon next to the 1. Create b...
	2. Select the category into which you 2. want to i...
	3. Click the Import button at the 3. bottom of the...
	4. Locate the file which you would like 4. to impo...

	To export a Preset object file:
	1. Click the Triangle icon next to the 1. Create b...
	2. Select the category from which you 2. want to e...
	3. Select the preset or presets you wish 3. to exp...
	4. Click the Export button at the 4. bottom of the...
	5. Enter a name and location for the file 5. and c...
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	Creating Skies
	Environments and Bryce�3D
	The Sky�&�Fog Palette
	Environmental Attributes dialog
	Working with the Sky�&�Fog palette
	Using the Control Thumbnails
	To change the intensity of an effect:
	To pick a color for an effect:
	Setting Palette Options

	To link Sky�&�Fog attributes directly to your scen...
	To reset Sky�&�Fog palette settings to their defau...
	Saving Sky�&�Fog settings

	To save Sky�&�Fog settings:
	To switch to a saved Sky�&�Fog setting:
	To reset Sky�&�Fog settings to default:
	To delete a saved Sky�&�Fog setting:
	Randomizing Skies

	To randomize your sky:


	Working with Sky Modes
	To select a sky mode:
	Sky Modes

	To set custom sky colors:
	1. Click the triangle icon next to the Sky 1. Mode...
	2. Click the Sky Color swatch and 2. choose a colo...
	3. Click the Solar Halo Color swatch 3. and choose...
	4. Click the Horizon Color swatch and 4. choose a ...

	To render objects against a plain background:
	1. Click the triangle icon next to the Sky 1. Mode...
	2. Click the Atmosphere swatch and 2. choose a col...
	3. Drag left inside the Haze control and 3. set th...


	Setting Sky Attributes
	Shadows in Your Scene
	To set shadow intensity:
	1. Display the Sky�&�Fog palette by 1. clicking th...
	2. Drag left or right inside the Shadow 2. control...

	To set shadow intensity numerically:
	1. If it’s not already visible, display the 1. Sky...
	2. Click the triangle in the corner of the 2. pale...
	3. Enter a value into the Shadow 3. field.This fie...


	Ambient Color
	To set Ambient Color:


	Adding Fog and Haze
	Fog
	To set the amount of Fog:
	1. Display the Sky�&�Fog palette by 1. clicking th...
	2. Drag horizontally inside the Fog 2. thumbnail t...

	To set Fog height:
	1. Display the Sky�&�Fog palette by 1. clicking th...
	2. Drag vertically inside the Fog control 2. to in...

	To set Fog color:
	1. Display the Sky�&�Fog palette by 1. clicking th...
	2. Click the color swatch beneath the 2. Fog thumb...

	To set Fog attributes numerically:
	1. If it’s not already visible, display the 1. Sky...
	2. Click the triangle in the corner of the 2. pale...
	3. Click the Atmosphere tab.
	4. Enter a value in the Fog field. This 4. field s...
	5. Enter a value in the Height field. This 5. fiel...
	Blending the Fog Color

	To link Fog color to the Sun controls:
	1. If it’s not already visible, display the 1. Sky...
	2. Click the triangle in the corner of the 2. pale...
	3. Click the Atmosphere tab.
	4. Click the Blend with Sun button.
	5. Make sure the Blend Fog button is 5. enabled.
	6. Enter a value in the Color field to set 6. how ...
	7. Enter a value in the Luminance field 7. to set ...
	Localized Fog

	To create localized fog:
	1. Display the Create palette.
	2. Click the Sphere tool. A sphere object 2. appea...
	3. Squash and stretch the sphere, until it 3. is t...
	4. With the object selected, click the M 4. icon t...
	5. Click the Volume button at the top of 5. the la...
	6. Set up the values for channels in the 6. materi...
	7. Click the OK icon to exit the lab.
	8. In the Working window, move the 8. object to th...


	Haze
	To set Haze intensity:
	1. Display the Sky�&�Fog palette by 1. clicking th...
	2. Drag horizontally inside the Haze 2. thumbnail ...

	To set Haze intensity numerically:
	1. If it’s not already visible, display the 1. Sky...
	2. Click the triangle in the corner of the 2. pale...
	3. Click the Atmosphere tab.
	4. Enter a value in the Haze field. This 4. field ...

	To set Haze color:
	1. Display the Sky�&�Fog palette by 1. clicking th...
	2. Click the color swatch beneath the 2. Haze thum...
	Blending the Haze color with the Sun

	To link Haze to the Sun controls:
	1. If it’s not already visible, display the 1. Sky...
	2. Click the triangle in the corner of the 2. pale...
	3. Click the Atmosphere tab.
	4. Click the Blend with Sun button.
	5. Make sure the Blend Haze button is 5. enabled.
	6. Enter a value in the Color field to set 6. how ...
	7. Enter a value in the Luminance field 7. to set ...
	8. To get the best effect, set both these 8. field...



	Clouds in Bryce
	Adding Clouds
	Cloud Types
	To add Cumulus clouds to a sky:
	1. If it’s not already visible, display the 1. Sky...
	2. Click the triangle in the corner of the 2. pale...

	To add Stratus clouds to a sky:
	1. If it’s not already visible, display the 1. Sky...
	2. Click the triangle in the corner of the 2. pale...
	Editing Cloud Textures

	To edit cloud texture in the Environmental Attribu...
	1. If it’s not already visible, display the 1. Sky...
	2. Click the triangle in the corner of the 2. pale...
	3. Click the Cloud Cover tab.
	4. Click the Arrow icon next to the type 4. of clo...
	5. Click the + or - Turbulence buttons 5. to incre...
	6. Click the + or - Complexity buttons 6. to incre...
	7. Click the Randomize button if you 7. want to ch...
	8. Click the OK icon to apply your 8. changes.

	To edit cloud textures in the Deep Texture Editor:...
	1. If it’s not already visible, display the 1. Sky...
	2. Click the triangle in the corner of the 2. pale...
	3. Click the Cloud Cover tab.
	4. Click the Arrow icon next to the type 4. of clo...
	5. Click the Editor button. The Deep 5. Texture Ed...
	6. If you want to add additional 6. turbulence to ...
	7. If you want to change the colors of a 7. compon...
	8. If you want to add more complexity 8. to the te...
	9. If you want to change the pattern in 9. the tex...
	10. Click the OK icon to exit the editor.
	Cloud Coverage

	To set cloud coverage:
	1. If it’s not already visible, display the 1. Sky...
	2. Drag left or right inside the Cloud 2. Coverage...

	To set cloud coverage numerically:
	1. If it’s not already visible, display the 1. Sky...
	2. Click the triangle in the corner of the 2. pale...
	3. Click the Cloud Cover tab.
	4. Enter a value in the Density field at 4. the bo...

	To set cloud color:
	1. Display the Sky�&�Fog palette by 1. clicking th...
	2. Click the color swatch beneath the 2. Cloud Cov...
	Cloud Altitude

	To set cloud altitude:
	1. If it’s not already visible, display the 1. Sky...
	2. Drag horizontally inside the Cloud 2. Altitude ...

	To set cloud altitude numerically:
	1. Display the Sky�&�Fog palette by 1. clicking th...
	2. Click the triangle in the corner of the 2. pale...
	3. Click the Cloud Cover tab.
	4. Enter a value in the Height field at the 4. bot...
	Sky Dome Color

	To set Sky Dome color:
	1. If it’s not already visible, display the 1. Sky...
	2. Click the color bar beneath the Cloud 2. Altitu...
	Frequency and Amplitude

	To set Cloud Frequency and Amplitude:
	1. Display the Sky�&�Fog palette by 1. clicking th...
	2. In the Cloud Frequency and 2. Amplitude control...
	3. Drag vertically to control the 3. amplitude of ...

	To set Frequency and Amplitude numerically:
	1. If it’s not already visible, display the 1. Sky...
	2. Click the triangle in the corner of the 2. pale...
	3. Click the Cloud Cover tab.
	4. Enter a value in the Scale field.
	5. Enter a value in the Amplitude field.
	Linking Clouds to the Camera View

	To link clouds to view:
	1. If it’s not already visible, display the 1. Sky...
	2. Click the triangle in the corner of the 2. pale...
	3. Click the Cloud Cover tab.
	4. Click the Link Clouds to View 4. button.
	Using a Fixed Cloud Plane

	To use a fixed cloud pattern in your sky:
	1. If it’s not already visible, display the 1. Sky...
	2. Click the triangle in the corner of the 2. pale...
	3. Click the Cloud Cover tab.
	4. Click the Fixed Cloud Plane button.



	Working with the Sun
	Positioning the Sun
	Day and Night
	To switch between night and day:
	1. Display the Sky�&�Fog palette.
	2. Click the Day/Night toggle button in 2. the top...
	Sunrise/Sunset

	To position the sun manually:
	1. Display the Sky�&�Fog palette by 1. clicking th...
	2. Drag the larger highlight area in the 2. Sun Po...

	To position the sun numerically:
	1. Display the Sky�&�Fog palette by 1. clicking th...
	2. Click the triangle in the corner of the 2. pale...
	3. Click the Sun & Moon tab.
	4. In the Numerical Sun Values fields, 4. type a v...
	5. Enter a value in to the Y field. The Y 5. field...
	6. Enter a value in to the Z field. The Z 6. field...
	Linking the Sun to the Camera

	To link the sun to the camera:
	1. Display the Sky�&�Fog palette by 1. clicking th...
	2. Click the triangle in the corner of the 2. pale...
	3. Click the Sun & Moon tab.
	4. Click the Link Sun to View button.
	Sun Color

	To set the Sun Color:
	1. Display the Sky�&�Fog palette by 1. clicking th...
	2. Click the Sun Color swatch and 2. choose a colo...
	Disabling the Sun

	To disable the Sun:
	1. Display the Sky�&�Fog palette by 1. clicking th...
	2. Click the triangle in the corner of the 2. pale...
	3. Click the Sun & Moon tab.
	4. Click the Disable Sun/Moon button.



	Working with the Moon
	Positioning the Moon
	To position the moon manually:
	1. Display the Sky�&�Fog palette by 1. clicking th...
	2. Drag the blue highlight area in the 2. Sun/Moon...

	To position the moon numerically:
	1. Display the Sky�&�Fog palette by 1. clicking th...
	2. Click the triangle in the corner of the 2. pale...
	3. Click the Sun & Moon tab.
	4. In the Numerical Sun Values fields, 4. type a v...
	5. Enter a value into the Y field. The Y 5. field ...
	6. Enter a value in to the Z field. The Z 6. field...


	Moon Phases
	To set the moon’s phase:
	1. Display the Sky�&�Fog palette by 1. clicking th...
	2. Click the triangle in the corner of the 2. pale...
	3. Click the Sun & Moon tab.
	4. Drag over the Moon Phase control. 4. The phase ...
	5. Click the OK icon to exit the dialog.


	Moon Brightness and Sharpness
	To set the brightness of the moon’s shadow:
	1. Display the Sky�&�Fog palette by 1. clicking th...
	2. Click the triangle in the corner of the 2. pale...
	3. Click the Sun & Moon tab.
	4. Drag over the Earthshine control. 4. Drag left ...
	5. Click the OK icon to exit the dialog.

	To set the moon’s edge softness:
	1. Display the Sky�&�Fog palette by 1. clicking th...
	2. Click the triangle in the corner of the 2. pale...
	3. Click the Sun & Moon tab.
	4. Drag over the Softness control. Drag 4. left to...
	5. Click the OK icon to exit the palette.



	Adding Environmental Effects
	Sun/Moon Rings
	To add Sun/Moon rings:
	1. Display the Sky�&�Fog palette by 1. clicking th...
	2. Click the triangle in the corner of the 2. pale...
	3. Click the Sun & Moon tab.
	4. Click the Rings button.
	5. In the Rings area, enter a value in the 5. Inte...
	6. Enter a value in the Radius field to set 6. the...

	To add a secondary Sun/Moon ring:
	1. Display the Sky�&�Fog palette by 1. clicking th...
	2. Click the triangle in the corner of the 2. pale...
	3. Click the Sun & Moon tab.
	4. Click the Secondary Ring button in 4. the Rings...


	Sun/Moon Horizon Illusion
	To add a secondary Sun/Moon ring:
	1. Display the Sky�&�Fog palette by 1. clicking th...
	2. Click the triangle in the corner of the 2. pale...
	3. Click the Sun & Moon tab.
	4. Click the Horizon Illusion button at 4. the top...
	5. In the Horizon Illusion area, enter a 5. value ...


	Rainbows
	To add a rainbow to your sky:
	1. Display the Sky�&�Fog palette by 1. clicking th...
	2. Click the triangle in the corner of the 2. pale...
	3. Click the Atmosphere tab.
	4. Click the Rainbows button to activate 4. the ra...
	5. Enter a value in Radius field in the 5. Rainbow...
	6. Enter a value in the Opacity field. 6. This con...

	To add a secondary rainbow to your�sky:
	1. Display the Sky�&�Fog palette by 1. clicking th...
	2. Click the triangle in the corner of the 2. pale...
	3. Click the Atmosphere tab.
	4. Click the Secondary Rainbow button.
	5. Enter a value in Intensity field in the 5. Rain...


	Star Fields
	To add a Star Field:
	1. Display the Sky�&�Fog palette by 1. clicking th...
	2. Click the triangle in the corner of the 2. pale...
	3. Click the Sun & Moon tab.
	4. Click the Starfield button at the 4. bottom of ...

	To add comets to a Star Field:
	1. Display the Sky�&�Fog palette by 1. clicking th...
	2. Click the triangle in the corner of the 2. pale...
	3. Click the Sun & Moon tab.
	4. Click the Comets button at the 4. bottom of the...


	Volumetric World
	To add visible sunlight to your scene:
	1. Display the Sky�&�Fog palette by 1. clicking th...
	2. Click the triangle in the corner of the 2. pale...
	3. Click the Atmosphere tab.
	4. Click either the Rough or Fine button 4. in the...



	Using the Preset Skies Library
	To add a sky from the Preset Skies library to your...
	1. Click the triangle icon next to the 1. Sky�&�Fo...
	2. Click on the preset thumbnails to 2. view prese...
	3. Click the OK icon to add the selected 3. sky to...

	Adding and Deleting Preset Skies
	To add a sky to the preset library:
	1. Click the triangle icon next to the 1. Sky�&�Fo...
	2. Click the Add button at the bottom of 2. the di...
	3. Enter a name for the new preset in 3. the Prese...
	4. Enter a description of the preset in 4. the Des...
	5. Click the OK icon. Your preset will be 5. added...

	To delete an object preset:
	1. Click the triangle icon next to the 1. Sky�&�Fo...
	2. Click on the preset you want to 2. delete, or h...
	3. Click the Delete button at the bottom 3. of the...


	Importing and Exporting Preset Skies
	To import a preset sky file:
	1. Click the triangle icon next to the 1. Sky�&�Fo...
	2. Click the Import button at the 2. bottom of the...
	3. Locate the file which you would like 3. to impo...

	To export a preset sky file:
	1. Click the triangle icon next to the 1. Sky�&�Fo...
	2. Select the preset or presets you wish 2. to exp...
	3. Click the Export button at the 3. bottom of the...
	4. Enter a name and location for the file 4. and c...
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	Terrains
	What is a Terrain?
	The Terrain Editor
	To add a terrain object to your scene:
	1. Click the Create text button at the top 1. of t...
	2. Click the terrain object tool. A 2. randomly ge...

	To open the Terrain Editor:
	1. Select the terrain object.
	2. Click the E icon that appears next to 2. the te...

	Features of the Terrain Editor
	Editing Tools
	To access a tab:
	Terrain Canvas
	3D Terrain Preview

	To rotate the terrain preview:
	Animation Controls


	Working in the Terrain Editor
	Using Terrain Editor Tools
	To apply a tool to the Terrain Canvas:
	1. Move the cursor over the tool you 1. want to us...
	2. Do one of the following:
	Starting a New Terrain

	To create a new Terrain Canvas:
	1. Make sure the Elevation tab is 1. displayed. If...
	2. Click the New button.

	To gradually flatten your terrain:
	To reset your terrain:
	Inverting Terrains

	To invert your terrain image:
	1. Make sure the Elevation tab is 1. displayed. If...
	2. Click the Invert button, or press 2. Command-I/...

	To gradually invert your terrain image:
	Undoing Operations

	To undo operations in the Terrain Editor:
	1. Make sure the Elevation tab is 1. displayed. If...
	2. Click the Undo button, or press 2. Command-Z/Ct...
	Eroding Terrains

	To erode terrains:
	1. Make sure the Elevation tab is 1. displayed. If...
	2. Click the Erode button. You can also 2. gradual...
	Setting 3D Terrain Preview Options

	To set 3D Terrain Preview options:
	Using the Zoom Area

	To turn the Zoom Area on:
	To turn the Zoom Area off:
	To move the Zoom area:
	1. Move your pointer over an edge of 1. the Zoom A...
	2. Drag the marquee to an area in the 2. Terrain C...

	To resize the Zoom area:
	1. Move the pointer over a corner of the 1. Zoom A...
	2. Drag away from the center of the 2. marquee to ...

	To scale the zoom area to fill the Terrain Canvas:...
	To fit the contents of the Terrain Canvas into the...
	Setting Terrain Resolution

	To set the Terrain resolution:


	Creating Terrains
	Creating Landscapes
	Animation and Terrain Editing
	Elevation Tools
	Using Elevation Tools
	To switch between sets of elevation tools:
	1. Click the curves in the bottom left 1. corner o...
	2. Click again to return to the first set.

	To use an elevation tool:
	1. Make sure the Elevation tab is 1. displayed. If...
	2. Click an effect tool. 100% of the 2. effect is ...
	3. Click the tool again to increase the 3. intensi...

	To apply an elevation effect gradually:
	1. Move the pointer over an Elevation 1. tool. The...
	2. Drag to the left to increase the effect 2. or d...
	Source Generators
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	Subplateaus
	Cross Ridges
	Cross Ridges 2
	Bubble Ridges



	Painting Terrains
	Setting Up the Paintbrush
	To set brush attributes:
	1. In the Terrain Canvas frame, drag 1. over the S...
	2. Drag over the Hard control.
	3. Drag the pointer over the Flow 3. control.
	4. Drag over the Level control.

	To pick up gray levels from the terrain image:
	1. While holding down the Control/ 1. Ctrl, move t...
	2. Drag the brush over a different area 2. of the ...


	Brush Behaviors
	To paint elevations:
	1. Make sure the Elevation tab is visible. 1. If i...
	2. Click the triangle icon next to the 2. Brush Be...

	To apply an effect locally:
	1. Make sure the Elevation tab is visible. 1. If i...
	2. Click the triangle icon next to the 2. Brush Be...
	3. Hold down the Spacebar and click 3. the Elevati...
	4. Drag the paintbrush over an area of 4. your can...

	To remove an effect locally:
	1. Click the triangle icon next to the 1. Brush Be...
	2. Drag the paintbrush over an area of 2. your can...

	To erode areas of your terrain:
	1. Click the triangle icon next to the 1. Brush Be...
	2. Drag the paintbrush over the area 2. you want t...

	To lighten gray levels:
	1. Click the triangle icon next to the 1. Brush Be...
	2. Drag the paintbrush over an area you 2. want to...

	To darken gray levels:
	1. Click the triangle icon next to the 1. Brush Be...
	2. Drag the paintbrush over an area you 2. want to...
	Modifying Brush Behavior



	Filtering Terrains
	How Filtering Works
	To see how filtering works:
	1. Place your cursor (which changes to a 1. Pencil...
	2. Drag diagonally to the bottom right 2. corner.


	The Filtering Tab
	Working in the Filtering tab
	Altering the Filtering Graph
	To alter the Filtering graph:
	1. Make sure the Filtering tab is visible. 1. If i...
	2. Drag your pointer over the area of the 2. Filte...

	To undo all changes to the Filtering graph:
	1. Make sure the Filtering tab is visible. 1. If i...
	2. Click the Reset text button below the 2. Filter...

	To soften harsh transitions in the graph:
	1. Make sure the Filtering tab is visible. 1. If i...
	2. Click the Soften text button below the 2. Filte...
	3. Click the Soften button again to 3. soften the ...
	Applying Presets

	To apply presets:
	1. Make sure the Filtering tab is visible. 1. If i...
	2. Click one of the preset buttons along 2. the to...
	Applying Filtering Changes to Your Terrain Canvas

	To apply the Filtering graph to the 3D Preview:
	To apply filtering changes to the Terrain Canvas:
	Blending the Filtering Graph With the Terrain Canv...

	To blend the Filtering graph with the Terrain Canv...
	1. Adjust the Filtering graph to achieve 1. the de...
	2. Click the triangle icon below the 2. Filtering ...
	3. Click Apply.



	Creating Terrains Using Pictures
	The Pictures Tab
	Working in the Pictures Tab
	Loading Pictures
	To load pictures:
	To copy and paste a picture into the Picture tab:
	1. In another application, copy the 1. picture you...
	2. In the Picture tab, click the Paste text 2. but...
	Blending Pictures

	To blend pictures:
	1. Load pictures into the first two 1. squares.
	2. Click the triangle icon under the 2. third pict...
	3. Drag the pointer over the Blend 3. control.
	Applying Changes to the Terrain Canvas

	To apply a picture to the Terrain Canvas:


	Adding Color to Terrains
	Mapping Color to Your Terrain Canvas
	To map colors to your Terrain Canvas:
	1. Click the Color Picker button in the 1. bottom ...
	2. Drag the gradient up or down to map 2. the colo...

	To return to grayscale:
	To apply a gradient to a terrain’s Diffuse channel...
	1. Apply a gradient to the terrain.
	2. Click the triangle icon below the 2. Color/Gray...

	To remove a gradient from a terrain’s Diffuse chan...
	1. Open the terrain in the Terrain 1. Editor.
	2. Click the Color/Grayscale toggle.


	Clipping Terrains
	To set the clipping range:
	1. Drag the top of the Clipping Bracket 1. to set ...
	2. Drag the bottom of the Clipping 2. Bracket to s...

	To reset the Clipping Bracket:
	To move the entire Clipping Bracket at once:
	To add caps to your terrain:

	Saving Terrains
	Tips for Speeding Up the Terrain Editor on Slower ...
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	Materials
	Material Structure
	Understanding Surface Material Channels
	Color channels
	Value channels
	Optics channels
	Color Channels
	Value Channels
	Optics Channels


	Understanding Volume Material Channels
	Color channels
	Value channels
	Volume channels
	Volume Channels


	Understanding Material Components
	A Word About Alpha Channels


	Surface Material Channels
	Diffusion
	Setting Diffusion Using a Texture

	Diffuse Color
	Ambience
	Setting Ambience Using a Texture

	Ambient Color
	Setting Ambient Color Using a Texture

	Specularity
	Setting Specularity Using a Texture

	Specular Color
	Setting Specular Color Using a Texture

	Specular Halo
	Setting Specular Halo Using a Texture

	Metallicity
	Setting Metallicity Using a Texture

	Bump Height
	Transparency
	Setting Transparency Using a Texture

	Transparent Color
	Setting Transparent Color Using a Texture

	Refraction
	Setting Refraction Using a Texture

	Reflection
	Setting Reflection Using a Texture


	Volume Material Channels
	Volume Color
	Base Density
	Setting Base Density Using a Texture

	Edge Softness
	Fuzzy Factor
	Quality/Speed

	Material Components
	Color Components
	To use a color as a component:
	1. In the Materials Lab, click the color 1. oval i...


	Value Components
	To use a value as a component:

	Texture Components
	The Texture Component Window
	To use a Texture as a component:
	3D Textures

	To use a 3D texture as a component:
	1. In the Materials Lab, click a channel 1. column...
	2. If you want to change this texture, 2. click th...
	2D Textures

	To use a 2D texture as a component:
	1. In the Materials Lab, click a channel 1. column...
	2. In the Component window, click the 2. P button ...
	3. To change the picture, click the pink 3. button...
	4. Click an image square to load an 4. image.
	5. If the image you want is not in the 5. library:...
	6. Click the OK icon to exit the dialog.


	Texture Mapping Modes
	To select a mapping mode for a texture:
	1. In the Materials Composer, click a 1. channel.
	2. Select a mode for the channel.
	3. Click the title of the Component 3. window and ...
	4. Click the current Mapping Mode title 4. and cho...
	Object Space
	World Space
	Parametric
	Parametric Scaled
	World Top
	Spherical
	Cylindrical
	Reflection Map
	Random

	Object Top
	Object Front
	Mapping Mode Modifiers

	Symmetrical Tiling
	Scale Pict Size


	Transforming Textures
	Scale
	Rotation
	Position
	To transform a texture numerically:
	1. In the Texture Component window, 1. click the c...
	2. Move your cursor over the 2. transformation you...
	3. Drag the cursor over the value you 3. want to a...
	4. Click the OK icon to apply your 4. changes.

	To transform a texture interactively:
	1. In the Texture Component window, 1. click the c...
	2. Move the cursor over the tool you 2. want to us...
	3. As you pass the cursor over the tool, 3. the to...
	4. Drag the mouse in the direction you 4. want to ...
	5. Click the OK icon to apply your 5. changes.
	Editing Textures


	Combining Components
	Mode A
	Mode AB
	To use mode AB to blend textures:
	1. In the Materials Lab, Control/Ctrl- 1. click th...
	Mode ABC

	To use Mode ABC to blend textures:
	1. In the Materials Lab, Control/Ctrl- 1. click th...



	Shading Modes
	To choose a shading mode:
	Surface Material Shading Modes
	Normal
	Blend Transparency
	Fuzzy
	Light

	Volume Material Shading Modes
	Flat Shading
	Full Shading
	Light Sensitive

	Shading Mode Modifiers
	Additive
	Distance Blur
	Receive Shadows
	Cast Shadows
	Volume Blend-Altitude
	Volume Blend-Distance


	The Materials Lab
	To display the Materials Lab:
	1. Create an object.
	2. Select the object in the Working 2. window. A n...
	3. Click the M icon. Alternatively, you 3. can cho...

	A Quick Tour of the Materials Lab
	Material Preview Window
	The Materials Grid
	Texture Component Windows


	Working in the Materials Lab
	Building Materials
	To create a new surface material:
	1. Select an object.
	2. Display the Materials Lab.
	3. Set the material channels to define 3. the prop...
	4. If you’re using texture components, 4. you can:...
	5. Choose a shading mode for the 5. material by cl...
	6. Click the OK icon. The new material 6. is appli...

	To create a new volume material:
	1. Select an object.
	2. Display the Material Lab.
	3. Click the toggle button to switch to 3. Volume....
	4. Set the material channels to define 4. the prop...
	5. If you’re using texture components, 5. you can:...
	6. Choose a shading mode for the 6. material by cl...
	7. Click the OK icon. The new material 7. is appli...

	To activate a component in the Materials Grid:
	To use a component in a channel:
	To switch between components:
	To combine a component with a value:
	1. In a material channel, click an empty 1. column...
	2. Drag over the value control for the 2. channel....
	Copying and Pasting Materials

	To copy a material to the Materials clipboard:
	To paste a material to the Materials clipboard:
	Using the Material Preview Area

	To switch preview modes:
	To change the view angle of the preview area:


	Material Presets
	Using the Preset Materials Library
	To add a material from the Preset Materials Librar...
	1. Select an object.
	2. In the Working window, click the 2. triangle ic...
	3. Click one of the Category names 3. along the le...
	4. Click the thumbnail of the preset you 4. want t...
	5. Click the OK icon to add the selected 5. materi...
	Adding and Deleting Preset Materials

	To add a material to the library:
	1. Select the object whose material you 1. want to...
	2. Click the triangle icon next to the 2. Edit tex...
	3. Click a category name. The library 3. switches ...
	4. Click the triangle icon at the bottom 4. right ...
	5. Drag the preview area to rotate the 5. view of ...
	6. Hold down the Spacebar and drag 6. up, down, ri...
	7. Hold down Command/Ctrl and drag 7. in the previ...
	8. Click the Add button at the bottom of 8. the di...
	9. Enter a name for the new preset in 9. the Prese...
	10. Enter a description of the preset in 10. the D...
	11. Click the OK icon. Your preset will be 11. add...

	To delete a material preset:
	1. Click the triangle icon next to the 1. Edit tex...
	2. Click the preset you want to delete.
	3. Click the Delete button at the bottom 3. of the...


	Importing and Exporting Preset Materials
	To import a preset material file:
	1. Click the triangle icon next to the 1. Edit tex...
	2. Click the Import button at the 2. bottom of the...
	3. Locate the file you want to import 3. and click...

	To export a preset material file:
	1. Click the triangle icon next to the 1. Edit tex...
	2. Select the preset or presets you want 2. to exp...
	3. Click the Export button at the 3. bottom of the...
	4. Enter a name and location for the file 4. and c...


	Animating Materials
	Speeding Up Materials
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	Textures
	Textures and Materials
	Texture Structure
	Components vs. Texture Components
	Understanding Component Structure
	Components and Output


	Component Output
	Assigning Output Types
	Color Output
	To assign Color output to a texture:
	1. Display the Deep Texture Editor.
	2. In the desired component window, 2. click the C...
	Alpha Output

	To assign Alpha output to a texture:
	1. Display the Deep Texture Editor.
	2. In the desired component window, 2. click the A...
	Bump Output

	To assign Bump output to a texture:
	1. Display the Deep Texture Editor.
	2. In the desired component window, 2. click the B...



	Component Elements
	The Component window
	To activate a component:
	1. Display the Deep Texture Editor.
	2. Click the component selector in the 2. top-left...

	Color
	To activate Color output for a component:
	1. Display the Deep Texture Editor.
	2. In the desired component window, 2. click the C...

	To choose colors for a component:
	1. Display the Deep Texture Editor.
	2. In the desired component window, 2. make sure t...
	3. Click one of the color indicators 3. along the ...

	To mix colors for a component:
	1. Display the Deep Texture Editor.
	2. In the desired component window, 2. make sure t...
	3. Option/Alt-click the one of the color 3. indica...
	4. Choose a color model by clicking one 4. of the ...
	5. Enter color values or adjust the 5. sliders to ...
	6. Click the OK icon.
	Color Blending Modes

	To choose a Color Blending mode:
	1. Display the Deep Texture Editor.
	2. In the desired component window, 2. make sure t...
	3. Click the triangle icon in the lower 3. left co...
	None
	Red or Hue
	Green or Light
	Blue or Saturation
	Spline Interpol
	Linear Interpol 2
	Linear Interpol 3
	Randomized
	Earth Map
	Banded
	Perturbed
	Interferences
	Interpol + Interferences
	Altitude
	Spline with Snow
	Slope
	Orient


	Noise
	To display the Noise palette:
	1. Display the Deep Texture Editor.
	2. Click the Noise button at the bottom 2. of the ...

	To display the Noise Editor:
	1. Display the Deep Texture Editor.
	2. Click the Noise button at the bottom 2. of the ...
	3. Click the top-left corner of the 3. palette. Th...
	Creating Noise
	Noise Dimensions

	To choose the number of dimensions for your noise:...
	1. Display the Deep Texture Editor.
	2. Display the Noise Editor.
	3. Click one of the dimension buttons at 3. the bo...
	Noise Type

	To choose a noise type:
	1. Display the Deep Texture Editor.
	2. Display the Noise Editor.
	3. Click the type field at the top of the 3. edito...
	Noise Frequency

	To change the frequency of noise:
	1. Display the Deep Texture Editor.
	2. Display the Noise Editor.
	3. Drag over the X field in the 3. Frequency area ...
	4. Drag over the Y field in the Frequency 4. area ...
	5. Drag over the Z field in the 5. Frequency area ...
	Noise Orientation

	To change the orientation of noise:
	1. Display the Deep Texture Editor.
	2. Display the Noise Editor.
	3. Drag over the XY field in the 3. Direction area...
	4. Drag over the YZ field in the 4. Direction area...
	Noise Octaves

	To change the number of octaves:
	1. Display the Deep Texture Editor.
	2. Display the Noise Editor.
	3. Drag over the octaves field at the top 3. of th...
	Noise Modes

	To choose a Noise Mode:
	1. Display the Deep Texture Editor.
	2. Display the Noise Editor.
	3. Click the Mode field at the top of the 3. edito...
	Standard
	Irregular
	More Irregular
	Maximum
	Mulitfractal
	With Rotation
	Minimum
	Multiply
	Difference
	Minimum 90
	Maximum 90
	Auto-phased
	Displaced Max


	Phase
	To display the Phase palette:
	1. Display the Deep Texture Editor.
	2. Click the Phase button at the bottom 2. of the ...

	To display the Phase Editor:
	1. Display the Deep Texture Editor.
	2. Click the Phase button at the bottom 2. of the ...
	3. Click the top left corner of the 3. palette. Th...
	Creating Phase
	Phase Dimensions

	To choose the number of dimensions for your phase:...
	1. Display the Deep Texture Editor.
	2. Display the Phase Editor.
	3. Click one of the dimension buttons at 3. the bo...
	Phase Noise Type
	Phase Frequency

	To change the frequency of phase noise:
	1. Display the Deep Texture Editor.
	2. Display the Phase Editor.
	3. Drag over the X field in the 3. Frequency area ...
	4. Drag over the Y field in the Frequency 4. area ...
	5. Drag over the Z field in the 5. Frequency area ...
	Phase Noise Orientation

	To change the orientation of phase noise:
	1. Display the Deep Texture Editor.
	2. Display the Phase Editor.
	3. Drag over the XY field in the 3. Direction area...
	4. Drag over the YZ field in the 4. Direction area...
	Phase Noise Octaves
	Phase Noise Modes


	Filtering
	To display the Filtering palette:
	1. Display the Deep Texture Editor.
	2. Click the Filtering button at the 2. bottom of ...
	Editing the Filter

	To edit the Filtering graph:
	1. Display the Filtering palette.
	2. Drag over the Filtering graph area. 2. The shap...

	To change variable values:
	1. Display the Filtering palette.
	2. Drag over the variable field you want 2. to cha...
	Choosing a Filter

	To choose a filter:
	1. Display the Deep Texture Editor.
	2. Display the Filtering palette.
	3. Click the Filtering Equation area and 3. choose...
	None
	Quantize
	Saw Wave
	Sine Wave—Sin (aX) + b
	Absolute—Abs(aX + b)
	XPower—(X PWR a) + b
	Gaussian—(a(X + b))
	Clip aX + b
	Altitude Minus Slope—Xb + a (Altitude-Slope)
	Slope—X(a * Slope + b)
	Altitude—X(a* Altitude + b)
	Orientation—X(a * Orientation + b)
	Smooth Clip
	Snow Puddles



	Combining Components
	Blend Modes
	To apply a blend mode:
	1. Display the Deep Texture Editor.
	2. Click the Arrow between components 2. and choos...
	Parallel
	Combine
	Average
	Multiply
	Maximum
	Blend Maximum
	Minimum
	Blend Minimum
	Add
	Subtract
	Blend v1 and v2
	Blend Slope
	Fast Slope
	Blend Altitude
	Blend Orientation
	Blend Random
	Procedural Blend
	Difference


	Global Changes
	Global Colors
	To add colors directly to a texture:
	1. Click the top color circle in the 1. combinatio...
	2. Repeat for each of the other two color 2. circl...
	Global Noise

	To adjust noise globally:
	1. Click the top left button in the 1. combination...
	2. Drag the slider to adjust the noise 2. value.
	Global Phase

	To adjust phase globally:
	1. Click the bottom right button in the 1. combina...
	2. Drag the slider to adjust the phase 2. amplitud...
	Global Filtering

	To filter noise globally:
	1. Click the top right button in the 1. combinatio...
	2. Choose a filter and adjust its variables 2. to ...



	The Deep Texture Editor
	To display the Deep Texture Editor:
	1. Display the Materials Lab.
	2. Click the A, B or C column of the 2. material c...
	3. Click the pink button at the top of the 3. Comp...

	A Quick Tour: The Deep Texture Editor

	Working in the Deep Texture Editor
	Building Textures
	To build a texture:
	1. Display the Deep Texture Editor.
	2. Click the Component Selector to 2. choose the n...
	3. In the first component window, click 3. one of ...
	4. If your component contains color, 4. click one ...
	5. Click the triangle icon below the 5. color circ...
	6. Click the Noise button at the bottom 6. of the ...
	7. Adjust the noise in the component 7. by:
	8. Click the bottom right button on the 8. Compone...
	9. Adjust the phase in the component 9. by:
	10. Click the Filtering button at the 10. bottom o...
	11. Choose a filter to apply the 11. component noi...
	12. Repeat steps 3–11 for each 12. component in th...
	13. Click the arrow between Component 13. 1 and Co...
	14. If you have more than two 14. components, clic...
	15. Click the color circles in the 15. Combination...
	16. If you want to change the noise of 16. combine...
	17. If you want to change the phase of 17. combine...
	18. If you want to change the filter of 18. combin...
	19. Click the OK icon at the bottom of 19. the edi...


	Using Drag and Drop in the Editor
	To drag and drop between windows:

	Changing Component Preview
	To choose a preview mode:

	Randomizing Textures
	To randomize component elements:

	Undoing Changes
	To reset a component:

	Saving Textures
	To save a texture:
	1. In the Combination component 1. window, click t...
	2. Enter a name for the new texture and 2. click t...
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	To set the application’s launch state:
	1. Choose Edit menu> Preferences. 1. The Preferenc...
	2. Enable either Launch to Previous 2. State or La...

	To save PICT or bitmaps used in a scene with a fil...
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	2. Enable either Create Objects Within 2. View or ...
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	To maximize the Bryce window:
	1. Pass the cursor over the right side of 1. the W...
	2. Click the Interface Max/Min tool.
	3. Click the tool again to switch to a 3. standard...

	Setting Up the Working Window
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	To switch between display modes:
	1. Click on the Display Mode tool in the 1. corner...
	2. Click the button until you’re in the 2. desired...

	To toggle between modes:
	Flat Shaded Preview Mode

	To display objects in Flat Shaded Preview:
	Wireframe attributes

	To set Wireframe attributes:
	1. Make sure you’re in Wireframe mode. 1. Click th...
	2. Drag the Depth Cue control up or 2. down. Dragg...
	3. Click the Wireframe Shadows button 3. to turn s...
	4. Click the Underground On/Off 4. button to hide ...
	5. Click the Resolution tool and then 5. choose St...
	Window Backgrounds

	To select a background texture:
	To select a background color:
	1. Click the Background Paper button 1. and choose...
	2. Use the color picker to select a color.



	Using the Bryce Interface
	To move a palette:
	To reset a palette to its original position:
	To hide the Bryce interface:
	1. Press Command-Tab/Ctrl+Tab. All 1. the palettes...
	2. Press Command-Tab/Ctrl+Tab again 2. to display ...

	To display individual palettes:
	1. Press Command-Tab/Ctrl+Tab to 1. hide the inter...
	2. Press the key combination for the 2. palette yo...

	Displaying Text Information
	To display information about the interface:
	To display statistics about the objects in your sc...
	1. Switch to Wireframe display using 1. the Displa...
	2. Pass the pointer over the working 2. window.

	To display information about rendered images:
	1. Switch to bitmap display mode using 1. the Disp...
	2. Pass the pointer over the working 2. window.


	Displaying/Hiding Palettes
	To display different palettes:
	To display hidden palettes:

	Displaying Submenus and Pop-up Dialogs
	To display a submenu:


	Working with Documents
	Creating an Empty Scene
	To create a new document:
	1. Choose File menu> New. The 1. Document Setup di...
	2. Enter values in the Document 2. Resolution fiel...
	3. Enter values in the Document Aspect 3. Ratio fi...
	4. Enable the Constrain Proportions 4. button if y...
	5. Select a Render Resolution from the 5. list.

	To set up a new document using presets:
	1. Choose File menu> New. The 1. Document Setup di...
	2. Click one of the preset aspect ratios 2. displa...


	Opening an Existing File
	To open an existing file:
	1. Choose File menu> Open.
	2. Use the dialog controls to locate and 2. open y...
	Merging scenes

	To merge two scenes:
	1. Click Save. The Open dialog appears.
	2. Use the dialog controls to locate the 2. file y...



	Working in a Scene
	Displaying Your Scene
	Changing Object Display
	To display objects as boxes:
	1. Choose Object menu> Show Object 1. as Box.

	To display objects as wireframes:
	Using the Nano-Preview

	To display your scene from different angles in the...
	To set Nano-Preview options:

	Viewing Your Scene
	Orthogonality and Views
	Zooming In and Out
	To zoom in:
	To zoom out:
	To zoom into an area:
	To zoom out of an area:
	To zoom numerically:
	1. Double-click the Trackball in the 1. Control pa...
	2. Enter a value in the Scale field.

	To reset the zoom value:
	Panning

	To pan your scene using the Pan tool:
	To pan your scene using the Spacebar:
	To pan numerically:
	1. Double-click the Trackball in the 1. Control pa...
	2. Enter a value in the Horizontal field.
	3. Enter a value in the Vertical field.

	To reset the pan value:
	Using Fly-around View

	To switch to Fly-around view:
	To switch back to Camera view:
	To rotate the view of your scene in Fly-around vie...
	To zoom in and out in Fly-around view:
	To pause the Fly-around:
	To end the Fly-around and save Fly-around position...
	Using the View Control

	To switch views using the View control:
	To switch views using the View control menu:
	To switch views using the keyboard:
	To reset the view of your scene:

	Selecting Objects
	To select an object:
	To select a number of objects:
	To step through all the objects in your scene:
	To select all objects:
	To select an object within a group:
	To deselect all:
	To add objects to a selection:
	To remove objects from a selection:
	To select obscured objects:
	The Selection Palette

	To display the Selection palette:
	Selecting By Object Type

	To select a specific object by type:
	To select objects by family:
	To select Polymesh objects:
	To select all objects except a specific type:
	1. Click the tool for the object you want 1. to ex...
	2. Click the triangle icon in the 2. Selection pal...

	To select all the objects in your scene:
	The VCR Controls

	To display the VCR Controls:
	1. Click the Swap button in the lower 1. right cor...
	2. Pass your cursor over the right side of 2. the ...

	To step forward and backward through the object ty...
	1. Click on the larger forward arrow to 1. step fo...
	2. Click on the larger backward arrow to 2. step b...

	To step forward and backwards through the object i...
	1. Click on the smaller forward arrow to 1. step f...
	2. Click the smaller backwards arrow to 2. step ba...

	To step sequentially through every object in your ...
	1. Click the triangle icon in the 1. Selection pal...
	2. Click the larger backwards or 2. forwards arrow...

	To step sequentially through families:
	1. Click the triangle icon in the selection 1. pal...
	2. Click the smaller backwards or 2. forwards arro...

	To temporarily remove all unselected objects from ...
	1. Select an object.
	2. Click the Solo Mode button in the 2. center of ...


	Editing Your Scene’s Contents
	Cutting and Pasting Objects
	To cut and paste an object:
	1. Select an object.
	2. Choose Edit menu> Cut, or 2. Press Command-X/Ct...

	To copy and paste an object:
	1. Select an object.
	2. Choose Edit menu> Copy, or press 2. Command-C/C...
	3. Choose Edit menu> Paste, or press 3. Command-V/...
	Copying and Pasting Materials

	To copy and paste an object’s material:
	1. Select an object.
	2. Choose Edit menu> Copy Material, 2. or press Co...
	3. Choose Edit menu> Paste Material, 3. or, press ...
	Copying and Pasting Matrices

	To copy and paste an object’s matrix:
	1. Select an object.
	2. Choose Edit menu> Copy Matrix, or 2. press Opti...
	3. Select a different object.
	4. Choose Edit menu> Paste Matrix, 4. or press Opt...

	To delete a selected object:
	1. Select an object.
	2. Choose Edit menu> Clear, or press 2. the Delete...
	Duplicating and Replicating Objects

	To duplicate an object:
	1. Select an object.
	2. Choose Edit menu> Duplicate, or 2. press Comman...

	To replicate an object:
	1. Select an object.
	2. Choose Edit menu> Replicate, or 2. press Comman...

	To replicate objects numerically:
	1. Select an object.
	2. Choose Edit menu> 2. Multi-Replicate, or press ...
	3. Enter a value in the Quantity field.
	4. Enter X, Y and Z values in the Offset 4. fields...
	5. Enter X, Y and Z values in the Rotate 5. fields...
	6. Enter X, Y and Z values in the Scale 6. fields....


	Undoing Operations
	To undo the last operation:
	To redo the last operation:
	To revert to the last saved version of your scene:...

	The Marker Pen
	To draw with the marker tool:
	1. Click the Marker Pen tool, or press 1. the M ke...
	2. Drag it anywhere on your screen.

	To erase marker pen lines:


	Saving and Closing
	Saving Files
	To save a file:
	1. Chose File menu> Save. The Save 1. dialog appea...
	2. Use the dialog controls to choose a 2. location...

	To save a file under a different name:
	1. Chose File menu> Save As. The Save 1. dialog ap...
	2. Enter a new name and/or location in 2. the fiel...
	3. A copy of your work is saved, leaving 3. the or...


	Closing
	To close Bryce:
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	04-Tutorial.pdf
	Tutorial
	Welcome
	Getting Started
	To configure the Bryce environment:
	1. Launch Bryce�3D.

	To display layered palettes:
	To display hidden palettes:
	To display option menus:
	Lesson 1: Setting Up a New Document
	To set up a new document:
	1. Choose File menu> New. The 1. Document Setup di...
	2. Click the Photo preset. The 2. Resolution and A...
	3. Click the checkmark icon at the 3. bottom of th...


	Lesson 2: Positioning the Camera
	To switch between views:
	To hide the camera:
	1. Click the camera in the scene.
	2. Click the A icon that appears next to 2. the ca...
	3. Enable the Invisible option. Click the 3. OK ic...

	To open the camera lesson file:
	1. Choose File menu> Open.
	2. Locate the file Tutorial: Camera: 2. Camera Sce...

	To reposition the camera using the Camera Cross Co...
	1. On the XZ Cross, drag the Z arrow 1. down. The ...
	2. On the XY Cross, drag the tip of the Y 2. arrow...

	To reposition the camera using the Trackball:
	1. Click the center of the Trackball and 1. drag t...

	To reposition the camera numerically:
	1. Click the triangle icon next to the 1. Trackbal...
	2. Double-click the Trackball. The 2. Camera & 2D ...
	3. Enter Position X=24, Position Y=15, 3. Position...
	4. Leave the remaining values at their 4. defaults...
	5. Click the OK icon to apply the 5. changes to th...
	6. Close the file and save it if you want.



	Arranging Objects in the Scene
	The Story So Far
	What You’ll Need
	Lesson 1: Adding Objects
	To add an infinite plane:
	1. Display the Create palette by clicking 1. the C...
	2. Click the Water Plane tool.

	To add objects from the Preset Objects Library:
	1. Display the Create palette by clicking 1. the C...
	2. Click the triangle icon next to the 2. Create t...
	3. Click the Tutorial category.
	4. Click the terrain object labeled 4. Tutorial Te...
	5. Click the OK icon. The terrain 5. appears in yo...
	6. Click the triangle icon again, then, 6. without...
	7. Repeat step 6 again to add the 7. umbrella and ...


	Lesson 2: Positioning Objects
	To reposition the camera:
	1. Click the triangle icon next to the 1. Trackbal...
	2. Double-click the Trackball. The 2D 2. Projectio...
	3. Enter Position X=23.68, Position 3. Y=17.16, Po...
	4. Enter Pan V=-128 and Pan H=0.
	5. Click the OK icon to apply the 5. changes to th...

	To reposition objects numerically:
	1. Press the tab key repeatedly until the 1. large...
	2. Click the A icon that appears next to 2. the te...
	3. Enter Position X=0, Position 3. Y=29.95, Positi...
	4. Click the OK icon. The terrain moves 4. to a ne...


	Lesson 3: Rotating Objects
	To adjust an object’s Origin Point:
	1. Click the sphere object. The ball’s 1. bounding...
	2. Click the A icon that appears next to 2. the ba...
	3. Click the General tab.
	4. Click the Show Origin Handle 4. button.
	5. Click the origin point and drag it 5. away from...

	To rotate an object using its control points:
	1. Hold down Command/Ctrl and drag 1. one of the o...


	Lesson 4: Scaling Objects
	To scale objects using the Scale tool:
	1. Click the umbrella object.
	2. Click the Edit button at the top of the 2. Bryc...
	3. Drag the mouse over the Scale tool 3. until the...
	4. Drag to the left to decrease the size of 4. the...
	Moving On



	Creating Objects
	The Story So Far
	What You’ll Need
	Lesson 1: Creating Terrains
	To open the Terrain Editor:
	1. Display the Create palette.
	2. Click the Terrain Object tool.
	3. Select the terrain object. A series of 3. icons...
	4. Click the E icon. The Terrain Editor 4. appears...

	To change the 3D Terrain Preview:
	To set up the grayscale paintbrush:
	1. Drag the cursor over the Size control 1. until ...
	2. Make sure the Hardness control looks 2. like th...
	3. Drag the cursor over the Flow control 3. until ...
	4. Drag the Level control until the 4. setting loo...
	5. Click the triangle icon below the 5. Brush Beha...

	To clear the Terrain Canvas:
	1. Click the Elevation tab title to make it 1. vis...
	2. Click the New button.The current 2. image in th...

	To paint a terrain:
	1. Position the brush at the top right 1. corner o...
	2. Click the mouse once.
	3. Move the brush to the left and down 3. slightly...
	4. Continue moving and clicking the 4. mouse to cr...
	5. Adjust the size of your brush by 5. dragging ov...
	6. Drag the Level control up to adjust 6. the brig...
	7. Dab the brush over two or three areas 7. of the...
	8. Decrease the size of the brush again.
	9. Adjust the Level control to get a 9. brighter g...
	10. Dab over the tops of the hills to add 10. more...

	To soften an area of your terrain:
	1. Drag right over the Size control to 1. increase...
	2. Decrease the hardness of the brush, 2. by dragg...
	3. Drag to the left over the Flow control 3. to de...
	4. Drag down over the Level control to 4. decrease...
	5. Drag the brush over the center 5. portion of yo...
	6. Click the OK icon to exit the editor.

	To scale the terrain object:
	1. Click the Edit button at the top of the 1. Bryc...
	2. Click the triangle icon below the 2. Resize too...
	3. Enter Scale X=200, Y=200, Z=200.
	4. Click the OK icon.

	To name an object:
	1. Click the terrain object.
	2. Click the A icon that appears next to 2. the te...
	3. Enter UTOPIA in the Object Name 3. field and cl...


	Lesson 2: Adding Skies
	To select a sky mode:
	1. Click the Sky & Fog text button to 1. display t...
	2. Click the triangle icon under the Sky 2. Mode t...

	To set shadow intensity:
	1. Pass your cursor over the Sky & Fog 1. palette ...
	2. Drag to the left over the thumbnail 2. until th...

	To set fog color and intensity:
	1. Pass you cursor over the Sky & Fog 1. palette u...
	2. Drag to the right over the thumbnail 2. until t...
	3. Drag up over the thumbnail until the 3. value i...
	4. Hold down Option/Alt and click the 4. color bel...
	5. Enter the values R=210,G=210, 5. B=210. These v...

	To set haze intensity and color:
	1. Pass your cursor over the Sky & Fog 1. palette ...
	2. Drag left over the thumbnail until the 2. value...
	3. Hold down Option/Alt and click the 3. color bel...
	4. Enter the values R=185,G=185, 4. B=185. These v...

	To set cloud altitude:
	1. Pass your cursor over the Sky & Fog 1. palette ...
	2. Drag right over the thumbnail until 2. the valu...

	To set cloud coverage:
	1. Pass your cursor over the Sky & Fog 1. palette ...
	2. Drag right over the thumbnail until 2. the valu...

	To set cloud frequency and amplitude:
	1. Pass your cursor over the Sky & Fog 1. palette ...
	2. Drag to the right over the thumbnail 2. until t...
	3. Drag up over the thumbnail until the 3. number ...

	To add clouds to a sky:
	To position the sun numerically:
	1. Click the triangle icon below the 1. memory dot...
	2. Click the Sun & Moon tab.
	3. In the Numerical Sun Values fields 3. enter X=8...
	4. Click the OK icon. The sun moves to 4. the new ...


	Lesson 3: Creating Infinite Slabs
	To add infinite slabs:
	1. Click the Create button to display the 1. Creat...
	2. Hold down the mouse button over 2. the Water Pl...
	3. Click the water slab in the Working 3. window.
	4. Click the A icon the appears next to 4. the sla...
	5. Make sure the General tab is visible.
	6. Enter OCEAN in the Object Name 6. field. This g...
	7. Enter Size Y=2 and leave the other 7. values as...
	8. Click the OK icon.
	Moving On



	Creating Materials
	The Story So Far
	What You’ll Need
	To open the Materials tutorial file:
	1. Choose File menu> Open. The Open 1. dialog appe...
	2. Locate the file Materials 1 in the 2. Tutorial ...

	Lesson 1: Creating Materials Using 3D Textures
	To display the Materials Lab:
	1. Click the terrain object in the scene.
	2. Click the M icon that appears next to 2. the te...

	To activate a component:
	1. Click the A column of the Diffuse 1. channel. A...
	2. Click the arrow button at the top of 2. the com...
	3. Click the B column of the Diffuse 3. channel. A...
	4. Click the arrow button at the top of 4. the com...
	5. Click the C column of the Diffuse 5. channel. A...
	6. Click the arrow button at the top of 6. the com...
	The Deep Texture Editor

	To edit a texture component:
	1. Click the pink button at the top of the 1. Comp...
	2. In the component 2 window, Option/ 2. Alt-click...
	3. Enter the values R=215, G=192, 3. B=139 and cli...
	4. Option/Alt-click the second color 4. circle.
	5. Enter the values R=221, G=204, 5. B=159 and cli...
	6. Click the OK icon to exit the Deep 6. Texture E...
	7. In the Materials Lab, click the pink 7. button ...
	8. In the component 1 window, Option/ 8. Alt-click...
	9. Enter the values R=252, G=252, 9. B=252 and cli...
	10. Option/Alt-click the second color 10. circle.
	11. Enter the values R=133, G=116, 11. B=72 and cl...
	12. Option/Alt-click the third color 12. circle.
	13. Enter the values R=84, G=63, B=45 13. and clic...
	14. Click the Noise button at the bottom 14. of th...
	15. Make sure the indicator ball is in the 15. fir...
	16. Drag the Noise slider to the right to 16. incr...
	17. Click the button at the bottom right 17. of th...
	18. Make sure the indicator ball is in the 18. fir...
	19. Drag the Phase slider to the right to 19. incr...
	20. Click the OK icon to exit the Deep 20. Texture...

	To transform a texture component:
	1. In the component B window (Zion), 1. click the ...
	2. Next to the Resize tool, drag left over 2. each...
	3. Click the T button in the lower-right 3. of the...

	To choose a mapping mode for textures:
	1. In the component A window (Fire), 1. click the ...
	2. Make sure that the other two 2. components are ...

	To combine components on the grid:
	1. Control/Ctrl-click the C column in 1. the Diffu...
	2. Control/Ctrl-click the B column in 2. the Ambie...
	3. Leave the Specular, Transparent 3. Specular Hal...
	4. Drag the slider in the Diffusion 4. channel to ...
	5. Drag the slider in the Ambience 5. channel to t...
	6. Leave the Specularity and Metallicity 6. channe...
	7. Control/Ctrl-click the C column in 7. the Bump ...
	8. Drag the slider in the Bump Height 8. channel u...
	9. Leave the Transparency, Reflection 9. and Refra...
	10. Click the OK icon at the bottom of 10. the Mat...


	Lesson 2: Creating Volume Materials
	To create a volume material:
	1. Click the Swap button at the bottom 1. of the B...
	2. Hold down the mouse button over 2. the Sphere b...
	3. Click the M icon that appears next to 3. the sp...
	4. Click the Volume Material button in 4. the top ...
	5. Click the A column in the Diffuse 5. channel. T...
	6. Click the triangle icon in the top right 6. cor...
	7. Click the A column in the Ambient, 7. Specular ...
	8. Leave Specular Halo as is.
	9. Option/Alt-click the Volume Color 9. oval and e...
	10. Click the A column in the Diffusion 10. channe...
	11. Click the A column in the Ambient 11. channel,...
	12. Click the A column in the Specularity 12. chan...
	13. Click the A column in the Base 13. Density cha...
	14. Drag the slider in the Edge Softness 14. chann...
	15. Drag the slider in the Fuzzy Factor 15. channe...
	16. Leave Quality/Speed at the default.
	17. Click the OK icon to exit the lab.
	Moving On



	Adding Lights
	The Story So Far
	What You’ll Need
	To open the light tutor file:
	1. Choose File menu> Open.
	2. Locate the file Light Tut in the 2. Tutorial fo...

	To set the Nano-Preview to Auto-Update:
	Lesson 1: Adding Lights
	To add a light:
	1. Click the Create button to display the 1. Creat...
	2. Click the Spotlight tool.
	3. Click the light to select it.
	4. Click the E icon that appears next to 4. its bo...
	5. Click the triangle icon below the light 5. prev...
	6. Click the Texture Gel button at the 6. bottom o...
	7. Click the Tutorial category.
	8. Click Tutorial Light Gel and click the 8. OK ic...
	9. Click the OK icon to exit the Edit 9. Lights di...

	To position lights:
	1. Select the light in the Working 1. window.
	2. Click the A icon that appears next to 2. its bo...
	3. Make sure the General tab is visible.
	4. Enter Position: X=-20.52, Y=34.47, 4. Z=28.68, ...
	Moving On



	Animating Objects
	The Story So Far
	What You’ll Need
	To begin the animation tutorial:
	1. Choose File menu > Open. The 1. Open dialog app...
	2. Locate the file Animate Tutor in the 2. Tutoria...
	3. Click Open.

	To setup your animation:
	1. Choose File menu> Animation 1. Setup or double-...
	2. Enter 24 in the FPS field.
	3. In the Duration fields enter 3. 0:00:03:00. Thi...
	4. Enable the Once button in the Play 4. area to h...
	5. Enable the SMPTE Time button in 5. the Display ...

	Lesson 1: Creating Key Frames
	To create key frames:
	1. Click the triangle icon to the left of 1. the a...
	2. Drag the Current Time Indicator to 2. time 00:0...
	3. Click the ball and move it down and 3. to the r...
	4. Move the Current Time Indicator to 4. time 00:0...
	5. Drag the ball in the scene up and to 5. the lef...
	6. Move the Current Time Indicator to 6. time 00:0...
	7. Drag the ball in the scene down and 7. to the r...
	8. Move the Current Time Indicator to 8. time 00:0...
	9. Drag the ball in the scene up and to 9. the rig...
	10. Move the Current Time Indicator to 10. time 00...
	11. Drag the ball in the scene down and 11. to the...
	12. Move the Current Time Indicator to 12. time 00...
	13. Drag the ball in the scene to the right.

	To preview an animation:
	1. Click the First Frame button. The ball 1. jumps...
	2. Click Play.


	Lesson 2: Editing Time Mapping Curves
	To display the Advanced Motion Lab:
	1. Click the ball in the Working 1. window.
	2. Make sure the animation controls are 2. visible...
	3. Click the Advanced Motion Lab 3. button. The Ad...

	To edit time mapping curves:
	1. Drag the first point on the curve up 1. to the ...
	2. Drag the second point up and to 2. right so tha...
	3. Drag the third point up as shown.
	4. Drag the fourth point up and to the 4. right as...
	5. Leave the fifth point as is.
	6. Drag the sixth point down slightly as 6. shown....
	Moving On



	Animating the Camera
	The Story So Far
	What You’ll Need
	Lesson 1: Animating the Camera
	To aim the camera:
	1. Move the cursor over the line that 1. extends o...
	2. Drag the tip of the line, or the Aim 2. control...

	To animate the camera position:
	1. Make sure you’re in Director’s View. 1. If you’...
	2. Click the triangle icon next to the 2. View Con...
	3. Click the Camera icon in the scene.
	4. Click the triangle icon to the right of 4. the ...
	5. Move the Current Time Indicator to 5. time 00:0...
	6. Drag the camera icon to the position 6. shown.
	7. Change the aim so that the camera is 7. facing ...
	8. Move the Current Time Indicator to 8. time 00:0...
	9. Drag the camera icon to the position 9. shown.
	10. Change the aim again so that the 10. camera fa...
	11. Move the Current Time Indicator to 11. time 00...
	12. Drag the camera icon to the position 12. shown...
	13. Change the aim so that the camera 13. faces th...
	14. Move the Current Time Indicator to 14. time 00...
	15. Change the aim so that the camera is 15. facin...
	16. Click the triangle icon next to the 16. View C...
	17. Click the First Frame button in the 17. Animat...
	Moving On



	Animating Materials
	The Story So Far
	What You’ll Need
	To begin animating materials:
	1. Choose File menu >Open. The Open 1. dialog appe...
	2. Locate the file Animate Mat in the 2. Tutorial ...
	3. Click Open.

	Lesson 1: Animating Between Materials
	To animate between materials:
	1. Click the sphere object in the fire pit.
	2. Click the M icon that appears next to 2. the sp...
	3. Click the First Frame button in the 3. Animatio...
	4. Click the triangle icon to the right of 4. the ...
	5. Drag the Current Time Indicator to 5. 00:00:02....
	6. Drag the slider in the Fire material’s 6. chann...
	7. Click the Add Frame button to store 7. your cha...
	8. Click the First Frame button to move 8. to the ...
	9. Click the Play button to preview the 9. animati...
	Moving On



	Rendering
	The Story So Far
	What You’ll Need
	To open the preset file for rendering:
	1. Choose File menu > Open.
	2. Locate the file Rendering Tut in the 2. Tutoria...
	3. Click Open.

	Lesson 1: Rendering an Image
	To choose a rendering resolution:
	1. Double-click the Render button in 1. the Render...
	2. Click 480 x 360 at the bottom of the 2. dialog....
	3. Click the OK icon.

	To choose rendering options:
	1. Click the triangle icon next to the 1. Renderin...
	2. Make sure Texture On/Off is 2. disabled.
	3. Make sure Fast Render mode is off.
	4. Click the triangle icon next to the 4. Render c...
	5. Click the triangle icon next to the 5. Render c...

	To start rendering your final image:

	Lesson 2: Rendering an Animation
	To render an animation:
	1. Choose File menu> Render 1. Animation. The Rend...
	2. Click the Set Destination File if you 2. want t...
	3. Click the Output Type popup to 3. choose a form...
	4. Click the Set Compression button if 4. you want...
	5. Set a range of the animation to 5. render.
	6. Click OK and the render of the 6. animation beg...
	Moving On
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	Creating Skies
	Environments and Bryce�3D
	The Sky�&�Fog Palette
	Environmental Attributes dialog
	Working with the Sky�&�Fog palette
	Using the Control Thumbnails
	To change the intensity of an effect:
	To pick a color for an effect:
	Setting Palette Options

	To link Sky�&�Fog attributes directly to your scen...
	To reset Sky�&�Fog palette settings to their defau...
	Saving Sky�&�Fog settings

	To save Sky�&�Fog settings:
	To switch to a saved Sky�&�Fog setting:
	To reset Sky�&�Fog settings to default:
	To delete a saved Sky�&�Fog setting:
	Randomizing Skies

	To randomize your sky:


	Working with Sky Modes
	To select a sky mode:
	Sky Modes

	To set custom sky colors:
	1. Click the triangle icon next to the Sky 1. Mode...
	2. Click the Sky Color swatch and 2. choose a colo...
	3. Click the Solar Halo Color swatch 3. and choose...
	4. Click the Horizon Color swatch and 4. choose a ...

	To render objects against a plain background:
	1. Click the triangle icon next to the Sky 1. Mode...
	2. Click the Atmosphere swatch and 2. choose a col...
	3. Drag left inside the Haze control and 3. set th...


	Setting Sky Attributes
	Shadows in Your Scene
	To set shadow intensity:
	1. Display the Sky�&�Fog palette by 1. clicking th...
	2. Drag left or right inside the Shadow 2. control...

	To set shadow intensity numerically:
	1. If it’s not already visible, display the 1. Sky...
	2. Click the triangle in the corner of the 2. pale...
	3. Enter a value into the Shadow 3. field.This fie...


	Ambient Color
	To set Ambient Color:


	Adding Fog and Haze
	Fog
	To set the amount of Fog:
	1. Display the Sky�&�Fog palette by 1. clicking th...
	2. Drag horizontally inside the Fog 2. thumbnail t...

	To set Fog height:
	1. Display the Sky�&�Fog palette by 1. clicking th...
	2. Drag vertically inside the Fog control 2. to in...

	To set Fog color:
	1. Display the Sky�&�Fog palette by 1. clicking th...
	2. Click the color swatch beneath the 2. Fog thumb...

	To set Fog attributes numerically:
	1. If it’s not already visible, display the 1. Sky...
	2. Click the triangle in the corner of the 2. pale...
	3. Click the Atmosphere tab.
	4. Enter a value in the Fog field. This 4. field s...
	5. Enter a value in the Height field. This 5. fiel...
	Blending the Fog Color

	To link Fog color to the Sun controls:
	1. If it’s not already visible, display the 1. Sky...
	2. Click the triangle in the corner of the 2. pale...
	3. Click the Atmosphere tab.
	4. Click the Blend with Sun button.
	5. Make sure the Blend Fog button is 5. enabled.
	6. Enter a value in the Color field to set 6. how ...
	7. Enter a value in the Luminance field 7. to set ...
	Localized Fog

	To create localized fog:
	1. Display the Create palette.
	2. Click the Sphere tool. A sphere object 2. appea...
	3. Squash and stretch the sphere, until it 3. is t...
	4. With the object selected, click the M 4. icon t...
	5. Click the Volume button at the top of 5. the la...
	6. Set up the values for channels in the 6. materi...
	7. Click the OK icon to exit the lab.
	8. In the Working window, move the 8. object to th...


	Haze
	To set Haze intensity:
	1. Display the Sky�&�Fog palette by 1. clicking th...
	2. Drag horizontally inside the Haze 2. thumbnail ...

	To set Haze intensity numerically:
	1. If it’s not already visible, display the 1. Sky...
	2. Click the triangle in the corner of the 2. pale...
	3. Click the Atmosphere tab.
	4. Enter a value in the Haze field. This 4. field ...

	To set Haze color:
	1. Display the Sky�&�Fog palette by 1. clicking th...
	2. Click the color swatch beneath the 2. Haze thum...
	Blending the Haze color with the Sun

	To link Haze to the Sun controls:
	1. If it’s not already visible, display the 1. Sky...
	2. Click the triangle in the corner of the 2. pale...
	3. Click the Atmosphere tab.
	4. Click the Blend with Sun button.
	5. Make sure the Blend Haze button is 5. enabled.
	6. Enter a value in the Color field to set 6. how ...
	7. Enter a value in the Luminance field 7. to set ...
	8. To get the best effect, set both these 8. field...



	Clouds in Bryce
	Adding Clouds
	Cloud Types
	To add Cumulus clouds to a sky:
	1. If it’s not already visible, display the 1. Sky...
	2. Click the triangle in the corner of the 2. pale...

	To add Stratus clouds to a sky:
	1. If it’s not already visible, display the 1. Sky...
	2. Click the triangle in the corner of the 2. pale...
	Editing Cloud Textures

	To edit cloud texture in the Environmental Attribu...
	1. If it’s not already visible, display the 1. Sky...
	2. Click the triangle in the corner of the 2. pale...
	3. Click the Cloud Cover tab.
	4. Click the Arrow icon next to the type 4. of clo...
	5. Click the + or - Turbulence buttons 5. to incre...
	6. Click the + or - Complexity buttons 6. to incre...
	7. Click the Randomize button if you 7. want to ch...
	8. Click the OK icon to apply your 8. changes.

	To edit cloud textures in the Deep Texture Editor:...
	1. If it’s not already visible, display the 1. Sky...
	2. Click the triangle in the corner of the 2. pale...
	3. Click the Cloud Cover tab.
	4. Click the Arrow icon next to the type 4. of clo...
	5. Click the Editor button. The Deep 5. Texture Ed...
	6. If you want to add additional 6. turbulence to ...
	7. If you want to change the colors of a 7. compon...
	8. If you want to add more complexity 8. to the te...
	9. If you want to change the pattern in 9. the tex...
	10. Click the OK icon to exit the editor.
	Cloud Coverage

	To set cloud coverage:
	1. If it’s not already visible, display the 1. Sky...
	2. Drag left or right inside the Cloud 2. Coverage...

	To set cloud coverage numerically:
	1. If it’s not already visible, display the 1. Sky...
	2. Click the triangle in the corner of the 2. pale...
	3. Click the Cloud Cover tab.
	4. Enter a value in the Density field at 4. the bo...

	To set cloud color:
	1. Display the Sky�&�Fog palette by 1. clicking th...
	2. Click the color swatch beneath the 2. Cloud Cov...
	Cloud Altitude

	To set cloud altitude:
	1. If it’s not already visible, display the 1. Sky...
	2. Drag horizontally inside the Cloud 2. Altitude ...

	To set cloud altitude numerically:
	1. Display the Sky�&�Fog palette by 1. clicking th...
	2. Click the triangle in the corner of the 2. pale...
	3. Click the Cloud Cover tab.
	4. Enter a value in the Height field at the 4. bot...
	Sky Dome Color

	To set Sky Dome color:
	1. If it’s not already visible, display the 1. Sky...
	2. Click the color bar beneath the Cloud 2. Altitu...
	Frequency and Amplitude

	To set Cloud Frequency and Amplitude:
	1. Display the Sky�&�Fog palette by 1. clicking th...
	2. In the Cloud Frequency and 2. Amplitude control...
	3. Drag vertically to control the 3. amplitude of ...

	To set Frequency and Amplitude numerically:
	1. If it’s not already visible, display the 1. Sky...
	2. Click the triangle in the corner of the 2. pale...
	3. Click the Cloud Cover tab.
	4. Enter a value in the Scale field.
	5. Enter a value in the Amplitude field.
	Linking Clouds to the Camera View

	To link clouds to view:
	1. If it’s not already visible, display the 1. Sky...
	2. Click the triangle in the corner of the 2. pale...
	3. Click the Cloud Cover tab.
	4. Click the Link Clouds to View 4. button.
	Using a Fixed Cloud Plane

	To use a fixed cloud pattern in your sky:
	1. If it’s not already visible, display the 1. Sky...
	2. Click the triangle in the corner of the 2. pale...
	3. Click the Cloud Cover tab.
	4. Click the Fixed Cloud Plane button.



	Working with the Sun
	Positioning the Sun
	Day and Night
	To switch between night and day:
	1. Display the Sky�&�Fog palette.
	2. Click the Day/Night toggle button in 2. the top...
	Sunrise/Sunset

	To position the sun manually:
	1. Display the Sky�&�Fog palette by 1. clicking th...
	2. Drag the larger highlight area in the 2. Sun Po...

	To position the sun numerically:
	1. Display the Sky�&�Fog palette by 1. clicking th...
	2. Click the triangle in the corner of the 2. pale...
	3. Click the Sun & Moon tab.
	4. In the Numerical Sun Values fields, 4. type a v...
	5. Enter a value in to the Y field. The Y 5. field...
	6. Enter a value in to the Z field. The Z 6. field...
	Linking the Sun to the Camera

	To link the sun to the camera:
	1. Display the Sky�&�Fog palette by 1. clicking th...
	2. Click the triangle in the corner of the 2. pale...
	3. Click the Sun & Moon tab.
	4. Click the Link Sun to View button.
	Sun Color

	To set the Sun Color:
	1. Display the Sky�&�Fog palette by 1. clicking th...
	2. Click the Sun Color swatch and 2. choose a colo...
	Disabling the Sun

	To disable the Sun:
	1. Display the Sky�&�Fog palette by 1. clicking th...
	2. Click the triangle in the corner of the 2. pale...
	3. Click the Sun & Moon tab.
	4. Click the Disable Sun/Moon button.



	Working with the Moon
	Positioning the Moon
	To position the moon manually:
	1. Display the Sky�&�Fog palette by 1. clicking th...
	2. Drag the blue highlight area in the 2. Sun/Moon...

	To position the moon numerically:
	1. Display the Sky�&�Fog palette by 1. clicking th...
	2. Click the triangle in the corner of the 2. pale...
	3. Click the Sun & Moon tab.
	4. In the Numerical Sun Values fields, 4. type a v...
	5. Enter a value into the Y field. The Y 5. field ...
	6. Enter a value in to the Z field. The Z 6. field...


	Moon Phases
	To set the moon’s phase:
	1. Display the Sky�&�Fog palette by 1. clicking th...
	2. Click the triangle in the corner of the 2. pale...
	3. Click the Sun & Moon tab.
	4. Drag over the Moon Phase control. 4. The phase ...
	5. Click the OK icon to exit the dialog.


	Moon Brightness and Sharpness
	To set the brightness of the moon’s shadow:
	1. Display the Sky�&�Fog palette by 1. clicking th...
	2. Click the triangle in the corner of the 2. pale...
	3. Click the Sun & Moon tab.
	4. Drag over the Earthshine control. 4. Drag left ...
	5. Click the OK icon to exit the dialog.

	To set the moon’s edge softness:
	1. Display the Sky�&�Fog palette by 1. clicking th...
	2. Click the triangle in the corner of the 2. pale...
	3. Click the Sun & Moon tab.
	4. Drag over the Softness control. Drag 4. left to...
	5. Click the OK icon to exit the palette.



	Adding Environmental Effects
	Sun/Moon Rings
	To add Sun/Moon rings:
	1. Display the Sky�&�Fog palette by 1. clicking th...
	2. Click the triangle in the corner of the 2. pale...
	3. Click the Sun & Moon tab.
	4. Click the Rings button.
	5. In the Rings area, enter a value in the 5. Inte...
	6. Enter a value in the Radius field to set 6. the...

	To add a secondary Sun/Moon ring:
	1. Display the Sky�&�Fog palette by 1. clicking th...
	2. Click the triangle in the corner of the 2. pale...
	3. Click the Sun & Moon tab.
	4. Click the Secondary Ring button in 4. the Rings...


	Sun/Moon Horizon Illusion
	To add a secondary Sun/Moon ring:
	1. Display the Sky�&�Fog palette by 1. clicking th...
	2. Click the triangle in the corner of the 2. pale...
	3. Click the Sun & Moon tab.
	4. Click the Horizon Illusion button at 4. the top...
	5. In the Horizon Illusion area, enter a 5. value ...


	Rainbows
	To add a rainbow to your sky:
	1. Display the Sky�&�Fog palette by 1. clicking th...
	2. Click the triangle in the corner of the 2. pale...
	3. Click the Atmosphere tab.
	4. Click the Rainbows button to activate 4. the ra...
	5. Enter a value in Radius field in the 5. Rainbow...
	6. Enter a value in the Opacity field. 6. This con...

	To add a secondary rainbow to your�sky:
	1. Display the Sky�&�Fog palette by 1. clicking th...
	2. Click the triangle in the corner of the 2. pale...
	3. Click the Atmosphere tab.
	4. Click the Secondary Rainbow button.
	5. Enter a value in Intensity field in the 5. Rain...


	Star Fields
	To add a Star Field:
	1. Display the Sky�&�Fog palette by 1. clicking th...
	2. Click the triangle in the corner of the 2. pale...
	3. Click the Sun & Moon tab.
	4. Click the Starfield button at the 4. bottom of ...

	To add comets to a Star Field:
	1. Display the Sky�&�Fog palette by 1. clicking th...
	2. Click the triangle in the corner of the 2. pale...
	3. Click the Sun & Moon tab.
	4. Click the Comets button at the 4. bottom of the...


	Volumetric World
	To add visible sunlight to your scene:
	1. Display the Sky�&�Fog palette by 1. clicking th...
	2. Click the triangle in the corner of the 2. pale...
	3. Click the Atmosphere tab.
	4. Click either the Rough or Fine button 4. in the...



	Using the Preset Skies Library
	To add a sky from the Preset Skies library to your...
	1. Click the triangle icon next to the 1. Sky�&�Fo...
	2. Click on the preset thumbnails to 2. view prese...
	3. Click the OK icon to add the selected 3. sky to...

	Adding and Deleting Preset Skies
	To add a sky to the preset library:
	1. Click the triangle icon next to the 1. Sky�&�Fo...
	2. Click the Add button at the bottom of 2. the di...
	3. Enter a name for the new preset in 3. the Prese...
	4. Enter a description of the preset in 4. the Des...
	5. Click the OK icon. Your preset will be 5. added...

	To delete an object preset:
	1. Click the triangle icon next to the 1. Sky�&�Fo...
	2. Click on the preset you want to 2. delete, or h...
	3. Click the Delete button at the bottom 3. of the...


	Importing and Exporting Preset Skies
	To import a preset sky file:
	1. Click the triangle icon next to the 1. Sky�&�Fo...
	2. Click the Import button at the 2. bottom of the...
	3. Locate the file which you would like 3. to impo...

	To export a preset sky file:
	1. Click the triangle icon next to the 1. Sky�&�Fo...
	2. Select the preset or presets you wish 2. to exp...
	3. Click the Export button at the 3. bottom of the...
	4. Enter a name and location for the file 4. and c...
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	Terrains
	What is a Terrain?
	The Terrain Editor
	To add a terrain object to your scene:
	1. Click the Create text button at the top 1. of t...
	2. Click the terrain object tool. A 2. randomly ge...

	To open the Terrain Editor:
	1. Select the terrain object.
	2. Click the E icon that appears next to 2. the te...

	Features of the Terrain Editor
	Editing Tools
	To access a tab:
	Terrain Canvas
	3D Terrain Preview

	To rotate the terrain preview:
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	Working in the Terrain Editor
	Using Terrain Editor Tools
	To apply a tool to the Terrain Canvas:
	1. Move the cursor over the tool you 1. want to us...
	2. Do one of the following:
	Starting a New Terrain

	To create a new Terrain Canvas:
	1. Make sure the Elevation tab is 1. displayed. If...
	2. Click the New button.

	To gradually flatten your terrain:
	To reset your terrain:
	Inverting Terrains

	To invert your terrain image:
	1. Make sure the Elevation tab is 1. displayed. If...
	2. Click the Invert button, or press 2. Command-I/...

	To gradually invert your terrain image:
	Undoing Operations

	To undo operations in the Terrain Editor:
	1. Make sure the Elevation tab is 1. displayed. If...
	2. Click the Undo button, or press 2. Command-Z/Ct...
	Eroding Terrains

	To erode terrains:
	1. Make sure the Elevation tab is 1. displayed. If...
	2. Click the Erode button. You can also 2. gradual...
	Setting 3D Terrain Preview Options

	To set 3D Terrain Preview options:
	Using the Zoom Area

	To turn the Zoom Area on:
	To turn the Zoom Area off:
	To move the Zoom area:
	1. Move your pointer over an edge of 1. the Zoom A...
	2. Drag the marquee to an area in the 2. Terrain C...

	To resize the Zoom area:
	1. Move the pointer over a corner of the 1. Zoom A...
	2. Drag away from the center of the 2. marquee to ...

	To scale the zoom area to fill the Terrain Canvas:...
	To fit the contents of the Terrain Canvas into the...
	Setting Terrain Resolution

	To set the Terrain resolution:


	Creating Terrains
	Creating Landscapes
	Animation and Terrain Editing
	Elevation Tools
	Using Elevation Tools
	To switch between sets of elevation tools:
	1. Click the curves in the bottom left 1. corner o...
	2. Click again to return to the first set.

	To use an elevation tool:
	1. Make sure the Elevation tab is 1. displayed. If...
	2. Click an effect tool. 100% of the 2. effect is ...
	3. Click the tool again to increase the 3. intensi...

	To apply an elevation effect gradually:
	1. Move the pointer over an Elevation 1. tool. The...
	2. Drag to the left to increase the effect 2. or d...
	Source Generators
	Fractal
	Eroded
	Picture
	Basic Tools
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	Smoothing
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	Square Edges
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	Sawtooth
	Subcontours
	Geometry Effects

	Blob Maker
	Relief Noise
	Raise Edges
	Subplateaus
	Cross Ridges
	Cross Ridges 2
	Bubble Ridges



	Painting Terrains
	Setting Up the Paintbrush
	To set brush attributes:
	1. In the Terrain Canvas frame, drag 1. over the S...
	2. Drag over the Hard control.
	3. Drag the pointer over the Flow 3. control.
	4. Drag over the Level control.

	To pick up gray levels from the terrain image:
	1. While holding down the Control/ 1. Ctrl, move t...
	2. Drag the brush over a different area 2. of the ...


	Brush Behaviors
	To paint elevations:
	1. Make sure the Elevation tab is visible. 1. If i...
	2. Click the triangle icon next to the 2. Brush Be...

	To apply an effect locally:
	1. Make sure the Elevation tab is visible. 1. If i...
	2. Click the triangle icon next to the 2. Brush Be...
	3. Hold down the Spacebar and click 3. the Elevati...
	4. Drag the paintbrush over an area of 4. your can...

	To remove an effect locally:
	1. Click the triangle icon next to the 1. Brush Be...
	2. Drag the paintbrush over an area of 2. your can...

	To erode areas of your terrain:
	1. Click the triangle icon next to the 1. Brush Be...
	2. Drag the paintbrush over the area 2. you want t...

	To lighten gray levels:
	1. Click the triangle icon next to the 1. Brush Be...
	2. Drag the paintbrush over an area you 2. want to...

	To darken gray levels:
	1. Click the triangle icon next to the 1. Brush Be...
	2. Drag the paintbrush over an area you 2. want to...
	Modifying Brush Behavior



	Filtering Terrains
	How Filtering Works
	To see how filtering works:
	1. Place your cursor (which changes to a 1. Pencil...
	2. Drag diagonally to the bottom right 2. corner.


	The Filtering Tab
	Working in the Filtering tab
	Altering the Filtering Graph
	To alter the Filtering graph:
	1. Make sure the Filtering tab is visible. 1. If i...
	2. Drag your pointer over the area of the 2. Filte...

	To undo all changes to the Filtering graph:
	1. Make sure the Filtering tab is visible. 1. If i...
	2. Click the Reset text button below the 2. Filter...

	To soften harsh transitions in the graph:
	1. Make sure the Filtering tab is visible. 1. If i...
	2. Click the Soften text button below the 2. Filte...
	3. Click the Soften button again to 3. soften the ...
	Applying Presets

	To apply presets:
	1. Make sure the Filtering tab is visible. 1. If i...
	2. Click one of the preset buttons along 2. the to...
	Applying Filtering Changes to Your Terrain Canvas

	To apply the Filtering graph to the 3D Preview:
	To apply filtering changes to the Terrain Canvas:
	Blending the Filtering Graph With the Terrain Canv...

	To blend the Filtering graph with the Terrain Canv...
	1. Adjust the Filtering graph to achieve 1. the de...
	2. Click the triangle icon below the 2. Filtering ...
	3. Click Apply.



	Creating Terrains Using Pictures
	The Pictures Tab
	Working in the Pictures Tab
	Loading Pictures
	To load pictures:
	To copy and paste a picture into the Picture tab:
	1. In another application, copy the 1. picture you...
	2. In the Picture tab, click the Paste text 2. but...
	Blending Pictures

	To blend pictures:
	1. Load pictures into the first two 1. squares.
	2. Click the triangle icon under the 2. third pict...
	3. Drag the pointer over the Blend 3. control.
	Applying Changes to the Terrain Canvas

	To apply a picture to the Terrain Canvas:


	Adding Color to Terrains
	Mapping Color to Your Terrain Canvas
	To map colors to your Terrain Canvas:
	1. Click the Color Picker button in the 1. bottom ...
	2. Drag the gradient up or down to map 2. the colo...

	To return to grayscale:
	To apply a gradient to a terrain’s Diffuse channel...
	1. Apply a gradient to the terrain.
	2. Click the triangle icon below the 2. Color/Gray...

	To remove a gradient from a terrain’s Diffuse chan...
	1. Open the terrain in the Terrain 1. Editor.
	2. Click the Color/Grayscale toggle.


	Clipping Terrains
	To set the clipping range:
	1. Drag the top of the Clipping Bracket 1. to set ...
	2. Drag the bottom of the Clipping 2. Bracket to s...

	To reset the Clipping Bracket:
	To move the entire Clipping Bracket at once:
	To add caps to your terrain:

	Saving Terrains
	Tips for Speeding Up the Terrain Editor on Slower ...
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	Materials
	Material Structure
	Understanding Surface Material Channels
	Color channels
	Value channels
	Optics channels
	Color Channels
	Value Channels
	Optics Channels


	Understanding Volume Material Channels
	Color channels
	Value channels
	Volume channels
	Volume Channels


	Understanding Material Components
	A Word About Alpha Channels


	Surface Material Channels
	Diffusion
	Setting Diffusion Using a Texture

	Diffuse Color
	Ambience
	Setting Ambience Using a Texture

	Ambient Color
	Setting Ambient Color Using a Texture

	Specularity
	Setting Specularity Using a Texture

	Specular Color
	Setting Specular Color Using a Texture

	Specular Halo
	Setting Specular Halo Using a Texture

	Metallicity
	Setting Metallicity Using a Texture

	Bump Height
	Transparency
	Setting Transparency Using a Texture

	Transparent Color
	Setting Transparent Color Using a Texture

	Refraction
	Setting Refraction Using a Texture

	Reflection
	Setting Reflection Using a Texture


	Volume Material Channels
	Volume Color
	Base Density
	Setting Base Density Using a Texture

	Edge Softness
	Fuzzy Factor
	Quality/Speed

	Material Components
	Color Components
	To use a color as a component:
	1. In the Materials Lab, click the color 1. oval i...


	Value Components
	To use a value as a component:

	Texture Components
	The Texture Component Window
	To use a Texture as a component:
	3D Textures

	To use a 3D texture as a component:
	1. In the Materials Lab, click a channel 1. column...
	2. If you want to change this texture, 2. click th...
	2D Textures

	To use a 2D texture as a component:
	1. In the Materials Lab, click a channel 1. column...
	2. In the Component window, click the 2. P button ...
	3. To change the picture, click the pink 3. button...
	4. Click an image square to load an 4. image.
	5. If the image you want is not in the 5. library:...
	6. Click the OK icon to exit the dialog.


	Texture Mapping Modes
	To select a mapping mode for a texture:
	1. In the Materials Composer, click a 1. channel.
	2. Select a mode for the channel.
	3. Click the title of the Component 3. window and ...
	4. Click the current Mapping Mode title 4. and cho...
	Object Space
	World Space
	Parametric
	Parametric Scaled
	World Top
	Spherical
	Cylindrical
	Reflection Map
	Random

	Object Top
	Object Front
	Mapping Mode Modifiers

	Symmetrical Tiling
	Scale Pict Size


	Transforming Textures
	Scale
	Rotation
	Position
	To transform a texture numerically:
	1. In the Texture Component window, 1. click the c...
	2. Move your cursor over the 2. transformation you...
	3. Drag the cursor over the value you 3. want to a...
	4. Click the OK icon to apply your 4. changes.

	To transform a texture interactively:
	1. In the Texture Component window, 1. click the c...
	2. Move the cursor over the tool you 2. want to us...
	3. As you pass the cursor over the tool, 3. the to...
	4. Drag the mouse in the direction you 4. want to ...
	5. Click the OK icon to apply your 5. changes.
	Editing Textures


	Combining Components
	Mode A
	Mode AB
	To use mode AB to blend textures:
	1. In the Materials Lab, Control/Ctrl- 1. click th...
	Mode ABC

	To use Mode ABC to blend textures:
	1. In the Materials Lab, Control/Ctrl- 1. click th...



	Shading Modes
	To choose a shading mode:
	Surface Material Shading Modes
	Normal
	Blend Transparency
	Fuzzy
	Light

	Volume Material Shading Modes
	Flat Shading
	Full Shading
	Light Sensitive

	Shading Mode Modifiers
	Additive
	Distance Blur
	Receive Shadows
	Cast Shadows
	Volume Blend-Altitude
	Volume Blend-Distance


	The Materials Lab
	To display the Materials Lab:
	1. Create an object.
	2. Select the object in the Working 2. window. A n...
	3. Click the M icon. Alternatively, you 3. can cho...

	A Quick Tour of the Materials Lab
	Material Preview Window
	The Materials Grid
	Texture Component Windows


	Working in the Materials Lab
	Building Materials
	To create a new surface material:
	1. Select an object.
	2. Display the Materials Lab.
	3. Set the material channels to define 3. the prop...
	4. If you’re using texture components, 4. you can:...
	5. Choose a shading mode for the 5. material by cl...
	6. Click the OK icon. The new material 6. is appli...

	To create a new volume material:
	1. Select an object.
	2. Display the Material Lab.
	3. Click the toggle button to switch to 3. Volume....
	4. Set the material channels to define 4. the prop...
	5. If you’re using texture components, 5. you can:...
	6. Choose a shading mode for the 6. material by cl...
	7. Click the OK icon. The new material 7. is appli...

	To activate a component in the Materials Grid:
	To use a component in a channel:
	To switch between components:
	To combine a component with a value:
	1. In a material channel, click an empty 1. column...
	2. Drag over the value control for the 2. channel....
	Copying and Pasting Materials

	To copy a material to the Materials clipboard:
	To paste a material to the Materials clipboard:
	Using the Material Preview Area

	To switch preview modes:
	To change the view angle of the preview area:


	Material Presets
	Using the Preset Materials Library
	To add a material from the Preset Materials Librar...
	1. Select an object.
	2. In the Working window, click the 2. triangle ic...
	3. Click one of the Category names 3. along the le...
	4. Click the thumbnail of the preset you 4. want t...
	5. Click the OK icon to add the selected 5. materi...
	Adding and Deleting Preset Materials

	To add a material to the library:
	1. Select the object whose material you 1. want to...
	2. Click the triangle icon next to the 2. Edit tex...
	3. Click a category name. The library 3. switches ...
	4. Click the triangle icon at the bottom 4. right ...
	5. Drag the preview area to rotate the 5. view of ...
	6. Hold down the Spacebar and drag 6. up, down, ri...
	7. Hold down Command/Ctrl and drag 7. in the previ...
	8. Click the Add button at the bottom of 8. the di...
	9. Enter a name for the new preset in 9. the Prese...
	10. Enter a description of the preset in 10. the D...
	11. Click the OK icon. Your preset will be 11. add...

	To delete a material preset:
	1. Click the triangle icon next to the 1. Edit tex...
	2. Click the preset you want to delete.
	3. Click the Delete button at the bottom 3. of the...


	Importing and Exporting Preset Materials
	To import a preset material file:
	1. Click the triangle icon next to the 1. Edit tex...
	2. Click the Import button at the 2. bottom of the...
	3. Locate the file you want to import 3. and click...

	To export a preset material file:
	1. Click the triangle icon next to the 1. Edit tex...
	2. Select the preset or presets you want 2. to exp...
	3. Click the Export button at the 3. bottom of the...
	4. Enter a name and location for the file 4. and c...


	Animating Materials
	Speeding Up Materials
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	Textures
	Textures and Materials
	Texture Structure
	Components vs. Texture Components
	Understanding Component Structure
	Components and Output


	Component Output
	Assigning Output Types
	Color Output
	To assign Color output to a texture:
	1. Display the Deep Texture Editor.
	2. In the desired component window, 2. click the C...
	Alpha Output

	To assign Alpha output to a texture:
	1. Display the Deep Texture Editor.
	2. In the desired component window, 2. click the A...
	Bump Output

	To assign Bump output to a texture:
	1. Display the Deep Texture Editor.
	2. In the desired component window, 2. click the B...



	Component Elements
	The Component window
	To activate a component:
	1. Display the Deep Texture Editor.
	2. Click the component selector in the 2. top-left...

	Color
	To activate Color output for a component:
	1. Display the Deep Texture Editor.
	2. In the desired component window, 2. click the C...

	To choose colors for a component:
	1. Display the Deep Texture Editor.
	2. In the desired component window, 2. make sure t...
	3. Click one of the color indicators 3. along the ...

	To mix colors for a component:
	1. Display the Deep Texture Editor.
	2. In the desired component window, 2. make sure t...
	3. Option/Alt-click the one of the color 3. indica...
	4. Choose a color model by clicking one 4. of the ...
	5. Enter color values or adjust the 5. sliders to ...
	6. Click the OK icon.
	Color Blending Modes

	To choose a Color Blending mode:
	1. Display the Deep Texture Editor.
	2. In the desired component window, 2. make sure t...
	3. Click the triangle icon in the lower 3. left co...
	None
	Red or Hue
	Green or Light
	Blue or Saturation
	Spline Interpol
	Linear Interpol 2
	Linear Interpol 3
	Randomized
	Earth Map
	Banded
	Perturbed
	Interferences
	Interpol + Interferences
	Altitude
	Spline with Snow
	Slope
	Orient


	Noise
	To display the Noise palette:
	1. Display the Deep Texture Editor.
	2. Click the Noise button at the bottom 2. of the ...

	To display the Noise Editor:
	1. Display the Deep Texture Editor.
	2. Click the Noise button at the bottom 2. of the ...
	3. Click the top-left corner of the 3. palette. Th...
	Creating Noise
	Noise Dimensions

	To choose the number of dimensions for your noise:...
	1. Display the Deep Texture Editor.
	2. Display the Noise Editor.
	3. Click one of the dimension buttons at 3. the bo...
	Noise Type

	To choose a noise type:
	1. Display the Deep Texture Editor.
	2. Display the Noise Editor.
	3. Click the type field at the top of the 3. edito...
	Noise Frequency

	To change the frequency of noise:
	1. Display the Deep Texture Editor.
	2. Display the Noise Editor.
	3. Drag over the X field in the 3. Frequency area ...
	4. Drag over the Y field in the Frequency 4. area ...
	5. Drag over the Z field in the 5. Frequency area ...
	Noise Orientation

	To change the orientation of noise:
	1. Display the Deep Texture Editor.
	2. Display the Noise Editor.
	3. Drag over the XY field in the 3. Direction area...
	4. Drag over the YZ field in the 4. Direction area...
	Noise Octaves

	To change the number of octaves:
	1. Display the Deep Texture Editor.
	2. Display the Noise Editor.
	3. Drag over the octaves field at the top 3. of th...
	Noise Modes

	To choose a Noise Mode:
	1. Display the Deep Texture Editor.
	2. Display the Noise Editor.
	3. Click the Mode field at the top of the 3. edito...
	Standard
	Irregular
	More Irregular
	Maximum
	Mulitfractal
	With Rotation
	Minimum
	Multiply
	Difference
	Minimum 90
	Maximum 90
	Auto-phased
	Displaced Max


	Phase
	To display the Phase palette:
	1. Display the Deep Texture Editor.
	2. Click the Phase button at the bottom 2. of the ...

	To display the Phase Editor:
	1. Display the Deep Texture Editor.
	2. Click the Phase button at the bottom 2. of the ...
	3. Click the top left corner of the 3. palette. Th...
	Creating Phase
	Phase Dimensions

	To choose the number of dimensions for your phase:...
	1. Display the Deep Texture Editor.
	2. Display the Phase Editor.
	3. Click one of the dimension buttons at 3. the bo...
	Phase Noise Type
	Phase Frequency

	To change the frequency of phase noise:
	1. Display the Deep Texture Editor.
	2. Display the Phase Editor.
	3. Drag over the X field in the 3. Frequency area ...
	4. Drag over the Y field in the Frequency 4. area ...
	5. Drag over the Z field in the 5. Frequency area ...
	Phase Noise Orientation

	To change the orientation of phase noise:
	1. Display the Deep Texture Editor.
	2. Display the Phase Editor.
	3. Drag over the XY field in the 3. Direction area...
	4. Drag over the YZ field in the 4. Direction area...
	Phase Noise Octaves
	Phase Noise Modes


	Filtering
	To display the Filtering palette:
	1. Display the Deep Texture Editor.
	2. Click the Filtering button at the 2. bottom of ...
	Editing the Filter

	To edit the Filtering graph:
	1. Display the Filtering palette.
	2. Drag over the Filtering graph area. 2. The shap...

	To change variable values:
	1. Display the Filtering palette.
	2. Drag over the variable field you want 2. to cha...
	Choosing a Filter

	To choose a filter:
	1. Display the Deep Texture Editor.
	2. Display the Filtering palette.
	3. Click the Filtering Equation area and 3. choose...
	None
	Quantize
	Saw Wave
	Sine Wave—Sin (aX) + b
	Absolute—Abs(aX + b)
	XPower—(X PWR a) + b
	Gaussian—(a(X + b))
	Clip aX + b
	Altitude Minus Slope—Xb + a (Altitude-Slope)
	Slope—X(a * Slope + b)
	Altitude—X(a* Altitude + b)
	Orientation—X(a * Orientation + b)
	Smooth Clip
	Snow Puddles



	Combining Components
	Blend Modes
	To apply a blend mode:
	1. Display the Deep Texture Editor.
	2. Click the Arrow between components 2. and choos...
	Parallel
	Combine
	Average
	Multiply
	Maximum
	Blend Maximum
	Minimum
	Blend Minimum
	Add
	Subtract
	Blend v1 and v2
	Blend Slope
	Fast Slope
	Blend Altitude
	Blend Orientation
	Blend Random
	Procedural Blend
	Difference


	Global Changes
	Global Colors
	To add colors directly to a texture:
	1. Click the top color circle in the 1. combinatio...
	2. Repeat for each of the other two color 2. circl...
	Global Noise

	To adjust noise globally:
	1. Click the top left button in the 1. combination...
	2. Drag the slider to adjust the noise 2. value.
	Global Phase

	To adjust phase globally:
	1. Click the bottom right button in the 1. combina...
	2. Drag the slider to adjust the phase 2. amplitud...
	Global Filtering

	To filter noise globally:
	1. Click the top right button in the 1. combinatio...
	2. Choose a filter and adjust its variables 2. to ...



	The Deep Texture Editor
	To display the Deep Texture Editor:
	1. Display the Materials Lab.
	2. Click the A, B or C column of the 2. material c...
	3. Click the pink button at the top of the 3. Comp...

	A Quick Tour: The Deep Texture Editor

	Working in the Deep Texture Editor
	Building Textures
	To build a texture:
	1. Display the Deep Texture Editor.
	2. Click the Component Selector to 2. choose the n...
	3. In the first component window, click 3. one of ...
	4. If your component contains color, 4. click one ...
	5. Click the triangle icon below the 5. color circ...
	6. Click the Noise button at the bottom 6. of the ...
	7. Adjust the noise in the component 7. by:
	8. Click the bottom right button on the 8. Compone...
	9. Adjust the phase in the component 9. by:
	10. Click the Filtering button at the 10. bottom o...
	11. Choose a filter to apply the 11. component noi...
	12. Repeat steps 3–11 for each 12. component in th...
	13. Click the arrow between Component 13. 1 and Co...
	14. If you have more than two 14. components, clic...
	15. Click the color circles in the 15. Combination...
	16. If you want to change the noise of 16. combine...
	17. If you want to change the phase of 17. combine...
	18. If you want to change the filter of 18. combin...
	19. Click the OK icon at the bottom of 19. the edi...


	Using Drag and Drop in the Editor
	To drag and drop between windows:

	Changing Component Preview
	To choose a preview mode:

	Randomizing Textures
	To randomize component elements:

	Undoing Changes
	To reset a component:

	Saving Textures
	To save a texture:
	1. In the Combination component 1. window, click t...
	2. Enter a name for the new texture and 2. click t...



	Tips for Speeding Up Textures
	Noise
	Phase
	Filtering
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	Arranging Objects
	Arranging Objects in a Scene
	Bryce and 3D Space
	World Space
	Object Space
	Camera Space
	To choose a 3D spatial option for transformations:...
	1. Click the Edit button at the top of the 1. Bryc...
	2. Click the triangle icon below one of 2. the tra...


	Bryce Units
	To reset object to unity:


	Coordinate Systems
	Absolute Coordinates
	Object Space Coordinates
	Relative Coordinates

	Transforming Objects
	Transformation Tools
	To select a tool:
	1. Click the Edit button at the top of the 1. Bryc...
	2. Select an object.
	3. Drag over the tool to perform a 3. transformati...
	Resize Tool
	Rotate Tool
	Reposition Tool
	Align Tool
	Randomize Tool


	Object Origin Points
	Nano-Edit Mode
	To activate Nano-Edit Mode:
	To temporarily activate Nano-Edit mode:


	Resizing Objects
	Using the Resize tool
	To resize an object along a specific axis:
	1. Make sure the Edit palette is visible. If 1. it...
	2. Move the Cursor over the Resize tool.
	3. When the state you want to use 3. becomes activ...

	To resize an object in all directions:
	1. Make sure the Edit palette is visible. If 1. it...
	2. Click the center of the Resize tool and 2. drag...

	To resize an object from two directions along a si...
	1. Make sure the Edit palette is visible. If 1. it...
	2. Move the cursor over the Resize tool.
	3. When the state you want to use 3. becomes activ...

	To choose a spatial option for resizing:
	1. Make sure the Edit palette is visible. If 1. it...
	2. Click the triangle icon next to the 2. Resize t...
	Flipping Objects

	To flip an object:
	1. Make sure the Edit palette is visible. If 1. it...
	2. Click the triangle icon next to the 2. Resize t...

	To undo resize operations:
	1. Make sure the Edit palette is visible. If 1. it...
	2. Select an object.
	3. Click the triangle icon next to the 3. Resize t...


	Numerical Resizing
	To resize an object numerically:
	1. Make sure the Edit palette is visible. If 1. it...
	2. Select an object.
	3. Click the triangle icon below the 3. Resize too...
	4. Enter a percentage in one or all of the 4. axis...


	Interactive Resizing
	To resize an object along a single axis interactiv...
	1. Select an object.
	2. Drag one of the control points at the 2. center...

	To enlarge or shrink an object interactively:
	1. Select an object.
	2. Drag one of the control points on the 2. corner...

	To resize an object from the bottom center:
	1. Select an object.
	2. Click the Y facial control point and 2. hold do...
	Using the Keyboard



	Rotating Objects
	Using the Rotate tool
	To rotate an object around a specific axis:
	1. Make sure the Edit palette is visible. If 1. it...
	2. Move the cursor over the Rotate tool.
	3. When the state you want to use 3. becomes activ...

	To choose a spatial option for rotation
	1. Make sure the Edit palette is visible. If 1. it...
	2. Click the triangle icon next to the 2. Rotate t...

	To undo rotation operations:
	1. Make sure the Edit palette is visible. If 1. it...
	2. Click the triangle icon next to the 2. Rotate t...


	Numerical Rotation
	To rotate an object numerically:
	1. Make sure the Edit palette is visible. If 1. it...
	2. Select an object.
	3. Click the triangle icon next to the 3. Rotate t...
	4. Enter a degree value in one or all of 4. the Ro...


	Interactive Rotation
	To rotate around a single axis:
	1. Select an object.
	2. Hold down Command /Ctrl and drag 2. on any face...

	To free rotate an object:
	1. Select an object.
	2. Hold down Command /Ctrl and drag 2. on any corn...



	Positioning Objects
	Using the Reposition Tool
	To position an object along a specific axis:
	1. Make sure the Edit palette is visible. If 1. it...
	2. Move the cursor over the Reposition 2. tool.
	3. When the state you want to use is 3. active, dr...

	To choose a spatial option for repositioning:
	1. Make sure the Edit palette is visible. If 1. it...
	2. Click the triangle icon next to the 2. Repositi...

	To undo position operations:
	1. Make sure the Edit palette is visible. If 1. it...
	2. Click the triangle icon next to the 2. Repositi...


	Numerical Repositioning
	To reposition an object numerically:
	1. Make sure the Edit palette is visible. If 1. it...
	2. Select an object.
	3. Click the triangle icon next to the 3. Repositi...
	4. Enter a value in one or all of the 4. Offset fi...


	Interactive Repositioning
	To reposition objects by dragging:

	Nudging Objects
	To nudge an object along the X axis:
	1. Select one or more objects.
	2. Press either the Right or Left arrow 2. keys.

	To nudge an object along the Y axis:
	1. Select one or more objects.
	2. Press either the PageUp or PageDown 2. arrow ke...

	To nudge an object along the Z axis:
	1. Select one or more objects.
	2. Press either the Up or Down keys.



	Aligning Objects
	Using the Grid
	To precisely position objects using the grid:
	1. Make sure all the objects are unity 1. size.
	2. Determine the objects’ positions 2. relative to...
	3. Use the nudge controls to move the 3. object. N...


	Using the Align Tool
	To align objects along a specific axis:
	1. Make sure the Edit palette is visible. If 1. it...
	2. Select two or more objects.
	3. Move the cursor over the Align tool.
	4. When the state you want to use is 4. active, cl...
	Anchor Objects


	Snap To Options
	To snap objects to the Grid:
	1. Make sure the Edit palette is visible. If 1. it...
	2. Select an object.
	3. Click the triangle icon next to the 3. align to...

	To snap objects to the center of the anchor object...
	1. Make sure the Edit palette is visible. If 1. it...
	2. Select an object.
	3. Click the triangle icon next to the 3. align to...

	To snap object to the World Center:
	1. Make sure the Edit palette is visible. 1. If it...
	2. Select an object.
	3. Click the triangle icon next to the 3. Align to...

	To drop or lift objects to ground level:
	1. Make sure the Edit palette is visible. If 1. it...
	2. Select an object.
	3. Click the triangle icon next to the 3. Align to...
	Landing Objects

	To snap object to the top surface of an object bel...
	1. Make sure the Edit palette is visible. 1. If it...
	2. Select an object.
	3. Click the triangle icon next to the 3. Align to...


	Aligning Numerically

	Randomizing Objects
	Using the Randomize Tool
	To randomize objects:
	1. Make sure the Edit palette is visible. If 1. it...
	2. Select a number of objects.
	3. Click the Randomize tool repeatedly 3. until th...
	4. Click the Randomize Sphere.
	5. The selected objects are randomized.

	To randomize objects interactively:
	1. Select a number of objects.
	2. Drag over the Randomize sphere. 2. Release the ...



	Object Hierarchies
	Grouping vs. Linking
	Hierarchical Structure
	Viewing Object Hierarchies
	To view a listing of the hierarchy:
	1. In the Working window, make sure 1. there are n...
	2. Click the Advanced Motion Lab 2. button at the ...
	Expanding and Collapsing a Hierarchy

	To expand/collapse a hierarchy listing:

	Linking Objects
	To link objects in the Working window:
	1. Select the object you want to set as 1. the chi...
	2. Click the Link icon and drag the 2. linking lin...

	To link objects using the Object Attributes dialog...
	1. Select the object you want to use as 1. the chi...
	2. Click the A icon that appears next to 2. the ob...
	3. Click the Linking tab.
	4. Click the Object Parent Name menu 4. and choose...
	5. Click the OK icon to link the two 5. objects.

	To break a link:
	1. Select a child object.
	2. Click the A icon that appears next to 2. the ob...
	3. Click the Linking tab.
	4. Click the Object Parent Name menu 4. and choose...
	5. Click the OK icon to unlink the two 5. objects....
	Linking Options
	Parent to Child Transformations Options

	To set which parent object transformations are app...
	1. Display the Object Attributes dialog.
	2. Click the Linking tab.
	3. Disable the buttons for the 3. transformation y...
	Geometric Path Linking Options

	To constrain/unconstrain an object to a geometric ...
	1. Select an object linked to a geometric 1. path....
	2. Display the Object Attributes dialog.
	3. Click the Linking tab.
	4. Enable the Constrain to path button 4. to const...

	To set where the object sits on the path:
	1. Select an object linked to a geometric 1. path....
	2. Display the Object Attributes dialog.
	3. Click the Linking tab.
	4. Enter a percentage in the Position 4. field.


	Grouping Objects
	To create a new group:
	1. Select all the objects you want to 1. group.
	2. Choose Objects menu>Group, or 2. press Command/...

	To select objects within a group:

	Families
	To create a new family:
	1. Select all the objects you want in the 1. famil...
	2. Click the colored box next to the 2. selection’...
	3. Click on a color. The color is applied 3. to th...
	4. You adjust these colors by dragging 4. the rect...
	5. Enter a name for the family in the 5. text fiel...

	To select a family:
	1. If the Animation controls are visible 1. at the...
	2. Click the Family button and choose 2. the name ...
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	Editing Objects
	Overview
	Restoring Objects
	To restore an object:

	Editing Object Attributes
	Object Attributes Dialog
	To display the Object Attributes dialog:
	1. Select an object.
	2. Choose Object menu> Edit 2. Attributes, or pres...


	Object Attribute Icons
	To display Object Attribute icons:
	Object Attributes Icon

	To display the Object Attribute dialog:
	1. Select an object or group of objects.
	2. Click the A icon that appears next to 2. the ob...
	Families Icon

	To add selected objects to a family:
	1. Select all the objects you want to add 1. to th...
	2. Click the Family icon that appears 2. next to t...
	3. Choose a color that represents an 3. existing f...
	4. Click the OK icon. The color you 4. select beco...
	Linking Icon

	To link one selected object to another:
	1. Select the object you want to be the 1. child o...
	2. Click the Link icon and drag it to the 2. objec...
	Tracking Icon

	To set a selected object to track another:
	1. Select the object you want to be the 1. station...
	2. Click the Tracking icon and drag it to 2. the o...
	Group Icon

	To group selected objects:
	1. Select all the objects you want 1. grouped.
	2. Click the G icon that appears next to 2. the ob...
	Ungroup Icon

	To ungroup a selected group of objects:
	1. Select all the objects you want 1. ungrouped.
	2. Click the U icon that appears next to 2. the ob...
	Material Icon

	To display the Materials Lab:
	1. Select an object or group of objects.
	2. Click the M icon that appears next 2. the bound...
	Edit Object Icon

	To display an object’s editor:
	1. Select an object or group of objects.
	2. Click the E icon that appears next to 2. the bo...
	Land Object Icon

	To land a selected object:
	1. Select the object you want to land.
	2. Click the Arrow icon that appears 2. next to th...


	Editing Object Names
	Editing Boolean Attributes
	To set an object’s Boolean attributes:
	1. Display the Object Attributes dialog.
	2. Make sure the General tab is 2. displayed.
	3. Enable one of the checkboxes at the 3. top of t...


	Editing Display Quality Attributes
	Hidden
	To hide an object:
	1. Display the Object Attributes dialog.
	2. Make sure the General tab is 2. displayed.
	3. Enable the Hidden button.
	Locked

	To lock an object:
	1. Display the Object Attributes dialog.
	2. Make sure the General tab is 2. displayed.
	3. Enable the Locked button.

	To unlock an object:
	1. Click the Swap button at the bottom 1. of the W...
	2. Click an object type button or hold 2. down the...
	Show as Box

	To display an object as a box:
	1. Display the Object Attributes dialog.
	2. Make sure the General tab is 2. displayed.
	3. Enable the Show as Box button.
	Show Origin Point

	To display an object’s origin point:
	1. Display the Object Attributes dialog.
	2. Make sure the General tab is 2. displayed.
	3. Enable the Show Origin Point button.


	Editing Transformation Attributes
	To set an object’s origin point:
	1. Display the Object Attributes dialog.
	2. Make sure the General tab is 2. displayed.
	3. Enter values in the Origin X, Y and Z 3. fields...

	To set an object’s position:
	1. Display the Object Attributes dialog.
	2. Make sure the General tab is 2. displayed.
	3. Enter a value in the Position X field to 3. set...
	4. Enter a value in the Position Y field to 4. set...
	5. Enter a value in the Position Z field to 5. set...

	To rotate an object:
	1. Display the Object Attributes dialog.
	2. Make sure the General tab is 2. displayed.
	3. Enter a value in the Rotate X field to 3. set t...
	4. Enter a value in the Rotate Y field to 4. set t...
	5. Enter a value in the Rotate Z field to 5. set t...

	To set an object’s size:
	1. Display the Object Attributes dialog.
	2. Make sure the General tab is 2. displayed.
	3. Enter a value in the Size X field to set 3. the...
	4. Enter a value in the Size Y field to set 4. the...
	5. Enter a value in the Size Z field to set 5. the...


	Editing Link Attributes
	Linking
	To link objects:
	1. Display the Object Attributes dialog.
	2. Click the Linking tab.
	3. Click the Object Parent Name field 3. and choos...
	4. Enable a Propagate option. These 4. options con...
	Tracking

	To set an object to track another:
	1. Display the Object Attributes dialog.
	2. Click the Linking tab.
	3. Click the Track Object Name field 3. and choose...
	4. Enable one of the Orientation 4. options. These...


	Editing Animation Attributes
	Motion Path Display Options
	To set motion path display options:
	1. Display the Object Attributes dialog.
	2. Click the Animation tab.
	3. Enable one or all of the display 3. options:
	Motion Path Attributes

	To set motion path attributes:
	1. Display the Object Attributes dialog.
	2. Click the Animation tab.
	3. Enable one or all of the attributes:
	Align Options

	To set align options:
	1. Display the Object Attributes dialog.
	2. Click the Animation tab.
	3. Enable one or all of the options:
	Motion Path Geometry Options

	To set motion path geometry options:
	1. Display the Object Attributes dialog.
	2. Click the Animation tab.
	3. Enable one or all of the options:



	Editing Toruses
	To display the Torus editor:
	1. Click a Torus object.
	2. Click the E�button that appears next 2. to the ...

	To adjust the inner radius:
	To accept your changes and exit the Torus Editor:
	To exit the Editor without accepting any changes:

	Editing Imported Polyhedrons and Stones
	To smooth imported objects or stones:
	1. Click the imported object or stone.
	2. Click the E�button that appears next 2. to the ...
	3. Adjust the value of the smoothing 3. range by d...
	4. Click the Smooth button until you 4. achieve th...

	To unsmooth imported objects or stones:
	1. Click the imported object or stone.
	2. Click the E�button that appears next 2. to the ...
	3. Adjust the value of the smoothing 3. range by d...
	4. Click the Unsmooth button until you 4. achieve ...


	Converting Objects
	To convert an object to another type of object:
	1. Select the object you want to convert.
	2. Click the Edit button at the top of the 2. Bryc...
	3. Click the double-headed arrow in the 3. top lef...
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	The Camera and Lights
	The View of Your Scene and Lighting in Bryce�3D
	The View of Your Scene
	Camera View
	Director’s View
	Orthogonal Views

	Lights
	Viewing Lights
	Visible Lights

	Setting Up the View of Your Scene
	Camera View
	To switch to Camera View:
	Setting Camera Object Properties

	To hide the camera wireframe:
	1. Switch to Director’s View or an 1. orthogonal v...
	2. Select the camera in the Working 2. window.
	3. Click the A icon that appears next to 3. it. Th...
	4. Enable the Invisible option.

	To display the camera’s field of view:
	1. Switch to Director’s View or an 1. orthogonal v...
	2. Select the camera in the Working 2. window.
	3. Click the A icon that appears next to 3. the ca...
	4. Enable the Show FOV option.

	To lock the camera position:
	1. Switch to Director’s View or an 1. orthogonal v...
	2. Select the camera in the Working 2. window.
	3. Click the A icon that appears next to 3. its bo...
	4. Enable the Locked option.


	Director’s View
	To switch to Director’s View:
	Swapping Director’s Views for Camera View

	To swap the Director’s View position for the Camer...

	Orthogonal Views

	Positioning the View of Your Scene
	Camera Modes
	Trackball Mode
	Center to Selection Mode
	Tripod Mode
	Free Mode
	To choose a camera mode‘:
	1. Double-click either the Trackball or 1. one of ...
	2. Make sure the General tab is visible.
	3. Click one of the mode buttons at the 3. top of ...


	Using the Trackball
	To move the camera using the Camera Trackball:

	Using the Cross Controls
	X-Y Cross
	X-Z Cross
	Y-Z Cross
	To move the camera in two axes at once:
	1. Drag the sphere at the center of one 1. of the ...

	To move the camera along a single axis:
	Camera Cross Options

	To use a Camera Cross control option:

	Banking Controls
	To bank the camera:

	Field of View
	To increase/decrease the camera’s field of view:

	Positioning the Camera Numerically
	To position the camera’s origin point numerically:...
	1. Double-click either the Trackball or 1. one of ...
	2. Make sure the General tab is visible.
	3. Click the Free Mode button.
	4. Enter values in the Origin X, Y and Z 4. fields...

	To set the position of the camera numerically:
	1. Double-click either the Trackball or 1. one of ...
	2. Make sure the General tab is visible.
	3. Enter values in the Position X, Y and 3. Z fiel...

	To rotate the camera numerically:
	1. Double-click either the Trackball or 1. one of ...
	2. Make sure the General tab is visible.
	3. Enter values in the Rotate X, Y and Z 3. fields...

	To set the Field of View numerically:
	1. Double-click either the Trackball or 1. one of ...
	2. Make sure the General tab is visible.
	3. Enter a value in the Field of View 3. field.


	Manually Positioning the Camera
	Camera Origin Point
	To display the camera’s origin point:
	1. Switch to one of the orthogonal views 1. or Dir...
	2. Click the camera wireframe.
	3. Click the A icon that appears next to 3. the ca...
	4. Click the General tab and enable the 4. Show Or...

	To position the camera manually:
	1. Switch to Director’s View or an 1. orthogonal v...
	2. Drag the camera wireframe to a 2. location in t...

	To position the camera’s origin manually:
	1. In the Object Attributes dialog, 1. display the...
	2. Drag the green point to a location in 2. the sc...


	Aiming the Camera
	To change the Camera’s aim in an orthogonal view:
	1. In the Working window, click the 1. triangle ic...
	2. Drag the end of the control handle to 2. the po...


	Saving Camera Positions
	To return to the default camera position:
	To save a camera position to a memory dot:
	To switch between saved positions:
	To clear a full dot:
	To switch between positions using the keyboard:


	Setting Up Lights
	Creating Direct Light Sources
	Radial Light
	Spotlight
	Square Spotlight
	Parallel Light
	Cylindrical Parallel Light
	To create a light source:
	1. Make sure the Create palette is 1. visible. If ...
	2. Click one of the create light tools:


	Editing Light Attributes
	To access the Edit Lights dialog:
	1. Select a light. The Object Attribute 1. control...
	2. Click the E button.

	To adjust light intensity:
	To set a light’s color:
	To disable shadow casting for a light source:
	Light Preview

	To set the preview options:
	Light Attributes

	To adjust the spread of a spotlight:
	1. Select a spotlight.
	2. Drag the one of its bounding box 2. control poi...

	To adjust a light’s edge softness:
	Light Fall-off

	To adjust a light’s fall-off:

	Creating Visible Lights
	To create a surface visible light:
	1. Create a light source.
	2. Select the light in the Working 2. window.
	3. Click the E button that appears next 3. to the ...
	4. Click the triangle icon below the light 4. prev...

	To create a volume visible light:
	1. Create a light source.
	2. Select the light in the Working 2. window.
	3. Click the E button that appear next to 3. the l...
	4. Click the triangle icon below the light 4. prev...
	Editing Visible Light Materials


	Applying Gels
	To use a picture as a gel:
	1. In the Edit light dialog, click on the 1. Pict ...
	2. Choose a picture from the preset 2. library, or...
	3. Click the checkmark. The picture is 3. applied ...

	To use a texture as a gel:
	1. In the Edit Light dialog, click on the 1. Textu...
	2. Select a material from one of the 2. categories...
	3. Click the checkmark. The texture in 3. the mate...


	Positioning Lights
	Linking and Tracking with Lights
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	Animating
	Key Event Animation and Bryce�3D
	Time-Based Animation
	Animation and Motion Paths
	Animatable Properties
	Properties in the Sequencer
	To expand a listing in the Sequencer:
	1. Make sure the Advanced Motion Lab 1. is visible...
	2. Click the object’s listing.



	Creating Animations
	To display the Animation controls in the Working w...
	Setting Up an Animation
	To set the duration of your animation numerically:...
	1. Choose File menu> Animation 1. Setup or double-...
	2. Click the Set Timeline button. This 2. switches...
	3. In the Duration fields, enter the total 3. leng...
	Setting the Frame Rate

	To set the frame rate for your animation:
	1. Choose File menu> Animation 1. Setup or double-...
	2. Enter a frame rate in the FPS field.


	Working with the Timeline
	Working with Time
	To scroll the time area:
	Setting the Animation Range in the Timeline

	To manually set the Animation Range:
	Setting the Current Time for an Animation

	To move to a specific frame manually:
	To move the current time manually:
	1. Make sure the Animation controls are 1. visible...
	2. Drag the Current Time Indicator 2. along the Ti...

	To move the current time numerically:
	1. Choose File menu> Animation 1. Setup. The Anima...
	2. In the Current fields, enter the hour, 2. minut...

	To save the position of the Current Time Indicator...
	1. Make sure the Animation controls are 1. visible...
	2. Move the Current Time Indicator to 2. the posit...
	3. Click on an empty Memory Dot at 3. the bottom o...

	To move the Current Time Indicator to a saved posi...
	1. Make sure the Animation controls are 1. visible...
	2. Click the Memory dot for the 2. position you wa...

	To delete a saved position:
	1. Make sure the Animation controls are 1. visible...
	2. Option/Alt+click on a full 2. memory�dot.
	Setting Up the Working Area

	To set the range of the Working Area manually:
	1. Make sure the Animation controls are 1. visible...
	2. Drag either end of the existing 2. Working area...

	To set the range of the Working Area numerically:
	1. Choose File menu> Animation 1. Setup or double-...
	2. Click the word “Current” at the top of 2. the d...
	3. Enter the starting time for the 3. Working Rang...
	4. Click the word again and choose 4. Working Rang...
	5. Enter the ending time for the 5. Working Range....
	Setting Timeline Scale

	To set the scale of the timeline:
	1. Make sure the Animation controls are 1. visible...
	2. Drag the scale indicator.
	Scaling Animation Duration

	To set the scale of the entire animation manually:...
	1. Make sure the Animation controls are 1. visible...
	2. Hold down Option/Alt and drag the 2. animation ...

	To scale the animation numerically:
	1. Choose File menu> Animation 1. Setup or double-...
	2. Click the Scale Animation button.
	3. Enter the desired animation duration 3. in the ...


	Recording Key Events
	To enable or disable Auto-Record mode:
	1. In the Working window, make sure 1. the Animati...
	2. Click the triangle icon to the left of 2. the c...
	Recording Key Events in the Editors


	Previewing Animations
	Setting Previewing Options
	To set a preview option:
	1. Choose File menu> Animation 1. Setup. The Anima...
	2. Enable a Play option:


	Adding and Deleting Key Frames
	Adding Frames
	To add a key frame:
	1. Move the Current Time Indicator to 1. the point...
	2. Click the Add Key Frame button.

	To a add a frame for a certain type of property:
	1. Select an object.
	2. Hold down the mouse button over 2. the Add Key ...

	To add a key frame for sky properties:
	Deleting Frames

	To delete a key frame:
	1. Use the Animation Preview controls 1. to move t...
	2. Click the Delete Key Frame button.

	To delete a frame for a specific object property:
	1. Select an object.
	2. Hold down the mouse button over 2. the Delete K...
	Adding and Deleting Frames in the Editors



	Advanced Motion Lab
	Viewing Object Hierarchies
	To hide an object’s property timelines:
	To expand/ collapse the hierarchy list:

	Editing Property Timelines in the Sequencer
	To display object’s property timelines:
	To display an object’s property timelines:
	To move a key event on a timeline:
	1. Expand the listing you want to edit.
	2. Click the white tick mark on the 2. listing’s t...
	3. Drag the key event to a new position.

	To move a group of key events:
	1. Drag a marquee around all the key 1. events you...
	2. Drag one of the selected key events. 2. All the...

	To delete a key event from a timeline:
	1. Select the key event, or group of 1. events you...
	2. Press Delete. The key event is 2. removed from ...

	To copy a key event on a timeline:
	1. Hold down Option/Alt and drag a 1. key event. T...


	Time Mapping Curves
	Editing Time Mapping Curves
	To edit a Time Mapping curve:
	1. Display the Advanced Motion Lab.
	2. Click the name of the object whose 2. propertie...
	3. Click the name of the property you 3. want to r...
	4. In the Time Mapping Editor, click a 4. point on...
	5. Continue dragging points until you 5. achieve t...

	To zoom into an area of the Time Mapping curve:
	1. Move the cursor over the curve in the 1. Time M...
	2. Drag over an area of the curve. When 2. you rel...

	To zoom out of an area in the Time Mapping curve:
	To pan the Time Mapping curve:

	Previewing the Animation
	To preview an animation:
	To switch between Camera View and Director’s View ...
	To change the view in the Preview Area:
	To zoom in and out of the preview:
	To reset the view in the preview area:
	To pan the Preview Area:
	Hiding and Displaying Objects

	To hide/display an object:
	Saving Preview Positions

	To save a position:
	1. Play the animation and then stop it at 1. the p...
	2. Click on an empty Memory dot on 2. the right si...

	To move to saved position:
	To delete a saved position:


	Motion Paths
	To show the motion path as a ribbon:
	1. Select the object.
	2. Click the A icon that appears next to 2. its bo...
	3. Click the Animation tab.
	4. Enable the Show as Ribbon option 4. and click t...

	To display the path only when the object is select...
	1. Select the object.
	2. Click the A icon that appears next to 2. its bo...
	3. Click the Animation tab.
	4. Enable the Show Only when Selected 4. option an...

	To display the path at all times:
	1. Select the object.
	2. Click the A icon that appears next to 2. its bo...
	3. Click the Animation tab.
	4. Enable the Show Always option and 4. click the ...

	Editing Motion Paths
	Motion Path Modifiers
	To apply a modifier to a motion path:
	1. Select the object.
	2. Click the A icon that appears next to 2. its bo...
	3. Click the Animation tab.
	4. Enable a modifier.
	5. Extend the duration of the animation 5. so you ...


	Moving the Path
	To move a motion path:

	Aligning Objects to the Path
	To align an object to a motion path:
	1. Select the object.
	2. Click the A icon that appears next to 2. its bo...
	3. Click the Animation tab.
	4. Enable an alignment option and click 4. the OK ...





	14-Ani Techniques.pdf
	Animating Techniques
	Introduction
	Tracking Objects
	To set up object tracking interactively:
	1. Select the object you want to remain 1. station...
	2. Move the cursor over the target icon 2. that ap...
	3. Drag the Target line from the icon to 3. the ta...

	To set up object tracking using the Object Attribu...
	1. Select the object you want to remain 1. station...
	2. Click the A icon that appears next to 2. the ob...
	3. Click the Linking tab.
	4. Click the Target Object Name menu 4. and choose...


	Animating the Camera
	Camera Motion and Skies
	To link clouds to the camera:
	1. Display the Sky�&�Fog palette.
	2. Click the triangle icon in the bottom 2. right ...
	3. Click the Cloud Cover tab.
	4. Click the Link Clouds to View button 4. at the ...
	5. Click the OK icon to exit the palette.

	Using the Orthogonal Views
	To animate the camera in an orthogonal view:
	1. In the Working window, click the 1. triangle ic...
	2. Move the Current Time Indicator in 2. the Timel...
	3. Click the triangle icon in the 3. Animation con...
	4. Drag the Camera wireframe in the 4. Working win...
	5. If you want to see the results of your 5. chang...


	Using Director’s View
	To animate the camera using Director’s View:
	1. In the Working window, click the 1. triangle ic...
	2. Move the Current Time Indicator in 2. the Timel...
	3. Click the triangle icon in the 3. Animation con...
	4. Drag the Camera wireframe in the 4. Working win...
	5. If you want to see the results of your 5. chang...


	Displaying the Camera’s Trajectory
	To display the camera’s trajectory:
	1. In the Working window, click the 1. triangle ic...
	2. Select the Camera in the Working 2. window.
	3. Click the A icon that appears next to 3. the ca...
	4. Click the Animation tab.
	5. Click the Show Trajectory option and 5. click t...


	Linking and Tracking with the Camera
	To link the camera to an object using the Camera &...
	1. Switch to an orthogonal view or 1. Director’s V...
	2. Select the Camera.
	3. Click the A icon that appears next to 3. the ca...
	4. Click the Linking tab.
	5. Click the Object Parent Name menu 5. and choose...
	6. Click the OK icon to link the two 6. objects.

	To link the camera to an object interactively:
	1. Switch to an Orthogonal view or 1. Director’s V...
	2. Select the Camera.
	3. Move the cursor over the Link icon 3. that appe...
	4. Drag the linking handle from the 4. icon to obj...

	To force the camera to track an object using the C...
	1. Switch to an orthogonal view or 1. Director’s V...
	2. Select the Camera.
	3. Click the A icon that appears next to 3. the ca...
	4. Click the Linking tab.
	5. Click the Track Object Name menu 5. and choose ...
	6. Click the OK icon.

	To force the camera to track an object interactive...
	1. Switch to an orthogonal view or 1. Director’s V...
	2. Select the Camera.
	3. Move the cursor over the Tracking 3. icon that ...
	4. Drag the tracking handle from the 4. icon to th...


	Creating Camera Orbits
	To create a camera orbit:
	1. Switch to Director’s View or one of 1. the orth...
	2. Click the triangle icon in the 2. Animation con...
	3. Click the Camera wireframe in the 3. Working wi...
	4. Click the A icon that appears next to 4. the ca...
	5. Click the General tab.
	6. Click the Show Origin Handle button 6. and clic...
	7. Drag the ring handle to a position in 7. the sc...
	8. Rotate the object using the Rotation 8. tool in...



	Animating Materials
	Animating Material Channel Values
	To animate a material’s channel values:
	1. Select an object.
	2. Click the M icon that appears next to 2. the ob...
	3. Click the triangle icon in the 3. Animation con...
	4. Move the Current Time Indicator to 4. the point...
	5. Change the values of the material 5. channels u...
	6. Move the Current Time Indicator to a 6. differe...
	7. Change the channel values again.
	8. Continue moving the Current Time 8. Indicator a...
	9. Click the OK icon to exit the 9. Materials Lab....


	Animating Texture Components
	To animate a material’s texture components:
	1. Select an object.
	2. Click the M icon that appears next to 2. the ob...
	3. Click the triangle icon in the 3. Animation con...
	4. Move the Current Time Indicator to 4. the point...
	5. Click the button in the upper left 5. corner of...
	6. Adjust the position, orientation or 6. scale of...
	7. Click the pink button in the 7. upper-left corn...
	8. Adjust the values of the texture’s 8. component...
	9. Move the Current Time Indicator to a 9. differe...
	10. Change the texture properties again.
	11. Continue moving the Current Time 11. Indicator...
	12. Click the OK icon to exit the 12. Materials La...


	Animating Between Materials
	To animate between materials:
	1. Select an object.
	2. Click the M icon that appears next to 2. the ob...
	3. Click the triangle icon in the 3. Animation con...
	4. Move the Current Time Indicator to 4. the point...
	5. Set up a material by setting channel 5. values ...
	6. Move the Current Time Indicator to a 6. differe...
	7. Set up a different material by 7. choosing diff...
	8. Click the OK icon to exit the 8. Materials Lab....


	Previewing Material Animations
	To preview a material animation:


	Animating Skies
	Animating Sky & Fog settings
	To animate Sky & Fog settings:
	1. Click the triangle icon in the 1. Animation con...
	2. Move the Current Time Indicator to 2. the point...
	3. Adjust the sky’s properties using the 3. Sky & ...
	4. Move the Current Time Indicator to a 4. differe...
	5. Change the properties of the sky 5. again.
	6. Continue moving the Current Time 6. Indicator a...


	Animating Couds
	To animate clouds:
	1. Click the triangle icon in the 1. Animation con...
	2. In Sky & Fog palette, click the 2. triangle ico...
	3. Click the Cloud Cover tab.
	4. Move the direction indicator in the 4. Cloud Mo...
	5. Adjust the speed control to set how 5. fast the...
	6. Adjust the Turbulence control to set 6. how muc...


	Animating Environmental Effects
	To animate environmental effects:
	1. Click the triangle icon in the 1. Animation con...
	2. Move the Current Time Indicator to 2. the point...
	3. Display the Environmental Attributes 3. dialog:...
	4. Move the Current Time Indicator to a 4. differe...
	5. Change the properties of the effect 5. again.
	6. Continue moving the Current Time 6. Indicator a...


	Animating Sun or Moon Position
	To animate Sun or Moon position:
	1. Click the triangle icon in the 1. Animation con...
	2. Move the Current Time Indicator to 2. the point...
	3. Adjust the position of the sun or 3. moon using...
	4. Move the Current Time Indicator to a 4. differe...
	5. Change the position of the sun or 5. moon again...
	6. Continue moving the Current Time 6. Indicator a...



	Animating Terrains
	Animating Terrain Geometry
	To animate terrain geometry:
	1. Click a terrain object.
	2. Click the E icon that appears next to 2. the te...
	3. Click the triangle icon in the 3. Animation con...
	4. Move the Current Time Indicator to 4. the point...
	5. Paint new areas in the terrain using 5. the Gra...
	6. Move the Current Time Indicator to a 6. differe...
	7. Change the shape of the terrain again 7. using ...
	8. Continue moving the Current Time 8. Indicator a...
	9. Click the OK icon to exit the editor.


	Animating Terrain Filtering
	To animate terrain filtering:
	1. Click a terrain object.
	2. Click the E icon that appears next to 2. the te...
	3. Click the Filtering tab.
	4. Click the triangle icon in the 4. Animation con...
	5. Move the Current Time Indicator to 5. the point...
	6. Adjust the shape of the Filtering 6. graph.
	7. Move the Current Time Indicator to a 7. differe...
	8. Change the shape of the graph again.
	9. Continue moving the Current Time 9. Indicator a...
	10. Click the OK icon to exit the editor.


	Animating Terrain Clipping
	To animate terrain clipping:
	1. Click a terrain object.
	2. Click the E icon that appears next to 2. the te...
	3. Click the triangle icon in the 3. Animation con...
	4. Move the Current Time Indicator to 4. the point...
	5. Adjust the width of the clipping 5. bracket.
	6. Move the Current Time Indicator to a 6. differe...
	7. Change the width of the bracket 7. again.
	8. Continue moving the Current Time 8. Indicator a...
	9. Click the OK icon to exit the editor.


	Previewing Terrain Animations
	To preview a material animation:
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	Rendering
	What is Rendering?
	Raytracing
	The Rendering Procedure

	Setting Up a Render
	Setting Render Options
	AntiAliasing
	AntiAliasing Off
	AntiAliasing [Normal Quality]
	AntiAliasing Fine Art [Slow]
	To enable AntiAliasing:
	To disable AntiAliasing:
	Render Resolution

	To choose a render resolution:
	1. Double-click the Render all control, 1. or choo...
	2. Click one of the render resolutions at 2. botto...
	3. Click the checkmark button.
	Spatial Optimization
	Spatial Optimization Off
	Spatial Optimization Low
	Spatial Optimization High

	To use Spatial Optimization:
	Render Reporting

	To produce a render report:
	Document Resolutions


	Render Modes
	To choose a Render mode:
	Perspective Render
	Mask Render
	360° Panorama

	Before beginning a 360° panoramic render you shoul...
	1. Switch to the Top view using the View 1. contro...
	2. Display the Document Setup dialog 2. using File...
	3. Do a quick test render in Perspective 3. Render...
	4. Alter your camera position and Y/Z 4. rotation
	5. Switch to 360° Panorama render 5. mode and rend...
	Distance Render
	Altitude Render
	Preview Render Modes
	Fast Preview

	To enable Fast Preview Mode:
	1. Click the Fast Preview button in the 1. Render ...
	Textures On/Off

	To enable Textures On/Off Mode:
	1. Click the Textures On/Off button in 1. the Rend...



	Rendering a Scene
	Using the Render Controls
	To start a rendering of the entire scene:
	1. Click the Render All button.

	To resume a rendering:
	To clear a selection and start a rendering:

	Plop-Render Mode
	To enable/disable Plop-Render Mode:
	To render an area of your scene:
	1. Make sure Plop-Render mode is 1. enabled.
	2. Switch to Bitmap display mode by 2. clicking th...
	3. Drag a marquee around an area of 3. your image....
	4. Click the top button that appears 4. beside the...

	To resume a render:
	To scale the selected area to fill the working win...
	1. Make sure Plop-Render mode is 1. enabled.
	2. Switch to Bitmap display mode by 2. clicking th...
	3. Drag a marquee around an area of 3. your image....
	4. Click the triangle icon below the 4. render but...



	Rendering a Movie
	The Render Movie dialog
	Name
	File Type
	Compression
	Render Range
	To start the rendering of a movie:
	1. Choose File> Render Movie. The 1. Render Movie ...
	2. Enter destination and name for the 2. movie.
	3. Choose a file format for the movie.
	4. Choose a compression option from 4. the menu.
	5. Enable a render range option.
	6. Click the OK icon. Bryce starts 6. rendering ea...



	Batch Rendering
	To perform a batch render:
	1. Save a number of scenes to a folder.
	2. Drag all the files on the Bryce 2. application....


	Fast Render Strategies
	Patch Rendering
	To patch render your image:
	1. Start a render as normal.
	2. Let the rendering proceed for two or 2. three p...
	3. Switch to Bitmap display mode.
	4. Drag a marquee around key portions 4. of your s...

	You can also speed up rendering using these techni...

	Working with Rendered Images
	Scaling Your Image
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	Post Production
	Overview
	Post Production Applications
	Exporting Image
	To export an image:
	1. Render you scene.
	2. Choose File menu> Export. The 2. export dialog ...
	3. Choose a format for your image and 3. click OK....


	Compositing
	To render a scene as a mask:
	1. Click the triangle next to the Render 1. contro...
	2. Choose File menu> Export and 2. choose either B...
	Using Painter

	To composite using Painter:
	1. Render the scene normally using 1. Perspective ...
	2. Save the image in a convenient 2. location.
	3. Render the scene again, this time 3. using Mask...
	4. Save the mask image to the same 4. location.
	5. Open the Perspective Render image 5. in Painter...
	6. Choose Select menu> Load 6. Selection.
	7. In the dialog, select the Mask Render 7. image....
	8. Choose Edit menu> Copy.
	9. Open the background image (the 9. image you wan...
	10. Choose Edit menu> Paste.
	11. Position the floater where you 11. want�it.


	Adding Depth
	To render a scene as a distance mask:
	1. Click the triangle next to the Render 1. contro...
	2. Choose File menu> Export and 2. choose PICT.
	Using Photoshop

	To create depth of field using Photoshop:
	1. Render the scene normally using 1. Perspective ...
	2. Save the image in a convenient 2. location.
	3. Render the scene again, this time 3. using Mask...
	4. Save the mask image to the same 4. location.
	5. Open the Perspective Render image 5. and the Di...
	6. Place the Distance Render image into 6. the alp...
	7. Load the alpha channel as a selection.
	8. Apply Gausian Blur.



	Printing Images
	To print an image:
	1. Choose File menu> Print, or press 1. Command-P/...
	2. Choose the options you want to use.
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	QuickTime VR
	QuickTime VR and Bryce 3D
	Creating VR Panoramas
	To create VR panoramas:
	1. Choose Default in the Document 1. Setup dialog....
	2. Click on the uppermost Views 2. Memory Dot in t...
	3. Set up your scene.
	4. Keep the Nano-Preview in Camera 4. View mode to...
	5. Drag the tip of the camera around in 5. the Wor...
	6. Switch back to Camera View and do a 6. quick te...
	7. After the render, make any required 7. position...
	8. Choose File> Document Setup and 8. select QTVR ...
	9. Click the triangle icon next to the 9. Render c...
	10. Click the Render button to do a quick 10. test...
	11. Make any position changes you like.
	12. Choose File menu >Render To Disk. 12. The Rend...
	13. Leave the default settings.
	14. Select the 90° counterclockwise 14. auto-rotat...
	15. Click the OK icon.
	16. Click the Render button.
	17. When the rendering is done, choose 17. File me...
	18. On your desktop, drag the image 18. onto Apple...

	Further VR Exploration
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